Visio 2003 Bible

Complete coverage of both Visio Standard and Visio Professional

Bonnie Biafore
Visio® 2003 Bible

Bonnie Biafore

Wiley Publishing, Inc.
Visio® 2003 Bible
Visio® 2003 Bible

Bonnie Biafore

Wiley Publishing, Inc.
About the Author

Bonnie Biafore is an author as well as a project management consultant. As a consultant, she enjoys working with different clients and the diversity of projects she experiences, from CAD systems for structural steel fabrication to speech-enabled applications for telephone service field technicians and systems to manage hydroelectric power. While she’s sometimes tough on her clients, she is a far worse taskmaster for herself.

Bonnie has written several books, including Troubleshooting Microsoft Project 2002 (Microsoft Press) and The NAIC Stock Selection Handbook (NAIC). Since August 2000 she has been writing for Better Investing magazine a monthly column called Web Watch, which delves into the use of the World Wide Web for investing and how to develop good investing habits and smart and safe computer practices.

She is well known for her clear explanations of technical topics, whether it’s the inscrutable workings of computer software or the enigma of high finance. She applies her education from MIT and Columbia University to digest technical topics and then puts her organizational skills and humor to work to present material that engages beginners and experts alike.

Her education and work experience make her the ideal author for this Visio book. With a Bachelor of Science in Architecture and a Master of Science in Structural Engineering, she is well versed in using Visio for architecture and engineering and integrating it with CAD applications. As a project manager and consultant, she constantly applies Visio to office productivity problems. As a software project manager and application developer, she has also used Visio to document databases, software systems, and networks. As an engineer, she is fascinated with both the simplicity and power of Visio and enjoys experimenting with its customization and automation features.
Credits

Senior Acquisitions Editor
Jim Minatel

Vice President and Publisher
Joseph B. Wikert

Development Editor
James H. Russell

Executive Editorial Director
Mary Bednarek

Technical Editors
Bonnie Watts
Scott Ambler

Project Coordinator
Erin Smith

Production Editor
Eric Newman

Graphics and Production Specialists
Beth Brooks
Carrie Foster
Lauren Goddard
Heather Pope

Copy Editor
Luann Rouff

Quality Control Technician
Charles Spencer
Brian H. Walls

Editorial Manager
Mary Beth Wakefield

Proofreading and Indexing
TECHBOOKS Production Services

Vice President & Executive Group Publisher
Richard Swadley

Vice President and Executive Publisher
Bob Ipsen
To my agent, Neil Salkind, who always believes I’m better than I am and then helps me prove him right.
Visio® 2003 Bible is a comprehensive guide to Microsoft’s popular diagramming software. Covering both Visio Standard and Visio Professional, this book explains Visio fundamentals as well as advanced techniques applicable to any type of diagram. It also describes in detail how to use each of the specialized templates that Visio Standard and Visio Professional offer.

Visio 2003 includes significant changes and enhancements as well as many new features. Many templates and shapes have been improved to look and behave more consistently. Visio 2003 offers several new and improved collaboration tools, such as ink and markup, along with numerous productivity enhancements. However, several features have been discontinued, including the Forms template, the Visio Network Equipment Sampler, and a few wizards and tools. Visio 2003 Bible identifies these new features, enhancements, and changes and differentiates the capabilities available in both the Standard and Professional versions versus those available only in Visio Professional.

Visio 2003 offers a powerful combination of simple concepts and straightforward tools with far-reaching application. Whether you want to communicate basic business processes or highly specialized technical topics, Visio offers tools to simplify your work. This book strives to follow the same model. It explains Visio’s concepts and basic tools in a way that helps beginners get started and more advanced users get better. In addition, the book includes dozens of chapters on specialized templates that describe how the template, tools, and shapes support the work required and simplify typical tasks.

Is This Book for You?

Visio 2003 covers a lot of ground, and this book is right there with it. If you use Visio or want to start using it, you can benefit from reading this book. Beginners can learn the basic concepts and techniques that are the foundation of Visio’s power in every field and then apply those techniques to create the type of diagrams they need. Readers with some Visio experience can learn how to increase their productivity, use specialized templates and employ advanced techniques to draw more effectively or customize solutions. Advanced users can learn about new features, changes, and how to replace the features that have been discontinued in Visio 2003.
Although the book is fast paced, beginners can learn to use Visio, while more advanced users can notch up their productivity by following step-by-step instructions and applying tips and techniques. Readers in a hurry will appreciate the topic organization that makes it easy to find a solution as well as Tips and Cautions that help solve problems quickly.

**Conventions Used in This Book**

To help you get the most from the text and keep track of what’s happening, a number of conventions are used throughout the book:

- When important terms are first introduced, they are highlighted in *italic*.
- Characters that need to be typed in are in **bold**.
- Keyboard strokes appear as follows: Ctrl+A.
- URLs, filenames, directory names, and other program elements are contrasted from regular text in a monospaced font like this.

**Icons Used in This Book**

Following is a brief description of the icons used to highlight certain types of material in this book:

- **Tip**
  - This icon highlights helpful hints, time-saving techniques, or alternative methods for accomplishing tasks.

- **Note**
  - This icon identifies additional information about the topic being discussed.

- **Caution**
  - This icon alerts you to potential problems or methods that can impede your work if not used properly.

- **Cross-Reference**
  - This icon points you to other chapters or books that contain additional information about a topic.

- **New Feature**
  - This icon emphasizes new or significantly enhanced features in Visio 2003.
How This Book Is Organized

Visio 2003 Bible contains 41 chapters, divided into seven parts. In addition, the book is accompanied by a Web site (www.wiley.com/compbooks/biafore) that provides links to all the Web sites referenced in the book and a link to downloadable sample Visio files you can use to practice what you’ve learned. The following sections provide an overview of each part of the book.

Part I: Understanding Visio Fundamentals

Part I introduces the features that distinguish Visio 2003 from the 2002 version as well as Visio’s basic concepts and techniques. The first chapter provides an overview of Visio 2003’s new features and explains concepts such as templates and stencils, drag and drop drawing, and the components of the Visio interface. Chapters 2 and 3 explain how to work with Visio files, drawing tools, drawings, and drawing pages. Chapters 4 and 5 show you how to produce diagrams by creating and editing shapes and connectors. Chapters 6 and 7 introduce techniques to improve the appearance and readability of diagrams using text and formatting.

Part II: Integrating Visio Drawings

Visio 2003 includes many new and improved integration features, as explained in this part. Chapter 8 discusses methods for linking and embedding elements in Visio or linking and embedding Visio objects into other applications. Chapter 9 describes methods for importing and exporting data to and from Visio, in addition to techniques for publishing Visio diagrams to the Web. Chapter 10 covers techniques and procedures for linking Visio shapes with data to dynamically update Visio drawings based on data stored in other applications.

Part III: Using Visio for Office Productivity

Part III is the first of three parts in this book that cover specialized templates. It begins with Chapter 11, which describes new and existing tools for collaborating with others, a critical element to office productivity. Chapters 12 and 13 cover templates for building block diagrams and charts and graphs. Chapter 14 explains the many productivity tools, shapes, wizards, and data-sharing features for documenting organizations in the Organization Chart template. Chapters 15 and 16 explain tools and techniques for documenting flowcharts and business processes. Chapter 17 discusses Visio’s tools for documenting and scheduling projects. Chapter 18 describes the Visio Brainstorming template.
Part IV: Using Visio in Information Technology

Part IV describes the tools, wizards, and shapes that make Visio the most popular tool for documenting software systems and networks. Chapter 19 provides detailed instructions for modeling and documenting databases and database systems using a variety of notations. Chapter 20 describes how to document software systems with the Unified Modeling Language using the modeling tools available with the UML Model template and how to create different types of UML diagrams. Chapter 21 introduces several additional templates for documenting software systems. Chapter 22 describes Visio’s template for mapping Web sites. Chapter 23 describes techniques for creating effective network diagrams and identifies the network features no longer available in Visio 2003.

Part V: Using Visio for Architecture and Engineering

Visio 2003 works for scaled drawings as well as it does for diagrams. Part V covers Visio’s tools for scaled drawings and discusses what Visio can and can’t do for architectural and engineering drawings. Chapter 24 is an introduction to the concepts that underlie scaled drawings, such as scale, units, and dimensions. Chapter 25 describes different methods for creating scaled drawings and how to use layers to manage information. Chapter 26 describes procedures for adding basic plan components, such as walls, windows, doors, and furniture, as well as how to create other types of architectural and engineering plans. Chapter 27 discusses how to use Visio’s Space Plan template to plan space and manage facilities. Chapter 28 describes Visio’s tools for integrating Visio and CAD drawings, which are all based on AutoCAD file formats. Chapter 29 covers Visio’s Electrical Engineering, Mechanical Engineering, and Process Engineering templates.

Part VI: Customizing Templates, Stencils, and Shapes

Part VI returns to Visio concepts and techniques with a focus on customization. Chapter 30 discusses how to create and customize templates so you can start new drawings with the settings you want. Chapter 31 describes techniques for creating and customizing stencils to create custom collections of built-in shapes, shapes you’ve modified, or custom shapes you’ve developed. Chapter 32 discusses techniques for customizing shapes or creating your own and explains how to use custom properties to store data. Chapter 33 digs deeper into customizing shapes by showing you how to modify fields in Visio ShapeSheets or write custom formulas to control shape appearance and behavior. Chapter 34 explains the benefits and techniques for formatting with styles and describes how to create custom line patterns, fill patterns, and line ends. Chapter 35 describes techniques for customizing or creating your own toolbars and menus. Chapter 36 introduces the techniques available for automating Visio, including macros and writing add-ins.
Part VII: Quick Reference

Part VII includes helpful information and reference lists. Chapter 37 describes the process for installing Visio 2003. Chapter 38 provides different sources of help available for Visio 2003, both within the product and online. Chapter 39 identifies additional sources for customized and specialized templates, stencils, and Visio-based solutions. Chapter 40 is a reference to the most helpful keyboard shortcuts. Chapter 41 identifies the templates that Visio Standard and Visio Professional provide and the stencils each one opens.
Acknowledgments

Books are a collaboration of people and talents — and the final product is all the better for it.

My thanks go to my editors, Jim Minatel and James Russell, for their confidence and support; to my technical editors, Bonnie Watts and Scott Ambler, for making sure that the information in this book is not only accurate but practical; and to my copy editor, Luann Rouff, for making sure the whole ball of wax is readable. Thanks also to Teresa Stover, whose meticulous writing and readable style push me to improve.

In addition, my gratitude goes to my husband, Peter Speer, who took care of our life while I wrote this book. Finally, thanks to our dogs, Emma and Shea, who protected my feet, if not our computer cables, these many months.
# Contents at a Glance

**Preface** ................................................. ix  
**Acknowledgments** .................................. xv  

## Part I: Understanding Visio Fundamentals ........................................... 1  
Chapter 1: Getting Started with Visio .................................................. 3  
Chapter 2: Getting Started with Drawings ............................................ 23  
Chapter 3: Working with Visio Files .................................................... 43  
Chapter 4: Working with Shapes ......................................................... 61  
Chapter 5: Connecting Shapes ............................................................. 95  
Chapter 6: Working with Text ............................................................. 107  
Chapter 7: Formatting Visio Elements ................................................... 127  

## Part II: Integrating Visio Drawings ..................................................... 145  
Chapter 8: Inserting, Linking, and Embedding Objects ............................. 147  
Chapter 9: Importing, Exporting, and Publishing Visio Data to the Web ....... 171  
Chapter 10: Linking Shapes with Data .................................................... 187  

## Part III: Using Visio for Office Productivity ......................................... 203  
Chapter 11: Collaborating with Others ................................................... 205  
Chapter 12: Building Block Diagrams .................................................... 223  
Chapter 13: Constructing Charts and Graphs .......................................... 239  
Chapter 14: Working with Organization Charts ....................................... 253  
Chapter 15: Working with Flowcharts ................................................... 271  
Chapter 16: Documenting Business Processes ....................................... 287  
Chapter 17: Scheduling Projects with Visio ............................................ 297  
Chapter 18: Documenting Brainstorming Sessions ................................... 323  

## Part IV: Using Visio in Information Technology ...................................... 339  
Chapter 19: Modeling and Documenting Databases .................................. 341  
Chapter 20: Building UML Models ....................................................... 369  
Chapter 21: Building Software Development Diagrams ............................ 397  
Chapter 22: Mapping Web Sites ........................................................... 415  
Chapter 23: Creating Network Diagrams ............................................... 433
Part V: Using Visio for Architecture and Engineering .......................... 449
Chapter 24: Working with Scaled Drawings ........................................ 451
Chapter 25: Creating Scaled Plan Drawings ......................................... 467
Chapter 26: Laying Out Architectural and Engineering Plans ................. 481
Chapter 27: Planning Space and Managing Facilities ............................. 509
Chapter 28: Integrating CAD and Visio .............................................. 531
Chapter 29: Working with Engineering Drawings ................................. 547

Part VI: Customizing Templates, Stencils, and Shapes ......................... 575
Chapter 30: Creating and Customizing Templates .................................. 577
Chapter 31: Creating and Customizing Stencils .................................... 583
Chapter 32: Creating and Customizing Shapes .................................... 595
Chapter 33: Customizing Shapes Using ShapeSheets ............................... 643
Chapter 34: Formatting with Styles .................................................... 657
Chapter 35: Customizing Toolbars and Menus ...................................... 671
Chapter 36: Automating Visio ............................................................ 681

Part VII: Quick Reference ................................................................. 687
Chapter 37: Installing Visio 2003 ......................................................... 689
Chapter 38: Visio 2003 Help Resources .............................................. 699
Chapter 39: Additional Resources for Templates and Stencils .................. 705
Chapter 40: Keyboard Shortcuts ......................................................... 709
Chapter 41: Template and Stencil Reference ........................................ 717

Index .................................................................................................. 727
Contents

Preface ........................................................................... ix
Acknowledgments .......................................................... xv

Part I: Understanding Visio Fundamentals 1

Chapter 1: Getting Started with Visio ......................... 3
What’s New in Visio 2003? ........................................... 4
New and Improved Shapes and Templates .................... 4
Productivity Enhancements .......................................... 5
Collaboration and Sharing ............................................ 5
Features Discontinued in Visio 2003 ......................... 6
What Visio Is and Isn’t ................................................ 7
Understanding Visio Concepts ..................................... 8
Using Templates and Stencils ..................................... 8
Dragging and Dropping Shapes to Create Drawings ....... 9
Connecting Shapes .................................................... 12
Exploring the Visio 2003 Interface ............................. 14
Menus and Toolbars .................................................. 14
Task Panes ............................................................. 16
The Visio 2003 Drawing Area ..................................... 16
Viewing Drawings ..................................................... 19
Panning and Zooming ............................................... 19
Working with Drawing Windows ................................. 20
Summary .................................................................. 21

Chapter 2: Getting Started with Drawings ................. 23
Creating Drawings ..................................................... 24
Creating Drawings Using Templates ............................ 24
Creating Drawings from Existing Drawings ................. 26
Using the Fundamental Drawing Tools ....................... 26
Speeding Up Drawing with Snap To Tools .................. 26
Drawing Lines .......................................................... 28
Drawing Arcs and Curves .......................................... 28
Drawing Closed Shapes ............................................ 31
Using the Pencil Tool ............................................... 32
## Contents

### Working with Pages
- Creating Pages in a Drawing ........................................... 34
- Setting Up Pages .............................................................. 35
- Editing Pages ...................................................................... 39
  
  **Summary** ........................................................................ 41

### Chapter 3: Working with Visio Files ........................................ 43

- Opening Drawings ............................................................... 43
  - Opening Visio Drawings .................................................... 44
  - Accessing Recently Used Files ........................................... 45
  - Opening Other Types of Files in Visio ............................. 46
- Finding Files ......................................................................... 46
  - Using File Properties to Find Files .................................. 46
  - Searching for Drawing Files ............................................. 47
  - Finding Templates and Sample Drawings ........................... 49
- Saving Files .......................................................................... 50
  - Saving Visio Files ............................................................ 51
  - Protecting Files ............................................................... 53
- Previewing and Printing Drawings ....................................... 54
  - Previewing Drawings ........................................................ 54
  - Printing Drawings ............................................................ 55
  
  **Summary** ........................................................................ 59

### Chapter 4: Working with Shapes ............................................. 61

- Shapes 101 .......................................................................... 62
  - Shape Masters and Instances .............................................. 62
  - Positioning Shapes ............................................................ 62
  - Modifying Shapes ............................................................. 62
  - Groups of Shapes ............................................................. 63
- Finding Shapes ....................................................................... 63
  - Opening Stencils .............................................................. 64
  - Finding Shapes on Drawings .............................................. 64
  - Searching for Shapes ......................................................... 65
- Selecting Shapes .................................................................... 69
  - Selecting Individual Shapes ............................................... 69
  - Selecting Multiple Shapes ................................................ 70
- Positioning Shapes ............................................................... 71
  - Working with Rulers, Grids, and Guides ............................. 71
  - Moving, Rotating, and Flipping Shapes ............................. 75
  - Placing Shapes with Precision .......................................... 76
- Manipulating Shapes ............................................................ 82
  - Undoing Actions and Deleting Shapes ............................... 83
  - Duplicating Shapes ........................................................... 84
  - Resizing and Reshaping Shapes ......................................... 86
Reordering Overlapping Shapes ........................................ 87
Storing Data in Shapes ................................................. 87
Grouping Shapes ........................................................ 88
Labeling and Numbering Shapes ....................................... 90
Summary ................................................................. 92

Chapter 5: Connecting Shapes .......................................... 95
Using Connectors .......................................................... 95
  Using Stencil Connectors .............................................. 97
  Using the Connector Tool ............................................. 98
  Dragging Points to Connect Shapes ................................. 99
  Connecting a Sequence of Shapes .................................... 99
Organizing Connections with Glue ...................................... 100
  Gluing Shapes .......................................................... 100
  Specifying Points for Glue .......................................... 100
Adding, Moving, and Deleting
  Connection Points ..................................................... 101
Automatically Laying Out Shapes ....................................... 102
  Configuring Placement Behavior ................................... 102
  Specifying Layout Options ......................................... 103
  Specifying Layout and Routing Spacing ......................... 105
  Specifying Line Jump Options ..................................... 106
Summary ................................................................. 106

Chapter 6: Working with Text ........................................... 107
Text and Visio ............................................................. 107
  Adding Text to Drawings ............................................ 108
  Displaying Field Information in Text .............................. 110
  Displaying Information in Headers and Footers ............... 112
  Adding Comments to Drawings ...................................... 113
Selecting and Editing Text ............................................... 113
  Selecting Text ........................................................ 114
  Selecting Text in Groups ........................................... 114
  Editing Text .......................................................... 115
  Deleting Text ........................................................ 115
  Finding, Replacing, and Correcting Text ......................... 116
Positioning Text .......................................................... 119
  Repositioning Text in a Shape .................................... 119
  Moving Text Shapes ................................................ 120
  Editing Locked Shapes ............................................... 120
Creating Special Annotations .......................................... 121
  Creating Tables ....................................................... 121
  Using Callouts to Highlight Information ......................... 123
  Using Title Blocks ................................................... 125
Summary ................................................................. 126
Chapter 7: Formatting Visio Elements ........................................... 127
  Applying Formats ............................................................ 127
  Applying Formats to Lines .............................................. 128
  Applying Formats to Text ............................................... 129
  Applying Fill Formats .................................................... 133
  Formatting Shapes ........................................................ 133
  Formatting with Styles ..................................................... 136
  Applying Styles ............................................................. 137
  Restoring Default Styles ................................................ 138
  Working with Colors ....................................................... 138
    Using the Color Palette .............................................. 139
    Working with Color Schemes ........................................ 141
    Specifying Basic Color Settings ................................... 142
  Color-Coding Shapes ..................................................... 143
  Summary ........................................................................ 144

Part II: Integrating Visio Drawings ........................................... 145

Chapter 8: Inserting, Linking, and Embedding Objects ................. 147
  Understanding Linking and Embedding ................................ 148
  Linking Elements ............................................................ 148
    Using Hyperlinks ......................................................... 150
    Linking Visio Drawings with Microsoft Office Files ......... 154
  Embedding Objects ........................................................ 158
    Embedding Files and Fragments As Objects .................. 158
    Positioning and Formatting Embedded Objects ............ 160
    Editing the Content of Embedded Objects ................. 162
  Inserting Graphics in Visio ................................................ 163
    Inserting Graphics Files ............................................ 163
    Searching for and Inserting Clip Art ......................... 163
    Inserting Pictures from Digital Devices .................... 164
  Fine-Tuning Visio Drawings for PowerPoint ...................... 164
    Formatting Visio Drawings in a Presentation ............ 165
    Building Drawings in a Presentation ......................... 167
  Summary ........................................................................ 170

Chapter 9: Importing, Exporting, and Publishing Visio Data to the Web ................................................................. 171
  Formats for Importing and Exporting .................................. 172
    Using Template Tools to Import and Export ............... 173
    Exploring the New SVG Format ................................... 173
  Importing Data into Visio .................................................. 174
    Importing Graphic Files into Visio ......................... 174
    Importing Your Outlook Appointments to a Visio Calendar ... 175
Exporting Shapes and Drawings ........................................ 176
Publishing to the Web .................................................... 177
  Choosing an Output Format for a Visio Web Page ............. 177
  Saving Drawings As Web Pages ................................... 179
  Specifying Web Page Publishing Options ..................... 180
  Embedding Visio Drawings in Web Pages ....................... 183
  Adding Hyperlink Navigation Shapes to Drawings ............ 183
Summary ........................................................................ 185

Chapter 10: Linking Shapes with Data ............................. 187
Understanding Links Between Shapes and Databases .......... 188
Linking Drawings to Databases ....................................... 190
  Limitations of the Database Wizard ............................. 191
  Creating Connections to Data Sources ....................... 191
  Linking Drawing Shapes to Database Records ............. 193
  Linking Masters to Databases ..................................... 194
  Creating Drawings from Database Records ................... 196
Exporting Shape Data to Databases ................................ 198
Keeping Drawings and Databases in Sync ....................... 199
  Adding Drawing Page Commands to Synchronize Shapes .. 200
  Adding Actions and Events to Shapes ...................... 201
  Synchronizing Shapes and Database Records Automatically 201
Summary ........................................................................ 202

Part III: Using Visio for Office Productivity .................. 203

Chapter 11: Collaborating with Others .......................... 205
Distributing Drawings .................................................... 206
  Sending Drawings Using E-Mail ................................. 206
  Routing Drawings ..................................................... 206
  Distributing Drawings to Exchange Folders .................. 207
Sharing Drawings .......................................................... 208
  Sharing Drawings with Colleagues Without Visio .......... 208
  Working with Document Workspaces ....................... 209
Working with Multiple Languages ................................. 215
  Configuring Windows for Multiple Languages .......... 216
  Configuring Office for Multiple Languages .............. 216
  Installing IME for Asian Characters ....................... 216
Tracking and Reviewing Changes .................................. 217
  Turning Markup On or Off ...................................... 217
  Marking Up Drawings ............................................. 218
  Reviewing Markup .................................................. 221
  Updating Drawings with Markup Changes .................. 221
Summary ........................................................................ 221
## Chapter 12: Building Block Diagrams ................................. 223
- Exploring the Block Diagram Templates .......................... 223
- Choosing the Right Template .................................... 224
- Exploring Block Diagram Shapes ................................. 225
- Showing Structure and Flow ........................................ 227
- Creating Block Diagrams ........................................... 227
- Modifying Block Diagrams .......................................... 228
- Creating Hierarchical Trees ........................................ 231
- Modifying Tree Shapes ............................................. 232
- Adding Impact with 3D Block Diagrams ......................... 233
- Modifying Perspective ............................................. 234
- Using Multiple Vanishing Points .................................. 234
- Working with Onion Diagrams ..................................... 235
- Creating Onion Diagrams .......................................... 235
- Modifying Onion Diagram Shapes ................................. 235
- Summary ............................................................... 238

## Chapter 13: Constructing Charts and Graphs ......................... 239
- Exploring the Chart and Graph Templates ......................... 240
- Choosing the Right Template .................................... 240
- Exploring Visio Chart and Graph Shapes ......................... 240
- Constructing Basic Charts and Graphs ............................ 243
- Constructing Bar Graphs .......................................... 243
- Constructing Line Graphs .......................................... 246
- Labeling Axes ....................................................... 246
- Working with Pie Charts .......................................... 247
- Creating Feature Comparison Charts .............................. 248
- Working with Marketing Diagrams ................................. 249
- Building Circle-Spoke Drawings .................................. 249
- Constructing Triangles and Pyramids ............................ 250
- Adding Text to Charts and Graphs ................................. 251
- Using Stackable and Extendable Shapes ......................... 251
- Summary ............................................................... 252

## Chapter 14: Working with Organization Charts ....................... 253
- Exploring the Organization Chart Template ...................... 254
- Exploring the Organization Chart Tools ......................... 254
- Exploring Visio’s Organization Chart Shapes .................... 255
- Creating Organization Charts Manually .......................... 256
- Creating Organization Charts Using the Organization Chart Wizard ........................................... 257
- Building a File for Organization Data Using the Organization Chart Wizard ..................................... 258
- Using Existing Organization Data ................................ 259
- Finalizing the Chart .................................................. 261
Chapter 17: Scheduling Projects with Visio .................................. 297
  Exploring the Project Scheduling Templates .................................. 298
  Constructing Calendars .......................................................... 298
    Creating Daily Calendars .................................................. 299
    Creating Weekly Calendars .................................................. 299
    Creating Monthly Calendars ............................................... 299
    Creating Yearly Calendars ................................................. 300
  Working with Calendars .................................................... 301
  Working with Appointments and Events .................................. 301
  Importing Outlook Calendar Data into Visio .................................. 303
  Documenting Project Timelines ............................................. 304
    Creating Timelines ......................................................... 305
    Expanding Timelines ..................................................... 306
    Synchronizing Milestones and Intervals .................................. 308
    Modifying Timelines ..................................................... 308
  Importing and Exporting Timeline Data .................................. 309
  Scheduling Projects Using Gantt Charts ................................... 311
    Creating Gantt Charts ...................................................... 312
    Modifying the Content in Gantt Charts .................................. 316
    Formatting Gantt Charts ................................................... 317
    Importing and Exporting Gantt Chart Data .................................. 317
  Building PERT Charts .......................................................... 319
    Creating PERT Charts ....................................................... 320
    Summarizing Projects on PERT Charts .................................. 321
  Summary ............................................................................. 322

Chapter 18: Documenting Brainstorming Sessions .......................... 323
  Exploring the Brainstorming Template ....................................... 323
    Accessing Visio Brainstorming Tools ....................................... 324
    Exploring the Brainstorming Outline Features .......................... 325
    Exploring Visio's Brainstorming Shapes .................................. 325
  Creating Brainstorming Diagrams ............................................. 326
    Adding and Connecting Topics ............................................. 326
    Connecting Topics Manually ................................................. 329
  Laying Out Brainstorming Diagrams ......................................... 329
    Moving and Reordering Topics ............................................. 330
    Changing Layout and Connector Styles .................................. 331
    Resizing the Page to Fit the Diagram ..................................... 331
  Enhancing Brainstorming Diagram Appearance .......................... 332
  Working with Legends ........................................................... 332
    Adding Symbols to Topics ................................................... 334
    Creating and Configuring Legends ......................................... 334
  Importing and Exporting Brainstorming Data ............................. 336
  Summary ............................................................................. 336
## Part IV: Using Visio in Information Technology 339

### Chapter 19: Modeling and Documenting Databases 341

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exploring the Database Model Templates</td>
<td>342</td>
</tr>
<tr>
<td>Exploring Database Model Shapes</td>
<td>343</td>
</tr>
<tr>
<td>Updating Database Shapes</td>
<td>343</td>
</tr>
<tr>
<td>Creating Database Models</td>
<td>344</td>
</tr>
<tr>
<td>Building Database Models from Scratch</td>
<td>344</td>
</tr>
<tr>
<td>Importing Database Models from Other Applications</td>
<td>345</td>
</tr>
<tr>
<td>Reverse Engineering an Existing Database</td>
<td>345</td>
</tr>
<tr>
<td>Updating Reverse-Engineered Database Models</td>
<td>348</td>
</tr>
<tr>
<td>Working with Database Models</td>
<td>348</td>
</tr>
<tr>
<td>Working in the Database Windows</td>
<td>348</td>
</tr>
<tr>
<td>Working with Tables and Columns</td>
<td>352</td>
</tr>
<tr>
<td>Defining Database Views</td>
<td>357</td>
</tr>
<tr>
<td>Creating Relationships Between Tables</td>
<td>358</td>
</tr>
<tr>
<td>Creating and Editing Indexes</td>
<td>359</td>
</tr>
<tr>
<td>Editing Database Code</td>
<td>360</td>
</tr>
<tr>
<td>Setting Database Options and Preferences</td>
<td>361</td>
</tr>
<tr>
<td>Setting Modeling Preferences</td>
<td>362</td>
</tr>
<tr>
<td>Specifying Notation and Other Display Options</td>
<td>363</td>
</tr>
<tr>
<td>Creating Express-G and ORM Diagrams</td>
<td>363</td>
</tr>
<tr>
<td>Using Express-G to Create Entity-Level and Schema-Level Diagrams</td>
<td>364</td>
</tr>
<tr>
<td>Creating Object Role Model Diagrams</td>
<td>365</td>
</tr>
<tr>
<td>Summary</td>
<td>367</td>
</tr>
</tbody>
</table>

### Chapter 20: Building UML Models 369

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exploring the UML Model Diagram Template</td>
<td>370</td>
</tr>
<tr>
<td>Choosing the Right UML Diagram</td>
<td>371</td>
</tr>
<tr>
<td>Exploring the UML Menu</td>
<td>373</td>
</tr>
<tr>
<td>Updating UML Shapes</td>
<td>374</td>
</tr>
<tr>
<td>Working with UML Models</td>
<td>374</td>
</tr>
<tr>
<td>Working with the Model Explorer</td>
<td>374</td>
</tr>
<tr>
<td>Using the UML Model Windows</td>
<td>376</td>
</tr>
<tr>
<td>Organizing Models with Packages</td>
<td>377</td>
</tr>
<tr>
<td>Working with Shapes and Model Elements</td>
<td>378</td>
</tr>
<tr>
<td>Specifying UML Options</td>
<td>380</td>
</tr>
<tr>
<td>Creating UML Models</td>
<td>381</td>
</tr>
<tr>
<td>Working with Static Structure Diagrams (UML 2 Class Diagrams)</td>
<td>382</td>
</tr>
<tr>
<td>Creating Use Case Diagrams</td>
<td>385</td>
</tr>
<tr>
<td>Creating Activity Diagrams</td>
<td>386</td>
</tr>
<tr>
<td>Creating State Machine Diagrams</td>
<td>388</td>
</tr>
<tr>
<td>Creating Sequence Diagrams</td>
<td>389</td>
</tr>
</tbody>
</table>
Creating Collaboration Diagrams ............................................. 390
Creating Component Diagrams ............................................. 391
Creating Deployment Diagrams ............................................. 392
Reverse Engineering Code into UML Models ......................... 393
  Reverse Engineering Visual C++ Code ............................. 394
  Reverse Engineering Visual Basic Code .......................... 395
Summary .................................................................................. 396

Chapter 21: Building Software Development Diagrams .............. 397
  Choosing the Right Software Template ................................ 398
  Constructing COM and OLE Diagrams ................................ 399
    Understanding the Elements of COM ............................... 399
    Creating COM and OLE Diagrams .................................. 400
  Creating Data Flow Diagrams ............................................. 401
  Creating Software Diagrams with Jackson Notation ............... 402
    Creating System Network Diagrams ............................... 402
    Creating Jackson Data or Program Structure Diagrams ........ 403
  Modeling Large-Scale Application Architectures .................. 405
  Creating Program Structure Diagrams ................................ 405
  Modeling Real Time Systems with ROOM Diagrams ............... 406
  Prototyping User Interfaces .............................................. 407
    Exploring the Windows XP User Interface Template .......... 407
    Creating an Application Window .................................... 408
    Prototyping Wizards .................................................. 409
    Building Menus and Toolbars ....................................... 411
    Designing Dialog Boxes .............................................. 413
Summary .................................................................................. 414

Chapter 22: Mapping Web Sites .............................................. 415
  Exploring the Web Diagram Templates ............................... 415
  Planning Web Sites ......................................................... 416
    Creating Conceptual Web Diagrams ............................... 417
    Fine-tuning Conceptual Web Diagrams ............................ 418
  Working with Web Site Maps ............................................ 419
    Generating Maps of Existing Web Sites ......................... 421
    Configuring the Content and Format of Site Maps ............ 422
    Viewing Site Maps ...................................................... 423
    Working with the Web Site Map Memory Model ................ 425
    Formatting Web Site Maps ............................................ 427
    Identifying Web Site Problems ...................................... 429
Summary .................................................................................. 431

Chapter 23: Creating Network Diagrams ................................ 433
  Exploring Network Templates ............................................ 434
  What’s New in the Network Templates? ............................... 434
  What’s Missing? .............................................................. 434
  Choosing the Right Template ............................................. 435
Chapter 26: Laying Out Architectural and Engineering Plans . . . . 481

Working with Walls ............................................................... 482
  Converting Spaces into Walls ........................................... 482
  Creating Walls ................................................................. 484
  Connecting and Resizing Walls ........................................ 485
  Modifying a Wall’s Properties and Appearance .................. 486
Adding Doors, Windows, and Other Openings ......................... 487
  Adding Openings to Walls ............................................... 487
  Modifying Doors, Windows, and Openings ......................... 488
Adding Cubicles and Furniture .............................................. 490
  Adding Cubicles to an Office Layout ................................ 490
  Connecting Modular Furniture ....................................... 491
  Modifying Cubicles ......................................................... 492
Creating Building Services Plans ......................................... 493
  Adding HVAC Services .................................................... 493
  Adding Electrical and Telecom Services ......................... 498
  Adding Plumbing ............................................................ 499
  Adding Security and Access Systems ............................... 500
Creating Site and Landscaping Plans ..................................... 500
  Adding Landscaping Elements ...................................... 501
  Working with Roads and Parking Lots .............................. 501
Drawing Directional Maps .................................................... 503
  Creating Road and Metro Maps ...................................... 504
  Modifying Roads and Intersections ................................. 504
  Using 3-D Map Shapes ................................................... 505
Labeling and Numbering Plans ............................................ 505
Summary ............................................................................. 507

Chapter 27: Planning Space and Managing Facilities ................. 509

Understanding Space Planning and Facilities Management Using Visio 510
Exploring the Space Plan Template ....................................... 512
  Menus and Stencils .......................................................... 512
  Using the Space and Category Explorers ......................... 512
Creating Space Plans .......................................................... 514
  Using the Space Plan Startup Wizard ............................... 515
  Adding Spaces Using the Import Data Wizard .................. 516
  Using Shapes to Create Space Plans ............................... 516
Assigning Resources to Space Plans ..................................... 519
  Adding Resources to Space Plans .................................. 520
  Assigning Categories to Resources ............................... 521
Using Visio Space Plans to Manage Facilities ......................... 522
  Importing Facilities Data into Space Plans .................... 522
  Labeling Facilities Shapes ............................................. 525
  Color-Coding Space Plans ............................................. 527
  Finding and Moving Resources .................................... 527
  Generating Facilities Reports ....................................... 528
Summary ............................................................................. 529
Chapter 28: Integrating CAD and Visio .......................................................... 531
Understanding CAD and Visio Integration ................................................. 532
Displaying CAD Drawings in Visio ............................................................. 534
  Inserting CAD Drawings into Visio ......................................................... 534
  Displaying CAD Layers in Visio ............................................................. 535
  Reviewing CAD Drawings in Visio ......................................................... 535
Modifying Inserted CAD Drawings ............................................................ 536
  Modifying Units and Scale ................................................................. 536
  Protecting Inserted CAD Drawings ....................................................... 539
  Positioning and Resizing Inserted CAD Drawings ............................... 540
Converting CAD Drawings to Visio Format ............................................. 541
  The Disadvantages of CAD Conversion ............................................... 542
Converting Multiple CAD Drawings ....................................................... 544
Creating Stencils from CAD Libraries ..................................................... 545
Converting Visio Drawings to CAD Format ............................................. 545
Summary .................................................................................................... 546

Chapter 29: Working with Engineering Drawings .................................. 547
Exploring Visio’s Engineering Templates .................................................. 548
Using Basic Visio Techniques in Engineering Drawings ........................ 549
Working with Mechanical Engineering Drawings ................................... 550
  Drawing Parts and Assemblies .............................................................. 550
  Constructing Fluid Power Diagrams ....................................................... 554
Working with Electrical Engineering Drawings ....................................... 556
Building Process Engineering Models ..................................................... 557
  Using Process Engineering Views ......................................................... 558
  Updating Process Engineering Projects from Visio 2000 ...................... 560
Creating P&ID and PFD Drawings .......................................................... 561
Building Pipelines .................................................................................... 563
Working with Components ....................................................................... 565
  Associating Shapes with Components .................................................. 566
  Working with Component Data ............................................................ 566
  Tagging and Numbering Components .................................................. 568
  Generating Component Lists and Bills of Material .............................. 571
  Converting Shapes and Symbols into Components ............................. 572
Summary .................................................................................................... 573

Part VI: Customizing Templates, Stencils, and Shapes .......................... 575

Chapter 30: Creating and Customizing Templates .................................. 577
Reasons to Customize Templates .............................................................. 578
Customizing Templates ............................................................................ 578
  Creating and Saving Customized Templates ........................................ 578
  Setting Up a File for Use as a Template .............................................. 579
Accessing Customized Templates ............................................................ 580
Summary .................................................................................................... 582
# Chapter 31: Creating and Customizing Stencils

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating and Saving Stencils</td>
<td>583</td>
</tr>
<tr>
<td>Creating a Stencil from an Existing Stencil</td>
<td>584</td>
</tr>
<tr>
<td>Creating Stencils from Shape Search Results</td>
<td>585</td>
</tr>
<tr>
<td>Creating Stencils from Scratch</td>
<td>585</td>
</tr>
<tr>
<td>Creating a Custom Stencil from a Document Stencil</td>
<td>585</td>
</tr>
<tr>
<td>Quickly Storing Your Favorite Shapes</td>
<td>586</td>
</tr>
<tr>
<td>Saving Stencils</td>
<td>587</td>
</tr>
<tr>
<td>Adding Shapes to Stencils</td>
<td>588</td>
</tr>
<tr>
<td>Adding Shapes from Drawing Pages</td>
<td>589</td>
</tr>
<tr>
<td>Adding Shapes from Other Stencils</td>
<td>590</td>
</tr>
<tr>
<td>Modifying Stencil Appearance</td>
<td>591</td>
</tr>
<tr>
<td>Displaying Master Information</td>
<td>591</td>
</tr>
<tr>
<td>Changing Spacing and Color Settings</td>
<td>592</td>
</tr>
<tr>
<td>Rearranging Shapes in Stencils</td>
<td>592</td>
</tr>
<tr>
<td>Summary</td>
<td>593</td>
</tr>
</tbody>
</table>

# Chapter 32: Creating and Customizing Shapes

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding Shapes and Shape Properties</td>
<td>595</td>
</tr>
<tr>
<td>What Makes Shapes Smart?</td>
<td>596</td>
</tr>
<tr>
<td>Understanding Shapes and Masters</td>
<td>597</td>
</tr>
<tr>
<td>Understanding Shape Geometry</td>
<td>597</td>
</tr>
<tr>
<td>Creating and Editing Masters</td>
<td>600</td>
</tr>
<tr>
<td>Creating Masters</td>
<td>600</td>
</tr>
<tr>
<td>Modifying Masters</td>
<td>602</td>
</tr>
<tr>
<td>Drawing Shapes and Masters</td>
<td>608</td>
</tr>
<tr>
<td>Drawing Line Segments and Paths</td>
<td>609</td>
</tr>
<tr>
<td>Creating Closed Shapes</td>
<td>609</td>
</tr>
<tr>
<td>Drawing Graphics Precisely</td>
<td>610</td>
</tr>
<tr>
<td>Creating and Editing Shapes with the Pencil Tool</td>
<td>612</td>
</tr>
<tr>
<td>Transforming Shapes into New Ones</td>
<td>613</td>
</tr>
<tr>
<td>Assembling and Disassembling 2-D Shapes</td>
<td>614</td>
</tr>
<tr>
<td>Manipulating Lines</td>
<td>619</td>
</tr>
<tr>
<td>Customizing Connection Points</td>
<td>620</td>
</tr>
<tr>
<td>Adding, Moving, and Deleting Connection Points</td>
<td>621</td>
</tr>
<tr>
<td>Working with Types of Connection Points</td>
<td>621</td>
</tr>
<tr>
<td>Customizing Shape Behavior</td>
<td>623</td>
</tr>
<tr>
<td>Specifying Double-Click Behavior for Shapes</td>
<td>623</td>
</tr>
<tr>
<td>Specifying Placement Behavior</td>
<td>625</td>
</tr>
<tr>
<td>Modifying Other Shape Behaviors</td>
<td>626</td>
</tr>
<tr>
<td>Adding Screen Tips to Shapes</td>
<td>630</td>
</tr>
<tr>
<td>Working with Custom Properties</td>
<td>630</td>
</tr>
<tr>
<td>Creating and Editing Custom Properties</td>
<td>631</td>
</tr>
<tr>
<td>Using Custom Property Sets</td>
<td>634</td>
</tr>
</tbody>
</table>
## Contents

Producing Reports with Custom Property Data ........................................... 637
  Defining Custom Reports ................................................................. 637
  Running Reports with Custom Property Data ....................................... 641
Summary ..................................................................................................... 641

**Chapter 33: Customizing Shapes Using ShapeSheets** ......................... 643
Viewing ShapeSheets ............................................................................. 644
  Opening ShapeSheets .......................................................................... 644
  Viewing and Adding ShapeSheet Sections .......................................... 645
Exploring ShapeSheet Sections .............................................................. 647
Writing ShapeSheet Formulas ................................................................. 652
  Exploring the Elements of Formulas .................................................. 653
  Creating Formulas .............................................................................. 653
Summary ..................................................................................................... 654

**Chapter 34: Formatting with Styles** ..................................................... 657
Working with Styles ................................................................................. 658
Creating and Editing Styles ................................................................. 660
  Creating Styles ..................................................................................... 660
  Editing Styles ....................................................................................... 662
Creating Custom Patterns ................................................................. 663
  Designing Pattern Shapes ................................................................. 664
  Designing Line Patterns ..................................................................... 665
  Designing Line End Patterns ............................................................ 667
  Designing Fill Patterns ....................................................................... 667
Creating New Custom Patterns ............................................................. 669
  Creating a New Pattern ...................................................................... 669
  Sizing Line Ends ................................................................................. 670
Summary ..................................................................................................... 670

**Chapter 35: Customizing Toolbars and Menus** .................................. 671
Customizing Toolbars and Menus ......................................................... 671
  Customizing Toolbars ....................................................................... 672
  Customizing Menus ........................................................................... 674
  Creating Toolbars and Menus ............................................................ 675
Modifying Toolbars and Menus .............................................................. 676
  Renaming Toolbars and Menus .......................................................... 676
  Grouping Commands and Menus ....................................................... 676
  Changing the Width of a Drop-down List ......................................... 676
  Modifying the Appearance of an Entry ............................................. 677
  Modifying Button Images .................................................................. 677
Creating Keyboard Shortcuts ................................................................. 678
Sharing Customized Toolbars and Menus ................................................ 678
Summary ..................................................................................................... 679
## Chapter 36: Automating Visio

- What’s New for Developers in Visio 2003 ........................................... 682
- Working with Macros ................................................................. 682
- Writing Add-Ins to Automate Visio ............................................. 684
- Using the Visio Drawing Control .................................................. 685
- Learning More About Automating Visio ....................................... 686
- Summary ..................................................................................... 686

## Part VII: Quick Reference

### Chapter 37: Installing Visio 2003 ................................................. 689

- Exploring Visio Installation Methods ........................................... 689
  - Using a Local Installation Source ............................................. 690
  - Deploying with an Administrative Installation Point ............... 690
  - Using a Compressed CD Image ................................................. 691
- Installing Visio on Your Computer ............................................... 691
  - Installing When a Previous Version Is Present ......................... 692
  - Using the Microsoft Windows Installer ..................................... 692
- Activating a New Visio Installation ............................................. 694
- Maintaining and Repairing Visio ................................................. 695
  - Adding and Removing Components ........................................ 696
  - Repairing Your Visio Installation ............................................. 696
- Learning More About Your Version of Visio ............................... 697
- Summary ..................................................................................... 698

### Chapter 38: Visio 2003 Help Resources ....................................... 699

- The Getting Started Tutorial ....................................................... 699
- Finding Help About Visio .......................................................... 700
  - Viewing Visio Help Topics ...................................................... 700
  - Configuring Your Help Settings .............................................. 701
  - Searching the Microsoft Knowledge Base ............................... 702
  - Working with Visio Task Panes ............................................... 703
- Other Helpful Resources ............................................................ 704
- Summary ..................................................................................... 704

### Chapter 39: Additional Resources for Templates and Stencils .......... 705

- Using the Diagram Gallery ........................................................ 705
- Exploring the Visio Extras Stencils ............................................ 706
- Finding Templates and Samples at Microsoft Office Online ........ 707
- Finding Third-party Visio Templates and Stencils ....................... 707
- Summary ..................................................................................... 708
Chapter 40: Keyboard Shortcuts ........................................ 709
Using Keyboard Shortcuts ............................................. 709
Handy Keyboard Shortcuts .............................................. 710
  File Shortcuts ....................................................... 710
  Action Shortcuts ...................................................... 710
  Editing and Formatting Shortcuts ............................... 710
  Window and Viewing Shortcuts ................................. 711
  Zoom Shortcuts ..................................................... 712
  Tool Shortcuts ....................................................... 712
  Shape Shortcuts ...................................................... 712
  Dialog Box Shortcuts ............................................. 713
  Edit Box Shortcuts .................................................. 713
  Menu and Toolbar Shortcuts ................................... 714
  Help Shortcuts ....................................................... 714
Summary ...................................................................... 715

Chapter 41: Template and Stencil Reference .................... 717
Templates for Office Productivity .................................. 718
Templates for Information Technology .......................... 720
Templates for Architecture and Engineering ................ 722
Visio Extras Stencils ..................................................... 725
Summary ...................................................................... 726

Index ........................................................................... 727
Understanding Visio Fundamentals

In This Part

Chapter 1
Getting Started with Visio

Chapter 2
Getting Started with Drawings

Chapter 3
Working with Visio Files

Chapter 4
Working with Shapes

Chapter 5
Connecting Shapes

Chapter 6
Working with Text

Chapter 7
Formatting Visio Elements
Humans are visual creatures, so it isn’t surprising that we visualize and communicate our ideas, designs, and final products graphically. In the past, high-quality graphics were the work of professional graphic artists and illustrators, but with Visio 2003, anyone can produce informative and attractive diagrams, drawings, and models. Visio is so straightforward that you can use it to capture the fast-paced output of brainstorming sessions or the frequent changes made to initial designs and models. At the same time, Visio is powerful enough to develop sophisticated models, and precise enough to document the details of existing systems.

Visio 2003 is like a good friend with expertise in dozens of fields. It jumpstarts your efforts with solutions designed specifically to produce different types of drawings. Visio templates set up your work environment with menus of specialized tools, sets of predefined shapes, and drawing settings such as page size and orientation typical for the type of drawing you want to create. Visio stencils categorize thousands of predefined symbols by industry, drawing type, and application. These Visio SmartShapes have built-in behaviors and properties to help you quickly assemble drawings and collect information.

Simplicity and convenience are key to Visio’s power. To construct a drawing, you drag and drop predrawn shapes from stencils onto drawing pages. Defining relationships between shapes is as easy as dropping one shape onto another or dragging and dropping connectors onto shapes. Specialized tools help lay out drawings and perform typical tasks. The simplicity of integrating Visio with tools such as Microsoft Office, AutoCAD, Adobe Framemaker, and database management systems makes it easy to maintain drawings and documentation of systems.
What’s New in Visio 2003?

Visio 2003 delivers brand-new templates and shapes as well as significant improvements and enhancements to many existing ones. In addition, Visio 2003 includes new and improved features to boost your productivity and enhance collaboration with others. You can send Microsoft feedback about the product or rate the usefulness of help topics and templates.

Look for the New Feature icon throughout this book to learn more about what’s new and improved.

New and Improved Shapes and Templates

The Visio team expands the scope of the product with every release. Visio 2003 introduces the following new templates and shapes:

- **Business Process templates** — New templates for event-driven process chains, fault tree analysis, and work flow, plus a new home for other business process templates
- **Brainstorming** — A replacement for the Mind Mapping template
- **Timeline** — A new template for documenting project timelines
- **Space Plan Startup Wizard** (Visio Professional only) — A new tool for building space plans quickly
- **Detailed Network Diagram** (Visio Professional only) — A replacement for the Logical Network Diagram
- **Rack Diagram** (Visio Professional only) — A new template for designing equipment placement in racks
- **Windows XP User Interface** (Visio Professional only) — A new template for designing Windows XP user interfaces

You’ll appreciate the enhancements added to many existing templates and shapes, including the following:

- Calendar
- Organization Chart
- Basic Network Diagram
- Space Plan Import Data Wizard (Visio Professional only)
- Web Site Map (Visio Professional only)
- Electrical Engineering (Visio Professional only)
- Building Plan (Visio Professional only)
Productivity Enhancements

Visio enhances its reputation for being quick and easy with the following new features:

✦ **Task panes** — You can access many of Visio’s most popular features on ten new task panes, which are docked to the right of the drawing page by default.

✦ **Shape management** — You can find shapes faster with Search for Shapes, an improved replacement for the Find Shape feature. You can organize your frequently used shapes on the Favorites stencil or add them to custom stencils, which you can store in the new My Shapes folder for easy access.

✦ **Editing tools** — Shapes now include rotation handles so you can rotate them without switching drawing tools. To select multiple shapes, you can choose from the Pointer, Lasso Select, or Multiple Select tools. It’s also easier to coordinate colors if you use templates with built-in color schemes.

✦ **Getting started** — The Diagram Gallery provides an overview of Visio drawing types to help you select an appropriate template. Microsoft Office Online includes additional templates and clip art, as well as starter drawings that already contain basic content to get you going. For an introduction to Visio’s features, you can use the Getting Started Tutorial on the Visio Help menu.

✦ **CAD integration** — The DWG Converter produces more accurate Visio representations of your original CAD drawings.

✦ **Help resources** — Online help from Microsoft Office Online provides up-to-the-minute help and in-depth articles about Visio and other Office applications. The Help and Template Help task panes provide access to almost all of Visio’s help resources, with a few more on the Visio Help menu and online. You can pause the pointer over a shape on a stencil to view a description and access a Help link.

✦ **Customer feedback** — You can help improve future versions of Visio by choosing to participate in the Customer Experience Improvement Program, in which Microsoft collects information about your hardware configuration and how you use Microsoft Office programs. In addition, you can provide feedback about programs, the effectiveness of help topics, templates, and Microsoft Office Online content.

✦ **Features for developers** — In addition to a Visio 2003 ActiveX control for incorporating Visio into host applications, developers can increase their productivity with new ShapeSheet functions, keyboard and mouse events, and other tools. New interface elements such as ShapeStudio and the Formula Tracing window make it easier to create SmartShapes. (Visio Professional only)

Collaboration and Sharing

Collaboration and the subsequent sharing of documents are key initiatives for Microsoft today. Visio 2003 includes a number of new features to simplify collaboration with your colleagues:
✦ **Track markup** — You can propose changes to drawings and review the changes proposed by your coworkers. Each person’s changes appear in a unique color on a separate overlay.

✦ **Ink** — You can add hand-drawn shapes or handwritten notes to drawings using a tablet PC or any computer with an electronic pen device. You can edit Ink shapes or add them to stencils just like other Visio shapes.

✦ **Scalable Vector Graphic format** — Visio 2003 now supports the Scalable Vector Graphics (SVG) format.

✦ **Microsoft Office Visio Viewer 2003** — People who don’t have Visio can view and print your Visio drawings after downloading the Visio Viewer from the Microsoft Download Center.

✦ **Document Workspaces** — People can collaborate on documents stored in Document Workspaces, which are Microsoft Windows SharePoint Services sites. Contributors can work on the master copy in the Document Workspace or edit their own copy, which they can synchronize periodically with the master.

✦ **Language handling** — Visio 2003 supports Unicode, End User Defined Character sets, and the new Chinese character-encoding standard, GB18030. In addition, Multilingual User Interface packs simplify Visio deployment in global enterprises by displaying text for the user interface, Help, and wizards in other languages.

### Features Discontinued in Visio 2003

A few templates and tools are no longer available. However, you can search Microsoft Office Online or other Web sites for replacements.

To find other sources for Visio shapes and templates, refer to Chapter 39.

✦ **Data Flow Model Diagram Model Explorer** (Visio Professional only) — The Data Flow Model Diagram template no longer contains the Model Explorer. However, the UML template still has its Model Explorer.

✦ **Directory Services Directory Navigator** (Visio Professional only) — The Directory Services Diagram template no longer contains the Directory Navigator.

✦ **Forms** — The Forms template is no longer available. You can use Microsoft’s new product, Infopath, to build forms and communicate data.

✦ **Import Flowchart Data Wizard** — You must import data into a flowchart in an earlier version of Visio and save the result in that version. You can then open the file in Visio 2003.

✦ **Organization Chart Conversion Utility** — You must convert an organization chart in an earlier version of Visio and save the result in that version. You can then open the organization chart in Visio 2003.
Visio Network Equipment Sampler (Visio Professional only) — Shapes in the VNE Sampler are no longer available, but many equipment manufacturers provide shapes for their equipment on their Web sites.

Visio has dropped support for the following file formats and their converters:

- Adobe Illustrator
- ABC Flow Charter, versions 2.0, 3.0, and 4.0
- CorelDRAW!, versions 3.0 through 7.0
- CorelFLOW 2.0
- Corel Clipart
- Computer Graphics Metafile
- Microstation (DGN)
- MicroGrafx Designer 3.1
- MicroGrafx Designer 6.0 English
- Postscript and Encapsulated Postscript
- Initial Graphics Exchange Specification
- ZSoft PC Paintbrush (PCX)
- Mac Clipboard
- Text Files (TXT) and Comma Separated Values (CSV)

What Visio Is and Isn’t

Visio can be many things to many people. Applied properly, Visio 2003 can help you produce simple diagrams or complex models. These far-reaching capabilities can be confusing if you don’t understand how they differ. Even worse, you can become quite frustrated if you try to use Visio for tasks for which it wasn’t designed.

Many drawings are simple diagrams with some basic connections and little or no associated data. For these drawings, you can simply drag and drop shapes and connectors in either Visio Standard or Visio Professional. The remaining chapters in Part I, Understanding Visio Fundamentals, describe the basic tools you need to diagram with Visio.

However, Visio Professional can also produce intelligent models and specialized documentation for numerous fields, including software engineering, architecture, mechanical and electrical engineering, and business process modeling. Templates for these advanced applications contain tools for performing specialized tasks. The shapes contained in the stencils for these templates have smart features —
built-in behaviors and attributes that fit the shapes to their role. For instance, intersecting walls in building plans are smart enough to clean up their overlapping lines. Cubicle shapes might contain properties that identify the people occupying the enclosed space for occupancy reports. These features are time-savers when you know how to use them, but can make Visio seem to have a mind of its own when you don’t. Parts III, IV, and V of this book teach you the ins and outs of Visio’s more sophisticated solutions.

You can draw precise plans to scale with Visio. Visio Standard supports only basic building plans, whereas Visio Professional supports a variety of architectural and engineering plans. Nonetheless, you’ll probably want the extra power of a CAD application, such as AutoCAD, to design and document large or complex plans. Even so, Visio can be a helpful companion to your CAD application. You can create shapes faster and more easily in Visio and then import them for use in AutoCAD or other CAD applications. Team members who don’t have access to AutoCAD can create their drawings in Visio using CAD drawings as a backdrop and import their work into AutoCAD if necessary. Visio also simplifies preparing presentations for large projects.

Understanding Visio Concepts

Visio enhances your drawing and modeling productivity because so many of its elements include features that incorporate industry expertise. Most of the time, you don’t even think about how much Visio does for you because the templates, stencils, and shapes do just what you would expect. However, some of Visio’s specialized capabilities might surprise or even confuse you at first. By understanding the concepts that make Visio so powerful, you can prevent problems and maintain your productivity.

Using Templates and Stencils

In the real world, templates are patterns you use to build something. For example, you could use a standard design for a log house to simplify the construction of your home. In Visio, templates are solutions that facilitate the construction of a specific type of drawing. Each template comprises settings, stencils, styles, and special commands to make your work on a drawing as easy as possible.

Visio stencils are categorized collections of shapes. To continue the house analogy, a Visio stencil is like a catalog of cedar logs and connecting brackets that are available from your local building supply store. To build your home, you order the components you need from the store and assemble them according to your house design. In Visio, you assemble your drawings by dragging and dropping shapes from stencils onto your drawing page.
When you create a drawing based on a template, Visio does the following things:

✦ **Opens stencils with shapes** — Visio opens stencils that contain the shapes you need for the type of drawing you are creating.

✦ **Includes styles** — Visio provides special formatting styles typical for the current drawing type. For example, a construction project created from a floor plan template includes line styles typically used to dimension architectural plans.

✦ **Automatically displays menus and toolbars** — If the template contains a special menu, Visio adds an entry for the menu to the menu bar. If the template contains a special toolbar, Visio floats the toolbar in the drawing area.

✦ **Specifies settings** — Visio specifies settings typical for the type of drawing. For basic block diagrams, Visio uses letter-size paper, portrait orientation, one-to-one scale, and inches for measurement units. For site plans, it specifies a 36” × 42” architectural drawing size in landscape orientation, a scale of 1 inch to 10 feet, and measurement units of feet and inches.

✦ **Displays rulers and grid** — To make positioning shapes easy, the rulers and grid take into account the scale and units for the drawing. For example, a block diagram shows inches on the rulers with each grid cell equal to one-quarter inch. Conversely, rulers for a site plan display feet in the rulers with each grid cell equal to ten feet.

### Dragging and Dropping Shapes to Create Drawings

Visio’s philosophy is elegantly simple — you construct drawings by dragging and dropping predefined shapes onto drawing pages. Although working with Visio can seem like copying clip art into a document, Visio shapes are much more powerful, quickly transforming a blank page into a professional document with a few applications of drag and drop.

### What Makes Shapes Smart

Visio shapes can represent many things: ideas, processes, components of a model, and real-world objects such as people, places, and things. Visio calls them *SmartShapes* because they have built-in properties and behaviors that give them intelligence. As you work on a drawing, shape behaviors help you position the shapes and connect them appropriately to other shapes. For example, when you place a door shape in a wall, the door lines up with the wall and creates an opening into a room, as shown in Figure 1-1. That same door might contain properties to modify the shape or identify it, also shown in Figure 1-1. For example, one door property specifies whether the door is centered in the wall. Other door properties can define a door’s dimensions, its catalog number, or its associated room number, so you can produce a schedule of the doors you need and where they belong in your building.
Door shapes can create openings in walls

Figure 1-1: Shapes include behaviors and properties that give them intelligence.

Cross-Reference

To learn about how to define properties and behaviors for shapes, see Chapter 32.

In Visio, predrawn shapes are called masters, which are stored and categorized in stencils. When you drag and drop a master from a stencil onto your drawing page, you create a copy, which is called an instance of that master. Each instance inherits its master’s behaviors, so it knows how to act when you add it to your drawing. It also inherits its master’s properties, so you can assign unique values to an instance.

Using Handles to Manipulate Shapes

Shapes have other features to help you position, resize, and connect them to one another. When you select a shape, Visio marks these features with colored graphics, as illustrated in Figure 1-2. Shapes include the following types of handles:

✦ Selection handles — Red or green boxes appear when you select a shape. You can drag these selection handles to resize a shape or attach connectors to them.

✦ Connection points — Blue Xs mark locations where you can glue connectors or lines.
✦ Rotation handle — This is a red circle that you can drag to rotate a shape.
✦ Control handles — Yellow diamonds that appear on some shapes. You can drag control handles to modify a shape’s appearance — for instance, to change the swing on a door.
✦ Eccentricity handles — Green circles that you can drag to change the shape of an arc.

Shapes can be one-dimensional or two-dimensional. Two-dimensional shapes, such as rectangles and office tables, have selection handles at each corner and the midpoints of each side, which you can drag to modify a shape’s height and width. 1D shapes, such as connectors, lines, and arrows, have end points that you can drag to change the length of the shape. You can change the length of 1D shapes as well as the width of some 1D shapes, such as the 1D single arrow. However, you can’t change length and width at the same time because a 1D shape doesn’t have selection handles at its corners.

Figure 1-2: Visio uses colored marks to identify handles you can use to modify shapes.
Connecting Shapes

Relationships can convey as much information as the elements they connect. Whether you are showing who reports to a manager in an organization or defining the relationship between two database tables, connections between Visio shapes are important. In Visio, connections not only provide information about a relationship, they also help you lay out and rearrange the shapes on your drawing.

To learn more about connecting shapes, see Chapter 5.

What Connectors Do

Connectors are Visio shapes that define the relationships between other shapes. In essence, connectors are lines with shapes attached to each end. When you move two connected shapes, the connector between them adjusts to maintain that connection. Likewise, connectors maintain shape connectivity when you use Visio’s automatic layout tools. For example, you can change the layout of an organization chart from horizontal to vertical and the connectors alter their paths as the employee shapes take up their new locations.

Connectors have start and end points that define direction for a connection between shapes. Which end you connect to a shape can make a big difference in behavior. For example, in a database model, the table shape at the start of a connector is the parent, whereas the table at the end of a connector is the child. When you define a one-to-many relationship between those connected tables, the one is associated with the table at the connector’s start point, and the many belongs to the table at the connector’s end point.

When you want to differentiate the predecessor and successor for two connected shapes, such as in a data flow diagram or project schedule, make sure you glue the start point of the connector to the shape you are connecting from and the end point to the shape you are connecting to.

Straight Versus Dynamic Connectors

Straight connectors are straight lines that connect shapes. They lengthen, shorten, and change their angle to maintain shape connectivity, but they draw straight over shapes that are in their path, as shown in Figure 1-3.

Dynamic connectors are smarter. They automatically bend, stretch, and detour around shapes instead of overlapping them. They can also jump over other connectors to make connections easier to follow on a drawing. By default, dynamic connectors use right angles to bend around shapes. You can change the path of a right-angled connector by moving any of its vertices. You can also add or move
segments of a right-angled connector by dragging a midpoint of a segment. Curved connectors are dynamic as well. You can drag their control points and eccentricity handles, to modify the shape of the curve.

**Figure 1-3:** You can connect shapes with straight or dynamic connectors.

### Using Glue

Just as in real life, Visio needs glue to make things stick together. Visio “glue” comes in two varieties: shape-to-shape and point-to-point. *Shape-to-shape glue*, also known as *dynamic glue*, builds dynamic connections between shapes. When you reposition shapes connected with shape-to-shape glue, the end points of the connector move to the closest available connection points, as shown in Figure 1-4. *Point-to-point glue*, also known as *static glue*, keeps the connector end points glued to the specific points you selected on the shapes, also illustrated in Figure 1-4. In addition, you can combine dynamic and static glue, gluing a connector to a shape at one end and a specific point at the other.

By default, you can glue to entire shapes, connection points, or guides. You can change glue settings to also glue to shape handles, shape vertices, or any point on a shape’s geometry. As you draw a connector, a red box appears around a shape when you are connecting to that shape. If you are connecting to a point, the connection point turns red.
Exploring the Visio 2003 Interface

When you begin a drawing session, Visio 2003 conveniently populates the Visio desktop with features to help you work. By default, the Visio environment positions menus and toolbars across the top, the Shapes window with stencils and shapes to the left, the task pane to the right, a status bar along the bottom, and the drawing window in the center, as shown in Figure 1-5.

**Menus and Toolbars**

You can find most features on one of Visio’s menus or toolbars. However, the fastest route to many tasks is right-clicking a shape or interface element to access a shortcut menu.

The Visio menu bar contains menus familiar to Microsoft Office users. In addition, when you work with some of the specialized templates, the Visio menu bar contains an additional entry for a specialized menu, such as Plan shown in Figure 1-5.
Shortcuts for many tools are available on the Standard or Formatting toolbars, which appear by default. Some templates include specialized toolbars, which float in the drawing window by default. You can easily show or hide a toolbar:

✦ To display a toolbar, choose View → Toolbars and choose the toolbar you want to use. A check mark appears when the toolbar is displayed. A specialized toolbar appears in the toolbar list when a drawing of its type is active.
✦ To hide a toolbar, choose View → Toolbars and uncheck the checked toolbar that you want to hide.

You can dock a toolbar along the top, bottom, or sides of the Visio window. When you dock a toolbar to the left or right, the toolbar hangs vertically along the side. Toolbars are easily manipulated:
✦ To reposition a docked toolbar, drag its move handle to a new location. The move handle is a series of dots to the left of a horizontal docked toolbar and along the top of a vertical docked toolbar.

✦ To float a toolbar in the middle of the window, drag its move handle to a new position.

✦ To reposition a floating toolbar, drag its title bar to a new location.

### Task Panes

Task panes provide easy access to common tasks such as creating new drawings, obtaining help, and collaborating with others. Task panes dock on the right side of the screen by default. To show or hide a task pane, choose View ➪ Task Pane. You can also display the task pane by pressing Ctrl+F1.

For more information about task panes and Visio help resources, see Chapter 38.

### The Visio 2003 Drawing Area

The drawing window, which contains your active drawing, takes center stage in the Visio drawing area. The drawing window is visible whenever you work on a drawing. However, you can display several other windows to facilitate your work. To display one of these other windows, choose View and then the window name.

### The Drawing Window

Drawing pages appear in the drawing window, where you can add shapes or modify and format the contents of your drawing. You can view different areas of a page using the horizontal and vertical scrollbars. To view another page, select the tab for that page below the drawing window.

A drawing grid and rulers make it easy to position and align shapes on a page. To display a grid in the drawing window, choose View ➪ Grid. To display rulers, choose View ➪ Rulers. The units that rulers display vary depending on the type of drawing and scale you are using. For example, the rulers for a block diagram use inches, whereas rulers for a site plan use feet.

To change the ruler units, choose Tools ➪ Options and select the Units tab. Click the Change button and choose the units you want from the Measurement Units drop-down list.
The Shapes Window
You drag and drop shapes from the Shapes window onto a drawing page. The Shapes window contains active stencils and their shapes, docked by default on the left, as shown in Figure 1-5. However, you can reposition the Shapes window or individual stencils to suit your needs. For instance, you can dock the Shapes window at the top or the bottom of the drawing area to provide more room for pages set to landscape orientation.

- To add another stencil to the Shapes window, choose File ➪ Shapes, and navigate to the stencil you want.


- To display the shapes for an open stencil in the Shapes window, click the stencil’s title bar.

- To resize the Shapes window, drag the vertical divider between the Shapes window and the drawing window to the left or right.

- To change the information displayed in the Shapes window, right-click the Shapes window title bar and choose one of the options, such as Icons Only, from the shortcut menu.

By default, in the Shapes window you see the title bars for all open stencils, but only the shapes for the active stencil. To view multiple stencils at the same time, you can

- Drag a stencil out of the Shapes window and float it on the screen, as shown in Figure 1-6.

- Drag a stencil to the top or bottom of the Shapes window to create a second stencil pane.
Multiple stencil panes in the Shapes window

A docked stencil

Figure 1-6: You can dock stencils in the Shapes window or float them on the screen.

The Drawing Explorer

The Drawing Explorer, shown in Figure 1-7, offers a hierarchical view of your drawing. You can use the Drawing Explorer to find, add, delete, or edit the components of your drawing, including pages, layers, shapes, masters, styles, and patterns. For example, you can select and highlight a shape on a drawing by double-clicking its name in the Drawing Explorer. To display the Drawing Explorer, choose View ➪ Drawing Explorer Window.

Figure 1-7: You can exploit the hierarchy of drawing components in the Drawing Explorer window.
Tip

You can conserve screen real estate by docking and merging view windows. You can dock other view windows within the Shapes window or you can merge several windows into one. To dock a view window, such as Pan & Zoom, drag it into the Shapes window. To merge view windows, drag one window by its title bar into the center of another window. To switch between merged windows, select the tab for the view you want.

The Size & Position Window

The Size & Position window is particularly useful when you work on scaled drawings such as building plans, where precise measurements are important. You can use the Size & Position window to view and edit a shape’s dimensions, position, or rotation.

To learn more about how to use the Size & Position window, see Chapter 4.

The Custom Properties Window

The Custom Properties window is the best place to modify the custom properties for a number of shapes. The window remains open until you close it and displays the values for a shape when you select that shape. To edit a property in the Custom Properties window, click the property box and enter or edit a value.

The ShapeSheet Window

You can modify any aspect of a shape in its ShapeSheet. You can display the ShapeSheet by choosing Window ‹› Show ShapeSheet.

To learn more about ShapeSheets, see Chapter 33.

Viewing Drawings

Examining your work is essential when you draw. As you progress from a blank page to a completed drawing, you want to view your drawing in different ways, and Visio 2003 provides the tools to do this.

People who don’t have Visio installed on their computers can still view Visio drawings. To learn about using the Microsoft Visio Viewer or viewing Visio drawings on Web pages, see Chapter 11.

Panning and Zooming

Sometimes you want to see the big picture, and at other times you want detail. In Visio, you can pan and zoom in several ways to see the area and detail that you want.
Using Pan and Zoom Shortcuts
Two keyboard shortcuts provide the fastest way to zoom in and out:

✦ To zoom in, use Ctrl+Shift+left-click.
✦ To zoom out, use Ctrl+Shift+right-click.

You can change the center of the zoom area by repositioning the magnifying glass that appears when you press Ctrl+Shift.

Tip
If you want Visio to center the zoom area on the selected shape when you zoom in or out, choose Tools ➪ Options. Select the General tab and put a check in the Center Selection on Zoom check box.

Using the Pan & Zoom Window
The Pan & Zoom window shows the entire drawing page, with the zoom area outlined in red. Visio docks the Pan & Zoom window within the drawing window, but you can dock it within the Shapes window if space is at a premium. Use one of the following methods to specify the area you want to see:

✦ On the right side of the Pan & Zoom window, drag the zoom scrollbar up or down to zoom in or out, respectively.
✦ Drag a side or corner of the red outline to resize it, thereby changing the part of the drawing visible in the drawing window.
✦ Click and drag to define a new zoom area box in the Pan & Zoom window.
✦ Click a point in the Pan & Zoom window to relocate the center of the zoom area box.

Panning and Zooming from Menus and Toolbars
The View menu and the Standard toolbar both contain zoom options, but the zoom list on the Standard toolbar is faster. You can choose from several predefined zoom percentages as well as the entire page, the entire width of the page, and the last zoom used.

Tip
If you use a mouse with a scroll wheel, you can use the mouse wheel to pan and zoom. To pan up or down, roll the mouse wheel. Press the Shift key while rolling the wheel to pan from side to side. You can zoom in and out by pressing the Control key while rolling the mouse.

Working with Drawing Windows
Sometimes one window for your drawing isn’t enough— for instance, when you want to copy shapes from one drawing to another or view details in two widely
separated areas of the same drawing. You can create additional windows for your drawings and arrange them in several ways.

**Creating New Windows**
When you create a new window, Visio displays the same drawing contained in the previous window. The new window, identified by the “:2” that follows the filename in the Visio title bar, fills the drawing window.

✦ To create a new window, choose Window ➪ New Window.

When you create a new window, the Shapes window doesn’t contain any open stencils. However, windows docked in the Shapes window are docked in the new Shapes window as well.

✦ To bring another window to the front, choose Window and then the name of the window you want to see.

**Viewing Multiple Windows**
You can view several drawing windows at the same time. Tiling and cascading both create panes for each open window. Tiling is helpful for viewing several areas of detail at the same time as it arranges the panes side by side in the drawing area. You can view all the windows at the same time, but each pane takes up a smaller area of the screen.

Cascading is better when you want larger panes for each window but want to switch between them quickly. Cascaded windows overlap, with each window slightly lower and to the right of the previous one. When you cascade windows, the current window appears in front.

✦ To tile the windows in the drawing area, choose Window ➪ Tile.
✦ To cascade windows, choose Window ➪ Cascade.
✦ To bring a hidden window to the forefront, click any visible part of that window.
✦ To fill the drawing area with one of the tiled or cascaded windows, click the window’s Maximize button.

**Summary**

Visio is an essential tool for effectively communicating ideas and documenting business results. Using drag and drop drawing techniques, anyone can produce great-looking diagrams, drawings, and models. This chapter introduced you to Visio 2003.
Specifically, in this chapter you learned about the following:

- New and updated features in Visio 2003
- Features discontinued in Visio 2003
- The concepts that make Visio so powerful
- The components of Visio’s interface
- How to view your Visio drawings
Getting Started with Drawings

There’s no reason to begin with a blank slate in Visio; new drawings can originate from a variety of sources, including existing Visio drawings, Visio templates on your computer, and online. Visio provides several convenient methods for creating drawings, none of which require more than a few clicks of a mouse.

After creating a drawing, you can add content quickly by dragging and dropping shapes from stencils or by using Visio’s drawing tools to create your own geometry. The tools to produce lines, curves, rectangles, and ellipses are simple to use, but also pack a lot of power when you utilize all their features.

As your drawings grow in size and complexity, you can add pages to hold more content. Background pages work like watermarks, displaying company logos or repetitive background graphics for each page of your drawing. With the Page Settings menu option, you can further fine-tune how your drawings look and behave. You can create drawings of different sizes and scales, whether you want a two-inch thumbnail with shapes at their actual size or a 22-inch by 34-inch architectural plan with shapes scaled to one quarter inch equal to one foot. Layout and Routing settings influence the appearance of connections and the readability of your drawings, whereas Shadow settings add visual impact.

It’s easy to work with multiple drawing pages. You can add, delete, rename, and reorder pages from a shortcut menu. In addition, you can rotate pages temporarily to easily add objects at an angle—for instance, to draw offices in a floor plan positioned at different angles.
Creating Drawings

Visio provides three places to access the features for creating drawings:

✦ **File ➪ New** — This is the quickest way to display the Choose Drawing Type pane or create a new drawing of the same type as the current one, particularly when the task pane is hidden. Choose File ➪ New ➪ Choose Drawing Type to preview and choose the available templates.

✦ **Choose Drawing Type pane** — By default, the Choose Drawing Type pane appears when you start Visio. This pane enables you to preview and choose one of Visio’s templates.

Tip If you work on existing drawings more often than you create new ones, you can turn this feature off. To do this, click **Tools ➪ Options**. Select the View tab and uncheck the Choose Drawing Type Pane check box.

✦ **New Drawing pane** — This pane contains links to every method for creating a new drawing. If the task pane is not visible, choose View ➪ Task Pane. Click New Drawing in the task pane drop-down list.

Creating Drawings Using Templates

Templates are incredibly convenient because they set up your drawing environment for you. Visio comes with dozens of templates, but you can also find templates on the Web or use custom templates you’ve built yourself or obtained from someone else.

To create a drawing from a template, follow these steps:

1. Display the Choose Drawing Type pane by choosing File ➪ Choose Drawing Type. You can also click Choose Drawing Type in the New Drawing task pane.

2. Click the category for the type of drawing you want to create. Visio displays thumbnails of each type of drawing in that category, as shown in Figure 2-1.

3. Click the picture representing the type of drawing you want.

Tip If you’re not sure that a drawing type is what you want, position the pointer over a drawing type picture to display a description of possible applications for that type. Conversely, when you know exactly which drawing type you want, it’s quicker to choose File ➪ New, navigate to the category you want, and click the name of the drawing type on the submenu.
The New Drawing pane offers several other options for finding templates to use for new drawings. Other links in the New Drawing pane include the following:

- **Search Online for** — Type keywords into this box to identify the type of template you want and click Go to search online.
- **Templates on Office Online** — Click this link to view templates available on the Microsoft Office Online Web site.
- **On My Computer** — Click this link to open the Browse Templates dialog box. Navigate to a folder on your computer, click the template you want to use, and click Open.
- **On My Web Sites** — Click this link to browse Web sites accessible from your My Network Places folder.
- **Recently Used Templates** — Click one of the templates in this section to create a new drawing based on that template.
When you install Visio, you can choose to install US (Microsoft’s abbreviation for United States), metric, or both versions of templates. If you install both, you will see two copies of each template. US Units templates use standard U.S. page sizes and U.S. units, such as feet or inches. Metric templates use metric units and page sizes.

**Creating Drawings from Existing Drawings**

Sometimes, an existing Visio drawing possesses exactly the settings you want for a new drawing. It might even have some shapes you want already in place, such as your favorite title block. Although you can open an existing drawing in Visio and use the Save As command to create a new drawing, it’s easier to click From Existing Drawing in the New Drawing task pane, which opens a copy of the existing file with a default name, such as Drawing1. To save the new drawing, click File ➤ Save, specify a folder and filename, and click Save.

If an existing drawing contains settings and content you use frequently, you can create a template of that drawing. To learn how to do this, see Chapter 30.

If you want to create a blank drawing, perhaps to use Visio drawing tools to mark up an image, you can create a drawing without any stencils or special settings assigned. To do this, make sure the task pane is open by choosing View ➤ Task Pane and then display the New Drawing task pane by choosing New Drawing in the task pane drop-down list. In the New Drawing task pane, click Blank Drawing. To open stencils, choose File ➤ Shapes, navigate to the category of shapes you want, and then choose a stencil.

**Using the Fundamental Drawing Tools**

You can produce most drawing content by dragging and dropping shapes and connectors. However, you can also create your own geometry to build new shapes or to annotate and mark up your drawings. Visio provides a powerful set of drawing tools. Combining these tools with drawing aids and snapping and gluing techniques, you can quickly add lines, curves, and closed shapes to any drawing.

To access the Visio drawing tools, display the Drawing toolbar by choosing View ➤ Toolbars ➤ Drawing.

The Drawing Tools icon appears to the left of the zoom box on the Standard toolbar. You can click this icon to show and hide the Drawing toolbar.

**Speeding Up Drawing with Snap To Tools**

Snapping helps you position lines and shapes exactly where you want by attracting a point to another shape, a ruler subdivision, a drawing guide, the drawing grid, or other elements on your drawing. You can specify which elements Visio snaps to as
well as the strength of attraction for a snap. As the attraction strength increases, the pointer snaps to those elements from further away.

To select snap elements, choose Tools ➪ Snap & Glue and select the Visio components you want to snap to in the Snap To column. To specify the strength of attraction, click the Advanced tab and drag the Snap Strength scrollbars to the left or right to decrease or increase the snap strength.

Although snapping is usually helpful, it can sometimes be a hindrance. When you’re trying to draw freeform curves, snapping can pull the pointer to positions you don’t want. To draw smoother freeform curves, choose Tools ➪ Snap & Glue and then uncheck the Snap check box in the Currently Active column. When you are finished, check the Snap check box to restore snapping.

To learn more about settings for snapping, see Chapter 4.

Drawing aids are dotted lines that indicate where to click to draw a circle, square, or a line at a particular angle. You can use them to simplify creating lines and closed shapes. When you use the Ellipse and Rectangle tools, a dotted line shows you where to click to create a circle or square, as demonstrated in Figure 2-2. When you use the Line tool, guides appear when you approach an increment of 45 degrees. When you edit a line segment, drawing aids extend at 45-degree increments as well as the line’s original angle. To display drawing aids, choose Tools ➪ Snap & Glue and check the Drawing Aids check box in the Currently Active column.

Figure 2-2: You can use drawing aids to create circles, squares, and angled lines.
Drawing Lines

Depending on how you click and drag, you can use the Line tool to create individual line segments, a series of connected line segments, or closed shapes. When the Line tool is active, the pointer changes to cross hairs with a short angled line to its right. To draw lines, follow these steps:

1. To begin a line, click the Line tool in the Drawing Tools toolbar, click the mouse button at the starting point of the line, drag to the end point of the line, and release the mouse button. Visio displays the new line segment and selects it.

   Tip
   To draw only orthogonal lines, hold the Shift key as you drag a line.

2. To connect another line segment to the one you just drew, click without moving the pointer from the end of the last segment, drag to the next end point, and release the mouse button.

   Caution
   If you click more than once before drawing a new line segment, Visio deselects the previous segment and the new line segment won’t be connected to the previous one. To prevent this problem, make sure the previous segment is selected before you add the next one. To join separate line segments, Shift+click each segment and then choose Shape ➤ Operations ➤ Join.

3. To add another line segment, repeat step 2.

4. If you want to close the shape by adding another line, click and drag to the starting point of the first line segment and release the mouse button.

   Note
   When you create a line segment with the Line tool, Visio shows the start and end points with green squares. However, when you create a series of connected lines, Visio indicates the vertices at the ends of each line segment with green diamonds.

   Note
   Visio applies a solid white fill to the shape when it closes, hiding the drawing grid behind the enclosed area.

Drawing Arcs and Curves

The Arc tool draws one arc at a time, and each arc represents no more than one-fourth of an ellipse or a circle. The curve of the arc depends on the angle between the start and end points you choose and can vary between a straight line and a circular curve. Visio arcs have vertices at each end and at their midpoints and also contain control points that you can use to change their shape, as shown in Figure 2-3. To draw an arc with a deeper curve, create an arc and then change its curve by dragging its vertices or control point.
Eccentricity point changes the lean of the curve
Midpoint changes the depth of the arc
Eccentricity point changes the curvature
Vertex changes endpoints

Figure 2-3: You can drag vertices and control points to modify an arc.

Note
You can’t create a complete circle or ellipse with the Arc tool. You must use the Ellipse tool to draw a closed ellipse.

You can draw and modify arcs in the following ways:

✦ To draw a clockwise arc, click one point and then sweep the pointer clockwise to the next point.
✦ To draw a counterclockwise arc, click one point and then sweep the pointer counterclockwise to the next point.

Tip
The direction of the arc remains fixed after the initial sweep. After the direction is set, you can drag the pointer to define the arc’s curve and orientation.

✦ To move an arc, select the Pointer tool, and click the arc away from any vertices or control points. When the pointer changes to a four-headed arrow, drag the arc to a new location.
✦ To extend the arc’s length, drag an end point to a new location.
Depending on where you drag the end point of an arc, you can also change the shape of the arc in addition to changing its length.

 Millennials may use a variety of tools to develop their designs, including Visio. This tool can be used to create a wide range of shapes and designs.

✦ To change the shape of an arc, drag the control point to a new location.

✦ To modify direction or rotation, right-click an arc, click Shape on the shortcut menu, and click one of the Rotate or Flip commands.

To draw multiple arcs and splines—for instance, to mimic handwriting—you use Visio’s Freeform tool. This tool senses changes in the direction of the pointer and adds vertices and control points as you draw. The result is a series of curves that you can modify section by section. To draw a freeform curve, click the Freeform tool in the Drawing toolbar and then drag the pointer slowly on the drawing page. Several factors contribute to the success of your curve drawing efforts. To improve your result, you can do the following:

✦ Take your time as you draw a freeform line. Drawing more slowly provides greater control over the curves you create, as Visio better recognizes your direction changes.

✦ Modify the freeform precision option. Precision controls how Visio switches between drawing straight lines and curved splines. To set precision, click Tools ➪ Options, click the Advanced tab, and drag the precision scrollbars to the left or right. Dragging to the left tightens the tolerance so that Visio switches to drawing splines unless you move the mouse in a very straight line. Dragging to the right loosens the tolerance, so Visio draws straight lines until you move the mouse in an obvious curve.

✦ Modify the freeform smoothness option. Smoothing controls how much Visio smoothes out your curves—in effect, how sensitive Visio is to changes in direction. Tighter settings add more control points, as shown in Figure 2-4, whereas looser settings add fewer. More control points provide greater control over the angles of arcs in a freeform curve.

✦ Disable snapping if your freeform lines are erratic. To do this, choose Tool ➪ Snap & Glue and uncheck the Snap check box in the Currently Active column. If you change your Snap & Glue settings frequently, you can display the Snap & Glue toolbar to keep Snap & Glue commands handy. Simply choose View ➪ Toolbars ➪ Snap & Glue.
Drawing Closed Shapes

Although you can use the Line tool to draw closed linear shapes, ellipses and rectangles have their own Visio drawing tools. With the Ellipse and Rectangle tools, you can draw ellipses, circles, rectangles, and squares by clicking two points.

You can draw quadrilateral shapes (shapes with four sides) using the following methods:

- To draw a rectangle, click and drag the pointer from one position on the drawing page to another to define opposite corners of the rectangle.
- To draw a square, hold the Shift key while dragging from one corner to the opposite corner.
- To use drawing aids to draw a square, click the first corner, drag the pointer close to a 45-degree angle, and click on the drawing aid that appears to select the opposite corner.
Many diagrams use rectangles with rounded corners. To round the corners of rectangular shapes, choose one of the following methods:

✦ Right-click a shape and choose Format ▶ Line on the shortcut menu. Select the rounding you want and click OK.

![Tip]

You can also specify the rounding by typing a value for the radius of the corner in the Rounding box of the Format Line dialog box.

✦ Choose Format ▶ Corner Rounding. Select the rounding you want and click OK.

✦ Choose View ▶ Toolbars ▶ Format Shape. Click the Corner Rounding button on the Format Shape toolbar.

✦ To define a style with rounded corners, choose Format ▶ Define Styles and click the Line button. Select the rounding you want and then click OK.

Cross-Reference

To learn more about defining styles, see Chapter 34.

You can draw ellipses and circles using the following methods:

✦ To draw an ellipse, click and drag the pointer from one corner to the opposite corner. The ellipse is circumscribed by the rectangle you defined with your two points.

✦ To draw a circle, hold the Shift key while dragging from one corner to the opposite corner.

✦ To draw a circle, click the first corner, drag close to a 45-degree angle, and click on the drawing aid that appears to select the opposite corner.

Using the Pencil Tool

The Pencil tool is quite versatile. It works as well for drawing new lines and arcs as it does for reshaping existing ones. In addition, you can use the Pencil tool to construct a polyline made up of a combination of straight lines and arcs, as demonstrated in Figure 2-5. The Pencil tool interprets your pointer movements to determine whether you want to draw a line or arc, and switches to either Line mode or Arc mode, respectively. In addition, the Pencil tool, unlike the Arc tool, can draw arcs that are almost complete circles.

To use the Pencil tool’s features, use one of the following methods:

✦ To draw a straight line, drag the pointer straight in any direction. Visio indicates that it is in Line mode by changing the pointer to cross hairs with an angled line below and to the right.

✦ To draw an arc, sweep the pointer in a curve. Visio indicates that it is in Arc mode by changing the pointer to cross hairs with an arc below and to the
right. You can move the pointer to define the radius of the arc, the angle that the arc circumscribes, as well as the position of the arc on the drawing page.

- To switch to Line mode while you are in Arc mode, move the pointer back to the starting point. When the Arc next to the cross hairs disappears, drag the pointer straight to switch to Line mode.

- To switch to Arc mode while you are in Line mode, move the pointer back to the starting point. When the angled line next to the cross hairs disappears, sweep the pointer to switch to Arc mode.

![Figure 2-5: You can draw straight lines and arcs with the Pencil tool.](image)

**Working with Pages**

You might add multiple pages to a drawing for several reasons. For example, the database model for an airline reservation system could require hundreds of pages to show every table. A construction project could show the entire building on one drawing page, with elevations and construction details on others. Background pages act like watermarks — for instance, displaying a company logo and standard title block for every foreground drawing. Every page you add can have its own settings for drawing size, orientation, margins, units and scale for architectural and engineering drawings, and more.

**Note**

The settings you specify in Page Setup can differ from page to page, but the settings you specify in Print Setup affect all pages in a drawing.
The quickest way to access page commands is by right-clicking a page tab in the drawing window. From this shortcut menu, you can do all of the following:

✦ Insert new pages
✦ Delete the selected page
✦ Rename the selected page
✦ Modify the order of the pages

Creating Pages in a Drawing

A Visio drawing file contains one page by default, but you can create as many pages as you want. When you create a new page, it inherits the page settings of the active page in the drawing window. However, Visio also displays the Page Setup dialog box as part of the page creation process, so you can specify page settings at the time of creation. You can create foreground or background pages using any of the following methods:

✦ Right-click any page tab and choose Insert Page on the shortcut menu.
✦ Choose Insert ➪ New Page.
✦ In the Drawing Explorer window, right-click the Foreground or Background folder and then click Insert Page.

You can create a background page that displays the same set of shapes, such as a logo, title block, or revision block, for multiple foreground pages. To do this, you must create a background page and assign it to each foreground page. To set up a background page, follow these steps:

2. Click the Background option and type a name for the new background page in the Name box.
3. Make any other page setting changes you want and click OK.
4. Add the shapes and text that you want on the new background page.
5. To assign the background page to a foreground page, click the page tab for the foreground page and choose File ➪ Page Setup.
6. Select the Page Properties tab, select the background page name in the Background drop-down list, and click OK.

You can’t delete a background page as long as at least one foreground page uses it. To remove a background page assignment, select the foreground page to which it is assigned, open the Page Setup dialog box, click None in the Background drop-down list, and then click OK. After you have removed all the background page assignments, you can delete the background page.
Setting Up Pages

Each page in a drawing can have its own unique settings. For example, a floor plan page might use a D-size sheet of paper with landscape orientation and an architectural scale. The door and window schedule for the floor plan might apply a standard letter-size sheet of paper with portrait orientation and no scale. To specify the settings for a page, click a page tab and then choose File ➪ Page Setup to open the Page Setup dialog box.

Defining Print Settings

To specify the settings for the printer paper, select the Print Setup tab in the Page Setup dialog box. To prevent incompatibilities between drawing pages and printer paper, Visio displays a preview window that shows the current settings for both, as shown in Figure 2-6. You can resolve discrepancies by modifying settings on either of the Print Setup or Page Size tabs.

![Discrepancies between Print Setup and Page Size settings](image)

**Figure 2-6:** The Print Setup and Page Size tabs preview your print settings to highlight incompatibilities.

On the Print Setup tab, you can specify the following:

- **Printer Page Size** — Choose a standard paper size from the drop-down list.
- **Printer Page Orientation** — Choose the Portrait or Landscape option.
- **Page Margins** — Click the Setup button to set page margins.
- **Small Drawing Centering** — Click the Setup button and check the Center Horizontally and Center Vertically check boxes.
Print Zoom — Specify a percentage for the print zoom or how many sheets across and down. Print Zoom enlarges or shrinks a drawing only for printing. For example, you can use Print Zoom to print a larger drawing on a letter-size sheet.

Printed Gridlines — Check the Gridlines check box to print the drawing grid along with the contents of your drawing.

Caution
The Print Setup tab in the Page Setup dialog box controls page size and orientation for a page. Clicking the Properties button in the Print dialog box accesses page size and orientation settings for a printer. If you choose different settings in these two locations, Visio will display a warning before printing, indicating that drawing pages will print across multiple pages because they are oriented differently than the printed page. To prevent this behavior, make sure that your drawing page dimensions are compatible with printer page size and orientation.

Specifying Page Size
By default, Visio sets the drawing page size to the printer paper size. To specify a page size that is different from that of the printer paper, select the Page Size tab in the Page Setup dialog box. This tab also displays a preview window that shows the current settings for both Print Setup and Page Size. On the Page Size tab, you can specify the following:

Page Size Same As Printer Paper Size — Visio selects this option by default.
Pre-defined Size — Select a category of sizes, such as Standard or ANSI Architectural, and then select one of the standard sizes for that category.
Custom Page Size — Specify the dimensions for the height and width of the custom page.
Page Size Fits Drawing Contents — Select Size to Fit Drawing Contents to define a page size just large enough to hold the contents of the current page.
Page Orientation — Choose Portrait or Landscape for the page. Make sure that the page orientation and printer paper orientation match.

Tip
You can also change the size of a page without opening the Page setup dialog box. To do this, click the Pointer tool, position the pointer along the edge of the page, and press and hold the Ctrl key. After the pointer changes to a double-headed arrow, drag the edge to change the dimension of the page. As you drag, the current dimension for the page appears in the status bar.

Defining Drawing Scale
When you work on scaled drawings such as construction plans, the drawing scale enables you to fit real-world objects onto sheets of paper. You can specify a drawing scale in Visio to represent real-world measurements on a drawing page. In Visio, the
No Scale option shows objects at their actual size—a one-to-one scale. On the Drawing Scale tab, you can specify the following options:

✦ **No Scale**—Objects appear at their actual size.

✦ **Pre-defined Scale**—Select a category of scales, such as Architectural or Metric, and then select one of the standard scales for that category.

The page size at the bottom of the Drawing Scale screen indicates the real-world size of your drawing page. You can modify these values to change the size of the page. If you do this, the preview window will show the relationship between your page and the printer paper.

✦ **Custom Scale**—Specify the measurement unit and the associated size in the real world to define a custom scale.

To learn more about using drawing scales, see Chapter 24.

The Title Blocks stencil includes masters that display the current drawing scale. These shapes reference a page field, so the scale in the title block updates automatically if you modify the scale for the drawing page.

### Specifying Measurement Units

On the Page Properties tab, you can specify the units used for measuring objects on a page by choosing the units you want with the Measurement Units drop-down list.

The Measurement Units list includes many familiar units of distance, units of time, and a few options that you might not know. When you work on drawings that deal with time, such as graphs showing actions over time, you can specify the time units that appear on the drawing rulers. The remaining units in the list are typesetting measurements; didots and ciceros represent metric measures, and points and picas represent U.S. measures.

### Setting Up Layout and Routing

The Layout and Routing tab provides options for specifying how shapes and connectors interact on a page. You can specify where connectors attach to shapes, whether connectors that share a shape overlap or not, and whether connectors use straight or curved lines. The Layout and Routing tab displays a preview of the settings you choose, so you can decide whether to apply them. On the Layout and Routing tab, you can specify the following options:

✦ **Style**—This setting specifies the appearance of connectors between shapes. For example, you can choose connectors with right angles or straight lines, or you can specify the way that Visio lays out connected shapes, such as Tree or Organization Chart.
Part I ✦ Understanding Visio Fundamentals

✦ **Direction** — Only applicable to some styles, such as Tree and Organization Chart, the direction specifies the shape’s layout: from top to bottom, bottom to top, left to right, or right to left.

✦ **Separate** — This specifies whether connectors that are overlapped should be separated. For example, when you choose Unrelated Lines, connectors from the same manager to multiple subordinates are related, so overlapping paths are acceptable. This setting does not affect connectors that are already separated.

✦ **Overlap** — This setting specifies whether connectors that are separated should be overlapped.

**Caution**

If you choose to overlap all lines, your drawing will be less cluttered, but it will be more difficult to identify relationships between shapes.

✦ **Appearance** — This specifies whether the connectors are straight or curved.

In the Page Setup menu, you can also configure the appearance of line jumps, which visually indicate that lines do not connect:

✦ **Lines That Use Line Jumps** — Choose which connectors use line jumps in the Add Line Jumps To drop-down list. For example, you can display line jumps in horizontal or vertical lines, with the first or last line displayed.

✦ **Line Jump Style** — This setting specifies the appearance of line jumps, such as arcs or gaps.

✦ **Line Jump Size** — Set the Horizontal Size to specify the width of line jumps on horizontal lines. Set the Vertical Size to specify the height of line jumps on vertical lines.

The Layout and Routing tab includes a few other settings. From here, you can also specify the following:

✦ **Move Other Shapes Away on Drop** — When this check box is checked, shapes automatically move on a page to make room for a shape that is dragged, moved, or resized on a page.

✦ **Enable Connector Splitting** — When this check box is checked, a shape dropped onto a connector splits the connector in two. The new shape automatically has connections to the two shapes that were previously connected.

✦ **Spacing** — Click this button to open the Layout and Routing Spacing dialog box. You can specify spacing between shapes, spacing between connectors, spacing between connectors and shapes, and the average shape size.
Setting Up Shadows

The Shadows tab controls the appearance of shadows associated with shapes on a page. On the Shadows tab, you can specify the following options:

✦ **Shadow Style** — This determines the angle and connection between the shadow and the shape, much like the position of a light source determines the shape of a shadow.

If you choose an oblique style, in which the shadow is oriented at an angle to the shape, you can specify the angle of rotation for the shadow.

✦ **Offset From Shape** — This setting specifies the distance between the shapes and the shadow. You can specify distances for horizontal and vertical offset or use the direction buttons.

✦ **Magnification** — Use this to specify the size of the shadow relative to the original shape.

Editing Pages

When a drawing contains several pages, it’s easy to edit pages and move between them. The quickest way to navigate to a page is by clicking its page tab. If you can’t see all the page tabs, you can choose Edit ➪ Go To and then click the name of the page you want to see.

Renaming Pages

When you create pages and don’t name them, Visio assigns default names, such as Drawing1. If you work with multiple pages, you should assign a meaningful name to each page when you create it. This enables you to easily identify a page by the label on the page tab. Afterwards, you can rename a page with one of the following methods:

✦ Double-click a page tab and type the page’s new name.

✦ Right-click a page tab, click Rename Page, and type the page’s new name.

If the Page Setup dialog box is open, you can rename the current page by clicking the Page Properties tab and typing a new name in the Name box.

Deleting Pages

You can delete the current page or delete several pages at one time. To delete one page, right-click its page tab and click Delete Page. To delete several pages at once, follow these steps:

1. Choose Edit ➪ Delete Pages.

2. Ctrl+click each page you want to delete in the Delete Pages dialog box. If you are using default names and want Visio to renumber the page names, select the Update Names box. Click OK.
Reordering Pages
As you insert and delete pages, the remaining pages might need to be reordered. If you can see most of the page tabs, you can drag and drop pages into position. To do this, select the tab of the page you want to move and drag and drop the tab into a new position.

When your drawing contains many pages, it’s easier to reorder them in the Drawing Explorer window. To do this, follow these steps:

1. Choose View ➪ Drawing Explorer Window.
2. Right-click either the Foreground folder or the Background folder and click Reorder Pages on the shortcut menu.
3. In the Reorder Pages dialog box, click the name of a page that you want to move and use the Move Up or Move Down buttons to move the page to its new position in the order. If you are using default names and want Visio to renumber the page names, select the Update Names box. Click OK when you have finished reordering all the pages.

Rotating Pages
You can create drawings in which different areas are at different angles without rotating each shape into position. By rotating the drawing page, you can construct each section orthogonally — that is, placing each shape at right angles to the drawing grid. Although existing shapes and guides rotate when you rotate a page, the rulers and drawing grid remain fixed. While the page is rotated, you add new shapes at right angles to the rulers and grid. When you rotate the page back to its original orientation, the shapes you added rotate with it, as illustrated in Figure 2-7.

Rotating pages does not affect print and page orientation settings. A rotated page prints as if it were not rotated.

To rotate a page, follow these steps:

1. Display the page you want to rotate in the drawing window.
2. Press Ctrl and position the pointer over a corner of the page. The pointer changes to a rotation pointer.
3. Drag the corner to the angle you want. If you want to rotate to a specific angle, release the mouse button when the rotation angle value in the status bar equals the angle you want.
Add a shape while the page is rotated.  

**Figure 2-7:** You can add a large number of shapes at an angle by rotating the page.

## Summary

Visio provides a number of methods for creating drawings. By creating drawings using templates, you can get to work without worrying about settings such as page size or scale. You can also use existing drawings as a foundation for new drawings and even create your own templates if you use the same drawings repeatedly.

Although Visio provides thousands of predrawn shapes, you can add your own lines and closed shapes with Visio’s drawing tools. Visio provides a number of features, such as snapping and drawing aids, that help you draw lines, arcs, and closed shapes precisely where you want.

You can add pages to a drawing to keep related information in one file or to show the detail of a large and complex model. By default, a new page inherits the settings for the previous page. However, each page in a drawing has its own unique settings, so you can modify page settings to support different types of information on each page. As you modify your drawing, you can navigate between pages—renaming, deleting, and reordering them as needed. In addition, you can easily draw shapes at different angles on a page by rotating the page and then adding shapes using the orthogonal grid.
In Visio 2003, you can open, save, and print different Visio drawing files such as drawings, stencils, and templates, and you can store these Visio file types in either binary or XML file formats. You can also work with other file formats such as AutoCAD, Scalable Vector Graphics, and Graphics Interchange Format (.gif). For many of these formats, you can open and save file formats simply by selecting the format in the File As Type list in the Open or Save As dialog boxes.

Visio provides several features that make it easy to find the files you want. Task panes include links to recently used files and templates. You can also use basic or advanced searches to locate files matching your search criteria. You can search for files in folders on your computer, your network locations, or the Internet. When you’re ready to print the results of your efforts, Visio provides features for specifying which parts of your drawing to print and how to print them.

Opening Drawings

Visio 2003 uses the same Open dialog box as other Microsoft Office applications, so you can use familiar shortcuts and features to locate and open your Visio files. In addition to the Open dialog box, Visio 2003 provides several convenient methods for opening the files you want to work on. For example, several new task panes contain links to Visio files, stencils, and templates.

Visio 2003 can open drawings created in earlier versions of Visio. However, Visio 2002 can’t open Visio 2003 files because of changes to XML and binary file formats. You can save Visio 2003 files as Visio 2002 drawings, stencils, or templates, so you can open them in Visio 2002.
When you open a Visio file, Visio opens several elements in addition to the drawing page and stencils that you can see:

- The workspace list saves the files, windows, and window positions from the last work session so that Visio can reset your work environment.
- Visio includes styles and color palettes associated with the drawing.
- Visio opens a VBA project, which initially contains an empty class module: ThisDocument.
- Visio opens a ShapeSheet for the file, which you can use to store information about the file and the shapes within it.

**Caution**

If you are concerned about macros jeopardizing your computer security, you can specify security options to limit macro features. To do so, choose Tools ➪ Options and select the Security tab. To disable Visual Basic for Applications (VBA) features, clear the check boxes that relate to VBA. You can also disable Com Add-Ins and Automation Events, although this might reduce the functionality available in some drawing types. Click the Macro Security button to specify the level of macro security and macro sources you trust.

## Opening Visio Drawings

The Open dialog box provides several helpful tools when you want to open a file in Visio. From this dialog box you can browse, search, access recently opened files, and open the file or files you want. To open an existing file, follow these steps:

1. Click the Open button on the Standard toolbar. Alternatively, you can choose File ➪ Open or press Ctrl+O.
2. In the Look In list, browse to the folder that contains the file you want to open. The contents of the folder appear in the dialog box.
3. Double-click a file to open it.

**Tip**

To select more than one file, press Ctrl and click the files you want to select. Then click Open to open all the selected files.

By default, a Visio drawing uses the units defined in the template you used to create the drawing. However, you can change the units for a drawing or specify the default units for new, blank drawings and stencils. To specify the default units for text, angles, and duration, choose Tools ➪ Options, select the Units tab, and choose the units you want. You can also specify whether Visio should offer both metric and U.S. units when you create new, blank drawings and stencils.
Working with Document Management Systems

You can open and save Visio files with a document management system (DMS) if it supports the Open Document Management Architecture (ODMA) 1.5 standard. When Visio detects an ODMA 1.5–compliant management system on your computer, it opens the DMS Open dialog box instead of Visio’s Open dialog box. Likewise, when you save a file in Visio, the DMS Save dialog box appears so that you can save and store your Visio drawing within the DMS. If the DMS dialog boxes don’t appear, you might need to register Visio with your DMS application. Refer to your DMS documentation for instructions.

You can’t use a keyboard shortcut or a link on the File menu or Task Pane to access the DMS dialog boxes to open or save files. To open or save files with a DMS, you must choose File ➪ Open and File ➪ Save.

Tip
You can change the measurement units for the current drawing on the Page Properties tab in the Page Setup dialog box or by clicking the Change button on the Units tab in the Options dialog box.

Accessing Recently Used Files

Although Visio is extremely easy to use, you often need more than one work session to complete a drawing. You can quickly locate and open files you worked on recently with one of the following shortcuts:

✦ **Getting Started Task Pane** — Click a link in the Open section to open a Visio file you worked on recently.

✦ **New Drawing Task Pane** — Click a link in the Recently Used Templates section to create a new drawing based on a template you used recently.

✦ **My Recent Documents folder** — When you use the Open dialog box, click the My Recent Documents link in the Places bar to view Visio files you accessed recently. To open a file, select the file in the file list and click Open.

✦ **File menu** — Depending on the options you have chosen, a number of your recently used files appear at the bottom of the File menu. Click a file name to open that file.

Tip
You can modify the number of recently used files that appear on the File menu and in the Getting Started Task Pane. To do this, choose Tools ➪ Options, choose the General tab, and use the Recently Used File List arrows to specify the number of entries you want to appear. By default, Visio lists four documents; but you can have it list as many as nine.
Opening Other Types of Files in Visio

In Visio 2003, you can open stencils, templates, and workspaces, as well as files in other formats. Opening a workspace opens all the files and windows for that workspace, and positions the windows as they were when the workspace was saved. You can also open stencils and templates to customize them. When you open files saved in other graphic formats, Visio opens a Visio drawing that treats the graphic file as a single shape that you can move, resize, and rotate.

To open other types of files, choose File ➪ Open to access the Open dialog box. Choose the type of file you want to open in the Files of Type drop-down list. As you navigate to the folder that contains the file you want to open, Visio displays only files of the type you specified in the file list. Select the file you want and click Open.

If you want to insert content from a type of file that Visio doesn’t support, open the file using another drawing application, cut or copy a section of the image, and then paste it into a Visio drawing.

Cross-Reference
Tip
To learn more about working with other types of files, refer to Chapters 8, 9, and 28.

Finding Files

Whether you want to find a Visio drawing with a shape you customized, or locate a template for your next diagramming project, you can search for Visio files, stencils, and templates on your computer, on your network, in Microsoft Outlook, or online. Like other Microsoft Office applications, Visio 2003 provides several convenient methods for finding the files you want.

Using File Properties to Find Files

You can differentiate files by the values in their File properties, whether you use search methods or inspect the properties in the Properties dialog box. Visio automatically populates some of the file properties. Some of these are read-only, but many others are editable. In addition, you can populate other properties, such as Category or Keywords, to simplify locating the files you want in the future. When you select a file in the Open dialog box, you can click Tools ➪ Properties to view its properties before opening the file.

Visio automatically populates the properties on the General tab. These properties are read-only and provide basic identification of a file, including the type of Visio file, the folder location where the file is stored, the file size, and the template on which it is based.

Although Visio populates some of the fields on the Summary tab automatically, you can use these properties to describe and categorize your drawings and then search
these fields to locate the files you want. Add or edit text in any or all of the following fields:

- **Title** — A descriptive title for the file.
- **Subject** — A description of the drawing contents.
- **Author** — Visio populates this field with the name of the person who created or last updated the file. You can enter another name.
- **Manager** — The name of the person in charge of the project or the department for which the drawing was created.
- **Company** — This can represent either the company responsible for creating the drawing or the client for which the drawing was produced.
- **Language** — Visio populates this field with the default language, but you can change the language in this field. Visio uses the language specified in this field when it checks spelling.
- **Category** — This describes the drawing type, such as a database model, block diagram, or Gantt chart.
- **Keywords** — These are words that identify the file, client, project, or other aspects of the drawing contents.
- **Description** — This option provides additional information about the file, such as purpose or revisions made.
- **Hyperlink Base** — This specifies the path used as an origin for hyperlinks for which the path is not fully defined. By default, Visio uses a path relative to the current file.
- **Save Preview Picture** — Select this check box to save a preview picture of the first page of the drawing and display the preview when you click Preview in the Views menu in the Open dialog box.

The Contents tab lists each page in the drawing and the master shapes included on them. You can use this tab to identify the names of the masters used in a drawing.

**Searching for Drawing Files**

You can search for files no matter which method you use for opening files. Visio provides both basic and advanced search features to help you find the file you want. To search for a file, choose one of the following methods:

- **Choose File ➪ File Search** to open the Basic File Search task pane.
- **Choose File ➪ Open. Choose Tools ➪ Search** in the action bar to open the Microsoft Office Search dialog box, which includes the same features as the Basic File Search and Advanced File Search task panes, displayed using a different format.
Using Basic Search Options
With basic search options, you can look for files that contain one or more words in the body of the drawing, in keywords, or in other file properties. You can also specify where to look and the type of file you want.

If your computer is configured to work with other languages and you are searching in English, French, Spanish, German, Dutch, Italian, or Swedish, you can enter one form of a word in the Search Text box and Visio will search for other forms as well. For example, you can search for “connect” and Visio will also search for “connecting” and “connected.”

The basic search options include the following:

✦ Search for text — Type one or more words in the Search Text box that you want to find in file properties. You can use a question mark (?) as a wildcard for one character and an asterisk (*) as a wildcard for several characters.

✦ Search in — Click the Search In arrow and choose the locations you want to search. You can select folders and hard disks on your computer, in your network places, and in Microsoft Outlook. To browse locations, click a plus sign to expand the list. To choose a folder, select the check box next to the folder.

Note
When you search your Microsoft Outlook mailbox in English, you can use natural language in your search text. For example, you can type a phrase such as “Find all the messages from engineering sent last week.”

✦ Results Should Be — Click the Results Should Be arrow and choose the types of files you want to find. You can select Visio files, document imaging files, and Web pages.

After you have specified your search criteria, click Go to search for files. If you don’t see the file you want in the Search Results task pane, click the Modify button to return to the Basic File Search task pane.

Tip
To find files more quickly or to search for text in shapes and custom properties in a Visio drawing, enable fast searching on your computer. To do this, click the Search Options link in the Basic File Search task pane and select the option to enable the Indexing service. Your computer scans your files while it is idle and builds an index of file properties and contents. If the Indexing service is disabled, enabling it turns the Indexing services back on and sets its Startup Type to Automatic.

Constructing an Advanced Search
You can use the advanced search options to restrict the number of results Visio retrieves. To open the Advanced File Search task pane, shown in Figure 3-1, click
the Advanced File Search link in the Basic File Search task pane or select the Advanced tab in the File Search dialog box. With advanced search options, you can do the following:

✦ Choose the text or property to search, such as Creation Date.
✦ Choose a condition that the text or property should match, such as On Or Before, for a date.
✦ Specify the value for the search criteria, such as August 27, 2003.
✦ Define several search criteria, combining them with logical Ands and Ors.

Finding Templates and Sample Drawings

Visio provides numerous templates and sample drawings to help you get started. The Diagram Gallery introduces the different types of drawings you can create with Visio. You can also download sample drawings prepopulated with typical drawing
content from Microsoft Office Online. The New Drawing Task Pane includes links to search for templates on your computer, in your network places, on Web sites, and at Microsoft Office Online. You can use the following tools to find templates and sample drawings:

- **Diagram Gallery** — Choose Help ➪ Diagram Gallery to identify the type of drawing you want. Click a category and a drawing type to see a description and examples of its applications. Click Next and Back to browse drawings in sequence.

- **New Drawing Task Pane** — To search for templates and sample files, choose View ➪ Task Pane to open the Task Pane and then choose New Drawing in the Task Pane drop-down list. Choose one of the following methods to find a template or sample drawing:
  - **Search Online For** — Type words in the Open the New Drawing Task Pane and click Go. To find drawings with predrawn content, type Sample Drawings in the Search Online For box.

Sample drawings are now available at Microsoft Office Online instead of installed on your computer with Visio.

- **Templates on Office Online** — Search Microsoft Office Online for additional Visio templates.
- **On My Computer** — Browse folders on your computer for Visio templates.
- **On My Web Sites** — Browse the location in your network places.

### Saving Files

Saving your work can be one of the best productivity tools there is, because nothing reduces productivity like recreating work that was lost. The only hard part about saving files in Visio is developing the habit of doing so. To save a file, choose one of the following methods:

- Press Ctrl+S.
- Click Save on the Standard toolbar.
- Choose File ➪ Save.

Visio includes several options to configure how and where Visio saves files. To specify save options, choose Tools ➪ Options to open the Options dialog box and then choose one or more of the following options:

- **User Information** — Select the General tab to specify the user name and initials you want Visio to use as the author of drawings.
Chapter 3 ✦ Working with Visio Files

✦ Prompt for Document Properties on First Save — Select the Save tab to select the option that prompts for document properties the first time you save a file.

✦ Save AutoRecover Info — Select the Save tab to specify whether Visio saves your file automatically and, if so, how many minutes elapse between automatic file saves.

✦ Default File Type — Select the Save tab to choose the file format to which Visio saves by default. The options are to save files as Visio 2003 drawings, Visio XML documents, or Visio 2002 drawings.

✦ Default File Locations — If you organize your files in specific folders, select the Advanced tab and click the File Paths button to specify the location for drawings, templates, stencils, help files, add-ons, and startup paths.

You can share drawings with others by saving them to network locations, Web folders, or shared workspaces created through Windows SharePoint Services. You can access network locations and Web folders in the Places bar of the Save As dialog box. To learn more about shared workspaces, see Chapter 11.

✦ Remove Personal Information from File Properties on Save — Select the Security tab to remove the author name, manager name, and company name from file properties when you save a file.

When you save a drawing for the first time, Visio opens the Save As dialog box automatically. You specify a filename and location for the drawing and click Save to store the file. After the file is saved, it’s quickest to press Ctrl+S to save the changes you made to your drawing.

When you save a file, Visio not only saves any changes you’ve made to pages, shapes, and properties; it also saves the position of all open windows to the drawing workspace so that your Visio environment will look the same the next time you open the file.

Saving Visio Files

You can use your drawings for different purposes by saving them as different types of Visio files. The following list identifies the types of Visio files you can save and what they represent:

✦ Drawing — A file that contains pages of shapes and text you use to convey information.

✦ Stencil — A file that contains master shapes you drag onto drawings.

✦ Template — A file that Visio copies to create a new drawing. Visio copies into the new drawing any settings, stencils, windows, styles, macros, and other elements you define in the template.
✦ XML Files — This identifies XML versions of drawings, stencils, and templates. You can work with these files as you would regular Visio files, but you can also open them in a text or XML editor and access your Visio data via XML tools.

Visio 2003 can open Visio 2002 XML files, but you can’t save Visio 2003 files to Visio 2002 XML format. To do that, you must save the file as a Visio 2002 drawing and then convert it to XML in Visio 2002.

✦ Visio 2002 Files — You can share drawings with people who use Visio 2002 by saving a Visio 2003 file to Visio 2002 format. However, you will lose any information or formatting specific to Visio 2003.

To save a drawing as another type of Visio file, choose File ➪ Save As. Choose the type of file you want to use in the Save As Type drop-down list. Specify the file name and location and then click Save. You can also use File ➪ Save As to save Visio drawings in many other formats. These formats include the following:

✦ AutoCAD formats (.dwg, .dxr)

To learn about working with AutoCAD formats, see Chapter 28.

✦ Metafiles (.emz, .emf, .wmf)

✦ Graphics formats (.gif, .jpeg, .png, .tif, .bmp, .dib)

✦ Scalable Vector Graphics Drawing (.svg, .svgz)

Support for Scalable Vector Graphics (SVG) format is new in Visio 2003.

✦ Web Pages (.htm, .html)

To learn more about publishing Visio drawings to the Web, see Chapter 9.

Tip

You can save a Visio drawing as a print file, which you can then print from any computer connected to the type of printer specified for the drawing, even if Visio is not installed on that computer. To do this, choose File ➪ Print and select the Print to File check box. Click OK and specify the name of the print file and where you want to save it. Then, you can use the Windows \pr command in the Command Prompt window to redirect the print file to the printer you want to use. In addition, although Visio has removed support for PostScript formats, you can save Visio to a PostScript file by choosing a PostScript printer in the Print dialog box.
Protecting Files

You can protect your files from inadvertent changes in several ways. If you save a file as a read-only version, other users can only view the drawing. If you use the Protect Document feature, you can specify which items you want to protect. If you use layers on your drawing, you can lock a layer against changes.

To learn how to lock a layer, see Chapter 25.

Saving a Read-Only Copy

Saving a read-only copy is not a surefire way to protect the contents of a drawing. When you open a read-only drawing, you can modify its contents all you want, but you must save the modified file with a different name. In addition, you can also remove the read-only protection in Windows Explorer. However, the warning message that appears when you try to save a read-only file is often enough to prevent someone from inadvertently changing the contents of a drawing.

To save a read-only copy of a file, choose File ➪ Save As. After specifying a file name and location for the file, click the Save drop-down arrow to display Save options. Select Read Only and then click the Save button.

Protecting Drawings

To protect specific items on a drawing, follow these steps:

1. Choose View ➪ Drawing Explorer Window.
2. Right-click the name of the drawing you want to protect and click Protect Document on the shortcut menu.

   If Protect Document doesn’t appear on the shortcut menu, you can add the command to a Visio menu or toolbar. To do this, click the Toolbar Options arrow at the end of a toolbar, and choose Add or Remove Buttons ➪ Customize. In the Customize dialog box, select the Commands tab, select Tools in the Category list, and then drag Protect Document to a position on the toolbar.

3. Check the items you want to protect from unauthorized changes and click OK. You can protect the following elements of a Visio drawing:

   • **Styles** — Although you can still apply styles when this check box is checked, you can’t create new styles or edit existing ones.
   • **Shapes** — This setting combined with the From Selection setting in the Protection dialog box prevents you from selecting shapes.
• **Preview** — This option prevents changes to a Visio file’s preview image when you change the contents of a drawing page.

• **Backgrounds** — Use this to prevent the deletion or editing of background pages.

• **Master shapes** — This setting prevents the creation, editing, or deletion of masters. However, you can still create instances of masters on drawing pages.

To remove protection from a drawing, uncheck the check boxes in the Protect Document dialog box and click OK.

### Previewing and Printing Drawings

Visio works hard to ensure that your drawings print as you would expect. In most templates, the drawing page and printed page settings are the same, so you don’t have to adjust page settings. Visio also adjusts colors in your drawing to your printer’s resources. For example, if you don’t have a color printer, then colors appear in shades of gray. To get the best results the first time, it’s a good idea to preview your drawing before you print. You can make sure that you set page properties such as page size and orientation properly, and define the headers and footers you want to see.

**Note**

Shapes that lie outside of the drawing page do not print. To include these shapes when you print your drawing, move them onto the drawing page.

### Previewing Drawings

If you want to make sure that your drawing prints the way you want, you can preview your drawing before you print. Print Preview features in Visio are similar to those in other Microsoft Windows applications. To preview a drawing, choose File ➪ Print Preview or click Print Preview on the Standard toolbar. Visio shades the margins for the printer paper, so you can see how your drawing fits on it. If your drawing is larger than the paper, Visio displays shading where page breaks are located.

You can also preview the fit between your drawing page and printer paper in the Page Setup dialog box. Choose File ➪ Page Setup and select one of the Print Setup, Page Size, or Drawing Scale tabs. If the preview indicates a discrepancy, you can modify settings on these tabs to correct the problem.

**Tip**

The easiest way to ensure that the drawing and printer paper match is to use the Same As Printer Paper Size option. Choose File ➪ Page Setup, select the Page Size tab, and select the Same As Printer Paper Size option.
Printing Drawings

You can print entire drawings, specific elements on drawings, or specific areas of drawings. After you have previewed your drawing to confirm that it will print the way you want, it’s easy to print using one of the following methods:

✦ Press Ctrl+P.
✦ Click Print on the Standard toolbar.
✦ Choose File ➤ Print.

If shapes are missing on the printed drawing, the shape might be configured as a nonprinting shape, or the layer to which it is assigned might be set not to print. To reset a nonprinting shape, follow these steps:

1. Right-click the shape and choose Format ➤ Behavior.
2. Uncheck the Non-Printing Shape check box and click OK.

To check the shape layer, follow these steps:

1. Right-click the shape and choose Format ➤ Layer.
2. Choose View ➤ Layer Properties and make sure the Print column for the layer is selected.

If the shape still doesn’t appear, the printer driver might have misinterpreted the shape’s colors. To verify the presence of shapes, choose File ➤ Print and then select the Color As Black check box to print all lines and fills with black.

Printing Selected Parts of a Drawing

The Print dialog box contains options for specifying pages or portions of your drawing that you want to print. In addition, you can use other Visio features, such as layers and markup, to control what you print. To print selected part of a drawing, choose one of the following methods:

✦ Selected Pages — To specify the pages you want to print, choose File ➤ Print and choose one of the following two options:
  • Current Page — Click this option to print the active page.
  • Pages From and To — Type the number of the first and last page you want to print.

✦ Printing a Portion of a Drawing — To specify an area of the drawing you want to print, choose File ➤ Print and choose one of the following two options:
  • Selection — If you have selected shapes on your drawing, click this option to print only the selected shapes.
  • Current View — Click this option to print the portion of the drawing that appears in the Visio drawing window.
If you assign shapes to layers, you can control whether layers print. You can set up nonprinting layers for shapes you use as reference points, guides, or feedback. To prevent a layer from printing, choose View ➪ Layer Properties and clear the check mark in the Print column for the layer.

Tip

If you assign shapes to layers, you can control whether layers print. You can set up nonprinting layers for shapes you use as reference points, guides, or feedback. To prevent a layer from printing, choose View ➪ Layer Properties and clear the check mark in the Print column for the layer.

✦ Printing a Background Page — Display the background page you want to print and then choose File ➪ Print. Select the Current Page option and click OK to print the background page.

✦ Printing Only a Foreground Page — You must remove the background page associated with a foreground page if you want to print only the foreground page. To do this, display the foreground page and choose File ➪ Page Setup. Select the Page Properties tab, click None in the Background box, and click OK. Use the Current Page option in the Print dialog box to print the page.

✦ Printing Drawing Markup — Display the drawing markup and then print the drawing.

Tip

By default, guides are nonprintable objects, but you can print a guide by modifying the guide’s ShapeSheet. To do this, select the guide you want to print and choose Window ➪ Show ShapeSheet. Scroll to the Miscellaneous section and type False in the NonPrinting cell.

✦ Printing ShapeSheets — To print a ShapeSheet, you must download the Print ShapeSheet file from the MSDN Web site (http://msdn.microsoft.com/visio) and install it. You can print the ShapeSheet data to a printer, copy it to the Clipboard, or save it to a text file. Currently, the MSDN Web site does not have the Print ShapeSheet tool for Visio 2003. However, Microsoft expects to have updated information by March 2004.

Cross-Reference

For more information about ShapeSheets, see Chapter 33.

Correcting Orientation Mismatches

Although you can specify a different size and orientation for each page in a drawing, Visio uses one set of printer settings, which can lead to page and paper discrepancies when you print an entire file. If you assign different sizes and orientations to each page, print each drawing page separately and reset the Print Setup options before you print each page.

If you try to print a Visio drawing page that uses an orientation different from the printer page, Visio displays an error message. When you click OK in response to this error, Visio prints the drawing on multiple pages. To correct the problem before printing, click Cancel and then reset either the drawing page or printer paper orientation so they match.
If your drawing contains shapes that you want to see only while you are working on the drawing, you can specify shape options to prevent them from printing. To do this, select the shape or shapes and choose Format ➤ Behavior. Select the Non-Printing Shape check box and click OK.

**Printing Large Drawings**

When your drawing is larger than the largest paper size that your printer can accommodate, you can choose from several solutions, depending on your needs. If you’re fortunate enough to have a larger format printer available, you can add access to that printer to your computer and then print to a larger sheet of paper.

If your drawing almost fits on one sheet of paper, the easiest solution is to shrink the drawing to fit on one sheet. To do this, choose File ➤ Page Setup and select the Print Setup tab. In the Print Zoom area, click the Fit To option and type 1 in both the Across and Down boxes.

You can use the Fit To option anytime you want to print a drawing to a specific number of pages. Type the number of pages you want in the horizontal direction in the Across box, and then do the same for the number of pages wanted vertically, in the Down box.

Print Zoom won’t help if your drawing is much larger than your printer paper, or when you want to print your drawing to scale. You can view the relationship between your drawing size and printer paper in the Page Setup dialog box, as demonstrated in Figure 3-2. For these situations, you can tile your drawing across several sheets of paper.

![Page Setup preview shows page breaks for tiled drawings.](image)
When you tile a drawing, shapes that overlap the page breaks might print twice—once on each page on either side of the page break. To prevent this duplication of shapes, you can view the page breaks on your drawing and relocate any shapes that overlap them. After the overlaps are eliminated, you can print the drawing to multiple sheets. To eliminate shapes overlapping page breaks, follow these steps:

1. To view the page breaks on your drawing, choose View ➪ Page Breaks. Visio indicates page breaks with gray shading. The thickness of the shaded lines represents the margins set for the printed page.

2. To reduce the thickness of the page breaks, choose File ➪ Page Setup and select the Print Setup tab. Click the Setup button and specify narrower margins. Click OK in the Print Setup dialog box and then click OK in the Page Setup dialog box.

   Printers have minimum margins that you can’t reduce. If you specify margins smaller than the minimum for the current printer, Visio sets the margins to the smallest margin that the printer can handle.

3. On the drawing page, drag any shapes that overlap the page break to one side or the other.

**Printing Drawings in the Center of the Paper**

Visio offers several methods for centering drawings on the printed paper. You can move the contents of a drawing to the center of the page or change the resize property of the drawing to match the size of the contents. If your drawing page and printer paper are the same size, you can center your drawing by pressing Ctrl+A to select the contents of the page and then choosing Shape ➪ Center Drawing.

To center the contents of your drawing on a page, follow these steps:


2. Click the Size to Fit Drawing Contents option. The new drawing size appears in the preview area.

3. Select the Print Setup tab and click the Setup button.

4. Select the Center Horizontally and Center Vertically check boxes to center the drawing on the printer paper and click OK. Click OK in the Page Setup dialog box.
Summary

You can work on any kind of Visio file as well as files in a number of different formats in Visio 2003, although several formats are no longer supported. Visio includes a number of shortcuts for finding and opening the files you want, including links on task panes and searching text and properties in files. When you’re ready to print, you can specify how you want the drawing to print on the page as well as which portions of the drawing you want to see.
Shapes are the foundation of every drawing you produce in Visio. No matter what type of diagram you want to develop, you create content for drawings by dragging and dropping shapes onto drawing pages. Known as *SmartShapes*, these predefined shapes have built-in properties and behaviors that simplify your work.

As you work, you can select the shapes you want to work on in several ways. With a combination of Visio tools and shape handles and behaviors, you can position shapes easily and as precisely as you want. After adding shapes to a drawing page, you can use several Visio tools and add-ons to move, align, and duplicate those shapes. By dragging shape handles, you can change the size and outline of shapes. To simplify work on related shapes, you can create groups of shapes that act as one.

Because many drawings convey information through text and data, Visio also provides features for annotation and data storage. Visio shapes can contain custom properties for storing data about the shapes. You can add annotation with text or property values directly to Visio shapes. You can also use Visio add-ons to label and number the shapes on your drawings.

Visio provides hundreds of built-in shapes for dozens of different types of drawings. With so many shapes to choose from, you might wonder how you would ever find the shapes you want. In addition to categorizing shapes by placing them on stencils, Visio’s Search for Shapes tool helps you find shapes on your computer or the Web.
Shapes 101

If you’re anxious to get started, here’s what you need to know to start working with shapes. When you’re ready for more detail, continue reading the remainder of this chapter.

Shape Masters and Instances

You can quickly create drawings by dragging and dropping masters from stencils onto a drawing page. Predrawn shapes, called masters, are stored and categorized in stencils. A master can be as simple as a single line or quite complex, with numerous graphic and text elements, custom properties, and specialized behaviors. When you drag a master from a stencil onto the drawing page, the copy or instance inherits its master’s components, properties, and behaviors.

Although shape instances are linked to masters, you can still modify instances on drawing pages. Visio creates a special stencil that contains a copy of each master you use in a document. In fact, this document stencil is an easy way to create stencils of customized shapes by editing the instances in your document and then saving the document stencil.

Positioning Shapes

Although masters on stencils simplify your work, assembling your drawings involves more than dragging and dropping. Whether you’re drawing a scaled plan in which dimensional accuracy is critical or aligning shapes to neaten the appearance of a business diagram, you can use Visio tools to snap shapes into position (a process called snapping to). Rulers, grids, and guides act as reference points for alignment and accurate placement. However, you can snap to many other elements in Visio, including different parts of the shapes themselves. When precision is important, you can also position shapes by specifying x and y coordinates in the Size & Position window.

In addition to the initial placement of shapes, you can choose from several methods when you want to reposition the shapes on your drawings. Visio shapes include tools and techniques for moving and flipping shapes. You can also rotate shapes by dragging their rotation handles or specifying an angle in the Size & Position window.

Modifying Shapes

Visio includes several methods for modifying and duplicating shapes. You can change shapes to suit your needs and then quickly construct your drawing by repeating
existing shapes. The shapes you add to a drawing aren’t always exactly what you want. After you add shapes, you can also control them in the following ways:

✦ Reposition or manipulate them
✦ Drag them to another position or use coordinates to place them precisely
✦ Rotate or mirror them to the orientation you want
✦ Change their size and even modify their shapes
✦ Change their position in the stacking order

To repeat the shapes on a page, you can stamp multiple copies of a master or copy and paste one or more shapes. For shapes positioned at regular intervals, you can create an array of shapes.

Groups of Shapes

Groups of shapes further enhance your drawing productivity. In addition to moving several shapes as one, groups can include their own behaviors and features to speed up the creation of specialized graphics, such as a bar graph or title block.

Depending on a group’s properties, you can work with the group as a whole or with the individual shapes within the group. For example, when you add a title block to a drawing page, you can move the group into position, but you can also add text to the individual cells to annotate the drawing.

Finding Shapes

When you start a drawing from a template, Visio opens stencils with shapes typical for that type of drawing. However, you can add shapes already on your current drawing, from another drawing, in a stencil that isn’t open, or stored somewhere on the Web. Visio 2003 includes dozens of built-in stencils with thousands of specialized shapes. However, you can also find shapes on the Web, at Microsoft Office Online, and at many vendor Web sites.

For more information about shapes on the Web, including URLs for online sources, see Chapter 39.

You can search for shapes in several ways, including the Search for Shapes feature, which is a powerful tool for finding the shapes you want. If you intend to use the shapes you find frequently, you can save your search results to a custom stencil so the shapes are easy to access the next time you need them. To access Search for Shapes, open a new or existing drawing and, if the Shapes window is not open, choose View ➪ Shapes Window.
The Search for Shapes feature is similar to the Find Shapes command available in Visio 2002, but now you can enter search criteria and search directly from the Shapes window. Instead of specifying search options in a special dialog box, you can set the Shape Search options by choosing Tools ➪ Options and selecting the Shape Search tab.

Opening Stencils

It’s easy to drag shapes onto a drawing when the stencils containing the shapes you want are open. If you are working on a drawing you created without a template or the open stencils don’t contain the shapes you want, you can open and close stencils to access other shapes. For example, you can open the Charting Shapes stencil to add a table of information to an organization chart.

First, open the drawing you want to work on or create a new one. Then, to open a stencil, choose File ➪ Shapes and then use one of the following methods:

✦ Open a built-in stencil — Point to a category and choose a stencil.
✦ Open a custom stencil — Point to My Shapes and choose a stencil.
✦ Create a blank stencil — Choose New Stencil to add shapes to create your own stencil.
✦ Display the document stencil — To display a stencil that contains all the shapes on the current drawing, choose Open Document Stencil.

Note

If no drawing is open in Visio and you choose File ➪ Shapes and choose a stencil to open, Visio displays stencil-related toolbars and opens the stencil in a window with very limited functionality. For example, when you right-click a master in the stencil window, you can only copy the master or add it to one of your custom stencils. To access all the stencil features, open a Visio drawing and then choose File ➪ Shapes to open a stencil in the Shapes window.

Finding Shapes on Drawings

The Search for Shapes feature doesn’t help find shapes on your current drawing because it searches for keywords associated with shapes in stencils. For example, when a new manager assumes responsibility for a department, you might want to locate the shape for that position on a large organization chart by searching for the previous manager’s name. Using the Find command, you can look for shapes in your current drawing by searching for text in shape text blocks, shape names, custom property values, and user-defined cell values in ShapeSheets. To find a shape on your drawing, follow these steps:

1. Choose Edit ➪ Find.
2. Type the words or phrase associated with the shape you are looking for. To include special characters in the search text, click Special and then choose the special character you want to include.

To learn more about searching for text, see Chapter 6.

3. In the Search In section, select an option to specify which pages or sections of your drawing to search.

4. To specify the shape components that you want to search, check one or more of the check boxes in the Search In section. You can search shape text, custom properties, shape names, and user-defined cells in the ShapeSheet.

5. In the Options section, check one or more of the check boxes to specify the criteria for matching text.

6. Click Find Next to begin the search. Visio highlights the first shape it finds containing the search text. If the text is not visible in the drawing, Visio displays the location of the text in the Found In text box in the Find dialog box.

**Searching for Shapes**

The Search for Shapes feature scans for text matching your criteria in the keywords associated with shapes. Depending on the options you choose, Visio will search built-in and custom stencils on your computer as well as stencils it finds on the Web. When you search for shapes, Visio creates a search results stencil that contains the shapes it finds. You can drag a shape from the search results stencil onto your drawing or save a shape to another stencil so it is easier to locate in the future.

To search for shapes that you’ve created, you must add search keywords to the master on the custom stencil. To learn how to do this, see Chapter 32.

For the best results using Search for Shapes, specify descriptive words for your search text, such as “table” and “furniture,” rather than specific shape names. You can type words as singular or plural; Visio searches for both forms. For example, typing “buttons” returns shapes with either “button” or “buttons” as a keyword. Unfortunately, you can’t use wildcards in your search text. To improve your success, try the following techniques:

✦ When Visio doesn’t find any matching shapes or the results aren’t what you expect, try other words in your search criteria. For example, instead of “file,” try “cabinet.”

✦ When too many results are returned, add words or phrases to further screen the results. For example, using “table” returns a variety of database shapes in addition to furniture. Use “conference table” to locate shapes for large office tables.
Using the Search for Shapes Feature

You can search for shapes by typing keywords describing the shapes you want into the Search for Shapes box in the Shapes window and clicking the green arrow. You can enter one or more words, separating them with spaces, commas, or semicolons. Visio keeps track of the keywords you used recently so you can repeat a search by clicking the Search for Shapes down arrow, choosing the keyword entry you want to reuse, and clicking the green arrow.

**Note**

If the Shapes window isn’t visible, choose View ➪ Shapes Window to display it.

When you execute a search, Visio uses the current Shape Search options to determine where and how to search for shapes. If the search results don’t contain the shapes you want, you can modify the Shape Search options by following these steps:

1. Right-click the Shapes window title bar or the Search for Shapes area in the Shapes window and choose Search Options on the shortcut menu.

**Note**

You can also access Shape Search options by choosing Tools ➪ Options and then selecting the Shape Search tab.

2. To specify where Visio should search for stencils, check the My Computer check box in the Search Locations list to search folders on your computer. Check the Internet check box to search the Web.

**Note**

When you search the Web for shapes, Visio retrieves only the shapes associated with your Visio product. For example, you won’t see shapes from Visio Professional if you use Visio Standard. However, Visio Professional includes all the shapes available in Visio Standard and many more.

3. To specify which keywords a shape must possess, choose the All of the Words or Any of the Words option.

4. To view the shapes found grouped by the stencil to which they belong, select the By Group option in the Results section. If you want to view the results in a new window, check the Open Results in New Window check box.

5. To prevent Visio from retrieving an overwhelming number of results, check the Warn When Results Are Greater Than check box and type a cutoff number in the box.

6. Click OK when you are finished specifying Shape Search options and click the green arrow to execute the search.

7. To specify whether Visio displays Icons, Names, or Details in the search results stencil, right-click the Shapes Window title bar and choose one of the following options:
• **Icons and Names** — Displays icons and shape names just as other stencils appear by default

• **Icons Only** — Displays only icons

• **Names Only** — Displays only names, which uses less space in the window but requires more familiarity with the shapes

• **Icons and Details** — Displays icons, names, and a brief description of the shape

**Tip**

If you want to find more shapes similar to one that Visio retrieved, drag the shape to your drawing, right-click it, choose Shapes ➪ Find Similar Shapes. Visio uses the keywords associated with the selected shape to search for other shapes, and adds them to a search results stencil.

**Speeding Up Shape Searches with the Indexing Service**

If you search for shapes frequently, you can reduce search time by enabling the Indexing Service on your computer. In effect, the Indexing Service maintains an index of words associated with your shapes so that it can search a database instead of shapes or drawings.

**Tip**

If you don’t want shapes from the Web, searches are quicker if you uncheck the Internet check box on the Shape Search tab of the Options dialog box.

To enable indexing on your computer, make sure you have administrator privileges on your computer and then follow these steps:

1. Choose Tools ➪ Options and select the Shape Search tab.
2. Select Visio Local Shapes in the Search Locations list and click Properties.
3. Choose Yes, Enable Indexing Service and then click OK. Indexing might take a few minutes; the Shape Search Local Shape Properties dialog box closes when Visio finishes indexing your shapes.

**Troubleshooting Shape Searches**

If Visio doesn’t find shapes you want and you know they exist, check for the following problems:

♦ **No Keywords Associated with Shape** — Open the custom stencil for editing and add keywords to the master.

♦ **Stencil Keywords Don’t Match** — If you add keywords to a master shape and the Indexing Service is not enabled, the custom stencil in which the master is located might not have the same keywords as the master. Open the custom stencil for editing and check the keywords for the shape you created by right-clicking the master and choosing Edit Master ➪ Master Properties on the shortcut menu.
✦ **Index Being Updated** — If shapes contain keywords and the Indexing Service is enabled, Visio might be trying to search while the index is being updated. Try the search again after a minute has passed.

✦ **Custom Stencil Open for Edit** — Visio can’t search stencils when they are open for editing. If the stencil icon in the stencil title bar includes a red asterisk, the stencil is open for editing. To save it so it can be searched, right-click the stencil title bar and then click Edit Stencil. When the red asterisk in the stencil title bar disappears, you can search the stencil.

✦ **Stencil Path Is Incomplete** — In addition to searching the folders that contain Visio’s built-in stencils, the Search for Shapes feature searches for stencils in your stencil path. If you store stencils in several locations, make sure that your stencil path includes those locations. To modify the stencil path, choose **Tools ➪ Options**, select the Advanced tab, and then click **File Paths**. To browse folders, click the Ellipsis button to the right of the Stencils box and navigate to the folder you want. To specify more than one stencil path, type a semicolon between each path.

**New Feature**

Visio 2003 automatically creates a My Shapes folder in your My Documents folder, and creates a Favorites stencil in your My Shapes folder so that you can easily access the shapes you use most frequently.

To save the search results stencil as a custom stencil, follow these steps:

1. Right-click the search results stencil title bar and choose **Save As** on the shortcut menu.

2. In the File Namebox, type a name for the custom stencil and then click Save. By default, Visio saves stencils in your My Shapes folder.

To save a shape in the search results stencil to a custom stencil, right-click the shape and choose **Add to My Shapes** ➪ **Add to Existing Stencil**. You can choose the Favorites stencil, other custom stencils, or click **Add to New Stencil** to create a new custom stencil for the shape.

**Note**

To access custom stencils in your **My Shapes** folder, choose **File ➪ Shapes ➪ My Shapes** and then click the stencil you want to open.
Selecting Shapes

You have to select shapes before you can edit, position, or manipulate them. Visio provides several selection methods to select individual shapes, multiple shapes, and groups.

With any drawing tool active, you can click on a line or closed shape to select that shape. If you pause the pointer, the selection handles appear, followed by control handles at line midpoints, and finally corner control handles.

Selecting Individual Shapes

You can select individual shapes whether they stand on their own or belong to a group. To select one shape, use one of the following methods:

✦ **One Shape** — Click a shape to select it and display its selection handles.

✦ **One Shape in a Group** — To subselect a shape in a group, click the shape once to select the group and then click a second time to select the shape and display its selection handles, as shown in Figure 4-1. You can also select a shape within a group by double-clicking it.

![Figure 4-1: Click once to select a group and a second time to select a shape in the group.](image)

If clicking a shape doesn’t select it, the shape might be protected against selection, or it could belong to a group. To determine whether a shape belongs to a group, click the shape and choose Format ➤ Special on the shortcut menu. If the Type field value is Group, the shape belongs to a group, and you can double-click the shape to select it. If the shape doesn’t belong to a group, check for protection by clicking the shape, choosing Format ➤ Protection, and seeing whether the From Selection check box is checked. If it is, you can uncheck the box and click OK to remove this protection.
Selecting Multiple Shapes

Visio offers several ways to select multiple shapes, whether they are side by side or spread across your drawing. When you select multiple shapes, Visio highlights each selected shape with a magenta box and adds handles for the collection of selected shapes so that you can rotate and resize them all. When you want to work on several shapes at once, select them using one of the following methods:

✦ **Select Box** — To select the shapes within an area, click the Pointer tool on the Standard toolbar and drag a rectangle that completely encloses the shapes you want to select.

By default, Visio doesn’t select a shape if a portion lies outside the selection rectangle. To include shapes only partially contained within the selection rectangle, choose Tools ➪ Options and select the General tab. Check the Select Shapes Partially within the Area check box and click OK.

✦ **Shift+click** — To select shapes that are scattered across your drawing, hold the Shift key and click each shape you want to select.

You can select one or more groups using the same methods you use to select shapes. To select groups, make sure you click within the group only once.

✦ **Select Tool** — Click the Pointer tool arrow on the Standard toolbar to access other multiple selection tools:

  • **Area** — Select this tool and drag a rectangle to select the shapes within an area. If you drag another rectangle while shapes are selected, the Area tool adds shapes within the new rectangle to the selections.

  • **Lasso** — Select this tool and drag the pointer around an irregular path to enclose the shapes you want to select, as illustrated in Figure 4-2.

  • **Multiple** — Select this tool and click shapes to add them to the selection. Click a selected shape to remove it from the selection.

  You can draw an irregular boundary around the shapes you want to select with the Lasso tool.

✦ **Select All** — Press Ctrl+A to select all shapes on the drawing page.

✦ **Select By Type** — Choose Edit ➪ Select By Type and then select the Shape Type or Layer option. If you select by shape type, check the check boxes for each type of shape you want to select. To select layers, check the layer check boxes.
Positioning Shapes

With most business diagrams, you want shapes to line up so the drawing looks organized and neat, but you don’t care about the exact position of the shapes. When you create scaled drawings, such as building plans, precise positions are very important. For example, a few inches in the wrong direction could place a door in the middle of a structural column. In Visio, you can align shapes or place them precisely depending on the requirements of your drawing project.

Working with Rulers, Grids, and Guides

Rulers, grids, and guides help you position shapes, whether you want them merely aligned or placed in a precise location. You can use any or all of these tools to position your shapes, as demonstrated in Figure 4-3. If you don’t use these features, you can hide them from view so they don’t distract you. (I tell you how in the following sections.)
About Rulers, Grids, and Guides
Visio rulers, grids, and guides are similar to real-world tools used by drafters and graphic artists. In Visio, vertical and horizontal rulers appear along the side of the drawing window and show measurements based on the drawing scale, just like an engineering scale ruler would when you place it on a paper drawing. The Visio grid is like drawing on a sheet of grid paper. Visio drawing guides are like the light pencil lines you might sketch on a sheet of paper before you begin inking a drawing. More powerful than their real-world counterparts, rulers, grids, and guides can act as magnets, so you can quickly snap shapes into place.

Working with Rulers
Visio rulers show intervals corresponding to the measurement unit you specify on the Page Properties tab in the Page Setup dialog box. As you move the pointer on a drawing page, dotted lines on the rulers indicate the current pointer position. You can use these indicators for any editing task, including creating shapes with drawing tools, moving existing shapes, or specifying tabs in a text block. For example, you can add a wall 40 feet from the building shell by snapping to the appropriate marker on the ruler. Choose View Ruler to toggle the ruler’s visibility on and off.

![Figure 4-3: Use rulers, grids, and guides to help position shapes.](image)

The ruler subdivisions also determine the distance an object moves when you nudge a shape into position. When you press an arrow key with a shape selected, Visio moves the shape by one tick mark on the ruler.

You can adjust the coarseness of the ruler subdivisions and the position of the ruler origin to facilitate drawing. For example, you can reposition the ruler origin to a corner of a shape so you can easily draw other components relative to that shape.
To specify the subdivisions that appear on the rulers, use one or both of the following methods:

✦ **Set Measurement Units** — To change the units that appear on the rulers, choose File ➪ Page Setup and select the Page Properties tab. Select the units you want in the Measurement Units drop-down list.

![Note]

When you choose units such as Inches, or Feet and Inches, Visio sets the units based on eighths of an inch. If you choose Inches (decimal), Visio divides an inch into tenths.

✦ **Set Ruler Subdivisions** — To change how many subdivisions Visio displays, choose Tools ➪ Ruler & Grid. Select Fine, Normal, or Coarse in the Horizontal and Vertical Subdivisions boxes.

You can reposition the origin for the rulers, known as the zero point, to align with an element on your drawing. Visio also uses the zero point as the center of rotation when you rotate the drawing page. The zero point is usually located at the lower-left corner of the page. To move the zero point for the rulers, use one of the following methods:

✦ **Change the zero point on both rulers** — Hold the Ctrl key and drag from the blue cross at the intersection of the two rulers to a position on the drawing page. As you drag, Visio displays blue, dotted lines that represent the x and y axes. When you release the mouse button, Visio moves the zero point to that location.

![Note]

Be sure to press the Ctrl key before you click the blue cross at the ruler intersection. If you press the mouse button before you press the Ctrl key, Visio drags a guide point onto the drawing page.

✦ **Change the zero point on one ruler** — Hold the Ctrl key and drag from the ruler.

✦ **Reset the zero point to the lower-left corner** — Double-click the intersection of the two rulers.

**Working with a Grid**

When you display the Visio grid, horizontal and vertical lines crisscross the page to help you position shapes. Depending on the settings you choose, you can use the grid as a visual reference or you can snap shapes to the grid intersections. For example, you can quickly position structural columns every 20 feet by defining a 20 foot grid for the drawing and dropping column shapes onto grid intersections. Choose View ➪ Grid to toggle the grid on and off.

![Tip]

By default, the drawing grid doesn’t print, but you can print it with the drawing page by choosing File ➪ Page Setup, selecting the Print Setup tab, and checking the Gridlines check box.
Most Visio drawing types use a *variable grid*, which means that Visio determines the best grid spacing based on how far you are zoomed in or out. When you zoom in, the grid intervals represent smaller distances, and switch to larger distances as you zoom out. You can also specify a fixed grid, in which the grid lines remain the same distance apart no matter how you zoom. A fixed grid is helpful when you are working with specific distances, such as drawing a ceiling grid. You can set the grid spacing to the size of the ceiling tiles so that it’s easy to snap tiles into place or position HVAC components in the ceiling.

You can adjust the coarseness and origin of the grid to facilitate drawing. For example, you can reposition the grid origin to a corner of a shape so you can easily draw other components relative to that shape. To reposition the grid origin, choose Tools ➤ Ruler & Grid, type the x and y coordinates for the new grid origin, and click OK.

### Working with Guides
Guides are like reference points or guidelines you can place to help you position or align shapes. For example, if a building has walls at different angles, you can add guides at those angles to help align furniture with the walls. In addition to snapping to guides, you can glue shapes to them so that you can move shapes by moving their associated guide. Choose View ➤ Guides to toggle guide visibility on and off.

#### Tip
By default, guides are nonprintable objects, but you can print a guide by modifying the guide’s ShapeSheet. To do this, select the guide you want to print and choose Window ➤ Show ShapeSheet. Scroll to the Miscellaneous section and type False in the NonPrinting cell.

To create or modify guides, use one of the following methods:

- **Create a guide** — Drag a guide from the horizontal or vertical ruler onto the drawing page. Visio displays a blue dotted line for the guide.

- **Create a guide point** — Drag the intersection of the rulers onto the drawing page. Visio displays a blue circle with crosshairs to indicate a guide point.
Use a shape as a guide — Any Visio shape can act as a guide, including arcs and splines. To create a guide from a shape, right-click the shape, choose Format ➪ Style on the shortcut menu, and then select Guide in the Line Style box. The shape looks and acts like a guide, but still has selection handles you can use to modify it. However, guides created in this way remain visible when you hide guides and guide points.

Delete a guide or guide point — Select the guide or guide point and press Delete.

Note After defining guides for your drawing, you might want to turn off the grid so it doesn’t interfere with snapping to your guides and guide points. To turn off the grid, choose View ➪ Grid.

Move a guide — Drag a guide to a new position. You can also select a guide and type an x or y value in the Size & Position window.

Rotate a guide — Choose View ➪ Size & Position, select the guide you want to rotate, and type an angle in the Angle box in the Size & Position window.

Moving, Rotating, and Flipping Shapes

When precision is not important, you can use shortcut commands or dragging to position and rotate shapes.

In Visio 2003, shapes include rotation handles similar to those found in other Office products. You can drag a rotation handle to rotate a shape.

To move or rotate shapes without precision, use one of the following methods:

Move by Dragging — Position the pointer over a shape. When the pointer changes to a four-headed arrow, drag the shape to a new location.

Caution If you try to move a shape while it is selected, you might end up resizing it instead. Before moving a shape, make sure it is not selected by clicking the page background or pressing the escape (Esc) key.

Nudging a Shape — Select a shape and then press one of the arrow keys to nudge the shape one interval on the ruler.

Rotate by Dragging — Select a shape and drag its rotation handle until the shape is rotated to the angle you want.

Note As you drag the rotation handle, you can see the rotation angle in the status bar.

Shape Menu Rotation — Right-click a shape and choose Shape on the shortcut menu. Choose Rotate Left or Rotate Right to rotate a shape by 90 degrees. Rotate Left and Rotate Right are also available on the Action toolbar.
Sometimes you want the mirror image of an existing shape. For example, you might have an office set up for a right-handed person and want to flip the layout so the desk return is on the left instead of the right. In Visio, you can flip shapes and groups horizontally or vertically. Select the shape or group you want to flip and use one of the following methods:

✦ To mirror a shape about the vertical axis, choose Shape ➪ Rotate or Flip ➪ Flip Horizontal.
✦ To mirror a shape about the horizontal axis, choose Shape ➪ Rotate or Flip ➪ Flip Vertical.
✦ Click Flip Horizontal or Flip Vertical on the Action toolbar.
✦ Right-click the shape and choose Shape ➪ Flip Horizontal or Shape ➪ Flip Vertical from the shortcut menu.
✦ Press Ctrl+H to flip horizontally or Ctrl+J to flip vertically.

**Placing Shapes with Precision**

You can use several Visio tools to position shapes precisely. Snapping helps you position and align shapes by pulling shapes to elements on your drawing. For example, you can snap a desk to the walls of an office cubicle. However, you can also specify exact coordinates and angles when you know exactly where something belongs. In addition, Visio includes additional tools for specialized placement and alignment, such as distributing several shapes equidistantly.

**Snapping Shapes into Position**

When snapping is activated, Visio pulls the pointer to possible placement positions on the drawing page. You can easily snap one shape to another or snap a shape vertex to a position on the drawing ruler. You can specify which elements Visio snaps to as well as control the strength of attraction exerted by those elements. To activate snapping, choose Tools ➪ Snap & Glue and check the Snap check box.

Whether you are dragging an entire shape, a selection handle, a rotation handle, a vertex, or another Visio element, Visio uses the closest snap point for your editing action. As you move the pointer, Visio indicates the current pointer location with cross hairs. When the pointer nears a snap point, Visio also displays blue cross hairs at the snap point. When the pointer snaps to a connection point, Visio highlights the connection point with a red square, indicating that you can glue to that point.

You can snap to the following elements:

✦ **Ruler subdivisions** — Intervals on the horizontal and vertical rulers
✦ **Grid** — The intersections of lines on the drawing grid
✦ **Alignment box** — The dotted, green box that appears around a selected shape or group
Shape extensions — Dotted lines or points that show how to draw a line in relation to a geometric point, such as the tangent to an arc or the midpoint of a line. You can specify which extensions Visio displays by selecting the Advanced tab and selecting the extensions you want.

Shape geometry — The edges of a shape

Guides — Guides and guide points you create, as described in the “Working with Guides” section earlier in this chapter

Shape intersections — Points where two shapes intersect, shape extensions and shapes intersect, or shape edges and the grid are perpendicular

Shape handles — Green selection handles that appear when you select a shape

Shape vertices — Green diamonds that indicate the start and end points of line segments

Connection points — Blue Xs that indicate points to which you can glue a shape

To see examples of shape handles, vertices, and connection points, refer to Chapter 1.

To specify the elements Visio uses for snapping and how strongly those elements attract the pointer, follow these steps:

1. Choose Tools ➪ Snap & Glue and check the Snap check box to enable snapping.
2. Check the check boxes under Snap to, to specify which elements Visio snaps to.
3. To specify the snap strength, select the Advanced tab and drag the sliders to the left or right to weaken or strengthen the attraction of an element, respectively. As you drag the slider, the number of pixels required to attract the pointer appears in the Pixels box for that element. For example, if you use one pixel for snap strength, an element doesn’t attract the pointer until it is less than one-eighth of an inch away. If the snap strength is set to 40 pixels, the pointer snaps when it is about half an inch away.

Tip
Depending on what you are trying to do, snapping can become a hindrance instead of a help. For example, when you are drawing freeform curves, snapping can make curves choppy. If snapping is causing trouble, uncheck one or more check boxes in the Snap & Glue dialog box. You can also change Snap & Glue settings quickly by clicking commands on the Snap & Glue toolbar. To display this toolbar, choose View ➪ Toolbars ➪ Snap & Glue.

Using the Dynamic Grid and Drawing Aids
You can also enable the dynamic grid and drawing aids to facilitate the positioning of shapes. The dynamic grid displays horizontal or vertical, dotted lines whenever you drag the pointer to advantageous positions for shapes based on the location of other shapes on the drawing. For example, you can use the dynamic grid to drop a shape so it aligns with the top, bottom, left, right, or center of another shape on the drawing. To enable the dynamic grid, choose Tools ➪ Snap & Glue, and check the Dynamic grid check box.
Drawing aids are dotted lines that show the correct position for drawing a circle, square, or line at a specific angle. When you use the Line tool, you can snap to these aids to draw lines at a specific angle, such as 45 degrees. You can snap to drawing aids when you use the Rectangle or Ellipse tools to draw a square or circle. To enable drawing aids, choose Tools ➪ Snap & Glue and check the Drawing aids check box. Check the Shape extensions check box in the Snap To column.

**Positioning Shapes by Specifying Coordinates**

When you know exactly where a shape must be placed, it’s often easier to type the coordinates. The Size & Position window displays fields for specifying position and size, depending on the type of shape you select. For example, Visio draws 1D shapes based on the start point, end point, and an angle. 2D shapes include width, height, angle of rotation, and the position of the shape’s pin, which is the shape’s center of rotation.

The x and y coordinates that you see in the Size & Position window represent the page coordinates for the selected shape. Visio expresses page coordinates relative to the origin of the rulers and based on the drawing scale for the page. For 2D shapes, the position coordinates represent the position of the shape’s pin: a green circle with cross hairs that appears when you pause the pointer over the rotation handle of a shape.

Although the pin is set to the center of a shape by default, you can move the pin wherever you want by dragging it to a new position. When you rotate the shape, it will rotate around the new pin location.

Open the Size & Position window by choosing View ➪ Size & Position window and select a shape to view its coordinates. To modify the position of a 2D shape, as shown in Figure 4-4, type values in any of the following boxes:

- **X** — Change the horizontal position of the shape’s pin.

You can simplify specifying coordinates in the Size & Position window by moving the ruler zero point to a convenient position on the page. For example, if you want to move a shape four feet away from a wall, you can set the ruler zero point on the wall.

- **Y** — Change the vertical position of the shape’s pin.

- **Width** — Although this option doesn’t move the shape, it is a convenient way to specify a precise shape width.

- **Height** — Although this option doesn’t move the shape, it is a convenient way to specify a precise shape height.

- **Angle** — To rotate the shape, type an angle in the Angle box. Angles start with 0 degrees pointing to the right, and increase as you move counterclockwise relative to the shape’s alignment box.
Pin Pos — To align the pin with one of the shape selection handles, select an alignment in the Pin Pos list. When you change the alignment of the pin position, Visio moves the shape so the pin is located at the existing x and y coordinates.

![Shape pin position](image)

### Figure 4-4: You can move or resize shapes using the Size & Position window.

The Size & Position window locks to the bottom-left corner of the drawing window by default. You can drag and dock it at the bottom of the Shapes window to keep the entire drawing area visible.

**Tip**

Using the Move Shapes Add-On

Visio provides another tool for moving and copying shapes. Available only in Visio Professional, the Move Shapes Add-On has several advantages over the Size & Position window. You can perform the following actions with the Move Shapes Add-On:

- **Specify relative distances** — Move a shape relative to its current position instead of calculating the page coordinates for the new position.

- **Specify polar coordinates** — Move a shape a specified distance in the direction specified by an angle. For example, you can move a shape six inches at a 45-degree angle.

- **Move or copy shapes** — Copy the selected shapes or move them.
To move or copy shapes with the Move Shapes Add-On, follow these steps:

1. Select the shape or shapes that you want to move or copy and then choose Tools ➪ Add-Ons ➪ Visio Extras ➪ Move Shapes.

2. Select either Horizontal/Vertical or Distance/Angle. Specify the new position using one of the following sets of information:
   - **Horizontal/Vertical** — Enter the distances you want the shape to move horizontally and vertically in the Horizontal and Vertical boxes. To move a shape down or to the left, use negative numbers.
   - **Distance/Angle** — Type the radial distance (vector length) you want the shape to move into the Distance box. Type an angle to specify the direction you want to move the shape on the page, as shown in Figure 4-5. Angles start with 0 degrees pointing to the right, and increase as you move counterclockwise relative to the shape’s alignment box. 90 degrees points up; 180 degrees points to the left; and 270 degrees points down.

3. To copy the selected shapes instead of moving them, check the Duplicate check box.

4. To preview the move or copy action, click Apply. If the results are correct, click OK. Otherwise, click Cancel.

   If you click OK without previewing the results, you can press Ctrl+Z to undo the move or copy.
Aligning and Distributing Shapes

Visio provides several tools to help you arrange shapes neatly on a drawing. Although you can align shapes by snapping them into position, you can also line them up horizontally, vertically, or in both directions by using the Align Shapes command. In addition, you can distribute three or more shapes evenly using the Distribute Shapes command.

To align a shape to a guide or guide point, create the guide, as described in the “Working with Guides” section earlier in this chapter, and then drag a selection handle or end point to the guide. To facilitate the alignment of shapes with other shapes, choose Tools ➪ Snap & Glue, check the Shape Geometry, Shape Handles, or Shape Vertices check boxes, and click OK.

To use the Align Shapes command to align several shapes at once, follow these steps:

1. Select the shape to which you want to align other shapes, press Shift, and then click each shape you want to align to it. Visio outlines the primary shape with a thick magenta line.

2. Choose Shape ➪ Align Shapes and select the alignment options you want. To cancel an alignment, click the X. You can align shapes vertically to the top, center, or bottom of the primary shape. Horizontally, you can align shapes to the left, center, or right of the primary shape. Click OK to align the shapes.

To distribute shapes equally, follow these steps:

1. Select three or more shapes and then choose Shape ➪ Distribute Shapes. You can select the shapes in any order.

2. Click a distribution option. The top and bottom shapes in the selection define the distances for vertical distribution. For horizontal distribution, the shapes to the left and right define the distances. Click OK.

Caution

Distribute Shapes measures the distance between the outermost shapes and then positions the other shapes equidistantly in that space. If you want to distribute shapes at precise intervals, you can use the Offset command to create lines offset from a shape at a specific distance. You can then snap shapes to these lines. To create offset lines, select a line or curve and choose Shape ➪ Operations ➪ Offset. Type a value for the offset and click OK. Visio creates matching lines offset on either side of the original.

Moving Shapes with Guides

You can use guides to move several shapes without disrupting the arrangement of those shapes. To accomplish this, you glue the shapes to a guide and then move the guide, which drags the glued shapes along with it. For example, you can create a guide through the center of a row of equipment. By gluing the equipment shapes to the guide, you can reposition the equipment on the plant floor by moving the
guide. Because the guides are nonprinting objects, they won’t appear when you print your drawing unless you modify the NonPrinting cell in their ShapeSheets.

You can also move several shapes at once by grouping them. When you group shapes, you can define separate settings and behaviors for the group in addition to the member shapes.

To glue shapes to a guide, follow these steps:

1. Choose Tools ✲ Snap & Glue and make sure that both the Snap and Glue check boxes are checked.
2. Check the Guides check box in the Snap To and Glue To columns and then click OK.
3. To create a guide, drag from a ruler onto the drawing page.
4. Drag a shape to the guide and drop it when Visio highlights the connection point you want with a red box.

You can also glue shapes to guides while aligning or distributing them by following these steps:

1. Select the shapes you want to glue to a guide and choose either Shape ✲ Align Shapes or Shape ✲ Distribute Shapes.
2. Select the alignment or distribution options you want, check the Create Guide and Glue Shapes To It check box (or Create Guides and Glue Shape To Them if you are distributing shapes), and click OK. Visio creates a guide or guides and glues shapes as follows:
   - **Distribute Shapes** — Visio distributes the shapes using the option you chose and creates a guide for each selected shape. You can redistribute the shapes by dragging one of the outermost guides. You can’t drag an interior guide.
   - **Align Shapes** — Visio aligns the shapes using the alignment options you chose, creates one guide, and glues the shapes to it. You can move the shapes by dragging the guide to another location.

**Manipulating Shapes**

In addition to positioning tools, Visio provides numerous features for reproducing, resizing, and otherwise manipulating shapes on your drawings. You can copy shapes one by one or several at once. You can resize and scale shapes, group them so you can work with them as one entity, or change the order in which they appear when you stack them on top of each other. You can also add information to the custom properties for your shapes.
Visio 2003 introduces ink shapes that enable you to insert hand-drawn shapes into your drawings. To learn about Ink features, see Chapter 11.

When you’re manipulating shapes, you can also modify Visio’s display options depending on whether you want faster display or higher quality. To control how Visio displays shapes, choose Tools ➪ Options and then specify the following options:

- **Smooth Drawing** — Select the View tab and check this check box so your drawing doesn’t flicker as you stretch a bitmap or other non-Visio object.

- **Higher Quality Shape Display** — Select the View tab and check this check box to draw shapes with anti-aliased lines. Anti-aliased drawing displays smooth lines even at angles but is slower than aliased drawing.

- **Enable Live Dynamics** — Select the General tab and check this check box to view shapes instead of only the alignment box as you transform shapes.

If you select a shape and see padlocks where you would normally see selection handles, the shape is locked to prevent you from manipulating it. To learn how to lock or unlock shapes to protect them from repositioning, resizing, formatting, deletion, and other types of editing, see Chapter 7.

### Undoing Actions and Deleting Shapes

When the editing you perform makes changes you don’t expect, you can delete or undo your actions using one of the following methods:

- **Undo one action** — If you want to undo only your last action, the quickest way is to press Ctrl+Z.

- **Undo recent actions** — To undo several of your most recent actions, click the arrow to the right of the Undo button on the Standard toolbar. Drag the pointer to select the actions you want to undo and release the mouse button. If you want to undo the last several actions, press Ctrl+Z multiple times.

- **Redo one action** — To redo one action that you undid, press Ctrl+Y.

- **Redo several actions** — To redo several actions, click the arrow to the right of the Redo button on the Standard toolbar. Drag the pointer to select the actions you want to redo and release the mouse button. If you want to redo the last several actions, press Ctrl+Y multiple times.

- **Delete shapes and other objects** — Select the shapes you want to delete and press Delete.

- **Cut shapes to the Clipboard** — To remove shapes from the drawing page and place them on the Clipboard, select the shapes and press Ctrl+X. To paste cut shapes, press Ctrl+V.
You can also delete shapes by clicking Delete on the Standard toolbar. You can cut shapes by choosing Edit \& Cut or clicking Cut on the Standard toolbar.

**Duplicating Shapes**

When you manipulate a shape into exactly what you want, you can avoid tedious repetition by duplicating that shape to reuse your modifications. However, if you use a shape frequently, it's easier to save the modified shape to your Favorites stencil or another custom stencil so that you can drag it onto any drawing.

**Copying Shapes**

In Visio, you can copy one shape or many, and you can copy the selected shapes once or multiple times. You can copy shapes in the following ways:

- **Copy one or more shapes on a drawing**—Select the shapes that you want to copy and press Ctrl+C to copy them to the Clipboard. Press Ctrl+V to paste them onto the drawing. You can press F4 or Ctrl+V to repeat pasting the selected shapes.

- **Copy shapes on a layer**—To copy shapes on one or more layers, choose Edit \& Select By Type and select the Layer option. Check the check box for each layer you want to copy and click OK. Use Ctrl+C and Ctrl+V to copy and paste the selected shapes, respectively.

- **Copy a master**—To copy a master several times, select the Stamp tool on the Standard toolbar and follow these steps:

  1. On a stencil, click the master you want to duplicate.
  2. Click the drawing page to add an instance of the master to the drawing. You can continue clicking to place additional instances until you select a different tool.
  3. To specify the size of the shape, click and drag on the drawing page while the Stamp tool is active.

  **Note**

  If the Stamp tool doesn't appear on the Standard toolbar, click Toolbar Options on the Standard toolbar and choose Add or Remove Buttons \& Standard \& Stamp Tool.

  The Stamp tool doesn't work with shapes on a drawing page. You must click a master in a stencil to use the Stamp tool.

**Creating an Array of Shapes**

The Array Shapes command duplicates a shape or shapes across a number of rows and columns, separated by the distances you specify, as illustrated in Figure 4-6.
Figure 4-6: Array Shapes creates rows and columns of copies.

Array Shapes used to appear on the Tools menu. It is now available as a Visio Extras Add-On.

To array a shape or shapes, follow these steps:

1. Position an instance of the shape that you want to array at the bottom left of the array and choose Tools ➪ Add-Ons ➪ Visio Extras ➪ Array Shapes.

2. To specify the distance between copies in the rows and columns of the array, type the separation you want into the Rows and Column Spacing boxes.

3. To specify the number of rows and columns, type numbers in the Numbers boxes for the total number of rows and columns.

4. To specify how Visio spaces the shapes, choose a spacing option:
   - **Between Shape Centers**—Separates the centers of the shapes by the spacing distance
   - **Between Shape Edges**—Separates the edges of the shapes by the spacing distance

5. To rotate the copied shapes to match the primary shape, check the Match Primary Shape’s Rotation check box.

6. Click Apply to preview the results. If they are correct, click OK. Otherwise, click Cancel.
Resizing and Reshaping Shapes

The shapes you drag from a stencil onto your drawing aren’t always the right size for your purposes. Sometimes you want to enlarge a shape to emphasize it or to fit its text within the shape’s boundaries. At other times, you might reduce the dimensions of a shape so you can fit more on a page. Visio provides several methods for resizing shape dimensions. You can also drag vertices and eccentricity handles to change the shape of a shape.

You can merge and decompose shapes in various ways to create more complex shapes. To learn about these capabilities, see Chapter 32.

To resize a shape, select the shape and then use one of the following methods:

✦ **Resize 1-D shapes** — Drag the selection handles at the end points to lengthen or shorten the shape. For 1D shapes with thickness, such as a 1D Single Arrow, you can also drag the selection handles at the midpoints to modify the thickness.

✦ **Resize 2-D shapes** — You can resize 2D shapes horizontally, vertically, or in both directions at once:

  • **Resize Horizontally** — Drag the selection handle at the midpoint of the left or right of the shape alignment box.
  
  • **Resize Vertically** — Drag the selection handle at the midpoint of the top or bottom of the shape alignment box.
  
  • **Resize Proportionally** — Drag a corner selection handle to change the horizontal and vertical dimensions in proportion to each other.

When a shape belongs to a group, you can specify how a shape resizes when you resize the group. A shape can resize along with the group or remain the same size but reposition itself relative to the new group boundaries.

✦ **Specify Shape Dimensions** — You can use the Size & Position window to resize shapes. Refer to the “Positioning Shapes by Specifying Coordinates” section earlier in this chapter for more information.

When you work on a scaled drawing, you can change the dimensions of a shape as you would on any other drawing. However, if you want shapes to appear smaller on the drawing page without changing their real-world measurements, you alter the scale of the drawing. To set the scale for a drawing page, choose File ➪ Page Setup and select the Drawing Scale tab. Specify the scale you want and click OK.

✦ **Reshape a shape** — Pause the pointer over a shape to display its vertices and eccentricity handles. You can change the form of a shape by dragging a vertex to a new position. For example, you can stretch a corner of a rectangle. To bend the side of a shape, drag the eccentricity handle on that side.
You can also change the dimensions of a shape in the ShapeSheet. To learn more about using ShapeSheets, see Chapter 33.

Reordering Overlapping Shapes

As you add or move shapes, one shape might hide a shape that you want to see. For example, if you add a 3D bar graph to a drawing and then drag the 3D axis onto the page, the axis shape hides the bar graph completely. To correct this, you can rearrange the order in which Visio overlaps shapes. Visio provides four options for reordering shapes. Bring to Front and Send to Back appear on the Action toolbar as well as in the Shape submenu on a shape’s shortcut menu. To access all four reordering commands, choose Shape ➤ Order and then choose one of the following commands:

- **Bring to Front** — Places the selected shape in front of all other shapes
- **Bring Forward** — Brings the selected shape forward one layer in the stacking order
- **Send to Back** — Places the selected shape underneath all other shapes
- **Send Backward** — Sends the selected shape back one layer in the stacking order

**Tip**

By clicking several times where a shape is located, you can cycle through selecting the shapes stacked on top of each other even when you can’t see the shapes.

Storing Data in Shapes

Shapes can contain more than the lines and text that you see on the drawing page. Custom properties associated with shapes store data similar to the way in which fields store data in a database record. You view and edit these fields in the Custom Properties dialog box. You can use them to produce reports, such as a door or window schedule for a floor plan, or display them in shape text blocks, as organization chart drawings do by showing the employee name, title, and telephone number in each organization chart shape.

To learn how to create custom properties and associate them with shapes, see Chapter 32.

To view and store data in shapes with custom properties, follow these steps:

1. To open the Custom Properties window, choose View ➤ Custom Properties Window.

**Tip**

Drag the Custom Properties window into the Shapes window to dock it so that you can see shape properties and your drawing at the same time.
2. Select a shape to display its properties in the Custom Properties window. If the shape doesn’t contain any custom properties, the window displays the text No Custom Properties.

3. To enter a property value, click the property you want to edit and type the value in the box. If the property includes a drop-down list, you can click a value in the list.

4. To view a prompt for a property, pause the pointer over the property label in the left-hand column of the Custom Properties window. If the property has a prompt, it will appear next to the label.

Note
You can also access a shape’s custom properties in its Custom Properties dialog box. To open this dialog box, right-click the shape and choose Properties from the shortcut menu.

Grouping Shapes
Quite often, you would like several shapes to work together as if they were one shape, but you also want them to retain their individuality. For example, a table of data in Visio includes many individual boxes and text blocks. You want the table to move as a single unit, but you also want to format and resize individual table cells. The easiest way to obtain this behavior is to group shapes. Many masters in Visio stencils are actually groups, such as title blocks. You can create your own groups, ungroup and modify built-in groups, and even nest groups within other groups.

When an element on your drawing doesn’t behave as you would expect, it could be a different type of object than you think it is. Groups behave differently than shapes. Merged shapes can be quite elaborate, but they are still shapes. To determine whether an element is a shape or group, select it and then choose Format ➪ Special. The Type field displays Shape or Group.

Groups are separate objects in Visio, so each group has its own text block and ShapeSheet separate from the text blocks and ShapeSheets for each shape in the group. You can add text to the group text block, configure the group’s options and behaviors, and define formulas for the group. For example, you can specify how a group resizes or create a formula that adds shapes to a group based on the value of a custom property.

Caution
Think twice before ungrouping shapes; doing so eliminates the group ShapeSheet, with its associated data and formulas.

Creating and Breaking Up Groups
You can create a group out of several shapes or divide a group into its component shapes. Visio includes commands to add or remove shapes from an existing group,
so you don’t have to eliminate a group to add or remove shapes. Use the following methods to create, modify, or eliminate a group of shapes:

✦ **Create a group**—Select the shapes you want to group and then choose Shape ➪ Grouping ➪ Group.

✦ **Break up a group**—Select the group and then choose Shape ➪ Grouping ➪ Ungroup.

✦ **Add a shape to a group**—Select the group and the shape you want to add and then choose Shape ➪ Grouping ➪ Add to Group.

Note

Sometimes the group’s alignment box doesn’t reflect the changes you’ve made, particularly when you resize the shapes in a group. When the alignment box doesn’t match the shape boundaries, snapping to the group might position shapes in unexpected places. To reset the alignment box, select the group and then choose Shape ➪ Operations ➪ Update Alignment Box.

✦ **Remove a shape from a group**—Select the shape within the group and then choose Shape ➪ Grouping ➪ Remove From Group.

Tip

You can select a shape within a group by double-clicking it.

You can specify the behavior of groups and some of the behaviors of the shapes that belong to them. For example, you can control how shapes within a group resize when you resize the group, the order in which you can select groups and shapes, and whether you can add shapes to groups by dropping them onto the group. To specify group behaviors, select the group and choose Format ➪ Behavior.

Cross-Reference

To learn more about the options for controlling group and shape behaviors, see Chapter 32.

**Working with Locked Groups**

When you try to edit some groups, Visio warns you that shape protection prevents execution of the command. This occurs when a group is locked to prevent you from ungrouping it. Many groups in built-in stencils are locked so that you can’t inadvertently reset built-in behaviors or formulas. For example, the 3-D Bar Graph on the Charting Shapes stencil is a group of bar shapes. The group has control handles so you can adjust the height of the tallest bar and the width of all the bars. If you experiment with the 3-D Bar Graph, you’ll find that you can’t reposition, resize, or edit the shapes in the group. You can only change them by dragging the group’s control handles or by changing values in the group’s custom properties.

The group is locked so you can’t ungroup it and eliminate the features provided by its control handles and ShapeSheet formulas. In addition, the group is configured so that you can’t reposition shapes in the group. Because the power of many grouped
shapes depends on their group features, you should think twice before removing locks and other protection settings. Visio makes these settings a bit harder to change by placing them on the group ShapeSheet.

Tip
If you choose to unlock a group, consider making a copy of the group before you unlock or break it up.

To reset group protections, select the group and then choose Window ➤ Show ShapeSheet. Use one of the following options:

✦ Unlock a group — Scroll down until you see the LockGroup cell in the Protection section of the ShapeSheet. Click the LockGroup cell (which contains the number 1), type 0, and then press Enter.

Note
You can add or remove protections in the Protection section of the ShapeSheet by typing 1, which represents True or On, or 0, which represents False or Off, in protection cells. The Protection section of a group ShapeSheet includes special group protection settings as well as the settings available in the Protection dialog box that appears when you choose Format ➤ Protection.

✦ Configure a group so you can reposition its shapes — Scroll down until you see the Don’tMoveChildren cell in the Group Properties section of the ShapeSheet. Type False in this cell to enable repositioning of the shapes in the group.

Cross-Reference
To learn more about working with ShapeSheets, see Chapter 33.

Labeling and Numbering Shapes

Drawing annotation helps your audience interpret your drawings, whether you use text shapes and callouts to display notes; label shapes with data associated with shapes; or number drawing elements for identification.

Cross-Reference
To learn how to annotate shapes with callouts and custom property values, see Chapter 6.

Many types of drawings number or label their elements for identification. For example, blueprints number the columns on a structural plan so the construction crew knows how to assemble the steel. You can use the Number Shapes Add-On to number shapes as you add them to your drawing or after all the shapes are in place. By default, Visio increments numbers moving from left to right and from top to bottom on the drawing. However, you can choose the order you want, as shown in Figure 4-7, or number shapes manually.
Shape numbering

Figure 4-7: You can identify shapes on a drawing with the Number Shapes Add-On.

To number shapes on a drawing, follow these steps:

1. If you want to number specific shapes on the drawing, select them in the order you want them to be numbered.

2. Choose Tools ▶ Add-Ons ▶ Visio Extras ▶ Number Shapes.

3. Choose an Operation option to specify how you want to number the shapes:
   - **Manually By Clicking** — Adds the next number in a sequence to a shape when you click it
   - **Auto Number** — Numbers shapes based on the order you specify on the Advanced tab

You can also renumber shapes by choosing Renumber Maintaining Sequence on the General tab. When you choose this option, select the Advanced tab and specify whether you want to renumber shapes with unique numbers or allow duplicates in the sequence.
4. Specify the sequence you want. The Preview field in the Number Shapes dialog box shows an example of the sequence you have specified.
   
   - **Start With** — The first number in the sequence
   - **Interval** — The gap between each number in the sequence. For example, an interval of 3 would create a sequence that begins 1, 4, 7.
   - **Preceding Text** — Text that precedes the number. For example, for steps in a process, you can choose Step in the list. For columns on a floor plan, you might choose A. or a.

   **Tip**
   Sometimes you might want two numbering sequences, such as numbers for the columns and different letters to identify each row. To apply two-part numbering schemes, select each row, specify the letter for that row in the Preceding Text box, and number the shapes. Repeat this process after selecting the shapes in the next row on the page.

5. To number shapes that you add later, check the Continue Numbering Shapes As Dropped On Page check box.

6. Select the Advanced tab to specify other numbering options.

7. Select an option to specify where the number appears relative to the shape text.

8. If you are using the Auto Number option, specify the order you want. You can number from left to right and then top to bottom, top to bottom and then left to right, from back to front, or in the order that you selected the shapes.

   **Note**
   To hide the shape numbers, check the Hide Shape Numbers check box on the Advanced tab.

**Summary**

Drawings are made up almost entirely of shapes, so Visio provides plenty of tools for finding, adding, and manipulating the shapes on your drawings. In this chapter, you learned how to work with existing shapes in numerous ways, including the following:

- Finding shapes on drawings
- Searching for shapes in stencils
- Selecting the shapes you want to work with on a drawing
- Snapping shapes into position as well as positioning shapes precisely
- Aligning shapes
- Duplicating shapes
✦ Resizing shapes
✦ Reordering shapes when they overlap
✦ Storing data in custom properties
✦ Grouping shapes
✦ Adding numbered labels to shapes

In addition to the features you can use on existing shapes, Visio provides even more tools to help you customize and create your own shapes. See Chapters 32 and 33 to learn more about these customization tools.
Connecting Shapes

Some shapes stand on their own, such as title blocks or legends, but in most diagrams the relationship between shapes constitutes a great deal of the information you’re trying to convey. For example, imagine an organization chart without reporting relationships between managers and employees, or a data flow diagram without flows between processes.

In Visio, you can show the relationships between shapes with connectors. In this chapter, you’ll learn how to define relationships by gluing shapes together with connectors. You can attach connectors to specific points on shapes or let Visio choose the best spot for the connection.

In fact, you can let Visio take complete control of the layout and arrangement of the shapes on your drawings. You can specify settings for the spacing between shapes, the type of shape arrangement you want, and the method for showing connectors that cross on a page. As you add or move shapes, Visio uses those settings to lay out your drawing.

Using Connectors

In Visio, you show relationships by using 1D shapes called connectors to join the 2D shapes on your drawings. Connectors come in all shapes and sizes, from unadorned lines to 1D shapes specialized to suit the different drawing types that Visio supports, as illustrated in Figure 5-1. No matter how fancy the formatting, connectors all boil down to lines that attach to shapes at each end.
Beginning endpoint
Control point
Ending endpoint

The stencils associated with each drawing type usually include connectors suitable for your drawing. In addition, the Connectors stencil contains many of the most popular connectors for all drawing types.

Connectors have starting and ending points that you can use to define the predecessor and successor for two connected shapes. All connectors store direction information, whether they include visual cues, such as arrowheads, or not. For example, in an organization chart, the direction of a connector differentiates the manager and the employee. When sequence is important, you must connect the correct end of the connector to the predecessor and successor shapes. For situations in which order doesn’t matter, you can connect whichever end of the connector you want.

**Cross-Reference**

For an overview of connection concepts, see Chapter 1.

Visio provides visual cues to show you where you can connect shapes and connectors. 2D shapes often include connection points, which are locations you’re likely to use on those shapes. Visio indicates a connection point on a shape with a blue x.
Each end point on a connector looks a little different. The starting point for the connector is a green square with an x inside the square. The end point is a green square with a + inside the square, as shown (without the color, of course) in Figure 5-1.

You can also use other types of points to make connections between shapes and connectors. To learn more about specifying glue points, see the “Specifying Points for Glue” section later in this chapter.

Depending on the template you use and the shapes you want to connect, you can choose from a variety of methods for connecting shapes. With some templates, such as the Organization Chart, you can simply drop a shape onto another shape to connect them. You can also drag connectors from stencils or use the Connector tool to create connectors by dragging from shape to shape or even to create a sequence of connected shapes.

### Using Stencil Connectors

Dragging connectors from stencils is probably the most popular method for connecting shapes because Visio automatically opens stencils with suitable connectors when you use templates to create drawings. It’s easy to drag the connector you want onto a page and attach it to the shapes you want to connect.

Visio makes it easy to access basic connectors, such as the Dynamic connector and the Line-curve connector, by including them on many stencils. For a wide selection of connectors appropriate for numerous types of drawings, open the Connectors stencil by choosing File ➪ Shapes ➪ Visio Extras ➪ Connectors.

To connect shapes using a connector from a stencil, follow these steps:

1. Drag the connector you want from a stencil onto the page.
2. Drag one end point of the connector to a connection point on a shape.

   **Tip**

   You can create a dynamic or static connection, depending on the point you select on a shape. When you drag an end point into a shape, Visio highlights the entire shape with a red box, indicating that you’re creating a dynamic, or shape-to-shape, connection. To create a static, or point-to-point, connection, drag an end point to a connection point. Visio highlights the connection point with a red box.

3. Drag the other end of the connector to a connection point on another shape.

   **Note**

   If the direction of the connection is important, drag the beginning end point of the connector to a connection point on the predecessor or superior shape. Drag the end of the connector to a connection point on the successor or subordinate shape.
Using the Connector Tool

You can also create connectors as if you were drawing lines, by dragging the pointer from the first shape to the second. It’s easier to create connectors with a specific direction with this method because you naturally draw from the predecessor shape to its successor. To draw connectors with the Connector tool, activate the tool by clicking the Connector tool on the Standard toolbar and then use one of the following methods:

- **Static (Point to Point)** — Position the pointer over a connection point on the first shape. When Visio highlights the connection point with a red box, drag to a connection point on the second shape.

- **Dynamic (Shape to Shape)** — Position the pointer inside the first shape. When Visio highlights the shape with a red box, drag to a position inside the second shape.

- **Static-Dynamic** — Position the pointer over a connection point on the first shape. When Visio highlights the connection point with a red box, drag to a position inside the second shape.

- **Dynamic-Static** — Position the pointer inside the first shape. When Visio highlights the shape with a red box, drag to a connection point on the second shape.

You can also connect shapes automatically as you drop them onto a drawing page. When the Connector tool is active, Visio automatically connects each new shape you add to the previous shape with a dynamic connection.

**Tip**

When shapes are small or contain connection points in inconvenient locations, you can have trouble creating dynamic connections. To create a dynamic connection no matter where you position the pointer on a shape, hold the Ctrl key as you drag the end point or Connector tool over the shape.

When you use the Connector tool to draw connectors, Visio creates Dynamic connectors by default. However, you can use the Connector tool to create any kind of connector. To create another type of connector with the Connector tool, follow these steps:

1. Click the Connector tool on the Standard toolbar.
2. Click a connector master in a stencil in the Shapes window.
3. Draw a connector from the first shape to the second. Visio creates the type of connector you selected in the stencil.
Dragging Points to Connect Shapes

Specialized connectors simplify your work with behaviors and features tailored to a specific type of drawing. These connectors are actually shapes with connectors built in. You can drag control points on these shapes to attach connectors to other shapes. For example, by dragging the control point on the trunk of the Multi-Tree Sloped shape on the Blocks stencil, you can connect branches on the tree to several shapes, as shown in Figure 5-2.

Indication for point-to-point connection

Figure 5-2: Drag control points on connector shapes to create connections.

Tip
To find out what a control point can do, position the pointer over the control point. Visio displays a tip on the screen, as demonstrated in Figure 5-2.

Connecting a Sequence of Shapes

When you’re creating a drawing with a sequence of shapes, such as the steps in a procedure, you can add the shapes to your drawing, and instruct Visio to create the dynamic connections. To connect a sequence of shapes, select the shapes in the order you want them to appear in the sequence and then choose Shape ➪ Connect Shapes.
Organizing Connections with Glue

The paths that your connectors take depend on how you glue the connectors to shapes. Visio glue comes in two types: static and dynamic. Static glue (also called point-to-point glue) connects specific points on two connected shapes. As you move those shapes around, the connector remains attached to the points you glued, no matter how convoluted the connector path becomes. Static glue is best used when the connection point is important. For example, in a flowchart, you don’t want Visio to reattach a process to a different decision when you move the process on the page. With dynamic glue (also called shape-to-shape glue), Visio changes the connection points it uses as you move shapes around, connecting the two shapes by the shortest route. Dynamic glue is helpful when you construct diagrams such as block diagrams, where the specific connection point doesn’t matter.

Gluing Shapes

You can use any combination of glues when you connect two shapes. When you want to use the automatic layout tools, you must connect shapes using shape-to-shape, or dynamic, glue at both ends of the connector. However, you can also connect two shapes with one end of the connector glued with static glue and the other using dynamic glue. In this situation, the connection point that is glued dynamically can change as you move the shapes. The end point that is glued statically remains glued to the same point no matter where you position the shapes. You can also use static glue at both ends.

Tip

Use dynamic glue while you develop a diagram, so Visio automatically adjusts connections as you move shapes around. When you finalize the layout, you can change the connections between shapes to static glue to fix the connection points that Visio uses.

In some situations, glue gets in the way. For example, when you’re dragging connectors onto a crowded page, it’s difficult to drop a connector onto the page without gluing it to a shape. To prevent Visio from gluing connectors to shapes, choose Tools ➪ Snap & Glue, uncheck the Glue check box under Currently Active, and click OK.

Tip

The Snap & Glue toolbar includes buttons to specify which points Visio uses for snapping or gluing. If you want to switch the options for snap or glue frequently, choose View ➪ Toolbars and then choose Snap & Glue. Click one of the buttons to toggle a snap or glue option on or off.

Specifying Points for Glue

Although connection points are natural choices for gluing connectors to shapes, you can glue to other points on shapes. To specify the points that Visio uses for glue, follow these steps:
1. Choose Tools ➪ Snap & Glue.

2. Under Glue To, select one or more of the following options:
   - **Shape Geometry** — Glues connectors anywhere on the visible edge of a shape
   - **Guides** — Glues connectors or shapes to guides
   - **Shape Handles** — Glues connectors to shape selection handles
   - **Shape Vertices** — Glues connectors to shape vertices
   - **Connection Points** — Glues connectors to shape connection points

## Adding, Moving, and Deleting Connection Points

Visio adds connection points to the selected shape. Connection points don’t have to reside on or within the shape to which they belong. You can position a connection point anywhere on the drawing page, although connection points too far removed from their parent shapes can lead to confusion.

You can add, move, or delete connection points only while the Connection Point tool is active. To activate the Connection Point tool, click the arrow to the right of the Connector tool button on the Standard toolbar and choose Connection Point Tool on the menu. Visio displays a green, dotted line around the selected shape. To revert to the Connector tool, click the arrow to the right of the Connection Point tool and choose Connector Tool on the menu.

Visio provides three types of connection points: Inward, Outward, and Inward & Outward. Most built-in masters already contain connection points. To learn how to specify connection point types when you create your own customized shapes, see Chapter 32.

To work with connection points, activate the Connection Point tool, select a shape, and then use one of the following options:

- **Add a connection point** — Hold the Ctrl key and click the position where you want to add the connection point. Visio displays the new connection point as a small purple x, which changes to blue when you execute the next action.

Tip

It’s easier to add connection points when Snap & Glue is activated. To activate Snap & Glue, choose Tools ➪ Snap & Glue, check the Snap and Glue check boxes, and click OK.
✦ **Move an existing connection point** — Drag the connection point to a new location.

✦ **Delete a connection point** — Select the connection point you want to delete and press the Delete key.

In Visio 2002, you had to select the shape before activating the Connection Point tool because there was no way to change the selected shape while the Connection Point tool was active. In Visio 2003, you can click a shape to select it while the Connection Point tool is active.

## Automatically Laying Out Shapes

When you use dynamic connectors to create shape-to-shape connections, you can take advantage of Visio’s automatic layout and routing tools to arrange the shapes on your drawings. Dynamic, or shape-to-shape, connections know how to navigate around other shapes, jump over other connectors, and choose the connection points that create the best route between the connected shapes. You can harness this power and specify how you want shapes to lay out, and connectors to route and jump, by using the Layout Shapes command. Under most circumstances, automatic layout and routing perform as you would expect. By understanding how layout and routing work, you can specify options to achieve the results you want.

**Caution**

For automatic layout and routing to work properly, shapes must be connected with shape-to-shape connections. If connectors don’t stay attached to shapes or their end points are green, they aren’t glued properly. To glue connectors to shapes, drag the end point until Visio highlights the shape with a red box. An end point changes to a solid red square if it uses a shape-to-shape connection. The end point is a smaller red square with an x if it uses a point-to-point connection.

If the connections are correct, but automatic layout still doesn’t work properly, verify that the connector is drawn in the right direction. To do this, make sure the connector is not selected and then drag the connector away from its shapes. The starting point for the connector is a green square with an x in it. The end point is a green square with a +. Reattach the connector end points in the correct direction.

## Configuring Placement Behavior

The behaviors associated with shapes affect how those shapes react when you use the layout and routing tools. Stencil shapes for drawings that depend on connections, such as network diagrams or organization charts, are already configured to work with layout and routing. However, you can modify shape behaviors or add behaviors to shapes. For example, you can specify whether Visio lays out and routes around a shape, and, if it does, whether the shape moves during placement and how the shape interacts with other shapes and connectors.
To configure the placement behaviors for a shape, follow these steps:

1. Right-click a shape and choose Format ➪ Behavior from the shortcut menu.
2. Select the Placement tab.
3. Specify the placement behaviors you want for the shape. You can choose the following options:
   - **Placement Behavior** — Choose Lay Out and Route Around from the drop-down list to enable the shape for automatic layout and to enable other placement options. If you choose Do Not Lay Out and Route Around, Visio won’t process the shape during layout.
   - **Do Not Move During Placement** — Check this check box to prevent Visio from relocating this shape when it lays out the drawing.
   - **Allow Other Shapes to Be Placed on Top** — Check this check box to allow Visio to place other shapes on top of the shape during automatic layout. If you want every shape to be completely visible, leave this check box unchecked.
   - **Move Shapes on Drop** — Use these options to specify what shapes do when other shapes are nearby. The Move Other Shapes Away on Drop option specifies the plow behavior of the shape, which controls whether a shape plows other shapes out of the way when you drop it near other shapes. The Do Not Allow Other Shape to Move This Shape Away on Drop specifies whether other shapes can plow the selected shape out of the way. Check this check box, if you want a shape to remain where it is when you drop another shape near it.
   - **Interaction with Connectors** — Use these options to specify whether connectors can route through the shape horizontally or vertically. Leave these check boxes unchecked if you want Visio to route around the shape.

**Tip**
You can specify options on the Placement tab only for 2D shapes. If you select a 1D shape and then choose Format ➪ Behavior, the Placement options are disabled.

**Specifying Layout Options**
The Lay Out Shapes command includes options you can use to control the arrangement of shapes on your drawing, as shown in Figure 5-3. For example, you can organize a work flow diagram horizontally or vertically. You can also specify the style, direction, and appearance of the connectors on your drawing. As you choose placement options in the Layout Shapes dialog box, Visio changes the connector options to corresponding settings. For example, when you choose a Circular layout style, Visio changes the connector style to Center To Center. Although you can choose different options for connectors, your drawings will look cleaner if you keep the placement and connector options coordinated.
Figure 5-3: You can specify how Visio lays out and connects shapes on a drawing.

The Lay Out Shapes dialog box contains a preview window that displays a sample of the results of your chosen settings. To specify the layout and routing for a drawing, follow these steps:

1. Choose Shape ➪ Lay Out Shapes.

2. To specify the arrangement of shapes, choose settings for the following options under the Placement heading:
   - **Style** — Select an arrangement style, such as Radial, Circular, Flowchart/Tree, or Compact Tree. Visio changes the connector options to match the placement style you select.
   - **Direction** — Select the direction you want the shapes to flow on your drawing. You can choose from Top to Bottom, Bottom to Top, Left to Right, and Right to Left.
   - **Depth** — Select a depth to specify how much space Visio places between shapes. Choosing Shallow organizes shapes well but uses more space. Choosing Deep uses less space but doesn’t arrange the shapes as well. You can compromise between the two by using Medium.

3. To specify options for how connectors route in a layout, choose settings under the Connectors heading:
   - **Style** — Select a routing style, such as Right Angle, Straight, or Flowchart.
   - **Direction** — Select a direction to specify where connectors attach to shapes. For the best results, choose the same direction that you chose in Placement options.
   - **Appearance** — Select Straight or Curved connectors.
• **Apply Routing Style to Connectors** — Uncheck this check box if you want to lay out the shapes without changing the connectors.

• **Align Shapes to Grid When Possible** — Check this check box to lay out and route your drawing based on the spacing settings you specify in the Layout and Routing Spacing dialog box. (To learn how to specify the spacing for layout and routing, see the “Specifying Layout Spacing Options” section later in this chapter.)

• **Enlarge Page to Fit Drawing** — Check this check box to increase the drawing size if the optimal layout requires more room than the current drawing size provides.

4. To specify which shapes Visio lays out, choose the Selection option to lay out only the selected shapes, or the Current Page option to lay out the entire page.

5. To lay out the drawing, click Apply. If you don’t like the results, go back to step 2. Otherwise, click OK.

   To remove the new layout, press Ctrl+Z.

   **Tip**

   If Visio creates an overly complicated route for a connector, you can modify its path manually by dragging the connector’s green vertices to new positions. However, if you use Lay Out Shapes again, Visio overwrites your changes when it applies its layout rules.

**Specifying Layout and Routing Spacing**

You can adjust the spacing that Visio uses to fit more shapes on a page or to create more space around the shapes you have. To specify spacing options for a page, click the Spacing button in the Lay Out Shapes dialog box and then specify sizes for the following spaces on your drawing:

- **Space Between Shapes** — Specifies the horizontal and vertical space that Visio adds between shapes that it lays out.

- **Average Shape Size** — Specifies the average size of the shapes in your drawing and sets the average shape size used by the dynamic grid.

   **Tip**

   If the sizes of your shapes vary significantly, try using a smaller average shape size.

- **Connector to Connector** — Specifies the minimum spacing between parallel connectors. For example, a horizontal spacing of one inch lays out shapes so that horizontal segments of connectors are no closer than one inch apart.
**Connector to Shape** — Specifies the minimum spacing between connectors and shapes. A horizontal spacing of one inch lays out shapes so that a shape and a vertical segment of a connector are no closer than one inch apart.

You can also specify spacing by choosing File ➪ Page Setup, selecting the Layout and Routing tab, and clicking the Spacing button.

**Specifying Line Jump Options**

When connectors frequently cross over each other, it can be difficult to follow the relationships on a drawing. You can specify the line jumps that Visio uses to clarify the paths that connectors use. You can specify line jumps for an entire drawing page or for specific connectors. To specify line jumps for a page, choose File ➪ Page Setup and then select the Layout and Routing tab. Use the following options to specify how Visio applies line jumps on the page:

- **Add Line Jumps To** — Choose the lines to which you want to add line jumps. For example, you can specify Horizontal or Vertical. Last Displayed Line adds line jumps to the line at the top of the stacking order.
- **Line Jump Style** — Choose a style for the line jump, such as Arc and Gap. You can also choose from a number of multifaceted jumps.
- **Horizontal Size** — Specify the size for line jumps added to horizontal lines.
- **Vertical Size** — Specify the size for line jumps added to vertical lines.

To specify line jumps for a connector, right-click it and choose Format ➪ Behavior from the shortcut menu and then select the Connector tab. Under Line Jumps, choose an option in the Add list to specify whether the connector conforms to the line jump options for the page or uses different options. Choose a line jump style to specify a style other than the page default.

**Summary**

Connections between shapes convey a great deal of information on drawings. Visio provides several methods for adding connectors to shapes, as well as dozens of different types of connectors. Some shapes, such as trees, have connectors built in. You can glue connectors to shapes using dynamic or static glue. When you use static glue, Visio keeps connectors glued to the points you selected. However, you must use dynamic glue if you want to automatically lay out and route your diagram, or you want Visio to create optimal routes between shapes.
Working with Text

If you’re like most people, you probably devote a significant amount of time working with text, because your drawings often contain as much text as they do graphics. Visio makes it easy to add, edit, and format text and annotations. In Visio, you can add text in a variety of ways and places. You can add text to shapes and groups or add text blocks that stand on their own.

In Visio as in other Microsoft Office applications, you can search and replace text as well as check spelling. However, in Visio you can also select and modify text and text blocks as you can other Visio shapes. For example, you can easily move and rotate text and text blocks.

In addition, Visio provides built-in shapes useful for annotating your drawings. You can add a title block shape to a drawing to identify it. You can connect callouts to shapes to include notes or comments. You can also configure text into tabular form using a built-in Table shape or by formatting the text in a text block.

Text and Visio

Every Visio shape, including connectors, has an associated text block in which you can type text to annotate your drawings. Although these text blocks belong to their parent shapes, you can relocate, rotate, and format them independently to improve the readability of your drawings. Visio also offers special shapes, such as callouts and balloons, that are dedicated to the annotation of drawings. If these shapes aren’t enough, you can use the Text tool to add text-only shapes to your drawings.

In This Chapter

Adding text to shapes and groups
Adding text-only shapes
Selecting text
Finding and replacing text
Checking spelling
Moving and rotating text shapes and text blocks
Creating tables
Adding callouts
Using title blocks
In addition to the text that makes up drawing content, you often want to communicate questions and remarks to your colleagues about drawing content and changes. You can insert comments to communicate this type of information and remove them when the drawing is complete.

No matter which type of text medium you use, Visio makes it simple to add text to your drawings. In most cases, all you have to do is click a shape or text block, start typing, and press Esc when you’re done. You can type without worrying about whether your text will fit. After your words are in place, you can use a variety of tools to edit or format them.

**Adding Text to Drawings**

Text is a major component of most drawings. Whether you’re labeling a shape, tabulating details, identifying a drawing with a header or footer, or using comments to communicate with your colleagues, Visio provides simple tools and techniques to get the job done.

If you’re used to working with CAD programs, Visio’s text behaves differently, but is simpler to use. Text appears larger or smaller as you zoom in and out, but the Visio drawing scale has no effect on the appearance of text. Visio always displays text at its actual size relative to the printed page.

You can specify options to display aliased or antialiased text, depending on whether you prefer faster display or higher quality. To do this, choose Tools ➪ Options and select the View tab. Select the Text Quality option you want. You can also display a wavy line in place of text when the text is smaller than a specified point size on the screen, which is known as greeking. If a drawing includes a lot of text, you can use this feature to improve performance while you arrange drawing components. Then, when the drawing is finished, you can display all text. Specify the point size you want in the Greek Text Under box.

**Adding Text to Visio Shapes**

You can add text to most shapes, including connectors, by selecting a shape and typing the text you want. By default, Visio zooms in to 100 percent so it’s easier to see the text you’re entering. As you type, Visio underlines spelling errors with a red, wavy line. However, the misspelling indicator disappears when the shape or text block isn’t selected.

To disable automatic zooming when you edit text, choose Tools ➪ Options ➪ General. In the Automatically Zoom Text When Editing Under drop-down list, choose 0 for the point size. Because text point size must be greater than zero, this choice ensures that Visio never zooms text based on its point size.
Each shape includes a text block. When you select a shape with a tool other than the Text tool and begin typing, Visio replaces the text in the shape’s text block with the text that you type. If you select a shape with the Text tool, Visio positions an insertion point where you click in the shape text block.

If you activate the Text tool and drag to define a text block, Visio creates a separate text block shape and selects it so that you can begin typing text.

To add text directly to a shape or connector, follow these steps:

1. Select a tool other than the Text tool and click a shape or connector.
2. Begin typing.
3. To complete your text entry, press Esc or click outside the text block. Pressing Enter inside the text block inserts a carriage return and moves the insertion point to the next line in the text box.

When you add more text than a shape can hold, Visio simply displays the text overflowing the shape’s boundaries. You can resize the shape to hold the text by selecting the shape and dragging its selection handles. If you don’t want to resize the shape, you can shorten the text or apply a smaller font.

Adding Text to Groups of Shapes

Some shapes appear to include more than one text block. For example, the X-Y Axis shape on the Charting Shapes stencil includes a text block to label each of the axes. The X-Y Axis shape is actually a group of shapes. Accessing text in grouped shapes works similarly to accessing shape text, but sometimes requires a few additional clicks.

To add text to a shape in a group, click the shape you want to work with once to select the group to which it belongs and then click the shape a second time to select the shape. If you select the shape with the Text tool, Visio positions an insertion point in the text block of the shape. If you select the shape with any other tool, Visio selects the shape text block and replaces its contents when you begin typing.

Adding Text-Only Shapes

You can also add text that isn’t a part of any shape on a drawing. When you use the Text tool to add text to a drawing, you create a shape that contains only text. However, you can edit and format the text in these blocks as you would any other text. To add a text-only shape to a drawing, follow these steps:

1. Click the Text tool on the Standard toolbar.
2. Drag from one point on the drawing to another to create a rectangular text block with those dimensions.
Tip

You can also add text by selecting the Text tool and clicking a point in the drawing, which creates a text block at the point you clicked using default dimensions.

3. Type the text you want in the text block.

4. To complete your text entry, press Esc or click outside the text block. By default, Visio creates a text-only shape with 8-point Arial text centered in the block.

New Feature

In previous versions of Visio, you had to copy special characters from the Character Map or use special key sequences to enter their Unicode numbers. In Visio 2003, you can insert special characters into text by choosing Insert ➤ Symbol to open the Symbol dialog box. For the most common special characters, select the Special Characters tab, select the symbol you want, and click Insert. For other special characters, select the Symbols tab, select the symbol you want, and click Insert. If you don’t see the symbol you want, choose another font from the drop-down list.

Displaying Field Information in Text

Visio stores information about shapes and documents in fields. For example, Visio fields track who created a document, the name of a page, the angle of a shape, and the values of a shape’s custom properties. In addition, fields can display the results of a formula you create that uses the values from other fields. You can display this information on a drawing by inserting fields into text. For example, a Visio title block shape, shown in Figure 6-1, uses fields to automatically display information about the drawing in which it is located.

Fields that automatically display properties

Figure 6-1: You can use fields to display drawing, page, shape, or custom property information in drawing text.
Visio includes several categories of fields and numerous fields within each category. You can use any of the following field types to display information in text on a drawing:

✦ **Custom Formula** — Results of a ShapeSheet formula you define in the Custom Formula box

For an introduction to ShapeSheet formulas, see Chapter 33.

✦ **Date/Time** — Current date and time or the date and time that a file was created, printed, or updated

✦ **Document Info** — Information from a file’s Properties box, such as creator or keywords

✦ **Geometry** — Shape width, height, or angle of rotation

✦ **Object Info** — Information from a shape’s Special dialog box, such as the shape’s internal ID or the master used to create it. To view these fields, right-click a shape and choose Format ➤ Special from the shortcut menu.

✦ **Page Info** — Page settings such as the page number or number of pages in a drawing

✦ **Custom Properties** — Information from a shape’s custom property fields. Custom properties vary from shape to shape.

To learn more about fields and custom properties, see Chapter 32.

✦ **User-Defined Cells** — Formulas entered in the User-Defined Cells section of the ShapeSheet

You can insert a field in a text block or at a specific position in a text block. If you want to insert the field as the only text, select the shape. To insert the field within existing text, double-click the shape to open its text block and then click in the text to position the insertion point where you want to insert a field.

To insert fields in a shape text block, follow these steps:

1. With the shape selected or the insertion point in position, choose Insert ➤ Field.

2. In the Field dialog box, select the field category you want, such as Custom Properties.

3. Select the field you want, such as Width.

4. To apply a specific format, select the format you want, and then click OK.

You can insert more than one field in a text block, inserting them on separate lines or within lines of text.
You can edit fields in text blocks either to change the field that is used or to modify how its value is formatted. For example, you can change the date format so that the date fits in a smaller area. To edit a field in a text block, follow these steps:

1. Select the Text tool, select a shape, and then click the field you want to modify within the text block to select it.

   **Note**
   If the text block contains only a field, clicking it selects the entire field. You can’t position an insertion point within a field.

2. Choose Insert ➪ Field. The Field dialog box appears and shows the current settings for the selected field.

3. To modify the formatting for the field, select the format you want in the Format list and click OK.

4. If you want to replace the field that is used, select the category you want, select the new field, select a format, and then click OK.

### Displaying Information in Headers and Footers

Headers and footers appear only when you print your drawings, so they are useful for displaying information that isn’t needed while you are working, such as the date and time that the drawing was printed. You can display this information by adding text and fields to drawing headers and footers. For example, you can automatically number the pages in your drawing by inserting the Page Number field into the drawing footer.

**Tip**
Although they don’t appear when you view a drawing, you can see the drawing header and footer by choosing File ➪ Print Preview.

To include text and fields in the header or footer of a drawing, follow these steps:

1. Choose View ➪ Header and Footer.

2. To add text to a header or footer, type the text you want in the Left, Center, or Right box in the Header or Footer column.

3. To insert a field, click the list arrow to the right of one of the header or footer boxes, select the field you want to insert, and then click OK. Visio inserts a code in the box that Visio translates when you print the drawing.

4. To format the header and footer, click Choose Font, select a font, a style, a size, a color, and effects, and then click OK.

5. Click OK in the Header and Footer dialog box.
Adding Comments to Drawings

When you review a drawing, whether your own or someone else’s, you can add comments about the contents of the drawing or needed changes. In many organizations, reviewers provide feedback about a drawing with redlining—adding text to a separate layer reserved for comments, and more often than not using the color red.

Visio provides several methods for adding feedback to a drawing. Visio 2003 includes markup features so each collaborator can add comments and drawing modifications to a separate markup layer. You can also modernize the redlining process by creating a layer to hold reviewer comments. In addition, you can insert comments directly on a page.

To learn more about Visio’s new markup features, see Chapter 11. To use a layer for redlining, see Chapter 25.

To add a comment to a page of a drawing, follow these steps:

1. To add a comment to the current page, choose Insert Comment.
2. Type your comment and press Esc or click anywhere in the drawing. A comment icon appears approximately in the center of the visible drawing area.

You can view, edit, or delete comments on a page. To associate comments with an area of a page, you can move comments to other locations on the drawing page.

✦ To move a comment, drag the comment tag to another position on the page.
✦ To view the comment, click the comment tag.
✦ To edit or delete a comment, right-click the comment tag and choose Edit Comment or Delete Comment from the shortcut menu. You can also click the comment and press the Delete key.

To learn about other ways to communicate with your collaborators, see Chapter 11.

Selecting and Editing Text

You can reposition, format, and edit the contents of text blocks. You can even use the cut, copy, and paste shortcuts to process text as you do in other Microsoft Office applications. However, before you can do any of these things, you have to know how to select the text you want to work with.
Selecting Text

To replace or format the entire text block for a shape, you can select the shape and make the change you want. For example, to change the font size, you can right-click a shape, choose Format ➪ Text, select the text format options you want, and click OK.

You can also select text and position the insertion point where you want in a text block to edit or format a portion of it. The techniques you use to do this and the results you obtain vary depending on whether you use the Pointer tool, Text tool, or Text Block tool. Choose one of the following methods to select text or position the insertion point:

♦ Select a text block — You can click a shape to select a text block no matter whether the Pointer, Text, Text Block or a drawing tool is active.
  • Replace the existing text — Although there is no visual indication, typing after selecting a text block replaces the existing text.
  • Reposition, resize, or rotate a text block — If you want to move a text block in some way, use the Text Block tool to select the text block. The text block selection handles appear.

♦ Select the text in a text block — You can use the following methods to select all the text in a text block. After selecting the text, you can cut, copy, and paste the text, type to replace it, or format it.
  • Shortcut key — Click a shape to select it and press F2 to open the text block and select all the text.
  • Text tool — Click a shape and then drag to select all the text.

♦ Position the insertion point — You can use the following methods to position the insertion point in a text block.
  • Text tool — Click a shape or text block where you want to position the insertion point.
  • All other tools — Double-click a shape to select its text. Click in the selected text to position the insertion point.

♦ Select a portion of a text block — You can select a word, paragraph, or any other portion of a text block. To do this, activate the Text tool or the Text Block tool and select a shape.
  • Select text — Drag to select the text you want.
  • Select a word — Double-click the word you want.
  • Select a paragraph — Triple-click the paragraph you want.

Selecting Text in Groups

Sometimes, shapes and text blocks are consolidated into groups to make them easier to work with. In addition to the text blocks for each shape in a group, the group
itself has a text block. You can add, edit, or format text in each shape as well as for the group as a whole. The main difference when working with text in grouped shapes is that it sometimes takes a few more clicks to select the text you want.

✦ To add text to a group, click the group to select it and begin typing.
✦ To view the text block for a group, select the group and press F2.

Note

If the Text tool is active when you click a group, Visio opens the group text block and positions the insertion point in the text block.

✦ To work with text in one of the group’s shapes, select the shape and then type to replace the text.

Note

You can select the text in a shape within a group using the selection techniques described in the previous section. However, selecting a shape in a group with the Pointer tool could require more than one click. For example, if a shape belongs to a group that in turn belongs to a larger group, the first click selects the largest group. Clicking a second time in the same place selects the subordinate group. Clicking a third time in the same place selects the shape.

Editing Text

You can edit text in Visio using techniques similar to those used in other Microsoft Office applications. For example, you can use the Cut, Copy, and Paste commands to modify or duplicate Visio text. As with other applications, text that you cut or copy moves temporarily to the Windows Clipboard so you can paste it several times. Unlike other Microsoft Office applications, Visio zooms in to 100 percent automatically when you edit text to make the text easier to see.

Deleting Text

You can delete text in a Visio shape or a text-only shape, although deletion works differently in these two types of shapes. When you delete the text in a Visio shape, you only delete the text, not the shape’s text block. You can always select the shape and type text to insert new text into the shape’s text block. However, deleting all the text in a text-only shape deletes the text-only shape as well. To delete text, use one of the following methods:

✦ To delete text in a shape, select the Text tool and then click the shape to select it. Select the text you want to delete and press Delete. Press Esc to close the text block.
✦ To delete a text-only shape, select the Pointer tool, click the text block, and press Delete.
✦ To delete some of the text in a text-only shape, select the Text tool and click the text-only shape. Drag to select the text you want to delete and press Delete. Press Esc to close the text block.
Copy Text from Other Applications

If you want to copy text into Visio from another application, first create a text-only shape in your drawing and then paste the text from the other application into the text-only shape. To do this, select the text you want in an application such as Microsoft Word, and press Ctrl+C to copy it to the Windows Clipboard. In Visio, activate the Text tool and drag to create a text block in your drawing. Press Ctrl+V to paste the text into the text block.

You can also embed text from another application. To do this, copy the text from the other application and paste it directly onto the drawing page without creating a text block. When you double-click this text, Visio opens the application in which you created the text originally.

Finding, Replacing, and Correcting Text

Visio includes commands to find, replace, and check the spelling of words in drawings. These features work similarly to those in other Microsoft Office applications, although Visio offers more options for specifying the scope of its searches, as shown in Figure 6-2. When you search for text, Visio can search stencils, shapes, text-only text blocks, custom properties, and drawing properties.

Figure 6-2: You have numerous options in Visio for specifying the scope of a text search.
Finding and Replacing Text

When you are searching for text, you can search the current selection, the current page or all pages in a drawing. In addition to specifying the pages to search, you can specify which components to search:

- **Shape Text** — Searches for text in shape text blocks and text-only text blocks
- **Custom Property** — Searches for text in custom property fields
- **Shape Name** — Searches for text in the Name field of shapes or masters. You can use this option to locate instances of a master in a drawing or to find a master in a stencil you are editing.
- **User-Defined Cell** — Searches the Value and Prompt cells in the User-Defined Cells section of ShapeSheets for all shapes in a drawing.

To find text on a drawing, follow these steps:

1. Choose Edit ➪ Find or press Ctrl+F to open the Find dialog box.
2. Type the text you want to find in the Find What box. To specify a special character, click the Special button and choose the special character.
3. Select one of the options (Selection, Current page, All pages) to specify how much of the drawing to search.
4. Check the check boxes for each of the components you want Visio to search.
5. If you want Visio to match results in a specific way, check the check boxes in the Options section.

You can instruct Visio to return results that match the case entered in the Find What box or to return only results that match whole words, not a portion of a word. In addition, the Match Character Width check box limits the results to characters of the same width, such as searching for only wide or narrow characters in the Katakana alphabet.

6. Click Find Next to find the next occurrence of the text. Visio highlights matching text in the drawing.
7. To edit the text, close the Find dialog box and edit the text.

If Visio finds the text in a shape name or user-defined cell, it highlights the shape on the drawing and displays the name in the Found In section of the Find dialog box, as illustrated in Figure 6-2. If you want to edit the text in a shape name, close the Find dialog box, right-click the highlighted shape, and choose Format ➪ Special to access the shape’s name. To edit text in a user-defined cell, open the ShapeSheet for the highlighted shape and edit the text in the appropriate cell.
To replace text on a drawing, follow these steps:

1. Choose Edit > Replace.
2. Type the text you want to find in the Find What box. To specify a special character, click the Special button and choose the special character.
3. Type the new text in the Replace With box. To specify a special character, click the Special button and choose the special character.
4. Select one of the options (Selection, Current page, All pages) to specify how much of the drawing to search.
5. If you want Visio to match results in a specific way, select the check boxes in the Options section.
6. Click Find Next to find the next occurrence.
7. Click Replace to replace the current occurrence or Replace All to replace all occurrences.

Checking Spelling
Visio can check spelling like its Office counterparts. You can perform all of the following tasks with Visio:

✦ Check spelling with the built-in dictionary.
✦ Create your own dictionary of words.
✦ Instruct Visio to correct entries automatically as you type.
✦ Add your own AutoCorrect entries.

To learn how to create your own dictionary and AutoCorrect entries, refer to the Check and Correct Spelling topic in Visio Help.

To check spelling, follow these steps:

1. Choose Tools > Spelling or press F7. Visio opens the Spelling dialog box for each word not found in the dictionary.
2. Click Ignore or Ignore All if the word is spelled correctly. Click Add if you want to add the unrecognized word to the spelling dictionary.
3. If the word in the Change To box is spelled correctly, click Change to replace the misspelled word with the Change To text. If it is not spelled correctly, edit the contents of the Change To box and then click Change or Change All.

If you want to turn off the spell checker, choose Tools > Options and select the Spelling tab. Uncheck the Check Spelling As You Type check box and click OK. You can turn spell checking back on by pressing F7.
Positioning Text

You can position text-only shapes, callouts, and other annotation shapes wherever you want on a drawing. However, in addition to moving text shapes around, you can also reposition the text within a shape. By default, a shape’s text block is the same size as the shape itself and centered within it, but you can relocate or rotate a shape’s text block to remove overlapping text or make your drawing more readable. For example, you can move the built-in axis label for a graph to make room for numeric labels along the axis.

Repositioning Text in a Shape

The text block in a shape is a part of the shape but doesn’t have to reside in the same location on the drawing. You can move, resize, or rotate a shape’s text block. To reposition text in a shape, follow these steps:

1. Click the Text Block tool on the Standard toolbar. If the Text Block tool isn’t visible, click the arrow next to the Text tool and choose the Text Block tool from the menu.

2. Click a shape to select its text block and display the text block selection handles, as shown in Figure 6-3.

![Text Block tool displays text block handles](Image)

**Figure 6-3:** Use the Text Block tool to select a text block and display its selection handles.
3. To move the text block to another location, position the pointer within the text block and drag to the new location.

4. To rotate the text block, drag the rotation handle until the text is rotated to the angle you want.

**Tip**

You can also rotate only a shape’s text block by clicking the Rotate Text 90 Degrees tool on the Action toolbar.

5. To resize the text block, drag a selection handle.

**Tip**

You can view or modify the properties of a shape text block in the Text Transform section of a ShapeSheet. Although it’s easy to modify a text block’s contents and position on a drawing, you must use the ShapeSheet to perform some functions, such as preventing text from rotating.

### Moving Text Shapes

To move a text-only shape or a callout shape, select the shape as you would any other and drag it to a new location on your drawing. You can also use the Size & Position window to move text to a precise position. To do this, follow these steps:

1. To open the Size & Position window, choose View ➪ Size & Position Window.

2. Select the text shape you want to move.

3. Modify the values in the length, angle, or X and Y boxes to modify the width, rotation, and position of the shape on the drawing.

### Editing Locked Shapes

Some Visio shapes and connectors are locked so that text remains right side up when you move a shape or line. When you select a locked shape with the Text Block tool, Visio indicates the protection by changing the handles to gray. To unlock a shape to modify its text block position, follow these steps:

1. Right-click the shape and choose Format ➪ Protection from the shortcut menu.

2. To unlock the shape rotation, uncheck the Rotation check box.

3. To unlock a shape so you can resize it, uncheck the Width and Height check boxes.

4. To unlock a shape so you can move the text block, uncheck the X Position and Y Position check boxes.

5. Click OK when you are done. Select the Text Block tool, click the shape, and drag the text block handles.
Creating Special Annotations

Visio comes with predrawn shapes for displaying and emphasizing information in your drawings. Callout shapes can call attention to important information on drawings. You can use built-in title blocks to identify the drawing file and its contents or create your own custom title block to show the information you want.

Cross-Reference
By applying formatting, you can produce bulleted and numbered lists. To learn how to do this, see Chapter 7.

Creating Tables

The Charting Shapes stencil contains several built-in shapes for presenting tabular information. You can drag these shapes onto a drawing, select cells within the tabular shape, and type the text you want. However, if you want to show information in tabular form within one shape's text block, you must use tabs to present the text in columns.

Using Built-in Table Shapes

The tabular shapes on the Charting Shapes stencil provide several advantages over using tabs to create columns in text. These tables are groups of shapes, so you can work with each cell individually or modify the entire table. To resize the cells in a table shape, select the group and drag a selection handle. In addition, these shapes automatically assume the color scheme you apply to a drawing.

You can use the following shapes to create tables:

✦ **Grid** — Specify the number of rows and columns you want in the table.

✦ **Row Header and Column Header** — Drag these shapes and snap them into place next to a row or column in the Grid shape to label rows and columns.

✦ **Deployment Chart** — These shapes include labels for departments and phases, but you can modify the labels to represent anything you want.

✦ **Feature Comparison Chart** — This shape includes labels for products and features but you can modify the labels to represent anything you want.

To use the Grid shape to create a table, follow these steps:

1. To open the Charting Shapes stencil, choose File ➤ Shapes ➤ Charts and Graphs ➤ Charting Shapes.

2. Drag the Grid shape onto your drawing. The Custom Properties dialog box opens.

3. Select the number of rows and columns you want in the drop-down lists and click OK.
You can change the number of rows and columns later by right-clicking the Grid shape and choosing Set Grid from the shortcut menu.

4. To label a row, drag the Row Header shape and snap it to the leftmost cell in a row. With the Row Header selected, type the label text.

5. To label a column, drag the Column Header shape and snap it to the topmost cell in a column. With the Column Header selected, type the label text.

6. To add text in the table, click a table cell and type the text.

In Visio 2003, the Grid shape replaces the Table shape. Unfortunately, the Grid shape doesn’t come with the Table shape’s features for inserting, deleting, or resizing columns and rows. However, you can use Ctrl+click to select several cells within a grid and rotate or resize them.

**Formatting Shape Text into Columns**

You can format text into columns by applying tab stops to one or more paragraphs in a text block. You can align tabs to the left, center, or right, or use a decimal tab to align columns of numbers by their decimal points.

If you resize a shape after applying tab stops, the shape margins can impinge on the text block and affect the alignment of your tabs.

The tab stop positions you specify are relative to the left edge of the text block. Because of this, it’s easiest to begin your formatting by adjusting the origin of your ruler. To add tab stops to a shape, follow these steps:

1. To relocate the origin of the horizontal ruler, press the Ctrl key and drag the vertical ruler to the left edge of the shape.

2. Select the text you want to format in the text block.

3. Choose Format ➪ Text and select the Paragraph tab.

4. To set the text block alignment, select Left in the Horizontal Alignment dropdown list, and set the values in the Left, Right, and First Indentation boxes to zero.

5. To add a tab stop, select the Tabs tab. Type the distance from zero for the tab stop in the Tab Stop Position box. Select the alignment you want and click Add.

You specify tab stop indentations in unscaled units even if you’re working on a scaled drawing.

6. Repeat step 5 for each tab stop you want to add and click OK when you are finished.

7. To add text in columns, type a value in the text block and then press Tab to move to the next column.
Using Callouts to Highlight Information

Visio provides a variety of built-in callout shapes you can use to call attention to information on your drawings. You can drag these shapes onto a drawing, add your annotation, and point the callout line or arrow to the area you want to highlight. If you want a callout to move with the shape to which it points, you can glue the callout to a shape, as shown in Figure 6-4.

You can use callouts from any stencil regardless of which type of drawing you use. Simply open the stencil with the callout you want and drag the shape onto the drawing. Some stencils include one or two callout shapes, but you can find the widest variety of callouts on the following stencils:

- **Callouts** — Contains callouts, balloons, tags, notes, and other shapes for adding text to drawings. To open this stencil, choose File ➪ Shapes ➪ Visio Extras ➪ Callouts.
- **Charting Shapes** — Contains callouts, balloons, and the annotation shape. To open this stencil, choose File ➪ Shapes ➪ Charts and Graphs ➪ Charting Shapes.
- **Annotations** — Contains callouts in addition to other reference shapes, such as north arrows. To open this stencil, choose File ➪ Shapes ➪ Visio Extras ➪ Annotations.
Adding Callouts to a Drawing

Each callout has its own special attributes, but they all function similarly. Callouts often include instructions in the text block, as illustrated in Figure 6-4. To add a callout to a drawing, follow these steps:

1. Drag the callout from the stencil and drop it near the shape you want to annotate.
2. Click the callout shape to select it and type the annotation text.
3. To point the callout at a shape, drag the selection handle at the end of the callout line or arrow.
4. To glue the callout to a shape, drag the selection handle at the end of the callout line or arrow to a connection point on the shape. A red box highlights the connection point when the callout and shape are connected.

Displaying Properties in Callouts

You can annotate shapes with the information stored in their custom properties, such as the person who occupies an office, their department, and their phone number. Visio provides several Custom Callout shapes in which you can specify the custom properties you want to display and how to display them.

To display custom properties in a custom callout shape, follow these steps:

1. Open the Callouts stencil.
2. Drag a Custom Callout shape onto the drawing.
3. Drag the yellow control handle on the Custom Callout to the shape with custom properties that you want to annotate. The Configure Callout dialog box appears, listing every custom property for the shape in the Shape Custom Properties box.
4. Check the check box for each property you want to display in the callout. If you select more than one property in the list, choose an option in the Separator drop-down list to indicate how you want the properties separated in the callout.

To reorder the custom properties in the callout, select a custom property in the list and then click the Move Up or Move Down button.

5. To show only the custom property value and not the property name, uncheck the Show Property Name check box.
6. To move the callout when you move the shape, make sure the Move Callout with Shape check box is checked.
Using Title Blocks

Title blocks are commonly used with architectural and engineering drawings to identify and track their contents and revision history. Visio automatically opens the Borders and Titles stencil with many of the built-in templates, but you can open any stencil with title blocks and add the one you want to any type of drawing. In addition, you can create your own title block with exactly the information you want. You can open either of the following stencils to access title block shapes:

- **Borders and Titles**—Contains dozens of title block shapes, some of which use fields to automatically display information such as the date, scale, and page number. To open this stencil, choose File ➪ Shapes ➪ Visio Extras ➪ Borders and Titles.

- **Title Blocks**—Available only in Visio Professional, this stencil contains several title block and revision block shapes, along with shapes that display fields automatically. To open this stencil, choose File ➪ Shapes ➪ Visio Extras ➪ Title Blocks.

When none of the built-in title blocks suit your needs, you can use shapes on the Title Blocks stencil to create your own title block. The Title Blocks stencil contains shapes that display fields such as the current date, author of the drawing, filename, page number, and scale. You can use the Frame shape as the title block border and add these other shapes to design your custom title block. To create your own title block, follow these steps:

1. Drag the Frame shape onto your drawing and then drag other title block shapes to build the title block.
2. To group the shapes so you can move them as one, select the title block shapes and choose Shape ➪ Grouping ➪ Group.
3. To add the new title block to a stencil, open an existing stencil or create a new one.

   To learn how to create custom stencils and new masters, see Chapters 31 and 32.

4. Drag the title block from the drawing into the stencil window. If Visio asks whether you want to edit the stencil to complete the operation, click Yes.
5. Right-click the new master and choose Edit Master ➪ Master Properties from the shortcut menu.
6. Enter a name and any other options and then click OK.
Formatting Title Blocks

The title blocks built into Visio are often groups of shapes, combined so that you can add the title block to your drawing in one step. In addition, some of these groups are locked to prevent you from inadvertently changing part of the group. Depending on the protection applied, you can resize, delete, format, and annotate the shapes that make up the title block.

To format a shape within a group, you must select the shape. To do this, activate the Pointer tool, click the shape once to select the group, and then click the shape a second time to select the shape. You can then use format commands to modify the shape’s appearance.

If protections on a shape prevent you from modifying the title block, you can unlock the shape and then make the change you want. To do this, select the shape within the group and choose Format Protection. Uncheck the check boxes for the type of change you want to make and click OK. You can also ungroup the shapes and then rearrange them into the configuration you want. Although Visio warns you that ungrouping the title block will break the link to its master, click OK to ungroup the shapes. If the changes you make cause problems, delete the title block from your drawing and drag a fresh one from the stencil.

Summary

You annotate drawings in a variety of ways. Every shape on a drawing has its own text block that you can use to add information. In addition, you can add text-only shapes or built-in tabular shapes to your drawings to present large amounts of textual data. Callout shapes can include notes to highlight information on a drawing or to display the values of custom properties. You can add text to title blocks or insert fields that automatically display the values of file or page properties.
CHAPTER 7

Formatting Visio

Elements

Formatting can make the difference between dreary drawings that go unread and attractive documents that make everyone take notice. You can achieve the best formatting results in the shortest amount of time with a two-step process.

First, you can quickly obtain professional-looking results by using predefined formatting tools. These tools ensure consistency throughout each drawing and reduce the amount of time you spend choosing individual formatting options. For example, you can drag backgrounds and borders onto your drawing page to frame its contents. You can apply color schemes so that shape fills and shadows use consistent and harmonious colors. You can also use predefined styles, similar to the ones you’ve probably used in Microsoft Word, to apply sets of formatting options for lines, text, and fill. When you use these features, you might discover that no additional formatting is required.

However, if you do find a few shapes that need tweaking, such as those with large amounts of text or shapes that you want to emphasize, you can take a second step to apply specific formatting options to shapes, lines, or text blocks.

Applying Formats

It’s much easier to apply styles than to specify several formats, but the reality is that from time to time you will end up applying specific formatting options to shapes, connectors, and text. Visio provides several methods for applying formatting to your drawing elements so that you can format just one item or several shapes at once. Whether you decide to use styles or apply formatting options individually, the options you use most frequently are available on the Formatting, Format Text, and Format Shape toolbars, shown in Figure 7-1.
Most templates include the Backgrounds and Borders and Titles stencils, so you can easily add backgrounds and borders to your drawing. If you start a drawing from scratch, you can open these stencils by choosing File ➪ Shapes ➪ Visio Extras and then clicking the stencil name that you want. When you drag a background shape onto your foreground page, Visio automatically creates a background page for you and assigns the background page to the current foreground page.

Applying Formats to Lines

You can alter the weight, pattern, color, and end options for lines. The Formatting toolbar includes buttons to change weight, pattern, color, and ends. To select a weight, pattern, color, or end, click the option arrow and choose the format you want. If you don’t see a suitable format, you can choose the More command at the bottom of any formatting list to open the associated format dialog box, such as the Line dialog box, which contains all the line formatting options. To learn how to use styles to specify formatting, see the “Formatting with Styles” section later in this chapter.

To format lines, choose one or more of the following format options:

- **Line Weight** — The thickness of the line, no matter what pattern you use
- **Pattern** — Patterns of dotted or otherwise broken lines. Visio includes 23 patterns in addition to a solid line, but you can also define your own.

To learn how to define your own patterns, see Chapter 34.

When you produce drawings for a wide audience, use patterns instead of line color so that your drawings convey all the information, even when printed on grayscale printers.
Highlighting Elements

Visio doesn’t provide a highlighting feature like the one in Microsoft Word, but you can use formatting to highlight different elements of your drawings. For example, if you want to emphasize a shape on your drawing, you can change the fill color to one brighter than the ones used in the color scheme.

You can also highlight lines and connectors—for instance, to show the redundant paths in a high-availability network. To do this, click the Line tool on the Drawing toolbar. Choose Format ➪ Line, select a wide line weight and a bright color, and click OK. Draw lines using the same vertices as the paths you want to highlight. If you can’t see the connectors, right-click the lines you added and choose Send to Back from the shortcut menu. If you want to be able to remove these highlight lines easily at a later time, you can add them to a separate layer and delete the entire layer to remove them. To learn more about layers, see Chapter 25.

✦ **Line Ends**—Symbols such as arrowheads that you can place at the end points of lines. The Formatting toolbar includes separate options for symbols at each end and both ends of a line. In the Line dialog box, you can specify the symbol and symbol size for each end of the line.

![Tip](image)

If an arrow points the wrong way, you can correct this problem by switching the line end to the other end of the line or by reversing the line. To reverse a line, select the line and then choose Shape ➪ Operations ➪ Reverse Ends.

✦ **Color**—The color of the line

✦ **Cap**—Only available in the Line dialog box. This option specifies whether the ends of very thick lines are squared or rounded.

Applying Formats to Text

Although Visio provides options for formatting every aspect of text on your drawings, the options you use most often are conveniently located on the Formatting and Format Text toolbars, shown in Figure 7-1. The Formatting toolbar includes familiar options for specifying font, font size, font style, horizontal alignment, and text color. The Format Text toolbar includes options to specify a text style, font size, formatting such as strikethrough and subscript, vertical alignment, indents, paragraph spacing, and bulleted lists. Visio displays the Formatting toolbar by default when you create a drawing. To display the Format Text toolbar, choose View ➪ Toolbars ➪ Format Text.
The Text dialog box is the comprehensive source for text formatting options. In addition to the text formatting options available on the toolbars, you can specify options for the language used for checking spelling, transparency of text, character spacing, paragraph spacing, indents, margins around text blocks, tabs, bullet styles, and bullet characters. You might prefer to use this dialog box for other reasons besides the abundance of formatting options. All text formatting options are available within this one dialog box. In addition, the text formatting features are grouped on tabs and, in some cases, include visual clues about the results you obtain by choosing an option. To open the Text dialog box, choose Format Text.

You can use the Text Ruler to set, modify, or remove tab stops and indents. To display the Text Ruler, double-click a shape, right-click the text, and choose Text Ruler from the shortcut menu. To create a tab stop, select the text you want to format and then click the position on the ruler where you want to place the tab. To insert a different type of tab stop, click the Tab icon until the tab stop you want appears. You can also drag tab stops to other positions or remove them by dragging them off the ruler. To adjust indents, drag the top or bottom of the hourglass on the Text Ruler to another position.

You can format different portions of text based on how you select it:

✦ **Select a shape** — Apply text formatting to all of a shape’s text by selecting a shape and then choosing text formatting options.

✦ **Select text with the Text tool** — Apply text formatting to selected text by activating the Text tool, selecting the text you want to format, and choosing text formatting options.

**Tip**

You can also copy text formatting by using the Format Painter. Select the shape with the text formatting you want to copy with the Text tool. Select the Format Painter on the Standard toolbar and then click the shape whose text you want to format. Visio copies only the text formatting to the second shape.

**Formatting Text Blocks and Paragraphs**

The text blocks in many shapes contain no more than one paragraph, so it’s easy to assume that formatting text blocks and paragraphs means the same thing. In reality, you can specify one set of options that apply to the text block itself and other options for each paragraph within the text block. The formatting options themselves are familiar, such as indentations, margins, and alignment.

For a text block, you can specify the vertical alignment of the text within the text block, the margins between the text and the text block boundaries, and color and transparency of the background in the text block, as illustrated in Figure 7-2. To apply text block formatting, select the shape and then choose the text block formats you want.
Text block boundary

Figure 7-2: Formatting options for text blocks and paragraphs are different.

Note Most Visio shapes use a transparent background color so you can see what lies behind the text. If other elements behind your text make it unreadable, you can make the text background color opaque so that other shape components don’t show through. To do this, select the shape, choose Format ➤ Text, and select the Text Block tab. Type 0% in the Transparency field. The opaque background only blocks out components when the shape contains text because the background color only fills the area around text.

For each paragraph within a text block, you can specify the horizontal alignment of the paragraph, the indentation for the first line of the paragraph, the indentation on each side of the paragraph, the spacing before and after the paragraph, and the spacing between the lines in the paragraph, also shown in Figure 7-2. To format a paragraph, activate the Text tool, select the paragraph you want to format, and apply the paragraph formatting you want.

Creating Bulleted and Numbered Lists
You can create bulleted lists easily by selecting a shape and then clicking Bullets on the Format Text toolbar. This applies default formatting that adds a bullet before each line that ends with a soft or hard return in the shape text block. If you want to create bullets with only some of the text in the shape, use the Text tool to select the text you want to format before you click the Bullets button.
You can change the font for a bulleted list without affecting the appearance of the bullet when you use Visio’s built-in bullets. However, when you change font size, bullet size adjusts to match.

If you want to create a bulleted list using formatting other than the default settings, follow these steps:

1. Select the text block or the portion of the text block that you want to format as a bulleted list.

   **Tip** If you want to build a bulleted list as you enter text, select the shape, click Bullets on the Format Text toolbar, and then type text into the shape text block.

2. Choose Format ➪ Text and select the Bullets tab.

3. To choose a different bullet symbol, click a bullet option or type the character that you want to use as a bullet in the Custom box.

4. To adjust the font size and list spacing at the same time, increase or decrease the value in the Font Size list.

5. To change the hanging indent between the bullet and the list text, type the distance you want in the Text position box.

6. To preview the formatting you have chosen, click Apply. If the list is formatted the way you want, click OK.

You build numbered lists differently in Visio than you would in other applications, such as Word. In Visio, you have to add numbers, tabs, and indentation manually. If you plan to include a long numbered list in a Visio diagram, it might be easier to use Word to automatically create the numbered list and then create a link from your Visio drawing to the list in the Word document.

   **Cross-Reference** To learn how to create a link to a Word document, see Chapter 8.

To create a numbered list in Visio, follow these steps:

1. Make sure that text justification is left-justified by clicking Align Left on the Formatting toolbar.

2. Double-click the shape in which you want to create the numbered list.

3. Type the number 1, press Tab, and then type the text for the first entry.

4. Repeat step 3 for each entry in the numbered list (change the number accordingly).

5. To modify the alignment of the numbered list, select all the entries and click one of the alignment options on the Formatting toolbar.

6. To align the numbers and text, first display the Text Ruler. To do this, select the text, right-click the text, and choose Text Ruler from the shortcut menu.
Tip
To display the Text Ruler when text is not selected, double-click the shape, right-click the selected text, and choose Text Ruler from the shortcut menu.

7. Drag the bottom of the hourglass in the Text Ruler to the position to which you want the text to align.

8. Drag the top of the hourglass in the Text Ruler to the position to which you want the numbers to align.

9. Press Esc or click outside the shape to close the text block.

Applying Fill Formats
When a shape is closed, you can specify its fill formatting, which is the color and pattern applied to the interior of the shape. You can choose fill colors by clicking the Fill Color button on the Standard toolbar. However, if you want to specify patterns, transparencies, or shadow formatting, select the shape you want to format and then choose Format ➪ Fill. You can specify the following options for fill formatting:

✦ **Color** — The color for the interior of the closed shape

Caution
Colors preceded by a number in the color list are index colors and refer to the colors defined in the current color palette. If you choose an index color, your fill might change to another index color when you modify the color palette.

✦ **Pattern** — Visio provides 40 patterns, including cross-hatching, stippling, and gradients. You can also define your own custom patterns.

✦ **Pattern Color** — The second color used if you select a pattern other than None or Solid. This color is used for cross-hatching lines and patterns.

✦ **Transparency** — By default, fill is opaque (0%). Drag the transparency slider to the right to increase the transparency of the fill color.

You can also specify fill in a shape’s ShapeSheet. To do this, select the shape and then choose Window ➪ Show ShapeSheet. Scroll to the Fill Format section and type the values for the fill you want. For more information on specifying color values in a ShapeSheet, see Chapter 33.

Formatting Shapes
You can apply different formatting options to shapes depending on what they comprise. For example, you can apply line formats to any shape containing lines whether they are open or closed shapes. When you format closed shapes, such as rectangles and circles, you can also specify the fill formatting for those shapes. If you format text-only shapes created with the Text tool or other shapes containing text, you can format the text in those shapes.
Applying Formatting to Shapes

If you want to modify the formatting on only one shape, it’s easy enough to select that shape and then apply the formatting options you want from those listed in Table 7-1. However, you can easily format several shapes or groups of shapes, and you can copy formatting from one shape to another. You can remove a shape’s border, but you don’t use a formatting tool to accomplish this. To hide a shape’s border, select the shape, click the Line Formatting arrow on the Formatting toolbar, and select No Line in the Line Style list.

Tip

If you can’t apply formatting options to a shape, the shape could be protected against formatting or it could belong to a group. See the “Protecting Shapes” section later in this chapter to learn more about shape protection. To format a shape in a group, subselect the shape (click the shape within the group until Visio displays the shape’s alignment box) and then apply the formatting you want.

<table>
<thead>
<tr>
<th>Formatting Task</th>
<th>How to Accomplish It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format a shape</td>
<td>Select a shape and then choose the formatting options you want.</td>
</tr>
<tr>
<td>Format several shapes at once</td>
<td>Select all the shapes and then choose the formatting options you want.</td>
</tr>
<tr>
<td>Format a group of shapes</td>
<td>Select the group and then choose the formatting options you want.</td>
</tr>
<tr>
<td>Copy formatting from one shape to another</td>
<td>Select a formatted shape, click the Format Painter button on the Standard toolbar, and click the shape to which you want to copy the formatting.</td>
</tr>
<tr>
<td>Copy formatting from one shape to several others</td>
<td>Select a formatted shape, double-click the Format Painter button on the Standard toolbar, and click each shape to which you want to copy the formatting. To stop copying formatting, click the Format Painter button or press Esc.</td>
</tr>
</tbody>
</table>

For instructions on formatting only the text in shapes, refer to the “Applying Formats to Text” section earlier in this chapter.

Applying Shadows to Shapes

You can add punch to your presentations by applying shadows to your shapes. You can use Visio 3-D shapes to add shapes that already have shadows set up. Shadows are not separate shapes; they are formatting that you can apply to add shadows to any shape you want.
You can define a default shadow for a drawing page. To do this, display the page, choose File ➪ Page Setup, and select the Shadows tab. Specify the shadow style, offset dimensions, magnification, and direction for the shadow, and then click OK.

To format and apply shadows, follow these steps:

1. Right-click a shape and choose Format ➪ Fill from the shortcut menu or select several shapes and then choose Format ➪ Fill.

2. Choose the shadow style you want in the Style list. Each shadow style includes offset dimensions, magnification, and direction for the shadow.

   To use the default shadow specified in Page Setup, choose Page Default in the Style list.

3. To change the shadow color from the one assigned by the current color scheme, choose a color in the Color list.

4. To change the shadow pattern, choose the pattern you want in the Pattern list. If you choose a pattern other than None or Solid, choose a color in the Pattern Color list.

5. To specify the transparency of the shadow, drag the Transparency slider to the right. By default, the shadow is opaque.

**Protecting Shapes**

You can protect shapes from inadvertent changes. The Formatting menu is an unlikely place for this tool, but you can use it to protect shapes against resizing, moving, rotation, text editing, and formatting. You can also prevent someone from selecting or deleting shapes. To protect shapes, select the shapes you want to protect and choose Format ➪ Protection. The Protection dialog box enables you to protect a shape in the following ways:

- **Resizing** — Check the Width, Height, or Aspect Ratio check boxes to prevent users from changing the width or height of shapes or from modifying the proportions of a shape.

- **Moving** — Check the X Position and Y position check boxes to prevent users from moving a shape to a new location.

- **Rotation** — Check this check box to prevent users from rotating a shape.

- **Moving Endpoints** — Check the Begin Point and End Point check boxes to lock the end points of 1D shapes in place.

- **Editing Text** — Check the Text check box to prevent users from editing shape text.

- **Formatting** — Check the Format check box to prevent users from modifying the formatting of a shape.

- **Selection** — Check this check box to prevent users from selecting a shape.

- **Deletion** — Check this check box to prevent users from deleting a shape.
You can quickly choose or remove protection by clicking the All or None buttons in the Protection dialog box.

Some shapes are protected against changes with the GUARD function. To learn how the GUARD function works, see Chapter 33.

Formatting with Styles

When you use the same sets of formatting options repeatedly, using styles is much easier than applying each formatting option you want to each shape. Much like a style in Microsoft Word, a Visio style compiles several formatting options into one handy package. However, because Visio works with more than text, a Visio style can do much more. You can specify whether the style incorporates text, line, and fill formatting, which determines whether it appears in those style lists, and you can assign any or all formatting options to any style. This enables you to format the lines, fill, shadows, and text for a shape by applying only one style.

You can view a style’s setting to determine which types of formatting it contains and which options it configures. To do this, choose Format ➪ Define Styles to open the Define Styles dialog box, shown in Figure 7-3. The check boxes in the Includes area indicate whether the style applies text, line, or fill formatting. To view the specific formatting options for the style, click the Text, Line, or Fill buttons in the Change area, but make sure you don’t change any of the settings.

Figure 7-3: View the type of formatting a style applies in the Define Styles dialog box.
Templates for drawings often include specialized styles for the shapes they contain. For example, when you create a building plan, Visio includes line styles with end points for building dimensions, fill styles for walls, and text styles for a variety of purposes. In most cases, you don’t have to think about applying styles; Visio assigns them automatically as you drag shapes onto your drawing. However, when you create a blank drawing or use drawing tools to add content, you can apply styles to format your shapes. For drawings you create without a template, Visio inserts five default styles for lines, fill, and text. Some of the default style names sound similar, so it’s helpful to know what each one does:

- **Guide** — For a drawing guide, the line style is a dashed, blue line. Text is Arial 9-point blue. There is no fill format.
- **No Style** — Basic formatting options, in which the line style is a solid black line. Text is Arial 12-point black with text centered and no margins in the text block. Fill is solid white with no shadow.
- **None** — Removes lines and fill so a shape has no boundaries and is totally transparent. Uses default text options of Arial 12-point black but includes 4-point margins in the text block.
- **Normal** — By default, Normal uses the same settings as No Style. However, you can redefine normal if you want.

To learn how to create and modify styles, see Chapter 34.

- **Text Only** — Removes lines and fill. Uses Arial 12-point black but aligns the text to the top left of the text block, with no margins.

### Applying Styles

Visio includes style lists on both the Format Shape and Format Text toolbars. If you choose Format ➪ Style, Visio opens the Style dialog box, which includes three style lists for text styles, line styles, and fill styles. Styles appear on these lists based on whether their Text, Line, or Fill check boxes are checked in the Define Styles dialog box. Depending on which style list you choose from, you can control which type of formatting Visio applies to the elements you select. However, applying styles has no effect when a shape is protected against formatting. Refer to the “Protecting Shapes” section in this chapter for instructions on removing formatting protection.

When you tweak a shape’s formatting options after you apply a style, it’s usually to resolve a readability issue for that shape. You can retain these individual formatting options even when you apply a different style to that shape. To do this, choose Format ➪ Style and check the Preserve Local Formatting check box.
To format using styles, select a shape or shapes and choose a style from one of the following style lists:

- **Text Style** — When you choose a style from the Text style list in the Format Text toolbar and the style specifies line and fill attributes, Visio asks whether you want to apply the line and fill formats. Click Yes to apply all formatting options. Click No to apply only text formatting.

- **Line Style** — When you choose a style from the Line style list in the Format Shape toolbar and the style specifies text and fill attributes, Visio asks whether you want to apply the text and fill formats. Click Yes to apply all formatting options. Click No to apply only line formatting.

- **Fill Style** — When you choose a style from the Fill style list in the Format Shape toolbar and the style specifies text and line attributes, Visio asks whether you want to apply the text and line formats. Click Yes to apply all formatting options. Click No to apply only fill formatting.

- **Style** — When you choose a style in the Style dialog box, Visio applies all formatting options. You can also open the Style dialog box by right-clicking a shape and choosing Format Style from the shortcut menu.

When you use styles to format shapes in a drawing, shape formatting can change when you copy the shapes to another drawing. This occurs when the destination drawing contains styles with the same names used in the source drawing but with different formatting options. To prevent your shapes from assuming the formatting in the destination drawing, rename the styles in the source drawing before copying the shapes.

### Restoring Default Styles

Sometimes, you want to remove the local formatting you applied to a shape — for example, when the colors assigned locally to a shape clash with the drawing’s color scheme. You can restore the default styles associated with the shape’s master by selecting the shape and choosing Format Style. In any of the style lists, choose Use Master’s Format, which is the first entry in the list, and click OK.

To restore the default style for a shape you created with a drawing tool, select the shape and apply the Normal style.

### Working with Colors

When you’re preparing presentations or illustrating complex topics, color can enhance the readability of your drawings and make them more appealing to your audience. You can choose from 16.7 million colors and 100 levels of transparency for text, lines, fill, and shadows.
You can fill shapes with transparent colors so that the colors mix when you overlap shapes. You can specify color transparency from totally transparent to completely opaque.

Although Visio provides a tempting supply of colors, drawings look more professional when you use fewer colors and coordinate them carefully. Visio provides tools to apply coherent sets of colors so you can quickly enrich the appearance of your drawings. You can select colors from a color palette or define your own custom colors. When you want to ensure that you use colors consistently throughout your drawing, you can apply a color scheme, which assigns colors to basic styles for your drawing. Any shapes or text formatted with styles based on those basic styles assume the colors from a new color scheme.

Visio displays the colors from the color palette and the current color scheme in color lists. These lists appear when you click the arrow in a Color box in any of the formatting dialog boxes. These colors also appear as color samples when you click Text Color, Line Color, or Fill Color on the Formatting toolbar.

You can define custom colors for text, lines, or fill by entering RGB (red, green, blue) or HSL (hue, saturation, luminosity) values in the Colors dialog box. To open the Colors dialog box, select More Colors at the bottom of any color list. When you apply custom colors to drawing elements, Visio stores the RGB or HSL values in the ShapeSheet so the colors won’t change when you change the color scheme or redefine colors in the color palette.

### Using the Color Palette

The color palette is a set of 24 indexed colors from which you can choose when you want to specify color for text, lines, fill, or shadows. When you apply one of these indexed colors to a shape, Visio stores in the ShapeSheet the index value of the color, such as 4 for bright blue in the default color palette. On the one hand, using indexed colors means that you can change any element that uses an indexed color by redefining that index color in the color palette. On the other hand, shapes can change color unexpectedly when someone redefines a color on the color palette or you copy shapes to a drawing that uses a different color palette.

### Applying Colors from the Color Palette

You can identify indexed colors in the color list by the number from 00 to 23 that precedes the color. To apply a color from the Color Palette, follow these steps:

1. Open one of the Format dialog boxes by choosing Format ▸ Text, Format ▸ Line, or Format ▸ Fill.
2. Click the arrow for one of the Color boxes in the dialog box, such as Color in the Fill dialog box.
3. Scroll to the top of the color list and click one of the colors preceded by a number.
Modifying the Color Palette

You can replace the colors in the color palette with custom colors that you define, or you can rearrange the colors in the palette so that the ones you use most frequently appear at the top of the list. For example, you can add the signature color for your company to the color palette so the company logo is the proper hue on your drawings.

When you edit the color palette, your changes affect only the current file. If you want to use your modified palette for other drawings, you can save a template with that color palette or copy the color palette from the current file to another drawing.

To edit the colors in the color palette, follow these steps:

1. Choose Tools ➪ Color Palette.
2. Click the color you want to edit and then click the Edit button to open the Edit Color dialog box.
3. Choose a standard color or define a custom color and click OK when you are done. Define a color by using either of the following methods:
   - To use one of the colors in the hexagon of samples on the Standard tab, click the cell with the color you want.
   - To define a custom color, select the Custom tab and choose RGB or HSL in the Color Model box. Type the values in the RGB or HSL boxes, depending on which color model you selected. You can also click a color in the Colors preview area. When the color is the hue you want, you can drag the arrow up or down to lighten or darken the tint.
4. Repeat step 3 to redefine other colors, and click OK when you have finished modifying the color palette.

Copying or Restoring a Color Palette

You can replace the current color palette when you want to restore the original Visio colors or use the color palette from another source. You can copy built-in Visio color palettes or color palettes from other open Visio drawings. In addition, you can copy the default Excel Chart color palette into a Visio drawing so you can coordinate the colors when you copy your Visio drawing into an Excel spreadsheet, or vice versa.

To copy the default color palette or a color palette from another source, follow these steps:

1. To copy a color palette from one Visio file to another, open both files.
2. Select the drawing you want to change and choose Tools ➪ Color Palette.
3. In the Copy Colors From list, choose the color palette you want to use.

- **Drawing Name** — To copy from another drawing, click the name of the open drawing whose color palette you want to copy.

- **Built-in Palette** — Click one of the entries with a .vss extension to copy a built-in color scheme.

- **Default Color Palette** — Choose Visio Default Palette to restore the color palette to Visio’s default colors. Choose Excel Chart Color Palette to use the color palette for Excel charts.

4. Click OK and save your drawing.

If the colors in your Visio drawing don’t look the way you want when you use them in a PowerPoint presentation, see Chapter 8.

### Working with Color Schemes

You can format all the shapes that support color schemes at once by applying a color scheme to your drawing. Many Visio drawing types, including most of the business diagrams, contain settings and styles that work with color schemes. Shapes in these drawing types are already formatted with styles that reference colors in the color scheme for text, lines, fill, and shadows. For example, Visio includes styles within color schemes that specify formatting for shape components such as shape faces and borders. In color schemes, you can also specify colors for the shadow for a shape, background and foreground colors in patterns, highlights, line colors, and text color. When you change the color scheme, the colors of shape components switch to the colors for the new color scheme. Although you can’t edit or delete built-in color schemes, you can create your own schemes from scratch or based on an existing scheme.

**Note**

Shapes that don’t support color schemes won’t change color when you apply a new color scheme. If you draw your own shapes or copy a shape from a drawing type that doesn’t support color schemes into a drawing that does, the shape colors won’t match the color scheme. However, you can apply a matching color to these shapes by selecting the shapes, opening one of the Format dialog boxes, and choosing a color scheme color in the color list. When you assign a color in this way, you must rematch the shape color manually each time you apply a new color scheme.

### Applying Color Schemes

To apply a color scheme to a drawing, follow these steps:

1. Right-click the drawing page and then choose Color Schemes from the shortcut menu.

**Tip**

The Color Schemes command is available on the drawing page’s shortcut menu only if the drawing type supports color schemes, as in templates such as Organization Chart, Calendar, and Flowchart.
2. Select the color scheme you want and click Apply to preview the new scheme.

3. If you want Visio to retain any specific color formatting you applied to shapes in the drawing, check the Preserve My Shape Color Changes check box.

4. Click OK to apply the color scheme or click Cancel to revert to the previous scheme.

Creating and Editing Color Schemes

To create or edit a custom color scheme, follow these steps:

1. Right-click the drawing page and then choose Color Schemes from the shortcut menu.

2. Click New or Edit in the Color Schemes dialog box to create a new color scheme or edit an existing scheme, respectively.

3. To change the name of the scheme, type a new name in the Name box.

4. To base a new color scheme on the color scheme in the current document, click the Use Current Document Style Colors button.

5. To modify a color scheme style, choose the style you want to change in the Style drop-down list. You can specify colors for the foreground, background, shadow, line, and text for that style. To specify one of these color settings, click the button for that setting to open the Colors dialog box. Choose a standard color or create a custom color as described in the “Modifying the Color Palette” section earlier in this chapter.

6. Repeat step 5 for each color scheme style you want to create or edit. Click OK when you are finished.

Specifying Basic Color Settings

You can specify the colors that appear by default for the drawing page, drawing page background, stencil text, stencil background, print preview background, and full-screen background. To do this, follow these steps:

1. Choose Tools ➪ Options, select the Advanced tab, and click the Color Settings button.

2. To change a color, click the arrow for the color you want to change and select a new color.

3. Repeat step 2 for each color you want to change. Click OK in the Color Settings dialog box and then click OK to close the Options dialog box.
The drawing window and stencil window each have two entries for background colors. With adequate screen resolution and your monitor set to display 32-bit color, Visio will grade the background from one of the colors into the other from the top to the bottom of the screen.

Color-Coding Shapes

You can color-code shapes based on the values in their custom properties. For example, you can highlight the building space occupied by different departments by color-coding space shapes by the value in the Department custom property.

To select the shapes you want to color-code, use one of the following methods:

✦ To color-code all shapes or all instances of one master, click the drawing page background to make sure nothing is selected.
✦ To color-code specific shapes, select only those shapes.

To color-code the selected shape, follow these steps:

1. Choose Tools ➪ Add-Ons ➪ Building Plan ➪ Color By Values.
2. In the Color By list, select the property by which you want to color-code the shapes.
3. In the Shape Type list, select the type of shape you want to color-code. To color-code all shapes, select <all shapes>.
4. In the Range Type list, select the type of values. Unique values apply a different color for each unique value in the custom property. Discrete values apply a different color for each range of values, such as 100 to 199. Continuous values apply colors from low to high across the range of custom property values.
5. In the Color field, select the colors you want to use.
6. To assign predefined colors to all values, click the Color arrow and select a color range. You can also click a box in the Color column to assign a new color to that box.
7. In the Value and Label fields, type the values for the color-coding and the labels you want to appear in the color legend. Click OK when you are finished.
8. To modify the color-coding in your drawing, right-click the legend on the drawing page and choose Edit Legend from the shortcut menu.
9. To update the color-coding to reflect changes to custom property values, right-click the legend and choose Refresh Legend.
Summary

Visio provides formatting tools so you can make your drawings look exactly the way you want. You can choose options to format text, lines, fill, and shadows. Color schemes and styles are the easiest way to apply consistent formatting to your drawings. By using color schemes, you can modify the formatting of all shapes that use styles associated with color schemes. You can also modify the formatting for all shapes using a specific style by modifying the formatting options of that style. Although styles appear in Text, Line, and Fill style lists, each style can include options for all three types of formatting. In addition, you can apply special formatting to specific shapes on your drawing and preserve those options as you apply the color schemes or styles.
Integrating Visio Drawings

In This Part

Chapter 8
Inserting, Linking, and Embedding Objects

Chapter 9
Importing, Exporting, and Publishing Visio Data to the Web

Chapter 10
Linking Shapes with Data
Inserting, Linking, and Embedding Objects

Your work with Microsoft Visio does not exist in a vacuum. The very point of Visio is to communicate information in a graphic way to others “out there.” Sometimes, Visio drawings are the end point for the communication. Other times, they become a part of larger communications, in reports or presentations, for example.

To facilitate this kind of information sharing, you can create hyperlinks to Visio drawings. Click the hyperlink, just as you do in a Web site, and Visio and the drawing are launched. You can take this concept of linking a step further by inserting Visio drawings as links in other application files, ensuring that any edits update the links. A third method is to insert, or embed, separate copies of Visio drawings in other application files, where you can view the drawings and use Visio tools to edit them at will.

These three methods work in the other direction as well. You can create hyperlinks in Visio drawings to other applications. You can link or embed the contents of other application files and make changes to them without leaving Visio itself. One of the most common elements embedded in Visio drawings are graphics such as clip art and digital photographs.

In this chapter, I show you how to create hyperlinks to and from Visio drawings as well as how to link and embed information from one application into another. I also demonstrate the finer points of embedding graphics files in Visio, and provide tips for adding Visio drawings to PowerPoint presentations to the best effect.
You can also exchange information between different applications by saving or opening files as different file formats. To learn about importing and exporting with Visio, see Chapter 9.

### Understanding Linking and Embedding

The term *linking* often brings to mind hyperlinks between Web pages, and rightly so, because you can certainly create hyperlinks from Visio drawings to other files, and vice versa. In addition, you can use another type of linking that uses Object Linking and Embedding technology, or OLE. Applications that employ OLE technology, including the Microsoft Office applications, can easily swap elements with other OLE applications. Swappable objects can be entire files or items within files. For example, you can include a PowerPoint presentation or an individual PowerPoint slide within a Visio drawing.

You can swap objects between applications by either linking or embedding them. With linking, a picture of the object appears in the target, or container, application, but the object actually exists elsewhere on the computer. When that object changes in the source application, it also changes in the container application. You can access the source application’s menus and tools within the container application to make changes there, and those changes also update the source file.

When an object is *embedded*, rather than linked, a separate copy of the object is inserted into the container application. The source file still exists, but separately and independently from the object in the container application. Similar to linking, you can access the source application’s menus and tools within the container application and make changes there, but the changes only update the copy of the object in the container application and do not affect the source file.

Whether you’re linking or embedding, you can double-click the object in the container application to make changes to it on the spot. You can also create a new object from scratch to link or embed in the container application. To decide whether you want to link or embed an object, evaluate the differences between these options in Table 8-1.

### Linking Elements

When you want to create links between documents in different applications, you can choose between hyperlinks or OLE links. With hyperlinks, the container application shows an icon or a different mouse pointer. When you click a hyperlink, the application to which the hyperlink is pointing launches in a separate window, and the file or Web page opens. With an OLE link, the container application can show either a representation of the source file or just the application icon. Either way, when you double-click an OLE link, the source application and the file launch in a separate window.
## Table 8-1
### Linking versus Embedding

<table>
<thead>
<tr>
<th>Feature</th>
<th>With Linking</th>
<th>With Embedding</th>
</tr>
</thead>
<tbody>
<tr>
<td>File versions</td>
<td>You need to deal only with one version of the object.</td>
<td>You have two separate and independent versions of the object.</td>
</tr>
<tr>
<td>Updating versions</td>
<td>When you change the object, either in the source or container application, it's updated in both locations.</td>
<td>Any changes to the source file do not affect the object inserted in the container file. Likewise, any changes made to the object do not affect the source.</td>
</tr>
<tr>
<td>File Size</td>
<td>You can maintain a smaller file size because the object is not actually within the container application — it's only a link.</td>
<td>The container file size can grow quite large, because it's actually storing the content of the object itself, not just the link to the source.</td>
</tr>
<tr>
<td>Time-Consuming File Launch</td>
<td>Larger or more complex files containing several links might take longer to open, especially across a large network. The source file is accessed and checked for changes, and those changes are updated in your target file, either manually or automatically.</td>
<td>Larger or more complex files containing several embedded files might take longer to open. This can be especially true if those embedded files contain graphics elements, as they take time to draw completely.</td>
</tr>
<tr>
<td>Source File Location</td>
<td>You must always be aware of the location of the linked file for the link to continue to work.</td>
<td>The container file is self-contained. You don't need to worry about the portability of the file or whether the source file has been moved.</td>
</tr>
<tr>
<td>Linking Individual Elements</td>
<td>You must link the entire file; you cannot link just an individual element within a file.</td>
<td>You can embed individual elements within a file.</td>
</tr>
</tbody>
</table>
Hyperlinks at Work

After you’ve added hyperlinks to your Visio drawing, their behavior depends on the method you choose for viewing your drawing:

- **Full screen mode** — If you choose View ➤ Full Screen or use a Visio drawing as a Web page, when the mouse pointer is over a shape containing a hyperlink, the pointer changes to the pointing hand icon. To follow the hyperlink, click the shape.

- **Normal mode** — If you are not in full-screen mode, when the mouse pointer is over a shape containing a hyperlink, the pointer changes to an arrow with the hyperlink globe icon. To follow the hyperlink, right-click the shape and then choose the link from the shortcut menu.

The Web page or file appears in its own window. If the hyperlink is designed to go to another Visio page, that page replaces the current page.

Another type of linking involves shape properties. To learn about linking shape properties to a database, see Chapter 10.

Using Hyperlinks

Add a hyperlink to a Visio drawing when you want to be able to dynamically click and launch a Web page or file from the drawing. When you have a multipage drawing, you can use hyperlinks to move from one page to another. You can also create hyperlinks from another application to a Visio drawing.

Although hyperlinks can be associated with drawing pages, they’re more commonly associated with shapes, including Hyperlink buttons or circles. To use specially designed Hyperlink shapes, open the Borders and Titles stencil, drag the hyperlink shapes to the drawing page, and add hyperlinks to those shapes.

To learn more about adding hyperlink navigation shapes to your drawings, see Chapter 9.

Inserting Hyperlinks

The first step to inserting a hyperlink in a Visio drawing is to decide where to place the hyperlink. If you associate the hyperlink with a shape, when you move the mouse over the shape, the pointer changes to one of the hyperlink icons to indicate that the shape is hot. When you click the shape, the linked application and file or Web page launches in a separate window. You can use this approach when you use a navigation shape on a drawing or want to navigate from the last step on one page to the continuation on another.

If you do not want to associate a hyperlink with a shape in the drawing, you can make the entire page hot instead. In this case, when you move the mouse over a
blank part of the page not inhabited by any shape, the mouse pointer changes to the hyperlink icon.

To insert a hyperlink in a Visio drawing, follow these steps:

1. Click the shape or page that you want to associate with the hyperlink.
2. Choose Insert ➤ Hyperlinks.
3. In the Address box, enter the address for the hyperlink using one of the following methods:
   - **Linking to a Web page** — Type the full address starting with the protocol—for example, http://. You can also click the Browse button and then click Internet Address. Your Web browser launches. Navigate to the Web page to which you want your Visio hyperlink to point. Return to Visio, and you should see the full Web address in the Address box of the Hyperlinks dialog box. If not, copy the address from the Web browser and paste it into the dialog box.
   - **Linking to a file on your system** — Enter the full file path. You can also click the Browse button and then click Local File. Navigate to the location of the file to which you want your Visio hyperlink to point. Select the file and then click the Open button.

   If you’re entering a Web address, remember to use front slashes (/) where necessary. If you’re entering a file path, remember to use back slashes (\) to separate the folder names.

4. To display text when the mouse pointer pauses over the hyperlink, enter the text in the Description box. When you’re finished, click OK.

   By default, hyperlinks use a relative path—that is, the path relative to the location of the Visio drawing itself. If you prefer to use the absolute path, uncheck the Use Relative Path for Hyperlink check box in the Hyperlinks dialog box. Because Visio uses relative paths when creating hyperlinks, this check box is dimmed until you save the Visio file.

You can associate multiple hyperlinks with a single element—for example, to provide links to each detail drawing page for a high-level process. In the Hyperlinks dialog box, click New, enter a new hyperlink address as usual, and then click OK. When you right-click the hyperlinked shape or page, a list of hyperlinks appears and you can choose the hyperlink you want from the shortcut menu. Add multiple hyperlinks when you expect to use the drawing only in normal mode. Multiple hyperlinks are not supported in full-screen mode.

When you use Internet Explorer 5.0 or later and right-click a shape with multiple hyperlinks, all the associated hyperlinks appear on the shortcut menu. For browsers or output formats such as SVG that don’t support multiple hyperlinks, you see only the default hyperlink when you right-click a shape or, if there is no default hyperlink, the first hyperlink in the list.
Inserting Hyperlinks to Drill Down in a Drawing

Suppose your Visio drawing starts with an overview process and you have other pages that include detail processes for several steps in the overview. You can create hyperlinks so you can drill down to see the detailed drawings. You can also use hyperlinks to move from one page to the next in a sequence of drawing pages.

To create hyperlinks for multiple pages in a Visio drawing, follow these steps:

1. Click the shape to contain the hyperlink. If this is an overview drawing, click the shape that represents the overview of the detail drawings to come. If this is the first page of a sequence of pages, add a navigation shape that indicates a next page.

2. Choose Insert ➪ Hyperlinks.

3. Next to the Sub-address box, click the Browse button to open the Hyperlink dialog box.

4. Select the page you want in the Page drop-down list, as illustrated in Figure 8-1.

5. To focus on a specific shape on the target page, type the name of the shape in the Shape box. When you click the hyperlink, Visio centers this shape in the drawing window.

Note
To find the name of a shape, right-click the shape and choose Format ➪ Special from the shortcut menu. The shape name appears in the Name box—for example, Circle, Sheet.1, or Manager.18.
6. To change the default size of the target page, select the percentage you want in the Zoom drop-down list.
7. Click OK to return to the Hyperlinks dialog box.
8. To display text when the mouse pointer pauses over the hyperlink, enter the text in the Description box. When you’re finished, click OK.

Cross-Reference
To learn about creating drill-down diagrams for network models, see Chapter 23.

Modifying Hyperlinks
If your Visio drawing is used for any length of time, it’s a good idea to periodically monitor your hyperlinks to make sure their locations have not changed. This is especially important if you’re pointing to Web pages or files that you don’t control. Your hyperlinks can break if someone changes or removes the Web pages or moves the files to which your hyperlinks point.

However, if the location of a hyperlink target changes, you can change your hyperlink definition. To modify a hyperlink, follow these steps:

1. Click the shape or page with which the hyperlink is associated and then choose Insert ➪ Hyperlinks.
2. If there are multiple hyperlinks for the selected shape, select the name of the hyperlink you want to change in the list.
3. In the Address box, edit the Web address or path name. You can also click the Browse button and navigate to the Web page or file to automatically update the address.
4. Make any other changes you want to the hyperlink and then click OK.

Creating Hyperlinks to Visio Drawings
You can create a hyperlink in another application, such as Microsoft Excel or any application that supports hyperlinks, to launch Visio and a particular drawing. It’s a similar process to creating hyperlinks in Visio. To insert a hyperlink from another application to a Visio drawing, follow these steps:

1. In the host, or container, application, click the location you want for the hyperlink.
2. Choose Insert ➪ Hyperlinks, or the equivalent command.
3. In the Text to Show box, enter a description for the hyperlink.
4. Browse through the file system to find the Visio drawing file. Select the file and then click OK.
Linking Visio Drawings with Microsoft Office Files

Insert an OLE link when you want to show part of the contents of the linked file, and when you want to just point to the file, rather than include it in its entirety. For example, suppose you want to show a Visio drawing in a Microsoft Word document. The Visio drawing is occasionally updated and you want to see those updates in the Word document. Creating a link to the drawing from Word is the perfect solution.

This works just as well in the opposite direction. You might have a Visio drawing that refers to a Microsoft Excel chart that is dynamically updated as data is entered. By linking that chart to your drawing, you can include the chart as an integral part of your Visio drawing and ensure that you’re always looking at the latest version of the data.

Whether Visio is the container or the source application, you can double-click the linked object to open the source application and file in a separate window. From there, you can enlarge the window and review the entire file. You can also edit the source file to make needed changes.

Linking Visio Drawings with Other Applications

You can link Visio drawings in any application that employs OLE technology, including the Microsoft Office applications. Going in the other direction, you can link another application’s files in a Visio drawing.

To link a file in one application to a file in another application, follow these steps:

1. Open the container application and the file in which you want to add the OLE link.
2. Choose Insert ➪ Object, or the equivalent command.
3. In the Object dialog box, select the Create from File tab or option and click Browse.
4. In the Browse dialog box, find and select the name of the source file you want to link to the current application’s file and then click Insert. The file path is completed in the File Name box.
5. Check the Link to File check box to ensure that the object is linked, rather than embedded.
6. To show the source application’s icon, rather than the file itself, in the container file, check the Display As Icon check box.
7. Click OK. At least a portion of the selected file shows in the container application, as illustrated in Figure 8-2.
Selection handles Linked object

Figure 8-2: The source file is linked in the container file.

Moving and Resizing Linked Objects

With the linked object in your container application, you can move and resize it at will using one of the following methods:

✦ **Select a linked object** — Click the object. A selection box similar to the selection box for a Visio shape appears around the object.

✦ **Resize the object proportionally** — Drag one of the selection handles in any of the four corners, as shown in Figure 8-2.

✦ **Stretch or condense the object along one side** — Drag one of the selection handles at the midpoint of a side.

✦ **Move the object** — Drag the middle of the object to the position you want. Take care to drag from the center of the object, and not along any of its edges.

By default, objects in Word are inserted in line with text, and you can’t reposition the object. Instead, you can use line spacing to adjust the object’s position. To change the object so you can drag it anywhere, right-click the object, and then choose Format Object from the shortcut menu. Select the Layout tab, click In Front of Text, and then click OK. Now you can drag the object wherever you like because it’s independent of the text in the Word document.
Editing the Content of a Linked Object

You can change the content of a linked object either from within the source application or the container application. Either way, you’re working with the same file. To change the content of a linked object, start by double-clicking the object. The source application and the file open in a separate window, as shown in Figure 8-3. Make whatever changes you want and then save and close the file. The source application window closes and you see the changes reflected in the object in the container application. If someone changes the source file while you’re working with the linked object, you’ll see the changes the next time you open the container file.

![Linked object in container application](image1)

![Launched source application](image2)

**Figure 8-3:** Double-click a linked object to open its application in a separate window.

**Note**

To edit the content of a linked object, you must have read-write privileges.

Managing Linked Objects

You can manage the links associated with linked objects, as well as specify how link updates are to occur. Using the Links dialog box, you can perform the following actions:

✦ Review details for all linked objects in the file.
✦ Review the path name for a linked source file and change the path if the file has moved.
✦ Specify whether you want updates from the source to be automatic or manual (they’re automatic by default).

✦ Break the link between the object and source, transforming the linked object into an embedded object or a static picture.

If you link to a file that is subsequently moved or deleted, the link breaks. The next time you open the container file, instead of a picture of the linked content, an error message appears, such as “Error! Not a valid link.” To change the path name for this broken link, follow these steps:

1. Choose Edit ▶ Links. The Links dialog box appears.
2. In the Links box, click the link whose path you need to edit.
3. Click the Change Source button and then browse to the new location of the source file.
4. Click the filename and then click Open.
5. When you’re finished making changes in the Links dialog box, click the Close or OK button.

You can change an automatic link update to manual update. To do this, select the link in the Links dialog box, select the Manual option, and then click Close. To update the manual links in your container file, open the Links dialog box again, select the link, and then click Update Now.

Tip
If you decide you no longer need a linked object at all, you can remove it from the container document by selecting the object and then pressing Delete.

<table>
<thead>
<tr>
<th>Change Links to Embedded Objects or Pictures</th>
</tr>
</thead>
</table>

Suppose you linked to a dynamic file that underwent ongoing changes so that you would see the most up-to-date version, but now the file is static and you would prefer to store the copy completely within the container document. You can break the link while keeping the object in the container, essentially converting a linked object to an embedded object. To do this, follow these steps:

1. In the container file, choose Edit ▶ Links, and then select the link in the Links box.
2. Click Break Link, and then click Yes in the message box that appears. The link information is removed from the Links dialog box.
3. Click Close. The object is still where it was in your container document, and looks just the same. However, it no longer is linked to the source. It becomes an independent copy existing within the container document—that is, it’s now an embedded file or a static picture.
Embedding Objects

When you embed an object from another application, you’re inserting an independent copy of the source file into the container application file. Like linking objects, you can access the source application’s tools within the container application and make changes on the spot. However, the changes update only the copy of the object in the container, and do not affect the source. Unlike linking, you don’t have to worry about the location of the source file: A copy of the file exists inside the container. Because of this, however, the size of the container file grows to accommodate that other file.

You can embed an entire source file or just a piece of it. For example, you can embed an entire Excel workbook within a Visio drawing, or just a single chart from that workbook. Likewise, you can embed all pages of a Visio drawing in a PowerPoint presentation, a single page, or even a single shape in another application.

Embedding Files and Fragments As Objects

If you’re working in any OLE application, you can embed all or part of another OLE application into the container file. When embedding an entire file, you choose the Insert ➪ Object commands. When embedding part of a file, you choose the Copy and Paste Special commands.

Embedding Entire Files

The procedure for embedding an entire file is nearly identical to linking. The difference is that you do not check the Link to File check box. To embed an entire existing source file into the container file, follow these steps:

1. Open the container application and file into which you want to embed the file from the other application.
2. Choose Insert ➪ Object, or the equivalent command.
3. In the Object dialog box, select the Create from File tab or option and click Browse.
4. In the Browse dialog box, find and select the file you want to embed in the current application’s file and then click Insert. The file path is completed in the File Name box.
5. Click OK. The selected file is inserted in your container file as an embedded object. Drag the edges of the object to resize it and move it to the position you want.

Tip
If you check the Display As Icon check box in the Object dialog box, the entire file is still embedded. However, displaying just the icon saves space in your document layout while providing a visual cue that more information is present.
Creating an Embedded Object from Scratch

If you want to create (with another application) a file whose only purpose would be to augment information in the container application file, you can create a brand-new file from within the container application.

To create a new embedded object file, follow these steps:

1. In the container application, choose Insert ▶ Object and then select the Create New tab or option.
2. Under Object Type, select the application with which you want to create the new embedded file.
3. Click OK. A blank file is inserted in your container file, and you can start creating the new embedded file using its application’s tools.

Embedding Parts of Files

You might want only a single page or portion of a Visio drawing in a Word report. Similarly, you might want to embed just a table from Word or a single PowerPoint slide in your Visio drawing, rather than the entire file. You can select and copy the portion of a file you want and embed only that much in the container file. Along with including only the necessary information, this can also help keep the size of the container file from ballooning larger than it needs to be.

To embed a part of a file in another application, follow these steps:

1. In the source application, open the file and go to the page that contains the portion you want to embed in the other application.
2. Using the application’s tools, select the portion you want to embed.
3. Choose Edit ▶ Copy, or the equivalent commands.
   
   **Tip**

   If you’re working in Visio, activate the Pointer tool if necessary, and then drag across the portion you want to embed. The selection area must fully enclose all elements you want to embed.

4. Switch to the container application, open the file, and go to the page in which you want to embed the object you just copied. If necessary, click the location where you want to embed the object.
5. Choose Edit ➪ Paste Special.

6. In the As box, click the type of object you’ve selected, such as Microsoft Visio Drawing Object or Microsoft Excel Worksheet.

7. Click OK. The copied object appears in the container file.

Ordinarily, you cannot link just a fragment of a file. However, if you have a multi-page Visio drawing and you choose Edit ➪ Copy Drawing, when you choose Edit ➪ Paste Special in the container application, the Paste Link option is available to you.

If you need only a single Visio shape in the other application, you can copy and paste it. In Visio, show the shape you want in the Shapes window. Right-click the shape and then choose Copy. (If you try to copy the shape from the Shapes window using any other method, it won’t work.) In the container application, select the location you want and then choose Edit ➪ Paste or click the Paste button on the Standard toolbar. You can also arrange the Visio and container applications side by side and then drag the shape from Visio to the other application.

**Positioning and Formatting Embedded Objects**

As soon as you insert an object into the container application, you can perform the following actions:

✦ Move it to the location you want.
✦ Resize it to the dimensions you need.
✦ Crop one or more edges of the object.
✦ Adjust the space surrounding the object.

Before you can manipulate the object, select the object by clicking it. A selection box appears around the object.

**Other Object Formats**

In the Paste Special dialog box, you might see other formats with which you can paste the copied object:

✦ Picture
✦ Device Independent Bitmap
✦ Picture (Enhanced Metafile)
✦ Bitmap

The options available depend on the container application. Click each item to see an explanation in the Result box.
Moving and Resizing Objects
To move an object, drag the middle of the object to the position you want. Take care to drag from the center of the object, not along any of its edges. To resize an object proportionally, drag one of the selection handles in any of the four corners. To stretch or condense the object along one side, drag one of the selection handles at the midpoint of an edge.

Cropping Objects
If you need to trim extraneous space from the edges of an object, crop the object. To crop a Visio object in another application, follow these steps:

1. In the other application, click the Visio object and then choose Format ➤ Object. The Format Object dialog box appears. Make sure the Picture tab is showing.
2. Under Crop From, enter the amount you want to crop from the Left, Right, Top, or Bottom.
3. When you’re finished, click OK. You might have to repeat these steps a few times to achieve the amount of cropping you want.

To crop an object in Visio, follow these steps:

1. If it’s not already showing, display the Picture toolbar by choosing View ➤ Toolbars ➤ Picture.
2. Select the object you want to crop.
3. On the Picture toolbar, click the Crop button.
4. Drag a selection handle in the object in the direction you want to crop the object.

Adjusting the Space Surrounding Objects
To adjust the space surrounding a Visio object in another application, follow these steps:

1. In the other application, double-click the Visio object to open the in-place editing window.
2. Drag one of the selection handles to change the shape surrounding the object.
3. Click in the container file outside the in-place editing window. The editing window closes, and the container file reflects the new space surrounding the object.

To adjust the space surrounding an object in Visio, follow these steps:

1. If not already showing, display the Picture toolbar by choosing View ➤ Toolbars ➤ Picture.
2. Select the object.
3. On the Picture toolbar, click the Crop button.
4. Drag a selection handle outward from the object in the direction in which you want to add space around the object.
Editing the Content of Embedded Objects

You can change the actual content of an embedded object without leaving the container application. In effect, you can work with the tools of two applications in one.

To edit an embedded object, simply double-click it. The in-place editing window appears. The menu and toolbars change from those of the container application to those of the embedded object’s application, as shown in Figure 8-4. You can use them exactly as if you were working with the source application. When you’re finished editing, click in the container file outside the in-place editing window. The editing window closes and the embedded object reflects your edits.

Figure 8-4: Adjust the space around a drawing by dragging the selection handles in the in-place editing window.
If you prefer, you can open an object in a separate window. To do this, select the object and choose Edit, and then choose the type of object, such as Visio Object or Worksheet Object. Choose Open. The object and its source application open in a separate window where you can make the changes you want. When you’re finished, choose File ➤ Update to update your changes to the container application. Close the Visio window to return to the container application. You can now see the object with your edits.

Inserting Graphics in Visio

Inserting graphics such as clip art or photographs is a specialized form of embedding. You can use the new Clip Art Task Pane in Visio 2003 to search a variety of sources for just the right piece of clip art. You can insert a graphics file you have handy, including graphics from a digital camera or scanner. Because embedding graphic files is done so frequently, Visio includes tools to make the process easy and versatile.

Inserting Graphics Files

To insert a specific graphics file you have on your hard drive or network drive into a Visio drawing, follow these steps:

1. In your Visio drawing, select the page in which you want to insert the graphic.
2. Choose Insert ➤ Picture ➤ From File. The Insert Picture dialog box appears.
3. Browse to the location of the graphic, select the file, and then click Open. The graphic appears on the page.
4. Resize, move, and crop the graphic as needed on the page.

Searching for and Inserting Clip Art

To embed a piece of clip art in Visio, follow these steps:

1. In your Visio drawing, select the page in which you want to insert the graphic.
2. Choose Insert ➤ Picture ➤ Clip Art. The Clip Art Task Pane appears.
3. In the Search For box, type a key word or phrase that describes the type of clip art you want.

Note

If you haven’t installed the clip art feature, you’ll see a prompt to do so. The CD is not required to install clip art.
Tip

Searches execute faster if you use specific key words or phrases. However, you can use general key words to obtain a wider selection of clip art.

4. In the Search In box, specify where you want Visio to search. You can check the check box for a particular folder on your hard drive, such as Office Collections. You can also have Visio search the Internet in a particular Web collection. Be aware that the wider the search and the larger the collections, the longer the search might take.

5. In the Results Should Be box, select the type of media you want to find, such as photographs or sounds. To further specify file formats you want, click the plus sign under the media. This can help narrow your search, especially when searching Web collections.

6. When you’re finished defining your clip art search criteria, click Go. Results of your search appear in the Clip Art Task Pane as thumbnails.

7. When you find the clip art you want to use in your drawing, drag it into position in your drawing. Resize the art if necessary.

Inserting Pictures from Digital Devices

To insert a picture coming from a digital device such as a scanner or digital camera, follow these steps:

1. In your Visio drawing, select the page in which you want to insert the digital picture.

2. Choose Insert ➪ Picture ➪ From Scanner or Camera. If you have more than one digital device attached to the computer, select the one you want to use in the Device box.

3. If you’re inserting a picture from a scanner, select Web Quality or Print Quality. Click Insert.

   Note

   If the Insert button is not available or you want to change your scanner’s settings, click Custom Insert.

4. If you’re inserting a picture from a digital camera, click Custom Insert. Follow the instructions for the camera until the picture is inserted.

5. Resize, move, and crop the picture as needed on the page.

Fine-Tuning Visio Drawings for PowerPoint

PowerPoint presentations and Visio drawings go together like bread and butter. Visio is great for illustrating processes, while PowerPoint provides the larger context in which to explain those processes to your audience. Embedding Visio
drawings in PowerPoint adds a world of clarity to your presentations. You can apply specific techniques for size, position, color, and animation to ensure that your Visio drawings look compatible and work effectively in the presentations.

**Formatting Visio Drawings in a Presentation**

The text and color scheme of your Visio drawing might look great on its own, but not so great when you bring it into your PowerPoint presentation. You can adjust the drawing to coordinate its colors with PowerPoint. You can also tweak the drawing to ensure that it’s appropriate for projection on a screen and for viewing at a distance by an audience. For example, you can use a smaller font size for body type and titles for a drawing in a paper report or in a Web page. However, when the drawing is being projected and viewed by a presentation audience, you need to be sure that text can be read by everyone all the way in the back of the room. Edit the text in the drawing so that it’s at least two to four points larger than you typically use for reports or Web pages.

**Tip**

Print your drawing, place it on the floor, and stand up over it. If you can read all the text comfortably from your height, your audience will probably be able to read all the text comfortably in the presentation.

Pay attention to the contrast of letters and lines against the background. What looks snazzy on a Web site might look washed out or busy in a presentation. Use high contrast between foreground and background elements. For example, you can use combinations such as dark blue text and lines on a white background, or white text and lines on a black background.

**Cross-Reference**

If you’re using styles in your drawing, you might be able to adjust the drawing by simply changing the text, line, and fill styles. This way, you don’t have to adjust each element individually. For more information about working with styles, see Chapters 7 and 34.

**Coordinating Visio Color Schemes with PowerPoint**

You might find that the color scheme of your embedded Visio drawing is clashing with that of your PowerPoint presentation. You can adapt the drawing to the PowerPoint color scheme by following these steps:

1. In PowerPoint, double-click the embedded drawing to open the Visio window within PowerPoint.
2. Right-click an empty area of the Visio window and then choose Color Schemes from the shortcut menu. The Color Schemes dialog box appears.
3. To change the Visio drawing color scheme to the PowerPoint color scheme, select PowerPoint and then click OK.
4. Click outside the Visio window on the PowerPoint slide to close the Visio window.
Creating Color-Coordinated Backgrounds

You might want to retain the colors in the Visio drawing as they are, especially if the colors have special significance or if the linked drawing was created by someone else. You can make the colors work better in a presentation by simply adding a complementary background in the slide in which the drawing is linked or embedded.

To create a color-coordinated background for your Visio drawing in PowerPoint, follow these steps:

1. In PowerPoint, show the slide in which you will be linking or embedding the Visio diagram.

2. On the Drawing toolbar, click the Rectangle tool.

   If the Drawing toolbar is not visible in PowerPoint, choose View ➪ Toolbars ➪ Drawing.

3. In the slide, drag the area to define the size of the rectangle. Drag any of the selection handles to further adjust the size of the rectangle.

   If you have already inserted the object, it’s okay to cover the object with the rectangle for now — you can bring the object to the top after you’ve defined the rectangle.

4. On the Drawing toolbar, choose the Fill Color tool to fill the inside of the rectangle, as shown in Figure 8-5. By doing this, you can select a color that offsets the Visio drawing well, but also works with the overall color scheme of the PowerPoint presentation.

Figure 8-5: Place a filled rectangle behind a Visio drawing to complement the color scheme of your PowerPoint presentation.
5. On the Drawing toolbar, choose the Line Color tool to add a color to the rectangle’s outline.

6. If you have not already inserted the object, do so now by choosing Insert ➤ Object. Use the selection handles to move and resize the drawing into position within the rectangle.

7. If you have already inserted the object, you can bring it to the front of the rectangle by right-clicking the rectangle and choosing Order ➤ Send to Back from the shortcut menu.

Building Drawings in a Presentation

Many processes are best explained by introducing a single element at a time. Not only does this break the process down into manageable chunks, it also keeps the audience focused on the current topic. When you present an entire drawing at once, many people only half-listen to the presentation while they’re busy deciphering the full diagram.

You can build drawings in PowerPoint using animation in a single slide or by building a drawing incrementally across multiple slides. Either way, you can build sequential elements of the drawing with consecutive mouse clicks.

Animating a Drawing on One PowerPoint Slide

With animation on a single slide, you can control how each element enters the slide. To build multiple elements in a drawing using animation on a single PowerPoint slide, follow these steps:

1. In Visio, select the part of the drawing that makes up the first element you want on the PowerPoint slide. Either drag across the shapes or Shift+click each shape.

   Connectors might bend in wrong directions after you separate and paste them in PowerPoint. In Visio, choose View ➤ Toolbars ➤ Layout & Routing. Shift+click the connectors in your drawing and then click the Never Reroute tool on the Layout & Routing toolbar.

2. Choose Edit ➤ Copy.

3. Switch to PowerPoint and add or show the slide where you want to build the elements from the Visio drawing.

   The Blank or Title Only slide layouts are ideal for this purpose.


5. Repeat steps 1 through 4 for each succeeding element you want to build on the slide. After pasting the next element, drag the grouping into the position you want on the slide.
6. When all elements are showing in the PowerPoint slide, select the element you want to appear first in the slide show and then choose Slide Show ➤ Custom Animation.

The animation features are available in Microsoft PowerPoint 2002 and later.

7. In the Custom Animation Task Pane, choose Add Effect ➤ Entrance, and then choose the entrance effect you want for the first element.

8. Under Modify, specify how you want the effect to behave. For example, you can specify what action triggers the effect, the direction, and the speed.

9. Repeat steps 6 through 8 for each succeeding element in the order you want to introduce them in the animation. You can choose the same or different effects for each element.

10. When you’re finished, click Play at the bottom of the Custom Animation Task Pane to show the animation in the current window. You can also click Slide Show in the Custom Animation pane to show your animation in the full Slide Show screen. When you’re finished, click a final time or press Esc to return to the normal window.

To remove an animation effect, right-click it in the Custom Animation Task Pane and then choose Remove.

Building Sequences of PowerPoint Slides
To build multiple elements in a drawing using multiple sequential PowerPoint slides, follow these steps:

1. In PowerPoint, click the New Slide tool on the Formatting toolbar to add a slide for each element of the drawing you want to build.

2. In the Slide Layout Task Pane, click the layout you want for each new slide. The Blank or Title Only slide layouts are ideal for this purpose.

3. In Visio, select the part of the drawing that makes up the first element you want on the PowerPoint slide, as shown in Figure 8-6. Either drag across the shapes or click each shape while pressing Ctrl or Shift, and then choose Edit ➤ Copy.

4. Switch to PowerPoint, show the first slide of the sequence you’re building, and then choose Edit ➤ Paste, as shown in Figure 8-7.

5. Switch back to Visio again, and, with the first element still selected, Shift+ click the second element and choose Edit ➤ Copy.

6. To paste the elements for the second slide, switch to PowerPoint, show the second slide of the sequence, and choose Edit ➤ Paste.

7. Repeat steps 5 through 7 for each additional element you’re adding to the sequence.
Figure 8-6: Select the part of the drawing that you want to show in the first PowerPoint slide of the sequence.

Figure 8-7: The first part of the Visio drawing is pasted in the first PowerPoint slide of the sequence.

Tip: Be sure to paste the element in the same location on each slide. Zooming into the slide and using the ruler can help position the element precisely so that the elements transition smoothly from one slide to the next.

8. When you’ve added all Visio drawing elements to their PowerPoint slides, choose Slide Show ➪ View Show and then click through the slides to preview the construction of the sequence.

9. After the last slide, click or press Esc to return to the normal PowerPoint view. Make any necessary adjustments to the drawing sequence.
To add a transition effect to a Visio drawing build sequence, follow these steps:

1. In PowerPoint, in the Slides pane, Shift+click to select all the slides in the drawing sequence for which you want the same transition effect.

   If the Slides pane is not showing, choose View ➪ Normal (Restore Panes) and make sure the Slides tab is selected.

2. Choose Slide Show ➪ Slide Transition.

3. In the Slide Transition Task Pane, click the effect you want when the slides move from one to the next.

4. Under Modify Transition, specify how you want the transition effect to behave. For example, you can specify how fast the effect should occur and whether any sound effect should be associated with the transition.

5. Under Advance Slide, specify the action that moves from one slide to the next.

6. Click Play at the bottom of the Slide Transition Task Pane to show the transition effect for the current slide.

7. Click Slide Show in the Slide Transition Task Pane to show the slide sequence and their transitions in the full Slide Show screen. When you’re finished, click a final time or press Esc to return to the normal window.

**Summary**

You can integrate information between Visio and other applications in a variety of ways. You can create hyperlinks from a Visio drawing to a file in another application, and vice versa. Through the use of OLE technology, you can insert a picture from one application into another and create a dynamic link between the two so that editsinstantaneously update both source and target. You can also insert an independent copy of information from another application by embedding an object. With all these integration methods, you can create and use information in the applications best suited to your task, and expect that information to behave as if it were all part of a single integrated application.
Visio provides several ways to integrate Visio drawings with documents in other applications. Depending on your goal and the capabilities of the other applications, you can embed, link, or export data between Visio and other Office applications such as Excel, Word, and PowerPoint, as well as other applications such as databases or CAD programs. In addition, you can share Visio drawings with others who don’t have Visio by publishing Visio drawings to the Web or, if you own Adobe Acrobat, by exporting them to Adobe PDF format.

To learn about linking and embedding with Visio, see Chapter 8.

Although linking and embedding documents provides more control over document appearance and the changes you can make, you can also export Visio drawings to incorporate Visio data in documents that don’t use OLE or to include drawings in HTML files for publication to the Web. You can also export Visio data to store it in Excel spreadsheets, AutoCAD drawings, or ODBC-compliant databases. In many cases in which you want to transfer data in or out of Visio, such as creating organization charts from organizational data in an employee database, you can use features built into Visio templates to import and export data. In this chapter, you learn how to accomplish all these tasks.

If you want your Visio drawings to display data from other sources, you can learn how to link Visio drawings to data sources in Chapter 10.
Part II ✦ Integrating Visio Drawings

**Formats for Importing and Exporting**

Visio 2003 supports numerous formats for importing and exporting data. However, this version adds support for a few new formats, while dropping support for several others, as shown in Table 9-1. In addition to a variety of graphics formats, Visio can export data to XML files, Excel spreadsheets, and ODBC-compliant databases, such as Access.

In Visio 2003, you can import and export to a new Web graphics standard format: Scalable Vector Graphics. You can also import appointments from Microsoft Outlook into Visio calendars.

<table>
<thead>
<tr>
<th>Supported Formats</th>
<th>Formats No Longer Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD Drawing (.dwg)</td>
<td>Adobe Illustrator (.ai)</td>
</tr>
<tr>
<td>AutoCAD Interchange (.dxf)</td>
<td>ABC Flow Charter 2.0, 3.0, and 4.0 (.af2, .af3)</td>
</tr>
<tr>
<td>Compressed Enhanced Metafile (.emz)</td>
<td>CorelDRAW! 3.0 through 7.0 (.cdr)</td>
</tr>
<tr>
<td>Enhanced Metafile (.emf)</td>
<td>CorelFLOW (.cfl)</td>
</tr>
<tr>
<td>Graphics Interchange Format (.gif)</td>
<td>Computer Graphics Metafile (.cgm)</td>
</tr>
<tr>
<td>Joint Photographic Experts Group (JPEG)</td>
<td>Corel Clipart Format (.CMX)</td>
</tr>
<tr>
<td>File Interchange Format (.jpg)</td>
<td></td>
</tr>
<tr>
<td>Portable Network Graphics (.png)</td>
<td>Bentley Microstation Drawing (.dgn)</td>
</tr>
<tr>
<td>Scalable Vector Graphics Drawing (.svg)</td>
<td>MicroGrafx Designer 3.1 and 6.0 (.drw, .dsf)</td>
</tr>
<tr>
<td>Scalable Vector Graphics Drawing – Compressed (.svgz)</td>
<td>Encapsulated Postscript (.eps)</td>
</tr>
<tr>
<td>Tag Image File Format (.tif)</td>
<td>Interchange Graphics Exchange Standard (.jgs)</td>
</tr>
<tr>
<td>Web Page (.htm, .html)</td>
<td>ZSoft PC Paintbrush (.pcx)</td>
</tr>
<tr>
<td>Windows Bitmap (.bmp, .dib)</td>
<td>Macintosh PIST (.pct)</td>
</tr>
<tr>
<td>Windows Metafile (.wmf)</td>
<td>PostScript (.ps)</td>
</tr>
</tbody>
</table>

When you export shapes or drawings by choosing File ➪ Save As, an Output Options dialog box might appear (depending on the export format you select) in which you can specify the settings for the exported file. In addition, the settings vary depending on the file format to which you want to export your drawing. You can find out more about the different export settings by clicking the Help button in the Output Options dialog box.
If you have Adobe Acrobat installed on your computer, you can create files in PDF format for your Visio drawings by printing them to the Adobe PDF printer.

To learn more about importing and exporting CAD drawings in Visio, see Chapter 25.

**Using Template Tools to Import and Export**

You can import data to create new Visio drawings or export Visio data by using database connections or wizards built into specialized templates. For example, the following templates offer tools for importing and exporting data:

- Project Schedules, including Gantt Chart, Timeline, and Calendar
- Building Plans, including Space Plan and other types of floor plans
- Brainstorming Diagram
- Organization Chart
- Database Model Diagram
- UML Model Diagram

To learn how to import data to create specialized Visio drawings, see Chapter 14 for importing organization charts, Chapter 17 for importing project information, or Chapter 19 for importing database models.

**Exploring the New SVG Format**

Visio 2003 supports the SVG format, albeit with some limitations, as summarized in Table 9-2.

<table>
<thead>
<tr>
<th>SVG Support</th>
<th>SVG Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open, Insert, and Save As support for both uncompressed (SVG) and compressed (SVGZ) files.</td>
<td>Scripting, animation, sound, XSLT style sheets, CSS cascading rules, masking and compositing, and metadata are not supported in Visio 2003.</td>
</tr>
<tr>
<td>When you open an SVG or SVGZ file, Visio translates SVG symbols into Visio masters and transforms SVG uses and paths into Visio shapes.</td>
<td>SVG parameterized linear gradients map to one of four predefined linear gradients in Visio.</td>
</tr>
</tbody>
</table>
Importing Data into Visio

Visio provides several methods for importing graphic files and other documents. For documents that support OLE, you can link or embed files in a Visio drawing. For some drawing types, you can import files by using the import tool located on the specialized menu for the drawing template. For other types of files, you can insert them as pictures in a Visio drawing page or save them as Visio drawings.

Importing Graphic Files into Visio

You can import files saved in other formats simply by opening them in Visio. Choose File ➪ Open, choose the file format you want to import in the Files of Type box, and choose the file you want to import. If you don’t see the type of file you want to import in the Files of Type list, save the file to one of the formats that Visio supports and then import the file.

If you want to import a file into an existing drawing, you can choose Insert ➪ Picture to insert the file as a picture on the current drawing page. However, this technique can change properties and set options without your intervention. For example, text boxes can end up on nonprinting layers.

Visio creates a new drawing file and adds the imported file as a picture. However, the picture acts as a shape with selection handles and a rotation handle, which you can use to resize or rotate the picture.

After you import a picture, you can crop the image to modify how much of the picture is visible on the drawing. To crop a picture, display the Picture toolbar by choosing View ➪ Toolbars ➪ Picture and then click the Crop tool. Drag a selection handle on the picture to crop it. If you want to display a different area of the picture,的选择引用部分。
picture, position the pointer over the picture and then drag the hand symbol until the area you want to display appears. When you finish cropping the picture, select another tool such as the Pointer tool.

Cropping a picture does not resize it. The cropped area is a border that reduces the amount of the picture that you see. However, the entire picture is still there. If you want to delete the areas outside the cropped border to reduce the size of the image, choose Format ➪ Picture, select the Compression tab, check the Delete Cropped Areas of Pictures check box, and then click OK.

### Importing Your Outlook Appointments to a Visio Calendar

Microsoft Outlook doesn’t provide an easy way to publish or distribute calendars. However, with Visio 2003 and Microsoft Outlook 2000 or later, you can import Outlook appointments into a Visio calendar, which you can then format, print, share, or publish. By using the Import Outlook Data Wizard, you can perform the following actions:

- Specify a date and time range.
- Include appointments that match a subject.
- Create a one-week, multiweek, or one-month calendar.
- Use Visio calendar tools to format and customize the calendar.

You can create Visio calendars based only on the Gregorian calendar. If your Microsoft Outlook calendar format is set to Arabic, Hebrew, Chinese, Japanese, Korean, or Thai, you can change your Outlook calendar format to Gregorian, use the wizard to import your appointments into Visio, and then change your Outlook calendar format back.

To create a Visio calendar from Outlook appointments, follow these steps:

1. Choose File ➪ New ➪ Project Schedule ➪ Calendar.
2. Choose Calendar ➪ Import Outlook Data Wizard.
3. In the Import Outlook Data Wizard dialog box, select the option to specify whether you want to create a new calendar or add appointments to the selected calendar and then click Next.

The Selected Calendar option is not available if you do not select a calendar before you start the wizard.

4. Specify the start and end dates and the start and end times that you want to scan for appointments.
5. To limit the appointments added to the calendar, click Filter and check the Subject Contains check box in the Filter Outlook Data dialog box. Type the subject text for the appointments you want to import, click OK, and then click Next.

6. If you choose to create a new calendar, specify the calendar type you want to create. You can specify a week, month, or multiple-week calendar, and select the day that begins the week. If you want to shade weekends, select the Yes option. If you want to display dates in a specific format, choose the language for that format in the Language list and click Next.

7. On the last wizard screen, review the calendar properties that you selected. If you want to change any properties, click Back or Cancel. To create the calendar, click Finish.

If appointments overlap, you can resize the calendar or delete some appointments.

Several people can combine their schedules onto one Visio calendar. To do this, import your appointments to the calendar and then route the calendar to the next person. Each person runs the Import Outlook Data Wizard to add their appointments to the calendar.

Exporting Shapes and Drawings

Because files go through transformations during export and subsequent import into another application, exporting to other formats might alter the appearance of your Visio drawings. If you find that a special fill pattern or other format causes problems, you can apply a different format and then try exporting your drawing again.

Visio gradient fill patterns might not transfer accurately when you save them in a non-Visio graphics format. If gradient fills don’t look the way you want, replace them with plain fill patterns and then export your Visio drawing.

To export Visio shapes or drawings, follow these steps:

1. Display the page you want to export in Visio. If you want to export specific shapes on a page, select them.

2. Choose File ➪ Save As and select the export format you want in the Save As Type drop-down list.

3. Type the name you want in the File Name box and click Save.

4. Depending on the type of format you chose, you might have to specify options in an Output Options or Filter Setup dialog box. After you specify the options you want, click OK. Visio exports the page and selected shapes to a file using the format you chose.
Tip

If you export Visio shapes but they don’t appear in the exported file, the shapes might be metafiles, such as Visio Network Equipment shapes or some objects linked or embedded in a Visio drawing. To export metafiles, apply the Ungroup command until Visio converts all the components of the metafile to shapes, and then export the drawing.

You can specify export options for the following formats:

- **TIFF** — Data compression, color format, background color, color reduction, transformation, resolution, and size
- **JPEG** — Baseline or progressive, color format, background color, quality, transformation, resolution, and size
- **GIF** — Data format, background and transparency color, color reduction, transformation, resolution, and size
- **PNG** — Same options as GIF

**Publishing to the Web**

When you want to share information with a large or widely distributed audience, the Web is frequently your first choice. Fortunately, with every release, Visio makes it easier to publish Visio drawings to the Web. In Visio 2003, you can publish Visio drawings to the Web by saving Visio drawings as their own Web pages or as part of existing Web pages, saving them as graphics files that you can embed in Web pages, or saving them as Visio XML files that you can open in a Web browser.

**Choosing an Output Format for a Visio Web Page**

When you save a Visio drawing as a Web page, you can choose from several output formats. The best format depends on what you are trying to accomplish by publishing the Web page as well as what types of browsers your audience uses. You can use Table 9-3 to help determine which output format works best with the browsers your audience is likely to use. In addition, you can evaluate output formats based on the tasks you want to perform in the following lists.

Saving Visio drawings as Web pages is effective when you want to

- Export several pages of a multiple-page drawing at once
- Maintain navigational links in shapes when you publish to a Web page
- Include reports that users can view easily

Saving drawings in JPG, GIF, PNG, or SVG format is preferable when you want to

- Insert a Visio drawing into an existing HTML Web page
- Publish only a portion of a drawing
### Table 9-3
Browser and Output Format Compatibility

<table>
<thead>
<tr>
<th>Output Format</th>
<th>Earliest Browser Supported</th>
<th>Internet Explorer 5.0 or Later Behavior</th>
<th>Other Browser and Version Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>VML with alternate browser support</td>
<td>Any HTML 2.0–compliant browser that supports frames</td>
<td>Drawing is displayed in VML and scalable with browser window</td>
<td>Drawing is displayed in JPEG, GIF, or PNG, but is not scalable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Left frame includes Go To Page, Pan and Zoom, Details, and Search Pages</td>
<td>Left frame shows pages as links</td>
</tr>
<tr>
<td>VML only</td>
<td>Internet Explorer 5.0</td>
<td>Drawing is displayed in VML and is scalable with browser window</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Left frame includes Go To Page, Pan and Zoom, Details, and Search Pages</td>
<td></td>
</tr>
<tr>
<td>SVG with alternate browser support</td>
<td>SVG Viewer and any HTML 2.0–compliant browser that supports frames</td>
<td>Drawing is displayed in SVG with SVG Viewer or SVG-compatible browser; otherwise, as JPEG, GIF, or PNG.</td>
<td>Drawing is displayed in SVG with SVG Viewer or SVG-compatible browser</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Left frame includes Go To Page, Details, and Search Pages</td>
<td>Left frame shows pages as links</td>
</tr>
<tr>
<td>SVG only</td>
<td>SVG Viewer and Internet Explorer 5</td>
<td>Drawing is displayed in SVG with SVG Viewer or SVG-compatible browser; otherwise, as JPEG, GIF, or PNG</td>
<td>Drawing is displayed in SVG with SVG Viewer or SVG-compatible browser</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Left frame includes Go To Page, Details, and Search Pages</td>
<td>Left frame shows pages as links</td>
</tr>
</tbody>
</table>
### Output Format

<table>
<thead>
<tr>
<th></th>
<th>Earliest Browser Supported</th>
<th>Internet Explorer 5.0 or Later Behavior</th>
<th>Other Browser and Version Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG or GIF</td>
<td>Internet Explorer 3.0, Netscape Navigator 3.0, and any HTML 2.0–compliant browser that supports frames</td>
<td>Drawing is displayed in JPEG or GIF and is not scalable.</td>
<td>Drawing is displayed in JPEG or GIF and is not scalable.</td>
</tr>
<tr>
<td></td>
<td>Left frame includes Go To Page, Details, and Search Pages</td>
<td>Left frame shows pages as links</td>
<td></td>
</tr>
<tr>
<td>PNG</td>
<td>Internet Explorer 4.0 or later; Netscape Navigator 6.0 or later</td>
<td>Drawing is displayed in PNG and is not scalable</td>
<td>Drawing is displayed in PNG and is not scalable</td>
</tr>
<tr>
<td></td>
<td>Left frame includes Go To Page, Details, and Search Pages</td>
<td>Left frame shows pages as links</td>
<td></td>
</tr>
</tbody>
</table>

### Saving Drawings As Web Pages

Whether your Visio drawings contain one page or several, it’s easy to transform them into Web pages. When you use Microsoft Internet Explorer 5.0 or later and save Visio drawings as Web pages, you can navigate around the drawing, zoom in and out, display custom properties for shapes, search the drawing for shapes, or view reports associated with the drawing, as illustrated in Figure 9-1. When you save a Visio drawing as a Web page, by default Visio creates HTML frame pages with frames for drawing pages and controls, and generates HTML source code.

In order for colors to appear properly when you display a Visio drawing as a Web page, your system must have more than 256 colors. Even then, colors don’t always match exactly when you display a Visio drawing on the Web.

To save a Visio drawing as a Web page, follow these steps:

1. Open the Visio drawing that you want to publish to the Web and then choose File ➪ Save As Web Page.
2. In the Save As dialog box, navigate to the folder in which you want to save the file and type the name for the Web page file in the File Name box.
3. To specify the title you want to appear in the browser title bar, click Change Title, and then, in the Page Title dialog box, type the title you want, and click OK.
4. Click Publish to specify the Web page publishing options, which are described in more detail in the next section.
5. If you didn’t specify publishing options, click Save in the Save As dialog box. If you did click Publish to set additional options, click OK.
Ctrl+click shape to view custom properties

Figure 9-1: Visio includes controls and other information in the left frame of a Web page.

Specifying Web Page Publishing Options

When you save a Visio drawing as a Web page, you can specify which pages to publish, which controls appear in the left frame of the Web page, and the output format and additional display options, such as the target resolution you want. To specify Web page publishing options, click Publish in the Save As Web Page dialog box.

When you select the General tab, you can specify the following options:

- **Specify pages to publish** — To specify a range of pages to publish, select the Pages: From To option and type the page numbers for the first and last pages in the range.

- **Display search and navigation controls** — Check Go to Page and Search Pages in the Publishing Options list.

Tip

If you don’t want a left frame in your browser window and don’t need Go to Page to navigate between Web pages, uncheck Go to Page, Search Pages, Details, and Pan and Zoom.
✦ **Display custom properties for shapes** — If you want to display custom properties in a table on the left side of the browser window, check Details in the Publishing Options list.

To view custom properties in the left frame, you can Ctrl+click a shape that contains custom properties on the Web page or click the shape and then press Ctrl+Enter.

✦ **Display pan and zoom controls** — Check Pan and Zoom in the Publishing Options list. Pan and zoom controls are available only when you use the VML output format in Internet Explorer 5.0 or later.

✦ **Publish reports** — Check each report you want to publish in the Publishing Options list. Reports appear on separate pages that you can access by using the Go to Page control in the left frame of the Web page.

If no shapes in your drawing match the report query, Visio creates the Web page without the report.

✦ **Open Web page in browser** — To open the Web page in your browser immediately after you save it, check Automatically Open Web Page in Browser, under Additional Options.

✦ **Organize supporting files in a folder** — This option creates a subfolder for storing the supporting files for the Web page. When you move your Web page to another folder, the supporting files folder moves with it automatically.

You can specify the following options on the Advanced tab:

✦ **Specify output format** — To specify the output format for the Web page, choose the format you want in the Output Formats drop-down list. VML produces the best results for displaying controls in the left frame of the Web page. VML and SVG support scalable graphics, so the Web page output resizes if the browser window resizes.

Because VML and SVG require more recent browser versions, it’s a good idea to specify an alternate format so that the Web page still opens in older browsers. In addition, you must install an SVG viewer to view Web pages in SVG format. If you open a Web page in SVG format without an SVG viewer, the page appears in a format such as GIF.

✦ **Specify an alternate format for older browsers** — To ensure that your Visio Web page works with a wide range of browsers, including earlier versions, check the Provide Alternate Format for Older Browsers check box and select the format you want, such as JPG or GIF.

✦ **Specify the target resolution** — If you are creating a file in JPG, GIF, or PNG format, specify the smallest resolution that you expect people to use to view your Web pages.
You don’t have to specify the Target Monitor resolution for scalable formats such as VML and SVG.

✦ **Embed a saved Visio Web page in another Web page** — Specify the Web page in which you want to embed the saved Web page, as described in the next section.

✦ **Specify color scheme** — If you want to apply the color scheme for your Visio drawing to the resulting Web page, select the color scheme in the Style Sheet drop-down list. This color scheme applies colors to the left frame and report pages that match the color scheme for the Visio drawing.

### Caution

Visio looks for the supporting files for a Web page based on the root file’s name. If you rename a root HTML file, Visio displays a warning that renaming the file will break the links to the supporting file folder. Instead of renaming a root file, open it in Visio, save it with the new name (which also creates a new subfolder), and delete the old _files folder.

### Files That Visio Creates for Web Pages

Web pages require a lot of files, so it’s helpful that Visio creates all the files you need for a Web page and stores them in a convenient location. However, if you publish Visio drawings as Web pages often, it’s a good idea to understand what files Visio creates and where they’re located.

When you save a drawing as a Web page, Visio creates a root HTML file for your Visio drawing in the folder that you specify. In addition, Visio creates a subfolder in the same location using the same name as the root HTML file but with _files appended to the end. Visio stores the files required for the Web page in the subfolder. Because of this naming convention, the subfolder moves with its root HTML file; if you delete the HTML file, the subfolder is deleted as well. However, when you move HTML files, you might have to edit them to update pointers to graphics files.

For each Visio drawing, Visio creates the following files:

✦ A root HTML file with the name you specified, such as AcmeOrg03.htm

✦ Graphics files of the output format you specified for each published page in the Visio drawing, such as vml_1.htm, and the alternate format, such as gif_1.gif, if you chose to include an alternate format for older browsers.

✦ Other files that support the publishing options you selected when you published the Web page, such as graphics (.gif) for controls, style sheet (.css), script (.js), and data files (.xml)
Embedding Visio Drawings in Web Pages

If your organization already has a Web page template, you can create a Visio Web page to embed in your company’s template instead of creating one to stand on its own. If you want to distribute a drawing electronically but don’t need to show custom property data or provide navigation tools, you can also embed Visio drawings as images using GIF, JPEG, or PNG format.

To embed a Visio Web page in another HTML page, you add an `<IFRAME>` tag to the host HTML page where you want the Visio drawing to appear, and specify the host page in the Save as Web Page dialog box. Visio provides a sample template, Basic.htm, in the Host in Web Page list if you need an example of how to use the `<IFRAME>` tag.

To use an existing HTML template to display a Visio Web page, follow these steps:

1. Edit your HTML template to include the following HTML tag:
   ```html
   <IFRAME src="##VIS_SAW_FILE##">
   
   This tag embeds the Visio Web page into your HTML template. It is case-sensitive and refers to the HTML output file that Visio creates when you create a Visio Web page.
   
   2. Choose File ➪ Save As Web Page and specify the folder and name for the Web page in the Save As Web Page dialog box.
   
   3. Click Publish and select the Advanced tab.
   
   4. Under Host in Web Page, browse to the HTML template file that you want to use as the host page and click OK.

   Note
   Visio stores the Basic.htm template in the Visio path, usually C:\Program Files\Microsoft Office\Visio 11\1033\. Your customized HTML templates appear in the Host in Web Page drop-down list if you store copies of them in this same folder.

Adding Hyperlink Navigation Shapes to Drawings

Navigating between shapes and pages is easy when you add hyperlinks to the shapes on your drawings. When you create a Web page from a Visio drawing, Visio saves these hyperlinks in shapes, so people viewing the drawing on the Web can navigate to the information they want. However, Visio doesn’t indicate the presence of a hyperlink until you position the pointer over a shape with a hyperlink. You can make your drawing easier to navigate by adding hyperlink navigation shapes to your drawing before you save it as a Web page. People viewing the drawing can navigate simply by clicking the navigation shapes on the Web page.
Other Ways to Reference Visio Drawings in HTML

You can include links to Visio Web pages in other Web pages or reference images of Visio drawings, if you don’t need special features such as custom properties. To include a link to your Visio Web page, you can add a tag to your HTML template, such as the following:

```
<a href="##VIS_SAW_FILE##">My Drawing</a>
```

To reference a graphics file in a Web page, save your Visio drawing in JPEG, GIF, or PNG format. Then add an `<IMG>` tag to your HTML code, such as `<IMG SRC="process_flow1.gif">`. Visio drawings saved as graphics do not include custom properties or navigation controls, such as hyperlinks.

To keep links intact, you can print a Visio drawing to a PostScript printer to create a PostScript file. Then, you can use Acrobat Distiller to create a PDF format file of the drawing to include in the HTML file.

Cross-Reference

To learn about creating hyperlinks in your Visio drawings, see Chapter 8.

Although you can add hyperlinks to any shape you want, the Borders and Titles stencil includes several built-in navigation shapes, Hyperlink Button, Hyperlink Circle 1, and Hyperlink Circle 2, that automatically open the Hyperlinks dialog box when you drag them onto a page. After you add one of these hyperlink shapes to a drawing, you can change the icon that appears in the shape to indicate the function of the associated hyperlink. Table 9-4 includes the names of the icons you can use.

<table>
<thead>
<tr>
<th>Table 9-4</th>
<th>Hyperlink Icons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>Forward</td>
</tr>
<tr>
<td>Up</td>
<td>Down</td>
</tr>
<tr>
<td>Home</td>
<td>Help</td>
</tr>
<tr>
<td>Directory</td>
<td>Info</td>
</tr>
<tr>
<td>Search</td>
<td>Mail</td>
</tr>
<tr>
<td>Photo</td>
<td>None</td>
</tr>
</tbody>
</table>
To add a navigation shape to a drawing, follow these steps:

1. Drag one of the hyperlink shapes from the Borders and Titles stencil onto a drawing page.
2. In the Hyperlinks dialog box, specify the address or sub-address for the hyperlink and click OK.
3. To change the icon in the shape, right-click the hyperlink shape and choose Change Icon from the shortcut menu. Select the icon you want in the Icon Type drop-down list and click OK.

Summary

You can import and export Visio data to other formats such as Excel spreadsheets, AutoCAD drawings, ODBC-compliant databases, graphic files, and Web pages. Many of the templates that are built into Visio include tools that simplify the task of importing and exporting data to specific types of drawings. However, to import data from another source into Visio without a specialized tool, you need to select the type of file in the Open dialog box and open the file you want. To export data to another format, you use File ➪ Save As, selecting the type of format you want in the File of Type drop-down list. When you want to publish Visio drawings to the Web, the Save As Web Page command provides numerous options for specifying the contents and functionality of the resulting Web page.
Visio drawings are a great way to convey information. However, by linking shapes on your Visio drawings to databases, you can transform your drawings into visual and dynamic representations of the data stored in databases. For example, you might link furniture specifications from an asset database to the furniture shapes on a Visio office layout, even sizing the furniture on the plan based on the dimensions in the database. Shape-database links can be bi-directional, so you can make changes in your drawing and propagate them to the database table, or vice versa. Visio can link to any database that supports the Open Database Connectivity (ODBC) standard, which includes Oracle, Informix, Microsoft Access, and Microsoft Excel.

You can link shapes on a drawing page to database records, but it’s usually more effective to link masters so that shapes are linked as soon as you drop them on a page. You can create masters that link to any record in a database table and select the record you want when you drag the master to a page. You can also create masters for each record. For example, if you have a database table, such as the computer equipment for your next client installation, you can create a stencil with a master for each component and create an equipment layout by dragging the masters onto the page. You can also export shape data to a database, including basic shape properties such as the shape’s name and location on the drawing page, as well as custom properties.

No matter how you decide to use links between shapes and databases, Visio makes it easy to keep your drawings and databases synchronized. You can add commands to synchronize your data to the shortcut menus for shapes or drawing pages or specify an interval and let Visio update your shapes and linked database records automatically. In this chapter, I...
show you how to link your Visio drawings to database fields to synchronize your drawings with data stored in a database or to store shape information in a database.

**Understanding Links Between Shapes and Databases**

Databases store data in fields in records, which in turn are stored in tables. Although you view shapes on a drawing page, Visio stores shape data such as name, position, and custom properties in the cells of ShapeSheets, which look much like spreadsheets. Visio connects shapes with databases by linking cells in ShapeSheets to fields in database records.

Chapter 33 explains how to use ShapeSheets to customize shapes.

You use a Data Source Name (DSN) created in the Open Database Connectivity (ODBC) Administrator to specify both the database that contains the data you want and the driver to use with it. Whether you use the Link to Database or Export to Database commands, the Database Wizard, or the Database Export Wizard, you can choose an existing DSN or create a new one.

When you link shapes to databases, each shape in a drawing corresponds to a record (or row) in a database table, and each linked field in the record corresponds to one cell in the shape’s ShapeSheet, as shown in Figure 10-1. With a link between a ShapeSheet cell and a database field, you can change the value in the cell to update the field, or vice versa.

You can link Visio shapes with a database without a database application installed on your computer. However, you must have the database application installed if you want to open the database directly to edit its records.

Although you usually link custom properties to database fields, you can link other ShapeSheet cells as well. For example, you can propagate equipment dimensions in a database table to the Width and Height cells in a ShapeSheet to specify a shape’s size. If the ShapeSheet doesn’t have cells suitable for linking to your database fields, the Database Wizard or Link to Database command creates new cells in the Custom Properties section of the ShapeSheet.
Chapter 10 • Linking Shapes with Data

Shape linked to database

Custom properties for shape

Property values linked to database fields

Connection string for link to database

Figure 10-1: ShapeSheets cells connect to database fields.

Visio also creates a User.ODBCConnection cell in the User-Defined Cells section of the ShapeSheet to specify information about the connection to the database table. This cell is a concatenation of several lines of text separated by vertical bars. By separating the lines, you can see the components of the connection string:

```
ODBCDataSource=Visio Database Samples
ODBCQualifier=C:\PROGRA~1\MICROS~2\Visio11\1033\DBSAMPLE
ODBCTable=Airplane - Filled Seats
1
SeatNumber=Prop.SeatNumber
5
Baggage=Prop.Baggage=32
Class=Prop.Class=0
FrequentFlier=Prop.FrequentFlier=0
PassengerName=Prop.PassengerName=0
TicketPrice=Prop.TicketPrice=111
```
The connection string includes the following information:

- **ODBCDataSource=\(<name>\)** — The name of the data source to which the shape is linked. The example uses a sample data source installed with Visio.
- **ODBCQualifier=\(<name>\)** — If your data source includes more than one database, this parameter specifies the direct path to the database to which the shape is linked.
- **ODBCTable=\(<name>\)** — This is the name of the table to which the shape is linked.
- **\(<number>\)** — The fourth line in the example represents the number of key fields you specified. The example uses only one key field.
- **\(<Field Name>=\(<name>\)>** — The fifth line in the example specifies the field and the ShapeSheet cell used to store the key.
- **\(<number>\)** — The sixth line in the example represents the number of fields linked to shape properties. In the example, five fields are linked.
- **\(<Field Name>=\(<name>=\)<number>\)>** — For each field linked to a ShapeSheet cell, the connection string identifies the linked field name and the ShapeSheet cell name to which it is linked. The number at the end of the line represents the constant for the Evaluate As setting. For example, 0 represents Value, whereas 111 represents Currency. In the example, lines 7 through 11 specify field information.

### Linking Drawings to Databases

By linking your Visio drawings to databases, you can transfer data between shapes and database records. You can update Visio drawings to show the current values in your databases or update your database with changes made in Visio drawings. For example, you can maintain a flowchart of a process with the estimated cost, the duration, and the assigned department from a reengineering database. Then, if you notice an error in the flowchart, you can update the database with the correction made on the Visio diagram. You can use either the Database Wizard or the Link to Database command to link drawings and databases in the following ways:

- Link shapes to records in databases.
- Create Visio drawings that represent the data in database tables.
- Create masters linked to database records.
Limitations of the Database Wizard

Links between Visio shapes and tables in databases have the following limitations:

✦ **String Length** — To store ODBC strings in Visio cells and fields, they must be smaller than 64K characters.

✦ **Binary Field Length** — To store ODBC binary fields in Visio cells and fields, they must be less than 32K.

✦ **Precise Numbers** — Visio stores numeric values as double floating-point numbers, truncating numbers with greater precision to 17 significant digits.

✦ **Database Key Field** — You can’t use a field of the `SQL_TIMESTAMP` type as a primary key.

✦ **ID Replication** — You can’t update replication IDs in Microsoft Access.

✦ **Timestamps** — You can’t update Timestamp fields when you use an Informix database.

✦ **Row Deletion** — You can’t delete rows in Excel when you use the Excel ODBC driver. The Database Wizard indicates deleted rows by setting text fields to `#ROW DELETED#` and numeric fields to 0. For wizard operations, such as Update, Select, and Refresh, the values 0 and `#ROW DELETED#` are invalid keys.

Creating Connections to Data Sources

Before you can link a Visio drawing to a database or other source of data, you must define and select an ODBC data source. By defining a data source, you specify the following:

✦ The name and location of the database you want to use

✦ The driver to use with the database

✦ The type of data source

✦ Who can access it

✦ A unique name for the data source so it’s easy to find later

You can define data sources in Visio with the Export to Database and Link to Database commands and the Database wizards. You can also define data sources from the Windows Start menu by Choosing Control Panel ➪ Administrative Tools ➪ Data Sources (ODBC).
Each Visio database command and wizard includes similar steps for defining a data source. To define a data source using the Link to Database command, follow these steps:

1. Choose Tools ➪ Add-ons ➪ Visio Extras ➪ Link to Database and then click Create. This command is not available unless a drawing is open.

2. Specify who can access the data source. In the Create New Data Source dialog box, choose one of the following options for type of data source and then click Next:
   - **File Data Source** — You can copy a file data source to other computers or network locations. Any user who can access the data source can use it.
   - **User Data Source** — This creates a data source available only on the current computer and visible only to the current user.
   - **System Data Source** — This creates a data source available only on the current computer but accessible to any user who logs on to the system.

3. Select the 32-bit ODBC driver you want to use in the Driver list and click Next.

4. In the driver-specific dialog box that opens, type a data source name. Because the functionality of ODBC drivers varies, it’s a good idea to include the type of data source in the name, along with a brief description of the data, such as Employees_Excel2000. After you specify the location and name for the data source, click Next and then click Finish.

   **Note**

   By default, Visio creates data sources in C:\Program Files\CommonFiles\ODBC\Data Sources. If you create data sources in the default location, they appear in the list of available data sources. However, you can create data sources anywhere you want. If you don’t see your data source in the list, click Browse and navigate to the location of your data source.

5. If you’re creating an Access data source, click Select to specify an existing database for the DSN. Select the database file you want to use and click OK. For example, to use the sample database included with Microsoft Office, navigate to C:\Program Files\Microsoft Office\Office10\Samples in the Select Database Dialog box, select Northwind.mdb in the Database Name list, and click OK. The ODBC Data Source Administrator creates the data source and adds it to the list of available data sources. When you complete this step, you can continue with the Link to Database command to select and link to the data source, as described in the next section.

   **Note**

   If you’re creating an Excel-based data source, you must specify the version of Excel and then select the Excel .xls file you want to use as the database. After you select the file to use, click Options and uncheck the Read Only check box. You can create tables in Excel files by clicking Define Table on the Choose a Database Object to Connect to screen in the Database Wizard. Visio stores tables created in Excel 5.0 or later as separate worksheets in the Excel file and creates a named range for the records.
To use an Excel workbook as a data source, you must create a named range in a worksheet that includes all the rows and columns of data. Visio uses the values in the first row of the named range as table column names.

**Linking Drawing Shapes to Database Records**

You can use the Database Wizard or the Link to Database command to create a link between your drawing and database records. For example, if you have a furniture plan drawn, you can link the furniture shapes to records in a facilities management database that includes fields such as manufacturer, model, color, cost, department, and employee. The Database Wizard feeds you steps one at a time, whereas the Link to Database command provides the features you need to create a link in one dialog box.

To link shapes using the Link to Database command, follow these steps:

1. Select the shapes you want to link to a database and then choose Tools ➪ Add-Ons ➪ Visio Extras ➪ Link to Database.
2. Select the data source you want to use. If you select Excel Files as the data source, select the Excel file (.xls) that you want to use in the Select Workbook dialog box, uncheck the Read Only check box, and click OK.

   **Note**
   If you don’t see your data source in the list, click Browse, navigate to your data source folder, and select the data source. For example, to use the sample database included with Office, in the File Open dialog box, navigate to C:\Program Files\Common Files\ODBC\Data Sources, select the data source file you want, and click Open. You can click Create to create a new data source, as described in “Creating Connections to Data Sources” in this chapter.

3. If you can access multiple databases through your data source, select the database you want to use in the Qualifier drop-down list. To filter the list of tables to those for a specific owner, select an owner in the Owner drop-down list.

   **Note**
   If you use a data source based on Excel, Access, or another application that creates single databases, the Qualifier box shows the database path and name, and the Owner box is set to All Users.

4. In the Table/View list, select the database table you want to use. For Excel data sources, the Table/View list shows the worksheets within the Excel workbook.

   **Note**
   You can create a new table or worksheet in the data source by clicking New.

5. If you want to change the default mapping between database fields and ShapeSheet cells, select a field and click Modify. Select the ShapeSheet cell to which you want to link. If you want to change the data type for the field, select a type in the Evaluate As drop-down list. If you want to use a field as the primary key, select Yes in the Key drop-down list.
Click Add or Delete to create new links or delete existing links between fields and cells.

6. Click OK to create the links.

7. To associate a shape on a drawing to a specific record in the table in the data source, right-click the shape and choose Select Database Record. In the Key Value list, select the record you want and click OK to insert the record values into the linked ShapeSheet cells.

The Database Wizard divides the steps in the Link to Database command into screens for each step in the process. To use the Database Wizard to link shapes to database records, follow these steps:

1. Select the shapes on a drawing that you want to link to a database.
2. Choose Tools ➪ Add-ons ➪ Visio Extras ➪ Database Wizard. Click Next on the first screen.
3. Make sure the Link Shapes to Database Records option is selected and then click Next.
4. Select the Shapes in a Drawing option and click Next.
5. By default, Visio selects the current drawing, current drawing page, and the shapes you selected in step 1. To link shapes on a different drawing, select the drawing in the drop-down list or click Browse to open the drawing file you want to link. Select the page in the Page drop-down list. You can select the shapes you want in the Shape Names and IDs list or click Select Shapes to select shapes by clicking them on the drawing. When you are finished selecting shapes, click Next.
6. Select the data source to which you want to link.
7. Select the table you want to use and click Next. Continue to step through the screens to specify the primary key, events and commands to add to shortcut menus, and field mapping. Click Finish to create the links.
8. To associate a shape to a specific record in the data source, right-click the shape and choose Select Database Record. In the Key Value list, select the record you want and click OK to insert the record values into the linked ShapeSheet cells or custom properties.

Linking Masters to Databases

Although you can link shapes on drawings to database records, you can create drawings with links to databases more effectively by using masters already configured with database links. For example, you can create office furniture masters that pull model information, such as manufacturer, model, cost, and color, from a furniture database. When you drag a master onto a page, the shape comes with custom properties pre-populated with the manufacturer, model, and cost. You can use the color from the database to specify the shape’s fill color so the layout shows the color scheme for the office.
You can also create masters that link to any database record. Using an example from the Visio samples database, you can create a master for an airplane seat and link that master to a database with information about the seats in a plane. After you build a diagram of the seats for a Boeing 767, you can link each seat shape to a seat number in the database.

**Generating Masters from Each Database Record**

You can create a master for each record in a database table. For example, if you want to create a flowchart that shows every process in your business process reengineering database, you can generate masters for each record and then drag each master onto the drawing page to build your diagram. The shapes on the drawing are automatically linked to the appropriate record in the database. To generate masters from a database table, follow these steps:

2. Choose the Generate New Masters from a Database option and click Next.
3. In the Stencil box, select the stencil that contains the Visio master that you want to use as the basis for new masters. Choose the master in the Masters list and click Next.
4. Continue through the wizard to select the data source, the table, and the primary key.
5. In the Choose the Database Link and Naming Options screen, check the Keep Database Links in New Masters check box if you want to create a bi-directional link between the database and the masters. Select an option to either generate master names based on the values in the primary key field or on the original Visio master name. Click Next.

   *Note* If the master you use doesn’t show custom properties in text fields, it’s easier to identify the master you want when you name the master using the primary key. For example, using the airplane seat number as the primary key, each airplane seat master would include the seat number in the name, such as Seat.2a.

6. Specify the links between ShapeSheet cells and database fields and click Next.
7. Select an option to create a new stencil or append the linked masters to an existing stencil. Click Next and then click Finish.
8. To save the stencil containing the linked masters, choose File ➪ Save, specify a folder and a stencil name, and then click Save.
9. To use the stencil, save it, close it, and then reopen it to use it on a drawing.

**Linking Masters to Specific Records**

When you want every instance of a master to use the same information, you can link masters to specific records in an existing database table. For example, you can link an equipment master to the database record that contains the specifications for the piece of equipment so that each instance of that master includes the specification
values, such as amps, operating temperature, and BTUs. To create a master linked to a specific database record, open the master for editing. Use the Link to Database command to link the master to a data source. Then, in the master drawing window, right-click the master and choose Select Database Record to specify the record with the data for that master. Choose File ➪ Save to save the stencil.

You can also create a master linked to a record by creating a link between a shape on a drawing page and a database record and then dragging the linked shape onto an editable stencil.

Creating Masters That Link to Any Database Record

You can link masters, such as furniture shapes, to database information, such as model lists, without specifying a record for the master. When you drag a master such as this onto the drawing page, you choose the database record you want the instance to represent. To create a master that can link to any record in a database table, follow these steps:

2. Select Link Shapes to Database Records and click Next.
3. Select the Master(s) on a Document Stencil option to link masters specific to a drawing, or Master(s) on a Visio Stencil to link masters that you can use on any drawing. Click Next.
4. Select a document stencil or click Browse to select a Visio stencil or one of your custom stencils. By default, Visio opens the File Open dialog box at the My Shapes folder.
5. Choose the master you want to link and click Next.
6. Continue through the Database Wizard screens to select a data source, the table to which you want to link, the primary key, events and shape shortcut menu commands, and the ShapeSheet cell that holds the primary key value.
7. On the Link ShapeSheet Cells to Database Fields screen, click a ShapeSheet cell in the Cells list, click the corresponding database field in the Database Fields list, and then click Add. Visio adds the shape-field link in the Links list. When no database fields are visible in the Database Fields list, click Next and then click Finish.
8. To save the stencil containing the linked masters, choose File ➪ Save, specify a folder and descriptive stencil name, and click Save.

Creating Drawings from Database Records

You can use the Database Wizard to generate a Visio drawing that contains a shape for each record in an existing database table. For example, if you have a database or spreadsheet that delineates the computer equipment you’re going to install at a client site, you can use the Database Wizard to create a layout drawing with shapes linked to each record. Then you can move the shapes into the layout you want.
To create a drawing based on a database table, follow these steps:

1. Follow the steps in the preceding section to create a master that links to a database table.
2. Choose Tools ➤ Add-Ons ➤ Visio Extras ➤ Database Wizard. Click Next on the first wizard screen.
3. Select the Create a Linked Drawing or Modify an Existing One option and click Next.
4. Select the Create a Drawing Which Represents a Database Table option and click Next.
5. Select the Create New Drawing option and click Next.
6. Continue through the wizard to select a drawing template, options to use to monitor the drawing, and information about the data source to use.

**Note**

If the database table includes data for the x and y coordinates of the shape’s position, be sure to uncheck the Automatically Distribute Shape on Page check box and the Automatically Scale the Drawing Page check box.

7. When the Select a Visio Master Shape screen appears, click Browse and navigate to the stencil you saved in step 1. Select the linked master and click Finish to create a new drawing with an instance of the master for every record in the table, such as the airplane layout shown in Figure 10-2.

![Shapes laid out based on positions in database table](image)

**Figure 10-2:** You can generate a drawing based on the records in a database table.
Exporting Shape Data to Databases

You can export shape data and custom properties to a database table using either the Database Export Wizard or the Export to Database command. In addition to stepping through the process, the Database Export Wizard includes an option to export all shapes on a layer. However, if you don’t want to export by layers, you can follow a more streamlined process by choosing Tools ➪ Export to Database.

To export shape data to a database with the Database Export Wizard, follow these steps:

2. Select the drawing file that you want to export and then select the page you want to export and click Next.
3. Click one of the following options for the shapes you want to export and then click Next:
   - **All shapes on the page** — This option exports all shapes on the selected page.
   - **Selected shapes on the page** — This option exports any shapes you selected before you started the wizard. To select additional shapes, click Select Shapes.
   - **All shapes on one or more layers** — Select the layers you want to export in the Layers list to export all shapes on those layers.
4. For each Visio item you want to export, select the item in the Visio Cells and Fields list and click Add. Visio adds the cell or field you chose to the Cells and Fields to Export list. Click Next.
   
   **Note**
   
   Cell names for custom properties begin with Prop. followed by the custom property name. For example, the cell name for the custom property Duration is Prop.Duration.

5. Select the data source to which you want to export and click Next.

6. In the Table Name list, select the table to which you want to export the Visio data. If you want to create a new table in the data source, type the name of the table in the Table Name box.

7. To specify a key to uniquely identify each record, type a name in the Key Field box. By default, the key field is the ShapeID, which is the shape name with a sequential ID generated when you add the shape to a drawing page. To use the GUID as the unique identifier, select GUID in the Key Type drop-down list. Click Next.

   **Note**

   If the ODBC driver does not support primary keys, the Make Key Field the Primary Key for Table check box is grayed out.
8. To modify the default field mapping that Visio defines, in the Specify the Export Mapping Details screen, select an item in the Visio Data list, modify one or more of the following options, and then click Next:

- **Evaluate Data As** — Specify the data type or units for the Visio item.
- **Field Name** — Modify the field name to use in the export data source.
- **Field Type** — Modify the field type, which is a broad category such as Number.

9. If you want to re-export data by right-clicking the drawing page, make sure the Add Export Right Mouse Action to the Drawing Page check box is checked.

10. Click Next and then click Finish to export the data.

When you export shape data with the Database Export Wizard, the wizard stores export-related information with the drawing page. If you want to export the data again after you have modified the drawing, right-click the drawing page and choose Database Table Export.

### Keeping Drawings and Databases in Sync

Visio provides several methods for manually and automatically synchronizing the data in your linked Visio drawings and databases. When you link shapes on a Visio drawing to a database record, Visio adds four commands for maintaining database links to each shape’s shortcut menu. In addition, Visio provides several add-ons that help you update many shapes at once.

To update a single shape or database record, right-click a shape and then choose one of the following commands on the shape’s shortcut menu:

- ✦ **Select Database Record** — Specify the database record to which you want to link the shape.
- ✦ **Refresh Shape Properties** — Replaces the shape’s properties with data from the linked database record.
- ✦ **Update Database Record** — Replaces the data in the database record with values from the shape’s custom properties.
- ✦ **Delete Shape and Record** — Removes the shape on the drawing page and the linked record in the data source.

If you want to remove the links to a database while keeping the shape on a page, run the Database Wizard as if you were linking shapes. In the screen in which you select a drawing, a page, and shapes, select the shapes whose links you want to break and then click Remove Links.
If you want to refresh or update all the shapes on a drawing page, use one of the following add-ons:

✦ **Database Refresh** — Replaces each shape’s properties with data from its linked database record
✦ **Database Update** — Replaces the data in each database record with values from the linked shape’s properties

**Adding Drawing Page Commands to Synchronize Shapes**

When you use the Database Wizard to links shapes and databases, you can add commands to synchronize links to shape or drawing shortcut menus. In addition, you can specify what happens when you drop a shape or copy and paste one on a page. If you use the Link to Database command to link your shapes, you can use the Database Wizard later to add synchronizing commands to the drawing page.

To add shortcut commands to a drawing page, follow these steps:

2. Click the Create a Linked Drawing or Modify an Existing One option and click Next.
3. Click the Add Database Actions and Events to a Drawing Page option and click Next.
4. Select the drawing file and page to which you want to add actions and events and then click Next. Check one or more of the following actions or events:
   - **Refresh shapes on page** — Adds a command to refresh all shapes on the page with the data from their linked database records
   - **Update shapes on page** — Adds a command to update the database records with values from the shapes on the page
   - **Refresh linked shapes on document open** — Each time you open the drawing file, Visio refreshes ShapeSheet cell values to match linked database records for all shapes in the drawing file.
   - **Periodically refresh based on NOW function** — Refreshes ShapeSheet cell values to match linked database records for all shapes in the drawing file at the interval specified by the NOW function. When you choose this option, Visio adds commands to the drawing page shortcut menu to start and stop the continuous refresh.
5. Click Next and then click Finish.
Adding Actions and Events to Shapes

When you use the Database Wizard to link shapes to databases, you can specify the commands you want to add to shape shortcut menus as well as what happens when you drop a shape on a page. If you want to add or modify those actions and events after you’ve linked your shapes, follow these steps:

1. After you’ve linked the shapes to a database, select the shapes to which you want to add actions and events.
2. Choose Tools ➪ Add-Ons ➪ Visio Extras ➪ Link to Database and click Advanced.
3. Select the actions and events you want and then click OK.

Tip

By default, Visio sets Refresh Shape as the default Shape Drop Event. When you select this option and drop or paste a shape on a drawing page, Visio refreshes the values based on the database record linked to the original shape. If you want to select a different database record when you copy a shape, select the Select Record option. When you drag a master onto the page or paste a copy, Visio prompts you to select a database record.

Synchronizing Shapes and Database Records Automatically

If you would prefer to have Visio automatically refresh your drawings, you can have Visio monitor the database linked to a drawing at a regular interval and refresh the shapes in the drawing with the values from the linked database records. To refresh shapes automatically, follow these steps:

2. Check the Automatically Refresh Drawing Page check box.
3. In the Refresh Drawing Interval (Secs.) box, type the number of seconds between every refresh and click OK.

If you want to keep your drawing and database up to date as you work, you can use Visio’s Drawing Monitor to watch for differences between the drawing and its linked database. Whenever the Drawing Monitor finds a discrepancy, it updates the database record with the values from the shape.
In order for the Drawing Monitor to function, you must set several options:

- **Launch Drawing Monitor** — When you use the Database Wizard to create a drawing based on a database table, the wizard displays one screen in which you can specify options to use for the monitored drawing. In this screen, be sure to check the following check boxes:
  - Launch the Drawing Monitor on Document Open
  - Add ‘launch monitor’ Right Mouse Action to the Page
  - Automatically Refresh Page Based on Global Setting

- **Automatically Refresh Drawing Page** — You must also choose Tools ➪ Add-Ons ➪ Visio Extras ➪ Database Settings and check the Automatically Refresh Drawing Page check box and specify the interval for monitoring the database.

With these settings selected, Visio launches the Drawing Monitor every time you open the file. If you close the Drawing Monitor and want to reopen it, you can right-click the drawing page and choose Launch Database Monitor from the shortcut menu. Visio monitors the drawing and the database at the interval you specify in the Database Settings dialog box. Changes you make to shapes are reflected in the database table.

**Summary**

You can link the shapes on Visio drawings with data in ODBC-compliant databases. Whether you want to maintain a Visio drawing based on the data in a database, export your Visio shape data to a database, or create two-way links between shapes and database records, Visio provides wizards and commands to simplify the task. You can set up connections that link shapes on drawings or masters to database records. When you link masters to databases, you can link masters to specific records or specify the record when you add the master to a drawing page. You can also generate drawings based on the records in a database table. After you link shapes to database records, you can update values by using shortcut menu commands or by specifying a refresh interval and letting Visio update your shapes or records automatically.
Using Visio for Office Productivity

In This Part

Chapter 11
Collaborating with Others

Chapter 12
Building Block Diagrams

Chapter 13
Constructing Charts and Graphs

Chapter 14
Working with Organization Charts

Chapter 15
Working with Flowcharts

Chapter 16
Documenting Business Practices

Chapter 17
Scheduling Projects with Visio

Chapter 18
Documenting Brainstorming Sessions
Collaborating with Others

It takes a team to brainstorm, generate, and develop new ideas and processes. Together, you can all show your brilliance. Sometimes, however, you’re toiling away as a team of one. Even so, you probably still need to share your Visio drawings with others, whether they are reviewers, customers, or other outside resources.

Either way, with Visio, you can use your e-mail program to distribute drawings to others, from simple attachments to a sequential routing system. You can share your drawings in a variety of situations, whether it’s with non-Visio users, collaborating with team members in a shared workspace, or working with colleagues across worldwide continents and languages.

You can also exchange and review one another’s Visio drawings, tracking markup to capture every important thought. Recognizing the importance of collaboration in its various forms, Visio 2003 includes many new features that facilitate collaboration with others.

In this chapter, you learn how to distribute Visio drawings through e-mail, share drawings using Visio Viewer, and collaborate using the new document workspaces. You’ll learn how to work with other languages in Visio. Finally, I’ll show you how to track changes in Visio and how to review and accept those changes into your drawings.
Distributing Drawings

When you send your Visio drawings via e-mail, you’re efficiently getting your Visio drawings into the hands of colleagues or your target audience. Using e-mail features, you can perform the following actions:

✦ Send drawings as attachments
✦ Route them sequentially to a series of reviewers
✦ Post drawings to a public Microsoft Exchange folder for all to see

Note

Visio can distribute drawings using any e-mail program that supports the MAPI (Messaging Application Programming Interface) protocol.

Sending Drawings Using E-Mail

You can attach a Visio drawing within your e-mail program. In a new message form, choose Insert File (or the equivalent commands), and then select the drawing file. You can also create an e-mail with the Visio drawing attached from within Visio. To do this, follow these steps:

1. In Visio, open the drawing you want to send.
2. Choose File Send To Mail Recipient (As Attachment). Your e-mail program launches, if necessary, and a new e-mail message form appears with the current drawing as an attachment.
3. As appropriate, enter the recipients for the drawing in the To and Cc boxes, revise the Subject if necessary, and then type your message in the message area.
4. When you’re finished, choose Send or the equivalent command.

Routing Drawings

You can send a Visio drawing to multiple recipients for their review or approval. You can route the drawing sequentially—one recipient after the other or all at once. After the recipients review or approve the drawing, the drawing routes back to the person who sent it out in the first place. To route a drawing to multiple recipients, follow these steps:

1. In the Visio drawing you want to route, choose File Send To Routing Recipient. The Routing Slip dialog box appears.
2. Under the To box, click Address. The address book for your e-mail program opens.
3. Select the e-mail addresses for the recipients of the routed drawing, and then click OK. The names are added to the To box.

4. Revise the Subject if necessary and then type your message in the Message Text box.

5. Under Route to Recipients, select One After Another to route the drawing sequentially, which is the default. To route the drawing to all recipients simultaneously, select All At Once.

Tip Routing a drawing sequentially can be advantageous when a drawing is being reviewed and comments added. Each subsequent recipient can see the comments of the previous reviewers and add to them.

6. Check the Return When Done check box to have the routing e-mail sent back to you after it has been routed to all recipients.

7. Check the Track Status check box to monitor who has the drawing at any given time. This is helpful if you’re using the One After Another routing method.

Tip If you are routing sequentially, consider arranging the order of recipients in the To box. Select a name and click the Move Up or Move Down buttons to change the sequence.

8. When you’re finished, click OK. An e-mail with the current drawing attached is sent to your routing recipients.

Distributing Drawings to Exchange Folders

Instead of sending a Visio drawing to a large number of recipients, you can simply post the drawing to a public Exchange folder. Then you can alert the recipients of the drawing’s presence there so they can review it. To add a drawing to a Microsoft Exchange folder, follow these steps:

1. Open the drawing you want to add to an Exchange folder.

2. Choose File ➪ Send To ➪ Exchange Folder. The Send to Exchange Folder dialog box appears.

3. Select the folder, expanding your folders as needed. You can also create a new folder for your drawing by clicking New Folder, typing a name, and then pressing Enter.

4. Click OK.

Cross-Reference Another method for distributing drawings to others is to publish them on an intranet or Internet Web site. For more information, see Chapter 9.
Sharing Drawings

With Visio 2003, you now have powerful new capabilities for sharing drawings. Users who don’t have Visio installed on their computers can download the Microsoft Office Visio Viewer 2003 to open and examine Visio documents. If your organization has set up Windows SharePoint Services as an intranet Web site, you and your team can employ Document Workspaces to share and collaborate interactively on drawings. Your drawings can more seamlessly cross language barriers through the implementation of new multiple language support.

Sharing Drawings with Colleagues Without Visio

If you’re working with non-Visio users, they can now view Visio drawings on a Web page or use the Microsoft Office Visio Viewer 2003 to open and view Visio files. The Visio Viewer is an ActiveX control that displays Visio drawings in a Microsoft Internet Explorer (version 5.0 or later) window. With the Visio Viewer, a user can perform the following actions:

✦ View one drawing page at a time
✦ Navigate to another page in the drawing
✦ Zoom in and out
✦ View another area of the drawing
✦ Follow hyperlinks attached to shapes
✦ View custom properties
✦ Print Visio drawings

The Visio Viewer does not show stencils, rulers, guides, or guide points. Styles might not appear the same as they do in Visio. In addition, the Visio Viewer does not support rotated pages, more than one hyperlink on a shape, drawing page hyperlinks, or drawing page properties.

For Visio 2003 drawings, non-Visio users can open drawings with the Visio Viewer 2003.

The Microsoft Visio Viewer is available for download at the Microsoft Download Center (www.microsoft.com/downloads). To locate the download, type Visio Viewer in the Search box on the Microsoft Download Center site and follow the instructions for downloading and installing the Viewer.

You can use Visio Viewer 2003 to open Visio drawings (.vsd files) saved in versions 5.0, 2000, 2002, or later, or Visio XML format files (.vdx files) saved in version 2002 or
later. Only the Visio Viewer 2003 can open drawings created in Visio Professional 2003. Choose one of the following methods to open a Visio file using the Visio Viewer:

- If you do not have Visio installed on your computer, double-click a Visio file in Windows Explorer.
- If you do have Visio installed on your computer, right-click a Visio file in Windows Explorer, choose Open With Internet Explorer. If Internet Explorer is not listed, choose Program, select Internet Explorer, and then click OK.
- In your Web browser, choose File Open and navigate to a Visio file.

If you have both Visio and the Visio Viewer installed—for instance, to see how your drawings appear in the Viewer or to test Visio Viewer capabilities—opening a file in your Web browser launches Visio, rather than the Visio Viewer.

- Drag a Visio file from Windows Explorer into your Web browser window.

If you have trouble opening a drawing in the Visio Viewer, download the latest version from the Microsoft Download Center.

**Working with Document Workspaces**

If your organization is implementing Windows SharePoint Services, you have access to the new Document Workspace feature in Visio 2003. The Document Workspace is a shared area revolving around one or more drawings and hosted by the Windows SharePoint Services Web server. Using this shared workspace in either a Web browser or the Shared Workspace task pane in Visio, colleagues can perform the following tasks:

- Share and work on drawings
- Exchange information
- Maintain lists and related links about the drawing
- Assign tasks regarding the drawing
- Update one another about drawing and task status

When you have the appropriate permission to create a Document Workspace, you can share your drawings and invite the members you want to participate in the Document Workspace. Members work on their versions of the drawing, and update them periodically to the Web server. The other members receive updates so that all Document Workspace members can see the changes that others have saved to the drawing so far.

You can use the new Document Workspace feature to collaborate on files created in various Office applications, including Word 2003, Excel 2003, and PowerPoint 2003.
Creating Document Workspaces

As long as you have the appropriate permissions, you can create a Document Workspace for your drawing as a subsite of the Windows SharePoint Services site. You become the administrator of any Document Workspace you create.

To create a Document Workspace for a Visio drawing using Microsoft Outlook 2003, follow these steps:

1. Choose File ➪ Send To ➪ Mail Recipient to create an e-mail with the current Visio drawing as an attachment.
2. Enter the e-mail addresses of all the individuals with whom you are collaborating on the drawing. These people become members of the Document Workspace.
3. Edit the subject and type a message as needed.
4. In the Attachment Options Task Pane, click Shared Attachments.

   Note
   If the Attachment Options Task Pane is not visible, click Attachment Options.

5. In the Create Document Workspace At box, enter the Web address of your Windows SharePoint Services Web site. As long as you have permission to create Document Workspaces for this Web site, the Document Workspace will be created as a subsite of the Windows SharePoint Services site, using the e-mail recipients as members.
6. Click Send.

To create a Document Workspace for a Visio drawing using the Shared Workspace Task Pane in Visio, follow these steps:

2. Enter a descriptive name for the drawing workspace in the Document Workspace Name box.
3. In the Location for a New Workspace box, enter the Web address for the Windows SharePoint Services site, as illustrated in Figure 11-1.

   Note
   If you don’t know the Web address, check with your system administrator.

4. Click Create.
5. Select the Members tab at the top of the Shared Workspace Task Pane and then click Add New Members.
6. Type the names of the members you want to add to your Document Workspace, separating them with semicolons. You might use e-mail addresses or Windows SharePoint Services user names, depending on how your system administrator has set up Windows SharePoint Services users.

**Figure 11-1:** Create a new Document Workspace using the Shared Workspace Task Pane.

To create a Document Workspace for a Visio drawing from within your Windows SharePoint Services Web site, follow these steps:

1. In your Web browser, go to the site of your Windows SharePoint Services.
2. In the navigation bar, choose Create. The Create page appears.
3. Under Web Pages, click Sites and Workspaces.
4. Type a title, description, and Web address, select a permission setting, and then click Create. The Template Selection page appears.
5. In the Template box, select Document Workspace and then click OK.

Whenever you create a Document Workspace for a drawing, that drawing is automatically added to the Windows SharePoint Services document library. Anytime a member of the Document Workspace opens a drawing stored in the document library, the Shared Workspace Task Pane opens as well.
Shared Workspace for Online Meetings

Another method for collaboration in Visio is online meetings. If your organization uses Windows SharePoint Services and MSN Messenger, you can have Visio create a shared workspace for online meetings. Choose Tools ➪ Online Collaboration ➪ Meet Now. The MSN Messenger Windows NetMeeting Messenger Service launches. You can call participants, allow other participants to edit the active drawing, display a chat window, and display a whiteboard.

Tip
If the drawing on which you want to collaborate is stored in your Windows SharePoint Services document library, you can create a Document Workspace from the document library. In your Web browser, go to the site of your Windows SharePoint Services and then open the document library. Point to the name of the drawing, click the Edit arrow, and then click Create Document Workspace.

Working with Drawings in a Document Workspace

When you receive a Visio drawing attached to an e-mail message that is part of a Document Workspace, follow these steps to open the drawing and begin your collaboration work with it:

1. In your e-mail program, double-click the Visio drawing attachment to open it. A message indicates that this drawing is stored in a Document Workspace.

2. To be notified whenever another member of this Document Workspace updates this drawing, click Get Updates. To check for and incorporate updates from other members manually, click Don’t Update. The drawing opens in Visio, and the Shared Workspace Task Pane appears, indicating that this drawing is part of a Document Workspace.

3. In the Shared Workspace Task Pane, click Get Updates to immediately update the content of your version of the drawing. As other team members update and save their version of the drawing, the Shared Workspace Task Pane indicates that updates are available. See the “Setting Document Workspace Update Options” sidebar to learn how to receive automatic updates.

Tip
If you’re working on a Document Workspace drawing but you don’t see the Shared Workspace Task Pane, choose Tools ➪ Share Workspace.

4. Make any changes you want to the drawing. If another member of the Document Workspace has specified a particular aspect of the drawing for you to work on, you might see a task assigned to you in the Shared Workspace Task Pane.

Tip
The Document Workspace administrator can establish that drawing changes should be made with Track Markup turned on. If that’s the case, then the changes made by each member of the workspace are shown in a different layer. If the workspace administrator has not turned on Track Markup but you want your changes to show as markup, choose Tools ➪ Track Markup.
5. Save the drawing periodically, as usual.

6. To share the changes you’ve made, first save the drawing. In the Shared Workspace Task Pane, select the Status tab and then click Update Workspace Copy. Your version of the drawing becomes the Document Workspace copy, and other team members can update their versions of the drawing with your changes.

Tip: You can also edit the shared drawing in the Windows SharePoint Services Web site for the Document Workspace if you are using Internet Explorer 6.0 or later. In the document library containing the drawing, point to the name of the document and then click the Edit arrow that appears.

Deleting Document Workspaces

When you and your team are finished collaborating on a drawing, you can delete the Document Workspace. When deleting a Document Workspace, keep the following principles in mind:

✦ Deleting a document workspace can only be done by the administrator of the Document Workspace—that is, the person who created it.
✦ It deletes all the data in the Document Workspace.
✦ It removes the associated document library, including all the documents stored there.
✦ It does not delete your own copy of documents stored on your computer.

To delete a shared workspace using the Shared Workspace Task Pane, select the title of the Document Workspace and then click Delete Workspace. To delete a shared workspace from the Windows SharePoint Services Web site, follow these steps:

1. Use your Web browser to go to the Windows SharePoint Services site and the Document Workspace.
2. In the navigation bar, choose Site Settings.
3. Under Administration, click Go to Site Administration.
4. Under Management and Statistics, click Delete This Site, and then click Delete.

You can disconnect a drawing from a Document Workspace and retain an independent copy of the drawing without affecting the other members of the Document Workspace. To do so, open the drawing, and in the Shared Workspace Task Pane, click Disconnect from Workspace. When you save and close the drawing, it is permanently disconnected from its Document Workspace.
Setting Document Workspace Update Options

You can specify that you want to receive automatic updates when you first open the shared drawing or when you click Get Updates in the Shared Workspace Task Pane. If you do not want to be notified of updated information, click Don’t Get Updates when you first open the shared drawing or in the Shared Workspace Task Pane. You can still update your copy manually whenever you want by clicking Get Updates.

You can also use your e-mail program to receive notification when an update has been made to a drawing in a Document Workspace of which you’re a member. In the Shared Workspace Task Pane, click E-Mail Alerts.

Managing Shared Workspace Tasks

Members of a Document Workspace can create and assign tasks associated with the shared drawing to other members. You can assign to-do items with due dates to members of the shared workspace. To assign a task to another member, follow these steps:

1. With the shared drawing open, select the Tasks tab in the Shared Workspace Task Pane and then click Add New Task.

2. Complete the fields in the Task dialog box. This includes the task title, current task status, priority, the Document Workspace member to whom you want to assign the task, any description, and the due date and time.

3. Click OK. The task is added to the Shared Workspace task pane. All members of the Shared Workspace see the task assignment and associated information.

If another member has assigned a task to you, after completing it you can check it off in the Tasks list. When other team members open the Tasks list in the Shared Workspace Task Pane, they can see that you have completed the task. To check off a completed task that has been assigned to you, follow these steps:

1. With the shared drawing open, select the Tasks tab in the Shared Workspace Task Pane. The list of all tasks assigned to all Document Workspace members appears.

2. Select the task assigned to you.

3. In the Task dialog box, change the status to indicate that it’s complete. Enter any information in the Description box.

4. Click OK. The check box is checked, indicating that your task is complete.
Working with Multiple Languages

You might share your Visio drawings with colleagues or customers in other countries, such as Hungary, Greece, or Japan. Therefore, you might need to include elements of other languages and other language formats in a single drawing. You can also share and collaborate on drawings across multiple languages.

Visio 2003 includes new support for Unicode, End User Defined Character (EUDC) sets, and GB18030. See the following sidebar, “Multilanguage Support,” for details.

With the new multilanguage support, you can do all of the following:

✦ Flexibly format date, time, and number styles according to a specific region and language
✦ Type characters for Asian languages using an Input Method Editor (IME)
✦ Link fonts automatically to find needed characters in other languages. If a selected font does not include all the required characters, Visio automatically links to a second font to find the needed characters. This is particularly useful in multilingual drawings that include East Asian and right-to-left text.
✦ Create multilingual Web pages and intranet content in Visio

To work with additional languages in Visio, you might need to adjust settings in the Windows Control Panel, in Microsoft Office, and in Visio itself. Certain languages require additional resources installed to provide support.

Multilanguage Support

The new Visio 2003 multilanguage support includes the following:

✦ **Unicode** — A character encoding standard that enables almost all the written languages in the world to be represented by using a single character set. It uses more than a single byte to represent each character. Unicode makes it possible for multiple languages to appear in a single Visio drawing.

✦ **End User Defined Character (EUDC)** — A character set with which you can form Asian names and other Asian words using characters that are not available in standard screen and printer fonts.

✦ **GB18030** — A new Chinese character-encoding standard. You can use GB18030 to create Visio drawings containing Chinese characters from this character set.
Configuring Windows for Multiple Languages

Windows installs many files needed for multilanguage support. However, if the language you’re using requires additional Windows support, you can adjust the appropriate settings in the Windows Control Panel. To do this, follow these steps:

1. In Windows XP or Windows 2000, click Start and choose Control Panel, and then double-click Regional and Language Options.
2. Select the Languages tab.
3. Under Supplemental Language Support, check the check boxes for the additional language support you want—for example, complex script, right-to-left languages, or East Asian languages.
4. Follow the steps in the windows that appear to install the files needed.

For certain characters in certain languages, you might also need to install a particular keyboard layout. In Control Panel, double-click Text Services or Keyboard.

On the Regional Options tab within the Regional and Language Options dialog box, you can also change date, time, and number formats for other languages. In the language drop-down list, select the language whose number, currency, time, and date formats you want to change. The regional formats under Samples will all change to reflect the norm for the selected language. Click OK.

Configuring Office for Multiple Languages

To work with different languages in Visio, enable the appropriate languages to make additional language-specific options available. To do this, follow these steps:

1. In Windows XP, click Start and choose All Programs ➪ Microsoft Office Tools ➪ Microsoft Office 2003 Language Settings.
2. Select the Enabled Languages tab.
3. Under Available Languages, select the language you want to add and then click Add. The language appears in the Enabled Languages box.
4. When you’re finished adding languages, click OK.

If your organization has purchased the Microsoft Office Visio 2003 Multilingual User Interface Pack, you can also change the language of the user interface and Help.

Installing IME for Asian Characters

To enter ideographic characters for Asian languages, you must use an Input Method Editor (IME). This feature is available only if support for Japanese, Simplified Chinese, Traditional Chinese, or Korean is enabled through Microsoft Office Language Settings as described above.
To install the IME, follow these steps:

2. Navigate to the page containing IME Editor downloads.
3. Click the language you want and then follow the instructions that appear.

After you have installed the IME for the language you’re working with, you can access it from the Language bar that appears by default in the upper-right corner of the Visio screen.

**Tip**

You can make other adjustments for language settings from within Visio. Choose Tools ➤ Options and then select the Regional tab. You can also switch between metric and U.S. units in Visio. To do so, choose Tools ➤ Options, and then select the Units tab.

**Tracking and Reviewing Changes**

One of the most powerful means of collaborating on documents is the capability to track changes using some type of markup. With Visio 2003, you can now track and review changes using separate colored overlays for each reviewer. When track markup mode is turned on, reviewers can add text comments, shapes, or use Ink to create freehand markups on a drawing. After the reviewers have finished their work, the originator can review all the comments and other markup, and incorporate the changes as appropriate.

**New Feature**

The Reviewing Task Pane and Reviewing toolbar, with their markup features in separate colored overlays, are all new in Visio 2003.

**Turning Markup On or Off**

When track markup mode is on, reviewers can add their comments and other markup. Each reviewer’s markup is kept separate from the original and all other reviewers’ markups. To turn on track markup mode, follow these steps:

1. Open the drawing for which you want to turn on track markup mode.
2. Choose Tools ➤ Track Markup. A colored band appears around the drawing workspace, the Reviewing Task Pane appears, and the Reviewing toolbar appears, as illustrated in Figure 11-2.

**Caution**

You can edit your markup overlay only when track markup mode is turned on. To edit the original drawing, you must turn track markup mode off.
Reviewing taskbar
Colored band
Reviewing Task Pane

Figure 11-2: Visual cues, including the Reviewing Task Pane, indicate that track markup mode is on.

To turn track markup mode off, click Track Markup at the bottom of the Reviewing Task Pane. You can also choose Tools ➪ Track Markup, which acts as an on/off toggle. When markups exist and track markup mode is turned off, tabs appear on the right side of the drawing window, showing the original drawing, and the overlays of each reviewer’s comments, each one in a different color.

Caution
To print a drawing without your markup and comments showing, be sure to turn off track markup mode.

Marking Up Drawings
When you’re marking up a Visio drawing with track markup mode turned on, Visio assigns you an overlay in a particular color. You can add your markup to your overlay without affecting the original drawing or other reviewers’ markup. You can create three types of markup: comments, shapes, and Ink.
Markup appears only in the reviewer’s assigned color. Although the reviewer can apply colors to shapes and Ink, the colors are not visible until the shape is copied or moved onto the original drawing.

In Visio 2003, you can use the new Ink features to mark up a drawing, creating free-form shapes and handwriting with a tablet computer stylus or a regular computer mouse. Visio automatically converts the handdrawing into shapes that can be added to a custom stencil.

**Inserting Comments**

To add a text comment as drawing markup, follow these steps:

1. Make sure that track markup mode is on for the drawing.
2. If your comment is associated with a particular page in a multipage drawing, click the page.
3. In the Reviewing Task Pane, click Insert Comment. A comment bubble appears in the drawing.
4. Type your comment. When finished, click off the comment. The bubble disappears, but the comment marker with your initials remains, associated with the current page. A list of your comments builds in the Reviewing Task Pane.

**Inserting Shapes**

To add a shape to a drawing, simply drag it from the stencil into place. The shape appears in the color of your markup, and “Shape added” appears with your initials in the Reviewing Task Pane.

Although you can review other reviewers’ markup, you can change or remove only your own. To remove a markup, select it in the drawing or in the Reviewing Task Pane and then press Delete.

**Adding Freehand Markup Using Ink**

_Ink_ is the name of the freehand method of annotating a drawing in track markup mode. With Ink, you can draw shapes and add handwritten notes. You can work with these shapes like any other shape. You can even add them to custom stencils if they’re shapes you want to reuse. While Ink facilitates tablet computer input with a stylus, you can use your mouse on a desktop or notebook computer to draw freehand markup. To use Ink to mark up a drawing, follow these steps:

1. Make sure that track markup mode is on for the drawing.
2. If you’re adding Ink on a particular page in a multipage drawing, click the page.
3. On the Reviewing toolbar, choose the Ink tool. The Ink toolbar appears, showing different Ink colors, an Eraser tool, a Color tool, and a Line-width tool, as shown in Figure 11-3.
The Reviewing toolbar appears as soon as a drawing enters track markup mode. If the Reviewing toolbar is not showing, choose View ➪ Toolbars ➪ Reviewing.

**Figure 11-3:** Use Ink to add freehand shapes and handwritten comments to a Visio drawing.

4. Choose the tools on the Ink toolbar to set up the markup you’re adding.

5. Use your computer’s pointing device (such as the mouse or stylus) to draw the markup shape or use handwriting to mark up the drawing. After you finish a shape, it is converted to a shape that can be manipulated as a unit like any other Visio shape. The message “Ink added” appears with your initials in the Reviewing Task Pane.

6. When you’re finished using Ink, choose the Pointer tool on the Standard toolbar.

**Tip**

You can set the speed of your Ink entry conversion to a shape. Choose Tools ➪ Options and then select the Advanced tab. Under Ink Tool, drag the slider in the direction you want to indicate how fast or slow you want an Ink entry to be transformed into a Visio shape.
Reviewing Markup

By default, all markup in a drawing is displayed. Each reviewer’s markup appears in a different color, and each reviewer’s overlay can be seen by selecting the tab containing the reviewer’s initials on the right edge of the drawing. To see the original drawing containing all reviewers’ markups, select the Original tab.

To hide all markup, click Hide All in the Reviewing Task Pane. To show all markup again, click Show All.

To hide just the markup of selected reviewers, uncheck the check boxes for those reviewers under Show Markup Overlays in the Reviewing Task Pane. To specify which reviewers’ markup should show, check the check boxes for those reviewers.

Updating Drawings with Markup Changes

To incorporate markups into the original drawings, you first must turn off track markup mode. Then you can review markups and copy elements into the original drawing. To do this, follow these steps:

1. In the Reviewing Task Pane, click Track Markup to turn track markup mode off.
2. Select the tab for the reviewer whose markup you want to incorporate into the original drawing.
3. Select the shape(s), and then click the Copy tool on the Standard toolbar.
4. Select the Original tab at the lower-right edge of the drawing.
5. Click the Paste tool on the Standard toolbar. The copied shapes appear at the center of the drawing.
6. Drag the shape(s) to move them into place, using the markup overlay as a guide.

To move from one markup to the next, choose the Next Markup tool in the Reviewing Task Pane or the Reviewing toolbar. To delete a markup, select it, and then choose the Delete Markup tool in the Reviewing Task Pane or the Reviewing toolbar.

Summary

With Visio 2003, you can work as closely as you need to with colleagues, whether they’re right next door or on the other side of the globe. Using e-mail, a Windows SharePoint Services site on your intranet, or sophisticated layers of markup, you can discuss, experiment, and hammer out the most innovative ideas and processes. You can then effectively capture those ideas and processes in your Visio drawings.
Building Block Diagrams

Visio Block Diagrams are versatile and yet quite easy to use, so you can employ them to communicate an astounding variety of ideas. They can illustrate the structure and relationships between ideas, concepts, designs, or real-world objects, or show the flow within processes.

You can create simple diagrams using basic shapes or spruce up a diagram for a presentation with 3D shapes that show perspective. In addition, Visio’s Blocks stencil includes shapes to develop more specialized arrangements, such as hierarchical trees or onion diagrams. In this chapter, you’ll learn how to create different types of Visio Block Diagrams and configure your Block Diagram shapes.

Exploring the Block Diagram Templates

The Visio Block Diagram templates are some of the most popular templates because workers from any field can use the Visio techniques they already know, such as dragging, dropping, editing, and formatting, to communicate their ideas to their colleagues. Many of the Block Diagram shapes and connectors include powerful but simple to use features that speed up common diagramming tasks. For example, you can connect branches on one of Visio’s Tree shapes to boxes on a drawing to construct a hierarchical tree.

Block Diagram shapes are so simple that the Block Diagram templates don’t contain any specialized menus, toolbars, or add-ons. You can build diagrams that satisfy many different requirements by dragging and dropping shapes from Visio’s Block Diagram stencils. You can modify and tweak Block Diagram shapes by dragging selection handles or control handles. Annotation is as easy as selecting a shape and typing.
Choosing the Right Template

The descriptions that accompany the three Block Diagram templates in Visio sound quite similar—you can document structure, hierarchy, and flow using a combination of 2D or 3D shapes. However, the many solutions that you can create with Block Diagrams boil down to three fundamental formats: blocks, trees, and onions, as illustrated in Figure 12-1. Block diagrams communicate relationships between concepts or steps in a process and use geometric shapes such as rectangles and circles connected with arrows. For example, you can show the processes in the life-cycle of a project. Tree diagrams present hierarchical information, such as the descendants and ancestors in a family tree or the progress of teams in tournament play-offs. Onion diagrams illustrate relationships that build from a core. For example, an onion diagram is the best way to show the layers that make up the earth from its core to the crust.

Figure 12-1: Block diagrams can show flow, hierarchical structure, or concentric layers.
The three types of block diagrams don’t correspond directly to the three templates that Visio provides. Use Table 12-1 to choose the template that contains the shapes you need for the diagram you want to create. Each Block Diagram template automatically sets the page to a letter-size sheet with portrait orientation, and uses inches drawn at one-to-one scale.

<table>
<thead>
<tr>
<th>Diagram Type</th>
<th>Template</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Blocks</td>
<td>Basic Diagram</td>
<td>Opens the Basic Shapes, Borders and Titles, and Backgrounds stencils.</td>
</tr>
<tr>
<td>Blocks with Style</td>
<td>Block Diagram</td>
<td>Opens the Blocks, Raised Blocks, Borders and Titles, and Backgrounds stencils.</td>
</tr>
<tr>
<td>Tree</td>
<td>Block Diagram</td>
<td>Opens the Blocks, Raised Blocks, Borders and Titles, and Backgrounds stencils. Tree shapes show hierarchy.</td>
</tr>
<tr>
<td>Onion</td>
<td>Block Diagram</td>
<td>Opens the Blocks, Raised Blocks, Borders and Titles, and Backgrounds stencils. Concentric and Partial Layer shapes build onion diagrams.</td>
</tr>
<tr>
<td>High-Impact Blocks</td>
<td>Block Diagram with Perspective</td>
<td>Opens the Blocks with Perspective, Borders and Titles, and Backgrounds stencils. 3D and Vanishing Point shapes show perspective.</td>
</tr>
</tbody>
</table>

**Exploring Block Diagram Shapes**

Every Block Diagram template sets up the same basic environment, so you can use Block Diagram templates almost interchangeably. However, each Block Diagram stencil offers some specialized shapes that help create specific types of diagrams. By understanding the shapes available on each stencil, you can open the stencils as you need them, regardless of the Block Diagram template you start with.

**Basic Shapes**

The Basic Shapes stencil is a workhorse for simple block diagrams. It offers basic geometric shapes, arrow-like shapes that can act as connectors, as well as the standard Dynamic connector and Line-curve connector.
Part III ✦ Using Visio for Office Productivity

✦ **Geometric Shapes** — Drag and drop geometric shapes such as Rectangles, Circles, Stars, Rounded rectangles, Shadowed or 3D boxes, and shapes for polygons from Triangles to Octagons.

✦ **Arrows** — Drag and drop Arrow shapes onto a drawing to connect the geometric shapes. Choose from arrows with different arrowheads and tails.

✦ **Flexi-Arrows** — You can drag control points on the Flexi-arrow shapes to customize the angles and length of arrowheads and tails.

**Blocks**

The Blocks stencil is the most versatile, with shapes for block, tree, and onion diagrams. It contains connectors with dozens of different end styles as well as Tree shapes for building hierarchies. You can choose from a variety of shapes, with behaviors that help show relationships and flow.

✦ **Geometric Shapes** — Drag and drop Box, Diamond, and Circle shapes.

✦ **Auto-sizing Boxes** — The Auto-height Box increases or decreases its height to accommodate the text you enter. The Auto-size Box increases its height and width.

✦ **Open/Close Shapes** — The Open/close Bar and the Open/close Arrow shapes can display borders to represent a boundary, or hide borders so shapes appear to flow together.

✦ **Arrow Box** — This shape combines a box and an arrow to show both a process and the flow to the next step.

✦ **Arrows** — Drag the control points on the Curved Arrow shape to change the direction of the arrowhead and the curvature of the bend.

✦ **Onion Shapes** — Concentric Layer and Partial Layer shapes drop on top of each other to show relationships around a central core.

✦ **Tree Shapes** — Tree shapes show hierarchies with two to six branches.

✦ **Connectors** — In addition to the Dynamic connector and the Line-curve connector, the Blocks stencil includes several connectors with specialized styles, such as dots and arrows, at the end or midpoint.

**Blocks Raised**

The Blocks Raised stencil contains geometric shapes and arrows that appear three-dimensional. However, the height and orientation of the third dimension are fixed. Although these shapes appear to be three-dimensional, they do not change as you move a vanishing point, which is a Block Diagram feature with which you can add perspective to a drawing.
**Blocks with Perspective**

The Blocks with Perspective stencil contains geometric shapes and arrows that change their perspective in relation to a vanishing point. You can adjust the depth and angle of perspective by moving the Vanishing Point shape on the drawing.

- **Geometric Shapes** — Drag Block, Circle, Arrow, and Elbow shapes that adjust to the position of a Vanishing Point shape.
- **Holes** — Drag a Hole shape onto another shape to create the appearance of a hole.
- **Wireframe Blocks** — These shapes are three-dimensional boxes in which the edges are visible and the sides are transparent.
- **Vanishing Point** — Drag a second Vanishing Point shape onto a drawing to add more impact to diagrams.

**Showing Structure and Flow**

Block diagrams work equally well to represent static structural relationships or the flow between processes or steps. In a structural diagram, boxes and other geometric shapes represent components, and arrows or connectors indicate order or hierarchy. For processes and procedures, geometric shapes signify each process or step, while arrows show the dependencies and sequence between them. No matter which type of relationship you’re trying to communicate, you can use the same basic steps to create your diagram.

**Creating Block Diagrams**

You can use basic Visio techniques to create your Visio Block Diagrams. You begin by dragging shapes onto a drawing and typing the text you want to appear in each shape. You can connect shapes as you go or attach arrows and connectors after the shapes are in place. If necessary, you can rearrange the shapes and format them. To create a block diagram, follow these steps:

1. Choose File ➪ New ➪ Block Diagram ➪ Block Diagram.

   To access other Block Diagram shapes, click the Shapes icon on the Standard toolbar and choose Block Diagram ➪ Basic Shapes.

2. Drag shapes onto the drawing from the Basic Shapes, Blocks, or Blocks Raised stencils.

3. Select a shape and type any text you want to appear in the shape.
4. Connect shapes by dragging an Arrow shape from one of the stencils and gluing it to a shape on the drawing. A red square highlights a shape connection point when the Arrow shape connects to another shape. After one end of the Arrow is connected to a shape, drag the end point at the other end and glue it to another shape.

**Tip**
To connect shapes automatically, click the Connector tool before you drag shapes onto a drawing. Each shape automatically connects to the previous shape.

### Modifying Block Diagrams

Block Diagrams don’t include any specialized formatting or layout tools. You can use basic techniques to rearrange the shapes on a drawing or apply predefined backgrounds and color schemes to enhance its appearance. To adjust the overall appearance of a diagram, use any of the following techniques:

- **Rearrange Shapes** — Rearrange shapes in a diagram by dragging them to new locations.

- **Adjust Shape Location** — To make minor adjustments to the position of a shape, select it and then press one of the arrow keys to nudge it in that direction.

**Cross-Reference**
To learn about other ways to modify the location of a shape, see Chapter 4.

- **Apply Color Schemes** — To use a specific color scheme, right-click an empty area of the drawing page and choose Color Schemes from the shortcut menu. Select a color scheme and click OK.

### Modifying Block Diagram Shapes

Some Block Diagram shapes exhibit special behaviors. However, you still use basic Visio techniques to modify all the shapes available in the Block Diagram stencils. Use any of the following techniques to modify shapes on a Block Diagram:

- **Add Text** — To add or modify text for an existing shape, select the shape and begin typing. You can also double-click a shape to edit its existing text.

  **Note**
  When you type text in a shape, Visio zooms in to make the text more legible.

- **Modify Relationships** — Select a connector or Arrow shape. Drag one of its end points and glue it to another shape or another connection point on the same shape.
✦ **Resize Shapes** — Select a shape and drag one of its square, green selection handles to resize it. Drag a corner to modify height and width proportionately. Drag a mid-point selection handle to change just one dimension.

✦ **Reshape Shapes** — Activate the Line, Arc, Pencil, or Freeform tool on the Drawing toolbar and select a shape. Drag a vertex (a green diamond) to reshape.

✦ **Bend Shape Segments** — Activate the Line, Arc, Pencil, or Freeform tool on the Drawing toolbar and select a shape. Drag an eccentricity handle (a green circle) to bend one segment of the shape.

✦ **Reorder Overlapping Shapes** — To change a shape’s position in the stacking order, right-click it and choose Shape ➪ Bring to Front of Shape ➪ Send to Back.

✦ **Format Shapes** — To apply formatting to a shape, right-click it, choose Format from the shortcut menu, and then choose one of the Format commands.

✦ **Specify Shadow Colors** — To set the shadow colors for Raised Blocks and Blocks with Perspective, right-click a shape and choose one of the shadow color options from the shortcut menu. You can choose from three options:

  - **Automatic Shadow** — Sets the shadow color based on the shape’s fill color. This is the default setting.

  - **Manual Shadow** — Displays the shadow color you specified for the shape. To specify shadow color, select a shape, choose Format ➪ Fill or Format ➪ Shadow, and select the color you want from the Color drop-down list.

  - **Color Scheme Shadow** — This option sets the shadow color based on the color scheme you apply.

**Using Special Editing Techniques for Boxes**

You can use special behaviors, control handles, and shortcut menu options that come with some of the Block Diagram Boxes to modify their appearance. If you use these shapes, take advantage of the following editing shortcuts:

✦ **3-D Box** — Drag the control point on a 3D Box to modify the amount and orientation of the box depth.

✦ **Auto-height Box** — Type text in an Auto-height Box, and the height of the box changes automatically to accommodate the text you enter. To adjust the width of the box, drag one of the side selection handles.

✦ **Auto-size Box** — Type text in an Auto-size Box, and the height and width of the box changes to fit your text. Press Enter to start a new line. The box width is set by the longest line of text.
Modifying Block Diagram Arrows
You can use special behaviors, control handles, and shortcut menu options that come with some of the Block Diagram Arrows to modify their appearance. If you use these shapes, take advantage of the following editing shortcuts:

✦ **Arrow Box** — Drag the control point on the arrowhead to adjust its width. Drag the control point at the intersection of the arrow and the box to change the height of the box and the length of the arrow.

✦ **Flexi-arrows** — Drag the control points on the arrowhead to change the width and shape of the arrowhead and the width of the arrow tail, as shown in Figure 12-2.

![Figure 12-2: You can reshape the arrowhead and arrow tail of the Flexi-arrow shapes.](image)

✦ **Curved Arrow** — Drag the control point on the arrowhead to reposition the arrowhead. Drag the control point at the curve to change the curvature.

Emphasizing Flow Between Shapes
Flow is easier to see on a diagram when there are no boundaries between shapes. Several Block Diagram shapes hide or show boundaries to emphasize flow. In the Blocks stencil, these shapes include the 1-D Single Arrow, 2-D Single Arrow, and Open/closed Bar shapes. In the Blocks Raised stencil, you can open and close Right
Arrows, Up Arrows, Left Arrows, and Down Arrows, Horizontal Bars, Vertical Bars, and Elbow shapes. To open and close these shapes, follow these steps:

1. Drag a shape from a stencil and drop it onto the drawing.
2. To open the end of an arrow, right-click the shape and choose Open Tail from the shortcut menu.
3. Drag the open end of the arrow to the flat side of a box or other block shape.
4. To close the end of an arrow, right-click the shape and choose Close Tail from the shortcut menu.
5. To open or close Bar shapes from the Blocks or Blocks Raised stencil, right-click the bar and choose one of the following commands:
   - Open Left End Only
   - Open Right End Only
   - Open Both Ends
   - Close Both Ends

**Note**

For vertical bars, the commands on the shortcut menu change to Open Top End Only and Open Bottom End Only.

### Creating Hierarchical Trees

You can use tree diagrams to show hierarchies such as play-off standings or genealogy. As with other Block Diagrams, you can drag, arrange, and format shapes using basic Visio tools. Tree connectors include control points to help build your hierarchy. To build a hierarchical tree, follow these steps:

1. Choose File ➔ New ➔ Block Diagram ➔ Block Diagram.
2. Drag boxes from the Blocks stencil.
3. Drag one of the four Tree shapes from the Blocks stencil onto the drawing.

**Note**

You can choose from Trees with square or sloped branches. The Double-tree Sloped and Double-tree Square shapes provide only two branches. With the Multi-tree Sloped and Multi-tree Square shapes, you can draw from two to six branches.

4. For vertical Tree shapes, drag one of the green selection handles to rotate the shape.

**Tip**

Press Ctrl+L to rotate a Tree by 90 degrees. With horizontal Trees, you can also press Ctrl+H to flip the Tree from right to left.
5. To connect a branch to a shape, drag the control handle at the end of a branch to a connection point on the shape. A red square highlights the connection point when the branch and the shape are connected.

6. To add text to the trunk of a tree, select the Tree and type the text you want.

**Note**

You can add text to trunks only, not the branches of a tree.

**Modifying Tree Shapes**

You can use basic Visio techniques to modify and format the blocks and text in tree diagrams. You can use control points and built-in behaviors to modify tree trunks and branches. Use the following methods to modify trees:

- **Add a Branch** — Drag the control handle on the trunk of a Multi-tree shape to a position. The distance perpendicular to the trunk controls the width of the branch, whereas the distance parallel to the trunk determines the length of the branch, as illustrated in Figure 12-3.

  ![Drag to control the branch width and length.](image)

  **Figure 12-3:** Drag a Multi-Tree control handle to add a branch to the tree.

- **Remove a Branch** — Drag the control handle at the end of the branch on top of any other control handle on the tree.

- **Adjust Branch Position** — Drag the control handle at the end of a branch to a new position.
✦ **Modify Distance Between Branches**—Move the boxes attached to the branches to new positions. You can move these boxes by dragging them or applying the Align Shapes or Distribute Shapes commands on the Shape menu.

✦ **Move a Tree Trunk**—Select the Tree and press an arrow key to move the trunk in that direction.

When you move the shape connected to a tree trunk, the tree trunk rotates. One end of the trunk moves with the shape while the other end of the trunk stays fixed. To keep the trunk and branches of a tree orthogonal, select the tree and all the shapes connected to it and drag them all to a new position.

## Adding Impact with 3D Block Diagrams

3D block diagrams are visually appealing, so they’re perfect for presentations. Although they look like they require hours of effort, they’re just as easy to construct as regular block diagrams. When you create a block diagram using the Block Diagrams with Perspective template, the drawing includes a vanishing point that defines the perspective for the three-dimensional shapes. You can adjust the depth and orientation of the shape shadows by moving the Vanishing Point shape on the drawing.

To learn how to change the color of the shadows for 3D shapes, see the “Modifying Block Diagram Shapes” section earlier in this chapter.

Note

Only shapes from the Blocks with Perspective stencil adjust to the position of the Vanishing Point shape. Shapes from the Blocks Raised stencil might look three-dimensional, but their depth and orientation remain fixed.

To create a 3D block diagram, choose File ➤ New ➤ Block Diagram ➤ Block Diagram with Perspective to open a drawing that contains a Vanishing Point shape. Drag 3D shapes from the Blocks with Perspective stencil onto the drawing. You can drag, arrange, align, and format 3D block shapes with basic Visio tools.

The depth and orientation of a 3D shape changes as you move the Vanishing Point on a drawing. To add impact or emphasize specific parts of a diagram, you can change the perspective on the diagram, change the depth of a 3D shape, or disconnect a 3D shape from the Vanishing Point.

Note

If a shape on the drawing doesn’t adjust its perspective as you move the Vanishing Point, it might not be a shape with perspective, such as a Box on the Blocks Raised stencil. It also might be disconnected from the Vanishing Point.
Modifying Perspective

Use the following methods to modify the perspective of a 3D block diagram:

✦ **Change the Diagram Perspective** — Make sure no shapes are selected and then drag the Vanishing Point to another location.

✦ **Change a Shape’s Perspective** — To change the perspective for one shape, select the shape and then drag the red control handle on the Vanishing Point to another location. The Vanishing Point’s control handle that you move turns yellow, indicating that it and the selected shape are no longer connected to the Vanishing Point. However, when you select the Vanishing Point again, a red control handle still appears for the rest of the shapes connected to the Vanishing Point.

✦ **Connect a Shape to the Vanishing Point** — Select the shape. Drag the yellow control handle that appears on the drawing page and glue it to the connection point on the Vanishing Point shape.

✦ **Change a Shape’s Depth** — Right-click a shape and choose Set Depth from the shortcut menu. Select a smaller percentage for a shallower shape, a larger percentage for a deeper shape.

Tip
You can hide the Vanishing Point shape — for instance, to print the diagram or use it in a presentation. To hide the Vanishing Point for printing, click View ➪ Layer Properties and uncheck the check mark in the Print column of the Vanishing Point row. To hide the Vanishing Point on the drawing, uncheck the check mark in the Visible column of the Vanishing Point row.

Using Multiple Vanishing Points

You can create even more dramatic diagrams by adding additional Vanishing Point shapes to a diagram and associating shapes to those Vanishing Points. Visio doesn’t support true two-point perspective. Although each shape connects to only one Vanishing Point, adding a second Vanishing Point can spice up your presentation graphics. To work with an additional Vanishing Point, follow these steps:

1. Drag a Vanishing Point from the Block with Perspective stencil onto the drawing.

2. To associate a shape to the new Vanishing Point, first select the shape. If the shape is associated with another Vanishing Point, drag the red control handle that appears in the first Vanishing Point and glue it to the connection point on the new Vanishing Point. A red square highlights the Vanishing Point, indicating that the shapes are connected. If the shape is not associated with a Vanishing Point shape, drag the yellow control handle that appears on the
drawing page when you select the shape, and glue it to the connection point on the new Vanishing Point.

When you add new shapes, they associate automatically with the first Vanishing Point, which Visio adds by default to each block diagram that you create with the Block Diagram with Perspective template. You must change the connection for each shape you want connected to the other Vanishing Point.

### Working with Onion Diagrams

Onion diagrams use concentric rings to illustrate concepts or elements that build up from a core, such as the layers that make up our planet. Although the objects represented on an onion diagram grow from the center, you construct an onion diagram from the outside in.

### Creating Onion Diagrams

The Blocks stencil contains Concentric Layer and Partial Layer shapes that you can use out of the box for up to four layers of an onion. If you require more than four layers, you can resize the largest layer and add additional rings. To create an onion diagram, follow these steps:

1. Choose File ➪ New ➪ Block Diagram ➪ Block Diagram.
2. To establish the outer layer of the onion, drag the Concentric Layer 1 shape onto the drawing page.
3. To add the next layer of the onion, drag the Concentric Layer 2 shape onto the drawing and drop it onto the center of the first concentric shape.
4. To add the third layer of the onion, drag the Concentric Layer 3 shape onto the drawing and drop it onto the center of the other concentric shapes.
5. To add the core of the onion, drag the Concentric Center shape onto the drawing and drop it onto the center of the other concentric shapes.
6. To add text to a ring, select the shape and type the text you want.

### Modifying Onion Diagram Shapes

Whether you need additional layers or want to change a layer’s size or thickness, you’ll probably modify the standard concentric rings after you add them to your drawing.
Adjusting Layer Dimensions
You can resize Concentric Layer shapes or change their radius and thickness. You must realign the shapes after you make these adjustments. Use one of the following methods to adjust Concentric Layer shapes:

✦ To resize a Concentric Layer shape, drag one of the selection handles to change the radius of the circle. The opposite selection handle remains fixed on the drawing, as demonstrated in Figure 12-4.

✦ To change the thickness of a ring, drag the yellow control handle on the inside edge of the shape.

Figure 12-4: You can change the radius, thickness, and text position of a Concentric Layer shape.

✦ To change the thickness of a ring, drag the yellow control handle on the inside edge of the shape.
To realign concentric rings after you modify their size or thickness, select all the Concentric Layer shapes and choose Shape ➪ Align Shapes. Select the centered vertical alignment option, select the centered horizontal alignment option, and then click OK.

To fit a smaller ring inside a larger ring, drag the selection handle on the left outside edge of the smaller ring and snap it to the connection point on the left inside edge of the larger ring. Then, drag the selection handle on the right outside edge of the smaller ring and snap it to the connection point on the right inside edge of the larger ring.

**Dividing a Concentric Layer into Sections**

You can divide a Concentric Layer shape into sections to show several components. The Partial Layer shapes on the Blocks stencil fit the Concentric Layer shapes. When you drop a Partial Layer shape onto a Concentric Layer shape, they connect and act as one, so you can drag a Concentric Layer shape’s selection handles to resize it and its associated Partial Layer shapes. To divide a Concentric Layer into sections, follow these steps:

1. Drag a Partial Layer shape that matches the size of the Concentric Layer onto the drawing.
2. To rotate a Partial Layer, select it after dropping it onto the page and then press Ctrl-L as many times as necessary to rotate the shape into the correct quadrant.
3. If necessary, use the editing techniques described in the previous section to adjust the radius or thickness of the partial layer.
4. Drag the Partial Layer over the Concentric Layer you want to divide. When the Partial Layer snaps to the Concentric Layer, the red squares highlight the outside connection point and the center of the Concentric Layer shape to indicate that the shapes are glued, as shown in Figure 12-5.

**Working with Text in Onion Diagrams**

Text can be difficult to work with in onion diagrams because the shapes are curved and the text is straight. You have a few options when a long text string doesn’t fit within a concentric ring. For text that almost fits, you can apply a smaller font or try a narrower font such as Arial Narrow. For long text, you can position the text outside the shape by dragging the control handle in the middle of the Concentric Layer to a position outside the shape. You can also annotate an onion diagram using Callout shapes. To open a stencil of Callout shapes, choose File ➪ Shapes ➪ Visio Extras ➪ Callouts.
Part III ✦ Using Visio for Office Productivity

Partial Layer shape on top of Concentric Layer shape

Red squares indicate glue

Concentric Layer shape

**Figure 12-5:** You can subdivide Concentric Layers by gluing Partial Layer shapes to them.

5. To modify the length of the arc for a Partial Layer, drag the yellow control handle on the Partial Layer’s outside edge.

6. To rotate a Partial Layer within the Concentric Layer, drag the red selection handle.

**Summary**

The templates and shapes for Block Diagrams are easy to use and include many helpful features. Using basic Visio techniques, you can document structure and flow or communicate hierarchy or concepts revolving around a central idea. Visio Block shapes can be as simple as one-dimensional arrows and two-dimensional geometric shapes, but you can also produce impressive diagrams for presentations by using shadows or shapes with perspective.
Constructing Charts and Graphs

Charts and graphs illustrate scientific results, financial performance, marketing analysis, and many other types of quantitative data. Microsoft Visio and Microsoft Excel both offer features for constructing charts and graphs.

If the data you want to present is already stored in a Microsoft Excel spreadsheet, you can use the Insert Chart command in Excel to create different types of charts or graphs based on your spreadsheet data. In Excel, you can format every component of an Excel chart to achieve the look you want. In most cases, Excel is better than Visio for developing and formatting charts.

However, if you’re developing a presentation that summarizes data from a variety of sources, it might be easier to build a chart or graph in Visio. The charts and graphs in the Visio Charts and Graphs template don’t work with data stored in other sources, so you have to drag Visio shapes onto a drawing and type the values you want into the shape text blocks.

The Visio Charts and Graphs template includes shapes for common chart and graph styles, such as bar graphs, line graphs, pie charts, distribution curves, feature comparison tables, and any kind of tabular information. In addition, you can use Visio’s marketing shapes to analyze and communicate sales and marketing information, such as sales prospects, market analysis, market share, and marketing mix.

The Forms template is no longer available in Visio 2003, having been replaced by the form-building features in Microsoft’s new product, InfoPath.
Exploring the Chart and Graph Templates

Chart and graph shapes are simple enough that the Chart and Graph templates don’t contain any specialized menus, toolbars, or add-ons. You can create charts and graphs by dragging and dropping shapes from Visio’s stencils and adding text and numbers to components in the shapes. You can modify charts and graphs by dragging shape handles or by applying colors and formatting.

Choosing the Right Template

Visio offers two templates for charts and graphs, both of which contain shapes you can use for general purposes or specialized marketing presentations. Both templates automatically set the page to a letter-size sheet with portrait orientation, use inches drawn at a one-to-one scale, and open the Backgrounds and Borders and Titles stencils.

The Charts and Graphs template supports more generic charting applications, such as basic bar and line graphs, pie charts, and generic grids to show tabular information. However, if you’re not sure what kind of chart and graph shapes you want, just use the Marketing Charts and Diagrams template, which opens all three chart and graph stencils: Charting Shapes, Marketing Shapes, and Marketing Diagrams.

Note

The Forms template and Forms stencil are not available in Visio 2003. Beginning with Office 2003, you can use Microsoft InfoPath to design and construct forms. These forms are based on XML so you can use them to collect data for XML-compatible databases and back-end business systems.

Exploring Visio Chart and Graph Shapes

Chart and Graph shapes are simple to use. You can drag selection handles or control handles to resize them or modify their components. In tabular shapes, such as the Grid shape and the Feature Comparison chart, you can select and edit individual cells. Chart shapes that include custom properties for configuring the shape display a dialog box after you drop the shape onto a drawing. You can specify how many data points or other elements you want and click OK to complete the addition of the shape. To configure one of these shapes after you add it to a drawing, right-click it and choose a configuration command from the shortcut menu.

New Feature

The Grid shape on the Charting Shapes stencil replaces the Table shape available in previous versions of Visio. When you open a drawing that contains a Table shape in Visio 2003, the Table retains its formatting, but the formatting commands aren’t available to modify the table formatting further. If you want to format the table, you must recreate your table by dragging a Grid shape onto the drawing page and reentering the table values.
Charting Shapes

The Charting Shapes stencil, shown in Figure 13-1, provides the basic shapes to create standard charts and graphs. You can drag the shapes you want onto the drawing and add text to the shapes or in separate annotation shapes. Some of these shapes include control handles you can drag to modify the appearance of the chart and graph components.

Figure 13-1: The Charting Shapes stencil provides shapes for commonly used charts and graphs.

✦ Bar Graphs — The Bar Graph 1 shape shows numerical values, whereas Bar Graph 2 is set up to show percentages. You can use the X-Y axis, Graph Scale, and axis label shapes to add axes to your bar graphs.

✦ 3-D Bar Graphs — The 3-D Bar Graph and 3-D Axis shapes work together to document three-dimensional bar graphs. You can construct your own 3-D graph using the 3-D bar shapes, the X-Y-Z axis shape, and the shapes that label the x, y, and z axes.

✦ Pie Charts — The Pie Chart shape creates a whole pie with up to ten slices. To create a pie with more slices, you can use Pie Slice shapes. The Special Pie Slice shape shows a concentric ring that you can place on top of a pie slice. It is similar to the Partial Layer shape for onion diagrams available in the Block Diagram template.
Divided Bars—The Divided Bar 1 shape shows numerical values, whereas the Divided Bar 2 shape is set up to show percentages. You can add text to the divided bars or use the X-axis and axis label shapes to annotate the divided bars.

Tabular Charts—The Process Chart shape includes up to ten steps, with symbols to document the activities within each step. The Deployment Chart is a table for tracking the roll out of systems in an organization. It can show up to six departments implemented over five phases.

Feature Comparison Charts—The Feature Comparison Chart shape can compare up to ten features across up to ten products. You can indicate whether a product supports a feature completely, partially, or not at all by adding Feature On/Off shapes in each grid cell.

Grids—The Grid, Row Header, and Column Header shapes create generic tables. The Yes/No Box can display a filled circle, hollow circle, or text.

Distribution and Exponential Graphs—The Normal Curve shape displays a distribution curve. Control points change the shape and skew of the distribution. You can change the height and width of the Exponential Curve, but not its shape.

Line Graph Shapes—The Line Graph shape displays a series of data points with the area under the graph filled. You can highlight lines on a graph with the Graph Line and Data Point shapes.

Annotation Shapes—You can annotate your chart or graph with labels, text blocks with different font sizes, balloons, callouts, or annotation shapes.

Marketing Shapes
Most of the shapes in the Marketing Shapes stencil look like clip art and are useful for developing sales and marketing presentations. A few of the shapes are extendable, such as People and Variable Building. When you drag the selection handle on the side of the People shape, it will add up to four people. Dragging the selection handle on the top of the Variable building shape adds up to ten floors to a skyscraper.

Marketing Charts and Diagrams
The Marketing Diagrams stencil, shown in Figure 13-2, provides shapes to create charts and graphs typically used for marketing, such as market share, circle-spoke, or marketing mix. However, you can take advantage of these shapes to illustrate any kind of data.
Constructing Basic Charts and Graphs

Visio provides shapes for commonly drawn charts, such as 3-D bar graphs, but also includes shapes so you can assemble your own chart from scratch. If you find that a predefined chart won’t illustrate your data the way you want, you can build a graph with individual shapes.

Constructing Bar Graphs

In Visio 2003, you can create 2-D or 3-D bar graphs. Visio provides predefined 2-D shapes that can display up to ten bars. The 3-D bar graph shape includes up to five 3-D bars.

Creating 2-D Bar Graphs

You can construct a 2-D bar graph by dropping one of the bar graph shapes onto a drawing. To annotate the bar graph, you can add axes and axis labels as well as a variety of annotation shapes. To create a 2-D bar graph, follow these steps:

1. Drag a Bar Graph shape onto your drawing, choose the number of bars from the drop-down list, and click OK.

2. To set the height for the tallest bar in the graph, drag the yellow control handle at the top left of the Bar Graph shape until the tallest bar is the height you want for the largest Y-value, or 100% for graphs showing percentages, as demonstrated in Figure 13-3.
Drag to set the height of the tallest bar.

Drag to resize the entire graph.

Drag to change the width of the bars.

**Figure 13-3**: Drag selection and control handles to adjust the size of a bar graph.

3. To set the width of all the bars, drag the yellow control handle at the bottom right of the first bar and drag it until the bars are the width you want.

4. To specify the value for a bar, click the graph, click the bar to select it, and type the value for that bar.

**Caution**
Although the Bar Graph 2 shape is set up to show percentages, you must type % after the number when you enter a value for a bar. If you don’t end a number with %, Visio converts the number to a percentage by multiplying by 100 and sets the bar to the resulting height. For example, typing 1 will create a bar the same height as 100%.

5. To change the number of bars in a graph, right-click the Bar Graph shape, choose Set Number of Bars from the shortcut menu, select the number of bars you want, and click OK.

**Note**
To access the shortcut menu for the Bar Graph shape, make sure that none of the individual bars are selected and then right-click anywhere on the bar graph. Right-clicking a selected bar displays the shortcut menu for that bar. If a bar is selected, you can select the Bar Graph shape by right-clicking the dotted, green boundary line of the shape.
6. To change the color for a bar, first select the bar, then right-click it, and choose Format ➤ Fill from the shortcut menu. Select the fill options you want and click OK.

7. To add the x and y axes to a 2-D bar graph, drag the X-Y axis shape until the origin snaps to the bottom-left corner of the first bar in the graph.

8. To label the units for the axes, click the X-axis or Y-axis text blocks and type the label you want.

Creating 3-D Bar Graphs

To create a 3-D bar graph, follow these steps:

1. Drag the 3-D Axis shape onto your drawing.

   You can drag the control handles on the 3-D Axis shape to reposition the labels, change the number of grid lines, change the thickness of the wall, or change the depth of the third dimension.

2. Drag the 3-D Bar Graph shape onto your drawing and drop it on the origin of the 3-D Axis shape. In the Custom Properties dialog box that appears automatically, select the number of bars from the drop-down list. You can also specify the values and colors for each of the bars. Click OK when you are finished.

   Tip

   If you drag the 3-D Bar Graph shape onto your drawing before the 3-D Axis shape, the axis shape hides the bar graph. To change the stacking order of these shapes, right-click the 3-D Axis shape and choose Shape ➤ Send to Back from the shortcut menu.

3. To change the height of the graph, drag the green selection handle at the top or bottom of the shape.

4. To set the width of all the bars, drag the yellow control handle at the bottom right of the first bar and drag it until the bars are the width you want.

5. To specify the value or color for a bar, right-click the 3-D Bar Graph shape, choose Bar Properties from the shortcut menu, and edit the values in the Custom Properties dialog box. Click OK when you are finished.

6. To change the number of bars in a graph, right-click the 3-D Bar Graph shape and choose Bar Count and Range from the shortcut menu. Select the number of bars you want in the Bar Count drop-down list and click OK.

7. To change the height of bars in relation to the overall shape, right-click the 3-D Bar Graph shape and choose Bar Count and Range from the shortcut menu. In the Range box, type the value represented by the top of the y axis. For example, if you change the range from 4 to 8, the bars in the graph shorten by half.
Constructing Line Graphs

Unlike Microsoft Excel, Visio provides only one type of line graph. If you want to graph two lines or choose from different markers for data points, it’s easier to add data to a spreadsheet and use Insert Chart in Excel. If you want to create a simple line graph in Visio, follow these steps:

1. Drag the Line Graph shape onto a drawing. In the Custom Properties dialog box that appears automatically, select the number of data points you want, and click OK.

   Tip
   To change the number of data points after adding the shape to a drawing, right-click the line graph, choose Set Number of Data Points, pick a number, and click OK.

2. To change the length of the x or y axis, drag the control handle at the end of the axis to the length you want.

3. To change the value of a data point, drag the control handle for that data point to the appropriate value on the y axis.

4. To emphasize data points on a line graph, drag a Data Point shape onto the drawing and snap it to the control handle for a data point. To emphasize the lines between data points, drag a Graph Line shape onto the drawing. Glue each end to a pair of consecutive data points.

Labeling Axes

The axis shapes include text blocks that you can edit to show the units for an axis, such as the number of support calls handled on the y axis versus days of the week on the x axis. In addition to the text blocks in the axis shapes, you can add axis label shapes to show numeric values along each axis. To add axis labels to bar graphs or line graphs, follow these steps:

1. Drag the Y-axis Label shape onto the drawing so that its horizontal line is aligned with the x axis.

   Tip
   If you want to zoom in to make it easier to add labels, press and hold Ctrl+Shift and click the graph.

2. To copy the Y-axis label, select the Y-axis shape and then press Ctrl+D. Drag the second label so its horizontal line is even with the highest value you want to label.

3. Repeat step 2 to create labels for intermediate values along the y axis.

4. Repeat steps 1 through 3 with X-axis Label shapes to add labels along the x axis.

5. Select each label shape and type the value or name corresponding to the label position.
You can use Distribute Shapes to space labels evenly along an axis. Select all the labels along an axis and choose Shape ▶ Distribute Shapes, select the first option for Vertical Distribution for Y-axis labels, select the first option for Horizontal Distribution for X-axis labels, and then click OK.

**Working with Pie Charts**

In most cases, it’s easier to use Microsoft Excel for pie charts, but if you decide to create a pie chart in Visio, follow these steps:

1. Drag the Pie Chart shape onto the drawing, select the number of slices you want, and click OK.

2. To specify the size of each slice, right-click the pie chart and choose Set Slice Sizes from the shortcut menu. Type the percentage for each slice in the Custom Properties dialog box and then click OK.

   If the values you enter for the slices don’t total 100 percent, part of the pie will be empty.

The Pie Chart shape is a single shape that can represent up to ten slices. If you want to create a pie chart with more than ten slices or emphasize one or more of the slices, you can use Pie Slice shapes, which represent individual slices of pie to build a pie chart. To do this, follow these steps:

1. Drag the first Pie Slice shape onto the drawing.

2. To change the radius of the slice, drag the green selection handle at the outside edge of the slice.

3. Drag another Pie Slice shape and drop it close to the first slice.

4. Drag the green selection handle at the bottom right of the second slice to the vertex at the top left of the first slice, as shown in Figure 13-4. Drag the green selection handle at the center of the second slice to the vertex at the bottom left of the first slice. When you are done, the radius of the second slice will match that of the first slice.

5. To modify the percentage of a slice, select the slice and drag the yellow control handle until the percentage shown in the slice is the value you want.

   To increase the size of a slice by 1 percent, right-click the slice and choose Add 1% from the shortcut menu.

6. To change the color of a slice, right-click it and choose Format ▶ Fill from the shortcut menu. Select the fill options you want and click OK.

7. Repeat steps 3 and 4 to add additional slices, always adding slices counterclockwise around the pie.
This handle has been dragged into position.

Drag to rotate the slice into position.

Drag to modify the slice percentage.

Figure 13-4: Drag selection handles to build a pie chart from pie slice shapes.

If you create a pie chart with individual slices, you can emphasize a slice by dragging the slice away from the center of the pie. If the slice tends to snap to another shape, choose Tools ➪ Snap & Glue. Uncheck some of the check boxes, such as Shape Geometry, in the Snap To column, click OK, and then try to move the slice again.

Creating Feature Comparison Charts

Feature comparison charts illustrate the features that products possess so that you can choose the product that best fits your requirements. The Feature On/Off shape includes three status options:

- **Blank** — Indicates that the feature doesn’t exist for that product
- **A filled circle** — Indicates that the product provides the feature
- **A hollow circle** — Can indicate that the product provides the feature with some limitations
To create a feature comparison table, follow these steps:

1. Drag the Feature Comparison shape onto the drawing. Select the number of features and number of products to compare and click OK.

2. To enter a feature description, click a row header cell and type the name of the feature. To add a product name, click a column header cell and type the name of the product.

3. To add a status, drag the Feature On/Off shape onto a cell in the comparison chart, select the status option you want, and click OK. Repeat this step for each cell in the chart.

4. To change the number of features or products, right-click the chart and choose Set Fields from the shortcut menu.

Working with Marketing Diagrams

You can create marketing diagrams by dragging shapes from the Marketing Diagram stencil and specifying options for those shapes. Many of the marketing shapes include shortcut menu commands to modify the shape configuration. For example, you can specify the number of arrows in a Circular Arrows shape when you first add the shape, or you can specify the number later using the Set Number of Arrows command on the shape's shortcut menu. Some shapes also include control handles that you can drag to make other adjustments. This section describes some of the special features on marketing diagrams.

Building Circle-Spoke Drawings

Circle-spoke diagrams include up to eight circles arranged on spokes around a center circle. To create a circle-spoke diagram, follow these steps:

1. Drag the Circle-spoke shape onto the drawing. Select the number of circles desired and click OK. You can change the number of circles later by right-clicking the shape and choosing Set Number of Circles from the shortcut menu.

2. To relocate or rearrange the outer circles, drag the yellow control handle in the middle of a circle to a new location, as shown in Figure 13-5.

3. To resize the diagram, drag a selection handle.

Note

When you resize a diagram, Visio resets outer circles to be equally spaced from one another and at the same distance from the center.
Drag to resize the circle-spoke diagram.

Figure 13-5: You can reposition and rearrange the circles in a circle-spoke diagram.

**Constructing Triangles and Pyramids**

You can create triangular charts and 3-D pyramids to show hierarchical relationships. To create a triangular chart, follow these steps:

1. Drag a Triangle shape onto the drawing. Select the number of levels wanted and click OK.
2. To specify an offset that defines the gap between each layer of the triangle, right-click the shape and choose Set Offset from the shortcut menu. Type the number of inches between the layers and click OK.
3. To switch between a flat triangle and a three-dimensional triangle, right-click the triangle shape on the drawing and choose either 2-Dimensional or 3-Dimensional from the shortcut menu.
4. To change the number of levels after you have added the shape to the drawing, right-click the shape and choose Set Number of Levels from the shortcut menu.

When you add a 3-D pyramid to a drawing, you can specify up to six levels in the pyramid and can choose one color for the entire pyramid. To change these settings later, right-click the pyramid and choose Set Number of Levels or Set Pyramid Color from the shortcut menu.
Adding Text to Charts and Graphs

Depending on the chart and graph shapes you use, you can select a shape, a cell, or a text block within a shape and add text simply by typing. For example, you can select the text block on the left side of a Bar Graph shape to label the y axis. You can also select each bar in the Bar Graph shape to specify the height of the bar. If you select the entire Bar Graph shape and begin typing, Visio adds a text block below the x axis.

In addition to the text within shapes, the Visio Chart and Graph templates open stencils with title and callout shapes you can use to annotate your drawing. To add a title to your drawings, you can use the Text Block shapes from the Charting Shapes stencil or choose one of the title block shapes from the Borders and Titles stencil.

You can add other types of annotation to a chart or graph. To add a word balloon to a drawing, follow these steps:

1. Drag a 1-D or 2-D Word Balloon shape onto the drawing.
2. With the word balloon shape selected, type the text you want in the word balloon.
3. To change the size of the word balloon, drag a green selection handle to a new position.
4. To aim the pointer, drag the yellow control handle to a new position. The pointer automatically protrudes from the side of the balloon closest to the end of the pointer.

To add other annotation to a drawing, follow these steps:

1. Drag a Horizontal Callout or Annotation shape onto the drawing.
2. With the shape selected, type the text you want. The height of the shape adjusts to display the text you type.
3. To change the width of the annotation, drag a green selection handle to a new position.

To learn more about annotating drawings, refer to Chapter 6.

Using Stackable and Extendable Shapes

You can easily modify marketing shapes that are stackable or extendable. When you stretch stackable shapes, they stack additional shapes vertically or horizontally — for example, showing additional people to represent population. Extendable shapes stretch without distorting parts of the shape.
To work with stackable shapes in a chart or graph, follow these steps:

1. Drag a stackable shape, such as the People shape or the Variable Building shape, from the Marketing Shapes stencil onto the drawing.

2. To extend the shape, drag a selection handle. Additional repeating elements will appear.

3. To create a longer series, press Ctrl+D to copy the stackable shape and align it end to end with the first shape.

To work with extendable shapes in a chart or graph, follow these steps:

1. Drag an extendable shape, such as the Pencil shape, from the Marketing Shapes stencil onto the drawing.

2. To change the length of the extendable shape, drag a green selection handle.

**Summary**

Visio chart and graph templates provide shapes to produce a wide variety of charts, graphs, and marketing diagrams. However, if you want to create commonly used charts and graphs from numeric data stored in a spreadsheet, the Insert Chart command in Microsoft Excel is easier and more flexible. The Visio Marketing Shapes stencil includes clip art shapes for sales presentations. If you want to communicate the results of marketing efforts, you can use marketing-oriented shapes, such as feature comparison charts or marketing mix shapes in the Charting Shapes and Marketing Diagrams stencils.

✦ ✦ ✦
Working with Organization Charts

Organizations come in many shapes and sizes, with both formal and informal reporting structures. In strictly hierarchical enterprises, authority and communication travels up and down lines of command. Alternatively, companies that perform large multidisciplinary projects often use a strong matrix structure whereby workers report to project managers for the projects they work on in addition to a functional manager for other assignments and administrative issues.

Organization charts document the formal structure and relationships within an enterprise, including business units, functional areas, teams, and individuals. It’s sad but typically true that the unofficial relationships that propel progress remain undocumented even with an easy-to-use tool like Visio 2003.

When you use the Organization Chart template to create organization charts in Visio 2003, your diagrams are inherently hierarchical diagrams because even the strongest matrix organization has a hierarchy at its core. You can use the Visio 2003 organization chart features just as easily for other hierarchical diagrams, such as the genealogy of a family tree. In this chapter, you learn how to create organization charts from scratch or by importing organization data from other sources.
Exploring the Organization Chart Template

The Organization Chart template includes a stencil of Organization Chart shapes, a menu of specialized Organization Chart commands, a toolbar with layout and positioning tools, and a wizard to help build organization charts. The following sections describe the basics of these features.

Exploring the Organization Chart Tools

The Organization Chart menu contains commands to create, layout, format, modify, and update Visio organization charts. As you can see in Figure 14-1, when you open an existing Visio organization chart or create a new organization chart drawing, an Organization Chart stencil and toolbar appear and the Visio menu bar picks up an Organization Chart entry that you can choose to access the Organization Chart menu.

Figure 14-1: The Organization Chart template includes a menu, toolbar, and stencil.
Many of the Organization Chart commands are also available on a shortcut menu when you right-click a shape on a drawing page.

You can construct a hierarchical drawing manually by dragging and dropping shapes from the Organization Chart stencil onto the drawing page. When you drop an employee shape on top of another shape, Visio adds a connector between the shapes, which creates a reporting relationship from an employee to his or her manager. Standard Visio tools and techniques work for rearranging shapes or modifying an organization chart’s content and format. However, it’s much easier to use the template’s layout and editing tools to arrange and format the shapes on your organization chart.

Exploring Visio’s Organization Chart Shapes

The Organization Chart stencil includes shapes with formats that denote levels in a hierarchy or special conditions such as assistants, outside consultants, and vacancies. However, any employee shape in the stencil can act as either superior or subordinate. The Organization Chart stencil also includes a few shapes to speed up frequently used groupings, such as several resources reporting to a superior. For example, the appearance of the following employee shapes helps show levels in an organization chart:

- Executive
- Manager
- Position
- Staff position

The appearance of the following shapes indicate special situations, such as a dotted-line boundary for a vacancy, but these shapes can still act as superiors or subordinates:

- Consultant
- Assistant
- Vacancy

To learn how to change the appearance of Organization Chart shapes by applying a design theme, refer to the “Setting Organization Chart Options” section later in this chapter.
The following shapes simplify working with groups of employees in an organization chart:

- **Multiple Shapes** — Adds the number of positions and connectors that you specify to the superior shape on which you drop it
- **Three Positions** — Adds three positions as subordinates to the superior shape on which you drop it
- **Team Frame** — Indicates graphically that the employees within the frame are members of a team

The Dotted Line Report connector is a dynamic connector new in Visio 2003. An employee can have only one primary reporting relationship. To show an employee reporting to an additional manager, you can drop the dotted line report connector onto an additional shape that represents a superior and drag the other end to the shape that represents the employee.

### Creating Organization Charts Manually

When you’re documenting a large organization, it’s easier to import data into Visio. If you don’t have an existing source of organization data or you’re building an organization chart for a small group, it’s just as easy to create an organization chart manually. Starting at the top of the hierarchy — with a company president or the manager of a group, for example — you drag and drop shapes representing employees from the Organization Chart stencil onto the drawing page. By dropping a subordinate shape onto a superior, you can define the connection and reporting relationship as you add employees to the chart, as demonstrated in Figure 14-2.

Visio creates a connector and arranges the shapes.

**Figure 14-2:** Organization chart shapes are smart enough to create connections and reporting relationships when you drop them on other shapes.
To create an organization chart manually, follow these steps:

2. Drag an Executive shape onto the drawing page.

When you begin your first organization chart, Visio displays a message box that demonstrates how to connect shapes. To hide this reminder in the future, check the Don’t Show This Message Again check box and click OK.

3. Because the Executive shape is selected immediately after you add it, type the employee’s name, press Enter, and then type the employee’s title.

4. To add a manager reporting to the executive, drag and drop a Manager shape from the stencil onto the Executive shape. Visio adds a connector between the shapes and assigns the manager as a subordinate to the executive. Visio also arranges the shapes based on the current layout.

5. Drag and drop additional shapes from the stencil onto their superiors on the drawing page.

Note

You can assign a name and title to each shape as you add it or add all the shapes to the chart and then select each one and assign its values.

6. Select a shape and type the employee’s name and title as you did in step 3. To conclude your text entry, click the drawing page, press Esc, or drag a shape from the stencil.

Tip

If the shapes you add overlap each other, click Re-layout on the Organization Chart toolbar to rearrange them.

7. To modify the layout of a group of subordinates, select the superior shape to which the group reports, click a layout option in the Organization Chart toolbar, and select a layout configuration.

8. To add additional information such as department or telephone number, right-click a shape and choose Properties from the shortcut menu. Type values in custom property boxes and click OK when you are finished.

Tip

If your organization chart is cluttered or doesn’t look the way you want, see the “Formatting Organization Chart Appearance” section later in this chapter.

Creating Organization Charts Using the Organization Chart Wizard

The Organization Chart Wizard guides you through the steps of creating an organization chart whether you have organization data ready or not. It’s easy to build an organization chart if you already have personnel data in an ODBC-compliant database, a Microsoft Exchange Server, or even a spreadsheet or text file.
If you store personnel data in another type of system, you can still use that data to construct an organization chart by exporting it into a spreadsheet or comma-delimited file. In the worst case, when the personnel data is still in your head, the Organization Chart Wizard will create a file or spreadsheet for you to fill out.

You can use one of the following methods to access the Organization Chart Wizard to create an organization chart:

- Choose Tools ➪ Add-Ons ➪ Organization Chart ➪ Organization Chart Wizard
- If the Organization Chart template is active, choose Organization Chart ➪ Import Organization Data.

**Building a File for Organization Data Using the Organization Chart Wizard**

Follow the steps in this section to construct an organization chart data file using a template in the wizard:

With this option, you can only work with data entered in the default columns. If you want to import additional data into boxes and custom properties in an organization chart, you must create your organization chart data file before you start the wizard. Then, when you start the wizard, select the Information That’s Already Stored in a File or Database option.

1. To create the organization chart by entering data into a new file, select the Information That I Enter Using The Wizard option and click Next.
2. Select the Microsoft Excel option to enter data in a spreadsheet, or the Delimited Text option to create a text file. To specify the name and folder for the new data file, click Browse.
3. Navigate to the folder you want to use, type the name for the data file into the File Name box, and then click Save. Click Next to open the file.
4. After reading the instructions for creating the data file, click OK. A template file opens in Excel for a spreadsheet, as shown in Figure 14-3; or a text editor opens for a delimited file. The file contains three sample entries that demonstrate how to define top-level and subordinate entries in the organization chart. Replace the sample text with your data and enter additional rows of data for each position in your organization chart.
5. After you have completed your data entry, choose File ➪ Exit to save the file and return to the Organization Chart Wizard. Next, skip to the “Finalizing Your Chart” section later in this chapter and follow the steps outlined there to finish creating your organization chart.
Using Existing Organization Data

Follow the steps in this section to build an organization chart using data from an existing file.

1. To create an organization chart from existing data, select the Information That’s Already Stored in a File or Database option and click Next.

2. Select the option for the type of data file you want to use and click Next.

3. For the type of data file you chose, specify the information required to identify the data file you want to use. Your options are as follows:

   • **Spreadsheet or delimited text file** — Click Browse to specify the folder and filename.

   • **Microsoft Exchange Directory** — You do not have to provide any information for this option.

   • **ODBC-compliant data source** — If you have already defined a data source for your organization data, click the name of the data source in the list. If you select a generic type of ODBC-compliant data source, such as Microsoft Access Database or Excel Files, you must also specify the folder and filename of the database. After specifying the data source, you must also select the table in the database that contains your organization data.

   One advantage to using an ODBC-compliant data source is that you can link database records to shapes so that shape values change when the data source is updated.
If the ODBC-compliant data source list doesn’t contain the type of data source you are using, click Create Data Source. To create a data source, you must specify whether the data source applies only to the current machine or is machine-independent. You also must choose the driver for the data source and the file that contains your organization data as the file to which this data source should be connected.

4. After defining the data source, click Next to associate the columns or fields in the data file to the data in the Visio organization chart.

5. To specify the field that contains employee names, select an entry in the Name drop-down list, as shown in Figure 14-4. The entries correspond to the column headings in a spreadsheet or delimited file, or to the field names in an ODBC-compliant database. Optionally, you can associate a field or column heading with the First Name drop-down list.

6. To specify a field that contains reporting relationships in a data source, select an entry in the Reports To drop-down list and click Next.

7. Select the fields that you want to appear in each box on the organization chart. You can use the Add or Remove buttons to build the list of fields, and the Up and Down buttons to define the order in which the fields appear. Click Next.

Organization Chart shapes contain four default properties: department, telephone, name, and title. If you remove these properties from the field lists in the wizard, the custom properties still appear but the wizard will not transfer the values from your data file to the Visio diagram.

8. Select the fields whose data you want stored in custom properties associated with each box on the organization chart. You can use the Add or Remove buttons to build the list of fields. Click Next.
Chapter 14 ✦ Working with Organization Charts

Linking Database Records to Shapes

When you link database records to shapes, you can control how these links operate by clicking the Settings button in the wizard. You can specify which database-related commands to include on a shortcut menu that appears when you right-click a linked shape.

- **Select database record** — Selects a database record to link to a shape.
- **Refresh shape’s custom properties** — Updates a shape’s custom properties to match the values in the linked data source.
- **Update database record** — Updates the linked database record to match the values in the shape’s custom properties.
- **Delete shape and database record** — Removes the shape in the organization chart and the linked record in the data source.

You can also control when updates occur; update shape custom properties and database records each time you display a page; and refresh custom properties either when you open a Visio document or periodically by using the NOW function.

Displaying a field in a box on the organization chart automatically includes that field as a custom property for each shape. By associating a field with a custom property without displaying it in Organization Chart shapes, you can reduce clutter while providing access to the data. To view custom properties for a shape, right-click a shape and choose Properties from the shortcut menu.

9. Execute this step only if you are using an ODBC-compliant data file. Select either the Copy Database Records to Shapes or Link Database Records to Shapes option. If you link database records to shapes, the values in the organization chart will change when the database values change. Click Next.

Finalizing the Chart

You can control the placement of organization chart boxes across multiple pages in a Visio diagram. For example, you can produce summary pages for large organizations or show employees for different departments on separate pages. The steps to accomplish this are common to every type of data file, either existing or created using the wizard:

1. To create a hyperlink between shapes that represent the same employee on more than one page of your organization chart, check the Hyperlink Employee Shapes Across Pages check box. With this option, you can follow a hyperlink to a copy of an employee by right-clicking the shape and choosing the hyperlink from the shortcut menu.

2. To synchronize all shapes that represent the same employee so that changes made to one copy propagate to all other copies, check the Synchronize Employee Shapes Across Pages check box.
3. (Optional) If you want Visio to choose the breakpoints between pages, select the I Want The Wizard to Automatically Break My Organization Chart Across Pages option. After choosing this option, click Finish to create the organization chart and skip the rest of the steps in this list.

4. To specify how to distribute your organization across multiple pages, select the I Want to Specify How Much of My Organization to Display on Each Page option.

5. To specify the levels that you want to display on the first page, shown in Figure 14-5, click Modify Page. To use the first page as an executive summary, select the number of levels that you want to appear in the Number of Additional Levels box. Type a name for the page in the Page Name box and then click OK to return to the wizard screen.

![Organization Chart Wizard](image)

**Figure 14-5:** You can modify the number of organization chart pages and how many levels appear on each one.

6. To add additional pages to the organization chart — for example, to create a page for a lower level department — click Add Page. When you create additional pages, you can specify their contents and then click OK to return to the wizard screen:

- To choose the name that appears at the first level on this new page, select a name in the Name at Top of Page list. For example, select the name of a manager shown at the lowest level of the executive summary page.

- To show all subordinates who report to the person at the top-level of the page, select All Subordinates in the Additional Levels list.
• To show a number of levels below the top-level on this page, select that number in the Additional Levels list.

• Type a name for the page in the Page Name box.

7. When you have finished defining the pages for your chart, click Finish.

Formatting Organization Chart Appearance

The Organization Chart template includes tools and options to help you build attractive and easy-to-read organization charts. With Visio’s organization chart layout options, you should rarely have to resort to laying out shapes manually. Visio’s organization chart options enable you to fashion just the look you want for shapes and text. You can even apply a design theme, which applies consistent shape and text style formatting to your entire chart.

Laying Out the Organization

Visio provides numerous layout options that you can use to arrange subordinates reporting to a superior. Although Visio arranges subordinate shapes horizontally by default, you can specify different layout options for each person with direct reports. If you have synchronized copies of shapes on multiple pages of a chart, you can apply a different layout to each synchronized copy.

Tip Although each shape with direct reports can use a different layout, your organization chart will be more readable if you choose one or two layouts only.

You can layout the direct reports for one or more managers or ask Visio to layout all the shapes on the active drawing page. To layout shapes on an organization chart, choose one of the following methods:

✦ **Layout a group** — Select the superior to whom the group reports, click one of the layout options on the Organization Chart toolbar, and click the configuration you want.

✦ **Layout multiple groups** — Select the superior for every group you want to layout by clicking the first superior and then Shift+clicking the others. Click one of the layout options on the Organization Chart toolbar and click the configuration you want.

Note To see examples of each layout option, as shown in Figure 14-6, choose Organization Chart ➪ Arrange Subordinates. Click the layout you want and then click OK.
Optimize your layouts — You can optimize the location of the shapes on the drawing page using the layouts you chose by clicking Re-layout on the Organization Chart menu or toolbar. Visio moves the shapes on the page but maintains the layout options you selected for each superior.

Optimize overall layout — To have Visio select the best layout options for you, choose Organization Chart ➤ Best Fit to Page.

Caution
If your Organization Chart shapes explode over your drawing page when you apply a layout, the connections between shapes could be broken. This can occur if you or an earlier author positioned shapes manually and inadvertently broke the connections between shapes. You can continue to position shapes manually. However, to correct this chaotic behavior, reconnect shapes, ideally with shape-to-shape glue. To connect shapes with shape-to-shape glue, select a connector and drag each end point to the center of a shape, or drag the predecessor shape over the supervisor shape.

Setting Organization Chart Options
You can customize many aspects of an organization chart’s appearance by choosing Organization Chart ➤ Options to specify the settings you want. These options manipulate the appearance of Organization Chart shapes and text and determine which fields of information appear in the shapes. You can restore default settings by clicking Restore Defaults in the Options dialog box.

New Feature
You can display employee photos in organization charts created with Visio 2003. To attach a picture to a shape, right-click a shape and choose Insert Picture from the shortcut menu. Specify the folder and filename for the picture and click Open. To display pictures, choose Organization Chart ➤ Options. Select the Options tab and then check the Show Pictures check box. If a picture doesn’t appear in a shape, it might be too large. Crop the picture to a smaller size.
Setting Shape Options
Select the Options tab to customize shapes in the following ways:

✦ Set the height and width for all employee shapes.
✦ Apply a design theme, which sets shape and text styles for each type of organization chart shape.
✦ Show or hide employee pictures that have been inserted into shapes.
✦ Show or hide the divider line between the first and second line of text in shapes.
✦ Show drawing tips.
✦ Use the organization chart options that you choose for all new organization charts and for all Organization Chart shapes used on other types of drawings.

Note
Visio 2002 included an option to move shapes into position automatically when possible. Although this option is no longer available in Visio 2003, you can use Re- layout or Best Fit to Page to optimize shape layout.

Specifying the Fields to Display in Shapes
Organization Chart shapes can display the values for custom properties in five locations within their boundaries. The center of a shape can show one or more fields. Each corner of a shape can show the value for one field.

By selecting the Fields tab, you can perform the following actions:

✦ Select the fields that appear in the center of a shape.
✦ Rearrange the order for the fields in the center of a shape.
✦ Select the fields that appear at each corner of a shape.

Setting Text Options
By selecting the Text tab, you can customize the appearance of organization chart text in the following ways:

✦ Choose the field whose text style you want to set.
✦ Specify the font to use for a field.
✦ Specify the font size to use for a field.
✦ Specify whether a field’s text should be bolded or italicized.

Improving Chart Readability
Sometimes, organization charts require more tweaking than choosing layouts and options can provide. If your chart is still hard to read, you can adjust the spacing between shapes or hide some subordinates.
To modify the spacing between shapes, choose Organization Chart ➪ Change Spacing. You can adjust the spacing between shapes in the following ways:

✦ **Make qualitative changes** — Select the Tighter or Looser option to decrease or increase the current spacing.

✦ **Define specific spacing** — Select the Custom option and click Value to define values for spacing. For each layout type, you can specify the spacing between subordinates, the spacing between superiors and subordinates or assistants, and the justification spacing for layouts aligned to the left or right.

✦ **Apply Spacing to Shapes** — Select an option to apply the spacing changes to the selected shape, all shapes on the current drawing page, or all shapes in the file.

You can also improve readability by distributing a large or complex chart across multiple pages. To learn how to do this, see the “Working with Multiple Page Organization Charts” section later in this chapter.

In addition, you can improve a chart’s readability by hiding some of the subordinate shapes temporarily. To hide the subordinates for a shape, select a shape and choose Organization Chart ➪ Hide Subordinates. When subordinates are hidden, the entry on the menu changes to Show Subordinates, which you can choose to restore the subordinates to the view.

The Re-layout and Best Fit to Page functions optimize the layout of your chart based on the shapes that aren’t hidden. When you show the subordinates, you might have to apply Re-layout or Best Fit to Page again.

**Working with Organization Charts**

Organizational structure can be quite fluid, with people getting promoted or reassigned and even business units being reorganized, acquired, or divested. You can keep your organization chart up to date and still have time for other work by using Organization Chart tools to rearrange and update shapes.

**Moving and Deleting Organization Chart Shapes**

Visio includes standard commands to move and delete shapes, but these tools can sometimes cause problems when you use them in organization charts. The following sections identify the safest methods for moving and deleting shapes.

In most cases, it’s easiest to use the Organization Chart layout tools, such as Arrange Subordinates, Re-layout, or Best Fit to Page to arrange the shapes in a chart. If you drag Organization Chart shapes to relocate them, those changes disappear when you subsequently use a layout tool. In addition, you could inadvertently break the connections between shapes by moving them manually.
Reordering Subordinates
When you add a subordinate to a chart, Visio inserts the subordinate to the right
of existing subordinates in a horizontal layout or below existing subordinates in a
vertical layout. To change the order of subordinates, select the subordinate shape
you want to move, choose Organization Chart ➪ Move Subordinates, and then click
Left/Up or Right/Down. Visio moves the selected shape to the left or right in a hori-
zontal layout, and up or down in a vertical layout.

Deleting Organization Chart Shapes
You can use Cut to delete a shape as long as the shape is not linked to a database
record. To delete a shape that isn’t linked to a database, right-click the shape and
choose Cut, or select the shape and press Ctrl+X.

When a shape is linked to a database record, cutting that shape does not delete
the linked record in the database. When you want to delete a shape and its linked
database record, right-click the shape and choose Delete Shape and Record from
the shortcut menu.

Editing Organization Chart Shapes
Organization Chart shapes are still Visio shapes, so you can edit them as you
would other types of shapes. For example, you can resize a regular shape by drag-
ging its selection handles. However, because these shapes are so specialized, you’ll
use Organization Chart tools or modify custom properties to perform most editing
tasks. For example, if shapes aren’t large enough to display the information you
want, it’s easiest to specify larger shape dimensions in the organization chart
Options dialog box.

To learn more about organization chart options, see the “Setting Organization Chart
Options” section earlier in this chapter.

Editing Shape Text and Custom Properties
The text that appears in Organization Chart shapes is actually data stored in custom
properties associated with each shape. By default, the values for the Name and Title
custom properties appear in the center of a shape. (To learn how to select the fields
that appear in shapes, see the “Specifying the Fields to Display in Shapes” section
earlier in this chapter.)

You can modify organization chart custom property values in two ways: by editing
the text in the shape or by editing the values in custom properties. When shapes
are linked to database records, you can send updates from the database to Visio
shapes, or vice versa. To edit shape values, choose one of the following methods:

✦ Select a shape and begin typing to edit the name and title.
✦ Right-click a shape and choose Properties from the shortcut menu. Click a
custom property box and enter the new value.
To update a shape’s properties from a linked database record, right-click the shape and choose Refresh Shape Properties from the shortcut menu.

To update a database record from the values associated with a linked shape, right-click a shape and choose Update Database Record from the shortcut menu.

**Changing the Type of Organization Chart Shape**

Sometimes, the type of shape you dragged onto a drawing is no longer appropriate—for instance, when a person in the organization is promoted or a position becomes vacant. When this occurs, you can change the type of shape for a position by selecting a shape and choosing Organization Chart ➤ Change Position Type. Select the new position type and click OK. Because each Organization Chart shape has the same custom properties and behaviors, you don’t have to make any other adjustments.

**Working with Multiple-Page Organization Charts**

For large organizations, it’s often clearer to present portions of the organization on different pages. For example, you can show top-level executives on a summary page and include additional pages to display the organization that each executive leads. When you do this, the same employee appears on more than one page. By creating synchronized copies of these shapes, you can ensure that any text, custom properties, or subordinates that you add to a shape on one page apply to the copies on other pages.

Adding, deleting, or moving a shape, or modifying a shape’s associated layout, does not affect its synchronized copies.

To create a synchronized copy of a group or department, follow these steps:

1. Select a shape to which a group reports and choose Organization Chart ➤ Synchronize ➤ Create Synchronized Copy.
2. To create a copy on a new page, select the New Page option. To create a copy on an existing page, select the Existing Page option and choose the page from the drop-down list.
3. If you don’t want to see the subordinates on the original page after you create a synchronized copy, check the Hide Subordinates on Original Page check box.
4. Click OK to create a synchronized copy. If you create a copy on a new page, double-click the tab for the new page to rename the page.

If you add subordinates to a synchronized copy, those subordinates are initially visible only on that page. To update another synchronized copy to show the new subordinates, select that synchronized copy and choose Organization Chart ➤ Synchronize ➤ Expand Subordinates. Expanding subordinates applies to one level of subordinates for a shape, so you must expand each level that you added to a synchronized copy.
Creating Hyperlinks Between Copies

You can add hyperlinks to synchronized shapes so you can navigate more easily between them. Follow these steps to add hyperlinks to shapes:

1. Select a shape and choose Insert ➪ Hyperlink.
2. Click the Browse button next to the Sub-Address box and choose the page that contains a synchronized copy of the shape.
3. To create a hyperlink so Visio pans and zooms into a specific shape, type the shape ID into the Shape box and click OK. Visio displays the page and shape ID as a link in a shape’s shortcut menu.

Note

The shape ID is a unique name that Visio assigns. To find a shape ID, right-click a shape and choose Format ➪ Special from the shortcut menu. The shape ID appears in the Name box.

Comparing Versions of Organization Charts

When you build organization charts from imported data, you can end up with more than one version of an organization chart. You can compare versions of an organization chart and view a report of changes and then save the report. Follow these steps to compare two versions:

1. Open one of the versions of an organization chart and choose Organization Chart ➪ Compare Organization Data. If you would rather update the older version to maintain the layout and settings you have applied, open the older version.
2. Specify the file that contains the other version in the Drawing to Compare It With box. To compare only values from specific fields, click the Advanced button, delete the fields you don’t want to compare, and click OK.
3. If the version you opened is older, select the My Drawing Is Older option and click OK. Otherwise, select the My Drawing Is Newer option.
4. Review the Comparison Report that Visio displays in your browser and save it if you want to use it later.

Sharing Organization Chart Data

If your Visio organization chart is your source for information about an organization, you can share that data with others through reports or by exchanging data files. For example, you can produce a report showing employees along with other information stored in shape custom properties. If you want to provide organization chart data that someone can use in another application, you can export the data to other file formats.
To produce a report for an organization chart, follow these steps:

2. If you want to modify the report definition, click Modify and make your changes. You can choose options to specify the shapes you want to report on or define criteria that limits the report.
3. Click Run, choose the report format you want, and then click OK.

You can produce reports in Excel, HTML, Visio shapes, or XML.

You can also export organization chart data to Excel spreadsheets, text files, or comma-delimited files. To do this, choose Organization Chart ➪ Export Organization Data. Specify the folder and filename for the export file. Choose a file format in the Save As Type box and click Save. Visio exports the values stored in custom properties. It also exports the shape ID and the master shape designation so that you can use the exported file to build a Visio organization chart.

**Summary**

With the features available in the Organization Chart template, you can build and easily maintain documentation for an organization. Organization Chart shapes are smart enough to create reporting relationships when you drop one shape on top of another. However, if you already have organization chart data in another data source, you can build and update Visio organization charts automatically from that data.

To satisfy different documentation requirements, you can modify the appearance of organization charts in several ways:

✦ Specify the layout for subordinates in a group or instruct Visio to optimize layout for you.
✦ Specify the information fields that appear in organization chart shapes.
✦ Format the shapes and text styles in a chart.
✦ Distribute portions of an organization across multiple pages.

You can also share the information in your Visio organization charts by producing organization reports or data files based on Visio organization chart data.
CHAPTER

Working with Flowcharts

Many business endeavors result in diagrams documenting the flow of information or material through an enterprise. Whether you are describing the steps in a procedure, analyzing the flow of data in a business process, or showing how departments interact, Visio provides templates and tools for producing the flowcharts that describe these efforts. Flowcharts show both connections and flow between elements.

Whether you create basic flowcharts to document a procedure or develop specialized flowcharts using specific notation, in this chapter, you’ll learn how to create the types of flowcharts Visio offers. In addition, this chapter shows you how to modify flowchart contents and format them to look exactly the way you want. Because flowcharts are often quite complex, you’ll learn how to continue flowcharts onto additional pages.

Exploring Flowchart Templates

Current business practices use many specialized flowcharts for business process analysis, quality management, risk management, and other initiatives, and Visio includes templates to support many of these approaches. In fact, Flowchart templates are available within several of Visio’s template categories. In addition to the Flowchart category, you can find Flowchart templates within the Business Process, Process Engineering, and Software template categories. Even organization charts and project schedules incorporate characteristics of flowcharts.
To learn more about business process flowcharts such as Cause and Effect Diagrams, Fault Tree Analysis Diagrams, and Work Flow Diagrams, see Chapter 16.

Constructing flowcharts in Visio is quite simple. By creating your drawing with one of the Visio Flowchart templates, you can create professional-looking flowcharts using basic Visio techniques, such as dragging and dropping, connecting shapes, editing shape text, and formatting Visio elements.

Flowchart templates don’t include specialized menus, toolbars, or add-ons. You can create flowcharts by dragging and dropping shapes from stencils, connecting those shapes, and annotating and formatting your diagram.

Visio 2003 does not offer the Import Flowchart Data Wizard, which was available in Visio 2002. To import data into a flowchart in Visio 2003, you must open the file in Visio 2002, use the Import Flowchart Data Wizard in that version, save the diagram as a Visio 2002 file, and then open the flowchart in Visio 2003.

### Choosing the Right Template

Visio includes several templates for flowcharts within the Flowchart template category. These templates automatically set the page to a letter-size sheet and use inches drawn at a one-to-one scale. Visio sets the orientation depending on the template or diagram orientation that you choose. Visio 2003 has recategorized many of the Flowchart templates. Table 15-1 shows the Flowchart templates available in Visio 2003, including what they do, the template category Visio 2002 used, and the current template category for Visio 2003.

<table>
<thead>
<tr>
<th>Flowchart</th>
<th>Purpose</th>
<th>Visio 2002 Category</th>
<th>Visio 2003 Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Flowchart</td>
<td>Describe processes, document procedures, show work and/or information flow, track cost and efficiency, or document process improvements and process management in projects that use Six Sigma techniques.</td>
<td>Flowchart</td>
<td>Flowchart, Business Process</td>
</tr>
<tr>
<td>Cross-Functional Flowchart</td>
<td>Show how departments interact while executing a process.</td>
<td>Flowchart</td>
<td>Flowchart, Business Process</td>
</tr>
<tr>
<td>Flowchart</td>
<td>Purpose</td>
<td>Visio 2002 Category</td>
<td>Visio 2003 Category</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Data Flow Diagram&lt;sup&gt;a&lt;/sup&gt;</td>
<td>Document the logical flow of data through processes or procedures.</td>
<td>Flowchart</td>
<td>Flowchart, Business Process</td>
</tr>
<tr>
<td>IDEF0 Diagram</td>
<td>Model decisions, actions, and activities based on the Structured Analysis and Design Technique (SADT). See nearby note for a definition of IDEF.</td>
<td>Flowchart</td>
<td>Flowchart</td>
</tr>
<tr>
<td>SDL Diagram&lt;sup&gt;a&lt;/sup&gt;</td>
<td>Document event-driven systems such as communication and telecommunication systems and networks using the Specification and Description Language (SDL).</td>
<td>Flowchart</td>
<td>Flowchart</td>
</tr>
<tr>
<td>Audit Diagram</td>
<td>Create auditing diagrams for accounting, inventory, financial and money management, tracking fiscal information, and decision-making.</td>
<td>Flowchart</td>
<td>Business Process</td>
</tr>
<tr>
<td>Cause and Effect Diagram</td>
<td>Categorize the sources of problems and their effects on a process to help identify solutions to problems.</td>
<td>Flowchart</td>
<td>Business Process</td>
</tr>
<tr>
<td>EPC Diagram</td>
<td>Use EPC (Event-driven Process Chain) from the SAP R/3 methodology to engineer business processes as chains of functions and events.</td>
<td>Did not exist</td>
<td>Business Process</td>
</tr>
<tr>
<td>Fault Tree Analysis Diagram</td>
<td>Document events that can lead to failure to help prevent potential failures. Fault tree analysis is commonly used in Six Sigma processes.</td>
<td>Did not exist</td>
<td>Business Process</td>
</tr>
<tr>
<td>TQM Diagram</td>
<td>Document business process reengineering, continuous improvement, and quality solutions.</td>
<td>Flowchart</td>
<td>Business Process</td>
</tr>
<tr>
<td>Work Flow Diagram</td>
<td>Show the flow of information or work in processes for business process reengineering and business process automation.</td>
<td>Flowchart</td>
<td>Business Process</td>
</tr>
<tr>
<td>Brainstorming (previously Mind Mapping Diagram)</td>
<td>Documents the ideas and concepts identified during brainstorming sessions.</td>
<td>Flowchart</td>
<td>Brainstorming</td>
</tr>
</tbody>
</table>

<sup>a</sup>Available in Visio Professional only.
Visio provides shapes for methodologies such as SDL and IDEF0, but it doesn’t provide tools to ensure that you have constructed your flowcharts in accordance with the rules of those methodologies.

IDEF is an acronym of an acronym. IDEF originates from the acronym I-CAM Definition Methods. I-CAM is the acronym for Integrated Computer-Aided Manufacturing. The U.S. Air Force initiated the I-CAM project to develop methods for improving manufacturing productivity through a systematic application of rules enabled by computer technology.

### Exploring Flowchart Shapes

Many Flowchart shapes are simple shapes. They have connection points so you can connect them to other shapes, but they lack control points, custom properties, or special behaviors other than working with the automatic layout tools. However, some Flowchart shapes include additional features, several of which are described in Table 15-2.

<table>
<thead>
<tr>
<th>Stencil</th>
<th>Shape</th>
<th>Special Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Flowchart Shapes</td>
<td>Flowchart Shapes</td>
<td>Can transform into a Process, Decision, Document, or Data shape when you right-click the shape on the page and choose the type of shape you want from the shortcut menu</td>
</tr>
<tr>
<td>Cross-Functional Flowchart Shapes (Horizontal and Vertical stencils)</td>
<td>Functional Band</td>
<td>Grouped shape with text blocks for the Process name and Function name</td>
</tr>
<tr>
<td>Data Flow Diagram Shapes</td>
<td>Oval Process</td>
<td>Contains a control point in the center of the oval that you can drag to create data flows to other shapes</td>
</tr>
<tr>
<td>IDEF0 Shapes</td>
<td>Activity Box</td>
<td>Contains custom properties for Process Name, Process ID, and Sub-Diagram ID</td>
</tr>
</tbody>
</table>
Understanding Flowchart Basics

Whether you want to create a basic flowchart or a specialized diagram, you can use familiar Visio techniques to build much of your diagram. Flowchart shapes work with Visio’s automatic layout tools, so you can add and connect shapes and then let Visio arrange them for you. You can also use Visio’s annotation and formatting tools to enhance the appearance of your diagrams.

To create a flowchart, choose File➪New➪Flowchart and then choose one of the templates from the submenu, such as Basic Flowchart, Data Flow Diagram, or SDL Diagram.

Adding and Connecting Flowchart Shapes

The best method for adding and connecting shapes depends on the type of flowchart you create and the type of shapes you want to add. Because flowcharts indicate order or flow, you must take extra care to connect shapes in the proper order.

Visio Flowchart templates enable the dynamic grid by default to make it easy to position shapes relative to shapes already on your diagram. When the dynamic grid is active, Visio displays dotted lines as you drag a shape around to indicate positions that align the shape with other shapes already on the page. To align a shape, drag it and snap it to one of the horizontal or vertical dotted lines on the dynamic grid.

Tip

If you have trouble positioning shapes because of the dynamic grid, you can turn it off by choosing Tools➪Snap & Glue and unchecking Dynamic Grid under the Currently Active heading.

Adding Flowchart Shapes in a Sequence

For sequential processes, you can create a sequence by dragging the shapes onto the page in order, or you can specify the sequence after you add shapes to the diagram. Create a sequence of shapes using one of the following methods:

✦ Dragging — When you already know the sequence of steps, the Connector tool is the easiest way to define that sequence. Click the Connector tool on the Standard toolbar. As you drag shapes onto the page, Visio connects the new shape to the shape you added previously with a shape-to-shape connection.

To learn more about all the methods for connecting shapes, refer to Chapter 5.

✦ Selecting a Sequence — If you plan to work out the sequence by analyzing the shapes on your diagram, you can add shapes to the page and then use the
Connect Shapes command to create a sequence. Follow these steps to create a sequence out of shapes already on the page:

1. Drag all the shapes in the sequence onto the page.
2. After you determine the correct sequence, select each shape in order and then choose Shapes ➪ Connect Shapes. Visio connects the shapes in order using shape-to-shape connections. Visio does not rearrange the shapes when it connects them.
3. If the layout is difficult to read, rearrange the layout by choosing Shapes ➪ Lay Out Shapes, specifying the layout options you want, and clicking OK.

If your flowchart shapes don’t contain numbering, you can use the Number Shapes command to add numbering. To learn how to use this tool, see Chapter 7.

Connecting Nonsequential Shapes

For processes that don’t flow directly from start to finish, it’s easier to drag shapes onto the drawing page, and then use the Connector tool to connect them. For example, Decision shapes connect to one other shape for each possible outcome of a decision. You don’t want Visio to automatically connect Decision shapes with shape-to-shape connections because switching connection points can modify the decision.

To create a nonsequential flowchart, use the following methods to connect shapes:

- **Processes** — Connect process shapes or other shapes for which the connection points don’t matter using shape-to-shape connections. Click the Connector tool on the Standard toolbar and position the pointer within the predecessor process. When Visio highlights the shape with a red box, drag to a position within the successor process.

  **Tip**

  If process shapes are small, Visio highlights connection points instead of an entire process box. In this case, you can also create shape-to-shape connections by pressing the Ctrl key while using the Connector tool.

- **Decisions** — Use the following steps to connect a decision shape to its potential outcomes, as illustrated in Figure 15-1.

  1. With the Connector tool active, drag from a connection point on the Decision shape to a position within the process that represents one outcome. When Visio highlights the process with a red box, release the mouse button.
  2. Double-click the connector to edit the text box for that line and type a description or reference for the decision that leads to that outcome.
  3. Repeat steps 1 and 2 for each additional outcome.
Modifying Flowcharts

You don’t need special techniques to modify flowcharts. You can rearrange, annotate, and format your diagrams with any of the following methods:

✦ **Annotate Shapes and Connectors** — To add descriptive text to your steps, select a shape or connector and type the text you want.

   To learn about other ways to annotate diagrams, see Chapter 6.

✦ **Rearrange Shapes** — You can manually rearrange individual shapes and connectors or use Visio’s automatic layout tools:

   • **Move Individual Elements** — To manually rearrange shapes, drag shapes you want to move to new locations. To manually modify connector paths, drag green vertices on connectors to new locations.

   • **Automatically Layout Shapes** — To use Visio’s layout tools to automatically lay out your diagram, choose Shapes ➤ Lay Out Shapes and select the options you want. Note that using automatic layout overwrites any manual arrangement you have performed.
Reverse Direction of Flow — To change the direction of flow between two steps, select the connector between the steps and choose Shape ▶ Rotate or Flip. Choose Flip Horizontal for a horizontal connector, or Flip Vertical for a vertical connector.

Formatting Flowcharts
You can modify the appearance of individual shapes and connectors or your entire diagram using the following formatting tools:

Format Shapes and Connectors — You can modify the formatting for individual shapes and connectors by right-clicking a shape or connector, choosing Format, and choosing Line, Fill, or Text from the shortcut menu.

Many of the shapes on Flowchart stencils use predefined styles. You can apply formatting to individual shapes and connectors to emphasize specific steps, but you should use special formatting sparingly to keep your diagrams neat and consistent.

Apply Styles to Shapes and Connectors — Modify line, text, and fill formatting consistently by applying styles to shapes and connectors. To do so, right-click a shape or connector and choose Format ▶ Style from the shortcut menu. To redefine the formatting for a style, choose Format ▶ Define Styles, select the style you want to change, and select new formatting options.

Add a Background — To add a background to a flowchart page, drag a background shape from the Backgrounds stencil onto the page. Visio automatically creates a new page for the background and associates it with the current foreground page.

If the Flowchart template you’re using doesn’t open the Backgrounds stencil, choose File ▶ Shapes ▶ Visio Extras ▶ Backgrounds.

Apply a Color Scheme — To apply a consistent and coordinated set of colors to the shapes on your drawing, right-click the drawing page and choose Color Schemes from the shortcut menu.

Add a Border and Title — To add a border or title to identify your diagram, drag a border or title shape from the Borders and Titles stencil.

To learn about applying formatting, using styles, and applying color schemes, see Chapter 7. To learn about borders and titles, see Chapter 6. For more about working with background pages, see Chapter 2.

Creating Multiple Page Flowcharts
Complex processes typically require multiple pages to show all their steps. Flowcharts can also include a process summary on one page and show detailed steps for each high-level process on other pages. For these situations, you can use
On-page and Off-page reference shapes to indicate that your flowchart continues elsewhere on the diagram.

The Data Flow Diagram and IDEF0 Diagram templates do not contain On-page and Off-page reference shapes. To add these shapes to those drawing types, choose File ➪ Shapes ➪ Flowchart ➪ Basic Flowchart Shapes and drag the shapes onto the page.

The On-page reference shape creates a visual link between two steps on the same page. To create on-page references, follow these steps:

1. Drag an On-page reference shape onto the drawing page near the end of the main procedure.
2. Select the On-page shape and type a number or letter to label the reference.
3. Press Ctrl+C to copy the on-page reference to the Windows Clipboard.
4. Press Ctrl+V to paste a copy on the drawing page.
5. Drag the copy to the position where the procedure continues on the page.

Tip
To connect an on-page reference to the Flowchart shape to which it refers, click the Connector tool on the Standard toolbar and then drag between connection points on the on-page reference and the Flowchart shape.

When you want to continue your flowchart on another page, you can create a reference to a new or existing page with an Off-page reference shape. You can add an off-page reference to the second page, synchronize the text on both reference shapes, or add hyperlinks so you can easily switch from one page to the next, as shown in Figure 15-2.

Figure 15-2: Synchronize off-page references or add hyperlinks to simplify navigating between them.
To create off-page references, follow these steps:

1. Drag the Off-page reference shape from the stencil onto the page near the last shape on that page. Visio displays the Off-page Reference dialog box and selects the New Page option by default.

2. To add off-page references to both the current page and a new page, make sure the New Page option is selected. You can rename the new page by typing a new name in the Name field. To create the off-page reference on an existing page, select the Existing Page option and then choose the page on the drop-down list.

3. If you don’t want Visio to create an off-page reference on the other page, uncheck the Drop Off-Page Reference Shape on Page check box in the dialog box that appears after your reference is dragged over.

4. To synchronize the labels on corresponding off-page references, check the Keep Shape Text Synchronized check box.

5. To create a hyperlink between the two Off-page references, check the Insert Hyperlinks on Shape(s) check box.

   **Tip**

To navigate between the pages of the flowchart, double-click an Off-page reference shape with a hyperlink to another off-page reference.

---

**Working with Cross-Functional Flowcharts**

Cross-functional flowcharts show the steps in a process along with the departments that contribute to the execution of those steps. The flowchart includes steps, just as a basic flowchart does, but you denote the participation of departments by stretching a shape that represents a process across horizontal bands on the diagram that represent each participating department.

**Setting Up Cross-Functional Flowcharts**

When you create a new cross-functional flowchart, you can choose between a horizontal or vertical orientation. The Cross-Functional dialog box provides for only five functional bands, but you can create as many as you want after you create the initial diagram. To create a cross-functional flowchart, follow these steps:

2. Select Horizontal or Vertical to specify the orientation and then type a number from 1 to 5 to specify the number of departments. If you choose the horizontal orientation, Visio changes the page orientation to landscape.

   You can’t change the cross-functional flowchart orientation once you have selected one.

3. To include a title bar for the diagram, check the Include Title Bar check box.

4. Click OK to create the diagram. Visio adds the number of bands you specified to the diagram and opens the Arrow Shapes stencil, the Basic Flowchart Shapes stencil, and the Cross-Functional Flowchart Shapes stencil for the orientation you chose.

5. To label the flowchart or any of the bands, select the shape you want to label and type the label text.

---

**Adding Processes to Cross-Functional Flowcharts**

Creating steps for a process in a cross-functional flowchart is no different than creating a basic flowchart. You drag and connect shapes to represent the process steps. To indicate that a step crosses departments or functions, resize the shape for that step so that it spans the participating departments. Use the following methods to add processes and steps to a cross-functional flowchart:

- **Add Process Steps** — Drag Flowchart shapes from the stencil onto the page as you would for a basic flowchart. Use any of the basic methods for connecting those shapes to define your process.

- **Label Process Steps** — Select a shape and type the process description.

- **Associate Departments with Steps** — Drag a selection handle on a shape for a process until it spans the departments that participate in the process, as shown in Figure 15-3.

   You can’t split a process into multiple pieces to associate it with departments whose functional bands are not coincident in the diagram. However, you can show functional bands in a different order on each page. If several steps in a process relate to the same departments, you can show those steps on another page and rearrange the functional bands to co-locate those departments.
Working with Functional Bands

You can add, remove, edit, or rearrange the functional bands on a cross-functional flowchart. When you move or reorder the bands on a diagram, Visio moves the steps along with the bands, which can result in messy connections. You can drag the green vertices on connectors to reorganize the paths between steps. Use the following methods to modify the functional bands in a cross-functional flowchart:

✦ **Add a Functional Band** — Drag a functional band shape from the stencil to an approximate vertical position on the page. Visio snaps the functional band into place, aligning the band horizontally with the other bands. To add a functional band above another band, position the pointer within or slightly above the existing band. To label the band, select the label text and type the department or function name.

If you insert a functional band between two shapes that share a step, Visio resizes the step to span all three bands.

✦ **Remove a Functional Band** — Select the label of a functional band and then press Delete.

When you delete a functional band, Visio also deletes any shapes within that band, without requesting a confirmation. If you inadvertently delete shapes you want to keep, press Ctrl+Z to undo the deletion. Move the shapes to other bands and then delete the functional band.

✦ **Resize a Functional Band** — To resize a band, select the band and then drag one of the selection handles until the band is the width you want. For example, to change the width of a vertical band, drag a selection handle on either
side. To change the height of a horizontal band, drag the top or bottom selection handle.

✦ Change the Length of All Bands—Select the border or title of the cross-functional flowchart to display the selection handles for the chart group. Drag a selection handle until the bands are the length you want.

✦ Move a Band—To change the order of bands, select a band and drag it to a new location. Visio moves or resizes any shapes wholly or partially contained within the band.

✦ Move a Shape to Another Band—Drag the shape to another band. If you want to associate a shape with multiple bands, drag a selection handle on the shape until it spans all the bands to which it relates.

Identifying Process Phases
You can specify phases in a process with a Separator shape. When you add a separator to a flowchart, Visio associates the steps that follow the separator with that phase. On vertical cross-functional flowcharts, separators are horizontal; for horizontal flowcharts, they are vertical.

To add a separator to a flowchart, drag the Separator shape from the stencil onto the page. Select the separator and type a description for the phase. When you move a separator, Visio moves all the steps in that phase. To move a separator without moving the steps, delete the separator and add a new one in the new location.

Creating Other Types of Flowcharts
Visio provides templates for data flow diagrams, IDEF0 diagrams, and SDL flowcharts. Although the Visio stencils contain shapes for these methodologies, Visio does not verify that your diagrams follow the rules underlying the Gane and Sarson data flow diagram, IDEF0, and SDL methodologies.

Creating Data Flow Diagrams
You can create flowcharts that document the flow of data between processes and data stores using two different templates:


✦ Data Flow Model Diagram—To create a data flow model based on the Gane and Sarson symbology, choose Data Flow Model Diagram within the Software template category. Visio opens the Gane and Sarson stencil.
Part III ✦ Using Visio for Office Productivity

Note


Adding Data Flow Shapes
Drag the following types of shapes onto your diagram to document the elements of your process:

- **External Interactor** — An external source or destination for data
- **Process** — A process that transforms data in some way
- **State** — A state achieved during a process
- **Data Store** — A source or destination for data that is internal to the process
- **Entity** — An entity that performs a process
- **Entity Relationship** — A shape that indicates the relationship between entities
- **Oval Process** — A Process shape that contains a control point you can use to create multiple data flows from the process

Showing Flow Between Shapes
You indicate flow on a data flow diagram with Center to Center shapes. To create a data flow, follow these steps:

1. Drag a Center to Center shape onto the page near the two shapes between which data flows.
2. To change the direction of the flow, choose Shape ➤ Rotate or Flip, and then choose Flip Horizontal or Flip Vertical.
3. Glue the end points of the Center to Center shape to the connection points at the center of each of the other shapes. Visio highlights the end points with red squares when the shapes are connected.
4. To change the curvature of the data flow arrow, drag the green selection handle in the middle of the arc to a new location. To change the location of arrows, drag one of the control handles.

Showing a Data Loop
To indicate a loop in the process, follow these steps:

1. Drag a Loop on Center shape onto the page until Visio displays a red square around the connection point on the process that loops.
2. To change the size or position of the loop, drag the end point. To change the location of the ends of the loop, drag the control handle and the selection handle.
Creating IDEF0 Diagrams

The IDEF0 communication methodology uses context diagrams, parent/child diagrams, and node trees to model business and organizational processes. Context diagrams are high-level diagrams that show activities and external interfaces. IDEF0 node trees show an entire decomposition in one diagram. Parent/child diagrams illustrate the relationships between processes.

To learn about the IDEF0 methodology, navigate to www.idef.com.

Creating Context Diagrams

Context diagrams show the relationships between activities. To create a context diagram, drag activity boxes onto the page and type the process name and process ID in their corresponding fields in the Custom Properties dialog box. If the process is a decomposition, also type the ID for the decomposition diagram in the Sub-diagram ID field. You use the 1-legged Connector shape to connect activities to external interfaces. To add purpose and viewpoint statements to the diagram, drag 8 Pt Text Block shapes onto the page and type the text you want.

Creating Parent/Child Diagrams

Parent/child diagrams also show activities and connections. On these diagrams, you can use the IDEF0 connector to create a variety of connections between processes. After adding parent and child processes, choose one of the following methods to connect the process on your diagram:

♦ **Joined Arrows** — Drag one IDEF0 connector between connection points on two activity boxes. Drag a second IDEF0 connector onto the page and glue one end to a connection point on another activity box. Drag the free end of this connector so its arrowhead overlaps the first connector’s arrow.

♦ **Forked Arrows** — Drag one IDEF0 connector between connection points on two activity boxes. Drag a second IDEF0 connector onto the page and overlap its start point with the start point of the first connector. Glue the other end of the second connector to another activity box.

♦ **Branching Arrows** — Drag one IDEF0 connector between connection points on two activity boxes. Select the connector, press Ctrl, and drag a copy of the connector to create a branch. Press F4 to create additional branches. Connect the end points of the branches to the appropriate activity boxes.

To align the branches, connect the beginning points of all the branches. You can drag the control handle on each branch to reposition the middle leg of each branch.
Creating a Node Tree
To create a node tree, follow these steps:

1. Drag a node onto the page and type the node number or name of the node for
   the root of the tree in the Custom Properties dialog box.
2. Drag a Solid Connector shape onto the page and glue an end point to the
   connection point at the center of the node. Drag the other end point until
   the connector is the length and direction you want.
3. Repeat step 2 until you have created the branches you need to connect nodes
   to the top node.
4. Drag Node shapes onto the page and glue their centers to the open ends of
   the branches.
5. Repeat steps 2, 3, and 4 for each level of the tree.

Tip
Add a hyperlink between a node and the page that contains process details when
you want to quickly view the details associated with a node.

Creating SDL Flowcharts
SDL flowcharts use shapes and connectors based on International
Telecommunications Union standards to illustrate communications and telecommu-
nications systems networks. These shapes are similar to other types of flowchart
shapes, including procedures and decisions. Some include control points that you
can use to modify the position of dividers within the shapes.

Cross-Reference
To review the SDL specifications, navigate to http://iis-web.coloradotech.edu/bsanden/CS670/SDL.pdf.

Summary
You can create any type of Visio flowchart by dragging shapes onto the page and
then connecting them. Although many flowchart shapes contain only selection
handles for resizing, several include control points that you can use to modify the
shapes or create additional connectors. You can use standard techniques to anno-
tate and format flowcharts. For multiple-page diagrams, you can continue processes
on other pages by adding Off-page reference shapes. You can quickly jump from the
main process to the continuation by adding hyperlinks between the reference shapes.

Cross-functional flowcharts have a few additional behaviors. On these flowcharts,
you can associate processes with one or more departments or functional bands. As
you add, move, or delete functional bands, Visio modifies the processes to maintain
the connection between the steps and departments.
Documenting Business Processes

Most organizations today look to business process improvement methodologies, such as Total Quality Management and Six Sigma, to improve results such as quality, customer satisfaction, profits, and competitive edge. These business methodologies model processes in different ways to highlight potential problems or opportunities for improvement.

Whether you’re documenting and analyzing current processes or engineering process improvements, this chapter will show you how you can use specialized shapes in Visio’s Business Process templates to construct the diagrams you need. Although you have to know how to represent your business process information in a specific type of diagram before you begin your Visio session, you can still use standard Visio techniques to produce your documentation.

Working with Business Process Templates

Business Process templates don’t include specialized menus, toolbars, or add-ons. You can create business process flowcharts as you do any flowchart, but you use specialized Business Process shapes to create different types of diagrams. Business Process templates automatically set the page to a letter-size sheet, with the orientation depending on the template you choose. As with other flowcharts, Visio uses inches drawn at a one-to-one scale. The templates open the Backgrounds and Borders and Titles stencils so you can annotate and format your diagrams.

In This Chapter

Working with the Audit Diagram template
Creating Cause and Effect diagrams
Working with EPC diagrams
Creating Fault Tree Analysis diagrams
Understanding TQM diagrams
Using Work Flow diagrams
Adding data to Flowchart shapes
Adding custom properties to Flowchart shapes
Generating custom property reports
To learn about basic techniques for building flowcharts as well as more information about basic flowcharts, data flow diagrams, and cross-functional flowcharts, see Chapter 15.

Basic Flowchart, Data Flow Diagram, and Cross-Functional Flowchart templates appear in both the Flowchart and Business Process template categories, but they are identical, no matter which category you select when you create your drawing.

**Audit Diagrams**

Audit diagrams document processes, including accounting, bookkeeping, inventory, and other types of financial transactions. For example, you can model the process for an online stock trade to ensure that checks and balances are in place to satisfy the Securities and Exchange Commission.

The Audit Diagram template opens several stencils, including the Audit Diagram Shapes stencil, with shapes for processes, operations, documents, and data repositories, as well as basic flowchart shapes such as On-page and Off-page references and connectors. You can use Tagged Process and Tagged Document shapes to mark the process elements that you want to research further. After adding Tagged shapes to the page, right-click a Tagged shape and choose Tagged or Untagged from the shortcut menu to toggle the Tagged setting.

**Cause and Effect Diagrams**

Cause and effect diagrams document potential and real factors that produce an effect. By arranging these factors or causes by their level of importance or detail, cause and effect diagrams can help you identify root causes or problem areas, and can show the priority of different causes that lead to an effect. These diagrams are also called fishbone diagrams because they resemble a fish’s skeleton, with main causes shown as the bones that attach to the “spine” of the fish. They are also called Ishikawa diagrams, after their creator, Dr. Kaori Ishikawa, who initiated a well-known approach to quality management in the Kawasaki shipyards.

In quality management, you typically create a cause and effect diagram after investigating the problems associated with a product or service and ranking them in a Pareto chart (also known as an 80-20 chart). You use the effect ranked highest in the Pareto chart as the starting point for your cause and effect diagram. For example, when you determine that the most frequent customer complaint is late delivery, you can construct a cause and effect diagram to explore the reasons for this.

When you create a new drawing with the Visio Cause and Effect Diagram template, Visio opens a new page and automatically adds an Effect shape for the effect you are studying, and four Category boxes to classify the causes on your drawing. The template also includes shapes for primary and secondary causes, which you can use to add more detail.
Causes are frequently grouped into four major categories. You can choose your own categories to suit your study or choose one of two sets: Manufacturing, including manpower, methods, materials, and machinery, or Service, including equipment, policies, procedures, and people.

To create a cause and effect diagram, follow these steps:

2. To specify the effect you're studying, select the horizontal arrow on the page and type text describing the effect or problem.
3. To create the cause categories you want, use one of the following methods:
   - **Add a category** — Drag a Category 1 or Category 2 shape onto the page and position it so the arrowhead touches the horizontal arrow of the Effect shape. Visio automatically glues the Category shape to the geometry of the Effect shape.
   - **Delete a category** — Select a Category shape and press the Delete key.
   - **Move a category** — Drag a Category shape to the new location until it snaps to the geometry of the Effect shape.
4. For each Category shape on the page, select the shape, and type the name of the cause category that you want to appear as text in the shape box.
5. To show major causes in a category, drag Primary Cause shapes onto the page until the arrowheads snap to category lines, as shown in Figure 16-1.

![Figure 16-1: Cause and Effect shapes snap anywhere on shape geometry.](image)

The only differences between the two versions of primary and secondary cause shapes are the direction of the line and the location of the text relative to the line.
6. To illustrate secondary causes that contribute to primary causes, drag Secondary Cause shapes onto the page until the arrowheads snap to primary cause lines.

7. For each cause, select the shape, and type a description of the cause.

**Tip**

If text in Cause shapes overlaps on the page, click Align Left or Align Right on the Formatting toolbar to reposition the text in the text boxes within Cause shapes. You can also distribute the text over several lines by adding line breaks. To do this, select the Text tool, click the text, and press Ctrl+Enter.

---

**Event Process Chain (EPC) Diagrams**

EPC diagrams are part of the SAP R/3 modeling methodology for business engineering. EPC diagrams illustrate business process work flows by showing the transfer of control in processes as a chain of events and functions, as demonstrated in Figure 16-2.

**Figure 16-2:** EPC diagrams use events and functions to show flow.

You can use the following types of shapes to produce an EPC diagram:

- **Functions** — Represent processes or activities, such as creating forms or checking inventory
- **Events** — Trigger functions or are the result of functions. In EPC modeling, events also represent process states, such as Order Form Created.
- **Organizational Units** — Indicate the part of the organization responsible for a process or activity
✦ Information/Material — Represent data elements such as forms or data records

✦ Logical Operators — Specify how events and functions interact. For example, the AND operator indicates that both events must occur to trigger a function, whereas the exclusive OR (XOR) operator specifies that the occurrence of only one of the events triggers the function. An OR operator indicates that the occurrence of any or all of the events triggers the function.

✦ Connectors — Show the relationships between the components on the diagram

Fault Tree Analysis Diagrams

Fault tree analysis studies the events that can lead to failure in an effort to prevent failures from occurring. Fault tree analysis diagrams are frequently used in the Analyze phase of the Six Sigma business improvement process. Fault tree diagrams use a top-down structure to represent the routes within a system that can lead to a failure, as shown in Figure 16-3. You can use logical operators to interconnect events or conditions that contribute to a failure. By analyzing the factors that lead to failure, you can prevent failures by eliminating their causes.

Figure 16-3: Fault Tree Analysis diagrams show the events that can lead to failure.
Bell Telephone Laboratories developed fault tree analysis in 1962 for the U.S. Air Force so they could analyze the Minuteman system.

To create a fault tree diagram, follow these steps:

2. From the Fault Tree Analysis Shapes stencil, drag the Event shape to the top of the drawing page. With the shape selected, type the description of the failure.
3. Drag a Gate shape, such as the AND or OR gate, onto the page directly below the top event.
4. Drag additional Event and Gate shapes onto the page and position them from the top down to identify potential causes of the failure represented by the top-level event.
5. Connect the shapes using the Connector tool.

**TQM Diagrams**

TQM is a structured approach to business process improvement that focuses on building quality into products and services from the beginning. All employees and departments participate, from top-level management on down. The TQM Diagram template includes shapes and connectors for creating flowcharts for Total Quality Management projects.

**Six Sigma Templates**

Six Sigma projects include phases for defining, measuring, analyzing, improving, and controlling processes. You can use a Visio DMAIC Flowchart template, available on Microsoft Office Online, to document requirements and steps for a Six Sigma project. When you create Visio diagrams or other documents as part of your project, you can link these documents directly to the DMAIC diagram to keep your project information organized.

The DMAIC Flowchart template includes an overview page and two additional pages for drilling down. Each page includes shapes to get you started. The quickest way to find the DMAIC template is by using the Search drop-down list on Microsoft Office Online; from this list choose Templates and then type DMAIC in the Search For box. Click the button with the green arrow. Click the link for the DMAIC flowchart with the units you want and then click the Download Now button. After downloading and opening the template, learn how to use it by clicking the Using This Template link in the Template Help Task Pane.
**Work Flow**

Work flow diagrams are high-level flowcharts that show the interactions and flow of control for business processes. The Workflow Diagram Shapes stencil includes shapes that represent different departments and personnel. For example, it includes shapes such as Accounting, Information Systems, and Shipping. It also includes shapes for generic employees, such as Person 1, and specific roles, such as Treasurer. You can use basic Visio techniques to develop these diagrams.

**Estimating and Reporting with Flowcharts**

In addition to graphically depicting business processes, Visio flowcharts can also store data about the processes they represent. Many flowchart shapes contain custom properties for cost, duration, and resources. By adding data to these fields for each step in a process, you can produce reports or compute estimates or results automatically. For example, when you add cost, duration, and resources involved for each step in your organization’s current and proposed procurement processes, you can produce reports that show the potential cost and time savings from implementing the new process.

**Adding Data to Flowcharts**

Many flowchart shapes include predefined custom properties for Cost, Duration, and Resources. You can view and enter data in these fields as you would for any other custom property. You can also add custom fields to Flowchart shapes to support additional requirements for a special project.

To add data to Flowchart shapes, follow these steps:

1. Choose View ➪ Custom Properties Window.
2. Select a shape to which you want to add data.
3. In the Custom Properties window, click a field and type the data for that field for the selected shape. Repeat this step for each field you want to analyze or track.

   **Note** If a shape has no custom properties, the words "No Custom Properties" appear in the Custom Properties window. You can also access custom properties by right-clicking a shape and choosing Properties from the shortcut menu.

4. To add data to other shapes, repeat steps 2 and 3 for each shape.
5. After adding data to the shapes you want, close the Custom Properties window by clicking the Close button.
Adding Custom Properties to Shapes

You can add custom properties to shapes to track other types of data or to add custom properties to shapes that don’t include them, such as Cause and Effect shapes. For example, if you’re evaluating outsourcing opportunities, you can track the number of employees with general skills involved in each step of a process.

To learn more about creating custom properties, see Chapter 32.

To add custom properties to an existing flowchart master, follow these steps:

1. With the flowchart open, choose File ➪ Shapes ➪ Show Document Stencil. Visio opens the Document stencil, which contains master versions of the shapes you have used in your diagram. By adding custom properties to these masters, you can add the custom properties to all corresponding shapes in your drawing.

2. To add custom properties to a shape, right-click it in the Document stencil and choose Edit Master ➪ Edit Master Shape. Visio opens the master window and zooms into the shape so it’s easier to edit.

3. Right-click the master in the master drawing window and choose Properties from the shortcut menu. In the Custom Properties dialog box, click Define.

4. Click New. In the Define Custom Properties dialog box, specify the fields and options you want for the new custom property. To add another custom property, click New again.

5. When you’re finished adding custom properties, click OK. Your new properties appear in the Custom Properties dialog box. Click OK again.

6. Click the Close button for the master drawing window to return to the flowchart. When prompted to update the master and all of its instances, click Yes.

7. Repeat steps 2 through 6 for each master to which you want to add new property fields.

8. When you’re finished adding custom properties to masters, right-click the title bar of the Document stencil, choose Close, and save the flowchart.

Generating Reports with Custom Property Data

After you add data to your Flowchart shapes, you can produce inventories or lists, such as the types of job skills used in a process. You can also generate reports that calculate process statistics or total values so you can estimate costs or durations.
To learn more about producing reports using custom properties, see Chapter 32.

You can use the Database Export Wizard to transfer the data stored in your flowchart into a database. To learn more about exporting data to a database, see Chapter 10.

**Summary**

Visio’s Business Process templates help you construct diagrams based on several popular methodologies for business process improvement, such as Six Sigma. You need to know how to document business processes using the different types of diagrams, such as Cause and Effect or Fault Tree Analysis, but you can use standard Visio techniques to produce your drawings. The Basic Flowchart, Data Flow Diagram, and Cross-Functional Flowchart templates appear in both the Business Process and Flowchart categories, but they are identical.

You can create, edit, annotate, and format business process flowcharts as you do their more generic cousins. For multiple-page diagrams, you can continue processes on other pages by adding Off-page reference shapes or by adding hyperlinks between reference shapes to navigate between the main process and continuations. By using the custom properties associated with many Flowchart shapes, you can also estimate costs, durations, and other measures for your organization’s processes.
Scheduling Projects with Visio

Projects are endeavors that have a definite beginning and ending—typically, special initiatives that are distinct from routine operations of an organization. Projects don’t just happen on their own; they take conscientious planning and tracking. Project managers monitor and control tasks, schedules, resources, and budgets to ensure that projects achieve their goals. Typically, project managers use software such as Microsoft Project to build and track project plans, maintain the database of project information, and perform calculations.

Although Visio is not a project management tool, you can develop project-related diagrams with it to communicate project plans and status. You can also use the Timeline, Gantt Chart, and PERT Chart templates to build and report on very simple projects. Whether you’re managing a project or creating a calendar to track your kids’ school activities, the Calendar template provides shapes to construct calendars that span one day to several years.

In addition to building project management diagrams by dragging and dropping shapes, you can also import data from Microsoft Project or other applications into Visio diagrams. If you develop a prototype schedule in Visio, you can also jumpstart projects by exporting your schedules to Microsoft Project.

In this chapter you learn how to work with the Visio Calendar, Timeline, Gantt Charts, and PERT Chart templates to effectively represent your projects and other time-sensitive information.
Exploring the Project Scheduling Templates

In Visio 2003, four project-related templates present project and date-related information in distinct ways. Each template automatically sets the page to a letter-size sheet with landscape orientation, and uses inches drawn at a one-to-one scale. Use the template that corresponds with the type of information you want to convey:

- **Calendar**—Create calendars for projects as well as other purposes showing days, weeks, months, or years. Add reminders, meetings, special events, milestones, and more. The template includes the Calendar Shapes stencil and the Calendar menu.

- **Timeline**—Provides a set of dated timeline shapes that show events along a horizontal or vertical timeline. There are also shapes for milestones and intervals. The Timeline template includes the Timeline Shapes, Background, and Borders and Titles stencils, along with the Timeline menu.

- **Gantt Chart**—Drag shapes onto a page to create Gantt charts and import data from Microsoft Outlook or Microsoft Project. The Gantt Chart template includes the Gantt Chart Shapes, Background, and Borders and Titles stencils, along with the Gantt Chart menu and toolbar.

- **PERT Chart**—Provides a pair of PERT (Program Evaluation and Review Technique) Chart boxes, or nodes, to show the interdependencies between tasks without taking timing into account. There are shapes for node connectors, callouts, and legends. The PERT Chart template includes the PERT Chart Shapes, Background, and Borders and Titles stencils.

To create a drawing using one of the project scheduling templates, choose File ➪ New ➪ Project Schedule and then choose Calendar, Gantt Chart, PERT Chart, or Timeline. To use one of the project scheduling stencils in a different template, choose File ➪ Shapes ➪ Project Schedule and then choose the stencil you want. Visio adds the appropriate menu to the Visio menu bar when you drag a shape from one of the template stencils onto the drawing page.

Constructing Calendars

Use the Calendar template to create daily, weekly, monthly, or yearly calendars. You can add appointments, events, or project tasks to calendar days, which are then associated with the calendar dates. With calendar art, you can highlight special dates. You can create calendars by creating a new Visio drawing using the Calendar template or by opening the Calendar Shapes stencil. By specifying a language for the calendar, you set the date formats for your calendars.

With Visio 2003, you can now import appointments and other schedule information from your Microsoft Outlook Calendar (see the “Importing Outlook Calendar Data into Visio” section later in this chapter).
Creating Daily Calendars

You can create a calendar consisting of a single day or multiple nonconsecutive days. You could create a calendar of nonconsecutive days to show meetings or events that always occur on Tuesdays and Thursdays, for example. To create a calendar of selected days, follow these steps:

1. Drag the Day shape onto the drawing. The Configure dialog box appears.
2. Enter the date and the date format (if necessary) and then click OK. You can also change the date format by choosing another language. For example, if you choose French (Canadian), the date format changes to yyyy-mm-dd.
3. Repeat steps 1 and 2 for each day you want in your calendar.
4. Resize and move the Day shapes into the size and position you want. To change the date or date format in a Day shape after you’ve created it, select the shape and then choose Calendar ➪ Configure.

Creating Weekly Calendars

To create a weekly calendar, follow these steps:

1. Drag the Week shape onto the drawing. The Configure dialog box appears.
2. In the Start Date box, enter the date for the beginning of the week.
3. In the End Date drop-down list, select the number of days for the week and the resulting end date.
4. Specify the date format, language, whether you want the weekend to be shaded, and whether you want to show the title of the week (for example, “Week of July 12, 2004”).
5. To add additional weeks, repeat steps 1 through 4.
6. Resize and move the week shapes into the size and position you want.

Tip

Rather than add multiple individual weeks, you can create a multiweek calendar for consecutive weeks. Drag the Multiple Week shape onto the drawing. In the Configure dialog box, specify the start and end dates and any other calendar formatting options, and then click OK.

Creating Monthly Calendars

You can create a single-month or multimonth calendar. To create a monthly calendar, follow these steps:

1. Drag the Month shape onto the drawing. The Configure dialog box appears.
2. Enter the month and year for the calendar.
3. Select the day on which the weeks should begin in the Begin Week On drop-down list.

4. Specify the language if necessary, whether you want the weekends to be shaded, and whether you want to show the title of the month (for example, “August 04”).

5. If necessary, resize and move the Month shape into the size and position you want. By default, it fills the page.

   **Tip**

   You can add previous and next month thumbnails to a Month calendar. Drag the Thumbnail Month shape to the position you want in your Month calendar. In the Custom Properties dialog box, enter the month and year and then click OK.

6. To add additional months, add a new page by choosing Insert ➪ New Page and then clicking OK in the Page Setup dialog box. Repeat steps 1 through 5 to set up the month on the new page.

   **Tip**

   To show the phases of the moon, drag the Moon Phases shape onto a day of the month. Right-click the shape and choose New Moon, First Quarter, Last Quarter, or Full Moon.

---

### Creating Yearly Calendars

You can create a yearly calendar on a single page, or a multiyear calendar across multiple pages in your drawing. To create a yearly calendar, follow these steps:

1. Drag the Year shape onto the drawing. The Custom Properties dialog box appears.

2. Enter the calendar’s year, the day on which the weeks should begin (that is, Sunday or Monday), the language if necessary, and then click OK.

3. If necessary, resize and move the Year shape into the size and position you want. By default, it fills the page.

4. To add another year to the drawing, add a new page by choosing Insert ➪ New Page and then clicking OK. Repeat steps 1 through 3 to set up the year on the new page.

   **Tip**

   You might find the Year shape better suited to a portrait page orientation than the default landscape orientation. Choose File ➪ Page Setup and then select the Print Setup tab. Under Printer Paper, select Portrait and then click OK.
Exploring Calendar Art Shapes

The Calendar Shapes stencil includes a number of shapes, or calendar art, that you can use to enhance or visually categorize appointments and events. You can use shapes such as Clock or Meeting to flag appointments and events by category. Shapes such as Important, Idea, and To Do can emphasize calendar items. You can also highlight travel days with shapes, such as with Travel-Air. Shapes such as Birthday or Sports can enhance the appearance of your calendar in addition to reminding you of these types of activities. You can also add shapes, such as Milestone or Completion, for example, to make important project dates stand out.

Note
Calendar art is associated with the day, but not the date, to which you add it. This means if you change the date, the calendar art does not move to the new date.

Working with Calendars

After you’ve created a calendar, you can modify it in various ways:

✦ **Change dates or format settings** — Select a calendar and choose Calendar ➤ Configure.

✦ **Change colors** — You can change the color of a Calendar shape — for example, an individual day in a monthly calendar or the title area of a weekly calendar. Right-click the area whose color or pattern you want to change and choose Format ➤ Fill from the shortcut menu.

✦ **Change the color scheme** — To change a calendar’s entire combination of color, right-click an empty area of the drawing page outside the Calendar shape itself. From the shortcut menu, choose Color Schemes, select the color scheme you want, and click Apply or OK.

To learn more about working with color schemes, see Chapter 7.

Cross-Reference

✦ **Change the calendar title** — Double-click the calendar’s title and then type the text you want. When you’re finished, press Esc. To change the title for a year calendar, right-click the calendar and then choose Configure from the shortcut menu. Enter a year in the Year box and then click OK.

Working with Appointments and Events

After you’ve created a calendar, you can add appointments, such as meetings or classes, and events, such as conferences, as shown in Figure 17-1. Appointments and events are associated with the calendar dates you specify, so they move to the new dates automatically if you change the dates on which they occur.
✦ **Add an appointment**— Drag the Appointment shape onto a calendar day. In the Configure dialog box, enter the start and end times and the subject and location of the meeting, or the name of a one-day project task. You can specify the time and date format displayed as well. Click OK.

✦ **Add a multiple-day event**— Drag the Multi-Day Event shape onto your calendar. In the Configure dialog box, enter the subject and location of the event or project task as well as the start and end dates. Click OK.

✦ **Add text**— Double-click the day in which you want to add text, type the text you want, and press Esc. The text box and day box are grouped so that you can move and resize them as one. You can use standard techniques to edit and delete text in calendars.

Text added to a day box is associated with the day box, but not the actual day, as are appointments and events. To move the text to another day, you can cut and paste it from one day box to another.

![Figure 17-1: Create a calendar to show appointments, events, or project tasks.](image)

✦ **Revise an appointment or event**— Right-click it and choose Configure from the shortcut menu.

✦ **Delete an appointment or event**— Right-click it and choose Cut from the shortcut menu.
Consolidating Schedules for Several Individuals

You can import appointments from multiple individuals into a single Visio calendar to compare or combine the schedules of team members on a project. To combine appointments from different people, follow these steps:

1. Import your own appointments into a new or existing Visio calendar.
2. When you’re finished, choose File ➤ Send To ➤ Routing Recipient.
3. In the Routing Slip dialog box, enter the e-mail addresses for the people whose appointments you want to import.
4. In the Message Text box, instruct the recipients on how to run the Import Outlook Data Wizard on the calendar.
5. Under Route to Recipients, select One After Another. Be sure that the Return When Done check box is checked and then click OK.

Each recipient in turn runs the Import Outlook Data Wizard on the calendar to add his or her appointments. When the last recipient finishes, the calendar returns to you, complete with everyone’s imported appointments.

Importing Outlook Calendar Data into Visio

In Visio 2003, you can create, format, and share calendar appointments from Microsoft Outlook 2002 and later. To import Outlook calendar appointments into a Visio calendar, follow these steps:

1. Choose File ➤ New ➤ Project Schedule ➤ Calendar or open an existing calendar drawing into which you want to import Outlook appointments.
2. Choose Calendar ➤ Import Outlook Data Wizard.

Note

If the Choose Profile dialog box appears, select the profile you want to use in the Profile Name drop-down list.

3. In the first wizard page, select whether you want to import Outlook appointments into a new or existing Visio calendar and then click Next. The Selected Visio Calendar option is available only if you have already selected an existing Visio calendar on the drawing page.
4. In the second wizard page, specify the range of dates and times that contain the appointments you want to import and then click Next.

Tip

You can filter the appointments to import based on words in their Subject. Click Filter to open the Filter Outlook Data dialog box. Check the Subject Contains check box, type in the word or phrase for which you want to filter, and click OK.
5. In the third wizard page, which appears only if you import appointments into a new Visio calendar, specify the calendar type and properties and click Next.

6. In the last wizard page, review the import properties you specified. To change any of the import properties, click Back to open and edit the appropriate wizard page. When all import properties are set the way you want, click Finish.

Note
If there are too many appointments to fit in a single day in your calendar, they stack on top of each other. Resize the calendar to show all the appointments.

Documenting Project Timelines

Use the Timeline template to show milestones, intervals, tasks, or phases along a horizontal or vertical bar. A timeline drawing, as illustrated in Figure 17-2, can help you communicate dates and show progress toward a deadline.

Figure 17-2: Create horizontal or vertical timelines and summary and expanded timelines to show project milestones and intervals.
In Visio 2003, you can create vertical as well as horizontal timelines. You can also create a detailed view of a segment in an overview timeline.

With the Timeline template, you can take advantage of the following options:

- **Timeline shapes** — Specify the look and style of the timeline by selecting a particular Timeline shape.
- **Milestones** — Add one of several Milestone shapes to highlight and describe important dates along the timeline and to synchronize milestones across multiple timelines.
- **Intervals** — Define and annotate intervals in the timeline and synchronize intervals across multiple timelines on a single page.
- **Markers** — Annotate the timeline to show the current day or elapsed time. The Today Marker automatically moves to the current date as set in your computer system clock. You can also add the Elapsed Time shape to show the duration of a project up to the current date.
- **Expanded timeline** — Add an Expanded Timeline shape to show a detailed view of a segment in an overview timeline.
- **Data exchange with Project** — Import data from Microsoft Project into your Visio Timeline or export Visio Timelines to Microsoft Project.

### Creating Timelines

You can construct a timeline showing important beginning or ending dates (milestones) or phases of time (intervals). To create a new timeline drawing, follow these steps:

2. From the Timeline Shapes stencil, drag one of the Timeline shapes, such as Block Timeline or Cylindrical Timeline, onto the drawing.
3. In the Configure Timeline dialog box, under Time Period, specify the start and finish dates and times for the timeline.
4. Under Scale, specify the timescale properties you want in the Time Scale and Start Weeks On drop-down lists. If you select Quarters in the Time Scale dropdown list, you can also specify the Start Fiscal Year On date. Click OK.
5. Drag the new timeline to the position you want on the drawing.
If you don’t see dates or times on your timeline, select it and choose Timeline ➤ Configure Timeline. Select the Time Format tab and check the check boxes for the dates you want to show in the timeline.

To add a Milestone shape to your timeline to show an event on a particular date, such as the kickoff date of a phase or the due date of a major deliverable, follow these steps:

1. From the Timeline Shapes stencil, drag one of the Milestone shapes, such as Diamond Milestone or Pin Milestone, onto the timeline.
2. In the Configure Milestone dialog box, specify the date in the Milestone Date box. If the time is important, specify it in the Milestone Time box.
3. In the Description box, type the text for the milestone.
4. To change the date format, select a format from the Date Format drop-down list.
5. Click OK. The Milestone shape moves to the specified date in the timeline, and the date and description appear above or below the timeline itself as the milestone’s label.

Tip If part of the Milestone shape is not visible, right-click any visible part of it and then choose Shape ➤ Bring to Front from the shortcut menu.

To add an Interval shape to your timeline to show work over a period of time, such as the duration of the research phase of a project, follow these steps:

1. From the Timeline Shapes stencil, drag one of the Interval shapes, such as Block Interval or Cylindrical Interval, onto the timeline.
2. In the Configure Interval dialog box, specify the start and finish dates for the interval. If the time is also important, specify the start and finish times as well.
3. In the Description box, type the text you want to appear with the interval in the timeline.
4. Change the date format if necessary and click OK. The Interval shape appears at the specified dates in the timeline with the dates and description as labels in the Interval shape.

Expanding Timelines

In Visio 2003, you can use the Expanded Timeline shape to create a more detailed view of a segment of an overview timeline. For example, you can create an overview timeline that shows the phases for a project as a whole. Then you can expand one part of the timeline to show the detailed tasks for just one phase. You expand timelines to several levels. You can expand one timeline from an overview timeline. Then,
you can create a second expanded timeline to show additional detail for the first expanded timeline. You can also have more than one expanded timeline for a single overview timeline. To add an expanded timeline shape to your drawing, follow these steps:

1. Draw and configure the overview timeline.

2. From the Timeline Shapes stencil, drag the Expanded Timeline shape onto the drawing.

3. In the Configure Timeline dialog box, specify the start and finish dates for the expanded timeline. If the time is also important, specify the start and finish times as well.

   The dates in the expanded timeline must be within the date range of the overview timeline.

4. In the Time Scale box, select the detailed timescale. For example, if the overview timeline has a timescale of months, consider using a timescale of weeks in the expanded timeline.

5. Click OK to configure the expanded timeline. Any milestones, intervals, and date markers drawn on the overview timeline for the expansion time period also appear in the expanded timeline. As illustrated in Figure 17-2, gray, dashed lines correlate the start and finish dates on the expanded timeline and the overview timeline.

6. Draw any additional milestones or intervals on the expanded timeline.

   Milestones and intervals added to the expanded timeline do not appear on the overview timeline. However, if you add a milestone or interval to the overview timeline within the date range of an expanded timeline, it appears on the expanded timeline as well. Visio synchronizes changes to milestones or intervals with the associated timelines.

You can use the mouse to change the expanded timeline in the following ways:

- **Move** — Drag the expanded timeline to the location you want on the drawing. The expanded timeline’s association with the overview timeline is maintained even when you move it.

- **Resize** — Select the expanded timeline and drag any of the four selection handles to the size you want. This only resizes the timeline, and does not change the dates.

- **Change the start or end date** — Select the expanded timeline. On the overview timeline, drag the yellow control handles to the new date.
Synchronizing Milestones and Intervals

Just as Visio synchronizes milestones and intervals in overview and expanded timelines, you can synchronize milestones and intervals across multiple timelines on a page. You can synchronize existing milestones or intervals or you can create the synchronization using the Synchronized Milestone and Synchronized Interval shapes.

In Visio 2003, you can synchronize milestones and intervals across multiple timelines on a page and see visual cues as to which items are synchronized.

To synchronize a milestone or interval with another, follow these steps:

1. Use one of the following methods to select a milestone or interval:
   - **Existing shapes**—Select the milestone or interval you want to synchronize.
   - **New shapes**—From the Timeline Shapes stencil, drag the Synchronized Milestone or Synchronized Interval shape onto the timeline.

2. Choose Timeline ➪ Synchronize Milestone or Timeline ➪ Synchronize Interval.

3. In the Synchronize With drop-down list, select the milestone or interval with which the selected shape should be synchronized.

4. Select the date format if necessary and click OK. A gray, dotted line appears, showing the synchronization between the milestones or intervals.

Deleting the gray, dotted line does not remove the association between synchronized milestones or intervals. To break the link between synchronized milestones or intervals, delete one of the synchronized shapes. You can then add it back as a regular unsynchronized shape.

Modifying Timelines

For existing timelines, you can modify dates and times as well as the overall look of a timeline. To change date or time information and formats, select the timeline and choose Timeline ➪ Configure Timeline. In the Configure Timeline dialog box, use one or more of the following methods:

- **Start and end dates**—Select the Time Period tab if necessary. Under Time Period, change the start or finish dates.

- **Timescale**—Select the Time Period tab if necessary. In the Time Scale drop-down list, select the timescale you want, such as Months or Weeks. The timescale specifies the tick marks and interim dates that show on the timescale.

- **Date or time format**—Select the Time Format tab. Under Show Start and Finish Dates on Timeline, select the date format you want in the Date Format drop-down list. To change the date format for interim dates, select the format under Show Interim Time Scale Markings on Timeline.
✦ **Timescale date and markings** — Select the Time Format tab. Uncheck the Show Interim Time Scale Markings on Timeline check box if you don’t want any tick marks or dates between the start and finish dates. Uncheck the Show Dates on Interim Time Scale Markings check box if you don’t want interim dates to show. Your start and finish dates, as well as any milestone and interval dates, still appear.

✦ **Revise dates automatically** — Select the Time Format tab. Check the Automatically Update Dates When Markers Are Moved check box when you want dates to dynamically change as you move milestones or intervals along the timeline (this is the default). Uncheck this check box if you do not want dates to update automatically.

In Visio 2003, you can edit all date and time formatting for different elements in a timeline. Select the timeline and then choose Timeline ➤ Change Date and Time Formats. Change the date format for the elements you want, such as the start and finish dates or the milestone dates.

You can change the look of your timeline in the following ways:

✦ **Change the timeline orientation** — Select the timeline and drag the selection handles to move the timeline to a vertical orientation.

✦ **Change the type of timeline** — Right-click the timeline and choose Set Timeline Type from the shortcut menu. In the Timeline Type drop-down list, select the type of timeline you want.

✦ **Show arrowheads** — Right-click the timeline and then choose Show Start Arrowhead or Show Finish Arrowhead.

To delete a timeline, select it and press Delete. All milestones, intervals, and any other shapes associated with the timeline are deleted as well.

### Importing and Exporting Timeline Data

You can import and export timeline data between Visio and Microsoft Project if Microsoft Project 2000 or later is installed on your computer along with Visio.

In Visio 2003, you can no longer import Microsoft Excel data, .txt, or .mpx files into a timeline or convert data between a timeline and a Gantt chart. However, you can import Excel data, .txt, and .mpx files into a Visio Gantt Chart. If you export that data to Microsoft Project, you can use the Import Timeline Data wizard to import the new Microsoft Project data as a timeline or convert a timeline to a Gantt Chart in Visio.

### Importing Microsoft Project Data into a Timeline

Bring information from Microsoft Project into Visio when you want to create a timeline based on existing project management information. This is particularly useful for presenting or reporting project status. You can import all tasks in the project or just the top-level tasks, the summary tasks, the milestones, or any combination of
To import information from Microsoft Project into a Visio Timeline, follow these steps:

1. In Visio, open an existing Timeline drawing or create a new one.
2. Choose Timeline ➪ Import Timeline Data.

   **Note**
   
   If you don’t see Import Timeline Data on the Timeline menu, you don’t have Microsoft Project 2000 or later installed on your computer.

3. In the wizard page, click Browse. Navigate to the Microsoft Project file that contains the information you want to import into Visio. Select the file, click Open, and click Next.

   **Caution**
   
   To successfully import project data, make sure that the Microsoft Project file that you’re importing is not currently open.

4. In the next wizard page, select the type of tasks you want to import from Microsoft Project to Visio and click Next.

5. In the next wizard page, select the Timeline, Milestone, and Interval shapes for the Microsoft Project information being imported and click Next.

   **Note**
   
   Any Microsoft Project tasks with 0 duration are imported as milestones. Tasks with durations are imported as intervals, showing their start dates, finish dates, and durations. Any tasks designated as milestones but containing duration are imported as intervals, not milestones.

6. In the final wizard page, review the import properties you specified. To change any of the import properties, click Back.

7. When all import properties are set the way you want, click Finish. Visio imports the selected tasks. If you imported into an existing Timeline drawing, Visio creates the imported timeline on a new page.

**Exporting Visio Timelines to Microsoft Project**

Suppose you built a simple project as a Visio Timeline, perhaps as a proposal or to gather input from team members. Now it’s time to initiate the project and you want to transform the Visio Timeline into a Microsoft Project plan so you can take full advantage of scheduling, resource allocation, and budget tracking features. You can export milestones and intervals from your Visio Timeline. In Microsoft Project, intervals become tasks with start dates, finish dates, and durations. To export information from a Visio Timeline to Microsoft Project, follow these steps:

1. In Visio, open and select the timeline.
2. Choose Timeline ➪ Export Timeline Data.

   **Note**
   
   If you select a timeline that’s associated with expanded timelines, a prompt asks if you want to export markers on the expanded timelines. Click Yes or No.
3. In the browser window that appears, navigate to the folder in which you want to save the exported project file.

4. In the File Name box, type a name for the project file. Be sure that Microsoft Project File (*.mpp) is selected in the Save As Type box, and then click Save.

5. In the wizard page again, click Next. A message will appear saying that the project has been successfully exported. Click OK.

6. Open Microsoft Project and review the project file you just created with the exported timeline data.

Scheduling Projects Using Gantt Charts

The Gantt chart is one of the most popular diagrams for showing project task information. With a Gantt Chart, you can list tasks next to charts of task bars, milestone markers, and other symbols along a horizontal timescale. Using the Gantt Chart template to draw a Gantt chart in Visio can be helpful in the initial planning stages of a project when you're developing a broad outline of project phases and milestones. A Visio Gantt Chart, shown in Figure 17-3, can also be helpful during project execution when you're preparing presentations or progress reports.

Figure 17-3: Create a Gantt chart in Visio to gain consensus on a proposed project plan or to report ongoing progress.
With the Gantt Chart template, you can perform the following actions:

- **Draw a Gantt Chart** — Use the Gantt Chart Frame, Column, and Row shapes to define the Gantt Chart drawing.
- **Draw task bars and milestones** — Indicate the scheduling of tasks with the Task Bar shape, and the major accomplishments with the Milestone shapes.
- **Create a hierarchy of project tasks** — Indent and outdent tasks to create summary tasks and subtasks.
- **Link tasks** — Show dependencies between predecessor and successor tasks using the Link Lines shape.
- **Specify working time** — Indicate the normal working days and hours for your project team.
- **Explain the Gantt Chart to others** — Use the Title, Legend, Text Block, and Horizontal Callout shapes to add clarification to the Gantt Chart.
- **Add columns** — Insert predefined or custom project fields, such as Resource Names or % Complete, in the table area of the Gantt Chart.
- **Format the Gantt Chart** — Specify the look of the task bars, milestones, summary task bars, and text.
- **Exchange project data** — Import and export project information with Microsoft Project.

The Visio Gantt Chart is primarily a visual representation of a project. It uses SmartShapes technology and can perform basic calculations among start dates, finish dates, and durations. However, the Visio Gantt Chart does not calculate resource allocation, budget estimates, and other typical project management information. To perform such project management activities, use a software tool such as Microsoft Project.

**Creating Gantt Charts**

Start a new Gantt Chart drawing by setting up the overall parameters of the project. Next, specify the details for individual tasks. Add milestones, organize the tasks into a hierarchical outline or work breakdown structure, and link tasks together to show task dependencies.

To create a new Gantt Chart in Visio, follow these steps:

1. Choose File ➪ New ➪ Project Schedule ➪ Gantt Chart. A new drawing with the Gantt Chart Shapes stencil, the Gantt Chart toolbar, and the Gantt Chart menu appears, along with the Gantt Chart Options dialog box.

   To add a Gantt Chart to an existing drawing, choose File ➪ Shapes ➪ Project Schedule ➪ Gantt Chart Shapes. From the Gantt Chart Shapes stencil, drag the Gantt Chart Frame shape onto the drawing.
2. In the Gantt Chart Options dialog box, specify the number of tasks you want to define, the major and minor timescale units, the duration time units you prefer, the anticipated start and finish date for the project, and so on.

Caution
Under Time Units, don’t make your timescale too detailed for the timescale date range you specify. For example, if your timescale range is a year, and you set the time units for days within months, your chart will be much larger than what can fit on a standard page.

3. When you’re finished, click OK to build and display the Gantt Chart.

To enter task details in the table area of your Gantt Chart, follow these steps:

1. Zoom into the Gantt Chart if necessary to see text in the columns.

2. In the Task Name column, double-click Task 1 in the first row and change Task 1 to the first task name in your project. When you’re finished, double-click Task 2 and repeat the process. Repeat this for each task in your project.

3. In the Start and Finish columns, double-click a date and change it to the date for the corresponding task. When you’re finished, click outside the field.

4. In the same way, change the Duration field to the duration you want for the corresponding task.

Although you can specify the start date, finish date, and duration for tasks by typing in their table columns, you can also specify this information by dragging task bars under the dates indicated on the timescale of the Gantt Chart. When you select a task bar, selection handles and control handles appear, which you can use to define task information. Specify task details in the chart area of the Gantt Chart as follows:

- **Change the start date** — Drag the left green selection handle to the left or right until it’s under the start date you want. The date in the Start Date column for the task changes as well.

- **Change the finish date** — Drag the right green selection handle to the left or right until it’s under the finish date you want. The date in the Finish Date column for the task changes as well.

- **Change the task duration** — Drag either green selection handle until the task bar spans the number of days you want. The amount in the Duration column for the task changes as well.

- **Indicate progress in the task bar** — Drag the left yellow control handle toward the right in the task bar to display a pink progress bar.

**Navigating in Gantt Charts**
Tools on the Gantt Chart toolbar, illustrated in Figure 17-4, help you scroll to task bars or dates in your Gantt Chart. Use the following tools to scroll the chart area within your Gantt Chart.
Figure 17-4: The Gantt Chart toolbar provides tools for navigating to tasks.

✦ Go To Start — Shows the first task bar in the project
✦ Go To Previous — Shows the time period just before the period currently showing
✦ Go To Next — Shows the time period just after the first period currently showing
✦ Go To Finish — Shows the last task bar in the project
✦ Scroll To Task — Shows the task bar for the currently selected task

Adding Milestones
To add a milestone to your Gantt Chart, follow these steps:

1. From the Gantt Chart Shapes stencil, drag the Milestone shape onto the task above which you want to insert a new milestone task. Visio inserts a new task above that point and the milestone marker appears in the chart area.
2. Double-click New Task in the Task Name column and then change the placeholder name to the milestone name.
3. Change the Start Date field to the milestone date. In Visio, milestones must have a duration of 0, so as soon as you enter the start date, Visio updates the finish date to the same date. You can also drag the milestone marker in the chart area to the date you want. Visio updates the fields in the Start and Finish columns automatically.

   Leave the duration for the milestone task at 0. If you add a duration, the milestone marker changes to a Task Bar shape in the chart area. Likewise, if you change a task duration to 0, its task bar changes to a milestone marker.

Organizing Tasks
You can set up the tasks in your Gantt Chart as an outline of summary tasks and subtasks. This is helpful for setting up individual tasks within phases or for subdividing tasks with larger scope into their component tasks, as in a work breakdown...
structure. To arrange tasks into a hierarchy of summary tasks and subtasks, follow these steps:

1. Add all the summary tasks and subtasks in the proper order for the hierarchy.

   To move a task, select the entire task row by clicking the task’s ID. Drag the row to the location you want.

2. Select the task you want to transform into a subtask of the task above it.

3. Click the Indent tool on the Gantt Chart toolbar or choose Gantt Chart ➪ Indent, which makes the following changes:

   - Visio indents the selected task to show that it’s a subtask of the task above it.
   - Visio bolds the font for the task above, indicating that it’s now a summary task of the indented tasks below it.
   - The summary task information calculates rolled up values for all its subtasks.
   - The task bar for the summary task is marked with triangular end points, and represents the start, finish, and duration for all subtasks.

### Linking Tasks

Many tasks cannot start until other tasks are completed, a condition which is known as a *task dependency*, or *task link*. To link tasks to show their dependencies, follow these steps:

1. Select the first task or the predecessor you want to link. Then Shift+click or Ctrl+click the second task, or successor. Click as many tasks as you want in the order that you want them linked.

   Shift+clicking selects one task at a time, rather than a series of consecutive tasks.

2. On the Gantt Chart toolbar, click the Link Tasks tool. Visio links the selected tasks in a finish-to-start relationship, as shown by link lines in the chart area of the Gantt Chart. Start and finish dates might be recalculated to reflect the scheduling changes caused by the new task links.

   Tasks are linked in a finish-to-start relationship only. There is no way to represent start-to-start, finish-to-finish, or start-to-finish task links in a Visio Gantt Chart.
Setting the Project Working Time

By setting a project’s working time, you can show the days and times in which work occurs on the project—for example, Monday through Friday 8:00 A.M. through 5:00 P.M. If a project is behind schedule and Saturdays are workdays, you can specify that as well.

To specify working days and times for the project, choose Gantt Chart ➪ Configure Working Time. Under Working Days, check the check boxes for the days of the week designated as workdays and uncheck the check boxes for days off. Under Working Time, enter the start and finish times for the working days. Working time is reflected with different colors in the chart area of the Gantt Chart and can affect task finish dates.

Annotating Gantt Charts

You can polish up Gantt Charts by adding annotations. From the Gantt Chart Shapes stencil, drag one or more of the following shapes to the Gantt Chart drawing:

- Title
- Legend
- Text Block (8-point, 10-point, or 12-point text)
- Horizontal Callout or Right-Angle Horizontal (callout)

For information on annotation techniques, see Chapter 6.

Modifying the Content in Gantt Charts

After you’ve built your Gantt Chart, you can modify it to make necessary adjustments or add detail. You can add and delete tasks or show and hide columns in the table area of the Gantt Chart. Use one or more of the following methods to modify the content of your Gantt Chart:

- **Add a new task** — Click the task above which you want to add a new task. On the Gantt Chart toolbar, click New Task. You can also choose Gantt Chart ➪ New Task or drag the Row shape from the Gantt Bar Shapes stencil onto the Gantt Chart. Type the name of the new task along with the start date, finish date, duration, and any other task information.

- **Delete a task** — Select the task you want to delete. On the Gantt Chart toolbar, choose Delete Task, or choose Gantt Chart ➪ Delete Task.

- **Rename a task** — Double-click the task name, edit the name, and press Esc.

- **Add a column to the table** — Click the column heading to the left of where you want the new column. Choose Gantt Chart ➪ Insert Column or drag the Column shape from the Gantt Chart Shapes stencil onto the Gantt Chart.
the Column Type drop-down list, select the field you want to add, such as % Complete or Actual Duration. To add a custom column, select one of the User Defined fields, such as User Defined Duration. Click OK.

- **Remove a column from the table** — Click anywhere in the column you want to delete. Choose Gantt Chart ➪ Hide Column.

### Formatting Gantt Charts

To clarify a Gantt Chart, you can format how Visio displays time-based information. You can also change the appearance of chart area elements to make a Gantt Chart more compelling. Format your Gantt Chart in the following ways:

- **Change timescale dates and units** — Choose Gantt Chart ➪ Options and then select the Date tab if necessary. Under Time Units, specify the major and minor time periods for the timescale in the chart area of the Gantt Chart. Under Duration Options, specify the time unit for duration. Under Timescale Range, specify the start and finish dates for the project.

- **Change the look of task bars and milestones** — Choose Gantt Chart ➪ Options and then select the Format tab. Specify the shapes on the ends of task bars and summary bars (the type of text appearing in or around the task bars) and the shape of milestones.

- **Change text formatting in the table area** — Select the text you want to format and then choose Format ➪ Text.

- **Change colors in the Gantt Chart** — Select the item whose color you want to change and choose Format ➪ Fill.

### Importing and Exporting Gantt Chart Data

You can import and export Gantt Chart data between Visio and Microsoft Project. When Microsoft Project 2000 or later is installed on your computer with Visio, the Import and Export commands appear on the Visio Gantt Chart menu.

### Importing Project Data into Visio Gantt Charts

Bring information from Microsoft Project into Visio when you want to create a Gantt Chart based on existing project management information.

**New Feature**

The Import Project Data Wizard creates only Gantt Charts, not Timelines, now that Visio 2003 includes the Import Timeline Wizard.

To import Microsoft Project data into a Visio Gantt Chart, follow these steps:

1. In Visio, choose File ➪ New ➪ Project Schedule ➪ Gantt Chart or open an existing Gantt Chart drawing. Choose Gantt Chart ➪ Import.

2. Select Information That’s Already Stored in a File and then click Next.
3. In the next wizard page, select Microsoft Office Project File and click Next.

Tip

In this wizard page, you can also choose to import project information from existing Excel spreadsheets (.xls files) or text files (.txt or .csv files).

4. In the third wizard page, click Browse and navigate to the Microsoft Project file that contains the information you want to import as a Visio Gantt Chart. Select the file and click Open. Click Next.

5. In the fourth wizard page, specify the major and minor timescale units, as well as the duration time units to be used. Click Next.

6. In the fifth wizard page, select the type of tasks you want to import from Microsoft Project to Visio. Click Next.

Note

Any Microsoft Project tasks with 0 duration are imported as milestones. Any tasks designated as milestones but containing a duration, such as one day, are imported as a milestone with a 0 duration.

7. In the final wizard page, review the import properties you specified. To change any of the import properties, click Back. When all import properties are set the way you want, click Finish. The selected task information is built as a Gantt Chart in Visio. If you are importing into an existing drawing, Visio creates the imported Gantt Chart on a new page.

Entering Gantt Chart Data via an Excel or Text File

You might find it more efficient to enter large amounts of project data in an Excel (.xls) file or a text (.txt or .csv) file and then import that file into Visio. You can create these data files directly in Excel or an application that produces text files, or create the spreadsheets or text files within Visio. To import data from a spreadsheet or text file, follow these steps:

1. In Visio, choose File ➔ New ➔ Project Schedule ➔ Gantt Chart or open an existing Gantt Chart drawing.

2. Choose Gantt Chart ➔ Import. The Import Project Data Wizard appears.

3. Select Information That I Enter Using the Wizard and then click Next.

4. In the second wizard page, select Microsoft Excel or Delimited Text and then click Next. If you select Microsoft Excel, an Excel spreadsheet opens. If you select Delimited Text, a text file opens. Either option provides preset column headings to help you quickly enter project information for your Visio Gantt Chart.

5. Under the New Filename box, click Browse. Navigate to the folder in which you want to store the new file. Type a name for the file in the File Name box. Make sure that Microsoft Office Excel Workbooks (*.xls) or Text Files (*.txt; *.csv) is selected in the Save As Type box and then click Save.
6. Click Next. Microsoft Excel or Notepad will appear, with a page containing project-related headings that contribute to your Gantt Chart in Visio, such as Task Name, Duration, and Start Date. In a Notepad text file, the information for the different columns is separated by commas.

7. Replace the sample data under the headings with your own project data.

8. When you’re finished, save and close the file. For best results, close Microsoft Excel or Notepad as well.

9. Back in Visio, continue to work through the remaining wizard pages to import the information from the file you just created.

10. Check the information in the final wizard page and then click Finish. Visio creates a Gantt Chart using the selected task information from your data file.

**Exporting Visio Gantt Charts to Microsoft Project**

To export project information from your Visio Gantt Chart into Microsoft Project, follow these steps:

1. In Visio, open and select the Gantt Chart and then choose Gantt Chart ➪ Export.

2. Select Microsoft Office Project File and then click Next.

3. In the browser window that appears, navigate to the folder in which you want to save the exported project file.

4. In the File Name box, type a name for the new project. Be sure that Microsoft Project File (*.mpp) is selected in the Save As Type box. Click Save. In the wizard page again, click Next.

5. In the next wizard page, review the export properties you specified and click Back to change any properties. When all export properties are set the way you want, click Finish. A message indicates that the project has been successfully exported. Click OK.

6. Open Microsoft Project and the project file you just created with the exported Visio Gantt Chart data.

To learn more about importing and exporting information between Visio and other applications, see Chapter 9.

**Building PERT Charts**

Like Gantt charts, Program Evaluation and Review Technique (PERT) charts are also popular for displaying project task information in a network diagram layout. Each task is represented by a box, or node, which is connected to other nodes in the PERT chart via their task links in a manner similar to a flowchart. Each node
contains task information such as task duration, start date, and finish date. Use Visio to create PERT charts showing the relationship between tasks in your project, as shown in Figure 17-5.

![Figure 17-5: Draw a PERT chart to show project tasks in a network diagram layout.](image)

**Caution**

Unlike Visio Gantt Charts and Timelines, the Visio PERT Chart does not calculate start dates, finish dates, or durations. Use the PERT Chart strictly as a visual representation of your project tasks.

### Creating PERT Charts

To create a new PERT Chart in Visio, follow these steps:

1. Choose File $\rightarrow$ New $\rightarrow$ Project Schedule $\rightarrow$ PERT Chart. A new drawing containing the PERT Chart Shapes stencil appears.
   
   **Tip**

   To add a PERT Chart to an existing drawing, choose File $\rightarrow$ Shapes $\rightarrow$ Project Schedule $\rightarrow$ PERT Chart Shapes.

2. From the PERT Chart Shapes stencil, drag the PERT 1 or PERT 2 shape onto the drawing. The PERT 1 shape creates a task node containing the task name, with six boxes in which to enter task details. The PERT 2 shape contains four additional boxes for task details.
Both the PERT 1 and PERT 2 task node shapes contain placeholder project information, including duration, early start, slack, scheduled finish, and more. You can replace the placeholders with any type or format of information you want.

3. Drag a PERT node shape onto the drawing for each project task you want to show. It’s best to use the same type of PERT shape for all tasks.

4. To enter a task name, select a node and then type the task name. When you’re finished, press Esc.

5. To enter other task information in the node, first select the node, select a text box, type the information, and then press Esc.

   Tip
   
   To empty a text box, select it, press the spacebar, and then press Esc.

6. To show a task dependency from one node to another, click the Connector tool on the Standard toolbar, click the Line Connector, Line-curve Connector, or Dynamic Connector in the PERT Chart Shapes stencil, and then drag from the predecessor to the successor node.

7. To add a legend or callouts, drag the Legend shape onto the drawing and update the text to help others understand the information in your task nodes, or drag the Horizontal Callout or Right-Angle Horizontal shape onto the drawing.

   Cross-Reference
   If you want to show specific information, you can create your own PERT task node shape. To learn more about customizing shapes, see Chapter 32.

**Summarizing Projects on PERT Charts**

You can use the PERT Chart’s Summarization Structure shape to create a high-level graphical overview of a project. To do this, follow these steps:

1. Choose File ➤ New ➤ Project Schedule ➤ PERT Chart. A new drawing containing the PERT Chart Shapes stencil appears. To add a PERT Chart to an existing drawing, choose File ➤ Shapes ➤ Project Schedule ➤ PERT Chart Shapes.

2. From the PERT Chart Shapes stencil, drag the Summarize Structure shape onto the drawing.

3. Type the text you want in the box. The drawing instantly zooms when you begin typing. When you’re finished, press Esc, and the drawing zooms out.

4. Repeat steps 2 and 3 for the additional shapes in your project summary.

5. To show links among the summary structures, as shown in Figure 17-6, drag the yellow control handle in a structure lower in the hierarchy to the connection point on the bottom of the related structure above it.
Figure 17-6: Use the Summarization Structure shapes to draw a project overview or work breakdown structure.

**Tip**

You can also use the Summarization Structure shape to add notes or other additional text under PERT Chart task nodes. With the PERT Chart drawing open, drag the Summarization Structure shape under the node. Drag the yellow handle to the node to connect them. Type the text you want and press Esc when you’re finished.

**Summary**

In Visio 2003, you can create Calendars, Timelines, Gantt Charts, and PERT Charts to help plan and communicate project information. Calendars and PERT Charts strictly reflect the information you provide. By contrast, Timelines and Gantt Charts calculate start dates, finish dates, and durations, to assist with basic project scheduling.

Visio’s project scheduling tools are designed to exchange information easily with other programs. You can import appointments from your Microsoft Outlook calendar and exchange timeline information with Microsoft Project. You can import and export Gantt Chart information with Microsoft Project, Microsoft Excel, and text files.
Documenting Brainstorming Sessions

Brainstorming is an effective way to get people to think outside the box to generate new ideas and creative solutions to challenging problems. During brainstorming sessions, participants express any idea that comes to mind. By giving people’s minds free rein and withholding criticism, you can expand your options or identify innovative solutions. Brainstorming can help you flesh out ideas for any purpose, including business strategy, research, new applications for existing products, and even the plot of a novel.

In this chapter, you’ll learn how to create brainstorming diagrams to show the relationships between topics and numerous levels of subtopics. You’ll also learn how to rearrange topics on diagrams and format them to enhance their appearance. Finally, I will show you how to add a legend to a diagram to identify the symbols used.

Exploring the Brainstorming Template

The Visio Brainstorming template includes shapes and tools to help you document the results of brainstorming sessions. For brainstorming that progresses in an organized fashion, you can begin with a main topic and outline subtopics to generate a hierarchy of ideas. However, when participants think at full throttle, it’s hard to keep up with the volume of information. In these situations, you can use Visio Brainstorming tools to capture ideas as quickly as your team generates them and later analyze, organize, and refine the results.
The Visio Brainstorming template is simple yet powerful. You can quickly create brainstorming diagrams by adding, connecting, and arranging topics. Later, you can reorganize topics, emphasize ideas by formatting the diagram, and annotate the results with symbols and a legend. By default, the Outline window opens to show brainstorming topics hierarchically so that you can analyze and refine the results of a session before sharing them with your colleagues.

**New Feature**

**Accessing Visio Brainstorming Tools**
Brainstorming is frequently fast-paced, so Visio provides Brainstorming commands in several places. You can access most Brainstorming tools on the Brainstorming menu on the Visio menu bar as well as the shortcut menus that appear when you right-click a Brainstorming diagram or shape. The Brainstorming toolbar, which you can dock or float as you prefer, includes several commonly used Brainstorming commands. When you open or create a Brainstorming diagram using the Brainstorming template, Visio opens several stencils, floats the Brainstorming toolbar in the drawing window, and adds the Brainstorming menu to the Visio menu bar, as demonstrated in Figure 18-1.

![Figure 18-1: The Brainstorming template includes menus, a toolbar, and stencils.](image-url)
You can document ideas by dragging and dropping different types of topic shapes from the Brainstorming Shapes stencil onto the drawing page or by using the topic commands on the Brainstorming menus. As you work, you can quickly attach Legend shapes to topics to convey shorthand messages, such as order of priority or ideas that need more work. Whenever you have time during or after your session, you can create a legend, modify the topic and connector styles, or use Visio’s Auto-Arrange feature to optimize the layout of the topics on the page.

If you don’t see the Brainstorming toolbar when you open a Brainstorming diagram, choose View ➪ Toolbars and choose Brainstorming from the submenu. To display the Outline window when it is hidden, choose Brainstorming ➪ Outline Window.

Exploring the Brainstorming Outline Features

The Outline window, which displays topics on a brainstorming diagram hierarchically, offers a convenient way to work with Visio Brainstorming topics, particularly when your diagram covers several pages. You can rearrange topics in the outline without affecting the appearance of your diagram and without navigating between pages. You can reposition the Outline window, dock it along the side of the drawing area or within the Shapes window, or hide it when you want to work directly on the diagram. Within the Outline window, you can add, delete, or reorder topics in the hierarchy, change topic text, or navigate to a specific topic on the diagram.

You can also export a Brainstorming diagram to Microsoft Word and use its Outline view to fine-tune the results. The topic order you define in the Visio Outline window reappears in the exported Word document.

Exploring Visio’s Brainstorming Shapes

A Brainstorming diagram shows a hierarchy of topics with one or more main topics and as many levels of subtopics as you want. In addition, you can illustrate isolated ideas by dropping Topic shapes onto a drawing without connecting them to other topics. The Brainstorming Shapes stencil contains three Topic shapes and two connectors. Although you can drag shapes from the Brainstorming stencil onto a drawing page, the commands on the Brainstorming menus or toolbar are easier because they create and connect Topic shapes at the same time. The following shapes are the basic components for brainstorming diagrams:

- **Main Topic** — Represents a central theme or idea. You can add more than one Main Topic to a diagram.

- **Topic** — Represents ideas or topics. Although Visio provides only one Topic shape, you can use it to create peer-level or subordinate topics.
When you work with several hierarchical levels in a diagram, you can modify Topic shapes to differentiate levels in the hierarchy. To do this, right-click the shape and choose Change Topic Shape on the shortcut menu. Select the type of shape you want in the Change Topic dialog box and click OK.

- **Multiple Topics** — Opens a dialog box in which you can type the text for multiple topics. Visio adds separate Topic shapes for each line you type in the dialog box.

- **Dynamic Connector** — This option connects topics when you glue each end to shapes representing topics on the drawing page.

- **Association Line** — Choose this to shows an ancillary relationship between two topics.

The Legend Shapes stencil opens when you use the Brainstorming template. It contains the Legend shape itself as well as symbol shapes that you can glue to Topic shapes to include shorthand reminders. The Brainstorming template also opens the Backgrounds stencil and the Borders and Titles stencil.

### Creating Brainstorming Diagrams

The easiest way to create a Brainstorming diagram is to create a new file using the Brainstorming template and then use Brainstorming commands to add topics to the page. To create a Brainstorming diagram, choose File ➪ New ➪ Brainstorming, ➪ Brainstorming Diagram.

### Adding and Connecting Topics

Visio doesn’t automatically connect Topic shapes when you drag them from the Brainstorming stencil, but connections between Topic shapes are important, particularly when you want to use the Outline window to rearrange topics and their subordinates. It’s easier to use commands on the Brainstorming menus or within the Outline window to create shapes and automatically connect them to other shapes. To add text to a Topic shape, select it and type the text you want.

Topics that are not connected using shape-to-shape connections appear in the Outline window as standalone topics. To add or correct the connections between topics, drag an end point of a connector to the center of the first Topic shape. When the shapes are connected shape-to-shape, Visio highlights the topic with a red box, which appears gray in Figure 18-2. Drag the other end point of the connector to the center of the second Topic shape. Solid red squares at the connector end points indicate that the shapes are connected correctly, also illustrated in gray Figure 18-2.
Highlighted box indicates topic to be glued with connection.

Highlighted connection point indicates topic end point is glued.

**Figure 18-2:** Visio highlights topics to be glued and end points that are glued shape-to-shape.

**Adding Main Topics**

A Brainstorming diagram doesn’t have to contain only one Main Topic, although it’s easier to maintain your focus when you ration your main ideas. To create a Main Topic, choose your favorite from the following methods:

- **Drag and Drop** — Drag the Main Topic shape onto the drawing page.
- **Menu or Toolbar** — Choose Add Main Topic from the Brainstorming menu or the Brainstorming toolbar.
- **Shortcut Menu** — Right-click the drawing page and choose Add Main Topic from the shortcut menu.
- **Outline Window** — Right-click the diagram filename in the Outline window and choose Add Main Topic.
Adding Subtopics
You can create as many levels of subtopics as you want in a Brainstorming diagram. To create and automatically connect a topic as a subordinate to a superior topic at a higher level, use one of the following methods:

✦ **Menu or Toolbar** — Select a Main Topic or Topic shape on the diagram and choose Add Subtopic from the Brainstorming menu or the Brainstorming toolbar.

✦ **Shortcut Menu** — Right-click a topic on the drawing page and choose Add Subtopic from the shortcut menu.

✦ **Outline Window** — Right-click a topic in the Outline window and choose Add Subtopic.

You can reference documents containing additional information by adding hyperlinks to topics. To add a hyperlink, select a topic and choose Insert ➪ Hyperlinks. In the Address box, click Browse, and then click Local File. If necessary, choose the type of file you want to link to in the Save As Type list. Navigate to the file you want and click Open. To name the hyperlink, type the name you want in the Description box in the Hyperlinks dialog box and click OK.

To view the document connected by a hyperlink, right-click a topic and choose the hyperlink name from the shortcut menu.

Adding Topics at the Same Level
**Peer topics** are topics at the same level as another topic in the hierarchy. Create a peer topic using one of the following methods:

✦ **Menu or Toolbar** — Select a Topic shape at the same level as the topic you want to create and choose Add Peer Topic from the Brainstorming menu or the Brainstorming toolbar.

✦ **Shortcut Menu** — Right-click a topic on the drawing page and choose Add Peer Topic from the shortcut menu.

✦ **Outline Window** — Right-click a topic in the Outline window and choose Add Peer Topic.

Adding Multiple Topics at Once
The Add Multiple Subtopics command enables you to add several subtopics to the same superior topic. To add multiple subtopics, follow these steps:

1. Select a Topic shape and choose Add Multiple Subtopics from the Brainstorming menu or the Brainstorming toolbar.

You can also initiate the Add Multiple Subtopics command by right-clicking a topic on the drawing page and choosing Add Multiple Subtopics from the shortcut menu or by right-clicking a topic in the Outline window and choosing Add Multiple Subtopics.
2. In the dialog box, type text for each topic and press Enter to continue with the next topic.

3. When you have added all the topics you want, click OK.

**Connecting Topics Manually**

You can manually connect topics on a brainstorming diagram or add ancillary relationships between topics. If you added topics by dragging Topic shapes onto the page or want to connect Topic shapes that you inadvertently disconnected, create a shape-to-shape connection by following these steps:

1. Drag the Dynamic connector from the Brainstorming stencil and drop it near the first Topic shape you want to connect.

2. Drag an end point of the connector to the center of the first Topic shape until Visio highlights the Topic shape with a red box.

3. Drag the other end point of the connector to the center of the second Topic shape. Solid red squares at end points indicate that the shapes are connected correctly.

*Note*

Each subordinate shape can only connect to one superior shape. *Association lines* are connectors on the Brainstorming stencil that visually indicate connections to more than one superior topic, or relationships between topics at the same level. However, Topic shapes connected by Association connectors do not appear connected in the Outline window or when you export the diagram.

**Laying Out Brainstorming Diagrams**

Brainstorming diagrams are meant to capture and present ideas unearthed during brainstorming sessions, which often results in an arrangement of topics as hectic as the discussion that brought it to light. After collecting everyone's thoughts, the next step is cleaning up the clutter to present those ideas for review and further refinement. In Visio, you can rearrange Topic shapes manually or automatically, or modify the layout style to present ideas more clearly. If you would rather keep a large diagram on one page, you can resize the drawing to match your diagram.

*Tip*

You can use the Outline window to quickly locate and select a specific topic on a large brainstorming diagram. In the Outline window, navigate the hierarchy until you find the topic you want and then double-click the topic name. Visio displays the page on which the corresponding Topic shape is located, selects the shape, and centers it in the drawing area.
Moving and Reordering Topics

Visio offers several methods for moving Topics in a Brainstorming diagram. You can relocate Topics within a page or change their level in the diagram hierarchy. For large or complex diagrams, you can move Topics, with or without their subordinates, to other pages in the diagram. Table 18-1 describes methods you can use to move and reorder brainstorming topics.

<table>
<thead>
<tr>
<th>Method</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move a topic on the same page</td>
<td>Select the Topic shape and drag it to a new position on the page. Visio moves any subordinate Topic shapes and automatically repositions their connectors.</td>
</tr>
<tr>
<td>Move a topic and its subordinates to another page</td>
<td>Select the top-level topic that you want to move on the drawing page or in the Outline window and then choose Brainstorming ➔ Move Topic to New Page. In the Move Topics dialog box, click the New Page or Existing Page option. To move the topic and its subordinates to a new page, type the name you want for the new page. To move them to an existing page, select the page name from the Existing Page list. Click OK to close the dialog box and move the topic.</td>
</tr>
<tr>
<td>Copy a topic without its subordinates to another page</td>
<td>Right-click the Topic shape you want to copy on the drawing page and choose Copy from the shortcut menu. Navigate to the page onto which you want to copy the shape, right-click the page, and choose Paste from the shortcut menu. You can copy several Topic shapes without their subordinates by holding the Shift key and selecting all the Topic shapes you want. After selecting them, right-click one of the selected shapes and choose Copy from the shortcut menu.</td>
</tr>
<tr>
<td>Change a topic’s level in the hierarchy</td>
<td>In the Outline window, drag the topic whose level you want to change and drop it on top of the topic you want to be superior. Visio moves the topic and all its subordinates underneath the superior topic and changes connections on the diagram.</td>
</tr>
<tr>
<td>Rearrange topics automatically</td>
<td>Choose Auto-Arrange Topics on the Brainstorming menu or toolbar. As long as the Topic shapes on your diagram are connected using shape-to-shape connections, Visio automatically rearranges the Topic shapes for you.</td>
</tr>
</tbody>
</table>
When you move a Topic shape and its subordinates, the top-level Topic shape remains on the original drawing page with an arrow symbol that indicates that the topic appears on another page. To navigate to the corresponding Topic shape on the other page, right-click the Topic shape and choose Go to Sub Page from the shortcut menu. To navigate back to the original page, right-click the moved Topic shape and choose Go to Page Containing Parent.

### Changing Layout and Connector Styles

The *layout style* governs how Visio positions Topic shapes on the drawing page, whereas the *connector style* specifies whether the connectors are straight or curved. By default, Visio uses curved connectors, and positions the Main Topic shape in the center of the page with shapes for subtopics radiating outward. Follow these steps to change the layout or connector style:

1. Choose Brainstorming ➪ Layout and select the layout or connector style in the Layout dialog box.

2. To view the selected layout without committing your change, click Apply. If the results are acceptable, click OK.

Note

The layout you select applies to the current drawing page and to any Topic shapes you add to that page. The connector style applies only to the current drawing page.

### Resizing the Page to Fit the Diagram

If your colleagues are on a roll but you’ve run out of room on the drawing page, you can add Topic shapes beyond the borders of the page. Later, when you have time, you can resize the page to fit your diagram using one of the following methods:

- **Dragging the page borders** — To display the page borders, right-click the page and choose View ➪ Whole Page. Press the Ctrl key and position the pointer on a page border. When the pointer changes to a two-headed arrow, drag the pointer to resize the page. The status bar displays the current height and width as you drag the border.

Note

You can change either the height or width by positioning the pointer near the middle of a border. To change both height and width, position the pointer near but not on the corner of the page. When you position the pointer on a corner, the Rotation tool appears, enabling you to rotate the entire page.

- **Using Page Setup** — Choose File ➪ Page Setup and select the Page Size tab. Specify the new page size and click OK.
Enhancing Brainstorming Diagram Appearance

Visio includes tools to help you refine the relationships between topics or craft a professional appearance for your diagrams. You can change the shape of Topic shapes to emphasize specific ideas, reshape connections to clarify relationships, or apply themes and color schemes to create a presentation. Use one of the following methods to enhance your diagrams:

✦ **Change topic shape** — Select one or more Topic shapes and then choose Brainstorming ➤ Change Topic Shape. In the New Shape box, select the type of shape you want to apply and click OK.

✦ **Reshape connections** — Drag a green eccentricity handle to change the curvature of a curved connector or Association connector. Drag a green diamond vertex to modify the angle of a straight connector.

✦ **Applying a theme** — To apply a theme to the current drawing page, choose Brainstorming ➤ Theme and then select the theme you want in the Theme dialog box. To preview the theme’s appearance, click Apply. If the theme is acceptable, click OK. Visio changes the appearance of Topic shapes up to four levels in the hierarchy. Visio uses the shape type of the fourth-level for any additional levels.

You should apply a theme only after you’re sure the diagram is finished. If you add new Topic shapes or move Topic shapes to different levels in the hierarchy, you must reapply the theme.

✦ **Apply a color scheme** — To specify a set of coordinated colors for all pages in your diagram, right-click the drawing page, choose Color Schemes from the shortcut menu, and select the color scheme you want. To preview the appearance of the selected color scheme, click Apply. If the color scheme is what you want, click OK.

Working with Legends

You can attach symbol shapes, such as Attention, Note, or Priority 1, to Topic shapes to quickly annotate your diagram. For example, you can prioritize ideas by associating Priority 1 shapes with your top priority Topic shapes, or indicate Topic shapes that include additional information or need additional work with Note or To Do shapes. When you move a Topic shape, any symbol shapes attached to it move with it.
Creating New Symbol Shapes

If the symbols on the Legend Shapes stencil aren’t sufficient, you can transform any Visio shape into a symbol shape as long as your drawing page contains a Legend shape. For example, instead of using the Note shape on the Legend Shapes stencil, you might want to convert a built-in Note shape to a customized Note shape with a custom property that contains the note text.

You can use shapes on a Brainstorming diagram or from other stencils and drawing types. To turn a shape into a symbol, drag the shape you want to use as a symbol onto the Legend shape on the drawing page. When Visio asks whether you want to convert the shape into a symbol and add it to the legend, click Yes. You can drag the control handle in a custom symbol shape to connect it to a Topic shape, as shown in the following figure.

Visio adds a row for the symbol in the Legend shape and adds a control handle to the shape. Whenever you add another instance of that shape to the drawing by dragging it from a stencil or copying an instance on the drawing, you can drag its control handle to a Topic shape’s connection point to connect them.

A Legend shape displays the symbol shapes included on a page, the symbol descriptions, and the number of times each one appears on that page. The Legend shape on the page updates automatically as you add symbol shapes to the page, so you can choose whether to add the Legend shape or symbol shapes first.
Adding Symbols to Topics

You can attach each instance of a symbol shape to only one Topic shape. To add a symbol shape to a Topic shape, follow these steps:

1. To display the Legend Shapes stencil, click the Legend Shapes stencil title bar to display it in the Shapes window. If the Legend Shapes stencil isn’t open, choose File ➪ Shapes ➪ Brainstorming ➪ Legend Shapes.

2. Drag a symbol shape from the Legend Shapes stencil and drop it near the Topic shape with which you want to associate it.

As soon as you drop a symbol shape on a drawing page that contains a Legend shape, the symbol appears in the legend with its description and an updated count of the number of occurrences on the page.

3. To connect the symbol to a topic, drag the yellow control handle from the symbol shape to a blue connection point on the Topic shape. The control handle turns red when it’s attached.

To detach a symbol from a topic, select the symbol shape and drag the red square away from the Topic shape. To delete a symbol, select it and press Delete.

Symbols are simple shapes with little room for text in their text blocks and no custom properties for storing information. You can attach a Note shape to a Topic shape, but you can’t include the note text in that shape. To annotate the Note shape with a reference to the associated note text, type an alphanumeric ID, such as A1, as text into the Note shape and then add a text block to the drawing with the Text tool to add the identifier and note text.

Creating and Configuring Legends

You can catalog the symbols on a drawing page by adding a legend to the page. However, a Legend shape shows the symbols only for the drawing page on which it is located, not the entire diagram. If you want to differentiate symbols, you can add more than one Legend shape to a page and configure each one to display the symbols you want. For example, you can use one Legend shape to show topic priority and another to highlight actions needed, such as To-dos, tasks, or topics that need follow-up.
Creating Legends
To create a legend on a page, follow these steps:

1. Drag the Legend shape from the Legend Shapes stencil onto the drawing page. If the page contains symbol shapes, the legend automatically displays them.

2. To add a title and subtitle, double-click the Title or Subtitle text and type the titles you want.

Configuring Legends
Each Legend shape can have its own unique configuration and formatting. You can configure Legend shapes using the Configure Legend command or by editing and formatting text directly in the Legend shape. Right-click the Legend shape you want to configure and choose Configure Legend from the shortcut menu to specify its appearance and formatting:

- **Show or hide the subtitle** — Check or uncheck the Show Subtitle check box to show or hide the legend subtitle.

- **Show or hide the quantity column** — Check or uncheck the Show Count check box to show or hide the Quantity column.

- **Show or hide the column names** — Check or uncheck the Show Column Names check box to show or hide the column names.

- **Show or hide specific symbols** — To hide symbols in a Legend shape, uncheck the check boxes in the Visible column. By default, Visio displays all the symbols on the page.

- **Change the sort order for symbols in the Legend shape** — Select a row in the Legend shape for the symbol you want to move and click Move Up or Move Down to reposition it in the list.

  Visio retains sort order changes only for symbols that are set to Visible. Before you rearrange the sort order, check the check boxes in the Visible column for each symbol you want to sort and then use the Move Up and Move Down buttons to re-sort the symbols.

- **Modify the width of the Legend shape** — Drag a selection handle on one of the sides of the Legend shape to the width you want.

- **Edit Legend text** — Subselect the text you want to edit by clicking the Legend shape and then clicking the text you want to edit. Type the text you want. You can edit the title, subtitle, or text in any column except the Count column.

- **Format Legend text** — Subselect the text you want to format and choose Format Text. Choose the formatting options you want and then click OK.

To delete a legend, select it and press Delete. Visio deletes only the Legend shape, not the symbol shapes associated with Topic shapes, on the drawing page.
Importing and Exporting Brainstorming Data

You can export brainstorming data if you want to refine or expand your ideas using Microsoft Word 2003 or Excel 2003. Visio also exports brainstorming data to XML format if you plan to edit the data using other applications. Visio structures exported topics based on the hierarchy that appears in the Outline window. The export file includes topic text, custom properties, hyperlink data, and topic associations, but not symbols associated with topics.

You must have Microsoft Word 2003 or Excel 2003 installed in order to export Visio Brainstorming diagrams to those applications’ formats.

To export brainstorming data from a Visio drawing, follow these steps:

1. Choose Brainstorming ➪ Export Data and then choose To Microsoft Word, To Microsoft Excel, or To XML.
2. In the File Save dialog box, navigate to the folder in which you want to save the export file, type a name in the File Name box, and click Save. If you export to Word or Excel, that application launches automatically and displays the exported data. If you export to XML, Visio saves the data in an XML file.
3. If you exported your diagram to Word, choose View ➪ Outline in Word to work with the data in a hierarchical view.

If you have XML files that contain brainstorming topics and subtopics, you can import them into Visio brainstorming diagrams. To do this, choose Brainstorming ➪ Import Data. Select XML files (*.xml) in the Files of Type list, navigate to the folder that contains the XML file you want to import, and double-click the file.

Summary

Brainstorming diagrams can seem quite complex, but they contain only a few different Visio shapes. You can drag Brainstorming shapes from the Brainstorming stencil, but you must then connect those Topic shapes to their superiors or peers. It’s much faster to use the commands on the Brainstorming menu or toolbar because these commands add and connect Topic shapes at the same time. You can neaten up a first draft by moving Topic shapes or selecting different layouts and connector types. You can easily create a professional-looking brainstorming diagram by applying a theme or color scheme.
Symbol shapes act as shortcuts for annotating your diagram, whether you want to prioritize your ideas or identify topics that need more refinement. The Legend Shapes stencil includes a number of symbols you can use, but you can also create your own by dragging any Visio shape onto a Legend shape on a drawing page.

You can export diagrams to Word 2003 or Excel 2003 if you would prefer to use those applications to further develop your ideas. You can also import and export to XML files.
Using Visio in Information Technology

In This Part

Chapter 19  
Modeling and Documenting Databases

Chapter 20  
Building UML Models

Chapter 21  
Building Software Development Diagrams

Chapter 22  
Mapping Web Sites

Chapter 23  
Creating Network Diagrams
Database models and diagrams help you design databases that better satisfy requirements. In addition, database maintenance is much easier when you can refer to accurate and up-to-date documentation.

If you don’t have commonly used data modeling tools such as ERwin or Oracle Designer, you can use the Database Model Diagram template in Visio to design and document logical database models for both relational and object-relational databases as long as you have a working knowledge of database concepts and database management practices. Whether you want to build a diagram from scratch, import a model from another application, or reverse-engineer an existing database, the Database Model Diagram template offers commands and wizards to simplify the process. You can add to or modify objects in your database model, including tables, columns, parent-child relationships, indexes, and code.

Although Visio provides templates for Object Role Modeling diagrams and Express-G diagrams, these templates produce only diagrams, not models.

In this chapter, you learn how to create database models from scratch, as well as how to import models from other applications or reverse engineer models from existing databases. You’ll learn how to set database options and preferences in Visio and work with elements in Visio database model diagrams.

Database templates are available only in Visio Professional and the Visio Studio .NET Enterprise Architect.
Exploring the Database Model Templates

Visio 2003 Professional includes three templates to help you produce database documentation. The Express-G and ORM templates include shapes that conform to these special notations. The Database Model Diagram is useful for both logical data modeling and physical database modeling. ORM diagrams show the objects in a model, the relationships between them, the roles that the objects play in those relationships, and any constraints within the domain. These diagrams are useful in presenting conceptual domain models and also provide an effective way to communicate the details of relationships between business objects to project stakeholders. Express-G diagrams help database designers visualize large information models by showing relationships between objects and other components within a data model. You build Express-G and ORM drawings with basic Visio techniques, dragging shapes onto the page, connecting them, and adding custom property data to document and annotate your diagrams. Express-G and ORM templates don’t include the Database menu, so you can’t reverse engineer an existing database into diagrams using these notations. However, the shapes in the Express-G and ORM stencils include custom properties that make it easy to create diagrams with the proper notation.

In earlier versions of Visio, you could create a physical database from a Visio model. Now this capability is part of Visio for Enterprise Architects, which is part of Visual Studio .NET Enterprise, not Visio Professional. You can import logical database models from Visio Professional into Visio for Enterprise Architects, and then use that tool to transform them into physical database schemas or DDL scripts. To learn more about Visio for Enterprise Architects, search http://msdn.microsoft.com/vstudio for Visio-based database modeling.

With the Database Model Diagram template, you can do more than diagram databases; you can do logical as well as physical data modeling. With physical data modeling, you can model tables, views, relationships, stored procedures, and other elements, using either relational or IDEF1X notation. The Database Model Diagram template adds the Database menu to the Visio menu bar and provides several specialized windows for viewing and modifying database properties. In this template, the Reverse Engineer Wizard takes an existing database and builds a Visio database model for you.

If you’re fairly new to data modeling and database design, trying to learn what you need to do might be a bit overwhelming. In reality, you probably want to learn more about data and databases so that you can decide whether Visio 2003 has the tools you need. With this knowledge, you can more easily choose the right Visio template and build the diagram you want. The following are some educational resources to help you learn more about data modeling and database models:

- *Data and Databases: Concepts in Practice* by J. Celko (San Francisco: Morgan Kaufmann, 1999) is a good introductory book to database technology.
Just because documentation is helpful, you don’t necessarily need a lot of it. To learn how to produce just the right amount of database documentation, read *Agile Modeling* by Scott Ambler (Indianapolis: Wiley, 2002).

*Agile Database Techniques* (Indianapolis: Wiley, 2003) by Scott Ambler and one of Scott Ambler’s Web sites, www.ambysoft.com/agileDatabaseTechniques.html, both introduce the process of data modeling and also discuss database refactoring.

To learn more about what you need to model physical databases, see www.agiledata.org/essays/umlDataModelingProfile.html.

*Information Modeling and Relational Databases: From Conceptual Analysis to Logical Design* by T. A. Halpin (San Francisco: Morgan Kaufmann, 2001) is the book about ORM diagramming.

If Visio encounters an unexpected error from either an internal or external source, your template-specific menus, such as the Database menu, can disappear. If Visio shuts down unexpectedly, restart it and then choose Tools ➪ Options. Select the Advanced tab, check the Enable Automation Events check box, and click OK. Save any open drawings, exit and restart Visio, and then reopen your database model diagram.

### Exploring Database Model Shapes

When you create a new database model diagram, Visio opens the Entity Relationship stencil and Object Relational stencil. Although relational and object-relational notations both use entities, columns, views, and relationships, the shapes on each stencil appear and behave according to the rules of their respective database modeling methods.

The Entity Relationship stencil includes an Entity shape to represent tables, a View shape to show combinations of columns assembled from other tables, and a Relationship connector to shows parent-child relationships. In addition, you can use the Category shape to relate multiple child tables to a parent table. Parent to Category and Category to Child connectors link tables to categories and create foreign keys within parent tables.

The Object Relational stencil includes all of the shapes from the Entity Relationship stencil plus a few specific to object-relational modeling. The Table Inheritance and Type Inheritance connectors configure child tables or types to inherit the attributes of a parent automatically. You can nest object-relational tables in a model by using the Type shape to define a type and then assigning it as the data type for a column in another table.

### Updating Database Shapes

In Visio releases, the Database Model Diagram template frequently, and automatically, implements new shape behaviors. When you open a database model diagram, Visio opens the Update Shapes dialog box if it finds older versions of Database.
Model shapes. Microsoft recommends that you keep shapes up to date, but you don’t have to do so. However, if you choose not to update shapes, they continue to behave as they did in the earlier version of Visio and include the same shortcut menus as they had in the earlier version.

If you don’t update shapes when you open a diagram, you can update them later by choosing Tools ➪ Add-Ons ➪ Visio Extras ➪ Update Shapes.

Creating Database Models

You can create database models in Visio in three different ways. If you want to document an existing database, you can use the Reverse Engineer Wizard to create a model by extracting information from the database. You can also import database models that you developed in other applications. If you’re starting from scratch, you can build a diagram by dragging and dropping shapes and connectors onto the drawing page.

Building Database Models from Scratch

To create a database model and specify the modeling options you want to use, follow these steps:


2. To specify the modeling options you want to use, choose Database ➪ Options ➪ Document.

3. To specify the symbols you want to use and the names that appear on the diagram, follow these steps:
   a. In the Database Document Options dialog box, select the General tab.
   b. Select the symbol set you want to use (IDEF1X or Relational).
   c. Select the names you want to see on the diagram.

4. Select the Table tab and check the check boxes for the attributes you want to display for tables. Choose options to specify the order in which keys appear and which data types to show.

5. Select the Relationship tab and specify the notation you want to use and how to display relationship names.

6. Click OK to apply the settings.

Tip

You can save the current settings as the default for all new database models or restore other settings by clicking Defaults and then choosing a command from the list.
Importing Database Models from Other Applications

If you modeled a database using ERwin or Visio Modeler, you can import those model files into Visio and continue your work there. To import an ERwin .erx or Visio Modeler file, follow these steps:

2. Choose Database ➪ Import and then choose either Import ERwin ERX File or Import Visio Modeler .IMD File.
3. Type the path and filename for the file you want to import, or click Browse and navigate to the file, and then click Open. Click OK in the Import dialog box. Visio imports the file and displays import progress in the Output window. After the import is complete, Visio shows the imported tables in the Tables and Views window.

Reverse Engineering an Existing Database

It’s easy to build a model of an existing database by using the Reverse Engineer Wizard in Visio Professional. When you run the Reverse Engineer Wizard, Visio enables options if they match features provided by the target database management system. In addition to walking you through the steps to extract information from your database, the wizard analyzes your database schema and reports any problems it finds in the Output window.

Setting Up Data Sources

You can use existing database drivers and data sources or configure them in the Reverse Engineer Wizard. If you want to keep your reverse engineering process as simple as possible, you can set up database drivers from the Database menu and define data sources using the Data Sources (ODBC) administrative tool in the Windows Control Panel.

To define data sources with Windows Control Panel tools, choose Start ➪ Settings ➪ Control Panel ➪ Administrative Tools ➪ Data Sources (ODBC).

Visio provides several default database drivers that work specifically with the Database Model Diagram template. You can use the following drivers or combine one of the generic drivers with an ODBC driver provided by your database vendor:

- Generic OLE DB Provider
- IBM DB2 Universal Database
- INFORMIX Online/SE Server
- Microsoft Access
- Microsoft SQL Server
- ODBC Generic Driver
To set up a default Visio driver to work with the database management system you use, follow these steps:

1. Choose Database ➪ Options ➪ Drivers and select the default driver you want to use.

2. If you want to associate a vendor’s ODBC driver with the selected Visio driver, click Setup. Check the check box for the ODBC driver you want to use. To specify other settings, such as the comment style or semicolons at the end of SQL statements, select the Preferred Settings tab. Click OK when you’re done.

3. To specify the default property values for the portable data types used in a database, select the Default Mapping tab. For each category in the Category list, choose attributes such as type, size, length, and scale.

4. To specify the type of category you want to use for new columns in tables, in the Default Category Type for Column Creation list, select a category in the drop-down list.

5. Click OK.

Using the Reverse Engineer Wizard

You can specify the information you want to extract from your database and whether you want Visio to create a diagram for you. To reverse engineer a database, follow these steps:

1. Choose File ➪ New ➪ Database ➪ Database Model Diagram to create a new database model diagram file.

2. Choose Database ➪ Reverse Engineer.

3. On the first Reverse Engineer Wizard screen, use one of the following methods to set up or connect to a data source and then click Next:

   • **Set up a database driver and data source** — Click Setup if you want to configure a database driver to work with the database management system for the database you want to reverse engineer. If the data source you want doesn’t exist, click New to define it.

   To learn about configuring database drivers and defining data sources, see Chapter 10.

   • **Use an existing driver and data source** — Select the Visio driver appropriate for the database you want to reverse engineer. For example, to reverse engineer a Microsoft Access database, select Microsoft Access in the Installed Visio Drivers list. Select the data source you want to use in the Data Source list.
If you create a new data source in the Reverse Engineer Wizard, you can select its name in the Data Sources list.

4. If a driver-specific dialog box appears, such as the Connect Data Source dialog box, follow its instructions. For example, type a user name and password in the Connect Data Source dialog box and then click OK.

5. In the Select Object Types to Reverse Engineer screen, uncheck the check boxes for any objects you don’t want to extract from the database. Click Next.

6. Check the check boxes for the tables and views you want to extract. You can also click Select All to extract all tables and views. Click Next.

7. If you checked the Stored Procedures check box in step 5, check the check boxes for the procedures that you want to extract, or click Select All to extract them all. Click Next.

8. To automatically create a diagram of the reverse engineered database, select Yes, Add the Shapes to the Current Page option and click Next.

If you select No, I Will Add the Shapes Later, you can drag objects from the Tables and Views window onto the drawing page.

9. On the final screen, review the tables and catalog information that Visio will reverse engineer. To change any selections, click Back. To extract the information shown, click Finish.

The Reverse Engineer Wizard does not handle hyperlink fields in Access databases properly; nor does it reverse engineer default values and primary key names in Sybase databases. If you want to flag Access hyperlink fields so you can correct them in Visio, add a comment to the field in Access and reverse engineer the database. In Visio’s Database Properties window, look for the Access comments, which appear as notes in the Columns category.

Viewing Reverse-Engineered Information
Visio shows the information extracted from the database in the Tables and Views window. Every table and view in a database model shows up in this window, even if they don’t appear on the drawing page. If you did not choose to add shapes to your drawing during the reverse-engineering process, you can drag objects from the Tables and Views window onto the drawing page.

After you drag a table onto the drawing page, you can display tables related to it by right-clicking it on the drawing page and choosing Show Related Tables from the shortcut menu.

The Output window displays progress and summarizes the tasks accomplished during the reverse engineering process. You can check the objects that the process extracted, including tables, attributes, and code. When Visio validates the model, it displays any errors or problems, such as conflicting names, in the Output window.
If you want to copy the messages in the Output window to another application so you can refer to them while you correct the identified problems, right-click the Output window and choose Copy Message or Copy All Messages.

### Updating Reverse-Engineered Database Models

After you reverse engineer a database, you can update your Visio model with changes made to the physical database. The Refresh Model command starts a wizard that compares your diagram to the current physical schema and enables you to update your model and diagram if you want to.

**Caution**

The Refresh Model Wizard doesn't detect new tables in a database. To add new tables to your model, rerun the Reverse Engineer Wizard and choose Select All. The wizard adds only the new tables to your model.

To refresh a model, choose Database ➪ Refresh Model. You can choose individual discrepancies that you want to resolve or select an entire category of discrepancies. To ignore an issue, select the No Change option. To update the diagram to match the database schema, select the Refresh Model option.

**Note**

The Update Database option under the Resolution heading provides compatibility with Visual Studio .Net Enterprise Edition and is always disabled in the Refresh Model Wizard.

### Working with Database Models

In Visio Professional, you can create and edit objects in your database models. You can work with tables, columns, views, and relationships, modifying attributes such as data type, primary and foreign keys, cardinality and referential integrity, and indexes and extended attributes.

**Note**

If you change the schema of a database in Visio, you also must update the data in your database.

### Working in the Database Windows

The Database Model Diagram template includes several windows that make it easy to view and modify database objects and to navigate to any table or view in your database model. Although some of these windows appear automatically when you use the Reverse Engineer Wizard, you can open them by choosing Database ➪ View and then choosing the window you want.
By default, Visio anchors the Tables and Views window, Types window, and Code window at the bottom of the Shapes window. When more than one window is open at a time, Visio adds tabs for each window so you can navigate between them. You can also float each of these windows individually by right-clicking its tab and choosing Float Window from the shortcut menu. If you want to float the entire window that contains the docked database window, drag the window title bar to a new location, as shown in Figure 19-1.

![Figure 19-1: You can dock or float the database windows.](image)

The Output window docks in the same window as the Database Properties window by default. You can float either of these windows by right-clicking their tabs and choosing Float Window from the shortcut menu.

As you work on database model diagrams, you’ll find yourself frequently using the Database Properties window, in which you can view and modify properties associated with objects in your database model. When you select an object, such as a
table, the categories of table properties that you can specify appear in the Database Properties window, as shown in Figure 19-2.

![Selected table on drawing page](image1)
![Selected table in model](image2)
![Properties for selected table](image3)

**Figure 19-2:** You can modify properties for any database object in the Database Properties window.

The Database Properties window displays different categories depending on the object you select in the Tables and Views window or on the drawing page. You can view or edit the following properties for the following objects:

- **Table categories** — The following categories appear when you select a table in the Tables and Views window or an Entity shape on the drawing page:
  - **Definition** — Specify physical and conceptual names and whether you want to synchronize the two as you type. You can use name spaces to distinguish similarly named tables in a model. Owner and Source Database specify the owner and path for the source database. You can create typed tables using the composite data types in the Defining Type field.
• **Columns** — Add, remove, edit, or change the order of columns in a table. You can specify column data types, primary and foreign keys, required fields, and whether to show physical or portable data types.

• **Primary ID** — Edit or remove primary keys from the columns in a table. You can specify whether to create an index using the primary key.

• **Indexes** — Create, edit, rename, or delete indexes. You can also specify the type of index you want to create, or extended attributes if your database management system supports them.

• **Triggers** — Add, edit, or remove triggers associated with a table. The Code Editor window opens when you click Add or Edit.

• **Check** — Add, edit, or remove check clauses associated with a table. The Code Editor window opens when you click Add or Edit.

• **Extended** — If your database supports extended attributes, set them in this tab.

• **Notes** — Add notes about a table.

✦ **View categories** — The following categories appear when you select a view in the Tables and Views window or a View shape on the drawing page:

  • **Definition** — The properties are the same as for tables.

  • **Columns** — Add, remove, edit, or change the order of columns in a view. They are the same properties as for tables.

  • **Join Criteria** — Add or edit the columns to join for a view and any criteria for the join.

  • **SQL** — Create or edit the SQL statements that create a view.

  • **Extended** — Same as for tables

  • **Notes** — Same as for tables

✦ **Relationship categories** — The following categories appear when you select a Relationship connector on the drawing page:

  • **Definition** — Specify the parent, child, and foreign key for a relationship.

  • **Name** — Specify the verb phrases to use to describe the relationship, the physical name of the foreign key, and any notes.

  • **Miscellaneous** — Specify or modify the cardinality, relationship type, and whether a child table must have a parent.

  • **Referential Action** — Specify the action to take to check referential integrity when a parent is updated or deleted.
To access the properties for an object, choose one of the following methods:

- **Database Properties window closed** — Double-click the shape on the drawing page.
- **Database Properties window open** — Select the object in the model or on the drawing page.
- **Database Properties window hidden** — Select the object in the model or on the drawing page and then move the pointer over the Database Properties title bar.

**Tip**

When the Database Properties window is floating and you want it to remain open, click the Push Pin in the title bar to turn off AutoHide.

### Working with Tables and Columns

Tables in a Visio model appear as Entity shapes on a database model diagram. When you add an Entity shape to a drawing page, Visio displays the shape based on the stencil from which you dragged the shape and the modeling and display options you’ve chosen.

To add a table to your drawing, follow these steps:

1. Drag an Entity shape from the Entity Relationship or Object Relational stencil onto the drawing page.
2. In the Database Properties window, type a name in the Physical Name box. If the Sync Names When Typing check box is checked, Visio updates the Conceptual Name automatically.

To remove a table from your drawing, follow these steps:

1. Select the table you want to remove on the drawing page and press Delete.
2. In the Delete Object dialog box, click Yes to remove the table from the model. Click No to remove the table only from the drawing page.

**Note**

If the Delete Object dialog box doesn’t appear when you delete an object from the drawing, choose Database ➤ Options ➤ Modeling and select the Logical Diagram tab in the Database Modeling Preferences dialog box. Select the Ask User What to Do option under the When Removing an Object from the Diagram heading.

### Categorizing Tables

To simplify the creation of several tables of the same type or tables that share the same attributes, you can create categories that include the common columns, the primary key, and the discriminator, which is the column that Visio uses to determine the category to which a table belongs. For example, an Employee table can contain all the columns common to every employee in a company, and a discriminator that uses the Job_Category column. Category tables such as administrator, executive, and engineer can include columns specific to those job categories.
The Category shape represents a category table on the drawing page. You associate category tables to parent tables using the Parent to Category connector. The Category to Child connector associates a category table with the children. Complete categories include all possible subtypes and are indicated by double lines in the Category shapes. Categories that don’t include all possible subtypes use single lines.

To define a category, follow these steps:

1. Drag a Category shape onto the drawing page.
2. To link a parent table (the table with the common attributes) to a category, click the Connector tool on the Standard toolbar, click the Parent to Category shape in one of the Database Model Diagram stencils, and then drag from the parent Entity shape to the Category shape.
3. To link the category to the child tables, with the Connector tool still selected, click the Category to Child connector in one of the Database Model Diagram stencils and drag from the Category shape to a child Entity shape. Repeat this step for each child table that uses that category.
4. To specify the properties for the Category, double-click the Category shape on the drawing page. Check the Category Is Complete check box if the category represents all subtypes. To specify the column that acts as the discriminator for child tables, select the This Attribute option and choose the column in the list.

**Adding Columns to Tables**

You can add columns to any table in your model, whether it appears on the drawing page or not or has been reverse engineered from an existing database. When you use relational notation, Visio shows keys, which specify uniqueness in tables, as shown in Figure 19-3.

![Figure 19-3: Relational notation shows keys in tables.](image-url)
Understanding Keys

A key is one or more data attributes that uniquely identify an entity. A key that is made up of more than one attribute is called a composite key. A key defined by attributes that already exist in the real world is called a natural key. For example, U.S. citizens receive a Social Security Number (SSN) that is unique to them. For a project limited to the U.S., the SSN could be used as a natural key for a Person entity, assuming privacy laws allow it. In a logical data model, an entity type has zero or more candidate keys, also referred to as unique identifiers. For example, for American citizens, the SSN is one candidate key for the Person data entity, and a unique combination of name and phone number is potentially a second candidate key. In a physical data model, candidate keys can act as the primary key or an alternate key (also known as a secondary key), or not act as a key at all. A primary key is the preferred key for an entity type.

There are two strategies for assigning keys to tables. The first is to simply use a natural key, one or more existing data attributes that are unique to a business concept. For example, in a Customer table with two candidate keys, such as CustomerNumber and SocialSecurityNumber, you could use either candidate key. The second strategy is to introduce a new column to act as a key, which is called a surrogate key because it has no business meaning. For example, an AddressID column in an Address table is useful as a surrogate key, because addresses don’t have an “easy” natural key. You would need all of the columns of the Address table to form a key for itself, so a surrogate key is a much better option. The primary advantage of natural keys is that they exist already, so you don’t need to introduce a new “unnatural” value to your data schema. However, because they have business meaning, they might change if your business requirements change. If you decide to use surrogate keys, you can use one of the following strategies:

- **Key values assigned by the database** – Most leading database vendors, such as Oracle, Sybase, and Informix, implement a surrogate key strategy called incremental keys. Although each strategy uses a similar concept, some assign values uniquely across all tables, whereas others assign values that are unique only within a single table.

- **MAX() + 1** – A common strategy is to use an integer column, starting the first record at 1, and then using the SQL **MAX** function to set the value for a new row to the maximum value in this column plus one.

- **Universally unique identifiers (UUIDs)** – UUIDs are 128-bit values that are created from a hash of the ID of your Ethernet card or an equivalent software representation, and the current date and time of your computer system. The algorithm for doing this is defined by the Open Software Foundation (www.opengroup.org).

- **Globally unique identifiers (GUIDs)** – GUIDs are a Microsoft standard that extend UUIDs, if an Ethernet card exists. If one doesn’t, GUIDs hash a software ID and the current date and time to produce a value that is guaranteed to be unique to the machine that creates it.
To add columns to a table, follow these steps:

1. Double-click the Entity shape that represents the table to which you want to add a column on the drawing page.

2. In the Database Properties window, click Columns in the Categories list, and then use one of the following methods to add the column:
   - Click the Physical Name field in a blank line and type the name you want for the column. To add additional columns, press Enter or the Down Arrow key and type the next column name.
   - Click Add. Visio generates a default name for the column using the naming conventions you specified in the Database Modeling Preferences dialog box. If you want to change the name, double-click the physical name and type a new one.

3. Select the Portable Data Type or Physical Data Type option to specify the data types you want to use. Portable Data Types are generic data types you can use in any database. Physical Data Types correspond to the data types supported by the database management system you’re using.

4. To designate a column as a primary key for the table, check the PK check box for the column you want to act as the primary key.

   If you want the primary keys to appear at the top of the table, choose Database ‹ Options ‹ Document, select the Table tab, and then select the Primary Keys at Top option. To display a separator line between the primary keys and other columns, check the Draw Separator Line check box.

5. To specify or change the data type for a column, click the column’s Data Type field and select the data type from the list.

   You can also change the data type when you click Edit to access other column properties.
6. To require values for the column, select its Req’d check box.

7. To edit the properties of the column, click Edit and select the following tabs to specify column properties:

- **Definition** — Specify physical and conceptual names and whether you want to synchronize the two as you type. You can specify a default value and whether the default value is a literal or an expression. For optional columns, check the Allow NULL Values check box.

- **Data Type** — Specify the data type you want in the Data Type box and choose whether you want to use portable or physical data types.

- **Collection** — Specify whether the column contains a single value, a set of values, an ordered list of values, or values that can include duplicates.

- **Check** — Specify check clauses for the column.

- **Extended** — If your database supports extended attributes, set them in this tab.

- **Notes** — Add notes about the column.

### Creating Additional Data Types

Each column in a table has an associated data type that determines the kind of information you can store in that column. When you choose the Portable Data Types option in the Database Properties window, you can select from data types that are independent of the specific database management system you’re using. If you are building a diagram for a specific type of database or have reverse-engineered a database, you can choose the Physical Data Type option to use the data types for that database.

You can view the field types you use in the Types window. It lists built-in logical data types for your target database, composite types, and portable data types you create within the User Defined Data Types dialog box.

In addition, you can define your own data types, including composite data types. Composite data types can contain sets of several data types. Although they appear as distinct elements in a diagram, you can optimize the performance of your database by storing several values as one element. You can also use composite data types to create typed tables and views.

To create a user-defined data type, follow these steps:

1. Choose Database ‣ User Defined Types and click Add in the User Defined Types dialog box.

2. In the Add New User Defined Type window, type the name for the new data type. If you want to base the new type on an existing user-defined data type, check the Copy From check box and then select the data type in the list. Click OK.
3. Specify the data type category, data type, size, length, and scale as necessary. If you want to add a description of the data type, type text in the Description box. Click OK when you're done.

To create a composite data type, follow these steps:

1. Drag a Type shape from the Object Relational stencil onto the drawing page.
2. Double-click the Type shape and then click Definition in the Categories list in the Database Properties window.
3. Type the name you want for the composite data type in the Name box and choose one of the Composite Type options.
4. To specify other properties for the composite type, click a category in the Database Properties window and specify the properties and settings you want.

Reordering Columns
If the columns in a table don’t appear in the order you want, you can reorder them. For example, after you define the primary key and index columns, you can reorder the columns so that the primary keys appear first. To reorder columns in a table, double-click the Entity shape that represents the table that you want to reorder and click Columns in the Categories list in the Database Properties window. Click the column you want to move and then click Move Up or Move Down.

Tip
You can move several columns at once by Shift+clicking the first and last column in a group of contiguous columns and then dragging the columns to a new location in the column list.

Defining Database Views
Database views provide more than a pretty picture of your data. By using views, you can assemble information from several tables without modifying the structure of your underlying database. You can also use views to manipulate data and control access to information, or to encapsulate access to database tables, as described in *Agile Database Techniques* by Scott Ambler (Indianapolis: Wiley, 2003). In Visio, you can create views by dragging View shapes from the Entity Relationship or Object-Relational stencils onto the drawing page. When you do this, Visio automatically creates the SQL code to define the view.

To create a view, follow these steps:

1. Drag a View shape onto the drawing page.
2. If the Database Properties window isn’t open, double-click the View shape and then type the view name in the Physical Name box.
3. Click Columns in the Categories list and then use one of the following meth­ods to add columns to the view:

   - Click the Physical Name field in a blank line and type the name you want for the column. To add additional columns, press Enter or the Down Arrow key and type the next column name.

   - Click Add. Visio generates a default name for the column using the naming conventions you specified in the Database Modeling Preferences dia­log box. If you want to change the name, double-click the physical name and type a new name.

4. To specify the source for the column, click the name of the column and then click Edit.

5. In the View Column Properties dialog box, select the Source tab, click the Known Column in Another Table or View option, and then click Change.

6. In the Pick a Column dialog box, select a column from the list of tables and views in your database model and click OK.

   You can also choose the Derivation Rule option and then specify how to derive the information you want to display in the column.

7. Modify any of the other settings you want in the View Column Properties dia­log box and then click OK. Repeat steps 4 through 6 to edit each column added in step 3.

Creating Relationships Between Tables

When you create a relationship between two tables, the child table is assigned the foreign key attributes of the parent. In Visio, you use the Relationship connector to create parent-child relationships. By specifying properties for a Relationship con­nector, you can define the parent and child in the relationship, the key you want to use to join the tables (in case the primary key isn’t what you want), the referential integrity rules, and the optionality and cardinality of the relationship.

To add a relationship between two tables and specify the relationship’s properties, follow these steps:

1. Click the Connector tool on the Standard toolbar.

2. Position the Connector tool over the parent Entity shape. When Visio outlines the parent Entity shape in red, drag to the center of the child Entity shape and release the mouse button when the child Entity shape is outlined in red. Visio changes the Relationship connector end points to red and displays the pri­mary keys for the parent Entity shape as foreign keys in the child Entity shape.

3. To specify the properties for the relationship, double-click the Relationship connector on the drawing page.
4. To specify the cardinality of the relationship, in the Database Properties window, click Miscellaneous in the Categories list. Choose one of the cardinality options.

**Tip**

If the Database Properties window is not open, double-click a shape on the drawing to open the window.

5. To specify the referential integrity actions, click Referential Action in the Categories list and then select options to specify the actions to perform when a parent is updated or when a parent is deleted. You can choose from No Action, Cascade, Set NULL, Set Default, and Do Not Enforce.

### Creating and Editing Indexes

Database management systems use indexes to speed up searching and sorting the records in databases. You can significantly improve the performance of a database by defining indexes for columns you plan to search frequently. In the Database Properties window, you can create and edit indexes for columns or modify indexes extracted during the reverse engineering process.

When Visio extracts indexes during reverse engineering, it automatically applies uniqueness constraints to primary keys, unique indexes to alternate keys in an IDEF1X model, and non-unique indexes for inversion entries in an IDEF1X model.

To create a new index for a table, follow these steps:

1. Double-click an Entity shape that represents the table to which you want to add an index.
2. In the Database Properties window, click Indexes in the Categories list and then click New.
3. In the Create Index dialog box, type a name for the index and click OK.
4. To specify the type of index, such as Unique Index Only, select a type in the Index Type drop-down list.
5. In the Available Columns list, select each column you want to include in the index and click Add.

**Note**

You can Shift+click or Ctrl+click to select multiple columns for the index.

6. In the Indexed Columns list, uncheck the ASC check box if you want the index to use descending sort order. The Disp. Name field represents the index notation that Visio displays on the database model diagram.

**Note**

If you want to specify extended attributes for a database management system that supports them, click Options.
Editing Database Code

The Code window lists the code that is associated with your model, including code extracted during reverse engineering of a database. From the Code window, you can view the code for your model, write new code, and edit or delete existing code. Check clauses and triggers for tables are also available when you click the Check category and Triggers categories, respectively, in the Database Properties window.

When you write or edit code in Visio, it’s a good idea to use a mirror file to store your code. A mirror file is a separate file that you can save, access outside of Visio, and manage using your source code control application. To specify a mirror file for code, select the Properties tab in the Code Editor window and type the path and filename in the Mirror File File Name box.

Code listed in the Global Code category includes stored procedures, functions, and other platform-specific types of data definition language code. Local code includes triggers and check clauses specific to a table or column in a model. Entries in the Code window include the name of the table or view that uses the code. You can work with the following types of database code:

- **Check clauses** — To define check clauses for a table, double-click the Entity shape that represents the table and then click the Check category in the Database Properties window. Click Add to open the Code Editor. You can specify the check clause name on the Properties tab and type the SQL statements in the box on the Body tab. Check clauses appear in the Local Code list in the Code window.

- **Stored procedures** — To create a stored procedure, click Global Code in the Code window and then click New to open the Code Editor. Type the name of the stored procedure on the Properties tab. Select one of the Stored Proc, Function, or Raw DDL options. Type the SQL statements on the Body tab. If the Code window isn’t open, choose Database ➪ View ➪ Code.

- **Triggers** — To create a trigger, double-click the Entity shape that represents the table to which you want to apply a trigger and then click the Triggers category in the Database Properties window. Click Add to open the Code Editor. You can specify the trigger name on the Properties tab and type the SQL statements in the box on the Body tab. Triggers appear in the Local Code list in the Code window.

- **View SQL Code** — Double-click the View shape whose SQL code you want to edit and click the SQL category in the Database Properties window. Uncheck the Auto-Generated check box and edit the code.

The Code Editor provides several tools and shortcuts to help you edit your database code, which are described in Table 19-1. To specify settings for editing code, click the Window Properties icon in the Code Editor toolbar to open the Window Properties dialog box.
Table 19-1

<table>
<thead>
<tr>
<th>Editing Task</th>
<th>Visio Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert code skeleton</td>
<td>To insert a skeleton for the type of code you are editing, click the Insert Code Skeleton icon on the Code Editor toolbar.</td>
</tr>
<tr>
<td>Print the code for an item</td>
<td>Click the Print icon in the Code Editor toolbar.</td>
</tr>
<tr>
<td>Change code keyword colors</td>
<td>To highlight code keywords in different colors, click the Window Properties icon in the Code Editor toolbar, select the Color/Font tab, select Keywords in the Item list, and select the color you want to use. You can specify colors and font styles for several other code elements, such as line numbers and comments.</td>
</tr>
<tr>
<td>Automatically indent lines</td>
<td>To specify how the Code Editor indents lines, click the Window Properties icon in the Code Editor toolbar, select the Language/Tabs tab. Select the Follow Language Scoping option and select the language to which the scoping rules should be applied. Select Copy from Previous Line to use the same indentation as the previous line.</td>
</tr>
<tr>
<td>Assign keyboard shortcuts</td>
<td>To define keyboard shortcuts for frequently used commands, click the Window Properties icon in the Code Editor toolbar, select the Keyboard tab, select a command, and assign a keyboard shortcut.</td>
</tr>
<tr>
<td>Number lines automatically</td>
<td>Click the Window Properties icon in the Code Editor toolbar, select the Misc tab, select the Numbering style you want to use in the Style drop-down list, and type the starting line number in the Start At box.</td>
</tr>
</tbody>
</table>

Setting Database Options and Preferences

You can specify settings and preferences to control how shapes look and behave in your Visio model and database model diagram. For example, modeling preferences include options for deleting an object from a model and diagram. Database document options control the type of notation you use as well as other display options. For the database management systems that support them, extended attributes enable you to fine-tune object definitions in your model.

By default, Visio applies default options stored in the Database Model Diagram template to new diagrams you create. However, you can change these settings and use them for future diagrams.
Setting Modeling Preferences

You can use database modeling preferences to control shape behavior and naming in your database model. Visio uses the settings you choose for each new database model diagram you create until you change the settings again. To specify modeling preferences, choose Database ➪ Options ➪ Modeling. In the Database Modeling Preferences dialog box, select the Logical Diagram tab to specify the following preferences:

✦ **When Removing an Object from the Diagram** — You can choose to remove objects from the model as well as the drawing page, remove objects from the drawing page only, or ask the user what to do.

✦ **Show Relationships After Adding Table to Diagram** — Check this check box to show relationships for new tables you add to a diagram.

✦ **Show Relationships After Adding Type to Diagram** — Check this check box to show relationships for new types you add to a diagram.

✦ **Sync Conceptual and Physical Name in New Tables and Columns When Typing** — Check this check box if you want the changes you make to a name in one field in the Database Properties window to propagate automatically to the other field.

Select the Logical Misc tab to specify the following preferences:

✦ **FK Propagation** — Check Propagate on Add if you want Visio to create a foreign key relationship between parent and child tables when you connect them with a Relationship connector. Check Propagate on Delete if you want Visio to remove a foreign key relationship when you delete a Relationship connector.

✦ **Name Conflict Resolution** — Select the action you want Visio to take when you add a foreign key that uses the same name as a column in the child table.

✦ **Default Name Prefixes** — Specify the prefix you want to use in the default conceptual name for objects in a database model.

✦ **Default Name Suffixes** — Specify the suffix you want to add to the default prefix of the default conceptual name for objects in a database model.

✦ **FK Name Generation Option** — Specify the objects to use when automatically generating foreign key names. In the FK Name Generation Option list entries, the object, Suffix, inserts the text you typed in the Foreign Key box under Default Name Suffixes into the generated FK name.
Specifying Notation and Other Display Options

You can control the appearance of shapes in a database model diagram by specifying the database notation type. For example, IDEF1X notation shows a table as a rectangle with the conceptual name above the rectangle. Relational notation shows the conceptual name in a shaded section at the top of the table rectangle. You can also specify other display options, such as the level of detail you want to show and whether you use crow’s feet to show relationships. Choose Database ‣ Options ‣ Document and then use one of the following methods to specify notation and display options:

✦ **Notation** — To specify IDEF1X or relational notation, select the General tab, select either IDEF1X or Relational under the Symbol Set heading, and click OK.

You can switch between IDEF1X and relational notation whenever you want. If you collaborate with someone who prefers a different notation, you can change the notation each time you receive a copy of the file.

✦ **Crow’s Feet** — To specify how relationships are shown, select the Relationship tab. To use crow’s feet to show relationships such as one-to-many, check the Crow’s Feet check box.

✦ **Cardinality** — When the Crow’s Feet check box is unchecked, you can check this check box to display cardinality notation on Relationship connectors.

✦ **Referential Integrity** — Select the Relationship tab and check this check box to display symbols on Relationship connectors to indicate referential integrity constraints.

✦ **Level of Detail** — Select the Table tab and check or uncheck check boxes to specify the information you want to display on your diagram. For example, you can show keys, indexes, annotations, data types, and IDEF1X optionality.

Creating Express-G and ORM Diagrams

Express-G and ORM are notations designed to convey special types of information. For example, with Express-G notation, you can create entity-level and schema-level diagrams to document product data so it can be interpreted and exchanged via computer. Object Role Modeling captures business rules and describes them in terms of real-world objects and the roles they play in processes. ORM diagrams provide documentation for these rules so you can design databases to support them.
Note

You can build ORM models that you can engineer into databases using Visio for Enterprise Architects, which is a part of the Visual Studio .Net Enterprise product.

Using Express-G to Create Entity-Level and Schema-Level Diagrams

The Express-G stencil contains shapes and connectors to represent entities and relationships for Express-G diagrams. You can construct an Express-G diagram by dragging shapes from the Express-G stencil to the drawing page. To build an Express-G diagram, follow these steps:


2. To add an entity or data type to the drawing, drag an Entity shape or one of the following data shapes from the Express-G stencil onto the drawing page:
   - **Base types** — Uses a custom property to specify the data type as Binary, Boolean, Integer, Logical, Number, Real, or String.
   - **Enumerated type** — Type the data type you want in the Data Type custom property.
   - **Defined type** — Type the data type you want in the Data Type custom property.
   - **Select type** — Type the data type you want in the Data Type custom property.

3. To change an entity name or data type, use one of these methods:
   - **Entity** — Right-click the Entity shape, choose Set Entity Name from the shortcut menu, and type a new name or entity type.
   - **Data type** — Right-click the data shape, choose Set Data Type from the shortcut menu, and type a new data type.

   If your diagram is larger than one page, you can use To-page reference shapes and From-page reference shapes to indicate that the diagram continues on another drawing page. You can connect these reference shapes to Entity shapes and data shapes and add hyperlinks to make it easy to navigate between pages.

4. To reference foreign schemas, drag a USED Entity or REFERENCED Entity shape onto the drawing page. You can specify the schema details at any time by right-clicking the shape and choosing Set Schema Details from the shortcut menu.
5. To show relationships on the diagram, drag one of the following connectors onto the page. You can specify or change the type of relationship by right-clicking the connector, choosing Set Attributes from the shortcut menu, and typing or selecting values in the custom property fields:
   • Cardinality
   • Inverse cardinality
   • Normal r’ship
   • Subtype/supertype

6. To include schemas and boundaries, drag Schema and Boundary shapes onto the page.

   Note
   If you want to view only entities and data shapes on an Express-G diagram, you can assign your Express-G entities and relationships to different layers and then turn off the visibility of the relationship layer. To assign shapes to a layer, select the shapes you want, choose Format ➤ Layer, check the layer to which you want to assign the shapes, and then click OK.

Creating Object Role Model Diagrams

To create an ORM diagram in Visio, choose File ➤ New ➤ Database ➤ ORM Diagram. After Visio creates a new drawing and opens the ORM Diagram stencil, you can drag shapes and connectors onto the page to document the components of your diagram:

   Note
   To learn more about the uses and benefits of ORM diagrams, see the books and online resources provided in the “Exploring the Database Model Templates” section earlier in this chapter.

   ✦ Entity types — To represent a real-world object, drag an Entity shape onto the drawing page. While the shape is selected, type the entity type’s name. To include the entity reference, press Enter and type the reference mode in brackets, such as <Serial Number>.

   Entity types are also referred to as facts.

   ✦ Values — To represent a value that is stored in the database, drag a Value shape onto the drawing page and type the name for the value type. Press Esc to end your text entry.
Value types are also referred to as *references*.

- **Subtypes** — To indicate that one entity type is a subtype of another, glue a Subtype connector to the two Entity shapes, with the arrowhead on the connector pointing to the subtype Entity shape.

- **Relationships, roles, or facts** — In ORM, predicates containing one or more roles indicate relationships between entity types or between entity types and value types. To show relationships and roles, drag a Predicate shape with enough role boxes to relate all the associated entity types on the drawing and then glue Role connectors between each Entity shape and a role box on the Predicate shape:
  - **Unary** — Includes only one role.
  - **Binary** — The most commonly used predicate indicates relationships or roles between two entity types or between an entity and a value.
  - **Vertical Binary** — This predicate shows a binary relationship but is oriented vertically.
  - **Ternary** — Indicates relationships between three entities.
  - **Quarternary** — Indicates relationships between four entities.

To add the names for the roles that an entity type plays, double-click the Predicate shape, place the insertion point between the ellipsis in the text block, and type the name for the role.

- **Nested entities** — To indicate nested entities in an ORM diagram, use the Rectangle tool to draw a rectangle around the Predicate shape you want to designate as an objectified predicate. Select the rectangle, choose Format ▶ Corner Rounding, click the third rounding option in the top row, and click OK.

- **Mandatory roles** — Mandatory roles mean that every member of an entity type must play that role, so null values are invalid in the relationship. To indicate that a role is mandatory, glue the Mandatory Role connector to the Entity shape and the Predicate shape.

- **Uniqueness** — To show that a role is unique, drag the Uniqueness Constraint shape onto the drawing page and place it directly above or below the Predicate shape you want to constrain.

The Uniqueness shape is sized so that it can be glued to the connection points above a role in a Predicate shape.

- **Frequency** — To show that each instance of a role occurs a specific number of times, drag the Frequency Constraint shape onto the drawing page and place it near the Predicate shape you want to constrain. With the Frequency Constraint shape selected, type the number of times the role occurs.
✦ Subset or Equality constraints — To indicate a subset or equality constraint, drag the Subset Constraint or Equality Constraint shape onto the drawing page and place it between the Predicate shapes whose roles you want to constrain. Glue one end point of the Constraint shape to a role box on one Predicate shape. Glue the other end point of the Constraint shape to the corresponding role box on the other Predicate shape.

✦ Ring constraints — To show that an entity type plays two roles in a predicate, drag a Ring Constraint shape onto the drawing page near the Predicate shape with the two roles you want to constrain. Depending on whether the Predicate shape includes two or more roles, use one of the following methods to indicate a ring constraint:

- **Two roles** — For a binary predicate, you show only the constraint type with no line between the roles. Right-click the Ring Constraint shape and choose Format ➪ Line from the shortcut menu. Click None in the Pattern drop-down list and click OK.

- **Three or more roles** — Glue the end points of the Ring Constraint shape to the roles you want to constrain in a Predicate shape.

To designate the type of ring constraint, double-click the Ring Constraint shape and type a two-letter abbreviation. Use “ir” to indicate an irreflexive constraint or “as” to indicate an asymmetric constraint.

✦ External constraints — To show an external constraint, drag one of the External Constraint shapes (Ext. Freq., Ext. P, Ext. Mand., or Ext. Uniq.) onto the drawing page near the Predicate shape whose roles you want to constrain. Glue a Constraint connector to the role box on the Predicate shape and a connection point on the External Constraint shape.

### Summary

Database templates are available only in Visio Professional. You can draw Express-G and ORM database diagrams using basic Visio techniques. If you use the Database Model Diagram template, you can create both a diagram and model for your database. You can also reverse engineer existing databases into Visio models. In a Visio model, you can create additional objects, modify the properties of objects, and update the physical database with those changes.
Building UML Models

Developing an overall architecture and design before you begin to write code helps you produce a software system that meets requirements and is easier to develop and maintain in the long run. As you model a software system, you progressively develop the detail of that system, alternately decomposing high-level objectives and broad requirements into manageable pieces, and then assembling software components into packages and eventually a complete run-time system. Models and diagrams make it easier to visualize both high-level architecture and low-level components, so you can make the most of design opportunities or spot potential problems before you write code.

The Unified Modeling Language (UML) defines diagrams and the semantics behind them for modeling software systems through each phase of the software development life cycle, as specified by the Object Management Group (www.omg.org), which is the not-for-profit consortium that produces and maintains specifications for interoperable enterprise applications. In Visio Professional, you can build object-oriented models using the UML Model Diagram template, which contains stencils and shapes that use the UML notation and support the different types of diagrams used with UML. One Visio drawing file can contain all the models and diagrams for one software system. You can build and work on models in the hierarchical view provided by the UML Model Explorer window or on diagram drawing pages. In addition, the UML Model Explorer window is a handy tool for navigating to the diagram or component you want.

In addition to constructing models for new software systems, the UML Model Diagram template can help you model existing systems. You can reverse engineer projects created in several Microsoft programming languages and generate UML static structure models for those projects.
Note
The UML Model Diagram template is available only in Visio Professional and Visio Studio .NET Enterprise Architect.

In this chapter, you are introduced to the templates and stencils that Visio offers for UML, and you learn how to use the modeling tools that Visio provides for building UML models. In addition, you will learn how to work with each type of UML diagram that Visio offers, and examine the differences between Visio's UML shapes and terminology and those used in the current UML 2.0 specification.

Exploring the UML Model Diagram Template

Large or complex software systems require a coordinated development approach in which teams can collaborate on analysis and design for each phase of a system lifecycle. The UML methodology and Visio Professional's UML Model Diagram template provide tools to model and document each phase of system design and development.

The UML Model Diagram template includes stencils for several types of UML diagrams you create during a development project. Although this chapter describes only the basic approach for specifying properties, you can specify dozens of properties for most of the shapes on the UML stencils to represent the different attributes and conditions that UML supports. You can double-click any shape on a drawing page or an element in the Model Explorer window to open its UML Properties dialog box. If you're not sure what a property does, click the Help button in the lower-left corner of the dialog box.

Caution
Visio 2003 is far from a perfect solution for producing UML models. Its UML templates do not fully support the entire UML notation and in some cases, its support for UML notation does not match the current UML specification. Visio 2003 still uses nomenclature from earlier UML specifications for UML diagrams and doesn’t support Composite Structure diagrams, Interaction Overview diagrams, Object diagrams, and Timing diagrams for the UML 2 specification. However, in many cases, these discrepancies won’t prevent you from performing your work.

Cross-Reference

If you are new to UML and don’t know which Visio diagram you should use, consider the following resources to increase your knowledge:

✦ The Object Primer, 3rd Edition: Agile Model Driven Development with UML 2.0 by Scott Ambler (New York: Cambridge University Press, 2001). This book is a distillation of software development practices and provides a comprehensive description of all 13 UML diagrams in addition to other critical models.


✦ [www.agilemodeling.com/essays/umlDiagrams.htm](http://www.agilemodeling.com/essays/umlDiagrams.htm) provides a good overview of the UML 2.0 diagrams. Think of it as a free, online version of *UML Distilled*.

## Choosing the Right UML Diagram

Within the Software template category, Visio Professional provides only one template for UML: the UML Model Diagram template. When you create a new drawing file with this template, Visio opens stencils for each type of UML diagram you can create. As you proceed through phases in your project, you can create different UML diagrams using the stencils listed in Table 20-1.

<table>
<thead>
<tr>
<th>UML Diagram</th>
<th>Stencil</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Case Diagram</td>
<td>UML Use Case</td>
<td>Shows use cases, actors, and their interrelationships. Used to present an overview of usage requirements and/or the analysis model for your system.</td>
</tr>
<tr>
<td>Class Diagram (the Visio 2003 stencil is misnamed)</td>
<td>UML Static Structure</td>
<td>Shows the classes of a system, including their operations, attributes, and inter-relationships. Typically used for several purposes, including the exploration of domain concepts in the form of a domain model, the analysis of requirements, or the presentation of the detailed design of object-oriented software.</td>
</tr>
<tr>
<td>Package Diagram</td>
<td>UML Static Structure UML Use Case</td>
<td>Shows how related elements in a software system are grouped into packages. Commonly used to group classes or use cases.</td>
</tr>
</tbody>
</table>

Continued
Table 20-1 (continued)

<table>
<thead>
<tr>
<th>UML Diagram</th>
<th>Stencil</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Diagram</td>
<td>UML Activity</td>
<td>Similar to flowcharts and data flow diagrams in structured development, these diagrams are often used to show high-level business processes, including data flow, or to model complex logic within a system.</td>
</tr>
<tr>
<td>Statechart Diagram</td>
<td>UML Statechart</td>
<td>Shows the dynamic behavior of entities in response to events based on their current state. Used to explore complex behavior of classes, actors, subsystems, or components. Also used for modeling hardware and real-time systems.</td>
</tr>
<tr>
<td>Sequence Diagram</td>
<td>UML Sequence</td>
<td>Shows the classifiers, such as classes, objects, components, and use cases, that participate in an interaction, and the sequence and timing of events that they generate. Used to explore potential usage of a system, to determine the complexity of classes, and to detect potential bottlenecks in an object-oriented system.</td>
</tr>
<tr>
<td>Collaboration Diagram</td>
<td>UML Collaboration</td>
<td>Shows instances of classes, their interrelationships, and messages exchanged during an interaction. Typically depicts the organization of objects that send and receive messages.</td>
</tr>
<tr>
<td>Component Diagram</td>
<td>UML Component</td>
<td>Documents the components within an application, system, or enterprise, as well as component interrelationships, interactions, and public interfaces. Also used as a high-level architecture model.</td>
</tr>
<tr>
<td>Deployment Diagram</td>
<td>UML Deployment</td>
<td>Shows the structure of deployed systems and the configuration and deployment of hardware and software components. Also used as a high-level architecture model.</td>
</tr>
</tbody>
</table>
Tip

If you would like to see examples of each of the UML diagram types, you can download a sample file from the Downloads section of Microsoft Office Online. Choose Help ➪ Microsoft Office Online. On the Microsoft Office Online Web site, select Download in the Search drop-down list. Type Visio 2003 sample in the Search text box and click the green arrow. To download an executable file with 20 sample diagrams of different types, click Visio 2003 Sample: 20 Sample Diagrams in the Search Results list and follow the instructions for downloading and installing the file on your computer. After you extract the sample .vsd files, you can open them as you would any Visio drawing file.

For UML style guidelines that help you develop readable, high-quality diagrams, visit www.modelingstyle.info.

Exploring the UML Menu

When you use the UML Model Diagram template to create a new Visio drawing file, the UML menu appears on the Visio menu bar. Unlike the Database menu, which appears when you create a database model diagram using the Visio Database Model Diagram template, the UML menu doesn’t include any wizards. However, you can use it to create, view, or modify system elements such as models, packages, stereotypes, and events. You can also display or hide the UML windows and specify options for the appearance and behavior of elements in your models and diagrams. Choose UML on the menu bar and then choose the following commands on the UML menu:

✦ **Models** — Opens the UML Models dialog box, in which you can create or modify models for your system.

✦ **Stereotypes** — Opens the UML Stereotypes dialog box, in which you can create or modify stereotypes to extend UML functionality.

✦ **Packages** — Opens the UML Packages dialog box, in which you can create or modify packages for your system. This dialog box lists the packages for the different data types within your system, not packages that you create within models.

✦ **Events** — Opens the UML Events dialog box, in which you can create or modify events within any of the packages in your system. This dialog box lists all packages in your system in the Packages list box. To add an event, select the package to which you want to add the event and then click New.

✦ **View** — Choose Model Explorer, Properties, or Documentation from the View submenu to toggle between hiding and displaying those windows.

✦ **Options** — Opens the Options dialog box, in which you can specify options for default behavior for shapes, packages, object names, and more in the UML Model Diagram template.
If Visio encounters an unexpected error from either an internal or external source, your template-specific menus, such as the UML menu, can disappear. If Visio shuts down unexpectedly, restart it and then choose Tools | Options. Select the Advanced tab, check the Enable Automation Events check box, and click OK. Save any open drawings, exit and restart Visio, and then reopen your UML model drawing file.

**Updating UML Shapes**

In Visio releases, the UML Model Diagram template frequently implements new shape behaviors. When you open a UML model drawing file, Visio opens the Update Shapes dialog box if it finds older versions of UML shapes. Microsoft recommends that you keep shapes up to date, but you don’t have to. However, if you choose not to update shapes, they continue to behave as they did in the earlier version of Visio, and include the same shortcut menus they had in the earlier version.

If you don’t update shapes when you open a diagram, you can update them later by choosing Tools | Add-Ons | Visio Extras | Update Shapes.

**Working with UML Models**

In Visio Professional, you can build UML models that act like blueprints for the system you want to develop. Whether you work in the Model Explorer window or with diagrams on drawing pages, you can use UML models and diagrams to develop your system from requirements through deployment.

**Working with the Model Explorer**

You can represent an entire software system within one Visio drawing file, although that file typically contains multiple models and diagrams. The Model Explorer window displays the elements of a system as a hierarchy, including models and packages that you use to organize the system as well as diagrams that present different views of the system. In addition to viewing and navigating an entire system, you can also use the UML Model Explorer to create diagrams, add elements, or apply properties to elements.

When you create a UML drawing file, Visio adds several elements by default. As you work, you can create additional elements or organize them within the model hierarchy, as shown in Figure 20-1.
System being modeled
One model of system
Add new diagram or element by right-clicking in Model Explorer window.

Figure 20-1: You can view, navigate, and modify system elements in the Model Explorer window.

The hierarchy in the Model Explorer window includes the following elements:

- **System** — The top node of the hierarchy represents the system you’re designing or documenting.
- **Static Model** — By default, Visio creates a static model, which contains all the packages, elements, and diagrams for a software system model.
- **Top Package** — By default, for every static model in the system, Visio creates a top package, which contains all the elements and diagrams for that model. By right-clicking the top package, you can display a shortcut menu with commands for adding new elements to the package, renaming the package, or specifying its properties.
✦ **Package** — You can create additional packages within a model to organize your model elements, including subpackages nested underneath higher-level packages. The shortcut menu for packages includes commands for adding new elements to the package, duplicating, renaming, or deleting the package, or specifying its properties.

✦ **Static Structure** — By default, for each model in the system, Visio creates a Static Structure diagram within the top package. This diagram corresponds to a drawing page of the same name in the Visio drawing file.

✦ **Elements** — Within a package, you can create additional elements, including subsystems, classes, interfaces, data types, actors, and use cases.

The shortcut menu for every diagram in a model includes commands to open the diagram, rename it, or delete it from the model.

✦ **Data Types** — By default, Visio includes packages for common data types, including C#, C++, IDL, and Visual Basic. You can also create packages for your own data types.

You can’t delete the built-in Data Type packages, because the UML Add-on tool uses them.

### Using the UML Model Windows

The UML Model Diagram template includes several windows that make it easy to view and modify UML model elements and to navigate within the models and diagrams for your system:

✦ **The Model Explorer window** — Shows all the elements in a software system in a hierarchical tree. You can add elements or access their properties from this window.

To navigate to the drawing page for a diagram, double-click the diagram name in the Model Explorer window. If you want to display the drawing page that contains an element such as an actor, right-click the element, choose Views from the shortcut menu, select the diagram in the UML Diagram list, and then click OK.

✦ **The Properties window** — Shows the main properties associated with the selected element. The properties are for reference only. To edit element properties, right-click the element in the Model Explorer window and choose Properties from the shortcut menu. Although this window does not appear by default, you can open it by choosing UML ➪ View ➪ Properties.

✦ **The Documentation window** — Displays the documentation tagged value of the element you select on the drawing page or in the Model Explorer window. You can add documentation to the selected element by typing text in this window. Although this window does not appear by default, you can open it by choosing UML ➪ View ➪ Documentation.
When you open a new UML drawing file, the Model Explorer window appears by default and docks on the left side of the screen. You can hide or show each of the UML windows by choosing UML \textsuperscript{\textcopyright} View and then choosing the name of the window you want to hide or display. Although the Properties and Documentation windows don’t appear by default, Visio anchors them within the Model Explorer window when you display them. When more than one window is open at a time, Visio adds tabs for each window so you can switch among them.

You can also float each window individually by right-clicking its tab and choosing Float Window from the shortcut menu. If you want to float the entire window with all the UML windows in it, drag the window title bar to a new location.

**Organizing Models with Packages**

For large or complex software models, you can subdivide your models and diagrams into more manageable pieces by using packages in the Visio Model Explorer. Each model you create includes a top package, which contains all the elements, packages, and diagrams you create within that model. The top package in a model is like a big suitcase you pack for a trip. You can create additional packages within the top package to organize elements into smaller groups, as you might pack your travel toiletries in a smaller container within your suitcase. For more information about when to use Package diagrams and how to make the most of the Package diagrams you develop, see [www.agilemodeling.com/artifacts/packageDiagram.htm](http://www.agilemodeling.com/artifacts/packageDiagram.htm).

Each element in a model belongs to only one package. However, you can add any kind of model element to a package, including other packages, so you can partition the elements in your model any way you want. You can even use packages to partition diagrams when they become unwieldy. Use the following methods to package the contents of your model:

- **Create a package in a model** — Right-click a package in the Model Explorer window and choose New \textsuperscript{\textcopyright} Package from the shortcut menu. Visio adds a package icon to the model.

- **Add a package to a diagram** — Display the diagram drawing page you want to package. Drag the Package shape from the UML Static Structure, UML Use Case, UML Component, or UML Deployment stencil onto the drawing page. Visio adds a package icon to the model, with the diagram within the package.

- **Create a diagram from a package** — To automatically create a new diagram when you add a package to your model, choose UML \textsuperscript{\textcopyright} Options and select the UML Add-on tab. Make sure the Create a Diagram Page When a Package or Subsystem Shape Is Added to a Document check box is checked.

- **Show package contents on a diagram** — In the Model Explorer window, right-click the package whose contents you want to show on a diagram and choose the type of diagram you want from the shortcut menu. Visio displays the stencil for that type of diagram and opens a blank drawing page. Drag shapes for the elements you want to include in the package onto the drawing page.
Partition a diagram — In the Model Explorer window, create multiple diagrams within one package. You can drag the elements you want to include onto as many of the diagrams in the package as you want. Each instance refers to the same element in the UML model. To view all the references to an element on diagrams, right-click the element in the Model Explorer window and choose Views from the shortcut menu.

Working with Shapes and Model Elements

You can work on a UML model through shapes on diagram drawing pages or directly in the model using the Model Explorer window. In addition to adding and removing elements in a model, you can modify their properties to match the characteristics of your system. On UML diagrams, you can specify the element property values that appear on shapes.

Adding and Removing Elements in a Model

As you build or modify your UML model, the additions, changes, and deletions you make appear in the hierarchy shown in the Model Explorer window. When you drag shapes from stencils onto a diagram drawing page, Visio adds the elements that those shapes represent to the UML model. However, diagrams are merely views of a model, and you can choose what you want to display on them. This means that you can add elements to a model without adding them to a diagram, or drag an element in the Model Explorer window onto several drawing pages, creating multiple views of the same element.

You can use the following methods to add elements to a model:

- In the Model Explorer window, right-click a package or subsystem, choose New from the shortcut menu, and then choose the type of element you want to add to the model.
- Drag a shape that represents the element you want to add onto a drawing page.

Note

Elements added in the Model Explorer window do not appear on diagrams by default. After you add an element to a model in the Model Explorer window, you can add it to a diagram by dragging its icon from the Model Explorer window onto a drawing page.

If you want to remove an element from a model, right-click it in the Model Explorer window and then choose Delete from the shortcut menu. Visio deletes the element from the model as well as all UML diagrams.

Caution

If you delete a shape from a diagram, Visio deletes only the view of the element that the shape represents. The element remains in the model in the Model Explorer window.
Displaying Information in UML Shapes

The shapes on the UML stencils represent each element in the UML notation, and the behaviors for these shapes conform to UML rules. Although you don’t have to customize the appearance or behavior of UML shapes, you can change the values that appear on shapes in a diagram to show the information you want.

To specify the values that appear in UML shapes, right-click a shape in a UML diagram and choose Shape Display Options from the shortcut menu. Visio opens the UML Shape Display Options dialog box. You can specify values that you want to show or suppress in the following categories:

- **General options** — You can display the name, visibility, stereotype, operation parameters, properties, and realization links on a shape.
- **Attribute** — You can show attribute types, the initial value for attributes, and attribute multiplicity.
- **End Options** — For connectors, you can specify whether to show end names, multiplicity, navigability, and visibility.
- **Suppress** — Check these check boxes to suppress the display of attributes, operations, and template parameters. For connectors, you can suppress information at each end of the connector.

You can also choose whether to apply shape display options to other shapes. To apply the shape display options you selected to other shapes of the same type on the current drawing page, check the Apply to the Same Selected UML Shapes in the Current Drawing Window Page check box. To apply the options to new shapes you drop on the page, check the Apply to Subsequently Dropped UML Shapes of the Same Type in the Current Drawing Window Page check box.

Specifying Element Properties

The elements you add to a UML model include numerous built-in properties that support UML notation and behavior. To configure an element in a model, double-click the element in the Model Explorer window or the shape that represents it on a drawing page. Visio opens a properties dialog box for that element, such as the UML Class Properties dialog box for a class or the UML Use Case Properties dialog box for a use case. In the dialog box, you can select the category of properties you want to edit and then specify the properties you want, as shown in Figure 20-2.

You can use stereotypes, constraints, and tagged values in a UML <element> Properties dialog box to extend the behavior of elements in a system. To specify a stereotype for an element, select Class in the Categories list and then select the stereotype you want in the Stereotype drop-down list. To specify constraints, select Constraints in the Category list and then define the constraints you want. To add tagged values to an element, select Tagged Values in the Category list, select the tag you want, and then type the value in the Tag Value box.
Specifying UML Options

You can specify options to control the behavior of the UML Model Diagram template. For example, you can choose whether to use the lollipop or classlike version of an Interface shape, or whether to prompt before deleting a model element when you delete a shape on a drawing page. To specify the options for the UML Model Diagram template, choose UML \( \rightarrow \) Options to open the UML Options dialog box. Select the UML Add-on tab and then specify one or more of the following options:

- **Shape Ctrl-Drag Behavior** — To duplicate the UML element the shape represents, select Copy Object in the drop-down list. To create a view of the element the shape represents so that you can drag the shape to another package or diagram, choose Copy Object View in the drop-down list.

- **Create a Diagram Page When a Package or Subsystem Shape Is Added to a Document** — Check this check box to create a diagram page for every package or subsystem shape you add to a model.

- **Create Watermark on Drawing Page** — Check this check box to display a watermark that identifies the type of diagram the drawing page represents.

- **Prompt for Model Element(s) Delete on Delete of Shape(s)** — Check this check box if you want Visio to ask you if you want to delete the model element that a shape represents when you delete the shape on a drawing page.

- **Delete Connectors When Deleting Shapes** — Check this check box to delete the connectors glued to a shape when you delete the shape.
✦ On Drop of an Interface from the Model Explorer—Select an option to specify the default style you want to use for Interface shapes. If you want to show attributes on an Interface shape, select the Class-Like Interface Shape option.

✦ Auto Assign Name to Newly Created UML Model Element—Check this check box if you want Visio to generate names for elements you create. You can rename the elements after you create them.

Creating UML Models

When you create a new Visio drawing file with the UML Model Diagram template, Visio opens the stencils for each type of UML diagram, docks the Model Explorer window on the left side of the screen, and adds the UML menu to the Visio menu bar. In addition, the UML Model Diagram template creates several default model elements, including the Static Structure-1 diagram and a corresponding drawing page by the same name. UML diagrams use a letter-size drawing page with portrait orientation and no drawing scale. To create a new UML drawing file, choose File ➪ New ➪ Software ➪ UML Model Diagram.

You can create more than one model for a software system. To create a new model within the Visio drawing file, follow these steps:


2. In the UML Models dialog box, click a blank cell in the model column and type the name of the model.

3. To specify the properties for the model, click Properties in the UML Models dialog box. Select a category and specify the properties within that category. Click OK when you’re done.

   You can also access the properties for a model by right-clicking it in the Model Explorer window and then choosing Properties from the shortcut menu.

4. To add a diagram to the model, right-click a package in the Model Explorer window, choose New from the shortcut menu, and then choose the type of UML diagram you want to add. You can also right-click a drawing page and choose Insert UML diagram from the shortcut menu. Visio performs the following actions:

   • Creates a blank page named <diagram>-n, where <diagram> is the name of the type of diagram you are creating and n is the next number in the sequence of that type of diagram in the drawing file
   • Displays the new page in the drawing window
   • Brings the UML stencil for that type of diagram to the front in the Shapes window
   • Adds an icon for the diagram to the element to which you added it in the Model Explorer window
If you right-click a class or use case in the Model Explorer window and choose New from the shortcut menu, you can create diagrams appropriate for the selected element. You can choose from Static Structure Diagram, Activity Diagram, and Statechart Diagram for classes; and Activity Diagram and Statechart Diagram for use cases.

5. To add an element to the model, in the Model Explorer window, right-click a package, choose New from the shortcut menu, and then choose the element you want to add. You can also add subclasses to an existing class by right-clicking the class and choosing New ➪ Class from the shortcut menu.

Working with Static Structure Diagrams
(UML 2 Class Diagrams)

Early in the development life cycle, you create conceptual class diagrams to show the real-world objects represented by your system and the relationships between them. These diagrams help clarify the terminology used within the context of the system, and the classes of a system, including their operations, attributes, and interrelationships. You can use class diagrams to explore the domain concepts, to analyze system requirements, and to present the detailed design of object-oriented software. As you progress in the development cycle, class diagrams show the software classes that the system implements and how they relate to each other, as shown in Figure 20-3. Class diagrams specify attributes, associations, operations, methods, interfaces, and dependencies for the classes in a system.

Creating Static Structure Diagrams
To create a static structure diagram in an existing model, follow these steps:

1. In the Model Explorer window, right-click the package to which you want to add the static structure diagram and choose New ➪ Static Structure Diagram from the shortcut menu.

2. Drag Object or Class shapes onto the drawing page to represent real-world objects or the software classes that implement them in your system.

3. To specify properties for an object or class, double-click the object or class in the Model Explorer window or its corresponding shape on the drawing page. In the UML Object Properties dialog box, you can specify attributes, constraints, and tagged values for objects; in the UML Class Properties dialog box, you can specify attributes, operations, receptions, template parameters, components, constraints, and tagged values for a class. Click OK when you’re done.

When you select the Tagged Values category in the UML Object Properties or UML Class Properties dialog box, Visio displays default tags for the selected element. To add a value to a tag, select the tag you want to modify in the Tags list and type text in the Tag <tag> Value box. You can also add additional tags by clicking New.
Class
Association

Figure 20-3: Class static structure diagrams show information about a system's software classes.

4. To specify the information you want to display or suppress on shapes, right-click each object or class shape and choose Shape Display Options from the shortcut menu.

5. To show relationships between objects and classes, drag Association, Link, Dependency, Generalization, or Composition shapes onto the drawing page and glue them to the related objects or classes.

6. To specify properties for a relationship, double-click its relationship shape on the drawing page to open the UML <relationship> Properties dialog box, specify the properties you want, and click OK.

Troubleshooting UML Relationships
Relationship shapes have a few idiosyncrasies that might make them behave in ways you don't expect or don't want. For example, unlike other model elements, relationships appear only on drawing pages, not in the Model Explorer window. You must work on the drawing page to view, add, modify, or delete relationship shapes. Other behaviors that you might observe include the following:

✦ **Qualifier associations do not appear on diagrams**—The UML specification indicates that qualifier associations appear in UML diagrams, with attributes listed inside a box shape. In Visio, attributes of qualifiers are stored in the
properties pages for association ends. To view qualifier attributes, follow these steps:

1. Double-click an Association shape with a qualified association, which Visio indicates with a small box at one end.

2. In the UML Association Properties dialog box, under Association Ends, select the End Name that has the attributes you want to view and click Properties.

3. In the UML Association End Properties dialog box, select Qualifier Attributes under Categories to view the details of the qualifier association.

✦ Relationships persist after you delete them — If you delete an Association shape on one drawing page, the relationship it represents persists if shapes representing the associated elements exist on other pages. To remove a relationship from a model, you must delete all views of an Association shape.

You can find all the views of an association by right-clicking the Association shape and choosing Views from the shortcut menu. In the UML Diagram dialog box, select a view in the list and then click OK.

✦ Association shape labels don’t appear near the right shape — When several lines connect to the same shape, you might not be able to distinguish the shape to which a label applies. However, you can unlock and move text labels for Association shapes to make diagrams more legible by following these steps:

1. Select the Association shape whose label you want to move.

2. Choose Window ➪ Show ShapeSheet.

3. In the Protection section of the ShapeSheet, in the LockTextEdit cell, change the value from 1 to 0 and press Enter.

4. To move the label for the Association shape, click the Text Block tool on the Standard toolbar, select the label you want to move, and then drag it to a new location.

✦ Relationship lines appear for every instance of the same class — If you create more than one instance of a class, Visio displays relationship lines between every instance of the class and the other classes to which it relates. Although Visio is designed to do this, the multiple relationships lines can make your diagrams difficult to decipher. You can turn off the automatic display of additional relationship lines and then use the Show Relationships command from a shape’s shortcut menu to view its relationship lines. To turn off the automatic display of additional relationships lines, follow these steps:

1. Use the registry editor to access HKEY_CURRENT_USER\Software\Microsoft\Office\11.0\Visio\Solution\UML Solution.

2. Right-click the Automatic Instance UML Relationships registry entry, choose Modify from the shortcut menu, and change the value in the Value Data box from 1 to 0.
Creating Use Case Diagrams

In early stages of development, use case diagrams present an overview of how users (called actors) interact with and generate events in a system. Use case diagrams begin by showing the use cases in context within the system, highlighting the interaction of processes, rather than individual steps. As you progress, you can refine the diagrams to show more detail.

To create a use case diagram, in the Model Explorer window, right-click the package or subsystem to which you want to add the use case diagram and choose New ➤ Use Case Diagram from the shortcut menu. You can drag shapes from the UML Use Case stencil onto the drawing page to construct a use case diagram. After you have added a shape to the diagram, you can double-click it to open its UML <element> Properties dialog box and define any properties you want. Use the following shapes to show the actors, use cases, and interactions between them:

✦ **System Boundary** — Although few people use this symbol, you can drag this shape onto the drawing page to indicate the boundary of the system.

Tip

You can move a system boundary and all the use cases it contains by dragging a selection rectangle around the System Boundary shape and then dragging it to a new location.

✦ **Use Case** — Drag this shape onto the drawing page for each use case in the system and place it inside the system boundary.

✦ **Actor** — Drag this shape onto the drawing page for each actor in the system and place it outside the system boundary.

Note

Because an actor represents a role played by an external object, one physical object might be represented by more than one actor, and vice versa.

✦ **Communicates** — To indicate a relationship between an actor and a use case, click the Connector tool on the Standard toolbar, click the Communicates connector in the UML Use Case stencil, and then drag from the Actor shape to the Use Case shape.

Tip

To show the actor who initiates an interaction of the primary actor in a use case, double-click the Communicates shape. In the UML Association Properties dialog box in the Association category, check the IsNavigable check box for the end to which you want to add an arrow and click OK.

✦ **Extends** — To extend the behavior of one use case to another, click the Connector tool on the Standard toolbar, click the Extends connector in the UML Use Case stencil, and then drag from the Use Case shape with the behavior you want to extend to the Use Case shape that includes that behavior.
❖ **Uses**—To show that one use case uses the behavior of another, click the Connector tool on the Standard toolbar, click the Uses connector in the UML Use Case stencil, and then drag from the Use Case shape that contains the used behavior to the Use Case shape that uses that behavior. Visio draws an arrowhead at the end of the connector glued to the Use Case shape that uses the behavior.

In the UML 2 specification, the term “uses” has been replaced with “include.”

### Creating Activity Diagrams

Similar in many ways to data flow diagrams used in structured development, UML activity diagrams model business and software processes and can be used to depict logic for complex business rules and operations. They represent flows driven by internally generated actions, whereas statechart diagrams show flow in response to external events. Because activity diagrams emphasize parallel and concurrent activities, you can use them to model workflow, analyze use cases, and make sure that multithreaded applications perform properly.

To create an activity diagram in an existing UML model, follow these steps:

1. In the Model Explorer window, right-click the subsystem, package, class, use case, or operation to which you want to add the activity diagram and choose **New ➪ Activity Diagram** from the shortcut menu.

2. To indicate responsibility for activities, drag Swimlane shapes from the UML Activity stencil onto the drawing page for each class, person, or organizational unit you want to represent. You can double-click Swimlane shapes to add names and other property values or drag side selection handles to resize the lanes.

3. Drag Action State or State shapes onto the drawing page for each state you want to represent. Use the Initial State and Final State shapes for the first and last states.

4. To show the flow of control as one state changes to another, connect Control Flow shapes to Action State or State shapes. Click the Connector tool on the Standard toolbar, click the Control Flow shape in the UML Activity stencil, and then drag from the shape that represents the source state to the shape representing the state to which it changes.

   If you want to further define the transition between states, double-click the Control Flow shape on the drawing page and specify events, guard conditions, action expressions, and other information in the UML Transition Properties dialog box.

5. Double-click any shape to open its UML <element> Properties dialog box, specify the properties you want, and click OK.
Showing Complex Transitions

When one state forks into multiple parallel states, or several states synchronize into one state, you can use Transition shapes with Transition (Fork) and Transition (Join) shapes to show the transition. To represent a complex transition, follow these steps:

1. Drag a Transition (Fork) or Transition (Join) shape from the UML Activity stencil onto the drawing page.

2. Drag a Transition shape from the UML Statechart stencil onto the drawing page and glue it to the source State shape and the Transition (Fork) or Transition (Join) shape. When several states synchronize into one, repeat this step to add transitions from each of the original State shapes into the Transition (Join) shape.

3. Drag a Transition shape from the UML Statechart stencil onto the drawing page and glue it to the Transition (Fork) or Transition (Join) shape, as shown in the following figure. When one state forks into multiple parallel states, repeat this step to add transitions from the Transition (Fork) shapes to each forked State shape.

4. To use signal icons instead of transition strings with signal icons, drag Signal Send and Signal Receipt shapes onto the drawing page to represent the signals. Glue the control handles on these shapes to the source and destination Action State shapes.
Creating State Machine Diagrams

A state machine, which is attached to a class or use case, shows the dynamic behavior of an object in response to events, showing the responses to events based on the object’s current state. In Visio Professional, a statechart diagram represents a state machine. If you want to represent flow driven by internally generated actions, rather than external events, use an activity diagram instead.

To create a statechart diagram in an existing UML model, follow these steps:

1. In the Model Explorer window, right-click the class or use case that you want to document in the statechart diagram and choose New ➪ Statechart Diagram from the shortcut menu.

2. To show the states on the diagram, drag the following shapes onto the drawing page:
   - State — Represents the sequence of states through which an object passes
   - Composite State — Represents concurrent, mutually exclusive, or nested substates

   Visio creates a new statechart drawing page for a composite state. You can click the tab for the new statechart diagram in the drawing window to navigate to it. Drag State, Transition, Shallow History, or Deep History indicators and other shapes onto the drawing page to show the substates within the composite state.

3. To show transitions from one state to another in response to an event, click the Connector tool on the Standard toolbar, click the Transition shape in the UML Statechart stencil, and then drag from the first State shape to the next.

   You can show a state forking into multiple states or several states synchronizing into one by connecting Transition shapes to Transition (Fork) and Transition (Join) shapes, as described in the “Showing Complex Transactions” sidebar earlier in this chapter.

4. To show that an object remains in the same state in response to an event, drag the arc-shaped Transition shape onto the drawing page and glue both ends to the same State shape.

5. To show that an object resumes a state it held last within a region, drag a Shallow History or Deep History shape onto the drawing page and use Transition shapes to connect it to the source and destination State shapes.

6. Double-click any shape to open its UML <element> Properties dialog box, specify the properties you want, and click OK.
Creating Sequence Diagrams

Sequence diagrams are used to model the dynamic logic within classes and to show the time sequence of events generated by actors participating in an interaction. For example, you can use a sequence diagram to show the messages generated in a real-time transaction. In a sequence diagram, the horizontal dimension shows the actors or objects and the vertical dimension represents time. UML sequence diagrams are typically used to do the following:

✦ Expand and validate the logic for potential usage of a system.
✦ Walk through the invocation of the operations defined by your classes.
✦ Detect bottlenecks generated by messages being sent to objects within an object-oriented design. By examining the messages sent to objects and the time it takes to run an invoked method, you can identify design changes to better distribute the load within your system.
✦ Identify the classes in an application that are going to be complex, which therefore might benefit from the development of state machine (statechart) diagrams.

To create a sequence diagram in an existing UML model, follow these steps:

1. In the Model Explorer window, right-click the package or subsystem to which you want to add a sequence diagram, and choose New ➤ Sequence Diagram from the shortcut menu.

2. For each actor involved in the interaction, drag an Object Lifeline shape onto the drawing page and then drag the Object Lifeline control handle to define the length of the actor’s life in the interaction.

3. To indicate that the actor or object is destroyed during the interaction, right-click the Object Lifeline shape, choose Shape Display Options on the shortcut menu, and select Destruction Marker. Visio adds a black X at the end of the object’s lifeline.

   To apply this change only to the selected actor, in the UML Shape Display Options dialog box, make sure that the Apply to the Same Selected UML shapes in the Current Drawing Window Page check box is unchecked.

4. To define the classifier associated with an Object Lifeline shape, double-click the Object Lifeline shape to display the UML Classifier Role Properties dialog box. In the Classifier Role category, select the classifier that the actor represents in the Classifier drop-down list. Visio changes the appearance of the Object LifeLine shape to reflect the classifier you choose.
Tip

You can define your own classifiers by clicking New, specifying the properties for the class, and clicking OK.

5. To indicate when an actor performs an action, drag an Activation shape onto the drawing page and glue it to the actor’s Object Lifeline shape. Drag the end points of the Activation shape to correspond to the period during which the actor performs the action.

6. To indicate communication between actors, drag a Message shape onto the drawing page and glue it from the Actor shape sending the message to the Actor shape receiving the message.

Note

You can indicate transition times on a sequence diagram. For example, you can show how long a transition takes as well as any constraints on the time it takes to send a message. Use the Text tool to add a name that represents the time a message is sent. The convention is to show the name, usually a letter, in the left margin, aligned with the message to which it applies. If a message does not arrive instantaneously, slant the message line and name each end of the line. For the message received name, you can use the message sent name with a prime appended to it. For example, if the time a message is sent is a, the message receipt time is a'. You can indicate a constraint for the message time, such as \( b - a < 1\) sec by dragging a Constraint shape onto the drawing page near the message name, double-clicking the Constraint, and adding text in the Body text box.

7. Double-click any shape to open its UML element Properties dialog box, specify the properties you want, and click OK.

Creating Collaboration Diagrams

Collaboration diagrams are now called communication diagrams in the UML 2 specification. Like sequence diagrams, these diagrams show the exchange of messages between objects in response to system events, and imply the relationships between classes. Unlike sequence diagrams, collaboration diagrams do not show the sequence of messages by their position on the diagram. Instead, they use numbers associated with messages to indicate sequence. You can use communication diagrams to accomplish the following:

- Provide an overview of collaborating objects, particularly within a real-time environment.
- Allocate functionality to classes based on the behaviors within a system.
- Model the logic of complex operations, particularly those that interact with many other objects.
- Analyze the roles that objects play within a system, and the relationships associated with those roles.
To create a collaboration diagram in an existing UML model, follow these steps:

1. In the Model Explorer window, right-click the package in which you want to add a collaboration diagram, and choose New ➪ Collaboration Diagram from the shortcut menu.

2. For each actor or object role that collaborates in the interaction, drag a Classifier Role shape from the UML Collaboration stencil onto the drawing page.

3. To name the classifier role or specify other properties, double-click a Classifier Role shape. In the UML Classifier Role Properties dialog box, type the name in the Name box or select other properties for the role and then click OK.

4. To represent a set of objects, drag a Multi-Object shape onto the drawing page.

   A multi-object shows operations that affect an entire set of objects as a unit, rather than a single object within the set. To indicate an operation on each object in the set, use a single message with an iteration and include a many indicator (*) in the target role name.

5. To show links between objects, glue Association Role shapes to the Classifier Role or Multi-Object shapes. Double-click an Association Role shape to specify its name, message flow, message label, multiplicity, and other property values.

6. Double-click any shape to open its UML <element> Properties dialog box, specify the properties you want, and click OK.

---

### Creating Component Diagrams

UML component diagrams are typically used as architecture-level artifacts, to model the business software architecture and the technical software architecture for systems. You can enhance your architectural work by iterating between component diagrams for business and technical software architecture and UML deployment diagrams or network diagrams for the physical architecture.

Component diagrams help distribute development across large teams. Initially, your architectural modeling focuses on modeling the high-level software components and the interfaces to those components. After the team defines and agrees to the interfaces for the system, it’s much easier to assign development among smaller teams. As work progresses and you identify new requirements or needed changes, you can negotiate changes between teams and implement the modified interfaces. You can also use component diagrams to partition a system into components and use dependencies to indicate the relationships between components.
To create a component diagram in an existing UML model, follow these steps:

1. In the Model Explorer window, right-click the subsystem or package in which you want to add a component diagram and choose New Component Diagram from the shortcut menu.

2. For each component, drag a Component shape from the UML Component stencil onto the drawing page.

3. To add an interface to a component, drag an Interface shape from the UML Component stencil onto the drawing page and glue the end point without the circle to a connection point on the Component shape.

4. If you want to list the operations for an interface, right-click the Interface shape and choose Show As Class-like Interface from the shortcut menu. The operations you specify in the Operations category in the UML Interface Properties dialog box appear in the lower half of the rectangular Interface shape.

5. To show relationships between components or between a component and another component’s interface, click the Connector tool on the Standard toolbar, click the Dependency shape on the UML Component stencil, and then drag from one Component shape to the Component shape that depends on it.

5. Double-click any shape to open its UML <element> Properties dialog box, specify the properties you want, and click OK.

Creating Deployment Diagrams

Deployment diagrams, like component diagrams, provide a view of your system implementation. These diagrams illustrate the structure of the run-time system as well as the configuration and deployment of hardware and software. In deployment diagrams, nodes represent processing resources such as computers, mechanical processing devices, or human resources who perform processing activities. Components represent physical modules of code or business documents. You can use deployment diagrams to accomplish the following:

- Identify installation issues for your system.
- Identify the dependencies between your system and other current or planned production systems.
- Document the deployment configuration of a business application.
- Configure the hardware and software for an embedded system.
- Represent the network and hardware infrastructure of an organization.
To create a deployment diagram in an existing UML model, follow these steps:

1. In the Model Explorer window, right-click the subsystem or package in which you want to add a deployment diagram and choose New ➪ Deployment Diagram from the shortcut menu.
2. For each node in your system, drag a Node shape from the UML Deployment stencil onto the drawing page.
3. Drag Component and Object shapes into the Node shape to which they belong.

   Tip

   If you want to resize a Node shape, drag one of its selection handles.

4. To add an interface to a component, drag an Interface shape from the UML Deployment stencil onto the drawing page and glue the end point without the circle to a connection point on the Component shape.
5. To show relationships between nodes, click the Connector tool on the Standard toolbar, click the Communicates shape on the UML Deployment stencil, and then drag from one Node shape to another.
6. To show relationships between components or between a component and another component’s interface, click the Connector tool on the Standard toolbar, click the Dependency shape on the UML Deployment stencil, and then drag from one Component shape to the Component shape that depends on it.
7. Double-click any shape to open its UML <element> Properties dialog box, specify the properties you want, and click OK.

Reverse Engineering Code into UML Models

If you develop projects using Microsoft Visual C++, Microsoft Visual Basic, or Microsoft Visual C#, you can use Visual Studio to reverse engineer your source code into UML and generate a UML diagram in Visio from your project’s class definitions. For example, if you’re maintaining a legacy system, you can build a UML model to better understand the system and make software maintenance easier.

Visio includes Visio UML Add-Ins for Visual Basic and Visual C++, which provide toolbars you can use to reverse engineer source code to create a UML static structure model in Visio. The reverse-engineered code elements appear in the Visio Model Explorer window. Then, to create a UML static structure diagram, you can drag the elements from the model onto the drawing page.
Note
You can’t use the Visio 2003 UML reverse engineering add-ins for Visual Basic 6.0 and Visual C++ 6.0 simultaneously on the same machine.

Depending on the language you use, you can reverse engineer different aspects of a project. Visio reverse engineers the following elements:

- **Visual C++ 6.0** — Classes, user-defined types, enumerated types, member functions, member variables, and method parameters
- **Visual C++ 7.0** — Namespaces, classes, enums, structs, unions, member operations, member variables, method parameters, typedefs, template definitions, Inline function specifier, cv qualifier, conversion-function ID, and operator-function ID.
- **Visual Basic 6.0** — Classes, modules, and forms, functions and subroutines, parameters, constants, member variables, properties, events, and user defined types
- **Visual Basic .NET and Visual Studio .NET** — Namespaces, classes, interfaces, enumerated types, structures, properties, delegates, member operations, member variables, method parameters, events, and constants
- **Visual C#** — Namespaces, classes, interfaces, enumerated types, structs, properties, delegates, member operations, member variables, method parameters, and constants

Note
To prepare to use the Visio 2003 add-ins, shut down all instances of Visio and Visual Studio 6.0 that are running and then run and close Visio 2003 once.

## Reverse Engineering Visual C++ Code

Before you can reverse engineer a Visual C++ project, you must customize Visual C++ with the Visio UML Add-In, and you must generate a Browse Information file, which the UML Add-In uses to generate a UML model from the source code in your project.

To customize Visual C++ so you can reverse engineer code, follow these steps:

1. In Visual C++, choose Tools ➪ Customize.
2. In the Customize dialog box, select the Add-Ins and Macro Files tab, select the Visio UML Add-In in the Add-Ins and Macro files list, and click Close. The Visio UML Add-In toolbar appears.
3. To generate a Browse Information file in Visual C++, open the project you want to reverse engineer and choose Project ➪ Settings.
4. In the Project Settings dialog box, choose the type of build configuration you want, select the C/C++ tab, and then click Generate Browse Info.
5. Select the Browse Info tab to specify the name and location of the Browse Information file, click Build Browse Info File, and then click OK.
To reverse engineer a Visual C++ project, follow these steps:

1. Build the project in Visual C++.

   If you modify a Visual C++ project after you reverse engineer it, you must rebuild the project and reverse engineer it into Visio again to see the changes.

2. In Visual C++, click the Reverse Engineer UML Model button on the Visio UML Add-In toolbar. After the reverse engineering process is complete, Visio opens a blank static structure diagram drawing page. The Model Explorer includes elements for the class definitions from your project’s source code.

   If more than one project exists in the Visual C++ workspace, in the Select Project dialog box, select the project you want to reverse engineer and click OK. If more than one Browse Information file exists in the project hierarchy, in the Select Browse File dialog box, select the file you want and then click OK.

3. To create a static structure diagram, drag elements from the Model Explorer window onto the drawing page.

   The Browse Information file API contains a bug that sometimes corrupts class names and class method names. When you reverse engineer a project with corrupted names, the elements with corrupted names are usually not added to the UML model. However, if the reverse engineering process doesn’t detect the name corruption, the corrupted names are added to the model. Visio creates a log file that lists the errors detected during the reverse engineering process. By default, the file is written to C:\Temp\project.txt.

Reverse Engineering Visual Basic Code

Before you can reverse engineer a Visual Basic project, you must customize Visual Basic with the Visio UML Add-In.

To reverse engineer Visual Basic code, follow these steps:

1. To customize Visual Basic, in Visual Basic, choose Add-Ins ➤ Add-In Manager. In the Add-In Manager dialog box, select Visio UML Add-In. For Load Behavior, select Loaded/Unloaded and Load on Startup and click OK. The Visio UML Add-In toolbar appears.

2. Open the project that you want to reverse engineer.

3. In Visual Basic, click the Reverse Engineer UML Model button on the Visio UML Add-In toolbar. Visio opens a blank static structure diagram drawing page and populates the Model Explorer window with the elements that represent the class definitions in the source code.

4. To create a static structure diagram, drag elements from the Model Explorer window onto the drawing page.
Summary

The UML Model Diagram template is available only in Visio Professional and Visio Studio .NET Enterprise Architect. To model a software system, you can create a single Visio drawing file and create the multiple models and diagrams of your system within that file. You can work on the model of your system in the Model Explorer window or by modifying shapes on drawing pages. However, the shapes on drawing pages represent views of the elements in your model. You can add elements to a model without displaying them on diagrams or you can add views of elements to more than one diagram. You can also reverse engineer existing source code into Visio models.
Whether or not you use the Unified Modeling Language to model a software system, other types of software diagrams can help you design and document software architecture, program structure, and memory management. Visio makes it easy to visualize your software system with several additional software templates for other software development methodologies. The diagrams you produce can help identify problems or communicate designs to your development team.

You can create software diagrams using basic Visio techniques and the shapes on Visio’s software stencils. For example, after you drag and drop shapes onto the drawing page, you can glue them together with connectors, drag control handles to change their configuration, or right-click them to choose special configuration commands from their shortcut menus. You can also format them using Line, Text, or Fill formatting tools. If you want to produce reports about the elements on a diagram, you can add custom properties to the software shapes.

This chapter describes how to apply each software template that Visio offers. You’ll also learn how to create different types of software diagrams. For prototyping user interfaces, you will learn how to develop diagrams for application windows, wizards, dialog boxes, menus, and toolbars.
Choosing the Right Software Template

The Visio template you should choose depends on what you want to model, as well as the methodology you use, and the phase of development you’re in. In addition to the UML Modeling template, Visio provides seven other software templates for producing diagrams of software systems.

To learn more about other types of software diagrams, read Agile Modeling by Scott Ambler (Indianapolis: Wiley, 2002) and The Object Primer, 3rd Edition: Agile Model Driven Development with UML 2.0 by Scott Ambler (New York: Cambridge University Press, 2001).

In the templates that support the construction of software diagrams, many of the shapes conform to standard software modeling notations. However, in these templates, Visio does not verify that your diagrams conform to the rules and syntax of the methodology associated with the diagram. These templates don’t include specialized menus or toolbars. New diagrams based on these templates open with a new letter-size drawing page using portrait orientation and no drawing scale.

In the Software category, Visio provides the following software diagram templates:

✦ **COM and OLE** — Create diagrams that show the structure of Component Object Model (COM) and Object Linking and Embedding (OLE) components for an application and the interfaces between them.

✦ **Data Flow Model Diagram** — Design software by modeling the flow and transformation of data with process, interface, data store, and data flow shapes from the Gane-Sarson notation.

To learn about data flow diagrams (DFDs) and structured analysis, read Structured Systems Analysis: Tools and Techniques by Chris Gane and T. Sarson (Prentice-Hall, 1977) or go to www.agilemodeling.com/artifacts/dataFlowDiagram.htm.

✦ **Enterprise Application** — When you’re building large enterprise-wide applications, use this template to create logical and physical diagrams for systems. Logical diagrams document processes, components, interfaces, and boundaries. You can document the physical architecture of an application with mainframes, servers, workstations, laptops, interfaces, and communication links.

✦ **Jackson** — Document design from system analysis through physical design using the Jackson software design method, which focuses on the system activities that affect data. You can develop data structure diagrams, system network diagrams, and program structure diagrams using the Jackson notation, as described in Problem Frames: Analyzing and Structuring Software Development Problems by Michael Jackson (Addison-Wesley, 2000).
Program Structure — Document program architecture, structure, and memory management with shapes that represent language elements such as functions and subroutines; and memory objects, such as stacks, pointers, and bytes.

ROOM — Create diagrams of real-time systems using object-oriented concepts and real-time software techniques to show the structure of system components and the system’s response to events.

Windows XP User Interface — Create prototypes of Windows XP interfaces — from individual buttons and message boxes to tabbed dialog boxes and application windows.

**Constructing COM and OLE Diagrams**

COM is a Microsoft standard that supports the structured development of application software, in which software components can be written in more than one language and communicate through object interfaces. OLE is a subset of COM functionality. With COM and OLE diagrams, you can show the software components associated with processes and how those software components relate to each other through interfaces.

**Understanding the Elements of COM**

COM controls the identification, structure, and interaction of software components. Com specifications regulate the following:

- The structure of component interfaces
- Communication between components, including communication across process and network boundaries
- Shared memory management
- The dynamic loading of components
- Error and state reporting
- Unique identification of components and interfaces

Client applications and component objects interact through interfaces that define the behavior and responsibilities of the component objects. Interfaces are collections of functions that component objects make available to client components or applications. All component objects must implement the IUnknown interface, which counts references to determine component lifetime, and enables clients to determine whether an object supports a required interface and to connect pointers to object interfaces.
Each component object and interface receives a globally unique identifier, or GUID, which is a 128-bit integer that is unique across space and time. By uniquely identifying component objects and interfaces, you can prevent component objects from connecting to the wrong components or interfaces. For computers with Ethernet cards, GUID integers are based on the computer used to create the component or interface and the date and time at which the component or interface was created. If a computer doesn’t have an Ethernet card, the GUID is only guaranteed to be unique on that computer.

By using Vtables, you can write component objects in any language that uses pointers to call functions, such as C, C++, or Microsoft Visual Basic. COM specifies the layout of Vtables in computer memory and a standard method for calling functions through Vtables.

Creating COM and OLE Diagrams

When you create a new COM and OLE diagram, Visio opens only the COM and OLE stencil. Depending on the shapes you drag from the COM and OLE stencil, you can use custom properties, control handles, and commands on the shape shortcut menus to configure your diagram. To create a COM and OLE diagram, follow these steps:

1. Choose File ➪ New ➪ Software ➪ COM and OLE. Visio creates a new drawing file with one drawing page.

2. To create a COM object, drag a COM Object shape from the COM and OLE stencil onto the drawing page. COM objects include the IUnknown interface by default. To name the COM Object shape, select it, type the name you want, and press Esc.

3. To add an interface to the COM Object shape, drag the control handle in the center of the shape in the direction you want the interface to point. To name the new interface, subselect it, type the name for the interface, and then press Esc.

4. To change the style of a COM Object shape, right-click it and choose the COM Style command from the shortcut menu. This command toggles between COM Style 1 and COM Style 2.

5. To add Vtables to your diagram, drag a Vtable shape onto the drawing page. In the Custom Properties dialog box, specify the number of cells you want and click OK. To add text to table cells, subselect a cell and type the text you want. You can drag Vtables into COM Object shapes.

To specify the number of cells in a Vtable at a later time, right-click the table and choose Set Number of Cells from the shortcut menu.
6. To create relationships between COM objects, Vtables, and interfaces, drag Reference or Weak Reference connectors onto the drawing page and glue them to shapes or interfaces.

To change the angle of the bend in a Reference connector, drag its control handle to a new location.

Creating Data Flow Diagrams

The Gane-Sarson methodology represents software systems and business processes with data flow diagrams (DFDs) that show the data stores that hold data, the processes that transform data, and the data flows that processes generate. This approach to designing software begins by defining top-level processes and then decomposes those processes into lower-level processes, as shown in Figure 21-1.

Figure 21-1: Drag and connect shapes to show processes, data, and data flows.

In Visio 2003, the Model Explorer and DFD menu are no longer available.
To create a data flow diagram, follow these steps:


2. Define the top-level process by dragging Interface and Process shapes from the Gane-Sarson stencil onto the drawing page.

3. To show data repositories for your system, drag Data Store shapes onto the drawing page.

4. To indicate data flows between processes or to and from data stores, click the Connector tool on the Standard toolbar, click the Data Flow connector in the Gane-Sarson stencil, and then drag from the source to the destination of the data flow.

5. To define a lower-level process, create a new drawing page for the subprocess. Drag and connect Interface, Process, and Data Store shapes to define the lower-level process.

Note
You can create additional drawing pages to define additional levels of subprocesses in your system until you have described the entire data flow model in sufficient detail.

Creating Software Diagrams with Jackson Notation

The Jackson software design methodology encompasses the software system life cycle from analysis to physical design. With this methodology, you analyze the effect of system actions on input and output data streams, not functional tasks. The Jackson design method uses system network diagrams to show the interactions between processes at the top-level of a software system. Each data stream shown on the system network diagram is described in detail by a data structure diagram. Each program is described by a program structure diagram. It's important to note that the Jackson methodology has been overshadowed by UML-based object techniques in recent years, although it is still a common technique within traditional development circles.

Creating System Network Diagrams

To create system network diagrams, you use drawing tools to create circles that represent data streams, rectangles that represent programs, and arrows for the flow of data streams in and out of programs. When you create Jackson system network diagrams, use arrows to connect data stream circles to program rectangles.
In the Jackson methodology, you should not connect two circles or two rectangles. In addition, each circle can have only one arrow pointing into the data stream and one arrow flowing out.

To create a system network diagram, follow these steps:


2. Click the Drawing Tools button on the Standard toolbar to display the Drawing Tools toolbar.

3. To create data streams, click the Ellipse tool and drag the pointer to draw circles.

When you use the Ellipse tool, Visio displays drawing aids that show you where to click to create a circle.

4. To represent programs on the diagram, click the Rectangle tool and drag the pointer to define opposite corners of the rectangle.

5. To add the program or data stream name, select a rectangle or circle that you drew and type the name or other annotation you want. Press Esc to complete the text entry in a shape.

6. To show flow of data, click the Connector tool on the Standard toolbar and drag from a rectangle representing a program to a circle representing a data stream.

Creating Jackson Data or Program Structure Diagrams

The Jackson template includes shapes for creating tree diagrams to document data structure or program structure. Tree structure diagrams comprise four basic components: sequence, elementary, selection, and iteration. Elementary components are the lowest components in a tree structure. Other components consist of component parts as follows:

- **Elementary** — Contains no structure or parts of its own and is represented by a rectangle with no notation in the top-right corner.

- **Sequence** — Contains elementary component parts in sequence from left to right with the leftmost component part occurring first and the rightmost occurring last.

- **Selection** — Contains two or more component parts, but only one of the component parts occurs for the component. Indicated by a circle in the top-right corner of the shape.

- **Iteration** — Contains one component that can occur once, many times, or not at all. Indicated by an asterisk in the top-right corner of the shape.
As you build tree structure diagrams, you must comply with the following rules:

- Don’t connect a component part to a component on a different level.
- Don’t include different types of component parts in the same component. For example, do not include a sequence, iteration, and elementary component part for the same component type.
- Don’t include more than one component part for an iteration component.

To create a tree structure diagram to represent data structure or program structure, follow these steps:

2. Drag a Process, Procedure, or Procedure 2 shape from the Jackson stencil onto the drawing page. With the shape selected, type the name of the component and then press Esc to end your text entry.
3. To specify the component type, right-click the shape and choose one of the following commands from the shortcut menu:
   - No Symbol — Represents a sequence or elementary component
   - Show Asterisk — Represents an iteration
   - Show Circle — Represents a selection
4. To annotate the process or procedure using the text block within the shape, subselect the text below the shape and type the text you want. To hide the additional text, right-click the shape and choose Hide Note from the shortcut menu.

   If you want to create reports about the processes and procedures in your diagram, customize the Jackson stencil shapes by adding custom properties. You can then store your annotation in the custom properties and produce reports using them. To learn how to create and assign custom properties to shapes, see Chapter 32.

5. Repeat steps 2 through 4 to create additional processes or procedures.
6. To connect processes or procedures, drag the Tree Connector shape onto the drawing page and follow these steps to connect shapes:
   a. Glue the trunk of the tree to a connection point on a Process, Procedure, or Procedure 2 shape.
   b. Drag the control handles at the ends of the branches to glue branches to connection points on other shapes.
   c. To add additional branches, drag the control handle on the trunk of the tree and glue the new branch to a shape.
   d. To include text with the connector, select it and type the text you want. To reposition the text, drag the control handle in the center of the text to a new location.
Modeling Large-Scale Application Architectures

Enterprise architecture diagrams present logical and physical views of the architecture of a large-scale or enterprise system. During analysis, you can use these diagrams to show the system architecture at a conceptual level. During design and development, you can add physical details to the architecture diagram. Later in the system life cycle, you can use these diagrams to design test platforms and plan delivery and support services.

The shapes on the Enterprise Architecture stencil don’t have any extra bells and whistles. However, you can drag and drop them onto the drawing page, glue them together with connectors, add text to them, format them, or add custom properties to them as you would any standard Visio shape. To create an enterprise architecture diagram, choose File ➪ New ➪ Software ➪ Enterprise Application. Drag shapes that represent logical or physical components from the Enterprise Application stencil onto the drawing page and connect them as needed.

Creating Program Structure Diagrams

In addition to the program structure diagrams within the Jackson template, Visio offers another template for program structure that you can use to show memory management and language-level functions within structured/procedural computer programs. Although both types of program structure diagrams depict the same information, the symbols for Jackson notation differ from those in the Program Structure template. To document program structure or memory management using non-Jackson symbology, choose File ➪ New ➪ Software ➪ Program Structure and then use shapes from the following stencils:

✦ Language Level Shapes
  • To show program structure, drag Function/Subroutine, Function w/Invocation, Switch, and other shapes from the Language Level Shapes stencil onto the drawing page.
  • To reposition connections on shapes, drag control handles on the Function w/Invocation or Switch shapes. You can add additional switches by dragging the control handle on the vertical line in a switch to a new location.

✦ Memory Objects
  • To represent memory management, drag shapes from the Memory Objects stencil onto the drawing page.
  • To connect pointers to memory cells, drag end points or control handles from Pointer shapes and glue them to connection points on shapes representing memory objects, such as Array.
Modeling Real Time Systems with ROOM Diagrams

The Real-Time Object-Oriented Modeling (ROOM) language is a combination of real-time and object-oriented software techniques that you can use to show the structure of system components and a system’s response to events. The Visio ROOM template includes shapes for building ROOM structure and behavior diagrams.

*Note* To learn more about using ROOM to model software, read *Real-Time Object-Oriented Modeling* by Bran Selic (Wiley, 1994).

To create a new ROOM diagram, choose File ➪ New ➪ Software ➪ ROOM and then use the following shapes:

♦ ROOM Structure diagrams

- Drag an Actor Class shape onto the drawing page. With the shape selected, type its name.
- Drag an Actor Reference or a Modified Actor Ref. shape inside an Actor Class shape. To change the Modified Actor Ref. object type, right-click the shape, and then choose Select Actor Reference Type from the shortcut menu.
- Drag one of the Port shapes onto the drawing page and connect it to an Actor shape. To change the port type, right-click the shape and choose Select Reference Port or Select Relay Port from the shortcut menu.
- To represent a communication path between ports, drag a Binding shape onto the drawing page and connect it to Port shapes.
- To show ROOM layers for your diagram, drag Layer/Export Connection shapes onto the drawing page to connect different layers.

♦ ROOM Behavior diagrams

- Drag a State Context shape onto the drawing page and type its name.
- Drag a State shape inside a State Context shape.
- Drag a Transition Points shape onto the drawing page, select the type of transition point in the Custom Properties dialog box and click OK. Connect it to a State shape. To change the transition point type, right-click the shape and then choose Select Transition Point Type from the shortcut menu.
- Drag Transition, Group Transition, Internal Self-transition, and Transition To History shapes onto the drawing page and connect them to State shapes.
To create multiple paths for a transition, drag a Choicepoint shape onto the drawing page and glue the beginning end points of each diverging Transition shape to it.

Prototyping User Interfaces

By creating a prototype interface, you can design the menus, toolbars, dialog boxes, and controls for your application. You can then walk through the interface with end users to obtain feedback on its usability before you create the interface. In most cases, development resources use prototyping tools or Visual Basic to develop user interface prototypes. However, if don’t have access to tools such as these and want to experiment with interface elements, you can use Visio Professional's Windows XP User Interface template.

Feature

New

Visio 2003 replaces the Windows User Interface and Office User Interface stencils with the Windows XP User Interface template and several stencils with standard user interface components.

Exploring the Windows XP User Interface Template

The Windows XP User Interface template doesn’t contain specialized menus, toolbars, or commands. You can use basic Visio techniques to compose an interface for your application. Many of the interface shapes include shortcut commands you can use to configure the shape. For example, you can show the interface element as enabled or disabled or specify the type of button. To create a new user interface drawing, choose File ➪ New ➪ Software ➪ Windows XP User Interface. When you create a new user interface diagram, Visio opens the following stencils:

✦ Windows and Dialogs — Contains shapes for forms, panels, tab controls, group boxes, status bars, buttons and icons
✦ Wizards — Contains shapes for simple and advanced wizard windows, including welcome screens, completion screens, and interior screens for all the steps in between
✦ Toolbars and Menus — Contains shapes for menu bars, top-level menu items, drop-down menu items, toolbars, toolbar buttons, and other toolbar icons
✦ Icons — Includes commonly used interface icons such as the Recycle Bin, My Documents, Help, and Folder
✦ Common Controls — Includes shapes for frequently used controls, such as command buttons, option buttons, check boxes, scroll bars, list boxes, combo boxes, tree nodes, and sliders
Creating an Application Window

You can prototype the entire user interface for an application by starting with an application window. You begin with a blank form and add the user interface elements you want, as shown in Figure 21-2. To create a mock-up of an application interface, follow these steps:

Figure 21-2: You can mock up a Windows XP user interface before writing code.

1. Drag a Blank Form shape from the Windows and Dialogs stencil onto the drawing page. With the shape selected, type the title for the application window.

2. If you want to add an icon to the left of the text in the title bar, right-click the Blank Form shape and check the Room for Icon check box on the shortcut menu.

   You can also specify the background color for the Blank Form shape by right-clicking it and choosing White Background, Gray Background, or Custom Background from the shortcut menu. To change the appearance of the Blank Form shape to that of an inactive window, uncheck Active window on the shortcut menu.

3. To add buttons to the title bar of the form, drag a Windows Buttons shape onto the right end of the title bar area of the Blank Form shape and select the type of button you want. The typical arrangement of buttons for a form is the Minimize button, the Maximize button, and the Close button from left to right, respectively.
4. Drag a Status Bar shape from the Windows and Dialogs stencil and glue it to the bottom edge of the Blank Form shape. To add a divider to the status bar, drag a Status Bar Divider shape onto the page and glue it to the control handle for the Status Bar shape or another Status Bar Divider shape. To add text to the Status Bar or Status Bar Divider, select the shape and type the text you want.

**Note**

If the Status Bar Divider shape disappears when you glue it to a Status Bar shape, right-click the Status Bar shape and choose Shape ➪ Send to Back from the shortcut menu.

5. To indicate that the window is resizable, drag a Window Resize shape from the Windows and Dialogs stencil and glue it to the connection point at the bottom right of the Status Bar shape.

6. Drag Scroll Bar shapes (horizontal and vertical) from the Common Controls stencil onto the bottom and right edges of the Blank Form shape, respectively. To specify how far the window scrolls, right-click the Scroll Bar shapes and choose Set Thumb Size from the shortcut menu.

**Note**

To indicate that only a small portion of the document is visible, make the thumb size small. To indicate that most of the document is visible, make the thumb size large.

You can continue to drag shapes from the Windows XP User Interface stencils to add menus, toolbars, icons, and common controls to the form.

### Prototyping Wizards

The Wizards stencil includes shapes for the different types of screens you see in wizards. You can use the Simple-Single Page shape to create one-page wizards. For wizards with two or three pages, use the Simple Wizard shapes. Use the Advanced Wizard shapes for wizards with more than three pages.

### Creating Wizards with One to Three Pages

1. Drag a Simple-Single Page or Simple-Welcome shape from the Wizards stencil onto the drawing page. With the Wizard shape still selected, type the name of the wizard.

2. To add a graphic to the panel on the right side of the screen, subselect the box within the right panel and then choose Insert ➪ Picture to specify the graphic file to use.

3. To add the wizard instructions, select the Wizard Text text block in the main panel of the Wizard shape and type the instructions for your wizard.
4. To construct the interface elements of the wizard, drag shapes from the Common Control stencil onto the main panel of the Wizard shape. Because each Wizard shape includes the navigational buttons appropriate for that wizard page, you can’t edit them.

5. For each remaining wizard page, create a new drawing page and repeat steps 1 through 4.

Creating Wizards with More Than Three Pages
Wizards with more than three pages include a welcome page, a completion page, and two or more interior pages. You define the contents of each page as you would for a simpler wizard by dragging shapes from the Common Controls stencil onto the corresponding Wizard shape. To create the pages for an advanced wizard, follow these steps:

1. Drag an Advanced-Welcome shape from the Wizards stencil onto the drawing page. With the Wizard shape still selected, type the name of the wizard.

2. To create interior pages for a wizard, create new drawing pages and then drag an Advanced-Interior shape onto each drawing page. It’s common practice to include a graphic related to the one on the Welcome page at the right edge of the Wizard Text box.

3. To create a completion page, create a new drawing page and then drag an Advanced-Completion shape onto the drawing page.

Simulating Wizard Navigation
You can simulate the navigation through a wizard to test its usability before you write the code to implement it. To simulate wizard navigation, you must place the shapes for each wizard page on a separate drawing page and save the drawing file. To configure wizard diagrams so that you can simulate their behavior, follow these steps:

1. Navigate to the drawing page that contains the first page for the wizard.

2. To modify the drawing size to fit the wizard page exactly, choose File ➪ Page Setup and select the Page Size tab. Under Page Size, select the Size to Fit Drawing Contents option.

3. To add navigation to the Navigation buttons on the Wizard shape, follow these steps:
   a. Draw an invisible rectangle around each button using the Rectangle tool on the Drawing toolbar.
   b. Right-click the rectangle and choose Format ➪ Line. In the Pattern dropdown list, select 00: None and then click OK.
c. Right-click the rectangle and choose Format ➤ Fill. In the Pattern dropdown list, select 00: None and then click OK.

d. With the rectangle selected, choose Insert ➤ Hyperlinks. Click the Browse button to the right of the Address box and choose Local File.

e. In the Link to File dialog box, double-click the drawing you are working on.

f. Click the Browse button to the right of the Sub-address box.

g. In the Hyperlink dialog box, in the Page box, select the Visio drawing page that contains the wizard page to which the button should take you and click OK. In the Hyperlinks dialog box, click OK.

4. To run the simulation, choose View ➤ Full Screen and click the Next or Back buttons to navigate from page to page.

**Building Menus and Toolbars**

In the Windows XP User Interface template, you can mock up menu bars, drop-down menus, and toolbars. You can create menus and toolbars on their own on a drawing page or attach them to a blank form.

**Creating Menu Bars**

To create a menu bar, follow these steps:

1. Drag a Menu Bar shape from the Toolbars and Menus stencil onto the drawing page. To add the menu bar to a blank form, glue the Menu Bar shape to the connection points on the bottom edge of the title bar area in the Blank Form shape.

2. To display the gripper dots at the left edge of the menu bar that indicate that you can move the menu bar around, right-click the Menu Bar shape and uncheck the Lock Menu bar check box.

You can add an icon at the beginning of a menu bar, similar to the menu bar in Visio and other Microsoft Office programs. Drag an Icon shape from the Icons stencil and glue it to the left edge of the Menu Bar shape. To learn how to import a graphic file of an icon into a Visio shape that you can add to the menu bar, refer to Chapter 9.

3. To add a menu item to the menu bar, drag a Top-level Menu Item shape from the stencil and glue it to the connection point at the top-right corner of the Menu Bar shape. With the shape selected, type the menu name.
4. Repeat step 3 to glue additional Top-level Menu Item shapes to the right edge of the previous Top-level Menu Item.

Creating Drop-Down Menus

In most cases, you create drop-down menus associated with the top-level menu items in a menu bar. However, you can also build standalone versions. To create a drop-down menu, follow these steps:

1. Drag a Top-level Menu Item shape from the Toolbars and Menus stencil onto the drawing page. With the shape selected, type the name for the menu item, underlining the appropriate letter in the name if the menu item has a keyboard shortcut associated with it.

2. Drag a Drop-down Menu Item from the Toolbars and Menus stencil and glue it to the bottom of the Top-level Menu Item shape. Type the name of the drop-down menu item.

3. To add additional drop-down menu items, drag the Drop-down Menu Item shape and glue it to the bottom of the previous Drop-down Menu Item shape.

4. To resize all the drop-down menu items to the width of the widest menu entry, drag from the vertical ruler and glue the blue guide line to the connection point at the bottom right of the widest entry. Then, select each Drop-down Menu Item shape and glue its green end point to the guide line.

5. To specify options for drop-down menu items, right-click each shape and choose Menu Item Properties from the shortcut menu. You can choose an entry in the Menu Item Style drop-down list to change the menu item to Checked, Radio, Cascading, or Separator. The Menu Item Position option sets the justification and width of the menu item, depending on whether it is the top, bottom, or a middle entry in the menu.

Building Toolbars

You can build toolbars within a blank form or on their own on the drawing page. To create a toolbar, follow these steps:

1. Drag a Toolbar shape from the Toolbars and Menus stencil onto the drawing page. To add the toolbar to a blank form, glue the Toolbar shape to connection points for shapes within the blank form, such as the connection points on the bottom of a Menu Bar shape.
2. To display the gripper dots at the left edge of the toolbar that indicate that you can float the toolbar, right-click the Toolbar shape and uncheck the Lock Toolbar check box.

3. To add buttons to the toolbar, drag a Toolbar Buttons shape or an XP Toolbar Buttons shape from the Toolbars and Menus stencil and glue it to the left edge of the Toolbar shape. In the Custom Properties dialog box, choose the type of button you want.

   To change the type of button later, right-click the button and choose Set Button Type from the shortcut menu.

4. To add a separator between buttons, drag a Toolbar Separator shape from the stencil and glue it to the right edge of the previous Toolbar Buttons shape.

5. Repeat steps 3 and 4 to add buttons and separators to the toolbar.

   You can also add shapes to indicate a toolbar drop-down menu or the Overflow Chevron.

### Designing Dialog Boxes

The Windows and Dialogs stencil includes shapes you can use to design basic dialog boxes or dialog boxes with tabs. After you create a dialog box, you can use shapes from the Icons and Common Controls stencils to add interface elements to the dialog box.

To create a basic dialog box, follow these steps:

1. Drag a Blank Form shape onto the drawing page and type a title for the dialog box.

2. To add buttons to the dialog box title bar, drag a Windows Button shape, glue it to the right end of the title bar area in the Blank Form shape and select the button type. You can choose to add Restore, Minimize, Maximize, Close, or Help buttons to the title bar area.

3. To add command buttons, such as OK, Cancel, or Apply to the dialog box, drag a Command Button shape from the Common Controls stencil into the Blank Form shape and type the command name.

   If you add your own text blocks to the Blank Form shape with the Text tool, use Tahoma 8-point text to match the text in the user interface shapes.

4. Add other interface elements by dragging shapes from the Common Controls stencil onto the Blank Form shape.
To align user interface shapes, drag guide lines from the horizontal and vertical rulers onto the drawing page and glue Interface shapes to the guide lines.

5. To assemble interface elements into logical groups, drag a Group Box or Group Line shape onto the Blank Form shape. Group Box shapes include boundary line and heading text to identify the group. Group Line shapes include a horizontal line and heading text.

To add tab controls to a dialog box, follow these steps:

1. Drag a Blank Form shape onto the drawing page, and type a title for the dialog box.

2. To add a tab control to the dialog box, drag a Tab Control (Body) shape from the Windows and Dialogs stencil onto the Blank Form shape. Drag the Tab Control (Body) selection handles to resize the shape to fit inside the Blank Form shape with room along the top for tabs.

3. Drag a Tab Control (Tabs) shape from the Windows and Dialogs stencil and glue it to the top edge of the Tab Control (Body) shape. With the Tab Control (Tabs) shape selected, type the tab name.

4. Repeat step 3 for each tab, gluing the new tab to the connection point at the bottom right of the previous tab.

5. To display a tab as the front tab, right-click the tab you want in front and choose Foreground Tab from the shortcut menu.

By default, tabs are set to Background Tab. If you end up with more than one foreground tab, right-click the tab you want to send to the background and choose Background Tab from the shortcut menu.

6. Add other interface elements by dragging shapes from the Common Controls and Windows and Dialogs stencils onto the Blank Form shape.

Summary

You can choose from seven Visio software templates in addition to the UML template. Unlike the UML template, which provides a modeling environment, the other software templates provide only diagramming tools. They don’t validate your diagrams to make sure you correctly apply the rules of the selected methodology. You can use basic Visio techniques such as drag and drop, formatting, control handles, and custom properties to build your diagrams.

✦ ✦ ✦
CHAPTER 22

Mapping Web Sites

Whether a Web site is simple or complex, it requires careful planning during the development stage. After a site is up and running, it requires conscientious maintenance to ensure that it serves the needs of the organization and its customers.

Visio 2003 assists with tools for both stages of Web site work. With the Conceptual Web Site template, you can lay out the concept, structure, and elements for new or revamped Web sites. The Web Site Map template includes tools to generate maps of existing Web sites. With a site map, it’s easier to maintain a Web site because you can see its current content and organization as well as detect broken links. This chapter shows you how to use Visio to create and fine-tune conceptual Web diagrams. You’ll also learn how to generate and work with Web site maps for existing Web sites.

Exploring the Web Diagram Templates

Visio Professional includes the following two Web diagram templates:

✦ Conceptual Web Site — Draft the structure and elements for a planned Web site or application. Show Web pages, groups, pop-ups, forms, jumps, and other items to graphically describe the behavior and appearance of a proposed Web site. The template includes the Conceptual Web Site Shapes stencil, Web Site Map Shapes stencil, and Callouts, Backgrounds, and Borders and Titles stencils. The Conceptual Web Site Shapes stencil contains shapes for entire pages, objects and elements on pages, site map nodes, and jumps and connectors.
Web Site Map — Generate a map of a Web site to review the structure and find any broken links or other problems. Generate the map to the number of levels you want. The template includes the Web Site Map Shapes stencil, the Web Site Map menu, the List window, and the Filter window.

To create a drawing using one of the Web diagram templates, choose File ➪ New ➪ Web Diagram, and then choose Conceptual Web Site or Web Site Map. To use one of the Web diagram stencils in a different template, choose File ➪ Shapes ➪ Web Diagram and then choose the stencil you want.

Planning Web Sites

As the Webmaster for an organization’s Internet or intranet Web site, you might start your Web site development with a laundry list of items that should be included in the Web site, which might have been identified during a brainstorming session documented with a Visio brainstorming diagram. When you’re ready to organize that list into a structure, use the Conceptual Web Site template. This helps you and others on your Web development team visualize how you want to organize the elements in the Web site, as shown in Figure 22-1. As new ideas arise, you can easily change the drawing before any programming is performed for the site. When the concept is complete and approved by the powers that be, you’re ready to transform that conceptual Web design into a living, breathing Web site that serves its target audience well.

Figure 22-1: Use the Conceptual Web Site template to plan the content, organization, and interactions of a new Web site.
Creating Conceptual Web Diagrams

Because of the hierarchical nature of most Web sites, you might find it useful to create an overview page that shows all the major groups of pages. Then you can create pages to show detail for each of the major groups. If you want, you can take it down another level of detail and use provided shapes to show the elements on each page. For a simpler Web site, you might draw an overview of the Web site structure as a whole and then add pages for detail for each individual Web page you want to create.

You don’t need to restrict the use of this template to Web sites. You can also use it for planning user interfaces in general. For example, use the Conceptual Web Site template to plan the screens in a Visual Basic application.

Either way, with a high-level overview page, you can set up the big picture of your Web site (or application) before tackling the details of the individual elements on the individual pages. With the conceptual Web diagram, you can create a storyboard or flow diagram, showing major features and the relationships among them. Using this diagram, you can do the following:

✦ Develop and examine the interactions in your proposed Web site.
✦ Create and refine the navigation flow throughout the site.
✦ Determine whether any elements or connections are missing or superfluous.
✦ Determine whether the Web site is too complex.

To create a new conceptual Web diagram, follow these steps:

2. From the Conceptual Web Site Shapes stencil, drag the first shape you want onto the drawing.
3. Label the shape by selecting it and then typing its label.
4. Repeat steps 2 and 3 for each shape you want in your drawing.
5. Resize and move the conceptual Web site shapes into the size and position you want.
6. Drag connector shapes — for example, the 2-Way Data Connection connector or Dynamic connector — onto the drawing. Position the connector to show links among the different shapes on the drawing.

When you’re creating conceptual Web diagrams to include detail about groups of pages of the Web site, you might want to add shapes from the Web Site Map Shapes stencil. This stencil contains more page-specific shapes, such as Presentation, Database, FTP, and Search.
You can create a hyperlink from a node in the overview diagram to a page that contains the detail for that node. Hyperlinks can help others navigate as they review the Web site conceptual diagram. To create a hyperlink from one page in your diagram to another, follow these steps:

1. Select the node in the overview page and then choose Insert \( \text{Hyperlinks} \).
2. Click Browse, next to the Sub-Address box.
3. In the Page drop-down list, select the page that contains the detail drawing for the selected node.
4. Click OK and then click OK again.

To move from a shape on the overview page to the detailed diagram for that shape, right-click the shape and then choose the name of the page on which the link resides.

For more information about working with hyperlinks, see Chapter 8.

Fine-tuning Conceptual Web Diagrams

You can refine your conceptual Web diagram by formatting, aligning shapes, and adding callouts.

Formatting Web Diagrams

You can change the font, line style, and fill color of the shapes on your drawing. If necessary, activate the Pointer tool on the Standard toolbar and then select the shapes whose formatting you want to change by either dragging across the shapes or Shift+clicking or Ctrl+clicking them.

✦ **Change the font style** — Choose Format \( \text{Text} \). Select the Font tab if necessary and then make the font changes you want for the selected shapes.

✦ **Change the line style** — Choose Format \( \text{Line} \). Specify the changes you want to the line, the line ends, and the corners. The changes you make affect shape outlines and connectors in the current selection.

✦ **Change the fill style** — Choose Format \( \text{Fill} \). Specify the changes you want to make to the insides of shapes, including the color, patterns, and shadow.

To learn more about formatting, see Chapter 7.

Arranging Shapes in Web Diagrams

You can have Visio arrange the shapes on your drawing according to a pattern you select. Using Visio’s tools for arranging shapes automatically, you can focus on the content of your Web diagram and let Visio worry about the alignment and spacing.
✦ **Align Shapes**—Select the shapes you want to align to one of the shapes. Choose Shape ➪ Align Shapes. Select the vertical or horizontal alignment you want. Select the red X button to deselect an option.

✦ **Distribute Shapes**—Select three or more shapes you want distributed at regular intervals on the page. Choose Shape ➪ Distribute Shapes. When you select a vertical distribution, the selected shapes are arranged at equal intervals along a horizontal axis. When you select a horizontal distribution, the selected shapes are arranged along a vertical axis.

✦ **Center Drawing**—Choose Shape ➪ Center Drawing. The entire drawing is positioned to the center of the drawing page.

To learn more about aligning and distributing shapes, see Chapter 4.

**Annotating Web Diagrams**

You can explain elements in your Web diagram using shapes from the Callouts stencil. This stencil, which is part of the Conceptual Web Site template, contains shapes for line callouts, bracketed text, boxes, balloons, starbursts, and other shapes designed to annotate elements in your diagram.

To annotate your Web diagram, select the Callouts stencil in the Shapes window. Drag the Callout shape you want to use onto your Web diagram. With the shape still selected, type the text for the callout. When finished, press Esc. Resize and move the shape as needed.

For best results, use a consistent style of callouts throughout your Web diagram. Use different types of callouts for different types of information.

To learn more about text and methods of annotating diagrams, see Chapter 6.

**Working with Web Site Maps**

If you’re maintaining or revamping an existing Web site, you can use Visio to generate and work with a site map. Not only does this site map “discover” and show the structure and elements contained in the hierarchy of the Web site, but it can also find changes since the last time you generated the site map, including any broken links.

Use the Web site map as the starting point for reorganizing existing content, adding new elements, and merging or deleting duplicated pages. By keeping an eye on the overall Web site structure, you can ensure that the Web site is meeting the organization’s needs as well as those of the target audience.
Keeping Your Web Site Up to Date

Use the Visio Web Site Map to regularly check your Web site and keep it up to date. This is a very important aspect of Web site maintenance. An excellent process to achieve this is to work iteratively with the Web site, as follows:

1. Generate the map of the Web site using the Visio Web Site Map template.
2. Review the map to detect any broken links and other problems or potential problems with the site.
3. Model the repairs to the broken links and other issues in the Web site map. You might find it helpful to track markup in the Web site map, as described in Chapter 11, so you have a clear guide to what needs changing in the actual Web pages.
4. Open the source files for the Web pages that need updating. Use your changes in the Visio Web site map as your “punch list” for the required changes.
5. In Visio, generate the Web site map again to confirm that your changes work the way you expect.

Repeat this process at a frequency appropriate to the nature and expected usage of your Web site. For generally static Web sites, a monthly check might be sufficient. For sites whose content is constantly changing, a daily check might be required.

The generated Web site map is a visual representation of the elements in a specified Web site. Although you can add and remove shapes representing Web page elements and repair broken links on the drawing, these actions don’t change the Web site itself. For best results, keep track of the changes you’re making on the site map. When you’re finished modeling your changes in the Visio Web site map, make those changes to the Web site itself.

The Web Site Map template consists of the Web Site Map Shapes stencil, the Web Site Map menu, the List window, and the Filter window. The stencil includes shapes that represent various page elements. These include HTML or XML content, scripts, graphics, audio, and video. Content-related shapes represent documents created with Microsoft Word, Excel, or PowerPoint. Shapes for protocols such as FTP, Mailto, Newgroup, and Telnet are also included. The stencil provides two types of connectors.

In Visio 2003, the Web Site Map template has been updated for more compact layouts, increased speed, editable shape text, and new shapes for Web technology.
Generating Maps of Existing Web Sites

When you use Visio to create a Web site map, you can specify how many levels of the site’s hierarchy that you want Visio to discover. To generate a Web site map, follow these steps:


2. In the Address box, type the address for the Web site you want to map. Enter the full path, including the protocol and the name of the individual page—for example, http://www.microsoft.com/default.asp.

   Tip
   You can also map an HTML file, ASP page, or Internet shortcut stored on your local computer. In the Generate Site Map dialog box, click Browse. Navigate through your computer’s filing system to find and select the file. Click Open. This can be particularly helpful if you’re analyzing a Web site offline.

3. Review the discovery and diagramming settings. To learn about specifying the settings for discovery, see the next section. When you’re ready to generate the site map, click OK. Visio finds and scans the Web site or Web documents, verifies their links, searches the specified levels of the hierarchy, and then finally displays the Web structure and elements as a site map on the drawing page.

The site map appears as a series of shapes linked in a hierarchy, as illustrated in Figure 22-2.

![Figure 22-2: Visio shapes represent each site map element; connectors show the hierarchical relationship between the levels.](image-url)
Caution

When Visio 2003 is discovering the levels and links in a Web site, a page with pop-up windows and scripts might display incorrectly or even generate errors. Because there is no workaround for now, if Visio asks you if you want to debug the current page, click No.

Configuring the Content and Format of Site Maps

Use the Web Site Map Settings dialog box to specify how you want Visio to discover, generate, and diagram the Web site map. Choose Web Site Map ➤ Generate Site Map, enter the Web address, and then click Settings.

When you change any of the Web site map settings, generate the site map again to see the results of your changes.

You can use settings in the following areas on the Layout tab to control the level of detail and layout arrangement of a diagram:

- Discover — Enter the number of levels you want Visio to discover. Although the default is three levels, you can specify from one to twelve levels. Also enter the number of elements or links you want Visio to discover. The default is 300 links, and you can specify a maximum of 5,000. If you enter a number of levels or links greater than those contained in the Web site, Visio will discover all levels and links.

- Layout Style — Select the placement and routing styles Visio uses on the site map. To change these styles, click Modify Layout. Specify the styles you want under Placement and Connectors.

- Shape Text — Specify the default text to include in the shape, such as Relative URL (the default), Absolute URL, Filename Only, HTML Title, and No Text.

Tip

You can also change shape text after a site map is generated. Choose Web Site Map ➤ Modify Shape Text.

- Shape Size — You can control the size of shapes at each level, which provides an instant visual cue as to which level you’re looking at on the drawing. By default, the root level is displayed at 200 percent, level 1 at 100 percent, level 2 at 75 percent, and level 3 at 50 percent.

The Extensions, Protocols, and Attributes tabs on the Web Site Map Settings dialog box include lists of items that Visio can discover and represent with a shape in your Web site map. By default, Visio selects all the listed elements. Uncheck the check box for any elements you want to exclude from the site map. Click Add if there are other elements you want that are not currently represented in the list. The following list describes the options available on the tabs on the Web Site Map Settings dialog box:
✦ Extensions tab — Specify the types of programs, files, and scripts that you want to display or hide when Visio generates the Web site map. The Shape column shows the shape Visio uses to represent the file type on the site map.

✦ Protocols tab — Review or change the Internet protocols that Visio is able to discover when generating a Web site map. Examples include FTP, File, Mailto, Newsgroups, Search, and so on. The Shape column shows the shape Visio uses to represent the protocol on the site map.

✦ Attributes tab — Indicate the HTML attributes that Visio should include in its discovery and generation of Web site maps. Examples include Code, SRC, and HREF.

When you finish specifying site map settings, click OK in the dialog box. In the Generate Site Map dialog box, click OK to generate the site map according to your new parameters.

Viewing Site Maps
Visio generates a Web site map in a new drawing. Each shape represents a page, a link, or other element in the Web site. Connectors between shapes indicate the relationships between elements on the site.

The different shapes also delineate the type of page or element. You can compare the shapes on the drawing with the shapes in the Web Site Map Shapes stencil to learn more about the element. For example, you can see whether an element is an HTML page, a graphic image, a style sheet, or JavaScript.

Collapsing and Expanding Site Map Shapes
When your Web site map is first generated, it might only display a single large shape, which shows the name of the Web site you mapped. To reveal the levels or child links beneath this page, double-click the shape. You can also right-click the shape and then choose Expand Hyperlink from the shortcut menu.

Continue to double-click any shapes whose child links you want to see on the drawing. To see all child links beneath a shape, right-click the shape and then choose Select All Hyperlinks Beneath from the shortcut menu. Shapes that are collapsed and can be expanded include the down arrow icon.

You can also hide child links of a shape. Again, just double-click the shape, or right-click the shape and then choose Collapse Hyperlink from the shortcut menu. Shapes that are expanded and can be collapsed include the up arrow icon.

Note
You can expand or collapse only shapes that already contain links.
Finding Shapes in Web Site Maps

Suppose you’re searching for a particular shape or link in your Web site map—for example, a plug-in on the second level of the hierarchy. You can find shapes by searching for shape names, text, custom properties, and so on. To find a shape in your Web site map, follow these steps:

1. Choose Edit ➪ Find. The Find dialog box appears.
2. In the Find What box, type the text associated with the shape you’re looking for, such as the name of a Web page you are removing from the site.
3. Under Search In, select an option to specify whether you want Visio to search the current selection, the current page, or all pages on the drawing.
4. Under Search In, check the check boxes that indicate the element you want to search on. This element should correspond with the text you entered in the Find What box. For example, because Web page names appear in shape text, check the Shape Text check box to find a Web page name. You can check multiple check boxes.
5. Under Options, check the check boxes for any additional search parameters you want to use.
6. Click Find Next. Visio finds and highlights the first shape that meets your search criteria. Click Find Next to find the next shape that meets your criteria.

Mapping Protected Areas on Web Sites

In the Web site map, you might see areas that are not filled in or that are covered with a red X. These might be protected areas that require you to click a link or enter a password to continue the site map discovery process. In other words, you need to interact with the Web site itself to enable the site map discovery process to move forward.

To allow mapping of protected areas in a Web site, follow these steps:

1. On the drawing page, find the shape representing a link to the Web page that requires you to click a link or enter a password.
2. Right-click the link and choose Interactive Hyperlink Selection from the shortcut menu. The Interactive Discovery dialog box appears and loads the selected Web page.
3. Work with the Web page as needed and then click Close. The links you navigated to are added to your site map.
Working with the Web Site Map Memory Model

When you generate a Web site map, Visio creates a memory model that becomes an integral part of the site map drawing file. This memory model contains information about every Web element discovered and how they relate to each other. Through the use of this memory model, Visio is able to lay out the Web site map.

The List window and the Filter window show the contents of the memory model, as illustrated in Figure 22-3. These windows are part of the Web Site Map template, and list every element in the Web site map, whether or not those elements actually appear on the drawing. In fact, you can delete a shape from the drawing, but the element represented by that shape still remains in the List window and Filter window. You can easily add the element back into the drawing by dragging it from either of these windows onto a drawing page.

Figure 22-3: The List window and Filter window contain all elements in the memory model, which in turn builds the Web site map.
Using Web Site Maps Across Different Visio Versions

Although you can open a Web site map generated in Visio 2000, it’s best to just regenerate the Web site map in Visio 2003. Previous versions do not contain the memory model. When you open those old Web site maps in Visio 2003, Visio creates a memory model based on the contents of the site map. However, if you open and save a 2003 Web site map in Visio 2000, the memory model is deleted.

However, if you delete an element from the List window or Filter window, the element is deleted from the windows as well as every shape representing that element on drawing pages.

Remember that any changes you make to the Web site map and the memory model only affect the drawing itself. These changes do not update the actual Web site itself.

Using the List and Filter windows

The List window and Filter window appear in the Web Site Map template by default. The List window lists every Web page element in alphabetical order. The Filter window lists the Web page elements by file type.

- **Show the window** — Choose Web Site Map ➪ Windows ➪ List Window or Web Site Map ➪ Windows ➪ Filter Window. The windows appear as title bars in the left edge of the drawing.

- **Expand the window** — Click the window’s title bar.

- **Collapse the window** — Click outside the expanded window. The window collapses as long as the window is in AutoHide mode. To turn AutoHide mode on or off, right-click the window’s title bar and then choose AutoHide.

- **Float the window** — Right-click the anchored window’s title bar and then choose Float Window. The title bar becomes the top edge of the window and you can drag it anywhere you want on your screen.

- **Anchor the window** — Right-click the floating window’s title bar and choose Anchor Window. The title bar becomes the left edge of the window, which is docked at the left edge of the drawing.

- **Close the window** — Right-click the window’s title bar and then choose Close.

Adding Shapes from the Memory Model

You can add any Web site elements cataloged in the List window or Filter window to the Web site map drawing. Even if you delete corresponding shapes from the
drawing, they’re still in the Web site map’s memory model. To add an element listed in the memory model as a shape in the Web site map drawing, follow these steps:

1. Click the title bar of the List window or Filter window to expand the window.
2. Drag the element you want onto the drawing. The Web Site Map template redraws the site map to incorporate the new shape.

**Deleting Elements from the Memory Model**

If you delete a shape from the drawing, the element still exists in the memory model. However, if you delete an element from the memory model, it’s completely removed from the Web site map. To delete an element shape from the memory model, follow these steps:

1. Click the title bar of the List window or Filter window to expand the window.
2. Right-click the Web site element and then choose Delete from the shortcut menu. Visio deletes the element from the window and from all drawing pages. Any child links off that element are deleted as well.

**Comparing Map Versions**

You can compare one version of a Web site map with another version. This can be useful when you want to discern the changes made to a Web site—since last month, for example. To compare a Web site map with another version of the same Web site, follow these steps:

1. Have the current Web site map open.
2. Choose Web Site Map ➪ Compare to Previous Document. The File Open dialog box appears.
3. Navigate to the location of the earlier version of the Web site map you saved. Select the drawing and click Open. The Visio drawing you open must contain a Web site map. Visio compares the memory models of the two drawings and finds instances where a shape or link appears in only one of the models. For shapes or links that appear in both versions, Visio compares error status, file titles, file sizes, and file modification dates. Visio then generates an HTML file displaying the results.

**Formatting Web Site Maps**

To change the layout of your Web site map, you need to select the layout you want in the Web Site Map Settings dialog box and then generate the site map again. However, there are a few ways you can modify the look of the site map without having to regenerate the site map. You can switch between a hierarchical view and a page-centric view. You can move portions of the site map to other pages, with page connectors between them.
Tip: You can change the text displayed in site map shapes. To do so, choose Web Site Map ➤ Modify Shape Text. Select the option for the text you want to display as the title of the shape(s) and click OK.

Displaying Links to and from a Single Shape

By default, Visio displays your Web site map in the hierarchical view, which displays all the shapes in your Web site map in a top-down scheme according to the layout pattern you’ve chosen—for example, flowchart or circular. The hierarchical view provides a complete big picture of the Web site to the level of detail you have specified.

However, you can also create the page-centric view, which is shown in Figure 22-4. In the page-centric view, you select a single shape, which becomes the center of the page. Links to the shape appear above the central shape. Links from the shape appear below that shape. The page-centric view is great for focusing on the surrounding relationships of one particular element in a Web site.

![Figure 22-4: The page-centric view shows the links to and from a single selected shape.](image)

To create the page-centric view from your hierarchical site map, choose Web Site Map ➤ View ➤ Page Centric. Visio adds only one page to the drawing file for the page-centric view. If you select another shape for the page-centric view, the new shape replaces the previous shape in the one page–centric viewing page.
Panning Duplicate Links to the Original

Many Web sites have duplicate links throughout the site or even on the same page. For example, a Web page might contain a link to contact information in the midst of a paragraph of content, in a navigation pane, and in a standard menu across the bottom of the page. Duplicate links are grayed out in your Web site map. If you would rather not show duplicate links in your Web site map, you can remove them by right-clicking the duplicate link and choosing Jump to Original from the shortcut menu.

Displaying Site Maps Across Multiple Pages

You might find it advantageous to divide your Web site map across additional pages. This can help you separate categories and help others understand the structure of the site map.

To move a selected portion of a site map onto a separate page, right-click the shape with the child links you want to move to a separate page and choose Make Subpage from the shortcut menu. The Make Subpage command creates a new page, moves the child links to the new page, and creates an Off-Page Connector shape on both pages.

To move between pages, double-click the Off-Page Connector shape. You can also right-click the Off-Page Connector shape and choose the name of the hyperlink from the shortcut menu.

Identifying Web Site Problems

Shapes in a Web site map drawing covered by a red X indicate a link or element that is either broken or that Visio could not discover. Finding these broken links can help you determine whether you have a problem with the Web site itself, or just with the process of generating the site map. Once you find the broken links, you can determine the reasons and then resolve the problems. You can also run reports that summarize problems with the Web site map.

Finding Broken Links

If you’re a Webmaster responsible for maintaining a Web site, periodically generate the Web site map specifically to find broken links. You can then go straight to the problems in the Web site itself and, with a little luck, fix them before your users find them.

You can easily see broken links, either on the drawing page or in the List window or Filter window. If you see a broken link in one of the windows and you don’t see the element in your drawing, right-click the link in the window and choose Show on Page from the shortcut menu.
Getting information about the broken link is your first step toward fixing the problem. Position your mouse pointer over the broken link on the drawing to show the shape tag button. Click that button and read the information it provides. Broken links can be caused by the following errors:

- File Not Found (incorrect file name, incorrect file location, or missing file)
- Site Not Found
- Access Denied
- Password Required
- Site Timed Out

Try these strategies to fix a broken link in your Web site map:

- **Check the Web address** — Make sure you entered every part of the address — from the protocol (http:// or ftp://, for example) through to the page (home.htm or default.asp, for example), and that there are no typographical errors. If you entered a file path to an HTML file, make sure the path is typed accurately, and that the file is actually where you say it is.

- **Refresh the link** — If a broken link is caused by a timeout error, refreshing the link or the parent of the link should resolve the error. To do so, right-click the link and choose either Refresh or Refresh Parent.

- **Enter required information** — If a link connects to an area of the Web site that requires user entry, such as a password or a click, use the Interactive Discovery dialog box. To summon the dialog box, right-click the broken link and choose Interactive Hyperlink Selection from the shortcut menu. The Web page appears in the dialog box. Make the required entry and then click Close.

- **Fix the link on the Web site** — If the link is still displayed as broken, fix the link on your Web site or report the broken link to your Webmaster. After you fix the link, update the shape representing the link on your drawing. Right-click the link and then choose Refresh Parent. Visio regenerates the parent HTML or ASP page and the first level of links from that page.

**Running Web Site Map Reports**

You can generate reports of site links, including broken links. Visio provides three built-in reports. You can modify these reports to suit your requirements or create entirely new reports. To generate a Web site map report, follow these steps:

1. Choose Web Site Map ➪ Reports. The Reports dialog box appears, listing the three built-in reports: Inventory, Web Site Map All Links, Web Site Map Links with Errors.

2. Select the report you want and then click Run.
3. In the Run Report dialog box, select the report format — for example, Excel or XML. Visio Shape is the default, which displays the report as a shape in the current drawing page.

4. Specify whether you want to save the report with a copy of the report definition or a link to the report definition and then click OK. Visio generates the report according to your specifications.

Summary

You can use the Web diagramming tools in Visio 2003 to assist with your Web site development and maintenance efforts. The Conceptual Web Site template provides resources for brainstorming, organizing, and prototyping a new Web site or application interface. The Web Site Map template includes sophisticated functionality for generating a Web site map, including all elements and links, and representing them as shapes in a drawing. You can then examine the map for broken links or other problems. You can also use the site map to help plan improvements to your Web site.
Creating Network Diagrams

With people collaborating throughout organizations as well as over the Internet, computer networks have become the backbone of organizations large and small. Just like buildings and software, networks need to be designed well to satisfy requirements and adjust to changing needs. In addition, they must be regularly maintained to keep things humming. Whether you’re just starting to design a network or you’re trying to reverse engineer a network that has evolved, Visio network diagrams provide an easy way to represent the equipment in your network and how it interconnects.

With Visio Standard, you can create network diagrams using basic network equipment shapes. If you use Visio Professional, you can produce detailed logical or physical network diagrams, document directory services, or lay out network equipment in racks.

You can integrate your Visio network diagrams with other applications to store network information in databases, track equipment in spreadsheets, or present network designs in PowerPoint presentations. You can store network information in network shape custom properties, update your diagrams based on the information stored in a database, and produce reports, such as inventories for your network equipment.

This chapter explains the changes to network diagrams in Visio 2003. You’ll learn how to create logical and physical network diagrams as well as diagrams that drill down to lower levels of detail. You will also learn how to use Visio templates to create directory services diagrams and diagrams that show the placement of equipment in racks. Finally, you will learn how to store information in network shapes as well as how to label, number, and color-code your diagrams.
Exploring Network Templates

Visio 2003 includes templates for producing several types of network diagrams. You can use Visio Network templates to document high-level network designs, detailed logical and physical network designs, and the arrangement of network equipment in equipment racks. In addition, you can use them as architecture-level artifacts and as an alternative to UML deployment diagrams. Network tools for Visio 2003 have changed quite a bit. Many network shapes look better and behave more consistently. However, several features are no longer available. The following sections outline the changes made to Visio 2003.

What’s New in the Network Templates?

In Visio Standard and Visio Professional, the shapes in the Basic Network Diagram template have an enhanced look and feel that produces presentation-quality diagrams. In Visio Professional, the Detailed Network Diagram template replaces the Logical Network Diagram template in Visio 2002. You can use the Detailed Network Diagram to document logical and physical network topology.

The appearance of the shapes in these templates has been enhanced and their behavior is more consistent. In addition, network shapes include a consistent set of custom properties that you can use in conjunction with three new predefined reports (Network Device, Network Equipment, and PC Report) to extract data from your network diagrams.

The Rack Diagram template is new in Visio Professional and provides shapes in standard industry sizes that you can use to determine rack space requirements for new equipment. The shapes in this template fit together precisely so you can stack equipment and accurately estimate the rack space you need.

What’s Missing?

Visio 2003 does not offer several networking features that were available in previous versions, including the following:

- Visio’s AutoDiscovery features are no longer available.
- In Visio 2003, you can’t use SNMP to discover the network resources in a local or wide area network and create a diagram of your existing network.
- You can’t import directory services information, such as an existing Active Directory structure.
Using Visio with Large Networks

If you are designing or managing a large network with thousands of nodes, you can still use Visio Professional to produce high-level network diagrams. For example, you might produce diagrams that show all the routers on your network or the service providers that support your network in different geographical areas. However, you probably won’t want to spend the time required to draw diagrams that show every end node.

When you manage large networks, you can use products such as HP OpenView Network Node Manager, MicroMuse Precision, or What’s Up Gold to automatically generate maps of your network topology. Even with advanced discovery and mapping tools such as these, the maps they generate might require editing to represent your network the way you want.

✦ The Directory Services Diagram templates no longer include the Directory Navigator.
✦ The Visio Network Equipment Sampler is no longer available in Visio 2003. However, you can still download network shapes from equipment manufacturers’ Web sites.

If you want to use Visio to map your network, you can check out third-party products, such as the Optiview Console (formerly Network Inspector) and LAN MapShot products from Fluke Networks, which use Visio to generate diagrams of discovered network devices. An article about Fluke Networks’ network tools is available at the following URL:


Choosing the Right Template

The Network templates available in Visio 2003 do not include network-specific menus, toolbars, or add-ons. When you create a new network diagram, Visio creates a letter-size page using portrait orientation and no drawing scale, and opens stencils appropriate for the type of network diagram. The Basic Network Diagram template is available in both Visio Standard and Visio Professional. The other templates are available only in Visio Professional. In Visio 2003, you can choose from the Network templates described in Table 23-1.
### Table 23-1
Visio 2003 Network Templates

<table>
<thead>
<tr>
<th>Network Template</th>
<th>Description</th>
<th>Associated Stencils</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Network Diagram</td>
<td>Design and document simple networks or produce presentation graphics for high-level networks.</td>
<td>• Backgrounds&lt;br&gt; • Borders and Titles&lt;br&gt; • Computers and Monitors&lt;br&gt; • Network and Peripherals</td>
</tr>
<tr>
<td>Detailed Network Diagram</td>
<td>Design and document logical network connections or the layout and physical connections for network equipment at specific sites. Produce drill-down diagrams showing progressive levels of network detail.</td>
<td>• Annotations&lt;br&gt; • Borders and Titles&lt;br&gt; • Callouts&lt;br&gt; • Computers and Monitors&lt;br&gt; • Detailed Network Diagram&lt;br&gt; • Network and Peripherals&lt;br&gt; • Network Locations&lt;br&gt; • Network Symbols&lt;br&gt; • Servers</td>
</tr>
<tr>
<td>Active Directory</td>
<td>Design and document directory services for sites using Microsoft Active Directory.</td>
<td>• Active Directory Objects&lt;br&gt; • Active Directory Sites and Services&lt;br&gt; • Exchange Objects</td>
</tr>
<tr>
<td>LDAP Directory</td>
<td>Design and document directory services for sites using Lightweight Directory Access Protocol (LDAP.)</td>
<td>• LDAP Objects</td>
</tr>
<tr>
<td>Novell Directory Services</td>
<td>Design and document directory services for sites using Novell Directory Services.</td>
<td>• NDS Additional Objects&lt;br&gt; • NDS GroupWise&lt;br&gt; • NDS Objects&lt;br&gt; • NDS Partitions&lt;br&gt; • NDS ZenWorks</td>
</tr>
<tr>
<td>Rack Diagram</td>
<td>Optimize the use of space in equipment racks and document the configuration of equipment in racks.</td>
<td>• Annotations&lt;br&gt; • Callouts&lt;br&gt; • Free-standing Rack equipment&lt;br&gt; • Network Room Elements&lt;br&gt; • Rack-mounted Equipment</td>
</tr>
</tbody>
</table>
Creating Logical and Physical Network Diagrams

You can use standard Visio techniques to create network diagrams that show the logical or physical design of your network. You add network devices to diagrams by dragging and dropping the shapes you want from Network stencils. You can represent network topology by gluing the connectors on Ring Network or Ethernet shapes to connection points on shapes that represent network equipment. You can show additional information on your network diagrams by using text for labels or numbers, showing notes in annotation shapes, storing data in custom properties, or formatting shapes based on the values in shape properties.

Setting Up Network Diagrams

Although network diagrams might show different types of equipment and different levels of detail, you use the same techniques to construct them whether you use the Basic or Detailed Network Diagram templates. To create a network diagram to design or document a logical or physical network, choose File ➤ New ➤ Network and then choose either Basic Network Diagram (in Visio Standard and Visio Professional) or Detailed Network Diagram (in Visio Professional only).

Depending on the scope of your network or the detail you want to include, you can change the drawing size by choosing File ➤ Page Setup, selecting the Page Size tab, and specifying the page size you want. To change the page orientation, under Page Orientation, select the Portrait or Landscape option.

When you draw a wide area network (WAN), you can create a background for your network diagram by importing a map (see Chapters 9 and 28), inserting a graphic image (see Chapters 8 and 9), or dragging a shape from the Backgrounds stencil.

Adding Nodes and Network Topology

Whether you want to document a small network for a home-based business or a wide area network for a global corporation, you start by dragging topology shapes and equipment shapes onto the drawing page. Topology shapes, such as the Ethernet shape, have control handles that you drag and glue to the shapes that represent nodes and devices in your network.
In previous versions of Visio, network shapes often detached from each other when you moved them. For example, if you glued servers to an Ethernet shape, and then moved the Ethernet shape, the connections to servers were lost. The updated network shapes in Visio 2003 remain attached no matter which shapes you move.

To add topology and nodes, follow these steps:

1. From the Network and Peripherals stencil, drag a Ring Network shape or Ethernet shape onto the drawing page.

   You can also use the Cloud shape on the Network Locations stencil to show high-level connectivity.

2. To change the length of an Ethernet shape or the size of a Ring Network shape, drag a selection handle to a new location.

3. From stencils such as Computers and Monitors, Network and Peripherals, or Detailed Network Diagram, drag shapes that represent network devices onto the drawing page.

4. Select a topology shape, such as an Ethernet shape. Visio displays yellow control handles that you can use to connect the shape to shapes that represent network devices. Drag a control handle and glue it to a connection point on a device shape. When the device shape is glued to the topology shape, its connection point turns red.

5. If you use all the connectors that appear on a topology shape by default, add additional connectors by dragging one of the control handles within the topology shape, as shown in Figure 23-1.

   You can hide an unused connector by dragging its control handle back to the interior of the Ethernet or Ring Network shape.

6. To add text to a topology shape or device shape, select the shape, type the label you want, and press Esc. You can move text on device shapes by dragging the yellow control handle at the center of the text block.

   You can also show communication connections, such as satellite or microwave links, by gluing a Comm-Link shape, which looks like a lightning bolt, to shapes on a network diagram.
Creating Drill-down Diagrams

When you want to document a large or complex network, you can create *drill-down diagrams* to show the high-level view of your network on one page, with detail on additional pages. For example, you can use Cloud and Building shapes from the Network Locations stencil to show the campus buildings that your network supports. Then, you can show the network equipment within each building on other drawing pages, as shown in Figure 23-2. If necessary, you can create additional drawing pages for details such as the network equipment within a computer room in one of the buildings. To use hyperlinks to create a drill-down diagram, follow these steps:

1. Draw a high-level view on the first drawing page in your Visio drawing file.
2. To create additional pages for detailed diagrams of your network, choose Insert ➪ New Page. Type the name of the network diagram for that drawing page and click OK.

You can create detailed diagrams in the same file or in separate Visio drawing files. You can create the additional drawing files or pages all at once or create them as you realize they’re needed.
Right-click a shape and choose the hyperlink to navigate to the detail page.

Detail appears on other pages

High-level information appears on a summary page

**Figure 23-2:** Drill-down diagrams show additional detail on other drawing pages.

3. Select a topology or device shape on the page that shows a higher-level view of your network. For example, select a Building shape on the campus view of your network.


5. If your detailed diagram is in another Visio drawing file, click Browse in the Address box, and then click Local File. In the Link to File dialog box, navigate to the file with the detailed diagram and click Open.

6. To link to a specific drawing page, click Browse in the Sub-address box. In the Hyperlinks dialog box, select the drawing page in the Page drop-down list and then click OK.
7. In the Hyperlinks dialog box, type the text you want to use to identify the hyperlink in the Description box and click OK.

Note

When you position the pointer over a shape that includes a hyperlink, the Hyperlink icon appears, followed by the Hyperlink description you provided.

8. To navigate to the diagram associated with the hyperlink, right-click the shape and then choose the Hyperlink description from the shortcut menu.

Documenting Directory Services

Visio Professional provides templates for documenting directory services, whether you use Active Directory, LDAP Directory Services, or Novell Directory Services. You can develop directory services diagrams to design new directories, redesign existing directories, or plan the migration of your current network directory. You can also use Visio’s Directory Services templates to plan network resources and set network policies.

Note

The Novell Directory Services template is available only in the English and French language versions of the product.

The procedure for creating directory services diagrams is the same no matter which type of directory service you want to document:

1. Choose File ➤ New ➤ Network and then choose the template for the type of directory services diagram you want to create. Visio creates a drawing file with one drawing page and opens the stencils associated with the Directory Services template you chose.

2. To add objects to the diagram, drag shapes from any of the Directory Services stencils onto the drawing page.

3. To create a parent-child relationship between directory services objects, click the Connector tool on the Standard toolbar, click the Directory connector in one of the stencils (such as LDAP Objects), and then, on the drawing page, drag from the shape that represents the parent object to the shape that represents the child object.
Showing Relationships in Active Directory Diagrams

You can use shapes on the Active Directory Sites and Services stencil to plan networks and directories or to show how information is distributed and replicated to servers in your network. The following shapes show relationships between network domains, sites, and services:

✦ **Site shapes** — Represent regions for network connectivity, whether by geography or function, and can show one or more LANs and their interconnections.

✦ **Domain shapes** — Define security and administrative boundaries in a network. These shapes exist within a site or sites and move along with the shape that represents a site. A domain might have one or more domain controllers. Sites can also have one or more domain controllers.

✦ **Site link shapes** — Represent the transport links that communicate information between sites. The Site-Link Bridge 3D shape delineates a set of site links joined to form a larger link or bridge.

✦ **Replication connection shape** — Represents intersite replication between two domain controllers.

Laying Out Equipment Racks

Rack diagrams are helpful as installation guides for the people installing equipment in racks. The shapes in the stencils for rack diagrams conform to industry-standard sizes, so they fit together precisely. Connection points are positioned on equipment shapes, so they snap to racks and other rack-mounted equipment. Rack-mounted equipment glues together so your rack configurations stay connected even when you move them.

When you create a rack diagram in Visio Professional, the following stencils open along with your new drawing:

✦ **Annotations** — Add labels, notes, and reference symbols to your rack layouts.

✦ **Callouts** — Add labels and notes to your rack layouts.

✦ **Free-standing Rack Equipment** — Include equipment that doesn’t attach directly to racks, such as monitors, printers, and laptops.

✦ **Network Room Elements** — Include shapes for elevation views of doors, windows, chairs, and tables.

✦ **Rack-mounted Equipment** — This is useful for network equipment that attaches directly to racks, such as routers, switches, patch panels, shelves, and servers.

**Tip** If you want to use the Rack shape in other types of Visio drawings, open the Rack-mounted Equipment stencil with another drawing open by choosing File ➪ Shapes ➪ Network ➪ Rack-mounted Equipment.
To create a rack diagram, follow these steps:


2. From the Rack-mounted Equipment stencil, drag the Rack shape or Cabinet shape onto the drawing page. The Rack shape has open sides, whereas the Cabinet shape has sides that enclose the equipment.

3. To change the height of the rack or cabinet, choose one of the following methods:
   • Select the Rack or Cabinet shape and then drag a selection handle at the top or bottom of the shape to a new location.
   • Right-click the shape, choose Properties from the shortcut menu, and type a new distance in the Height field in the Custom Properties window.

4. To change the width between rack holes, right-click the Rack or Cabinet shape, choose Properties from the shortcut menu, and select the width you want in the Width Between Holes field in the Custom Properties window.

5. To add equipment to a rack or cabinet, drag equipment shapes from the Rack-mounted Equipment stencil and glue them to the Rack or Cabinet shape. Connection points at the lower corners of the equipment shape glue to the connection points on the Rack or Cabinet shape, as shown in Figure 23-3, and turn red to indicate that they are glued.

**Figure 23-3:** Equipment shapes glue to the connection points on Rack and Cabinet shapes.
Note

The U height is the number of units a rack holds or a piece of equipment uses. By default, the U height appears above Rack and Cabinet shapes and to the left of Rack-mounted equipment shapes. To hide the U height, right-click a shape and choose Hide U Sizes from the shortcut menu. To show U height, right-click a shape and choose Show U Sizes.

Enhancing Network Diagrams

Many techniques that increase the usefulness of other types of Visio drawings work equally well on network drawings. You can use text-oriented techniques to label and annotate your network diagrams, as described in Chapter 6, and formatting techniques to change the graphic appearance of shapes on your diagrams, as described in Chapter 7. You can also store additional information in custom properties within network shapes, or link those custom properties to data in a database. With data stored in custom properties, you can generate reports about your network, add dynamic labels to network shapes on drawings, and color-code shapes based on the custom property values.

Storing Network Information in Visio Shapes

The shapes in the Visio 2003 network diagram templates include a consistent set of custom properties that you can use to store information about the network devices they represent. By adding data to the custom properties associated with network device shapes, you can view information about devices in the Custom Properties window or in predefined or customized reports.

In Visio 2003, the custom properties associated with shapes in the Network stencils are more consistent from shape to shape. Network equipment shapes provided by equipment manufacturers also include numerous custom properties, many of them identical to the ones that Visio provides. However, if the predefined properties aren’t sufficient, you can modify Visio’s network shapes to add your own properties, as described in Chapter 32.

Most network shapes include a handful of custom properties, such as Asset Number, Serial Number, and Building, that you can use to identify the device and its location. Network devices, such as Routers and Switches, include additional properties, such as IP Address and Number of Ports, to identify specific network information.

To add data to a shape within Visio, right-click the shape and choose Properties from the shortcut menu. In the Custom Properties window, click the cell next to the Property name and type the value you want to add. To move to the next property in
the list, press Enter. You can also choose View ➪ Custom Properties Window to open the Custom Properties window. As you select shapes, you can view and edit their custom property values in the Custom Properties window.

**Tip**

If you want to add the same value to a custom property for many shapes on a drawing, select all of the shapes first, open the Custom Properties window, and then type the value in the cell for the property.

**Cross-reference**

To learn how to create dynamic links between custom properties and fields in a database, see Chapter 10.

### Generating Equipment Reports

Visio 2003 includes several new predefined reports you can use to present information about your network. The Inventory report has been available in several previous versions of Visio. Network Device, Network Equipment, and the PC Report are new report definitions in Visio 2003. If these reports don’t quite fit your needs, you can modify them or create your own.

**Cross-reference**

To learn how to create or modify reports, see Chapter 32.

When the shapes on your diagram include data in their custom properties, you can generate reports by following these steps:

1. Choose Tools ➪ Reports.
2. In the Reports list, select the name of the report you want to use.

**Tip**

If the report definition you want doesn’t appear in the list, uncheck the Show Only Drawing-specific Reports check box. If the report still doesn’t appear, click Browse, navigate to the folder that contains the report definition, select the report definition (.vrd) file, and click Open.

3. In the Reports dialog box, click Run.
4. In the Run Report dialog box, select the report format you want. You can create the report as an Excel spreadsheet, a Web page using HTML, a Visio shape, or an XML file.

**Note**

Excel must be installed on your computer to create a report as an Excel spreadsheet or as a Visio shape. When you create a report as a Visio shape, Visio saves the report as an Excel spreadsheet embedded in a shape on the drawing page.
5. Perform one of the following steps based on the report format you choose:

- **HTML** — Specify the path and filename for the HTML file.
- **Visio shape** — If you want others to be able to see the report, save a copy of the report definition with the Visio shape by selecting the Copy of Report Definition option. Otherwise, Visio saves the report as part of your Visio installation and does not transmit it when you send the drawing to others.
- **XML** — Specify the path and filename for the XML file.

6. Click OK to generate the report. If you chose the Visio shape format, Visio adds the report shape to the current drawing page.

### Labeling and Numbering Network Diagrams

Visio add-ons include two tools that are helpful for annotating your network diagrams: the Number Shapes add-on and the Label Shapes add-on.

The Number Shapes add-on can number shapes either in sequence as you add them to your diagram or after all the shapes are in place. By default, the add-on increments numbers from left to right and from top to bottom on the drawing, but you can specify the sequence order you want. To number network shapes in your diagram, choose Tools \(\rightarrow\) Add-Ons \(\rightarrow\) Visio Extras \(\rightarrow\) Number Shapes.

To learn how to use the Number Shapes add-on, refer to Chapter 4.

The Label Shapes add-on was originally developed for the Visio building plan templates, but works with any type of drawing in which shapes include custom properties. Using the Label Shapes add-on, you can specify which custom properties you want to display in four label text blocks that you can apply to shapes. You can label all shapes, selected shapes, or specific types of shapes on your diagram. You can also specify a data source from which to import data into the labels. To add labels to network shapes, choose Tools \(\rightarrow\) Add-Ons \(\rightarrow\) Building Plan \(\rightarrow\) Label Shapes.

To learn how to use the Label Shapes add-on, refer to Chapter 26.

### Color-Coding Network Diagrams

Network diagrams can contain a lot of information, much of which might be stored in custom properties associated with shapes. Displaying custom property values is one way to show information, but doing so can clutter your diagrams and make them harder to read. Another approach for showing information is color-coding shapes based on custom property values. For example, you can color-code equipment based on the LAN to which it belongs.
When Color Isn’t Enough

Not everyone has access to a color printer and some people are color-blind, so you might want to use patterns instead of or in conjunction with colors. To assign a pattern when you use the Color By Values add-on, in the Color By Values dialog box, click the color that you want to change in the Colors list. In the Change Color dialog box, choose a pattern in the Pattern drop-down list. You can also choose a color for the pattern in the Pattern Color drop-down list.

If you use Dynamic connectors to show network connections, you can also use patterns in line formatting to designate different types of cables. For example, you might use dashed lines to indicate multi-mode fiber, dotted lines for gigabit Ethernet, and solid lines for Cat-5 cable. You can apply this formatting by choosing Format ➪ Line and selecting a line pattern. If these connection types are used throughout your organization, you might want to build a custom stencil with multiple versions of the Dynamic connector predefined with the patterns you want.

The Color by Values add-on is another tool originally targeted for building plans that you can use on other types of Visio drawings, including network diagrams. In the Color by Value add-on, you can specify the custom property whose values control the color-coding and the shapes you want to color-code. You can color-code all shapes, selected shapes, or specific types of shapes on your diagram. If the custom property includes a set of unique values, you can assign a color to each value. For custom properties that can cover a range of numbers, you can assign a color to a range of values. After you color-code shapes, the add-on places a legend on the drawing page. You can change colors and patterns in the diagram by right-clicking the Legend shape and then choosing Edit Legend from the shortcut menu. To color-code network shapes, choose Tools ➪ Add-Ons ➪ Building Plan ➪ Color By Values.

To learn how to use the Label Shapes add-on, see Chapter 26.

Summary

The tools in the network templates have changed a great deal with the release of Visio 2003. The Visio Network Equipment Sampler, AutoDiscovery, and the Directory Navigator have all been discontinued. Although the Network templates are now primarily drag and drop tools, the shapes have been enhanced so they look better, connect consistently, and behave more reliably. In Visio Standard, you can create basic network diagrams. With Visio Professional, you can create basic and detailed network diagrams for logical and physical networks, directory services diagrams, and rack layouts. In addition to dragging, dropping, and connecting network shapes, you can use custom properties to label, color-code, and report on the devices in your network.
Using Visio for Architecture and Engineering

In This Part

Chapter 24
Working with Scaled Drawings

Chapter 25
Creating Scaled Plan Drawings

Chapter 26
Laying Out Architectural and Engineering Plans

Chapter 27
Planning Space and Managing Facilities

Chapter 28
 Integrating CAD and Visio

Chapter 29
Working with Engineering Drawings
If you’ve ever experimented with a new office layout by moving your office furniture around, you understand the value of scaled drawings. You can design real-world objects on paper before beginning construction, and you can work on your plan at a size that fits on a piece of paper. By scaling real-world objects up or down, you can work on them at a manageable size, manipulate them into the results you want, and easily share them with colleagues. In addition, you can draw real-world objects at different scales depending on the level of detail you want to show; for example, you could show either the layout of a floor or the connection details between a steel column and a floor joist.

When you work on technical drawings such as architectural plans, accuracy is essential. To ensure that components such as structural steel or modular furniture fit together when assembled in the field, you must draw them accurately and position them precisely.

Although Visio isn’t meant to replace a computer-aided design (CAD) application, you can use it to draw detailed plans that are both precise and accurate. Visio includes shapes that are designed to work on scaled drawings and adjust to the scale you’re using. In addition, many architectural and engineering shapes include behaviors that help you lay out components on your plans. In this chapter, you’ll learn which Visio templates produce scaled drawings, how to use scale and units to your advantage, and how to indicate dimensions on your scaled drawings.

To learn about methods for positioning shapes precisely, see Chapter 4.
Exploring Scaled Drawing Templates

Visio 2003 provides several drawing templates that are designed to produce scaled drawings. Visio automatically sets the units and drawing scale to those common for the type of drawing. Scaled shapes on the associated stencils resize to the scale of the drawing as long as the drawing and shapes scales aren’t too disparate. However, if these templates don’t suit your needs, you can specify the drawing scale for any drawing and create shapes to work at that scale.

Choosing the Right Scaled Drawing Template

If you use Visio Standard, the Office Layout template works not only for office lay­outs but for scaled building plans as well. In fact, it’s your only choice because the Office Layout template is the only Visio Standard template with shapes for walls. With Visio Professional, you can choose Building Plan templates suited to the type of plan you want to create. Although the Office Layout template is available, the Floor Plan template is better because it creates a standard architectural size page and opens stencils with more shapes for walls, doors, windows, and other common building components. Most of the Building Plan templates use an architectural page size of 36 inches by 24 inches and a drawing scale of \( \frac{1}{4} " = 1 ' \) or an A4 page using a drawing scale of 1:50 and millimeters for metric units. In addition, in the Mechanical Engineering category, the Parts and Assembly template uses mechanical engineering page size and scale. Table 24-1 includes the templates available for scaled drawings.

For a complete list of the stencils that open with templates, see Chapter 41.

<table>
<thead>
<tr>
<th>Template</th>
<th>Default U.S. Page Size</th>
<th>Default U.S. Drawing Scale</th>
<th>Metric Page Size and Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Office Layout</td>
<td>Letter</td>
<td>Architectural</td>
<td>A4 at 1:25</td>
</tr>
<tr>
<td>(Visio Standard and Professional</td>
<td>Landscape</td>
<td>( \frac{1}{2} &quot; = 1 ' 0 &quot; )</td>
<td></td>
</tr>
<tr>
<td>Electric and Telecom Plan</td>
<td>ANSI Architectural</td>
<td>Architectural</td>
<td>A4 at 1:50</td>
</tr>
<tr>
<td>(Professional only)</td>
<td>36&quot; × 24&quot;</td>
<td>( \frac{1}{4} &quot; = 1 ' 0 &quot; )</td>
<td></td>
</tr>
<tr>
<td>Floor Plan</td>
<td>ANSI Architectural</td>
<td>Architectural</td>
<td>A4 at 1:50</td>
</tr>
<tr>
<td>(Professional only)</td>
<td>36&quot; × 24&quot;</td>
<td>( \frac{1}{4} &quot; = 1 ' 0 &quot; )</td>
<td></td>
</tr>
<tr>
<td>Template</td>
<td>Default U.S. Page Size</td>
<td>Default U.S. Drawing Scale</td>
<td>Metric Page Size and Scale</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------</td>
<td>----------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Home Plan (Professional only)</td>
<td>ANSI Architectural 36&quot; × 24&quot;</td>
<td>Architectural ¼&quot; = 1' 0&quot;</td>
<td>A4 at 1:50</td>
</tr>
<tr>
<td>HVAC Control Logic Diagram Plan</td>
<td>ANSI Architectural 36&quot; × 24&quot;</td>
<td>No scale (one to one)</td>
<td>A4 and no scale</td>
</tr>
<tr>
<td>HVAC Plan (Professional only)</td>
<td>ANSI Architectural 36&quot; × 24&quot;</td>
<td>Architectural ¼&quot; = 1' 0&quot;</td>
<td>A4 at 1:50</td>
</tr>
<tr>
<td>Plant Layout Plan (Professional only)</td>
<td>ANSI Architectural 36&quot; × 24&quot;</td>
<td>Architectural ¼&quot; = 1' 0&quot;</td>
<td>A4 at 1:50</td>
</tr>
<tr>
<td>Plumbing and Piping Plan (Professional only)</td>
<td>ANSI Architectural 36&quot; × 24&quot;</td>
<td>Architectural ¼&quot; = 1' 0&quot;</td>
<td>A4 at 1:50</td>
</tr>
<tr>
<td>Reflected Ceiling Plan (Professional only)</td>
<td>ANSI Architectural 36&quot; × 24&quot;</td>
<td>Architectural ¼&quot; = 1' 0&quot;</td>
<td>A4 at 1:50</td>
</tr>
<tr>
<td>Security and Access Plan (Professional only)</td>
<td>ANSI Architectural 36&quot; × 24&quot;</td>
<td>Architectural ¼&quot; = 1' 0&quot;</td>
<td>A4 at 1:50</td>
</tr>
<tr>
<td>Site Plan (Professional only)</td>
<td>ANSI Architectural 36&quot; × 24&quot;</td>
<td>Civil Engineering 1&quot; = 10' 0&quot;</td>
<td>A4 at 1:200</td>
</tr>
<tr>
<td>Space Plan (Professional only)</td>
<td>Letter Landscape</td>
<td>Architectural ¼&quot; = 1' 0&quot;</td>
<td>A4 at 1:100</td>
</tr>
<tr>
<td>Parts and Assembly (Professional only Mechanical Engineering category)</td>
<td>ANSI Engineering B:17&quot; × 11&quot;</td>
<td>Mechanical Engineering ¼:1</td>
<td>A4 at 1:10</td>
</tr>
</tbody>
</table>

**Working with U.S. and Metric Templates**

Visio templates are available in both U.S. and metric units. When you install the English language version of Visio, the installation procedure checks the settings on your computer and installs the templates that match. If you use both types of units in your work, you can install both sets of templates on your computer. With both sets of templates installed, you can choose which type of template you want to use when you create a new drawing.
To install both sets of templates after Visio is already installed, follow these steps:

1. If Visio is running, save your work and then choose File ➤ Exit.

2. Click the Start button and choose Settings ➤ Control Panel ➤ Add or Remove Programs.

3. In the Currently Installed Programs list, select Microsoft Office Visio and then click Change.

4. On the first wizard page, select the Add or Remove Features option and then click Next.

5. In the Advanced Customization box, click the plus sign next to Microsoft Office Visio. For each category of template that you want to install that is preceded by a red X, including Solutions (US units), Solutions (Metric units), Add-ons (US units), and Add-ons (Metric units), click the arrow to the right of the red X and then choose Run from My Computer from the shortcut menu.

6. Click Update.

After you have both U.S. and metric unit templates installed, when you create a new drawing Visio displays two options for each built-in template. When you choose File ➤ New and point to the template category, you'll see one template with (US units) after the template name (Visio doesn’t use the periods for U.S.), and the other followed by (Metric). When you select the template that uses the units you want, Visio sets up the drawing with the appropriate measurement units and drawing scale.

**Caution**

When you work with both types of templates and open a stencil after starting a drawing, make sure you open the version of the stencil whose units match the template you’re working with. Mixing U.S. units and metric units in the same drawing can cause shapes to align improperly.

### Working with Scale and Units

When you use templates for scaled drawings, Visio automatically sets up your drawing with appropriate units and scale to show real-world objects at a manageable yet accurate size. As you add shapes associated with scaled drawing stencils to the drawing page, the shapes resize to match the drawing scale you’re using. In addition, as you modify or reposition shapes, the dynamic grid, rulers, and other Visio drawing aids help you place shapes precisely, based on the current units and scale. When you glue dimensioning shapes to shapes on a scaled drawing, the distances shown are based on the units and drawing scale. If Visio doesn’t set up the drawing page with the units and scale that you want, you can choose the units and drawing scale you want to work with.
Working with Scale

A drawing scale represents how a distance on a piece of paper corresponds to a distance in the real world. Whether you use architectural or engineering formats, you can choose the scale that makes your drawing readable on the drawing page. For example, the typical U.S. architectural scale of \(\frac{3}{8}\)" = 1' 0" means that \(\frac{3}{8}\) inch on a piece of paper is the equivalent of one foot in the real world, which is useful for most building plans. However, you might use \(\frac{3}{8}\)" = 1' 0" for a large building. Conversely, you might use a scale of 1" = 1' 0" to show welds and connection details for a steel column. For site plans that show the configuration of buildings, roads, parking lots, and more, you might use 1" = 10' 0".

Sometimes, scales show only the ratio between paper size and real-world size. For example, the metric scale of \(\frac{3}{8}:1\) means that the drawing on paper is one eighth of actual size. In Visio, metric scales are represented as ratios, such as 1:50, which indicates that one meter on paper represents 50 meters actual size.

The smaller the drawing scale, the more you can show on the same size piece of paper. Table 24-2 shows the real-world distances you can show on a 36" × 24" architectural page at different scales.

Table 24-2  
Distances You Can Represent on Scaled Drawings

<table>
<thead>
<tr>
<th>Drawing Scale</th>
<th>Real-world Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1&quot; = 10' 0&quot;</td>
<td>360 feet × 240 feet</td>
</tr>
<tr>
<td>(\frac{3}{8})&quot; = 1' 0&quot;</td>
<td>288 feet × 192 feet</td>
</tr>
<tr>
<td>(\frac{3}{4})&quot; = 1' 0&quot;</td>
<td>144 feet × 96 feet</td>
</tr>
<tr>
<td>1&quot; = 1' 0&quot;</td>
<td>36 feet × 24 feet</td>
</tr>
<tr>
<td>1:50</td>
<td>45.72 meters × 30.48 meters</td>
</tr>
</tbody>
</table>

The shapes on the stencils that open when you use a scaled template are designed to work with scaled drawings. When you drag one of these shapes onto a scaled drawing page, the shape resizes to match the drawing scale, as shown in Figure 24-1.
Two feet on ruler

Two foot column at 1/4" = 1'0" scale

Two foot column at 1" = 1'0" scale

Figure 24-1: Scaled shapes resize to match the scale of your drawing.

A shape won’t resize if its scale is more than eight times larger or smaller than the scale of the drawing page. If shapes don’t resize, make sure that you are using scaled shapes from stencils designed to work with the type of drawing you’re using. Visio compares the scale of the drawing on which the master resides to the scale of the drawing on which you drop shapes. You can create masters that work at a specific scale by setting the scale on your master drawing before you create the master shapes.

Setting Drawing Scale

Each drawing page in a drawing file can use a different drawing scale. This is handy when you want to show the layout of a floor on one page but need a larger scale drawing of a construction detail on another page. To specify the drawing scale for a drawing page, follow these steps:

1. Display the page whose drawing scale you want to set.
2. Choose File ➪ Page Setup and select the Drawing Scale tab.
3. To specify one of the scales predefined in Visio, select the Pre-defined scale option and select one of the following types of predefined scales:
• **Architectural** — Relates a number of inches or a fraction of an inch on paper to one foot in the real world

• **Civil Engineering** — Relates one inch on paper to a number of feet in the real world

• **Metric** — Relates meters on paper to a number of meters in the real world

• **Mechanical Engineering** — Relates a fraction of a unit to one unit in the real world in order to scale objects down to fit on the page. Relates multiple units on paper to one unit in the real world in order to scale objects up so they’re legible on paper.

You can also create your own drawing scale by selecting the Custom Scale option and specifying the paper distance and its corresponding real-world distance.

4. Choose the predefined scale you want in the Scale drop-down list. The values in the Page Size boxes change to indicate how many measurement units fit on the page at the scale you’ve selected.

5. Click Apply to save the drawing scale with the drawing page. Although the shapes on the drawing resize to match the new drawing scale, and the distances shown in the rulers adjust to the new scale, the real-world dimensions of the shapes on the drawing page remain the same.

6. If you use background pages with your scaled drawings, display the background page and then repeat steps 2 through 4 to apply the same drawing scale to it.

**Showing Scale on Drawings**

When you work with scaled drawings, it’s a good idea to indicate the drawing scale somewhere on the drawing page. In that way, anyone viewing a hard copy of the drawing knows what the scale is and can measure objects on it correctly. Visio provides several shapes that automatically display the drawing scale for you. Table 24-3 lists some of the shapes you can use to show drawing scale. To use one of these shapes, simply open the stencil on which the master is located and drag it onto the drawing page. By default, each shape shows the drawing scale differently, as outlined in Table 24-3 and shown in Figure 24-2. However, if you use the Drawing Scale shape from the Annotations stencil, you can change the scale type by right-clicking the shape and then choosing one of the scale styles from the shortcut menu.
### Table 24-3
Shapes That Show Drawing Scale

<table>
<thead>
<tr>
<th>Shapes</th>
<th>Stencil</th>
<th>Scale Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing Scale</td>
<td>Annotations</td>
<td>Mechanical Engineering 1⁄48:1</td>
</tr>
<tr>
<td>Scale Symbol</td>
<td>Annotations</td>
<td>Graphical display of scaled distances</td>
</tr>
<tr>
<td>Scale</td>
<td>Title Blocks</td>
<td>Decimal format 1:48</td>
</tr>
<tr>
<td>Title Block Large</td>
<td>Title Blocks</td>
<td>Maintains drawing scale format specified</td>
</tr>
<tr>
<td>Title Block Small</td>
<td>Title Blocks</td>
<td>Maintains drawing scale format specified</td>
</tr>
</tbody>
</table>

Title Block shape uses the format for selected scale

Format for Scale shape is fixed

Format for Scale Symbol shape is fixed

Right-click Drawing Scale shape to change format

**Figure 24-2**: Shapes that automatically display drawing scale use different scale formats.
Specifying Measurement Units

When you work with scaled drawings, two types of units are important: page units and measurement units. Page units represent the distances or units on the printer page or piece of paper you print. Measurement units represent real-world distances or the units for the actual sizes of the objects you’re drawing. For example, in the architectural scale of \( \frac{1}{4}'' = 1' \), the page units are inches and the measurement units are feet.

If you use one of Visio’s scaled drawing templates, Visio automatically sets both the drawing scale and measurement units for you. If you use both types of scaled templates, you can specify the units you want by choosing a U.S. units template or a Metric template when you create a new drawing. In addition, because drawing scales specify the relationship between page distances and real-world distances, Visio sets the measurement units and page units for you when you choose a drawing scale.

Setting Default Units

If you don’t use Visio’s templates to create scaled drawings or you use shapes you’ve created yourself, you can specify the units you want to use. To specify either U.S. or metric units, choose Tools ⧼ Options and select the Units tab. Under Default Units, check the Always Offer ‘Metric’ and ‘US Units’ for New Blank Drawings and Stencils check box. If you want to change the units for the current page, click Change and then choose the new units in the Measurement Units drop-down list.

Tip

The list of measurement units includes units such as days and weeks. You can choose these units if you want to produce schedules in which one inch represents one week or some other length of time.

Specifying Measurement Units for a Page

You can set or change the measurement units for a drawing page. For example, you can specify whether the rulers and drawing grid use inches, meters, or even miles. In addition, when you want to make sure that the plan you’re drawing fits on the page, you can specify the page size in measurements units. For example, if you want to draw a building that is 60 feet long and 30 feet wide, you can set your drawing page to 70 feet by 40 feet in measurement units. To specify measurement units, use one of the following methods:

✦ Specify measurement units—Choose File ⧼ Page Setup and select the Page Properties tab. Choose the units you want from the Measurement Units drop-down list and then click Apply. Visio changes the distances you see on the rulers and adjusts the grid to match the new units.
Specify the page size in measurement units — Choose File ➪ Page Setup and select the Drawing Scale tab. In the Page Size (In Measurement Units) boxes, type the distances you want to represent on the page. For example, to create a page that represents 70 feet by 40 feet, type 70 ft. in the first box and type 40 ft. in the second box. Click Apply to change the page size. Visio shows the size of the drawing page and the printer paper in the preview pane, as shown in Figure 24-3.

![Figure 24-3: You can set the page size so your plan fits.](image)

Dimensioning Scaled Drawings

Measuring a hard copy of a scaled drawing to determine the sizes of scaled objects isn’t always possible. Only the most hard-core architects and engineers walk around with scales in their pockets. Typically, scaled drawings include dimensions to show sizes, offsets, and distances from reference points. Visio Professional provides stencils with shapes you can use to dimension linear, radial, and angular distances.

In Visio Standard, the Room Measurement shape and the Controller Dimension shape on the Walls, Doors, and Windows stencil are the only way you can add dimensions to a scaled drawing.
Visio Professional provides two stencils with shapes specifically designed to glue to scaled shapes and show their dimensions. Although the shapes on each of these stencils share the same names and work the same way, they display dimensions in different formats. Depending on the type of drawing you are creating, you can open a dimensioning stencil by choosing File ➪ Shapes ➪ Visio Extras and then choosing either of the following stencils:

- **Dimensioning–Architectural** — For linear dimensions, architectural dimension shapes display the dimension value above the dimension line and use slashes at the ends of the dimension line.
- **Dimensioning–Engineering** — For linear dimensions, engineering dimension shapes display the dimension value in the middle of the dimension line and use arrowheads at the ends of the dimension line.

### Adding Dimensions

Some scaled shapes, such as Room and Wall shapes, display dimensions automatically when you select them. However, to annotate your drawings so that dimensions appear whether shapes are selected or not, you can use dimension shapes. Although the Dimensioning stencils include numerous dimension shapes, they all behave similarly. You drag a dimension shape onto the drawing page and glue its dimension lines to the shapes you want to measure. The dimension shape displays the dimension and recalculates the dimension automatically when you resize the shape.

Dimension shapes include control handles you drag to define the distance to measure as well as the location of the dimension lines. The control handles that appear depend on the dimension shape you choose. For example, you can add linear dimensions from a vertical baseline by following these steps:

1. Drag the Horizontal Baseline shape onto the page and position it at the bottom and to the left of the distances you want to dimension.
2. Drag the lower green end point and glue it to a geometry point that defines the baseline for all your dimensions, such as the corner of an exterior wall.
3. Drag the other green end point and glue it to a geometry point that defines the end of the first distance you want to dimension, such as the lower edge of a window.
4. To reposition the text and vertical dimension line for the first dimension, drag the yellow control handle on the first dimension line to the left or right.
5. To define the next dimension, drag the yellow control handle between the dimension shape’s selection handles to a position above the first dimension. Another yellow control handle appears at the end of the horizontal reference line. Drag this control handle and glue it to a point that defines the second distance you want to dimension, as illustrated in Figure 24-4.
Define dimension and position of extension line
Reposition first dimension to left or right
Refine dimension

Change spacing of dimension lines
Add another dimension
Redefine dimension and reposition extension line

**Figure 24-4:** Drag control handles to define multiple dimensions.

6. Repeat step 3 until you have added the dimensions you want.
7. To change the spacing between the vertical dimension lines, drag the yellow control handle at the bottom of the dimension shape to the left or right.
8. To change a dimension, drag a control handle or selection handle at the end of the horizontal reference lines up or down.

Shapes for dimensioning angles include selection and control handles you can drag to configure the angular dimension. For example, you can dimension a radius with the Radius shape by following these steps:

1. Drag the Radius shape onto the drawing and glue it to a point at the center of the radius you want to dimension.
2. Drag the yellow control handle onto the arc you want to dimension.
3. To position the radial dimension text, drag the green selection handle to a new location.

**Tip**
To find out what a control handle does, position the pointer over the control handle to display a screen tip.
For example, you can dimension an angle by following these steps:

1. Drag the Angle Even shape onto the drawing page and glue it to the origin of the angle you want to dimension.

2. To change the lower edge of the angular dimension, drag the selection handle on the Angle Even shape to a new location.

3. To change the top edge of the angular dimension, drag the yellow control handle at the top of the Angle Even shape to a new location, as shown in Figure 24-5.

![Figure 24-5: Drag control handles to define an angular dimension.](image)

You can also drag control handles on any of the Angle shapes to change the length of the extension line, the position of the angular dimension line, and the position of the dimension text.

**Specifying Precision and Units for Dimensions**

The dimensions that you add to a drawing show distances based on the measurement units you’ve chosen for that drawing page. However, you can specify precision...
and units for a dimension that differ from the ones that apply to the drawing page. To change precision and units for a dimension, follow these steps:

1. Right-click a dimension shape, such as Vertical, Radius Outside, or Angle Center, and choose Precision & Units from the shortcut menu. The Custom Properties window appears.

2. To specify the number of decimal points of precision for the dimension shape, select an entry from the Precision drop-down list.

3. To specify the units you want to use, select an entry from the Units drop-down list.

4. In the Units Display list, select an entry to specify whether or not to show the units.

5. To change the angle of the dimension, type an angle in the Angle box.

6. Click OK.

You can also show a shape’s dimensions by inserting a geometry field in the shape’s text block. To learn how to do this, see Chapter 32.

**Calculating Area and Perimeter**

Visio Professional also includes tools you can use to automatically measure the area and perimeter of any closed shape. For example, you can calculate the area within the floor of a building to determine the number of sprinkler heads you need for fire protection, or the perimeter of a parking lot to order fencing.

To measure the area and perimeter of one or more shapes, choose Tools ➪ Add-Ins ➪ Visio Extras ➪ Shape Area and Perimeter. The Shape Area and Perimeter dialog box opens, displaying the area in square inches and the perimeter in inches by default. You can keep the Shape Area and Perimeter dialog box open as you issue other commands. If no shapes are selected, the Total Area and Total Perimeter boxes display the words “No Selection.” As you select shapes, their area and perimeter values appear in the boxes.

If you select more than one shape, the Total Area and Total Perimeter values reflect the values of all the individual shapes combined. For example, to measure the square footage of several separate rooms, Shift+click each room shape. The Shape Area and Perimeter values reflect the total area and total perimeter of all the rooms combined.

To calculate the area and perimeter of the boundary for several shapes, such as the footprint of a building, use the Pencil or Line tool to trace the boundary you want to measure. To calculate the area and perimeter of the boundary, select the boundary you drew.
Measuring Areas with Holes

In many situations, you want to calculate the area for a space but want to ignore some space within it. Suppose you want to calculate the area of a space with a hole in it. For example, to calculate the rentable space within a building floor, you might want to calculate the area of the building boundary without the area for the building core, which contains stairs and elevators. You can use a Visio shape operation to help perform this calculation for you by following these steps:

1. Click the Line tool or Pencil tool on the Drawing toolbar.
2. Draw a shape around the building perimeter and then draw another shape around the building core.
3. With no other shapes selected, Shift+click the two shapes you just drew and then choose Shape ➪ Operations ➪ Combine. The Combine command creates a hole in the floor using the shape you drew around the building core.
4. Select the combined shape and choose Tools ➪ Add-Ons ➪ Visio Extras ➪ Area Shape and Perimeter. The Total Area and Total Perimeter represent the values for the entire floor minus the values for the hole.

Summary

Scaled drawings make it easy to communicate plans in which accuracy and precision are important. In Visio, you can specify drawing scales and measurement units so your plan fits on the drawing page. Visio includes shapes designed to work with scaled drawings. These shapes resize based on the scale you’ve set for the drawing page. Each drawing page can use a difference drawing scale and measurement unit, so you can show a site plan on one drawing page, a floor plan on another, and a detail of a structural connection on yet another page.

Because accuracy is important, you can add dimensions to your scaled drawings to show the real-world sizes of the objects. Visio provides two stencils for dimensions, which display dimensions in either architectural or engineering formats. Dimension shapes include control handles and selection handles you can drag to define and configure dimensions.
Creating Scaled Plan Drawings

Although Visio isn’t meant to replace or compete with CAD programs, there are plenty of reasons to use Visio as a complement to a CAD program. Visio building plan templates are ideal for fast prototyping. You can drag and drop Visio shapes to quickly experiment with different layouts. When you’re ready to produce CAD drawings, you can export your Visio shapes into your CAD application. Visio is also a good choice when you want to enhance drawings created in other applications for presentations. You can insert CAD drawings into Visio drawings and use Visio tools to add presentation details.

For folks who don’t have access to a CAD program, Visio is an adequate substitute for reviewing CAD drawings or for producing smaller plan drawings from scratch. Visio Professional stencils offer numerous shapes for a variety of building plans. Displaying CAD drawings as backgrounds in Visio is a great way to jumpstart new plans.

Like CAD programs, Visio provides the capability to organize the contents of plans by using layers. Although Visio layers differ from their CAD cousins, you can use layers to control shape behavior, such as whether shapes are visible on the screen or when printed or whether they are editable or not. Each shape can belong to multiple layers so that you can manage shapes to suit your needs. By assigning masters to layers, you can ensure that Visio automatically assigns the shapes to the proper layers as you drag them onto your drawings. In addition, when you drop shapes with layer assignments onto a page, Visio automatically creates that layer for the page.

This chapter shows you how to create plan drawings by using Visio plan templates, either by starting with an existing CAD drawing or by using an existing Visio plan drawing. You will also learn the ways in which you can use layers to control the behavior of shapes, and how to make the assignment of shapes to layers as easy as possible.
Creating Plan Drawings

Every once in a while, you do have to create a scaled plan drawing from scratch, but more often than not, there’s a floor plan kicking around that you can use to get started. For example, you might have a CAD drawing of a basic floor plan that you want to use as a reference as you try out different furniture layouts. You might also want to use Visio to review and add comments to a CAD drawing produced by someone else. In these cases, you can insert CAD drawings into Visio drawings and use them as backgrounds onto which you drag and drop Visio shapes.

Conversely, if you have a Visio drawing with some of the information you want, such as a building shell and core, you can use that as a basis for additional plans, such as electrical, telecom or HVAC plans. With Visio plan drawings, you can copy and paste just the shapes you want or the entire drawing into a new plan drawing. If you paste the existing Visio floor plan onto a background page, you can display it in every foreground page you create. If you want to make sure that your underlying floor plan doesn’t change, you can lock its layers so that the shapes on them can’t be edited.

Setting Up Plan Drawings

Whether you’re going to create a plan drawing from scratch or want to set up a Visio drawing file to hold an existing plan, follow these steps to prepare your Visio drawing file:

1. Choose File ➪ New ➪ Building Plan and then choose the template you want to use.
2. To make changes to the default drawing scale or units, choose File ➪ Page Setup, and use one or more of the following methods:

   - **Change the drawing scale** — To use a different drawing scale — for instance, to match the scale of an underlying CAD drawing — select the Drawing Scale tab, select the Pre-defined Scale option, and select the type of scale and the specific scale you want to use from the drop-down lists.

   - **Change the page size** — To adjust the page size to match the contents of a CAD or Visio plan drawing, select the Page Size tab, select the Pre-defined Size option, and select the type of page size and the specific page size you want from the drop-down lists.

   - **Change the printer paper size** — To change the size of the printer paper, select the Print Setup tab and select the paper size you want in the Printer Paper drop-down list.

The Printer Paper list includes paper sizes for the current printer. If you want to print to a different printer or plotter, choose File ➪ Print and then select the printer or plotter you want to use. Then, click Close in the Print dialog box and reopen the Page Setup dialog box to select a paper size for the new printer.
Using Existing CAD Floor Plans

If you have an existing CAD drawing, you can insert it into a Visio drawing file by following these steps:

1. Open the Visio drawing page into which you want to insert the CAD drawing.
2. Choose Insert ➤ CAD Drawing. By default, Visio sets the entry in the Files of Type box to AutoCAD Drawing (*.dwg, *.dxf).
3. Navigate to the folder with the CAD drawing you want to use, select the CAD file, and click Open. Visio opens the CAD Drawing Properties dialog box, populated with CAD drawing units and a custom drawing scale that fits the drawing to the page. In addition, Visio checks the Lock Size and Position check box, Lock Against Deletion, and View Extents check boxes by default so that the CAD drawing can’t be moved, resized, or deleted in Visio.
4. Click OK to insert the CAD drawing on the Visio drawing page.

   Cross-Reference

To learn more about options and methods for importing CAD drawings into Visio, see Chapter 28.

5. If you want to use the inserted CAD drawing as a background for Visio drawing pages, choose File ➤ Page Setup and then select the Page Properties tab. Select the Background option, type the name you want for the background page, and click OK.

Using Existing Visio Plan Drawings

Sometimes, several plans share information, such as the basic building shell for multiple building service plans or the same basic floor plan elements for several floors in a high-rise building. If you already have these shared elements in a Visio drawing, you can copy and paste them into other Visio drawing pages so you can reuse the common shapes.

Caution

When you paste shapes from a scaled drawing, Visio resizes the shapes using the drawing scale for the destination drawing page. If the drawing scales in the source and destination drawing pages are more than a factor of eight apart—for example, 1:12 and 1:200—the pasted shapes might look very large or too small. If this occurs, you can change the scale of the destination drawing page to match the scale of the source page.

To copy an existing Visio plan into another drawing, follow these steps:

1. Open both the existing Visio plan drawing (the source) and the Visio drawing file into which you want to paste the existing Visio plan (the destination.)
2. To display both drawing windows, choose Window ➤ Cascade or Window ➤ Tile.
3. Click the title bar for the source drawing, select the shapes you want to copy, and then press Ctrl+C. If you want to copy the entire drawing page, choose Edit ➪ Copy Drawing.

4. Click the title bar for the destination drawing and press Ctrl+V to paste the copied shapes onto the drawing page.

Managing Plan Drawing Files

When you work with plan drawings that contain numerous types of information, you can create or store that information in drawing files in different ways to satisfy different requirements. For example, by placing the data for each building service in a different file and using OLE links to link those drawings in Visio background pages, you can assemble a compiled plan in one Visio drawing file while ensuring that different resources can edit each building service plan simultaneously when necessary.

For information about linking and embedding files or portions of files, see Chapter 8.

Conversely, if you’re working on your own, you can add all your shapes to the same drawing page and use layers to specify which shapes you see and whether they are editable. If you want to add additional flexibility to your solo environment, you can also place information on separate drawing pages, using some as background pages so they are available to several different foregrounds.

Although these techniques are more typical in a sophisticated CAD environment, it’s worthwhile to plan your Visio drawing files, drawing pages, and layers before you create your plan drawings.

Managing Shapes with Layers

If you’re familiar with CAD programs, you know that layers help you organize and manage the information on your drawings. In Visio, you can use layers to accomplish the following:

✦ Selectively view objects or shapes
✦ Selectively print objects or shapes
✦ Display categories of objects or shapes in different colors
✦ Lock categories of objects or shapes against editing
✦ Control whether you can snap or glue to shapes on a layer
**CAD Layers Versus Visio Layers**

Although Visio layers share many characteristics with the layers in CAD programs, they also differ from CAD layers in several key ways. Visio layers don’t determine the order in which shapes appear on the drawing. To specify whether a shape appears in front or in back of other shapes, you right-click the shapes and choose Shape ➪ Bring to Front or Shape ➪ Send to Back from the shortcut menu.

In Visio, shapes can belong to no layer at all or multiple layers. In addition, each Visio drawing can have no layers or multiple layers, and the layers for each drawing page can be different. Finally, you can’t group Visio layers.

For example, in a building plan, you can assign the structural components to one layer; walls, doors, and windows to another layer; furniture to a third layer; and electrical outlets to a fourth. When you want to work on the furniture layout for the building, you can lock the other layers so you don’t move building components inadvertently. If you want to evaluate whether the electrical outlets are sufficient, you can turn off the display of the structural and furniture layers to focus on electrical components. In addition, you might assign review comments to a layer so that you can print the plan with or without those comments. By turning off snap and glue for layers, you can make sure that new shapes don’t snap or glue to inappropriate shapes. For example, when you want to add electrical outlets to a plan, you can turn off snapping and gluing to all layers except the ones for walls.

You can create layers to organize shapes in the categories you want and then assign shapes on drawing pages to those layers. Many shapes in Visio stencils already contain layer assignments. You can use those assignments or create your own versions of those masters with the layer assignments you want. Each shape can belong to multiple layers or no layers at all. If you drag a master with a layer assignment onto a drawing page, Visio automatically adds the layer associated with the shape to the drawing page, if it doesn’t already exist.

**Creating Layers**

You can create layers using several methods. No matter which method you choose, you must create the layers you want for each drawing page, because new layers are added only to the current page and new drawing pages don’t inherit the layers associated with existing pages. Every page in a drawing can have a different set of layers.

If you use shapes with layer assignments, you don’t have to create layers at all. Visio creates layers for the drawing page automatically when you drop or copy a shape with a layer assignment onto the page. If the page already contains a layer with the same name, Visio adds the shape to the existing layer.
If you use shape layer assignments to create your layers, you might end up with layers you don’t want if you copy the wrong type of shapes onto the page. If you end up with layers you didn’t expect, you can uncheck the visibility of all layers except the ones that concern you to see which shapes are the culprits. Then, you can reassign those shapes to other layers by following the instructions in the “Removing Layers” section later in this chapter.

To create a layer for a drawing page, follow these steps:

1. Choose View ➪ Layer Properties and then click New.
2. In the New Layer dialog box, type a name for the layer and then click OK. Visio creates the layer for the current page.
3. In the Layer Properties dialog box, click the cells in the column for each property you want to apply to the layer, if they are not already checked, as shown in Figure 25-1.

![Layer Properties dialog box](image)

Figure 25-1: The Layer Properties dialog box contains all the commands you need to work with layers.

To avoid the repetition of creating the same layers for each plan drawing you develop, create a Visio drawing file with the drawing pages you want and the layers you want associated with those drawing pages. Save the file as a Visio template, as described in Chapter 3, and use that template as the basis for new plans.

**Renaming Layers**

You can rename existing layers for the current drawing page. The shapes on the layer remain the same. To rename a layer, choose View ➪ Layer Properties, select the layer you want to rename, and click Rename. In the Rename Layer dialog box, type a new name and click OK.
You should only rename layers that you create. Although you can rename the pre-defined layers for shapes on Visio built-in stencils, Visio creates a new layer with the original layer name as soon as you add another shape with that layer assignment. For example, if you rename the Building Envelope layer to Building Outline and then add another Exterior Wall shape, you’ll end up with a Building Envelope and Building Outline layer.

### Activating Layers

When you drag a shape without a pre-defined layer assignment onto the page, Visio assigns it to the active layer. If no layers are active, Visio adds the shapes to the drawing page without assigning them to a layer. You can select the shapes after adding them and assign them to a layer. However, it’s much easier to assign shapes to a layer as you add them. To do this, activate the layer to which you want to assign the shapes by choosing View ➤ Layer Properties and then clicking the cell to add a check mark in the Active column for the layer you want to make active. Visio makes the layer you choose active for the current page.

You can use this approach to assign shapes to multiple layers by choosing more than one active layer. Shapes you add to the page are automatically assigned to all of the active layers.

Make sure you reset the active layer as you work so that the shapes you add are assigned to the correct layer. However, if you use built-in Visio shapes, you don’t have to use an active layer because the shapes already have the proper layer assignments built in.

### Removing Layers

Removing layers associated with a drawing page is easy. However, removing a layer also deletes any shapes assigned to it, so you should reassign any shapes you want to keep to other layers before deleting layers. To remove a layer, follow these steps:

1. Choose View ➤ Layer Properties.
2. To display the number of shapes assigned to each layer, click the # button along the top of the Layer Properties table.
3. If the layer you want to remove has shapes on it, reassign them to a different layer by following these steps:
   a. To make it easier to see the shapes you want to reassign, uncheck the Visible cells for every layer except the one you want to remove.
   b. Click OK to close the Layer Properties dialog box.
   c. Select the shapes you want to reassign and choose Format ➤ Layer.
   d. In the Layer dialog box, uncheck any layers that are checked and check only the layer to which you want to assign the shapes. Click OK. If all other layers are invisible, the reassigned shapes disappear from the screen.
4. In the Layer Properties dialog box, select the layer you want to delete and then click Remove.

5. Check the Visible cell for every layer you want to see on the page.

**Tip**

If your list layers have gotten out of hand, it’s easy to delete all unused layers. To do this, in the Layer Properties dialog box, check the Remove Unreferenced Layers check box and then click OK.

## Putting Layers to Work

To put layers to work for you, you can specify layer properties to control the behavior of shapes as a group. Layer properties specify whether you can see shapes on the screen or when you print the drawing, whether you can edit shapes or snap and glue to them, and the color in which shapes appear. In the Layer Properties dialog box, you can specify the properties for any layer in the current drawing page. If you want the same properties for layers on other pages, you must apply those properties to each of those pages.

To specify properties, choose View ➪ Layer Properties. Click a cell in the column for a property you want to apply and the row for the layer to which you want to apply it. Click an empty cell to add a check mark and activate the property. Click a cell with a check mark to deactivate the property. You can specify the following properties for layers:

- **Visible** — Check this property to display the shapes on the layer on the screen. To temporarily hide shapes on a layer, uncheck the layer.

- **Print** — Check this property to print the shapes on the layer when you print the drawing. To prevent shapes from printing, such as construction lines when you’re printing final drawings, uncheck this property.

- **Active** — Check this property to assign shapes dropped on the page automatically to this layer.

- **Lock** — When this property is checked, you can’t select, move, edit, or add shapes to the layer. In addition, you can’t make the layer active.

**Note**

Although you can’t select, move, edit, or add shapes to a locked layer, you can change the color of shapes on a locked layer by setting the color in the Color column of the Layer Properties dialog box.

- **Snap** — Check this property if you want to snap to shapes assigned to the layer. When you uncheck this property, you can’t snap to shapes on the layer, although the shapes on the layer can snap to other shapes on snappable layers.
Using Layers on Background Pages

Although you can’t share layers between drawing pages, you can achieve the same result by assigning layers to background pages. For example, you can put the basic building plan on a background page with different types of building components assigned to different layers. If you want to hide the furniture shapes for all the drawing pages in your file, you only have to hide the furniture layer on the background page. However, with this approach, the layer properties you specify on the background page apply to every foreground page.

✦ **Glue** — Check this property if you want to glue to shapes assigned to the layer. When you uncheck this property, you can’t glue to shapes on the layer, although the shapes on the layer can glue to other shapes.

If shapes are assigned to multiple layers, you must uncheck the Snap or Glue properties for every layer to which the shape is assigned.

✦ **Color** — Check this property to assign a color to the shapes on the layer. Each layer can use a different color, which overrides any color associated with graphic components of shapes on the layer. Shapes assigned to multiple layers appear in their original colors.

**Assigning Color to a Layer**

You can assign different colors to each layer for a drawing page. You can make colors opaque or transparent. For example, if you use filled rectangles to show areas on a plan, you can make the layer for those rectangles transparent so that you can still see the furniture and building components. To assign a color for a layer on the current page, follow these steps:

1. Choose View ➪ Layer Properties.
2. Click the cell in the Color column to add a check mark for the layer you want to color.
3. Click the arrow next to the Layer Color box and then select a color in the Layer Color list.
4. To change the transparency for the color, drag the Transparency slider to the value you want: 100 percent makes the layer totally invisible; 0 percent makes the layer completely opaque. To make a color visible but transparent, choose a value between 0 and 100.
Layer color overrides any color and transparency level associated with graphic components of shapes on the layer. However, shapes assigned to multiple layers appear in their original colors.

**Selecting Shapes Using Layers**

In addition to selecting shapes by dragging or clicking shapes on the drawing page, you can select groups of shapes by taking advantage of layers. To select shapes based on the layers to which they are assigned, choose **Edit** > **Select by Type**, and then use one of the following methods:

- **Select shapes on a specific layer** — Select the **Layer** option and then check the check box for the layer that contains the shapes you want. To select more than one layer, Ctrl+click each layer you want to select.

- **Select shapes without layer assignments** — Select the **Layer** option and then check the **{No Layer}** check box.

**Assigning Shapes to Layers**

Many shapes that come with Visio already have layer assignments. When you add these shapes to drawing pages, Visio creates the appropriate layer if it doesn’t already exist and assigns the shape to that layer. If a shape doesn’t have a predefined layer assignment, you can assign it to layers as you add it to the drawing page by specifying an active layer. Visio assigns any shapes you add without specific layer assignments to the active layer. You might have to change the active layer to ensure that new shapes are added to the appropriate layer.

You can use other methods to assign shapes to layers. You can assign shapes to layers after you’ve added them to a drawing. If you plan to use layers frequently, it’s more effective to assign masters to layers so Visio adds your shapes to their assigned layers automatically.

You can assign shapes to more than one layer to achieve more flexibility. For example, you can assign office furniture to both the Furniture layer as well as the Office Equipment layer. Then, the shapes for office furniture appear whenever either of those layers is visible.

**Assigning Individual Shapes to Layers**

To assign shapes that you’ve added to a drawing page to a layer, follow these steps:

1. Select the shape or shapes you want to assign and choose **Format** > **Layer**.

2. In the **Layer** dialog box, check the check box for the layer to which you want to assign the selected shapes. To select more than one layer, Ctrl+click each check box, as illustrated in Figure 25-2.
Assigning Masters to Layers

It’s more effective to use masters with predefined layer assignments, because Visio adds them to the correct layer automatically. You can add layer assignments to shapes you create or to built-in masters. However, because Visio built-in stencils are copyrighted as well as read-only, you should make a copy of the masters you want to change in a custom stencil of your Favorites stencil and edit them there. You can also edit the layer assignments for masters on a drawing’s Document stencil and then save it as a new stencil to use in the future.

If you edit the layer assignment for a master and then drag it onto the drawing page, the instance you create uses the new layer assignment. However, any shapes you added prior to the layer change still use the previous layer assignment. You can change the assignment for those shapes by selecting them and choosing Format ➪ Layer.

If you want to assign a Visio master to a layer or change its current layer assignment, copy the Visio master to your Favorites stencil or another custom stencil. To do this, right-click the master in the Visio stencil and then choose Add to My Shapes from the shortcut menu. Choose one of the custom stencils on the submenu or choose Add to New Stencil or Add to Existing Stencil.

To assign a master to a layer or to change its layer assignment, open a Visio drawing so that the Shapes window appears, and then follow these steps:

1. Open the stencil that contains the master you want to assign to a layer. If the stencil is read-only, right-click the stencil title bar and choose Edit Stencil from the shortcut menu.

2. Right-click the master you want to edit and choose Edit Master ➪ Edit Master Shape from the shortcut menu.
3. In the master drawing window, select the master.


5. Use one of the following methods to create a layer assignment:
   
   - If the master is not assigned to a layer, in the New Layer dialog box, type
     the name of the layer to which you want to assign it in the Layer Name
     box and click OK. You can assign the master to additional layers by click-
     ing New and typing the name for the next layer.
   
   - To change the layer assignment, uncheck a layer’s check box to remove
     an assignment and then click New to create a new layer assignment.

6. To close the master drawing window, click the Close button for the master
drawing window. When Visio prompts you to update the master, click Yes.

7. To save your changes, right-click the stencil’s title bar and click Save.

8. To change the stencil to read-only, right-click the stencil title bar and choose
   Edit Stencil.

Assigning Groups to Layers

Groups of shapes can also have layer assignments. By default, when you select a

group and choose Format ➪ Layer to assign the group to a layer, all of the shapes in
the group become members of the new layer, losing their previous layer assign-
ments. However, if you want individual shapes in a group to retain their current
layer assignments, you can check the Preserve Group Member Layers check box in
the Layer dialog box. For example, if you build groups of shapes to represent stan-
dard office configurations that include office furniture as well as computer equip-
ment, you can assign the shapes for furniture to the Furniture layer and shapes for
computer equipment to the Electronics layer before grouping them. If you assign
the group to the Office Equipment layer, the furniture and computer equipment
retain their previous layer assignments but also include assignments to the Office
Equipment layer.

Caution

If you can see shapes on the drawing page, but can’t select them, the layer might
be locked. However, if you open the Layer Properties dialog box and find that the
layer isn’t locked, group layer assignments could be the culprit. The problem can
occur when you assign individual shapes to one layer, and the group to which they
belong to another layer. If you also turn off the visibility of the group’s layer but not
the visibility of the individual shape’s layer, you can see the shapes because of
their layer assignment, but you won’t be able to select or edit them.
Summary

You can use Visio plan templates to create blank plan drawings. If you have other plans available, either CAD drawings or Visio plan drawings, you can insert them in background pages to quickly create foundations for new plans. To manage the content of plan drawings, you can create layers to categorize the shapes on your drawings. You can assign shapes to one or more layers. By specifying whether layers are visible on the screen, appear when you print your drawing, and are active or locked, you can control both the appearance of shapes and access to shapes.

✦ ✦ ✦
Laying Out Architectural and Engineering Plans

Whether you’re creating a plan of your house to try out remodeling ideas or designing your company’s new manufacturing facility, Visio provides tools to make your job easier. Although Visio Standard provides only a few shapes for laying out office space, Visio Professional includes numerous stencils and shapes for creating a variety of architectural and engineering plans.

With Visio Professional plan templates, you can develop plans beginning with the shell of a building and gradually add walls, doors, windows, and furnishings. You can create additional plans for building services, such as electrical service, plumbing, and HVAC. To complete your plan package, you can expand outdoors and develop site and landscaping plans or draw maps.

Unlike CAD programs, which come with tons of drafting commands, Visio provides its architectural and engineering capabilities through shapes on stencils. The Visio shapes for plan drawings are easy to drag, drop, and configure using basic Visio techniques along with control handles and custom properties to implement special behaviors. Of course, Visio Building Plan templates provide the tools you need to draw plans, but not the specialized skills needed to determine what the plans should contain. You’ll have to read other books to learn about that.

Many of the techniques described in this chapter work equally well for basic office plans you can create in Visio Standard and more specialized architectural and engineering plans available only in Visio Professional. Content specific to Visio Professional is identified as such throughout this chapter.

Note: Many of the techniques described in this chapter work equally well for basic office plans you can create in Visio Standard and more specialized architectural and engineering plans available only in Visio Professional. Content specific to Visio Professional is identified as such throughout this chapter.
To learn about the different types of Visio Building Plan templates and how to create a Visio plan drawing, see Chapter 24.

Working with Walls

Visio provides shapes that represent different types of walls, such as exterior, interior, curtain, or window walls. Built-in shapes for walls are available on both the Walls, Shell, and Structure stencil and the Walls, Doors, and Windows stencil. These shapes come with built-in behaviors that make it easy to draw connecting walls the way you want, and contain custom properties to specify attributes such as wall thickness and fire rating. Additionally, you can create your own custom wall shapes, with, for instance, a hatched fill to show walls to be demolished.

You can create walls by dragging and dropping shapes, such as Wall, Exterior Wall, or Curved Wall, onto the drawing page, by using the Connector tool, or, if you’ve started your design with Space shapes, by converting Space shapes into walls.

Converting Spaces into Walls

When you begin with a space plan, you can easily transform those spaces into walls with the Convert to Walls command. You can specify the type of wall you want to use, as well as whether to display dimension lines or add guides to the walls created. In addition, you can delete the original Space shapes or keep them for further use. For example, if you want to show the square footage of spaces on the drawing or you intend to track space in your building, keep the Space shapes for those purposes.

To learn more about Space shapes and other methods for laying out spaces and rooms, see Chapter 27.

To convert Space shapes into walls, follow these steps:

1. Select the Space shape or shapes you want to convert and initiate the Convert to Walls command using one of these methods:
   - Right-click a shape and then choose Convert to Walls from the shortcut menu.
   - Select the shapes you want to convert using any selection method and then choose Plan ➤ Convert to Walls.

2. In the Convert to Walls dialog box, in the Wall Shape list, select the type of Wall shape you want to use.

   The Wall Shape list includes only the Wall shapes available on open stencils. If you don’t see the Wall shape you want, click Cancel, open the stencil with the desired Wall shape, and begin again with step 1.
3. To automatically add dimensions to each segment of a wall that is created, check the Add Dimensions check box.

   **Note**

   The dimensions that Visio adds automatically might not dimension the segments you want and often produce redundant dimensions. If you are converting multiple shapes, you might prefer to add dimensions yourself.

4. To glue guides to each vertical and horizontal wall segment, check the Add Guides check box. You can reposition wall segments while maintaining their connection to other wall segments by dragging these guides.

5. To keep the Space shapes after you convert them to Wall shapes, select the Retain option. If you are converting some other type of geometry to Wall shapes, select the Convert to Space shape to turn the geometry into Space shapes.

6. Click OK to convert the Space shapes into Wall shapes and add any additional elements you specified, as illustrated in Figure 26-1. Visio creates a separate Wall shape for each wall segment in the building. Because the Wall shapes are glued together, the intersections between Wall shapes are cleaned up.

**Figure 26-1:** The Convert to Walls command can use Space shapes or other geometry to create walls, dimensions, and guides.
7. To reposition a Wall shape, drag the guide glued to it. Wall shapes glued to the guide resize, but the original Space shapes remain the same.

**Tip**

If you want to resize a Space shape to match the new wall configuration, right-click the Space shape and choose Auto Size from the shortcut menu.

**Creating Walls**

When you want to add walls from scratch, standard techniques such as dragging and dropping, drawing connectors, and dragging handles work effectively with Wall shapes. You can choose the technique you like or switch between techniques depending on the circumstances. For example, if you want to draw all the wall segments for a building shell, using the Connector tool with the Exterior Wall shape is convenient. Conversely, when you add bits and pieces of interior walls as you modify a floor plan, dragging and dropping the Wall shape might be more effective. As you add Wall shapes to the page and glue them together, Visio cleans up the intersections so you see lines only for wall surfaces, as shown in Figure 26-2.

![Original wall segments](image1)

![Glued walls with intersections cleaned up](image2)

**Figure 26-2:** Visio cleans up wall intersections.

**Note**

For Wall shapes to connect properly, snap and glue must both be turned on. Choose Tools ➪ Snap & Glue. In the Snap & Glue dialog box, make sure that both the Snap check box and the Glue check box are checked under the Currently Active heading. In addition, make sure that the Connection Points and Shape Geometry check boxes are checked under both the Snap To and Glue To headings.
To create new walls on a drawing, use one of the following methods:

- **Drag and drop Wall shapes**—To add walls one at a time, drag the Wall shape you want onto the drawing page. To glue the new Wall shape to Wall shapes already on the page, glue its end points to connection points or shape geometry on existing Wall shapes. Visio highlights the connection points or shape geometry with a red square to indicate that the shapes are glued.

- **Use the Connector tool**—To add several connected walls, click the Connector tool on the Standard toolbar, click the master for the type of wall you want to add on a stencil, and then follow these steps:
  1. For the first wall, drag between two points to define the beginning and end of the Wall shape. As soon as you complete this Wall shape, the pointer changes to the four-headed arrow, indicating that you can move the current point to a new location.
  2. To add another Wall shape that starts where the first Wall shape ends, move the pointer away from the end point and then move it back, but not quite over the end point, until the pointer changes to the Connector icon (a plus sign with a small connector next to it).
  3. Drag from the current point to the end of the next Wall shape.
  4. Repeat steps 2 and 3 to create the Wall shapes for each wall segment you want.

When you add Exterior Wall shapes to a plan, you want the selection handles to appear on the interior surface of the building wall. If an Exterior Wall shape’s selection handles are on the edge that represents the exterior of the building, right-click the shape and choose Flip Wall on Reference Line from the shortcut menu.

### Connecting and Resizing Walls

When you glue Wall shapes together, Visio cleans up the corners and other intersections. However, this glue only goes so far. If you drag a Wall shape to another position, it separates from its friends and the corners fill in again. You can use guides to move multiple Wall shapes and lengthen, shorten, or otherwise resize connecting Wall shapes. It’s easy to glue Wall shapes to guides as you construct your plan using one of the following methods:

- **Gluing to existing guides**—In many cases, you begin a floor plan by dragging guides onto the drawing page to use as reference. If you drag a Wall shape onto a page and drag its end points to guides, Visio glues the shape to the guide automatically.

- **Creating guides with the Convert to Walls command**—If you convert Space shapes to Wall shapes as discussed in the section “Converting Spaces to Walls,” you can create guides glued to the Wall shapes created during the conversion.
Right-clicking a wall shape — To add a guide to an existing Wall shape, right-click the shape and then choose Add a Guide from the shortcut menu.

When you drag a guide that is glued to a Wall shape, the Wall shape moves with the guide and any Wall shapes that adjoin that Wall shape stretch or contract.

Modifying a Wall’s Properties and Appearance

Wall shapes include custom properties and options that you can use to change the appearance of the walls on your plan. For example, you can configure every dimension of a wall, including length, thickness, and height, by specifying values for custom properties. You can also change the number of lines Visio uses to display walls.

Changing Wall Thickness and Other Properties

Visio Wall shapes include several custom properties, some of which modify the configuration of the shape itself, while others store data for reference or reports. For example, the Wall Length and Wall Thickness properties change the length and thickness of the shape, respectively. The Wall Justification property controls the alignment of the Wall shape, such as Centered or Edge. Conversely, the Wall Height and Base Elevation properties won’t change the shape outline. However, you can produce legends, quantity take-offs, or bills of material based on these values. To change a custom property value, right-click a Wall shape and choose Properties from the shortcut menu. Type or select a value from a field’s drop-down list and click OK when you’re done.

If you modify custom properties frequently, it’s easier to dock the Custom Properties window by choosing View ➪ Custom Properties Window. The field boxes display the values for the selected shape. To change or enter a value, select the property you want to edit and type or select a value.

Changing the Way Walls Are Shown

By default, Visio shows walls as double lines, one line for each wall surface, although you might have to zoom in to see them. However, you can also display walls as single lines to streamline a crowded drawing, or show walls as double lines with a reference so that the centerline of the wall is easy to spot. If you want to change how Visio displays walls, right-click any Wall shape on a drawing page and choose Set Display Options from the shortcut menu (available only in Visio Professional). Make sure the Walls tab is selected and then choose the option you want.

Changing the display options for walls affects all the Wall shapes on the current drawing page but not Wall shapes on other pages in the file.
Changing Wall Color and Line Style

In addition to the number of lines that represent walls, you can easily change the color and line style for the Wall shapes on a drawing. Wall shapes such as Wall, Exterior Wall, and Curved Wall use the Wall line and fill styles. To change color or line style, select a Wall shape and then choose Format ➪ Define Styles. The Define Styles dialog box opens, pre-populated with the information for the Wall style.

To change the line style, click Line, select the pattern, weight, color, or other properties for the line style, and then click OK. To change the fill style, click Fill, specify color, pattern, and transparency for the fill style, and click OK. In the Define Styles dialog box, click Apply to change the line style for the Wall shapes on all drawing pages in the drawing file.

Adding Doors, Windows, and Other Openings

Doors, windows, and openings in walls are important, because rooms aren’t very useful if you can’t enter them. Visio shapes for openings make it easy to add openings to walls. For example, when you add one of these shapes, it automatically rotates to match the angle of the Wall shape, glues itself to the Wall shape, adjusts its width to match that of the Wall shape, and cleans up the Wall shape where the opening is located.

After adding these shapes to your drawing, it’s easy to change the configuration of the shape, such as reversing the direction in which a door opens or whether the door opens to the left or right. These configuration features are available whether you use Door, Window, or Opening shapes on the Walls, Doors, and Windows stencil available for Visio Standard or the Walls, Shell, and Structure stencil available only in Visio Professional.

Adding Openings to Walls

To insert a door, window, or other type of opening into a wall, drag a Door, Window, or Opening shape from the stencil onto a Wall shape. When you drop the shape on the Wall shape, the shape rotates into position in the Wall shape, glues itself to the Wall shape, and changes its thickness to match the Wall shape, as shown in Figure 26-3.

If a shape for a door, window, or other opening, doesn’t rotate to match the direction of the Wall shape, the shape isn’t glued to the Wall shape. Drag the shape over the Wall shape until you see the red square indicating that the shape is glued and that it has been rotated to match the Wall shape, and then release the mouse button.
Change openings between outside and inside

Drag to change swing angle

Change width of opening

Position an opening near a wall

Shape rotates to match wall

Figure 26-3: Openings change to match the wall thickness and orientation.

Modifying Doors, Windows, and Openings

Shapes for doors, windows, and other openings include custom properties and shortcut menu commands that modify the configuration of the shapes. For example, you can change the direction that a door swings (in or out) or the width of openings. In addition, you can use Display Options to change how doors, windows, and openings appear on each drawing page. Use one of the following methods to change door, window, and opening shapes:

- **Reverse direction** — Right-click a Door, Window, or Opening shape, and then choose Reverse In/Out Opening from the shortcut menu.

- **Reverse swing** — Right-click a Door, Window, or Opening shape, and then choose Reverse Left/Right Opening from the shortcut menu.

- **Reposition opening** — Drag the shape to a new position in the Wall shape. Visio heals the opening in the Wall shape at the original position and cleans up the Wall shape at the new location.
Creating Door and Window Schedules

For architectural projects, door and window schedules identify each door and window in a set of architectural plans and specify the dimensions and other attributes for these components, so that the right components are installed in the right places. In Visio Professional, you can use reports to create door and window schedules that automatically report information for the Door and Window shapes on your drawing. For example, the default Door Schedule report shows door number, door size, door type, and thickness. The default Window Schedule report includes window number, size, and type. You can run the predefined report as is or modify the report definition to include other custom properties or to specify which shapes to include in the report.

An easy way to produce a door or window schedule is to drag a Door Schedule or Window Schedule shape from the Walls, Shell and Structure stencil onto the drawing page. These tabular shapes use the existing schedule report definition to show information on the drawing page.

- **Modify dimensions and other attributes** — Open the Custom Properties window and then select the shape whose properties you want to change. Type or select the new value from a property drop-down list. For example, with the Double-Door shape, you can specify the width of the door, its height, the type of door, the percentage that the door is open on the page, its number, its fire rating, and its base elevation.

  If you track information about building components in a database, you can import that data into the custom properties for Visio Building Plan shapes, as described in Chapter 10.

- **Change the door and window components that appear** — You can specify which components you want Visio to display for Door and Window shapes. For example, Visio displays the window frame and sash by default, but you can also show the header and sill. To change the components you see, right-click any Door or Window shape on a drawing page and choose Set Display Options from the shortcut menu. On the Doors or Windows tab, check the check boxes for the components you want to see and then click OK. Changing the display options for Door or Window shapes affects the shapes only on the current drawing page, so you must repeat this step for each drawing page you want to change.

- **Set default configurations** — When you use standard sizes, you can specify default properties for doors and windows. For example, you can specify the width of the door frame and the door panel so that every Door shape you add uses those dimensions. To do so, right-click a Door or Window shape, and choose Set Display Options from the shortcut menu. On the Doors or Windows tab, click Properties. In the Set Door Component Properties or Set Window
Component Properties dialog box, specify the default properties you want and then click OK. These settings affect only the current drawing page, so you must redefine these defaults for every page to which you want to apply them.

Set Display Options is available only in Visio Professional.

To learn how to modify and run report definitions, see Chapter 32.

Adding Cubicles and Furniture

Both Visio Standard and Visio Professional include shapes for laying out furniture for an office building. If you use Visio Standard, the Office Layout template is the only Building Plan template available to you. However, it includes the most frequently used shapes, including basic building components, office furniture, office equipment, office accessories, and cubicles. If you use Visio Professional, you can create a more detailed floor plan using the Floor Plan template. Then, you can open the Cubicles, Office Accessories, Office Equipment, and Office Furniture stencils to lay out your office within that floor plan.

Adding Cubicles to an Office Layout

Visio includes masters on the Cubicles stencil that are preconfigured with cubicle walls, furniture, and equipment. It’s easy to build an office layout by dragging these ready-made Workstation shapes onto the drawing page. If the built-in Workstation shapes don’t conform to the standards for your organization, you can create your own custom Workstation shapes.

You can also construct cubicles piece by piece with Panel shapes, Panel Post shapes, and shapes for work surfaces and storage units from the Cubicles stencil. You can create a cubicle configured the way you want, group its shapes, and then copy the group to lay out the rest of the office. In addition to cubicle components, you can add free-standing pieces such as Round Table and Stool shapes from the Office Furniture stencil to your custom Workstation shapes.

To create a cubicle from components, follow these steps:

1. Drag Panel or Curved Panel shapes from the Cubicles stencil onto the drawing page. To resize panels, drag selection handles on the shapes.

2. To connect panels, follow these steps:
a. Drag a Panel Post shape onto the page and glue it to one end of a Panel shape. Visio highlights the connection point in red to indicate that the two shapes are glued.

b. Drag a connection point from another Panel shape and glue it to a connection point on the Panel Post shape. The Panel Post shape rotates into position based on the connection point you choose. For example, if you position the pointer over the connection point on the right side of the Panel Post shape, the Panel shape will rotate to horizontal.

3. To add furniture and equipment to a cubicle, drag one or more of the following shapes into the cubicle:

   • **Modular work surfaces** — Drag shapes such as Work Surface or Corner Surface from the Cubicles stencil and position them along Panel shapes. You can use the shape’s rotation handles or the Rotate or Flip commands on the Shape menu to orient the shapes properly.

   • **Modular storage units** — Drag shapes such as Storage Unit from the Cubicles stencil and position them along Panel shapes.

   • **Suspended shelves and lateral files** — Drag shapes such as Susp Open Shelf or Suspended Lateral File from the Cubicles stencil on top of shapes for modular work surfaces.

   • **Chairs and other free-standing furniture** — Drag shapes from the Office Furniture and Office Accessories stencils into the Workstation shape.

   • **Computers and other equipment** — Drag shapes from the Office Equipment stencil into the Workstation shape.

**Connecting Modular Furniture**

The shapes on the Office Furniture stencil are designed with inward/outward connection points that make it easy to connect furniture components. Similar to Door and Wall shapes, shapes that represent modular furniture glue and rotate to match the Furniture shapes to which you glue them.

To connect modular furniture, follow these steps:

1. Drag a modular Office Furniture shape, such as 45 Deg Table, onto the drawing page.

2. Drag a connection point on a second modular Office Furniture shape and position the pointer over a connection point on the first shape. When Visio highlights the connection points with a red square and rotates the second shape into the proper position, release the mouse button.
Laying Out Plant Floors

In addition to laying out offices and cubicles on an office floor plan, you can also lay out machinery and equipment for manufacturing plants and distribution centers. As with other types of floor plans, you can start by creating a drawing with the Plant Layout template, or by laying out shapes over an existing Visio or CAD plan drawing. When you create a new plant layout by choosing File ➪ New ➪ Building Plan ➪ Plant Layout, Visio Professional opens some stencils shared with other plan templates and a few specific to plant layout, including the following:

✦ **Shop Floor–Machines and Equipment** — Includes shapes for machines such as lathes, saws, and other equipment
✦ **Shop Floor–Storage and Distribution** — Includes shapes for equipment such as forklifts, cranes, shelves, and racks
✦ **Vehicles** — Includes shapes for cars, trucks, buses, and shapes that show turning radii for vehicles
✦ **Warehouse–Shipping and Receiving** — Includes shapes for shipping doors, containers, and other equipment

The shapes on these stencils include selection and rotation handles you can use to position them. A few also include control handles for repositioning parts of the shape. However, these shapes are meant to be standalone and don’t include connection points for gluing the shapes together. Many of the shapes include custom properties you can use to specify the size of equipment, the department to which it is assigned, or asset number.

Modifying Cubicles

Predefined cubicles make it easy to lay out an office. By dragging Workstation shapes into place, you can add cubicle walls, work surfaces, office equipment, and other furniture in one step. If Visio’s built-in Workstation shapes aren’t set up the way you want, you can modify one of them and use it to populate your plan. You can also create a custom stencil of Workstation shapes configured to your organization’s standards.

To learn how to create custom masters, see Chapter 32.

To modify a cubicle, follow these steps:

1. Drag one of the Workstation shapes, such as an L workstation, from the Cubicles stencil onto the drawing page.
2. To change the size of the cubicle, drag the Workstation shape’s selection handles. Shapes such as Panels and Work Surfaces resize automatically to match the new cubicle size.

3. To move, delete, or format an individual component within the cubicle, select the Workstation shape and then subselect the individual shape inside it. Drag the shape to move it, press Delete to delete it, or choose format commands to reformat it.

4. To add additional furniture of equipment to the cubicle, drag a shape, such as Telephone, from the Office Equipment stencil, onto the Workstation shape. With the Workstation shape selected, Shift+click the new Furniture or Equipment shape, and then choose Shape ➪ Grouping ➪ Add to Group.

5. To copy the Workstation shape, press Ctrl+D to create a duplicate and then drag it into position.

Tip
If the office layout is laid out on a grid, you can also use the Array Shapes command to create Workstation shapes at regular intervals both vertically and horizontally. For information on using Array shapes, see Chapter 4.

Creating Building Services Plans

Documenting the equipment and services that keep a building running requires a lot more than just building walls and openings. If you use Visio Professional, you can create plans for each building service, including electrical, plumbing, HVAC, and security systems. Most of the shapes on stencils for building services include shortcut commands and custom properties that you can use to select a type of component, specify component dimensions, or configure shapes in numerous ways. In addition, these shapes include layer assignments so that it’s easy to use layers to control the behavior of building services shapes.

Adding HVAC Services

If you’ve ever worked in your office building on the weekend when the air conditioning is turned off, you know how important HVAC service is to people’s comfort. In Visio Professional, you can create two types of HVAC plans. An HVAC Plan shows the ductwork, registers, and diffusers that deliver and remove air. An HVAC Control Logic diagram represents the sensors and control equipment that control the delivery of air, such as quantity and temperature.
Separating Building Services from the Basic Building

Typically, you draw each building services plan over the exterior walls, structural elements, the building core, the interior walls, and, in some cases, the cubicles. You can use the same basic plan as a foundation for each building services plan by placing the basic building on a background page. You can associate the background page with each foreground page you create for different building services plans. In addition to sharing the same building plan for all your building services plans, a background page also prevents you from inadvertently modifying the basic building plan.

If you add all the building shapes to the same drawing page, layers on the drawing page act as separators. You can turn off the layers you don’t want to see for a specific plan; for example, you could turn off the HVAC layer when you’re documenting the electrical service plan. In addition, if you want to protect the basic building components, you can lock layers, such as Building Envelope, Wall, and Stair, so you can’t edit them as you work on Plumbing shapes.

If you’ve imported a CAD drawing as a backdrop, you also lock that drawing against editing. To do so, right-click the drawing and then choose CAD Drawing Object Properties from the shortcut menu. In the CAD Drawing Properties dialog box, on the General tab, make sure both the Lock Size and Position check box and the Lock Against Deletion check box are checked.

To learn more about using background pages, see Chapter 2. Chapter 25 describes how to use layers to control shapes. Chapter 28 discusses the use of CAD drawings within Visio drawings.

Drawing HVAC Plans

If you start an HVAC plan with the HVAC Plan template, Visio Professional opens the stencils with HVAC equipment and ductwork for you. If you are adding an HVAC plan in an existing drawing, you can open the same stencils by choosing File ➪ Shapes ➪ Building Plan and then selecting the following stencils:

- **HVAC Equipment** — Includes pumps, condensers, fans, and other types of HVAC equipment
- **HVAC Ductwork** — Includes numerous types of ducts shapes
- **Registers, Grills and Diffusers** — Includes shapes for openings that deliver, remove, or diffuse air
- **Drawing Tool Shapes** — Includes shapes for creating geometric shapes useful in duct layout

To lay out HVAC ductwork and equipment, follow these steps:

1. Open the drawing page on which you want to create your HVAC plan, whether it’s an existing floor plan page, a page with an imported CAD drawing, or a new page.
2. To simplify changing shape properties, open the Custom Properties window by choosing View ➪ Custom Properties Window.

3. Drag shapes that represent ductwork from the HVAC Ductwork stencil onto the drawing page.

4. To change the dimensions of a Ductwork shape, such as Straight Duct or Y Junction, use one of the following methods:
   - **Selection handles** — Drag selection handles to change the length or width of ducts.
   - **Control handles** — Drag control handles to change the angle of branches on ducts.
   - **Enter dimensions** — If the Custom Properties window is open, select the Ductwork shape and then type the new length or width in the Duct Length or Duct Width box.

5. To connect Ductwork shapes on the drawing page, drag a connection point on the second Ductwork shape to a connection point on the first Ductwork shape. For example, drag from a Branch Duct shape to the shape that represents the main duct. Visio highlights the connection points with a red square to indicate they're glued, and rotates the second Ductwork shape to match the orientation of the first.

   **Note** If you drag a Ductwork shape from a stencil, position one of its connection points over a connection point on a Ductwork shape on the page to connect them.

6. To change other attributes for some ductwork shapes, right-click a shape and choose a command from the shortcut menu. For example, you can choose between Rectangular Duct and Circular Duct or specify whether the ends are open or closed.

7. To label ducts, use one of the following methods:
   - **Show duct size** — Right-click a Ductwork shape and choose Show Duct Size from the shortcut menu. Shapes that represent rectangular ducts show the duct width and depth. Shapes that represent circular ducts show the diameter followed by the diameter symbol.
   - **Add a text label** — As with other standard shapes, you can select a shape and type the label text you want. You can reposition the label text by dragging the control handle on the text block.

8. To add registers, grills, diffusers, and other types of HVAC equipment, drag shapes from either the Registers, Grills, and Diffusers or HVAC Equipment stencils and drop them on top of Ductwork shapes. These shapes don't glue to Ductwork shapes or rotate to match the orientation of Ductwork shapes. However, you can use the rotation handles on these shapes to rotate them.
Drawing HVAC Control Logic Diagrams

HVAC Control Logic diagrams show the sensors, equipment, and wiring that control the HVAC system drawn on an HVAC plan. However, unlike the HVAC Plan template, the HVAC Control Logic Diagram template creates unscaled schematic drawings by default. These HVAC control logic schematics are single-line or double-line drawings that represent ducts, sensors, and mechanical equipment to control the HVAC system. The built-in shapes for sensors and equipment match the width of the Ductwork shapes so they snap into position when you drag them onto a Ductwork shape as shown in Figure 26-4.

In addition, many of the shapes for HVAC controls include custom properties you can use to select the exact configuration you want. For example, after you add a Control shape such as Voltage or Smoke to the page, you can select custom property values to specify whether the shape is a controller or a sensor, the type of controller or sensor, and the limit switch and reset switch settings.

To create an HVAC Control Logic diagram, follow these steps:

1. Start your diagram with one of the following methods:
   - **Use the HVAC Control Logic Diagram template** — To start a diagram from scratch, choose File ➪ New ➪ Building Plan ➪ HVAC Control Logic Diagram.
   - **Add to an existing plan drawing** — Open the drawing page you want to use and then open the HVAC Control and HVAC Control Equipment stencils.
2. If you are starting from scratch, drag guides from the horizontal and vertical rulers to provide reference points for adding ducts to the diagram.

3. To add ducts to the diagram, drag Duct shapes, such as Duct, Return Duct, or Supply Duct, from the HVAC Controls Equipment stencil onto the drawing page and glue them to guides. By default, Visio draws Duct shapes with double lines. To represent ducts with single lines, right-click a Duct shape and choose Single Line Ducts from the shortcut menu.

By adding guides to the page and gluing Duct shapes to them, you can easily move Duct shapes and their associated Control shapes as one by dragging the guide to which they are glued. Glue horizontal Duct shapes to horizontal guides, and vertical Duct shapes to vertical guides.

When you show ducts as double lines, position a Duct shape that is perpendicular to another by positioning an end point of the perpendicular Duct shape at the centerline of the existing Duct shape. If the connection doesn't show an opening between the Duct shapes, as shown in Figure 26-4, right-click the Duct shape you are adding and choose Shape ➔ Bring to Front.

4. To resize Duct shapes, drag their end points. If you want to constrain the Duct shape to its current rotation, press Shift as you drag its end point.

5. Drag Equipment shapes, such as Centrifugal Fan or Humidifier, from the HVAC Controls Equipment stencil onto the drawing page and place them on top of Duct shapes.

6. Drag Sensor shapes, such as Timer or Light, from the HVAC Controls stencil onto Duct shapes on the drawing page. The alignment boxes for these shapes match the width of Duct shapes so they snap into place, as illustrated in Figure 26-4.

If a Duct shape is glued to a guide, dragging Equipment and Sensor shapes onto the Duct shape also glues those shapes to the guide. To reposition the Duct shape and all of its associated Equipment and Sensor shapes, drag the guide to a new location.

7. To configure some Equipment and Sensor shapes, in the Custom Properties window, change the values for the custom properties. If the Custom Properties window isn’t open, you can also right-click a shape and choose Properties from the shortcut menu.

Creating Reflected Ceiling Plans

The Reflected Ceiling Plan template doesn’t actually include a tool to automate the creation of a reflected ceiling plan, so you can start with any building plan template you want. You can create the ceiling grid itself using drawing tools, guides, and the Array Shapes command. After the grid is constructed, open the Electrical and
Telecom stencil and the Registers, Grills, and Diffusers stencil if they aren’t open already and drag shapes for light fixtures, air diffusers, and smoke detectors onto the plan.

Ceiling grids often repeat the same pattern of tiles and devices throughout most of a building. Because of this, you can draw a portion of the grid with shapes for ceiling tiles and ceiling-mounted equipment and then use the Array Shapes command to repeat that pattern in the rest of the building. To create a ceiling grid, follow these steps:

1. Drag guides onto the page to define reference points for one or more ceiling tiles.
2. Use the Line tool or Rectangle tool to draw one or more ceiling tiles.
3. If the ceiling-mounted equipment is located at regular intervals in the grid, drag shapes for lighting from the Electrical and Telecom stencil on the drawing. Drag Diffuser shapes from the Registers, Grills, and Diffuser stencil onto the drawing.
4. Select the shapes for the ceiling tiles and ceiling-mounted equipment that you want to repeat.
6. To copy the shapes as a grid, in the Array Shapes dialog box, set the Spacing for Rows and Columns to zero, select the Between Shape Edges option, and then click OK.
7. If the ceiling-mounted equipment is not located at regular intervals or some rooms have special equipment, place equipment by dragging shapes from the Electrical and Telecom or Registers, Grills, and Diffusers stencils onto the drawing page.

Adding Electrical and Telecom Services

The Electrical and Telecomm stencil includes shapes you can use to show lighting fixtures, electrical switches and outlets, and other electrical devices on plans for a home, building, or manufacturing plant. You can start a diagram from scratch by choosing File ➪ New ➪ Building Plan ➪ Electrical and Telecom, but it’s often easier to open the Electrical and Telecom stencil while you work on an existing floor plan.

Most of the shapes on the Electrical and Telecom stencil include custom properties with multiple values for specifying different types of electrical devices. For example, the Switch Type property for the Switches shape can change the switch between Single Pole, 3 Way, 4 Way, Timer, and Weatherproof switches. Although the basic shape might stay the same, the shape displays other graphics to indicate which type of component it is. In addition, some shapes include shortcut menu commands for reconfiguring shapes. For example, you can use a shortcut command to flip the orientation of the Switches shape.
If you don’t see a shape for the device you want, drag one of the shapes onto the drawing page and then right-click it to display the shortcut menu. Look for configuration commands on the shortcut menu or choose Properties to look for custom properties that show different device types.

Although switches and outlets connect to walls on a floor plan, shapes for switches and outlets don’t rotate into position as Door and Window shapes do. You can use the rotation handle on the shape to rotate the shape into position. You can also rotate a shape to the left or right by ninety degrees by selecting the shape and then pressing Ctrl+L or Ctrl+R.

Visio doesn’t offer a tool to draw wiring between electrical devices. You can use the Freeform tool or Pencil tool to draw connections between devices. To add wiring between two shapes, select the Freeform tool, drag from a connection point on the first shape, and drag slowly to the connection point where the wire ends.

To learn about the Freeform tool, see Chapter 2.

**Adding Plumbing**

The Plumbing and Piping Plan template creates a new scaled drawing and opens stencils with shapes you can use to show pipes, valves, and fixtures for water supply or wastewater disposal systems. You can start a diagram from scratch by choosing File ➪ New ➪ Building Plan ➪ Plumbing and Piping Plan, but you can also open the following stencils while you work on an existing floor plan:

- **Pipes and Valves—Pipes 1 and 2** — These two stencils include dozens of linear shapes that represent pipelines and pipeline devices.
- **Pipes and Valves—Valves 1 and 2** — These two stencils include numerous valves you can glue to the ends of pipeline shapes.
- **Plumbing** — This stencil offers standard plumbing shapes, including Boiler, Radiator, Toilet, and Bath. Bathroom shapes include both top view and side view shapes so you can show how fixtures are connected in a plan or cutaway view.

To create a plumbing and piping plan, follow these steps:

1. Drag Plumbing fixtures onto the drawing page.
2. Drag shapes for pipelines onto the page and glue each end to connection points on shapes for fixtures or plumbing equipment. You can resize shapes for pipelines by dragging their end points.
3. Drag Valve shapes onto the drawing. Glue Valve shapes to the ends of shapes for pipelines.

4. For shapes that include shortcut commands or custom properties, such as the In-line Valve shape, right-click the shape and choose a configuration command from its shortcut menu or select a value in a custom property field.

Adding Security and Access Systems

Unfortunately, good security becomes more important every day. Whether you’re designing a state-of-the-art security system for a top-secret development facility or setting up electronic access for an office building, you can use the Security and Access Plan template to draw a security plan. You can start a diagram from scratch by choosing File ➪ New ➪ Building Plan ➪ Security and Access Plan, but you can also open the following stencils while you work on an existing floor plan:

✦ Alarm and Access Control — Includes shapes for card readers, keypads, cameras, and other access devices
✦ Initiation and Annunciation — Includes shapes for paging and alarms
✦ Video Surveillance — Includes shapes for motion detectors, cameras, and other video equipment

Most of the shapes on the Security and Access stencils include custom properties with multiple values for specifying different device configurations. For example, the Mount Type property, which is associated with numerous shapes, specifies whether the device is mounted on the ceiling, on the wall, flush, hidden, or in other ways. The shape label changes to reflect the type of mounting, the type of technology, and the function type.

Creating Site and Landscaping Plans

Site plans come in two flavors, depending on the type of site information you want to show. Landscaping plans can be as small as a garden in the backyard of a town home, showing plants, fences, irrigation equipment, and recreational elements for the site. Conversely, site plans usually represent a much larger area and show landscaping, irrigation, parking, driveways, and traffic management features.

Site plans are available only in Visio Professional.

For smaller sites, you can use an existing building plan as a foundation and add site details around the building. For larger sites, you’ll probably need a separate site plan that uses a smaller scale to fit the larger area onto the drawing page. To create
a site plan from scratch, choose File ➪ New ➪ Building Plan ➪ Site Plan. Visio creates a new drawing using a civil engineering scale of 1" = 10’ 0". This scale fits a site 360 feet by 240 feet on the architectural drawing page. If your site is larger than that, you can choose predefined civil engineering scales up to 1" = 100’ 0” or you can specify a custom scale.

If you use an existing building plan, your buildings are already on the drawing page. However, when you start a new site plan with the Site Plan template, you must draw building outlines using drawing tools such as Line, Rectangle, or Pencil.

Adding Landscaping Elements

Several stencils provide shapes to show the plantings and constructed features for a landscape. These shapes work equally well for commercial landscaping and home garden layouts. Drag shapes from the following stencils to add landscaping elements to the site plan:

- **Garden Accessories** — Includes shapes for fences, posts, and gates; and shapes for surfaces, such as flagstone, brick pathways, concrete, driveways, and patios
- **Irrigation** — Includes shapes for irrigation lines, spray heads, valves, and other devices. These shapes include custom properties you can use to specify different types of irrigation devices.
- **Planting** — Includes shapes for different types of trees, shrubs, hedges, and potted plants. You can use the Plant Callout shape to label plants with both common names and plant descriptions.
- **Sport Fields and Recreation** — Includes shapes for recreational equipment, such as pools, swing sets, and different types of sports fields

Many of the Landscaping shapes end up positioned at regular intervals, whether you are planting a grid of palm trees or placing a series of brick pathway shapes to represent a brick sidewalk. To create and arrange shapes at regular intervals vertically and horizontally, use the Array Shapes command.

To learn how to apply the Array Shapes command, see Chapter 4.

Working with Roads and Parking Lots

The Site Plan template opens both the Parking and Road stencil and the Vehicles stencil. You can use shapes on the Parking and Road stencil to add roads, driveways, parking stalls and lots, sidewalk ramps, and traffic islands. By adding shapes from the Vehicles stencil to the plan, you can make sure that differently sized vehicles can navigate the site.
Creating Roads and Parking Lots
To create roads and parking lots, follow these steps:

1. Drag guides onto the drawing page to mark reference points for the perimeter of the site, roads, and parking stalls.

2. Drag Curb and Driveway shapes onto the drawing page. To connect Curb and Driveway shapes, use the Line tool to draw lines between the shapes.

3. To add parking strips, stalls, and islands, drag shapes from the Parking and Roads stencil onto the drawing page. Glue their end points to guides on the page to simplify repositioning them.

4. To glue Parking and Road shapes, glue the end points or control points of Island and Driveway shapes to connection points on Parking Stall or other parking shapes.

5. If you drag individual Parking Stall shapes onto the page and glue them to a guide, you can reposition all the Parking Stall shapes at once by dragging the guide to which they are glued.

6. Drag shapes from the Vehicles, Site Accessories, and Planting stencils, to show vehicles, parking lot components, drains, outdoor furniture, and plants. Glue shape end points to guides.

Modifying Parking and Road Shapes
Parking and Road shapes include selection and control handles you can use to modify the configuration of the shape. Some shapes, such as the Parking Strip shape, are extendable shapes, and add additional parking stalls as you drag the selection handle at either end of the shape. Other shapes include control handles that modify the shape. For example, the control handle on the Radial Strip shape changes the number of stalls as you drag it, as shown in Figure 26-5.

Tip
To find out what a control handle does, position the pointer over the control handle until the screen tip appears.

Some shapes include custom properties that can modify the shape configuration. For example, the Parking Strip and Parking Stall shapes include a Stall Angle custom property. By default, parking stalls in the shape are oriented at seventy degrees. To create straight parking stalls, right-click a Parking Strip or Parking Stall shape on the drawing page and choose Properties from the shortcut menu. Type 90deg in the Stall Angle box and click OK. You can also type new values for the Stall Width and Stall Length properties to change the size of the parking stall. Shapes with curves, such as Curbs, include a Radius property that controls the radius of the curve on the shape.
Drag to change the number of stalls

Text block showing properties for the Parking Strip shape

Glue Island and Road shapes to Parking shapes

Figure 26-5: Drag control handles to change the number of parking stalls, and glue islands and road shapes to parking shapes.

Some Parking shapes include shortcut commands to reconfigure the shape. For example, with the Radial Strip shape, you can choose Stalls Inside or Stalls Outside from the shortcut menu to change whether the stalls face the inside radius or outside radius for the shape.

Drawing Directional Maps

Another type of Visio drawing that covers an even larger area than that of site plans is the directional map. With the Directional Map template, you can create road maps that show how to drive to your destination, or metro maps that help users navigate the transportation system in a city. These maps can include roads, transportation lines, and landmarks. In Visio, three-dimensional Directional Map shapes make it easy to render small geographic areas, such as villages or towns, with appealing and colorful three-dimensional shapes. By default, Visio creates maps without scale, but you can indicate an approximate scale by adding text to a Scale shape.

Note

The Directional Map templates are available in both Visio Standard and Visio Professional.
Creating Road and Metro Maps

To create a directional map, follow these steps:

1. Choose File ➪ New ➪ Map ➪ Directional Map.

2. To add roads to the map, drag a shape, such as Road Square, Curve 2, or Railroad from the Road Shapes stencil onto the drawing page. You can resize Road shapes by dragging their end points.

3. To specify the thickness of a Road shape, right-click the shape and choose Thin, Standard, Thick, or Custom from the shortcut menu. If you choose Custom, drag the control handle to specify the thickness you want.

   Tip

To change the direction of a Road shape, right-click the shape and choose one of the Rotate or Flip commands. You can also click Rotate or Flip buttons on the Action toolbar or use keyboard shortcuts such as Ctrl+L and Ctrl+R to rotate a shape ninety degrees to the left or right.

4. To simplify moving multiple road segments at once, glue Road shapes to guides and then drag the guides to reposition the shapes.

5. Drag 3-Way, 4-Way, Roundabout, and Interchange shapes onto the drawing page to represent intersections. Glue end points for Road shapes to connection points on the shapes that represent intersections.

6. Identify numbered roadways, such as interstates, by dragging shapes, such as Interstate and State Route, onto the page near the Roadshape you want to identify.

7. To draw metro or subway systems, use shapes on the Metro Shapes stencil. These shapes work similarly to Road shapes, but also include shapes to show stations and stops.

8. To indicate landmarks such as lakes, rivers, airports, malls, schools, and hospitals, drag the appropriate shapes onto the map. You can drag selection handles to resize Landmark shapes in one direction or proportionally.

9. To add transportation signs, such as one-way street signs or freeway exits, drag shapes from the Transportation Shapes stencil.

10. To indicate the location of recreational areas, drag shapes from the Recreation Shapes stencil.

Modifying Roads and Intersections

Visio Road shapes are quite simple, but you can combine straight, curved, and flexible Road shapes to adequately represent roads for a directional map. Road shapes include control handles and custom properties that you can use to change the width of the roadways or the length of intersection components. Use one or more of the following methods to modify the roads and intersections on your map:
✦ Road thickness — Make sure no shapes are selected and then right-click the drawing page and choose Shape ➤ Custom Properties. Type values in the Road Width and Metro Width fields to specify the thickness for Thin Road and Metro Line shapes. Standard and Thick Road and Metro Line shapes are multiples of these values.

✦ 3-way and 4-way intersections and interchanges — To change the thickness of intersection roadways, right-click the shape and choose the thickness you want from the shortcut menu. All arms of the shape change to the same thickness. To change the length of vertical or horizontal intersection arms, drag the selection handles on the sides or the top and bottom of the shape. To lengthen all the arms, drag one of the corner selection handles.

✦ Flexible roads or flexible metros — To change the thickness of intersection roadways, right-click the shape and choose the thickness you want from the shortcut menu. Use one or more of the following methods to modify a flexible shape:
  • Change a curve — Click the Pencil tool on the Drawing toolbar. Drag a vertex or selection handle to reposition the points or redefine the curves.
  • Add a vertex — Click the Pencil tool on the Drawing toolbar. Press Ctrl and click the shape where you want to add the vertex.

Using 3-D Map Shapes

Three-dimensional directional maps are perfect for producing illustrated maps or tourist guides. These maps aren’t to scale, but show buildings, roads, and landmarks in an isometric three-dimensional view. To create a three-dimensional map, you choose File ➤ New ➤ Map ➤ Directional Map 3D and then drag and drop shapes from the Directional Map Shapes 3D stencil onto the drawing page. You use standard Visio techniques to work with these shapes, including the following:

✦ Dragging selection handles to resize the shapes
✦ Using Ctrl-D to quickly duplicate shapes, such as road segments
✦ Using rotation handles to rotate shapes
✦ Grouping shapes so you can move them as one
✦ Adding text to shapes by selecting the shape and typing

Labeling and Numbering Plans

Building plans are like other types of drawings when it comes to annotation. You can use a variety of means to add textual detail to your drawings. For example, you can use text blocks, Callout shapes, and the text blocks within shapes themselves to show notes and comments. You can number shapes on the drawing in sequence
or display custom properties and other shape fields in shape text blocks. Because building plans are scaled drawings, you can also add Dimension shapes to show the distances represented on the plan.

To learn how to use the Number Shapes add-on to number shapes in sequence, see Chapter 4. For more information on annotating drawings, see Chapter 6. Chapter 32 describes how to include custom properties and fields in text blocks.

In addition to these techniques, the Label Shapes add-on was developed specifically for building plans, although you can use it to label shapes on other types of drawings as well. With the Label Shapes add-on, you can display up to four custom properties in labels on the shapes. You can also import data into the labels from other data sources.

To use the Label Shapes add-on, follow these steps:


2. To specify which shapes you want to label, select an entry in the Shape Type drop-down list. You can label all shapes on the page, all selected shapes on the page, or specify a shape name.

3. For each of the Label boxes, select the custom property that you want to appear in that label. The drop-down list contains all the custom properties associated with the shapes you’ve selected to label.

4. To import data from another data source into the labels, click Import Data, which initiates the Import Data Wizard. In the Import Data Wizard, you specify the data source and the data in it that you want to use, the property that uniquely identifies your shapes, and the column in the data source that matches the unique property. The Import Data Wizard then imports the data from the source into Custom Properties associated with the shapes.

5. Click OK to label the shapes.

You can use basic Visio annotation techniques to add notes to your directional maps. The Landmark Shapes stencil includes several Text Block shapes for adding text at different font sizes to the drawing page. You can use the Callout shape to add text and point it to an element on the map.

You can also use shapes on the Landmark Shapes stencil to indicate scale and direction for your map. Although maps are unscaled by default, you can drag the Scale shape onto the drawing page to indicate the approximate scale of the map. Select the Scale shape and type the total distance that the shape represents. To indicate direction, drag either the Direction or North shape onto the drawing page. Drag the rotation handles on either of these shapes so that north is pointing in the right direction.
Summary

Visio Professional includes templates for numerous types of architectural and engineering plans, as well as directional maps. You can create the basics for your scaled plans by adding shapes for walls, openings, and building core elements. By placing these shapes on a background page, you can use them as the foundation for other types of plans, such as building services. Most of the shapes for architectural and engineering plans include shortcut menu commands, control handles, and custom properties that you can use to modify a shape’s configuration. In addition, you can use custom properties to create component schedules and other types of reports.

Directional maps show larger areas than building or site plans. Although they are unscaled in Visio by default, they still represent real-world distances. You can drag and glue shapes together to depict roads, metros, and landmarks for road and city maps.

✦ ✦ ✦
Planning Space and Managing Facilities

Space plans provide value from the very beginning of building design to the ongoing management of facilities. Early on, space plans are essential tools for determining the optimal arrangement of building space to meet organizational needs. Then, when buildings are occupied, space plans help track the use of space by departments and the location of resources, and help manage the space and resources within facilities.

Visio Standard and Visio Professional both include Space and Room shapes on Building Plan stencils that simplify the initial layout of space on floors. You drag and drop the shapes onto the page, move them around, and resize them until you’re satisfied with the layout.

When it’s time to document who and what goes where in your facilities, only the Space Plan template in Visio Professional can help. This template helps you build a model of space, assets, and resources, whether you build it from scratch or import data to do so. In addition, whether you work with model elements in the Explorer windows or on the drawing page, Visio propagates your changes in the model and on the drawing.

Visio 2003 includes a new Space Plan Startup Wizard and additional enhancements to simplify what was once a painstaking process in previous versions of Visio.

Because space and facilities management plans require significant amounts of data, the Space Plan template also provides tools to emphasize data on space plan drawings. You can label or color-code space plan shapes with values from custom properties.

In This Chapter
Using Visio for space planning and facilities management
Exploring the Space Plan template
Using the Space Plan Startup Wizard to create space plans
Importing spaces
Using shapes to create space plans
Assigning people and assets to space plans
Using Visio space plans to manage facilities
Importing facilities data
Labeling space plans
Finding and moving resources
Generating facilities reports
This chapter begins by showing you how to create space plans using the Space Plan Startup Wizard, either by importing spaces using the Import Data Wizard or by adding shapes directly to drawings. You will then learn how to assign resources, such as people, furniture, and equipment to space plans. Finally, you will learn how to use these space plans to manage facilities.

Understanding Space Planning and Facilities Management Using Visio

Space planning typically involves laying out space within a building in a way that provides groups of people with the space they need and arranges space so business processes can operate efficiently. High-level space planning can begin as no more than hand-drawn ovals on a napkin, but eventually space planning requires laying out detailed spaces within a building shell.

You can perform both high-level and detailed space planning in both Visio Standard and Visio Professional. Depending on the stage of planning, you can use the following Visio features to produce space plans:

- **Conceptual planning** — Use the Ink tool or the Ellipse tool to draw rough outlines of space on a drawing page. Select the Ink or Ellipse shapes and type the name of the area. You can draw arrows between shapes to show spaces that should be located near each other.

- **Detailed conceptual planning** — When you have an existing floor plan for the building you’re planning or you know the amount of space each department needs, you can use Visio Space shapes to plan. Space shapes appear on the Walls, Doors, and Windows stencil and the Walls, Shell, and Structure stencil. Drag Space shapes onto the page and resize them until the value for the area that appears in the shape matches a department’s allocation. You can also drag Space shapes onto an existing Visio drawing or on top of an imported CAD drawing.

- **Detailed space planning** — When you’re planning space within a fully constructed building, you can drag Space shapes onto the page and resize them to meet a department allocation and fit within the Wall shapes that represent constructed walls. You can choose Auto-Fit from a Space shape’s shortcut menu to fit the space to existing shapes on the floor plan.

No matter which type of space planning you want to do, Boundary and Space shapes help you focus on abstract spaces. With custom properties associated with these shapes, you can keep track of the intended use for a space (such as office or conference room), the name of the space, the department using it, its occupancy, and more. You can enter these properties manually or by importing facilities data.
To help you size and lay out spaces properly, the Space and Boundary shapes automatically calculate and display the area they enclose. You can change the color and fill pattern of Space shapes to help in the space planning process. Later, you can convert Space shapes to Wall shapes and begin a detailed building plan.

Facilities management typically means relocating and tracking people, computers, equipment, and furniture to respond to reorganizations and office moves. For small facilities, management can be as simple as relocating Visio shapes on a drawing page. However, for larger facilities or more systematic tracking and management, Visio Professional offers tools to track space and assets accurately, and can use external data to show your facilities and automatically refresh plans with data changes. With Visio Professional space planning tools, you can perform the following tasks:

✦ Develop space plans that reflect the physical spaces you manage.
✦ Populate areas and offices with people and assets, such as equipment and furniture, by importing data from a spreadsheet or database.
✦ Allocate unassigned people and assets to spaces in the plan.
✦ Reassign people and assets by dragging shapes from one space to another in the Space Plan model or on drawing pages.
✦ Automatically update the space plan when data in the spreadsheet or database changes.

Accomplishing these objectives using the Visio Space Plan template requires a few steps. However, the new Visio Space Plan Startup Wizard has simplified these steps considerably. Before you can track and manage resources in a space plan, you must do the following:

✦ Prepare your facilities data in your external source.
✦ Import your facilities data into a space plan using the Space Plan Startup Wizard or the Import Data Wizard.
✦ Set up your space plan to refresh when the data in your external source changes.
✦ Make sure that all spaces are placed in your space plan using the Space Explorer window.
✦ Assign people and resources to the correct categories and spaces using the Space or Category Explorer window.
✦ Make sure that unassigned people and resources are assigned to spaces using the Space or Category Explorer window.

The Space Plan Startup Wizard is new in Visio Professional 2003.
Exploring the Space Plan Template

Available only in Visio Professional, the Space Plan template includes numerous tools to simplify both space planning and facilities management, including several features that are new or enhanced with this release. When you create a new drawing using the Space Plan template, Visio opens a letter-size drawing using landscape orientation and a scale of $\frac{\frac{3}{8}”}{1’0”}$. In addition, the template adds the Plan menu to the Visio menu bar and opens stencils associated with space planning and facilities management. Because space planning and facilities management are data-intensive processes, the Space Plan template uses both the new Space Plan Startup Wizard and an improved Import Data Wizard to set up space plans, import data, and manage the facilities represented by plans.

Menus and Stencils

The Plan menu that appears when you use the Space Plan template is beefier than its architectural and engineering plan counterpart. In addition to the Convert to Walls and Set Display Options commands, the Plan menu for the Space Plan template includes commands for importing and refreshing facilities data, assigning shapes to categories, opening the Space Explorer and Category Explorer windows, and labeling and coloring shapes based on custom property values.

When you use the Space Plan template to create a new space plan, Visio opens the Resources stencil, which includes Space and Boundary shapes for delineating departments, offices, and other areas in a building. The Resources stencil also includes shapes that represent resources, such as Person, Computer, and Asset for identifying the resources associated with spaces. You can create space facilities management reports quickly and easily by dragging Report shapes onto a drawing page.

Using the Space and Category Explorers

Because a Visio space plan is also a model of your facilities, you can use the Space and Category Explorers to easily view and modify the spaces and resources in your entire model, not just those on a drawing page. The Space Explorer displays a hierarchy of boundaries, shapes, and resources, where boundaries represent larger areas such as departments, shapes represent offices or rooms, and resources represent people, computers, or other assets associated with spaces. For example, you can associate people and equipment to offices, and offices to departments. In the Space Explorer, you can see which resources are located in which spaces, as shown in Figure 27-1, regardless of which drawing page shows them. The Category Explorer groups elements in the space plan by category, such as Person, Computer, or Space.
Using the Space Explorer and the Category Explorer, you can perform the following tasks:

✦ **Locate and select spaces and resources on a drawing page** — In an Explorer window, right-click a space or resource and choose Show from the shortcut menu. Visio displays the drawing page on which the corresponding Space or Resource shape is located and selects the shape on the page.

✦ **Easily move resources between drawing pages** — Instead of cutting a shape from one page and pasting it onto another, you can move resources by dragging the person or asset from one space to another in the Space Explorer. The corresponding shape moves on the drawing as well.

✦ **Enter resource information** — Right-click a resource in an Explorer window and choose Properties from the shortcut menu. In the Custom Properties dialog box, click a custom property field and type or select a value. The value you type in the Name custom property appears by default on the shape and in the Explorer windows.
Part V ✦ Using Visio for Architecture and Engineering

✦ **Rename resources** — Right-click a resource in an Explorer window and choose Rename from the shortcut menu.

✦ **Assign resources to spaces** — If resources haven’t been assigned to spaces, expand Unplaced Data in either Explorer window. Drag a resource from the Unplaced Data area to a Space shape on a drawing page.

✦ **Delete resources** — To delete a resource both in the model and on the drawing page, select a resource in an Explorer window and press Delete.

The drawing pages in your space plan might not include all Space and Resource shapes for your space plan. You can see spaces and resources that don’t exist on drawing pages within the Unplaced Data folder in either Explorer window.

When you open a new space plan, by default the Space and Category Explorer windows appear in one docked window, with tabs for each window. You can hide or show both of the Explorer windows by choosing Plan ➪ Explorer. You can also float each window individually by right-clicking its tab and choosing Float Window from the shortcut menu. If you want to float the entire window with both Explorer windows in it, drag the window title bar to a new location.

### Creating Space Plans

The amount of detail in space plans depends on their purpose. Space plans for prototyping the arrangement of departments and offices can be quite spare. Space plans used to manage the assets, personnel, and space in a facility are often loaded with detailed data and kept up to date with facility changes. Because of the tools that the Space Plan template provides, it’s a good idea to start a space plan by choosing File ➪ New ➪ Building Plan ➪ Space Plan to create your Visio drawing. After the file is open, the method you use to create your space plan depends on the purpose of your plan:

✦ **Preliminary layouts** — For prototyping, you don’t need detailed building outlines or floor plans. You can start by using drawing tools on the Drawing toolbar to sketch the outline of floors. Alternatively, you can just start dragging Space shapes onto the page.

✦ **Tracking plans** — When you plan to track resources on a space plan, you want accurate and detailed information. When you create a space plan with the Space Plan template, the Space Plan Startup Wizard opens, in which you can add a background floor plan and add Space shapes based on a list of room numbers and names. The shapes added by the wizard appear on the drawing page and in the Explorer windows. You still must add other spaces not in the original list, add resources, and associate them with spaces.
Using the Space Plan Startup Wizard

The Space Plan Startup Wizard doesn’t do everything for you, but it makes setting up a new space plan a little easier. You can specify a floor plan to use as a background for your space plan and select a data source with information about spaces in your plan.

Preparing Your Space Plan Data

Whether you want to import spaces or more detailed facilities data, you can import information from a variety of sources, including Excel spreadsheets, Microsoft Active Directory directory services, Microsoft Exchange, and any ODBC-compliant data source, such as a Microsoft Access database or a spreadsheet. To import data into your space plan properly, follow these guidelines to set up your data:

✦ Include a field or column in the data source that uniquely identifies the resources or assets you want to add to your space plan. A key field, such as employee number or asset tag number, is necessary if you want to automatically update the space plan when data in your data source changes.

✦ For resources and assets assigned to specific spaces, include a field in the data source for room numbers. Room numbers in the data source must match the room numbers for spaces in your space plan. Leave the room field blank if the resource or asset isn’t assigned to a space.

✦ Use the same room number for each asset or resource assigned to a space.

✦ For data sources that include data for more than one building, include a field that contains the building name or number and specify this field when you import the data.

✦ Include fields for other attributes you want to import, such as asset tag numbers, serial numbers, or maintenance dates. You can import this data into custom property fields associated with shapes.

Creating Space Plans Using the Wizard

To use the Space Plan Startup Wizard to create a space plan, follow these steps:


2. On the first page of the Space Plan Startup Wizard, select the type of image or drawing you want to use as a background for your space plan. You can use a graphics file, a Visio drawing, a CAD drawing, or no background. Click Next.

3. If you chose to use a graphics file or a drawing, navigate to the file you want and click Open.
4. On the next wizard page, select an option for the source of spaces you want to add to your space plan. You can use an existing spreadsheet, create a new spreadsheet, or type the room number manually. Click Next.

**Tip**
It’s best to create a spreadsheet of rooms before you start the wizard, so you don’t have to recreate your data in case something goes wrong during the wizard process.

5. If you use an existing spreadsheet, click Browse on the next wizard page and open the spreadsheet that contains your room data. If the workbook includes more than one worksheet or multiple columns, specify the worksheet and column that contain the room numbers. Click Next.

6. On the final wizard page, click Finish. Visio adds the spaces to the Category and Space Explorers. If Visio finds a shape on a drawing page with a matching room number, it lists the space under that drawing page in the Space Explorer hierarchy. Otherwise, it shows the spaces under the Unplaced heading.

7. For spaces that the wizard doesn’t place on a drawing page, drag an unplaced space from the Unplaced Data folder in the Space or Category Explorer window onto the drawing page, making sure not to overlap Space shapes. To resize a Space shape, drag one of its selection handles.

### Adding Spaces Using the Import Data Wizard

When you store data about spaces in a data source, you can add spaces to your space plan using the Import Data Wizard. With this approach, you can add spaces to your model and associate more information than a room number with those spaces.

1. Choose Plan ➪ Import Data.
3. On subsequent wizard pages, specify the source of the data and where the fields and values are stored.
4. When the wizard asks what kind of shape you want to add to your drawing, select the Space shape. Click Next.
5. Choose the field you want to use to label the spaces in the Explorer window. For example, use the room or space number. Click Next.
6. Specify the key field that uniquely identifies the space data, such as the room number. Click Next and then click Finish.

### Using Shapes to Create Space Plans

It’s easy to add broader boundaries and new spaces to your space plan model. If these new areas and spaces exist in your facilities data, you can use the Import
Data Wizard to update your plan. However, you can also add these elements by dragging shapes onto drawing pages. In the Resources stencil, the Boundary shape can depict larger areas such as departments or divisions. The Space shape acts as a container for the resources assigned to a specific space or office.

To ensure that spaces are assigned to boundaries, and resources are assigned to spaces, add Boundary shapes to your drawing page first, followed by Space shapes, and finally Resource shapes. If you don’t add these elements in this order, you can correct assignments by dragging spaces or resources to the proper boundary or space in an Explorer window.

**Manually Creating Spaces**

You can create Space shapes manually using either of the following methods:

- Drag Space shapes from the Resources stencil onto a drawing page. Visio adds a 100-square-foot square space by default. You can drag the shape’s selection handles to resize it, at which point Visio updates the square footage that appears within the shape when you select it, as shown in Figure 27-2.

![Figure 27-2: Space shapes automatically display the area that they enclose.](image-url)
When you drag a Space shape onto an existing floor plan with Wall or Room shapes, you can automatically adjust the shape to fit the area. Right-click the Space shape and choose Auto-Fit from the shortcut menu. Visio changes the outline of the Space shape to match the perimeter defined by the Wall shapes on the floor plan and displays the new enclosed area in the Space shape text block.

- Use drawing tools to outline spaces and then convert the drawing shapes to Space shapes by choosing Plan ➪ Assign Category. In the Assign Category dialog box, select Space in the Category drop-down list and click OK.

- Drag Boundary shapes onto the drawing page to designate larger areas, such as departments. You can place Space shapes within a Boundary shape to assign specific offices to a department. However, you can’t assign people or assets to boundaries. The Boundary shape displays the area it encloses, so you can use it to show the area of multiple Space shapes.

Caution To ensure that you are tracking the area of your space plan properly, do not overlap Space shapes. When Space shapes overlap, the Space shapes include calculated area, but the overall total of space area won’t match the area assigned within your building.

When you intend to import facilities data from a spreadsheet or database, spaces you add must include a value in their Name field, so you can match the space with a record in your data source. The value you specify must match a unique identifier in the spreadsheet or database. For example, if the office room number in the spreadsheet is 301, type 301 in the Space shape’s Name field. To do this, follow these steps:

1. If the Custom Properties window is not open, choose View ➪ Custom Properties Window.
2. Select the Space shape on the drawing page.
3. In the Custom Properties window, click the Name field and type the value that matches the identifier in the data source.

Tip You can also specify the intended purpose of a Boundary or Space shape by clicking the Space Use field in the Custom Properties window and typing the purpose for the Space shape or selecting one of the predefined purposes in the drop-down list.

Modifying Boundary and Space Outlines
Although the Space and Boundary shapes on the Resources stencil are 100-square-foot squares by default, you don’t have to stick to rectangular areas in your space plan. You can resize and reshape Boundary and Space shapes with basic Visio tools. No matter how you change the outline or size of these shapes, Visio displays the new total for the enclosed area within the shape. You can make the following modifications to Boundary and Space shapes:
Chapter 27  ✦ Planning Space and Managing Facilities

✦ Resize a Space or Boundary shape — Drag any selection handle on one of these shapes to resize it as you would any other type of shape.

✦ Reshape a Space or Boundary shape — To reshape a space or boundary, right-click it and then choose Edit from the shortcut menu, or click the Pencil tool on the Drawing toolbar, and then choose from the following methods:
  • Add a new vertex by Ctrl+clicking the outline of the shape.
  • Move a vertex by positioning the pointer directly over it. When the pointer changes to a four-headed arrow and the vertex turns magenta, drag the vertex to a new location.

To select more than one vertex to move, Shift+click each vertex and then drag to a new location.

✦ Auto-size a shape — If the Wall shapes that surround a Space shape change, you can fit the shape to the new wall configuration by right-clicking the Space shape and choosing Auto-Size from the shortcut menu.

Assigning Resources to Space Plans

To track and manage the people, equipment, furniture, and other assets that occupy your facilities, you assign them to categories and then to spaces in your space plan. When you use the Visio Space Plan template, these resources are grouped into six categories, each with its own set of predefined custom properties:

✦ Boundary — A location category that represents larger areas such as departments or functional uses
✦ Space — A location category that represents specific spaces such as offices or rooms and can contain other resources, such as people or assets
✦ Person — Represents the human resources assigned to spaces
✦ Computer — An asset category that represents computer equipment that you track
✦ Printer — An asset category that represents printers that you track
✦ Asset — A generic asset category for tracking any other kind of asset

By categorizing the resources in a space plan, you can standardize the data associated with resources, view the resources in your plan for each category, and produce facilities reports by category. The Space Explorer displays a hierarchy of your facilities that shows the boundaries in a space plan, with spaces underneath the boundaries to which they belong, and resources underneath the spaces to which they are assigned. The Category Explorer shows all the resources for each category in your space plan.
Placing Unassigned Resources

When you import resources into your space plan, the Import Data Wizard places resources within spaces when it can match a space identifier in the resource record with a space identifier in your space plan model. If a person or asset is not yet assigned to a space or the wizard can’t make a match, it places the people or assets in the Unplaced Data folder in the Space and Category Explorer windows.

To assign an unplaced resource in the Space Explorer window, click the plus sign to expand the Unplaced Data folder for the drawing page that contains the spaces to which you want to assign resources. Drag an unassigned person or asset from the Unplaced Data folder onto the icon that represents the space to which you want to assign it. Visio adds a shape for the person or asset to the Space shape on the drawing page as well. You can also drag an unassigned resource from the Unplaced Data folder onto a Space shape on the drawing page. In addition to adding the Resource shape to the drawing, Visio also moves the resource from the Unplaced Data folder to the icon that represents the space containing the resource.

You can’t rename the built-in categories or define your own.

It’s easy to add resources to space plans, because the Resources stencil includes a shape for each type of resource. You can create resources automatically assigned to a category by dragging these shapes onto a drawing page. In addition, the Import Data Wizard and Explorer windows use these masters to add shapes.

If you want to use shapes other than those on the Resources stencil, you can assign any shape to a category, as described in the section “Assigning Categories to Resources” later in this chapter. For example, you might want to use custom shapes to represent different types of computers, or assign different shapes for furniture to the Asset category.

Adding Resources to Space Plans

To track resources, they must be part of your space plan model. As with spaces, you can add resources to your model manually or by importing resource data. You can use either of the following methods to add resources to your model:

- **Add resources manually** — To add new resources to your space plan, drag one of the Resource shapes from the Resources stencil onto the appropriate Space shape on the drawing page. Visio adds the shape to the drawing page and assigns the resource to the space and to the appropriate category based on the shape you chose. In the Custom Properties window, type the name of the resource in the Name field.
✦ Import resources — Choose Plan ➪ Import Data and use the Import Data Wizard to create resources and Resource shapes, and to associate data with the custom properties for the Resource shape. For instructions on how to use the Import Data Wizard, see the section “Importing Facilities Data into Space Plans” later in this chapter.

Resource shapes on the Resources stencil include layer assignments, so shapes on the drawing page are assigned to a layer of the same name as its resource category, such as Space, Person, and Computer. You can hide or lock shapes on the drawing page by choosing View ➪ Layer Properties.

Assigning Categories to Resources

The shapes for resources on the Resources stencil are generic. You might have dozens of different pieces of furniture and equipment in an office, but by default, they’ll all use either an Asset, a Computer, or a Printer shape. If you want to use other shapes so the resources on your space plan drawing are more meaningful, you can assign categories to any Visio shape. For example, you can assign categories to the shapes from stencils, such as Office Equipment or Office Furniture. When these shapes are assigned to categories, you get the best of both worlds — not only do the shapes on the drawing page depict the resource they represent, but they also take on the custom properties for the category and appear in the appropriate category in the Category Explorer window.

To assign a category to a shape, follow these steps:

1. Select all the shapes on the drawing page that you want to assign to the same category.
2. Choose Plan ➪ Assign Category.
3. In the Category drop-down list, select the category to which you want to assign the shapes.
4. If the shapes you selected have custom properties associated with them, you can associate these properties with predefined space plan properties by following these steps:
   a. In the Assign Categories dialog box, click Properties. The Properties dialog box will appear.
   b. Under Properties, select the shape custom property you want to associate with a predefined property for the category.
   c. Under Category Properties, select the predefined category property, and then click Add to associate the two properties, as shown in Figure 27-3.
Custom properties on shapes

Correspondence between the two

Properties for category

Figure 27-3: You can associate shape custom properties with the properties for a Resource category.

5. Repeat steps 2 and 3 for each custom property that you want to associate with a predefined space plan property. Click OK when you’re done.

Note

Shape properties that you don’t assign to predefined space plan properties remain associated with shapes so you don’t lose any existing data.

6. Click OK to finish assigning the category to the selected shapes.

Using Visio Space Plans to Manage Facilities

You can use space plans to keep track of people, computers, equipment, and furniture as they relocate in response to reorganizations and office moves. Whether you add facilities data by hand or import it from external sources, you can display that data on your Visio space plan so you have a graphic map of the resources you manage. You can also produce facilities reports for executives or financial groups or to show departments the space and resources they have.

Importing Facilities Data into Space Plans

The Import Data Wizard makes it easy to import data into space plans. The wizard can handle data from Excel spreadsheets, Exchange Server Address Books, an Active Directory server, or tables in any ODBC-compliant database. The wizard can create new entities for the data it imports, either cascading shapes that represent the entities onto the drawing page or storing the entities as unplaced data in the Space and Category Explorer windows for later placement.
If you already have shapes on your drawing, the wizard can add the imported data to custom properties for those shapes or add the data as new shapes. For example, if you want to import data such as Space Use for Space shapes, you can import the data into custom properties in existing Space shapes on the drawing page. However, if you import data about people and assets, you can use the wizard to add Resource shapes to the Space shapes on your drawing. Even with these Resource shapes, the wizard associates other imported fields with custom properties on the Resource shapes.

Preparing Your Resource Data for Import

To produce the results you want when you import resource data, it’s a good idea to review your data. It’s also helpful to understand how the Import Data Wizard uses data to create and update shapes on space plans. The Import Data Wizard uses data in the following ways:

♦ **Assigning resources to spaces** — For each person or asset assigned to a space or room number in your data source, Visio places a Resource shape within the corresponding Space shape on the drawing page. You choose the type of Resource shape you want Visio to place for the imported data.

♦ **Assigning resources to spaces that don’t exist** — When a resource is assigned to a space number that doesn’t exist in the space plan, Visio places the resource in the Unplaced Data folder in the Explorer windows. You can create the spaces, if necessary, and manually place the resources in the appropriate spaces.

♦ **Assigning multiple resources to one space** — You can assign multiple resources to the same space by using the same space number in each resource record. For example, you can assign a person, several pieces of computer equipment, a printer, and several pieces of office furniture to the same room. Visio stacks the shapes for all these resources within the same Space shape. If you want to see all the shapes on the drawing page, drag each shape away from the shapes underneath while keeping them within the Space shape.

♦ **Refreshing data in shapes** — The Import Data Wizard uses unique identifiers in your source data when it refreshes the data associated with shapes on the drawing page. When you import data, the wizard matches the identifier in the source data with a value in a custom property for a shape. Before you import data, make sure that the field in your data source contains unique identifiers. For example, for spaces, the identifier might be the room number. For personnel, you might be able to use an employee name, but you can be assured of unique identifiers when you use an employee ID instead.

Using the Import Data Wizard

To import resource data and create new shapes within Space shapes on the drawing page, follow these steps:

1. If you want the wizard to automatically assign resources to spaces, make sure your spreadsheet or database includes a field for room or space numbers.
2. Make sure each Space shape in your drawing includes a room or space number in the Name field.

   Tip
   The easiest way to check for room numbers is to inspect the spaces in the Space Explorer window. If any space is named Space, you know that its Name property is blank.

3. Choose Plan ➪ Import Data. The first wizard page opens.

4. To create shapes as you import data, select the Into Shapes That Are Already on My Drawing option, and then, underneath that option, select the Add As New Shapes on Top of Existing Shapes option. Click Next.

5. In the wizard screen for the data source, select the type of data source that contains your facilities data. For an Excel spreadsheet, specify the path and filename for the file. Click Next.

6. In the next wizard screen, depending on which type of data source you chose, specify the location of the data you want to import in the data source. For example, for a spreadsheet, specify the worksheet. Click Next.

7. In the wizard screen for the shape to use, select the stencil that contains the shape you want, which is the Resources stencil by default. Then, click the shape you want in the window. Click Next.

8. On the next screen, you can specify a custom property for labeling or color-coding the new shapes. Click Next.

9. On the next screen, specify the field in your data source with unique identities, such as employee ID. Visio adds these values to a custom property associated with the new shapes and uses those values to update data when you use the Refresh Data command. Click Next.

10. On the next wizard screen, specify the shapes on which you want to place new shapes. When you're adding shapes for resources, choose the Space shape.

    Tip
    If you're using the Import Data Wizard to add spaces, you can choose the Boundary shape.

11. On the next wizard page, specify the custom property, which uniquely identifies the shapes already on the drawing, such as Name. Click Next.

12. On the next wizard page, specify the field in the data source that corresponds to the shape's custom property that you specified in step 11, such as room number. Click Next.

   Note
   The wizard places new shapes on existing shapes only when the values in the shape's property and the field in the data record match. For example, to place personnel within spaces, select the Name property for the Space shapes on the drawing, and a field, such as Room Number, in your data source.
13. On the final wizard page, click the Import Data Report link to view the results of importing your data. When you’re done reviewing the results, click Finish. Visio adds the new shapes to the Space shapes on the drawing page and adds any unassigned resources to the Unplaced Data folder.

Just as you can with other shapes, you can manually add or change data in Resource shapes by typing or selecting values in the Custom Properties window. However, changing the data in your drawing does not change the corresponding data in your spreadsheet or database. Visio does not export data from your drawing back to your source data.

Refresh Space Plan Data

When you import information into a space plan, you can create a connection between the data in the data source and the shapes on your space plan. After that connection is established, you can keep your space plan drawing current, reflecting any changes in your data source. For example, if employees move to other offices and the data source contains the new office numbers, you can update the drawing to show the employees in their new spaces. When assets are sold or recycled and deleted from the data source, Visio can remove them from the space plan as well. In addition, when the data source includes a new field such as maintenance data, the data for that field is added to the shapes on drawing when you refresh data.

To refresh the data in a space plan, follow these steps:

1. Make sure that the data source hasn’t been deleted or moved.
2. If you haven’t done so already, use the Import Data Wizard and specify the field in your spreadsheet or database that contains unique identifiers.
3. Choose Plan \&gt; Refresh Data. After the Refresh Data command processes the data, click the Import Data Report link to see a log of the changes the command made. Click OK.

Labeling Facilities Shapes

You can find spaces and resources more easily by adding labels to the shapes on your space plan. Labels are particularly helpful if you use the shapes from the Resources stencil, because they are so similar in appearance. The Plan menu in the Space Plan template includes the Label Shapes command, which runs the Label Shapes add-on. To label Space and Resource shapes, follow these steps:

1. Select the shape or shapes you want to label and then choose Plan \&gt; Label Shapes.
2. In the Label Shapes dialog box, make sure the Shape Type box is set to <all selected shapes>. If you want to choose other shapes, select the type of shape you want to label.
3. In the Label 1 box, select the custom property you want to use as the first line of the shape’s label, as shown in Figure 27-4.

![Image of Label Shapes dialog box]

Each line represents a label

**Figure 27-4:** You can add up to four labels to a shape with the Label Shapes command.

4. If you want to display additional properties as labels, select the properties you want for Label 2, Label 3, and Label 4.

5. Click OK.

---

**Controlling the Display of Spaces**

Space shapes on space plans include display options similar to those for Wall, Door, and Window shapes on floor plans. You can control the appearance of Space shapes for a drawing page by setting the display options on that page. Right-click any Space shape and choose Set Display Options from the shortcut menu. In the Set Display Options dialog box, on the Spaces tab, you can perform the following tasks:

- Specify the custom properties that appear in Labels 1 through 4 on Space shapes.
- Choose options to auto size Space shapes to Wall shapes or to wall reference lines.
- Choose the units to use for the area of the shape.
- Specify the precision of the total area calculation.
Color-Coding Space Plans

Color-coding makes it easy to spot shapes on your drawing. For example, you can color-code Space shapes by assigned departments so that you can easily identify which spaces belong to which departments. If you see the same color scattered throughout a building, you might consider an office move to co-locate all the people in that department.

You use the Color By Values add-on to color-code shapes. When you create your drawing using the Space Plan template, you can choose Plan ➤ Color By Values to color-code shapes.

To learn how to use the Color By Values add-on, see Chapter 7.

Finding and Moving Resources

The life of a facility manager is never boring with people quitting, new people being hired, and regular reorganizations thrown in for good measure. Naturally, as the location of people and assets constantly changes in a facility, so, therefore, will your space plan. You can move people or assets in the Explorer window or move the corresponding shape on the drawing page. In addition, when you manage a large number of resources, you can use tools in Visio to quickly locate the resource you want.

To find resources in a space plan, use one of the following methods:

✦ Using the Explorer windows — In the Space or Category window, expand a space or category, right-click the resource you want to locate and choose Show from the shortcut menu. Visio displays the drawing page that contains the corresponding shape, selects the shape on the drawing page, and centers it in the drawing window.

✦ Using the Find command — If there are so many resources that it’s hard to find the one you want even in the Explorer window, choose Edit ➤ Find. In the Find What box, type text that is associated with the shape you’re looking for, such as its name. You can use text that appears on a shape, in a custom property, or the shape name itself. Under Search In, click the locations you want to search and then click Find Next. The Find command finds the first shape containing the text you specified and highlights text within a shape or selects the shape if the text is found in a custom property, shape name, or cell.

To move resources in a space plan, use one of the following methods:

✦ Using the Explorer windows — In the Space Explorer window, expand pages and space until you find the resource you want to move. Drag the icon for the resource onto a different space icon.

✦ On the drawing page — Select the shape that represents the resource you want to move and drag it into a different Space shape on the drawing page.
Finding and Installing a Printer from a Space Plan

You can use Visio space plans to locate printers. In addition, if Smart Tags are turned on, you can install that printer on computers right from the Visio plan. To set up a space plan to do this, follow these steps:

1. To turn Smart Tags on, choose Tools: Options, select the View tab and make sure the Smart Tags check box is checked.
2. Drag a Printer shape from the Resources stencil onto the space plan.
3. Position the pointer over the Printer shape. When the Smart Tag appears, click Configure Printer on the Smart Tag.
4. Choose either Find a Printer in the Directory if you use an Active directory or Browse for Printer to find the printer on the network.
5. Select a printer, click OK, and then save the space plan drawing.

When others open the drawing, they can locate a printer that’s convenient. To set the printer as their default printer, they position the pointer over the Printer shape, click the Printer Smart Tag button and then choose Set As Default Printer from the shortcut menu. If they want to see the documents in the printer’s queue, they choose Open Print Queue from the shortcut menu.

Generating Facilities Reports

Similar to other management callings, facilities management has its fair share of reports. Visio Professional includes several predefined reports, such as Door and Window Schedules, that are useful to facilities management. In addition, the Space Plan template includes three specialized reports for space planning and facilities management:

- **Asset Report** — For each asset in a space plan, this report shows the asset type, its name, its manufacturer, and to whom it belongs. You can use this report as part of a facilities audit to ensure that resources are located where they should be or that the proper group has responsibility for the assets under their control.
- **Move Report** — This report shows where people are located.
- **Space Report** — This report shows the department, room number, space use, and area for each space in a plan.

The easiest way to create one of these facilities management reports is to drag a Report shape from the Resources stencil onto a drawing page. The shape uses the
current report definition and displays the results in a shape on a page. To display other information, just modify the report definition before adding the shape to the page.

To learn how to run or modify reports, see Chapter 23.

Summary

You can use Visio to plan space to varying levels of accuracy and then, after construction, manage facilities and the resources within them. For high-level space planning, you can use Ink or the Space shapes available in both Visio Standard and Visio Professional. As you become more precise about the location and areas you're planning, the Space Plan template provides specialized shapes and tools to help you. This chapter introduced you to the following features:

✦ **Space Plan Startup Wizard** — Gets a space plan started by setting up a background drawing or image and imports spaces into a plan

✦ **Import Data Wizard** — Imports space and resource data into new or existing shapes on a drawing

✦ **Refresh Data command** — Updates the data in a space plan from data in an external source

✦ **Space and Category Explorer windows** — Simplifies viewing, assigning, reorganizing, and selecting spaces or resources

✦ **Label Shapes and Color By Values** — Simplifies the display of facilities data by adding labels or color-coding based on values in custom properties

✦ ✦ ✦
Visio was never meant to be a substitute for a CAD program, such as AutoCAD. If you’re producing hard-core architectural or engineering drawings for large or complex projects, you’ll need every bit of functionality that the CAD application can provide — and even then, there are things you’ll wish it did, but doesn’t.

However, although Visio doesn’t replace CAD, it can complement it. By integrating Visio and CAD, you can do things that aren’t possible with either program alone. For example, if you’re designing part of a building and an architectural or engineering plan already exists, there’s no need to recreate that CAD drawing in Visio. You can insert CAD drawings as backgrounds in Visio and use them as a reference as you work with Visio shapes.

Visio also works well as a review tool. If you don’t have a CAD application or don’t know how to use the one you have, you can review CAD drawings by opening them in Visio. In addition, you can use Visio shapes and Ink to quickly mark up and add comments about CAD drawings to a separate layer.

If it turns out that you want to edit CAD drawings in Visio, you can convert their contents into Visio shapes. Although this solution has its faults, including slow redraw, it’s invaluable if you must edit a CAD drawing and no longer have access to the CAD program that created it.

Visio 2003 supports only .dwg and .dxr file formats. However, competitive CAD programs can produce these formats, so you can still integrate Visio with most commercial CAD packages. If you have a Microstation .dgn file that you want to insert, open it in Visio 2002 and convert it to Visio shapes. Then, open it in Visio 2003.
Understanding CAD and Visio Integration

Visio provides several methods for integrating CAD and Visio drawings, whether you want to bring CAD drawings into Visio, or vice versa. The following methods are available in both Visio Standard and Visio Professional:

✦ **Insert CAD drawings into Visio** — This method is typically the best approach for bringing a CAD drawing into Visio. Inserted drawings are OLE objects that offer the following benefits:
  
  • You can view, but not edit, inserted CAD drawings, so that you can use the CAD drawing as a reference without worrying about it being changed inadvertently.
  
  • You can snap Visio shapes to the geometry in an inserted CAD drawing just as you snap to other Visio shapes, rulers, grids, and guides in Visio.
  
  • You can crop CAD drawings to show details for part of a Visio drawing.
  
  • Inserted CAD drawings provide better visual results and faster opens and redraws.

✦ **Convert CAD drawings to Visio shapes** — If you must edit a CAD drawing and don't have access to the program that created it, you can convert the drawing into Visio shapes and continue your work in Visio. Keep in mind the following when using this approach:
  
  • CAD blocks and entities are mapped to the closest Visio shapes.
  
  • Converted CAD drawings don’t look as good as inserted CAD drawings; as with any conversion, accuracy and some details are lost.
  
  • File opens, redraws, and editing can be slow because of the number of shapes that the conversion process creates.

✦ **Convert CAD symbol libraries to Visio masters on a stencil** — You can take advantage of predefined CAD objects by converting libraries of CAD blocks into Visio shapes on a custom stencil. Then, drawing in Visio is as simple as dragging and dropping your new masters onto the drawing page.

  When you convert a CAD drawing to Visio, advanced features available only in the originating CAD program are discarded. If you subsequently reconver the Visio drawing back into CAD, you might lose additional information. For the best results, Microsoft recommends that you perform conversions in only one direction.

✦ **Export Visio drawings to CAD format** — If you sketch up a plan in Visio, you can export your Visio drawing to CAD format when it’s time to get serious about drawing. You can save Visio drawings as .dwg or .dxf files.

  You can export Visio drawings to CAD format for CAD users who want to review Visio drawings. However, an easier solution for reviewing is for the CAD users to download the Visio Viewer 2003 from [http://office.microsoft.com](http://office.microsoft.com).
If you’re familiar with CAD programs, Visio might leave you hungry for more. Conversely, as a Visio user, you might be frustrated by the complexity of most CAD programs. However, by understanding and appreciating their differences and similarities, you’ll know when to use which tool. Table 28-1 compares Visio and CAD features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Visio</th>
<th>CAD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coordinate Systems</td>
<td>Coordinates are based on the size and scale of the Visio drawing page. For example, for a drawing page using feet for measurement units and a scale of 1:12, one inch on paper equals one foot in real-world measurements. To specify drawing size and scale, choose File ➪ Page Setup and select the Page Size and Drawing Scale tabs.</td>
<td>CAD programs often include two types of coordinate systems. Model space represents the true size of the objects in the model. Paper space applies a scale to the model so you can print or plot the model on paper. You can create multiple paper spaces from the same model space.</td>
</tr>
<tr>
<td>Units</td>
<td>Measurement units are the units you choose on the Page Properties tab in the Page Setup dialog box. You can select from U.S. units, metric units, publishing units, and even time-based units.</td>
<td>Units represent the real-world units for the model coordinate system, but aren’t set to specific units such as feet or meters.</td>
</tr>
<tr>
<td>Scale</td>
<td>Drawing scale is the ratio of real-world measurements on the drawing page to the measurements on the printer paper. Every shape on a drawing page is drawn at the same scale. When you insert or convert a CAD drawing, Visio sets a custom drawing scale that fits the CAD drawing to the Visio drawing page.</td>
<td>In paper space, CAD creates views of your model in which each view can use a different scale. You can use one scale for an entire floor plan and another for a construction detail. Unlike Visio, you can compose a print or plot with multiple views, each using a different scale.</td>
</tr>
<tr>
<td>Layers</td>
<td>Visio layers separate shapes into categories, but don’t specify stacking order. You can specify attributes such as color, visibility, printability, and whether shapes are editable.</td>
<td>CAD layers also separate shapes into categories that you can use to control attributes. However, unlike Visio, CAD layers can also control the order in which CAD objects appear.</td>
</tr>
<tr>
<td>Objects</td>
<td>Shapes</td>
<td>Blocks</td>
</tr>
</tbody>
</table>
Displaying CAD Drawings in Visio

Visio is ideal as a viewing tool for CAD drawings. It’s easy to use and includes tools, such as markup and Ink, that even the most sophisticated CAD programs might not offer. For viewing CAD drawings, inserting them into Visio is the way to go. Your CAD drawings look better, Visio responds faster; and you can still control many aspects of inserted drawings. Using inserted CAD drawings, you can perform the following tasks:

✦ Use Visio to review CAD drawings produced by someone else, adding comments with Visio shapes, text, Ink, or markup on a separate Visio layer.
✦ Insert CAD drawings as backgrounds for Visio drawings. For example, if you want to use Visio to quickly prototype different office layouts, you can insert a CAD floor plan into your drawing as a reference and add Visio Furniture and Equipment shapes over it. As you work in Visio, you can snap to the geometry within the CAD drawing.
✦ Insert CAD drawings as details. For example, you can insert a CAD drawing that shows a highly detailed structural connection on a Visio drawing of an entire floor.

Inserting CAD Drawings into Visio

When inserting a CAD drawing from a .dwg or .dxf file into Visio, the Visio drawing assumes the last saved spatial view of the CAD drawing, either in model space or paper space. By using a CAD drawing saved in model space, you have more control over the CAD drawing after it’s inserted into Visio. For example, with CAD drawings saved in model space, you can change the CAD drawing’s scale in Visio. In addition, panning and resizing in Visio is faster when you use model space drawings. To insert a CAD drawing into a Visio drawing, follow these steps:

1. Open the Visio drawing file and the page that you want to contain the CAD drawing.
2. Choose Insert ➪ CAD Drawing. In the Insert AutoCAD Drawing dialog box, navigate to the .dwg or .dxf file you want to insert and click Open.
3. In the CAD Drawing Properties dialog box, Visio automatically chooses CAD drawing settings designed to produce the best results. For example, Visio sets the drawing scale to ensure that the CAD drawing fits on the current Visio drawing page. However, if you have specific requirements, choose the settings you want, as described in other sections of this chapter.
4. When you’ve specified the settings that you want, click OK.
Displaying CAD Layers in Visio

Although CAD drawings typically contain a number of layers, each inserted CAD drawing is assigned one Visio layer that is named CAD Drawing. However, within that inserted CAD drawing, you can specify which CAD layers are visible, along with the color and line weight for the objects on each layer. You can specify these settings when you insert the CAD drawing or at any time afterward by right-clicking the CAD drawing on the Visio drawing page and choosing CAD Drawing Object ➪ Properties from the shortcut menu. Select the Layer tab and then use one of the following methods:

- **Visibility** — To toggle the visibility of a layer, select the layer and then click the Visible field for the layer you want to toggle.

- **Color** — To specify the color of a layer, select the layer and then click Set Color. Click a color cell on the Standard tab or select the Custom tab and specify the color you want. Click OK.

- **Line Weight** — To specify the line weight for lines on a layer, select the layer and then click Set Line Weight. Type the line weight in points and then click OK.

Reviewing CAD Drawings in Visio

If you want only to view a CAD drawing and don’t plan to add Visio shapes or even markup on top of it, you don’t have to insert the CAD drawing into a Visio drawing. You can open the CAD drawing directly by following these steps:

1. Choose File ➪ Open.
2. In the Files of Type box, select AutoCAD Drawing (*.dwg, *.dxf).
3. Navigate to the folder that contains the file you want to open, select the file, and click Open. Visio creates a drawing page, inserts the CAD drawing onto the page, and sets the Visio measurement units and drawing scale to the units and scale of the CAD drawing.
4. To see when the CAD drawing was last updated, right-click the inserted CAD drawing and choose Shape ➪ Custom Properties from the shortcut menu. The Last Updated box shows the latest modification data, and the CAD File Name property shows the path and filename of the CAD drawing.
5. After you open the drawing, you can crop, resize, rescale, or reposition the drawing, as well as hide or show its layers and change layer colors, as described in other sections in this chapter.

Image files embedded in .dwg files don’t appear when you insert the CAD drawing into Visio. However, they will appear if you convert the drawing to Visio shapes. If you have no reason to convert the CAD drawing to Visio, you can embed the image files in the Visio drawing directly using the methods described in Chapter 8.
Working with External File References

When you insert or convert a CAD drawing that references external files, Visio tries to open any external linked files as well. Visio looks for external reference files in a folder with the same path as the one used when the file was originally linked or in the same folder as the Visio drawing. Before you insert a CAD drawing or when you receive a message that Visio can’t find the externally linked files, be sure to place any external files in the same folder as your Visio drawing or create a folder structure that mirrors the original used by the CAD drawing.

Modifying Inserted CAD Drawings

Although you can’t edit the CAD drawings you insert into Visio, you can modify them in several ways. If you plan to add Visio shapes over the top of an inserted CAD drawing, you can change its units and scale so that CAD objects and Visio shapes are sized in the same way. If you want to show specific portions of an inserted CAD drawing, you can crop, pan, move, or modify the visibility of layers in the CAD drawing. You can drop Visio shapes on top of the CAD drawing and even position Visio shapes by snapping to the geometry of the inserted drawing.

Note

If you want to edit or delete individual objects in an inserted CAD drawing, convert only the layers containing those objects to Visio shapes and then make the changes you want.

Modifying Units and Scale

To achieve the results you want, it’s important to coordinate the units and scale you use in both your inserted CAD drawings and the Visio drawings that hold them. If the CAD units and Visio measurement units don’t match when you insert a CAD drawing into a Visio drawing, you might see a blank rectangle or only a portion of the CAD drawing.

When you insert a CAD drawing into a Visio drawing, Visio sets the Visio drawing scale so that the CAD drawing fits on the Visio drawing page. For very large drawings inserted onto small Visio drawing pages, the result can be totally unreadable. In addition, when you drag Visio shapes on top of an inserted CAD drawing, your Visio shapes might appear too small or large, as illustrated in Figure 28-1. This occurs when the CAD drawing scale and the Visio drawing scale are set differently. Even when you match the drawing scales when you insert a CAD drawing, you can change the CAD drawing scale by dragging the border of the inserted drawing.
Cubicle drawn at scale of inserted CAD drawing

Figure 28-1: Visio shapes can appear too large or small when CAD and Visio drawing scales don’t match.

Coordinating CAD Units with Visio Measurement Units

CAD drawings don’t use pre-set drawing units. In the CAD world, a drawing unit can represent any unit—from a centimeter to an inch, or even a mile. When you insert a CAD drawing into a Visio drawing, Visio interprets CAD drawing units as Visio measurement units, which might be incorrect, especially if you insert a metric CAD drawing into a Visio drawing based on U.S. drawing units. To change the measurement unit for a CAD drawing, follow these steps:

1. To check the measurement units for the drawing page in which the CAD drawing is inserted, select the drawing page tab and then choose File ➪ Page Setup.

2. Select the Page Properties tab and check the value in the Measurement Units box. Click OK. If you prefer to change Visio units, change the value for Measurement Units here.

3. On the Visio drawing page, right-click the inserted CAD drawing and choose CAD Drawing Object ➪ Properties from the shortcut menu. On the General tab, select units to match the Visio measurement units in the CAD Drawing Units drop-down list. For example, if the Visio drawing uses feet and inches, select Feet in the CAD Drawing Units list. Click OK.

Modifying Drawing Scales

CAD drawings can represent very large areas, such as the architectural plans for a shopping mall. When you insert CAD drawings like this into Visio drawings, they
might appear at a very small scale to fit on the Visio drawing page. You can change the CAD drawing scale to match the Visio drawing scale. If you haven’t drawn any Visio shapes yet, you can even change the drawing page size and then change both the CAD and Visio scales to improve the readability of the plan. To change drawing scales, follow these steps:

1. If you want to change the Visio drawing scale, choose File ➪ Page Setup and select the Drawing Scale tab. For example, you can change the Visio drawing scale to match the custom scale that Visio used to fit the CAD drawing on the Visio drawing page.

2. To use a standard architectural or engineering scale, select the Pre-Defined Scale option, select the type of scale you want, and then select the scale you want to use. Click OK.

   **Note**
   
   If you want to use a custom scale, select the Custom Scale option and then enter a paper dimension in the first box and the real-world distance it represents in the second box.

3. To change the drawing scale for the inserted CAD drawing, right-click the inserted CAD drawing and choose CAD Drawing Object ➪ Properties from the shortcut menu.

4. Select the General tab, and select the scale using one of the following methods:

   - **Match CAD and Visio scale** — If you want the Visio shapes that you drop on top of a CAD drawing to match the scale of the CAD drawing, select the Pre-defined Scale option and then select Page Scale in the drop-down list. This sets the CAD drawing to the same scale as the Visio drawing scale.

   - **Use industry-standard scale** — If you are only reviewing an inserted drawing and won’t add Visio shapes on top of it, select the Pre-defined Scale option, select the type of scale you want to use, and then the specific scale.

   - **Define a custom scale** — Select the Custom Scale option and then enter a paper dimension in the first box and the real-world distance it represents in the second box.

5. Click Apply and then make sure that the CAD drawing still fits on the Visio drawing page by looking at the extent of the CAD drawing compared with the extent of the Visio drawing, as demonstrated in Figure 28-2. If the CAD drawing doesn’t fit, either change the Visio drawing size or specify a smaller CAD drawing scale. When the inserted drawing is scaled the way you want, click OK.

   **Note**
   
   You can’t change the scale of an inserted DWG drawing saved in paper space.
Chapter 28 ✦ Integrating CAD and Visio

Drawing scale for inserted CAD drawing

Preview of CAD drawing extent on Visio page based on current CAD drawing scale

Figure 28-2: Compare the CAD and Visio drawing extents in the preview pane.

Protecting Inserted CAD Drawings

By default, Visio protects CAD drawings you insert from deletion, resizing, and repositioning. When a CAD drawing is locked, you can’t inadvertently move it, reposition it, or delete it as you work on Visio shapes overlaid on top of it. However, when you do want to reposition the CAD drawing or change it in other ways, you can unlock the drawing from within the CAD Drawing Properties dialog box. To unlock an inserted CAD drawing, follow these steps:

1. Right-click the inserted CAD drawing and choose CAD Drawing Object ➤ Properties from the shortcut menu.

2. Select the General tab and uncheck the Lock Size and Position check box and the Lock Against Deletion check box.

3. Click OK.

Tip

Unlock an inserted CAD drawing only when you want to make a change. Then, after you’ve completed the change, lock the CAD drawing again.

In addition to the locking you can do with CAD Drawing Properties, you can also lock the Visio layer on which the CAD drawing is inserted. Although this technique mainly duplicates the efforts of CAD Drawing Properties locking, it also prevents the drawing from moving when you pan using the Crop tool.
Finding the Invisible CAD Drawing

Placing an object far from the main drawing is an all-too-common error in CAD. It’s easy to apply a CAD command incorrectly or specify the wrong dimension. When you don’t see the object where you expect it, you might just add it again. By doing this, you end up with one object where it’s supposed to be, but another out in space somewhere.

If you can’t see the contents of your CAD drawing in Visio, go back to the original CAD application and zoom to the drawing extents. If you see a tiny speck of color off in one corner, chances are good that the drawing has some wayward objects. Visio scales an inserted drawing to fit everything, including wayward objects, onto the Visio drawing page, resulting in a tiny drawing scale and an all but invisible CAD drawing. To correct this issue both in your CAD drawing and in Visio, open the drawing in the CAD program, locate and delete the objects that are misplaced, and resave the drawing.

Positioning and Resizing Inserted CAD Drawings

Visio provides several techniques for positioning and resizing CAD drawings inserted in a Visio drawing. The result you obtain depends on the tool you use, as described in Table 28-2. You can reposition or resize the entire CAD drawing. You can also crop the CAD drawing, reducing the CAD drawing border so that only a portion of the drawing appears. You can pan within a cropped border to display the portion of the CAD drawing that you want to see, as shown in Figure 28-3.

Figure 28-3: Crop a CAD drawing and pan to view the portion you want.
Before you attempt to reposition or resize an inserted CAD drawing, make sure that the drawing is unlocked. To confirm that it is unlocked in the CAD Drawing Properties dialog box, right-click the drawing, choose CAD Drawing Object ➪ Properties from the shortcut menu, and then uncheck the Lock Size and Position check box and the Lock Against Deletion check box. To confirm that the Visio layer into which the CAD drawing is inserted is also unlocked, choose View ➪ Layer Properties and make sure that the Lock field for the CAD Drawing layer is unchecked.

Tip

When you’ve completed repositioning and resizing, lock the drawing so that you don’t accidentally move or resize it as you continue your work.

### Table 28-2

#### Tools for Positioning and Resizing CAD Drawings

<table>
<thead>
<tr>
<th>Visio Tool</th>
<th>Positioning</th>
<th>Resizing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer Tool</td>
<td>Drag the inserted CAD drawing to move the entire drawing to a new location.</td>
<td>Drag a selection handle to change the size of the CAD drawing on the Visio drawing page. This also changes the CAD drawing scale.</td>
</tr>
<tr>
<td>Crop Tool</td>
<td>To pan the area of the CAD drawing that appears within the CAD drawing border, click the Crop tool on the Picture toolbar, click inside the CAD drawing border, and drag the Hand icon to a new location.</td>
<td>To crop the CAD drawing border so only a portion of the CAD drawing appears, right-click the CAD drawing, click the Crop tool on the Picture toolbar, and then drag a selection handle on the CAD drawing border until it’s the size you want. Click the Pointer tool to turn off the Crop tool.</td>
</tr>
<tr>
<td>Drawing Scale</td>
<td>Does not apply</td>
<td>You can change the size of a CAD drawing by specifying a different scale in the CAD Drawing Properties dialog box. This is more precise than dragging the inserted CAD drawing’s selection handles.</td>
</tr>
</tbody>
</table>

### Converting CAD Drawings to Visio Format

If you want to edit or delete CAD objects in an inserted CAD drawing, you can convert the inserted drawing into Visio shapes. For example, if you have a CAD drawing that you received from an architect and absolutely must make changes to it before a presentation Monday morning, you can convert the drawing to Visio shapes and use Visio tools to modify the contents the way you want.
If you do convert a drawing to make changes, don't convert the modified drawing back into the CAD format. This two-way conversion can reduce the quality of the drawing. Instead, ask the originator of the drawing to use the CAD program to make the same changes you did.

The Disadvantages of CAD Conversion

CAD and Visio formats differ significantly, and converting a CAD drawing into Visio format highlights those differences. CAD drawings can contain thousands, even hundreds of thousands, of objects, each of which belongs to a layer. When you convert a CAD drawing into Visio shapes, Visio converts those CAD objects into Visio shapes and assigns them to layers using the layer names contained in the source CAD drawing. Even with an improved .dwg converter, Visio 2003 isn’t able to recognize that all objects that represent the same item, such as an office chair, should convert into the same Visio shape. Therefore, a converted CAD drawing uses thousands of different shapes, each stored separately in the Visio drawing file. This glut of unique Visio shapes raises two issues with converted CAD drawings:

✦ Slow response time — Visio must sort through thousands of shapes and perform tremendous amounts of processing for the simplest actions, such as selecting all the shapes and repositioning them. Even relatively small converted drawings generate a noticeable delay in redraws or completion of commands.

✦ Large file size — When you use Visio masters, Visio stores the definition of the master only once and uses instances of the master to show shapes on the drawing page. When you convert CAD objects into unique shapes, Visio stores each shape definition separately, which greatly increases the Visio file size. For example, a .dwg file that consumes 850 kilobytes of space might require 10 megabytes of space after it’s converted into Visio shapes.

In Visio 2003, the .dwg converter can convert CAD objects into Visio shapes. Earlier Visio conversion tools converted CAD objects into separate shapes for each vector in the CAD objects.

When you convert a CAD drawing, you convert the last saved view of that drawing, which might have been saved in model space or paper space. Converting a drawing saved in model space converts all the objects and text on the layers you select into Visio shapes. However, when you convert a drawing saved in paper space, Visio converts only the objects wholly contained within the paper space viewport into Visio shapes, converting anything partially contained in the viewport into lines.

Converting CAD Drawings to Visio Format

You can convert CAD drawings into Visio shapes. Because of the quantity of data often contained in CAD drawings, the Visio conversion tool enables you to specify the CAD layers you want to convert. Even so, it’s a good idea to eliminate unused layers, blocks, linetypes, and other types of CAD objects from the CAD drawing before you begin conversion. To convert a CAD drawing into Visio shapes, follow these steps:
1. Make sure the CAD drawing is cleaned up and contains no extraneous elements.

2. Insert the CAD drawing into Visio as described in the section “Inserting CAD Drawings into Visio,” earlier in this chapter.

3. Right-click the CAD drawing and choose CAD Drawing Object ➪ Convert from the shortcut menu.

4. In the Convert CAD Object dialog box, click Unselect All to ensure that no layers are selected. This is a precautionary measure so that your converted drawing displays as fast as possible and is as small as possible.

5. Check only the check boxes for the layers you want to convert to Visio shapes.

6. To specify additional options for the conversion, click Advanced.

7. In the Convert CAD Object dialog box, shown in Figure 28-4, choose one of the following options to specify the action you want Visio to take with the original CAD layers:

Check only the layers you want to convert

Specify options for how to convert layers

**Figure 28-4:** You can specify the layers you want to convert and how to convert their contents.
8. In the Convert CAD Object dialog box, specify whether you want any dimensions on the CAD layers converted into Visio dimension shapes or lines and text.

9. In the Convert CAD Object dialog box, specify whether you want to convert hatch patterns into Visio lines or not.

10. Click OK to close the Convert CAD Object dialog box and then click OK to convert the CAD drawing into Visio shapes. Depending on the size and detail in your CAD drawing, this process can take some time. A progress bar shows you how much of the conversion process is complete.

11. After you’ve converted the layers you want, be sure to lock the remainder of the inserted CAD drawing, as described earlier in this chapter.

12. Save the Visio drawing.

When blocks in a CAD drawing overlap, the resulting Visio shapes in the converted drawing overlap as well, but they might not appear in the correct order. To correct the stacking order in which converted Visio shapes appear, choose Shape, and then choose either Bring to Front, Bring Forward, Send to Back, or Send Backward.

Converting Multiple CAD Drawings

If you want to convert several CAD drawings, you can use the Convert CAD Drawings add-on. However, this add-on converts each CAD drawing into a separate Visio drawing file and converts every layer in each CAD drawing. If you need more control over the conversion process, convert each drawing separately using the Convert command. To use the Convert CAD Drawings add-on, follow these steps:

1. Copy or move all the files you want to convert into one folder.
3. In the Convert CAD Drawings dialog box, navigate to the folder that contains the drawings you want to convert, select all the files you want to convert, and then click Open.
4. After Visio converts the CAD files into Visio drawing files, save each of the converted files by choosing File ➪ Save. Although Visio opens the Save As dialog box, the Save As Type option is set to Drawing (*.vsd) for a Visio drawing file. Type the name for the new file and click Save.

Creating Stencils from CAD Libraries

When you work in Visio, you don’t have to forego the symbols you store in symbol libraries with your CAD application. Symbol libraries are nothing more than .dwg files that contain blocks that act as library objects. You can convert the symbols in those .dwg files into Visio masters and store them on a stencil to drag and drop as you would any other Visio shape. When you convert a symbol library, each block becomes a Visio master and is named based on the name of the original block used to create it. Block attributes are converted into Visio custom properties and are stored with the master on the stencil. No matter how many symbol libraries you convert at once, Visio places the new masters on one new stencil. Block attributes become Visio custom properties stored in the master on the stencil.

To convert CAD libraries to a Visio stencil, follow these steps:

2. In the Convert CAD Library dialog box, select all the .dwg files for the libraries you want to convert and then click Open. The add-on converts each block in the selected .dwg files to a master and places them on a new stencil.
3. To save the stencil, right-click its title bar and then click Save As from the shortcut menu. In the Save As dialog box, type a name for the stencil and then click Save.

Converting Visio Drawings to CAD Format

In some circumstances, you might want to save a Visio drawing to CAD format. For example, suppose you’ve prototyped a plan in Visio and don’t want to redraw it in your CAD application. It’s easy to save Visio files as .dwg or .dxf files. You simply choose File ➪ Save As, select either AutoCAD Drawing (*.dwg) or AutoCAD Interchange (*.dxf) in the Save as Type drop-down list, and then click Save. However, you must save each page in a multipage Visio file separately. Metafiles, such as Ink objects, inserted in Visio files are not supported when you save a Visio file as an AutoCAD drawing.

The Save functionality in Visio 2003 has been enhanced to map Visio entities to the most representative entity in .dwg or .dxf file formats.
Visio drawings are saved as .dwg or .dxl files with fills and hatches turned off. You can turn fills and hatches back on in AutoCAD by setting the `FILLMODE` system variable to 1 and then using the `REGEN` command to regenerate the drawing.

When you save Visio files as CAD drawings or convert CAD drawings, Visio records any mapping errors and warnings that occur during file conversion to a common log file, located by default in `D:\Documents and Settings\<username>\Local Settings\Application Data\Microsoft\Visio\Temp`, but continues the conversion.

**Summary**

You can integrate CAD drawings and Visio drawings in several ways. When you don’t need to edit CAD drawings, you can insert CAD drawings as OLE objects into Visio drawings, move and resize them, and modify settings such as scale and visibility. If you do want to edit the CAD drawings in Visio, you can convert them along with CAD symbol libraries to Visio drawings and stencils. You can also convert Visio drawings to CAD format using Save As, and one of the AutoCAD file formats.
Working with Engineering Drawings

Although engineering drawings can be complex, building them doesn’t have to be. The templates that Visio provides for engineering disciplines include many of the shapes and symbols you need to prepare mechanical, electrical, and process engineering drawings, diagrams, and schematics.

What’s more, you can use basic Visio techniques, such as drag and drop, shape text blocks, snap and glue, and custom properties, to construct and fine-tune your engineering drawings. You can drag shapes from Electrical Engineering, Mechanical Engineering, and Process Engineering stencils onto a drawing page, using basic Visio tools to position shapes to the precise tolerances required in parts and assembly diagrams. You can use connectors and glue to define the relationships conveyed in process flow diagrams. Engineering stencils include hundreds of configurable shapes that make it easy to produce the documents you want.

In addition, the Process Engineering template includes tools that help you build a process engineering model. You can create components to track the elements of your model and view your model on a Visio drawing or in outline form.

This chapter shows you how to create mechanical engineering drawings and electrical engineering diagrams and schematics. It also describes how to build process engineering models and create process engineering diagrams. In addition, you will learn how to use components to add data to the shapes on your engineering drawings, tag and number components, and generate component lists and bills of materials.
Exploring Visio’s Engineering Templates

Visio provides templates for mechanical, electrical, and process engineering drawings and schematics. The Mechanical Engineering and Electrical Engineering templates include stencils of shapes that make it easy to assemble drawings. In addition to SmartShapes, the Process Engineering templates include tools to build a model and manage components. Each engineering discipline has its own category for templates. You can choose from the following categories and templates when you select File ➪ New or use the Choose Drawing Type pane:

✦ Mechanical Engineering
  - Fluid Power — Document designs for hydraulic or pneumatic controls, assemblies, and systems, such as assembly-line machinery or robotic equipment.
  - Part and Assembly Drawing — Design or produce specifications for mechanical parts or devices, or to show how to assemble equipment.

✦ Electrical Engineering
  - Basic Electrical — Produce wiring diagrams, electrical schematics, or one-line diagrams.
  - Circuits and Logic — Document integrated circuit designs, printed circuit boards, or digital or analog transmission paths.
  - Industrial Control Systems — Design industrial control systems, assembly lines, and power systems.
  - Systems — Represent components and relationships between electrical devices, particularly for large-scale systems such as utility infrastructure.

✦ Process Engineering
  - Piping and Instrumentation Diagram — Design and document industrial process equipment and pipelines.

If you want to see an example of a diagram to help you decide which template is most appropriate, choose Help ➪ Diagram Gallery and then browse the templates in the engineering categories. Some templates provide more detailed examples. If Visio displays an orange border around the image of the diagram when you position the pointer over it, click the image to open a window containing a more detailed example.
Using Basic Visio Techniques in Engineering Drawings

In many cases, you can produce complex engineering drawings simply by employing basic Visio tools. You can use the following Visio tools to build a large portion of the contents of your engineering drawings:

- **Drag and drop** — Drag shapes from Engineering stencils onto drawing pages.

- **Connectors and the Connector tool** — Drag connectors onto a page and glue the ends to Engineering shapes. You can also use the Connector tool to draw the connector you want between shapes.

  Refer to Chapter 5 for detailed instructions on using connectors and connection points.

- **Drawing precision** — Use snap and glue settings, shape extension lines, and the Size & Position window to draw and position shapes to the tolerances you want.

  Refer to Chapter 4 for more information about positioning shapes precisely.

- **Shape operations** — Use Visio drawing tools and Shape Operation commands to draw unique parts.

- **Custom properties and custom property sets** — Associate custom properties to shapes and add data to custom properties to configure shapes or include real-world information about the components that the shapes represent.

  To learn how to use drawing tools, Shape Operation commands, custom properties, and custom property sets, see Chapter 32.

- **Text features** — Label shapes by editing shape text blocks or adding callouts and other annotation shapes.

  Refer to Chapter 6 for more information about using text and annotation tools.

- **Background pages** — Include title blocks on background pages to identify the contents of engineering drawings.

  Refer to Chapter 2 for more information on background pages.
Working with Mechanical Engineering Drawings

You can use the Parts and Assembly Drawing template to create detailed specifications of parts or to show how pieces of equipment fit together in an assembly. The Fluid Power template helps you document hydraulic or pneumatic power systems, flow control, and fluid power schematics and assemblies. These templates don’t include specialized menus or toolbars, but they open several stencils with specialized shapes. Many of the Mechanical Engineering shapes include control handles or shortcut commands you can use to specify different shapes and sizes.

Drawing Parts and Assemblies

To manufacture mechanical parts, you need drawings that specify every dimension, edge, plane, and curve for a part. To assemble separate parts into a functional whole, you need instructions that show how the parts fit together. The Visio Parts and Assembly Drawing template includes masters that help you construct the geometric shapes found frequently on part and assembly drawings.

To create a part and assembly drawing, choose File ➪ New ➪ Mechanical Engineering ➪ Part and Assembly Drawing. If you use the US Units template, Visio creates a new ANSI B-size (17 inches by 11 inches) drawing in landscape orientation using a mechanical engineering one-quarter scale (shapes appear on the page at one fourth of their actual size). In addition, the following stencils open:

✦ Stencils in the Mechanical Engineering stencil category:
  • Fasteners 1 — Nuts and bolts
  • Fasteners 2 — Rivets and washers
  • Geometric Dimensioning and Tolerances — Symbols used to show dimensioning origins and tolerances
  • Springs and Bearings — Shapes for springs and different types of bearing conditions
  • Welding Symbols — Standard shapes that indicate different types of welds

✦ Stencils in the Visio Extras stencil category:
  • Annotations — Annotation shapes for callouts, text blocks, north arrows, reference and section indicators, and drawing scale symbols
  • Drawing Tool Shapes — Geometric shapes often used for parts and assemblies, including circle tangents, perpendicular lines, triangles, and rounded rectangles. These shapes might save you the trouble of using Shape Operations to create some geometries.
  • Dimensioning-Engineering — Dimensioning shapes for linear and radial dimensions drawn using standard mechanical engineering dimension styles
  • Title Blocks — Frames, tables, title blocks, and revision blocks
Using Geometric Shortcuts

The Drawing Tool Shapes stencil provides shapes that help you create geometric constructions more easily than you can with Visio drawing tools or Shape Operation commands. Drawing tools provide one way to construct rectangles and ellipses. The Drawing Tool Shapes stencil includes shapes that enable you to define geometry in other ways. For example, you can use shapes to create circles by specifying the circle diameter, the circle radius, and one point on the circumference, or by using three points on the circumference. In addition to handles that you can drag, some shapes have shortcut menus with commands that you can use to display other constructions. For example, the Sector-graphical shape shortcut menu includes the Show Complementary Sector command, which changes a pie slice to the rest of the pie.

You can use the following special geometric constructions or explore other shapes on the Drawing Tool Shapes stencil:

✦ Measure shapes — The icons for these masters look like measuring tapes. Drag a shape, such as Measure Tool, Horizontal Measure, or Vertical Measure, onto a page and glue it to the shape from which you want to measure. As you drag the green selection handle around, the text block shows the distance from the glued point in the set measurement units.

✦ Circle Tangents and Arc Tangents — Use these shapes to draw belt systems. The control handles on the Arc Tangent shape adjust the radius at the corresponding end of the shape. The yellow control handle on the Circle Tangent shape enables you to change the length of the tangent line and keep the line tangent to the circle.

Note

You can use Arc Tangent shapes to create linkages for belt systems. For example, to connect one mechanical cam to another, add an Arc Tangents shape to the drawing page to represent the first cam, then drag another Arc Tangents shape onto the page and glue one of its connection points to the Arc Tangents shape.

✦ Rounded Rectangle — Use this shape to quickly draw process storage tanks. Change the roundness of the corners by dragging the control handle.

Note

The Equipment–Vessels stencil in the Process Engineering Piping and Instrumentation Diagram template includes several tank shapes.

✦ Sector-graphical and Arc-graphical — The Sector-graphical shape is a pie slice with selection handles for changing the radius, origin, and rotation of the slice, and a control handle that modifies the angle circumscribed by the slice. The Arc-graphical shape is an arc shape that works the same way as the Sector-graphical shape.

✦ Sector-numeric and Arc-numeric — The selection handles and control handles determine the radius and origin for the sector or arc. Type a number while the shape is selected to change the angle circumscribed by the slice or arc.
✦ **Triangle shapes** — Use these shapes to construct triangles in different ways. You can adjust the angles in the Right Triangle: Angle, Hypotenuse shape by typing the angle you want while the shape is selected.

✦ **Multigon shapes** — Drag one of these shapes onto the drawing page, right-click the shape, and then choose the polygon you want from the shortcut menu.

### Creating Springs, Bearings, and Fasteners

Springs, bearings, and fasteners come in many standard shapes and sizes — too many to include one of each on the Mechanical Engineering stencils. Many of these shapes include custom properties that control shape dimensions. When you modify the value in a custom property, the size of the shape adjusts accordingly. You can specify one dimension and let Visio adjust the other dimensions based on industry standards or you can specify all dimensions. Although these shapes are locked so you can’t resize them inadvertently, you can unlock and display the shape handles so you can use them to resize the shapes. The following list includes some of the commands that appear on shape shortcut menus, depending on which shape you right-click:

✦ **Set Standard Sizes** — Modify the thread diameter in the Custom Properties dialog box. Visio adjusts the other dimensions for the shape to industry-standard lengths.

✦ **Set Dimensions** — Modify one or more of the dimensions in the Custom Properties dialog box to configure the shape the way you want.

✦ **Resize with Handles** — Display the selection handles on a shape so you can resize it by dragging.

✦ **Hatched** — Display cross-hatching on the shape. Choosing Unhatched from the shortcut menu removes the cross-hatching.

✦ **Simplified** — Show a simplified version of the shape with some lines removed. When the simplified version appears, the command on the shortcut menu changes to Detailed.

✦ **Alternate Symbol** — Alter the appearance of the shape slightly, such as changing an X to a plus within a shape.

### Creating Welding Symbols

You can use the symbols on the Welding Symbols stencil to show the locations and types of welds on a drawing. To add a weld to a drawing, follow these steps:

1. Drag one of the Arrow shapes onto the drawing page and position it so that the leader on the arrow points to the weld joint.

2. To specify additional weld information, right-click the arrow shape and choose Show All Around Circle and/or Show Tail from the shortcut menu.
3. To add symbols to specify the type of weld, follow these steps:

   a. Double-click the Arrow shape on the drawing page to open the group window.

   Tip

   If you can’t see the Shapes window while the group window is open, choose Window ➪ Tile to display all the windows side by side.

   b. Drag symbols that represent different types of welds, such as V-groove, onto the Arrow shape in the group window.

   c. To annotate the weld, drag Annotation shapes into the group window and edit the text. You can glue Welding Symbol shapes and Annotation shapes to the guides in the group window to keep symbols positioned correctly when you resize the Arrow shape.

4. To return to the drawing page, click the Close button in the group window.

Annotation Dimensions and Tolerances

Part and assembly drawings usually include numerous dimensions. You can add dimensions and datum points using shapes from the Dimensioning-Engineering stencil and Geometric Dimensioning and Tolerancing stencil.

Dimension shapes include control handles you can drag to define the distance to measure as well as the location of the dimension lines, as illustrated in Figure 29-1. The control handles that appear depend on the dimension shape you choose. As an example, you can add dimensions from a vertical baseline by following these steps:

1. Drag the Vertical Baseline shape onto the page near the bottom of the part you want to dimension. Drag the green end points to both position the ends of the horizontal reference lines and define the distance for the first dimension.

2. To position the text and vertical dimension lines for the first dimension, drag the yellow control handle on the first dimension line.

3. Drag the yellow control handle both equidistant from the base reference line and the first horizontal reference line and between the green selection handles up and to the left to define another vertical dimension line.

4. After you have added the dimensions you want, you can drag the control handles at the top of each dimension up or down to change the height of the dimension. When you drag these yellow control handles to the left or right, Visio repositions the horizontal reference line.

5. To change the spacing between the vertical dimension lines, drag the yellow control handle at the bottom of the Vertical Baseline shape.
You can also add datum points and datum frames to specify origins and geometric characteristics. Datum points delineate positions that you can use to align shapes on different pages or drawings. To add these symbols, use one of the following methods:

- **Datum shapes** — Drag a Datum shape, such as Datum Symbol or Datum (New), from the Geometric Dimensioning and Tolerancing stencil onto the drawing page and, while the shape is selected, type the text you want in the symbol. Press Esc to complete your text entry.

- **Datum Frame** — Drag a Datum Frame shape, such as 1 Datum Frame or 2 Datum Frame, onto the drawing page, and then double-click it to open the group window. To denote geometric characteristics, drag shapes, such as Cylindricity, into the box on the left end of the Datum Frame shape. To add text to the other boxes in the shape, double-click the box and type the text you want. When you have finished editing the Datum Frame shape, click the Close button for the group window to return to the drawing window.

**Constructing Fluid Power Diagrams**

To document pipes and equipment for fluid power diagrams, you can use the Visio Fluid Power template. To create a fluid power drawing, choose File ➪ New ➪
Mechanical Engineering ➪ Fluid Power. Visio creates a new letter-size drawing in landscape orientation with no scale and opens the following stencils:

✦ The following stencils are in the Mechanical Engineering stencil category and open automatically when you use the Fluid Power template:

• **Fluid Power-Equipment** — Pumps, compressors, gauges, meters, and other types of equipment

• **Fluid Power-Valve Assembly** — Shapes that represent valves and other types of equipment

• **Fluid Power-Valves** — Different types of valves

✦ The following stencils are in the Visio Extras stencil category:

• **Annotations** — Annotation shapes for callouts, text blocks, north arrows, reference and section indicators, and scale symbols

• **Connectors** — Different types of generic connectors

Putting together fluid power diagrams requires nothing more than basic Visio techniques. Use the following steps to construct a fluid power diagram:

1. Drag shapes from Fluid Power stencils onto the drawing page.

2. To change the configuration or version of a shape, right-click the shape and choose a command from the shortcut menu. For example, you can configure the Pump/motor (Simple) shape to be hydraulic or pneumatic, bi-directional or uni-directional, variable, or compensated. You can also configure the Pump/motor (Simple) shape to represent a pump, a motor, or a combination of the two.

   **Note**

   Most but not all shapes on Fluid Power stencils include configuration commands on their shortcut menus.

3. Add text to shapes by selecting a shape and typing the text you want. After you add text, most shapes include a control handle you can drag to reposition the text if it overlaps graphics on the drawing.

4. To connect equipment on the drawing, use the Connector tool to draw connectors between connection points, by following these steps:

   a. Click the Connector tool on the Standard toolbar.

   b. On the Connectors stencil, click, but don’t drag, the connector master that you want to use.

   c. On the drawing page, drag with the Connector tool from a connection point on one Fluid Power-Equipment shape to a connection point on another. Visio draws a connection between the shapes using the connector master you chose. The end points of the connector turn red when it is glued to the shape connection points.
Some shapes on Fluid Power stencils include control handles that you can use to connect them to other shapes. To find out what a control handle does, position the pointer over the control handle to see a screen tip.

**Working with Electrical Engineering Drawings**

The Electrical Engineering templates include stencils with shapes you can drag and connect to assemble electrical engineering drawings and schematics. You can create the following types of electrical engineering diagrams:

- **Basic electrical diagrams** — Produce wiring diagrams, electrical schematics, or one-line diagrams.
- **Circuits and logic diagrams** — Document integrated circuit designs, printed circuit boards, or digital or analog transmission paths.
- **Industrial control systems diagrams** — Design industrial control systems, assembly lines, power systems.
- **Systems** — Represent components and relationships between electrical devices, particularly for large-scale systems such as utility infrastructure.

Visio 2003 includes enhancements to some Electrical Engineering shapes so that they connect more cleanly than in Visio 2002.

To create an electrical engineering drawing, choose File ➪ New ➪ Electrical Engineering and then choose the template for the type of drawing you want. Visio creates a new letter-size drawing in portrait orientation and no scale. You can use basic Visio techniques to add shapes to the page and connect them. As with mechanical engineering drawings, the Connector tool is the best way to connect specific points on your Electrical Engineering shapes.

Use the following basic steps to construct an electrical engineering drawing:

1. Drag shapes onto the drawing page.
2. To change the configuration or version of a shape, right-click the shape and choose a command from the shortcut menu. For example, when you use the Indicator shape on the Fundamental Items stencil, you can choose Configure Indicator from the shortcut menu to choose from 16 different types of indicators.
3. Add text to shapes by selecting a shape and typing the text you want. After you add text, most shapes include a control handle you can drag to reposition the text if it overlaps graphics on the drawing.
4. To connect the equipment on the drawing, use the Connector tool to draw connectors between connection points, by following these steps:

   a. Click the Connector tool on the Standard toolbar.

   b. On a stencil that contains connectors, click, but don’t drag, the connector master that you want to use. For example, you can click the Transmission Path connector on the Transmission Paths stencil to connect two shapes that represent devices.

   c. On the drawing page, drag with the Connector tool from a connection point on one Fluid Power-Equipment shape to a connection point on another. Visio draws a connection between the shapes using the connector master you chose. The end points of the connector turn red when it is glued to the shape connection points.

**Caution**

Because Electrical Engineering shapes include connection points that are not interchangeable, such as the positive or negative terminals on a battery, you usually want to glue to specific connection points, rather than use shape-to-shape glue. When you glue connectors to Electrical Engineering shapes, make sure that Visio highlights only the connection points in red, not the entire shape.

### Building Process Engineering Models

With the Visio Process Engineering template, it’s easy to draw piping and instrumentation diagrams (P&IDs) and process flow diagrams (PFDs). You can drag shapes from Process Engineering Equipment stencils onto your drawing page, connect them with Pipeline shapes, and then add shapes to represent components, such as valves. Process engineering models use components, which represent physical objects, such as pipelines or pieces of equipment. In addition to the graphical view of your process engineering diagram, you can use the Component Explorer and Connectivity Explorer windows to view components and connections hierarchically.

You can add information to components through their custom properties and use those properties to produce reports or equipment lists. In addition, tags identify and track the components on your drawings. By default, Visio adds tags to components when you drag them onto the drawing page. Tags appear in component text blocks by default, but you can choose whether to hide or show them to improve the readability of a drawing. Visio provides predefined tag formats, but you can also create your own. If you construct different views that contain the same component, such as an overall plan and a detail, you can assign the same tag to multiple shapes, so you can accurately track components.

**New Feature**

In Visio 2002, custom property sets were available only through the Custom Property Manager in the Process Engineering template. In Visio 2003, custom property sets are available in all templates.
Using Process Engineering Views

In addition to viewing diagrams, you can use the Component Explorer and Connectivity Explorer windows to see an outline of the components and connections in your process engineering model. You can also easily view data associated with components as you work by opening the Custom Properties window. The Processing Engineering templates provide the following windows for viewing and working on your process engineering models and drawings:

✧ **Drawing window** — Shows the equipment and how it is connected. You can create process engineering diagrams across multiple pages or create detailed views of portions of a model. When you select a shape in the drawing window, Visio highlights the corresponding component in the Component Explorer window.

✧ **Component Explorer window** — Presents a hierarchical view of components in a model, grouped by category, such as Equipment, Pipelines, Valve, or Instrument. In the Component Explorer window, the component tag numbers appear in the outline. For each component, you can expand the outline to see the shapes that belong to it.

✧ **Connectivity Explorer window** — Shows a hierarchical view of the pipelines that connect components in your model. Pipelines appear at the top level of the hierarchy, identified by their tag numbers. For each pipeline, the components connected to the pipeline are listed by tag number.

✧ **Custom Properties window** — Whether you select a shape in one of the Explorer windows or on the drawing page, you can view the custom property values for the shape in the Custom Properties window. Process Engineering shapes come with several properties predefined. For example, Pipeline shapes include properties for line size, material, design pressure, design temperature, and more.

You can open and close Explorer windows or switch between Explorers, depending on what you want to see. To open an Explorer window, choose Process Engineering ➪ Component Explorer or Process Engineering ➪ Connectivity Explorer.

When both Explorer windows are open, you can switch between Explorers by selecting the Components or Connectivity tab at the bottom of the window.

The outline format of the Explorer windows provides an easy and familiar way to see your entire model even if it spans several drawing pages. You can also use the Expand and Collapse icons to filter the components you see, as shown in Figure 29-2. In the Explorer windows, you can create new components, rearrange them in the outline, and rename them. If you are trying to find a component on a complex drawing, you can quickly zoom into the shape that represents the component using the Select Shapes command. Choose from the methods in Table 29-1 to work with components within the Explorer windows.
Figure 29-2: You can manage components and connections in the Explorer windows.

Table 29-1

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Explorer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand or collapse hierarchy levels</td>
<td>Click the plus icon to expand the outline to show the next lower level in the hierarchy. Click the minus icon to hide the lower level.</td>
<td>Both</td>
</tr>
<tr>
<td>Select components</td>
<td>Double-click a component or right-click a component and then choose Select Shapes from the shortcut menu. Visio zooms in and centers the shape that represents the selected component on the drawing.</td>
<td>Both</td>
</tr>
<tr>
<td>Create components</td>
<td>Create a new component by right-clicking the category to which you want to add a component and then choose New Component from the shortcut menu.</td>
<td>Component Explorer only</td>
</tr>
<tr>
<td>Rename components</td>
<td>Right-click a component in an Explorer window and choose Rename from the shortcut menu. Type the new name and press Esc when you’re done. Visio renames the component in the Explorer windows and the drawing.</td>
<td>Both</td>
</tr>
</tbody>
</table>

Continued
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Explorer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associate shapes with other components</td>
<td>To change the component to which a shape belongs, in the Components Explorer window, drag a shape from one component to another component in the same category.</td>
<td>Component Explorer only</td>
</tr>
</tbody>
</table>

### Updating Process Engineering Projects from Visio 2000


In the Visio 2000 Process Engineering template, projects contained all the drawings and documents for a model, including PFDs, P&IDs, and other files. Projects could contain multiple drawings, each in its own Visio drawing file, so you used the Project Explorer to open and view your documents. In Visio 2003, process engineering drawings work like other types of drawings. There is no need to use separate functionality to manage project files, project databases, or other files. Data for components is stored in custom properties, not project databases, so it’s easier to manage, in addition to being more portable.

The migration process converts each drawing in a Visio 2000 project to a separate Visio 2002 process engineering drawing. In moving to Visio 2003, you can include several process engineering drawings in the same Visio drawing file by adding each drawing as a separate page.

After you migrate a Visio 2000 project to Visio 2002, you’ll see the following changes:

- ♦ All masters and shapes function as Visio 2002 and Visio 2003 shapes.
- ♦ All pipelines function as Visio 2002 and Visio 2003 pipelines.
- ♦ Information in datasheets migrates from the project database into custom properties associated with components.
Datasheet field definitions become custom property sets, which Visio applies to the appropriate shapes.

Tags are still applied to the same shapes as they were in Visio 2000.

Automatic Label shapes become Callout shapes from the Process Annotations stencil.

The migration process doesn’t affect the Visio 2000 files in any way. All files associated with the Visio 2000 Process Engineering project are preserved. You can even migrate your files within the same folder, because Visio uses slightly different names for the migrated drawing files to prevent the files from being overwritten.

To migrate a Visio 2000 Process Engineering project to Visio 2003, follow these steps:

1. To save the migrated files in a new folder, create a destination folder using Windows Explorer.

2. Open the Visio 2000 Process Engineering project (.vsd) in Visio 2002. When Visio prompts you, click Enable Macros to begin the migration. When Visio prompts you to migrate all drawings, click Yes to convert all the drawings in the Visio 2000 project to Visio 2002 drawings.

   If you click No, Visio does not migrate the drawings. However, you can still open them as read-only drawings in Visio.

3. In the Browse for Folder dialog box, select the destination folder you created in step 1 and then select a filename. Visio begins to migrate the files into the new format.

   The migration process might take some time, particularly if you are migrating a large Visio 2000 project. To avoid tying up your computer, you can start the migration and let it run on its own.

4. After the migration is complete, click OK. Visio presents a summary of the names and paths of the migrated files. Review the summary and then open the migrated files in Visio 2003.

Creating P&ID and PFD Drawings

The approach to creating process engineering drawings isn’t much different than creating other types of engineering drawings, although Visio provides some additional tools to simplify some tasks, such as adding valves to pipelines. The steps in this section provide an overview of the basic sequence for creating a process engineering drawing. You can then obtain more detailed instructions in other sections in this chapter.
To create a process engineering drawing, choose File ➪ New ➪ Process Engineering and then choose the template for the type of drawing you want. Visio creates a new ANSI B-size (17 inches by 11 inches) drawing in landscape orientation and with no scale. For either template, Visio opens the following stencils from the Process Engineering category:

- Equipment-General
- Equipment-Heat Exchangers
- Equipment-Pumps
- Equipment-Vessels
- Instruments
- Pipelines
- Process Annotations
- Valves and Fittings

To quickly assemble a process engineering drawing, follow these basic steps:

1. Drag shapes for major equipment, from the Equipment-Vessels, Equipment-Pumps, Equipment-Heat Exchangers, and Equipment-General stencils onto your drawing. As you drop them onto the page, Visio adds tags that identify each piece of equipment as a component.

2. Use Pipeline shapes to connect the shapes for major equipment. The easiest way to connect Equipment shapes using Pipeline shapes is to click the Connector tool on the Standard toolbar, click the Pipeline connector master you want to use in the Pipelines stencil, and then drag the mouse pointer from one shape representing a component to another on the drawing page.

   **Tip**

   To change to a different type of pipeline, click another Pipeline connector master in the Pipelines stencil and then continue to draw between Equipment shapes on the drawing page.

   **Note**

   You can modify the direction of a pipeline or the type of pipeline by changing the line style of the Pipeline shape, as described in the next section.

3. Drag Valve shapes from the Valves and Fittings stencil onto Pipeline shapes on the drawing page. When a red square appears on the Pipeline shape and the Valve shape rotates to the orientation of the Pipeline shape, release the mouse button to glue them. Visio automatically splits the Pipeline shape into two pieces, both of which are glued to the Valve shape.

4. Drag Instrument shapes from the Instruments stencil onto the drawing page near the Pipeline shapes, Valve shapes, or shapes for the equipment that the instruments monitor. If the Instrument shape includes a control handle, you can drag it to glue the Instrument shape to the shape for the component it monitors.
5. Drag shapes, such as Callouts or Text, from the Process Annotations stencil onto the drawing page and edit their text blocks to annotate the drawing.

6. Add data to components. Choose View ➪ Custom Properties Window. Select a shape, click a custom property field, and then type or select a value.

**Building Pipelines**

In Visio process engineering drawings, pipelines are components that connect equipment, such as vessels or centrifuges. However, as you connect Pipeline shapes to one another or add shapes for other equipment components to them, Visio splits the Pipeline shapes into separate shapes. Although a pipeline in the model might comprise several separate shapes on the drawing page, each one belongs to the same component and shares the same tag and custom properties.

**Specifying Pipeline Behavior**

To specify how pipelines behave when you add valves or connect other pipelines, choose Process Engineering ➪ Diagram Options and then specify the following options:

- To split Pipeline shapes when you drop Valve and Fitting shapes onto them, check the Split Pipelines Around Components check box.
- To split Pipeline shapes when you connect other Pipeline shapes to them, check the Split Pipelines When Branches Are Created check box.
- To repair Pipeline shapes when you delete components or other Pipeline shapes, check the Repair Split Pipelines check box.

*Note*

If you want Pipeline shapes to split, you must also be sure to glue to shape geometry. Choose Tools ➪ Snap & Glue and check the Shape Geometry check box under the Glue To heading.

**Specifying Pipeline Type**

Although you can specify attributes such as design pressure in custom properties associated with a pipeline component, the type of pipeline is determined by the line style you apply to a Pipeline shape. To change the line style for a Pipeline shape, right-click it and then choose Format ➪ Style from the shortcut menu. Select the type of Pipeline style you want in the Line Style drop-down list and click OK.

You can also use line styles to show the direction of flow in a pipeline. To show the flow direction of a Pipeline shape, select the shape and then select a style from the Line Style list on the toolbar. For example, the P&ID Minor Pipe-> line style shows flow from the starting point to the ending point of a pipeline shape. P&ID Minor Pipe<- indicates flow from the end back to the beginning.
Adding Components to Pipelines

When you drop a Valve shape onto a Pipeline shape, Visio splits the Pipeline shape into two pieces, with the ends of the two segments glued to the component you inserted, as shown in Figure 29-3. The two shapes still belong to the same component and share the same tag and properties as the original Pipeline shape.

![Figure 29-3: When pipelines split, the shapes still belong to the same component.](image)

When you connect one pipeline to another, the original Pipeline shape also splits into two pieces. Visio adds a Junction shape at the point where the three Pipeline shapes intersect. Although you don’t see Junction shapes on the drawing page, they do appear in the Connectivity Explorer window.

Tip

If you want to display Junction shapes—for example, to validate your drawing—choose Process Engineering > Diagram Options, check the Split Pipelines When Branches Are Created check box, and then select Junction in the drop-down list.

To add a valve or fitting to a pipeline, follow these steps:

1. Drag a Valve or Fitting shape from the Valves and Fittings stencil and position it on top of a Pipeline shape.

2. Release the mouse button when Visio displays a red square on the shape indicating that the shapes are glued. Visio rotates the Valve or Fitting shape to match the orientation of the Pipeline shape.
When you delete a valve or other component that splits a pipeline into two pieces, the pipeline heals into a single shape. However, if you delete a component between two different pipeline components, the pipelines remain separate components. If pipelines that belong to the same component don’t repair themselves when you delete a component, choose Process Engineering ➤ Diagram Options and check the Repair Split Pipelines check box.

**Continuing Pipelines on Other Pages**

In some circumstance, you might want to continue the same pipeline on different pages. For example, if a pipeline spans a distance that doesn’t fit on the drawing page you’re using, you can add shapes that show that the pipeline continues on another page. Clicking those shapes navigates to the continuation of the pipeline.

To continue a pipeline on another page, follow these steps:

1. Drag one of the Off-Sheet Label shapes from the Process Annotations stencil onto one of the end points of a Pipeline shape. When a red square appears, indicating that the Pipeline shape is glued to the Off-Sheet Label shape, release the mouse button.

2. In the Off-Page Reference dialog box, select either the New Page or Existing Page option. If you choose to refer to a new page, type the name of the page in the Name box. If you choose to jump to an existing page, select the name of the existing page in the drop-down list. Click OK. Visio displays the other page and adds an Off-Page Reference shape to it.

3. From the Pipelines stencil, drag a Pipeline shape onto the Off-Sheet Label shape on the new page. When a red square appears, indicating that the shape is glued to the Off-Sheet Label shape, release the mouse button.

4. To specify that the Pipeline shape on the new page is a continuation of the original, double-click the Pipeline shape and type the tag for the original Pipeline shape and press Esc. Visio associates the Pipeline shape with the original component and moves the entry for the Pipeline shape into the original component in the Component Explorer window.

To navigate between pages, right-click an Off-Sheet Label shape and then choose Off-page Reference.

**Working with Components**

Components represent individual real-world objects such as valves, pumps, or pipelines. In Visio process engineering drawings, components might be made up of one or more Visio shapes. For example, a main pipeline with several intersecting branches requires a separate Visio shape for each segment, but to you, it’s still one component. Each component includes properties, such as pressure, temperature, or material, that apply to all the shapes in it.
You can categorize components in a process engineering model so that it’s easier to track and report on different types of components. Visio includes several categories that correspond to the shapes on the Process Engineering stencils: Equipment, Instrument, Pipelines, and Valve. You can also create your own categories.

Caution
Only shapes from the Process Engineering stencils appear automatically in the Component and Connectivity Explorer windows. If you add shapes from other stencils or draw your own, they won’t appear as components. However, you can convert these shapes so that they will work with Visio Process Engineering features by following the steps outlined in the section “Converting Shapes into Components.”

Associating Shapes with Components
When you add Process Engineering shapes to drawings, Visio automatically creates components for you. Each shape you place on the drawing page receives a tag number that identifies the component to which the shape belongs. However, you can associate more than one shape with the same component or move a shape from one component to another.

Use one of the following methods to associate a shape with a component:

✦ In the Component Explorer window, drag an entry from one component to another component in the same category.
✦ On the drawing page, select a shape and type the tag for the component to which you want the shape to belong.

Note
If you want to remove a component association completely, you must delete the shape on the drawing page.

Working with Component Data
To accurately model and engineer processes, your drawings must include information about the components in the process, such as the operating temperature range for a piece of equipment or the design pressure of a pipeline. Visio uses custom properties to store process engineering data so that you can view component properties in the Custom Property window or display data directly on your drawings. In addition, Visio provides some custom properties to configure shapes — for example, displaying different versions of the shape depending on the type of instrument you choose.

Process Engineering shapes come with several custom properties by default, as shown in Table 29-2. Visio uses custom property sets to associate groups of custom properties to each category of component. You can use these properties and property sets or modify them to suit your organization’s needs. Although you can add data to components individually in the Custom Properties window, you might want to use Visio’s Database wizards to import and link data from engineering databases.
To learn how to create your own custom properties and custom property sets and apply them to Visio shapes, see Chapter 32.

To learn how to import data from databases or link Visio shapes to database records, see Chapter 10.

### Table 29-2
**Default Custom Properties for Component Categories**

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Instruments</th>
<th>Pipelines</th>
<th>Valves and Fittings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description</td>
<td>Description</td>
<td>Description</td>
</tr>
<tr>
<td>Material</td>
<td>Connection Size</td>
<td>Line Size</td>
<td>Line Size</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Service</td>
<td>Schedule</td>
<td>Valve Class</td>
</tr>
<tr>
<td>Model</td>
<td>Manufacturer</td>
<td>Material</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>Model</td>
<td>Design Pressure</td>
<td>Model</td>
<td></td>
</tr>
<tr>
<td>Instrument Type</td>
<td>Design Temperature</td>
<td>Valve Type</td>
<td></td>
</tr>
<tr>
<td>Local/remote</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Adding Data to Components
You can add data to component properties by using the Custom Properties window or by employing Visio’s Database wizards and commands to link shapes to engineering databases. To enter custom property values in the Custom Properties window, follow these steps:

1. Choose View ➤ Custom Properties Window to open the window.
2. Select a component in the Component Explorer window or the Connectivity Explorer window, or select the corresponding shape on the drawing page.
3. In the Custom Properties window, click the custom property you want to enter and either type a value or select a value from a drop-down list.

### Displaying Component Data
Visio displays the component tag in the text block of each Process Engineering shape by default. You can choose whether to show or hide component tags by right-clicking shapes on the drawing page and choosing Hide Tag or Show Tag from the shortcut menu. In addition, you can display other component data on the drawing page. For example, Callout shapes from the Process Annotations stencil can show key design attributes on the drawing, such as temperature or pressure.
To display component data using Callout shapes, follow these steps:

1. Drag one of the Callout shapes from the Process Annotations stencil onto the drawing page near the shape whose properties you want to display.

2. Drag the control handle from the Callout shape to any point on the shape that you want to annotate.

3. In the Configure Callout dialog box, check the check boxes for the custom properties you want to display in the Callout shape. With the Callout shape linked to the custom properties, changes to the custom property fields appear in the Callout shape automatically. If you select more than one property, be sure to specify a separator, so you can distinguish individual values in the Callout shape.

   If you want to change the order in which custom properties appear in the Callout shape, select a property and then click Move Up or Move Down to reposition it in the order.

4. To show the property name in addition to the value, check the Show Property Name check box.

5. Click OK. The properties appear in the Callout shape.

6. If you want to change the properties that appear, or you want to change whether the property name is shown after you add the Callout shape to the drawing page, right-click the Callout shape and choose Configure Callout from the shortcut menu. You can also choose Show Leader to draw a leader from the Callout shape to its associated shape.

**Tagging and Numbering Components**

Visio identifies the components in your process engineering model with a tag. In Process Engineering shapes, the tag appears in the shape’s text block. By default, Visio formats tags as `<tag name>-<tag counter>`. The tag name is the first letter of the component category and the tag counter is a number that increments by one every time you add a component from that category to the drawing. If you want to number components in a specific way, you can define your own custom tag format.

   If you don’t want Visio to automatically number components as you add them, choose Process Engineering ➪ Diagram Options and uncheck the Number Components When They Are Added to the Drawing check box.

**Applying Tag Formats to Shapes**

You can change the tag format associated with shapes on the drawing page. If you want to change the tag format for all instances of a shape, you can change the tag
format for a master on a stencil. To use a different tag format for shapes already on a drawing, follow these steps:

1. Select the shape or shapes you want to change on the drawing page and then choose Process Engineering ➪ Apply Tag Format.

2. In the Apply Tag Format dialog box, select the tag format you want in the Tag Format drop-down list, click the Apply to Shapes Selected in Drawing option, and click OK.

To change the tag format for masters in a stencil, follow these steps:

1. Open the stencil that contains the masters whose tag formats you want to change and then choose Process Engineering ➪ Apply Tag Format.

2. In the Apply Tag Format dialog box, select the tag format you want in the Tag Format drop-down list.

3. Click the Apply to Shapes in a Stencil option and then click Choose Shapes.

4. In the Choose Shapes dialog box, select the stencil you want to modify from the Document drop-down list, which includes all open stencils.

   If you want to choose masters on the Document stencil, select the drawing name in the Document drop-down list.

5. Check the check boxes for the masters whose tag formats you want to change and click OK. In the Apply Tag Format dialog box, click OK to apply the new tag format to the selected masters.

6. Right-click the stencil title bar in the Shapes window and choose Save from the shortcut menu.

**Defining Tag Formats**

Visio includes a default tag format for each category of components in the Process Engineering templates. You can modify these existing formats to fit your organization’s standards or you can create formats of your own. Tag formats can include text, punctuation, the values of custom properties, and numeric sequences, and can span more than one line.

To create a new tag format, follow these steps:


2. Type the name for the new tag format in the Name box.
3. Use one of the following options to specify the basis for the new format:

- **Create a New Format**—Choose this option to create a brand-new format based on the default tag format, `<tag format name>-[Counter]`.

- **Create from an Existing Format**—Choose this option to use an existing format as the basis for the new tag format. Select the drawing or stencil that contains the format you want to use in the Document drop-down list. Then, from the Format drop-down list, select the tag format you want to use.

4. Click OK. Visio adds the new name to the Tag Format list.

To specify a new format you just created or to edit an existing one, follow these steps:

1. In the Edit Tag Formats dialog box, select the tag format you want to modify and click Modify. Visio opens the Tag Format Properties dialog box and selects the text in the Tag Expression box.

   **Note**
   You can preview the results of the current tag expression in the Sample Tag Value box.

2. To insert text in the tag expression, position the insertion point in the tag expression and type the text you want.

   **Tip**
   You can add punctuation marks such as hyphens to the tag expression text to separate fields.

3. To replace text in the tag expression, select the text and type the new text you want.

4. To create a multi-line tag, position the insertion point where you want to start a new line in the tag expression and press Enter.

5. To add a custom property to the tag expression, position the insertion point where you want to insert the property, select a custom property in the Available Custom Properties list, and then click Insert Property.

6. To insert a sequential counter to the tag expression, position the insertion point where you want to insert the counter and then click Insert Counter.

   **Tip**
   You can specify the number of digits that the counter occupies by selecting an entry in the Format drop-down list. Visio adds leading zeroes to the counter. For values larger than the number of digits specified, Visio simply adds more digits to the counter.

7. When you have completed the tag expression, click OK. The tag expression appears in the Expression column of the Edit Tag Formats dialog box.
You can also rename or delete tag formats in the Edit Tag Formats dialog box by clicking Rename or Delete.

**Renumbering Components**

As you add components to your model, Visio numbers them using a numeric sequence in their tags. For example, the tag for the first piece of equipment you add is E-1, followed by E-2, and so on. However, as you work on a model, you might want to clean up the tag sequence. For example, if you delete components or reassign shapes from one component to another, you can end up with sequence numbers that are no longer used. You can renumber components to reuse those numbers, specifying the starting value you want to use and the increment between each tag.

To renumber the components in a model, follow these steps:

2. To specify which components you want to renumber, click one of the following options:
   - **Document** — Renumbers all the components in the current drawing file
   - **Page** — Renumbers all the components on the current drawing page
   - **Selection** — Renumbers the selected components
3. Uncheck the check boxes for any tag format you don’t want to renumber. By default, all the tag formats are checked.
4. To specify how to renumber components that use a tag format, select a tag format in the Include Tag Formats list. Type the starting value in the Starting Value box and type the increment between numbers in the Interval box. Repeat these steps for each tag format.
5. Click OK to renumber the components.

After Visio renumbers the components, the tags for new components begin where the last renumbered components left off. In addition, new tags use the settings from the renumbering you applied. For example, if you renumber pipelines starting at 100 using an interval of 2 and the pipelines in the model are tagged from 100 to 128, the next pipeline you add will start at 130.

**Generating Component Lists and Bills of Material**

You can generate reports about components in your model from the values in custom properties. Visio includes a predefined report for each category of components, which lists specific information about each component. You can use these reports as provided or use Visio’s report features to define your own reports. Even if you don’t add values to custom properties, you can still run these built-in reports to see a list of components by tag number, because Visio adds tag numbers automatically.
Visio provides the following predefined reports:

- **Equipment List** — Includes tag number, description, manufacturer, material, and model
- **Instrument List** — Includes tag number, description, connection size, service, manufacturer, and model
- **Pipeline List** — Includes tag number, description, line size, schedule, design pressure, and design temperature
- **Valve List** — Includes tag number, description, line size, valve class, manufacturer, and model
- **Inventory** — Shows the number of shapes on the page grouped by shape name

To run one of these reports, select it in the Report list and then click Run.

**Cross-reference**

To learn more about creating, modifying, and running reports, see Chapter 32.

### Converting Shapes and Symbols into Components

In order to work with Visio Process Engineering features, shapes must belong to a component category and have a tag format assigned to them. Without these, you won’t see the shapes in the Component Explorer or Connectivity window and they won’t function as other Process Engineering shapes do. However, you can convert shapes or objects from other sources into Process Engineering shapes using the Shape Conversion command. You can convert the following elements:

- Shapes you draw with Visio drawing tools
- Existing shapes on a drawing page
- Shapes from stencils other than the Process Engineering stencils
- Symbols created in AutoCAD

**Note**

Process Engineering shapes can lose their attributes when you perform some actions—for example, ungrouping a grouped Process Engineering shape or applying Shape Operation commands to them. When this happens, you can use the Shape Conversion command to reassign a category and tag format.

To transform shapes or symbols into Process Engineering shapes, follow these steps:

1. If you want to convert shapes on the drawing page, select the shapes you want to convert.
2. Choose Process Engineering ➪ Shape Conversion. Then, under the Source heading, choose one of the following options:
• **Selected Shapes** — Converts the shapes you selected on the drawing page.

• **Shapes in a Visio Stencil** — Converts masters on a Visio stencil. Click Choose Shapes, select the stencil in the Document list, check the check boxes for the masters you want to convert, and click OK.

To convert masters on the current drawing’s Document stencil, in the Choose Shapes dialog box, select the drawing name in the Document list. By doing this, you can convert all the shapes in the current drawing file.

• **Symbols in a CAD File** — Converts symbols in a CAD file. Click Browse and then locate and select the CAD file containing the symbols you want to convert. To set the drawing scale in Visio, enter a positive value for the number of Visio measurement units that equals one CAD unit and select the units you want to use in the Units drop-down list.

3. Select or type the name of a category in the Category box to assign it to the converted shapes.

   If you type a category name that doesn’t exist, Visio creates a new category for you.

4. In the Tag Format list, select a tag format to assign it to the converted shapes.

   In Visio 2002, you could also specify a custom property set for the shape conversion. In Visio 2003, you apply custom property sets to the shapes outside of the Shape Conversion command. For more information, see Chapter 32.

5. Click OK to convert the shapes. If you converted CAD symbols, Visio creates a new stencil that contains the shapes you converted. To save the stencil, right-click the stencil title bar and choose Save from the shortcut menu.

**Summary**

Visio provides templates for mechanical, electrical, and process engineering drawings. You can use basic Visio techniques such as drag and drop to perform much of the work for creating drawings. Visio uses custom properties not only to add engineering information to shapes, but also to configure shapes to show different varieties of equipment.

The Process Engineering solution includes additional tools to help you build a model. Visio uses components with identifying tags to track and report on the objects in a process engineering model. The Component and Connectivity Explorer windows present your model as an outline. You can create, delete, rename, and move components around on the drawing page or in these windows.
Customizing Templates, Stencils, and Shapes

In This Part

Chapter 30 Creating and Customizing Templates

Chapter 31 Creating and Customizing Stencils

Chapter 32 Creating and Customizing Shapes

Chapter 33 Customizing Shapes Using ShapeSheets

Chapter 34 Formatting with Styles

Chapter 35 Customizing Toolbars and Menus

Chapter 36 Automating Visio
Creating and Customizing Templates

Visio Standard 2003 provides 25 built-in templates, while Visio Professional 2003 includes over 60. You can obtain additional Visio templates from online sources listed in Chapter 39. Even with all these templates at your disposal, you might want to customize a built-in template or create your own.

Templates increase your productivity by setting up an environment appropriate for a type of drawing or conforming to your organization’s standards. You can automatically configure page settings, open stencils, position windows, add drawing pages, including backgrounds, and even pre-populate a page with shapes, such as your company logo, just by creating a drawing based on a template.

If a built-in Visio template offers most of what you need, it’s simpler to customize a built-in template. However, you can quickly create your own templates by saving an existing drawing as a template. In addition to regular Visio templates that create new Visio drawings, you can also create XML templates to create new Visio drawings as XML drawings. In this chapter, you’ll learn how to create your own templates. You’ll also learn to add stencils and styles to the templates you create, and how to configure page settings for the pages in your templates.
Reasons to Customize Templates

Developing your own set of templates makes sense for a number of reasons, even if many of the settings in a built-in template are exactly what you want. Customized templates can save you time if you

✦ Use specific page settings for different types of drawings.
✦ Create drawings using unusual page sizes.
✦ Draw plans using unusual drawing scales.
✦ Apply special formatting, such as color palettes, to different types of drawings.
✦ Use backgrounds on your drawings.
✦ Use stencils other than the ones that a built-in Visio template opens.
✦ Use different stencils to produce the same type of drawing for different departments.
✦ Drag shapes from custom stencils to create different types of drawings.
✦ Include the same shapes on all your drawings, such as company logos or title blocks.
✦ Prefer specific positions for Visio windows.

Even when you have an existing drawing that is similar to the one you want to create, it’s better to create your new drawing from a template with the settings you want. When you open a template, Visio automatically creates a copy of the template for your new drawing. If you use an existing drawing and forget to use the Save As command, you overwrite your original drawing instead of creating a new one. In addition, you must remove or revise the content on an existing drawing.

Customizing Templates

It’s easy to build your own templates, whether you want to customize one of the built-in Visio templates or create your own from an existing drawing. In short, you set up a drawing with the content, settings, and stencils you want, and then save it as a template or XML template.

Creating and Saving Customized Templates

You can create templates from existing Visio drawings, built-in Visio templates, or other customized templates. If you want to customize a built-in template, it’s better to create a new template based on the built-in template. You can use your customized template and still have a copy of the original if you need it.
When you save a file as a template, you assemble the file’s page settings, print settings, snap and glue options, drawing pages with any existing shapes, layers, styles, color palette, macros, and window sizes and positions into a reusable package. Make sure you set the file up exactly the way you want before you save it as a template, because every new drawing based on the template will inherit the same settings.

To create a template, follow these steps:

1. Open an existing Visio drawing (.vsd file) or create a new drawing based on the template you want to customize.
2. Set up the file with the content and settings that you want. For more information on making these changes, see the next section.
3. Choose File ➪ Save As, and, in the Save as Type list, select either Template or XML Template. Type the name for your template in the File Name box.
4. Click the Save arrow and, if necessary, check Workspace. Click Save. Visio saves your workspace to a .vst file if you chose a template, or to a .vtx file if you chose an XML template.

You can use Visio drawings to create XML templates without losing any of the drawing’s information. You can also create Visio XML templates by importing XML files created in other applications as long as they comply with the XML for Visio Schema and Visio’s internal rules.

### Setting Up a File for Use as a Template

You can specify as many or as few settings as you want, and pre-populate the file with pages and shapes if you want. You can apply these changes in any order as long as you make all the changes before you save the file as a new template. Use any of the following methods to set up your template:

- **Open Stencils** — To open a set of stencils when you use the template, open the stencils that you want Visio to open automatically and close any stencils that you don’t want Visio to open.

  If you make changes to a stencil as you are setting up your template, be sure to save the stencil file as well as the template file. Otherwise, your stencil changes will be lost even though Visio opens the stencil as part of the template.

- **Pre-populate Pages** — To define pages that you want Visio to create automatically in a new drawing, insert the number of pages you want and specify the page settings you want for each page.
You can add a background page to a template to display your company logo, or a standard title block for every new drawing based on that template. To do this, create the background page, add the shapes you want to it, and assign it to foreground pages before you save the template.

✦ **Pre-define Layers** — If you want drawings to use a standard set of layers, create the layers you want for each page in the drawing.

✦ **Pre-populate Shapes** — To begin drawings with a standard set of shapes, add the shapes you want to a drawing page (and layer, if you use them.)

✦ **Pre-define Print Settings** — Choose File ➪ Page Setup, select the Print Setup tab, and specify the print settings you want, such as the size of the printer paper.

✦ **Pre-define Page Settings** — Choose File ➪ Page Setup, select other Page Setup tabs, and specify the settings you want, such as page orientation, drawing scale, line jump settings, and shadow settings.

✦ **Pre-define Snap and Glue Options** — Choose Tools ➪ Snap & Glue and select the options you want.

✦ **Pre-define a Color Palette** — Choose Tools ➪ Color Palette and select the color palette or colors that you want.

✦ **Pre-assign a Color Scheme** — Right-click a page and choose Color Schemes from the shortcut menu.

When you customize both the stencils and colors in a template, make sure that the styles and colors for the template and stencil files are compatible. The style and color settings for the template file override the settings in the stencil file, which can lead to strange results when they conflict.

✦ **Make Styles Available** — Custom styles are associated with the drawing that’s open when the styles are created. To make a custom style available for future drawings, modify or create the styles you want before saving the template.

✦ **Set Up Visio Windows** — To open and position windows automatically when you create a new drawing, open the windows you want and position them where you want.

You can also specify where stencils appear in the Visio window and whether they are docked or floating. Position the stencils where you want them to appear when Visio opens them.

✦ **Include Macros** — Create any macros that you want to use.

### Accessing Customized Templates

By default, Visio installs its built-in templates in category folders within C:\Program Files\Microsoft Office\Visio11\1033\Solutions. If you
save your customized template files in one of these Solutions folders, Visio lists your templates along with built-in templates when you choose File ➪ New and then choose the category of template you want.

However, you might want to keep your customized templates separate from Visio’s built-in templates. Not only does that make it easier to differentiate customized and built-in templates, but you can ensure that your customized files are backed up. To store and retrieve your customized templates from other locations, follow these steps:

1. To keep your templates organized, save them in a folder dedicated to your customized templates, such as My Documents\My Visio Templates.

   Tip
   You can categorize your templates just as Visio categorizes its built-in templates by creating subfolders underneath your main folder, such as My Documents\My Visio Templates\Scaled Drawings.

2. To specify the file path for your templates, choose Tools ➪ Options and select the Advanced tab. Click the File Paths button and type the file path in which you store your templates in the Templates box. Click OK to close the Advanced dialog box. Click OK again to close the Options dialog box.

   Note
   You can save your templates on your own computer or on a network device.

3. To create a drawing using one of your templates, open the New Drawing Task Pane and click On My Computer under the Templates heading. Visio opens the Browse Templates dialog box, which displays the files within your template file path, as shown in Figure 30-1. Select a template name and click Open.

   Figure 30-1: Choose a template in your template file path.
Summary

Whenever you create several drawings that use the same settings or configuration, you can simplify your work by creating a template with those settings. Every time you want to create a drawing with those settings, you simply create a new drawing based on that template. Visio automatically sets up the new drawing with all the settings, configurations, and content you added to the template. You can specify a variety of settings with templates, including page settings, style definitions, color palettes and schemes, drawing pages, and common shapes, such as company logos. You can store your customized templates along with Visio’s built-in templates or keep them in a separate location.
Creating and Customizing Stencils

When you create a drawing based on a template, Visio opens one or more stencils that include shape masters you can use to construct your diagram. You can access other masters by opening other stencils. When you want to consolidate the masters you use frequently, you can copy them to a custom stencil. In addition, you can create custom stencils to store custom shapes that you create. When you create your own stencils, you can store them in your My Shapes folder or keep them with the Visio built-in stencils. Either way, they’re easy to open.

In this chapter, you learn how to create custom stencils for the shapes you use frequently, whether they are built-in Visio masters or custom masters you create. You’ll also learn how to add masters to the Favorites stencil. Finally, you will learn how to modify the shape information that appears in stencils, and how masters are arranged.

Microsoft has copyrighted the masters on the stencils that Visio installs. You can copy and modify masters to suit your requirements and distribute drawings that contain copyrighted shapes. However, you can’t sell or distribute original or modified Visio masters.

Creating and Saving Stencils

New stencils come in handy if you want to consolidate your favorite Visio masters from several built-in stencils or access custom shapes you create. You can use existing stencils as a foundation for your custom stencils or create them from...
scratch. In addition, Visio 2003 provides several shortcuts for quickly storing your favorite shapes. When you create your own stencils, you can prevent others from editing them by saving them as read-only. Although Visio saves custom stencils in the My Shapes folder by default, you can save your stencils wherever you want, including the Solutions folder Visio uses for its built-in stencils.

You can use shapes from stencils other than the ones that a template opens by default. Visio includes many useful stencils in the Visio Extras category. To open one of these stencils, choose File \ Shapes \ Visio Extras and then choose the stencil you want. Visio Extras stencils include masters for annotations, backgrounds, borders and titles, callouts, connectors, patterns, dimensioning, symbols, title blocks, and more.

Creating a Stencil from an Existing Stencil

If an existing stencil contains most of the shapes you want, you can use it as the basis for a custom stencil. To create a new stencil from an existing one, follow these steps:

1. Open a new or existing drawing so the Shapes window opens and then choose File \ Shapes \ Open Stencil. In the Open Stencil dialog box, Visio displays the contents of the My Shapes folder by default.

2. If you want to create a stencil from one of your custom stencils stored within the My Shapes folder, navigate to the folder within the My Shapes folder that contains the existing stencil you want to use and select the stencil name. On the other hand, if you want to use a built-in Visio stencil, navigate to C:\Program Files\Microsoft Office\Visio11\1033 and select one of the stencil names.

3. Instead of clicking Open immediately, click the drop-down arrow on the Open button and choose Copy from the drop-down menu. Visio opens a copy of the stencil in the Shapes window using a default name, such as Stencil1. The icon in the stencil title bar includes an asterisk, indicating that the stencil is editable.

4. Add, remove, or rearrange masters on the stencil, as described in later sections in this chapter.

5. To save the new stencil, right-click the stencil title bar and choose Save from the shortcut menu. In the Save As dialog box, type a name for your stencil and then click Save.

If the stencil you want to copy is already open, you can right-click the stencil’s title bar and choose Save As from the shortcut menu. In the Save As dialog box, type the name for the new stencil and click Save.
Creating Stencils from Shape Search Results

When you search for shapes by typing keywords in the Search for Shapes box in the Shapes window, Visio displays the shapes it finds in a search results stencil. You can save individual shapes or the entire search results stencil to a custom stencil if you want to access those shapes in the future without performing another search. In addition, adding the shapes you find online to stencils stored on your hard drive saves you from going online to access those shapes in the future.

To save the search results stencil as a custom stencil, follow these steps:

1. Right-click the title bar of the search results stencil and choose Save As from the shortcut menu.
2. In the File Name box, type a name for the custom stencil and then click Save. By default, Visio saves stencils in your My Shapes folder.

See the section “Adding Shapes from Other Stencils” later in this chapter to learn how to save individual shapes in the search results stencil to another stencil.

Creating Stencils from Scratch

If you want to create your own stencils to hold the custom shapes you create, you can begin with a new, blank stencil and add your shapes as you create them. To create a new stencil, choose File ▶ Shapes ▶ New Stencil. When you have finished adding masters to the stencil, right-click the stencil’s title bar and choose Save from the shortcut menu. In the Save As dialog box, type a name for the stencil and click Save.

Creating a Custom Stencil from a Document Stencil

If you use only a few shapes from each of the stencils that Visio opens by default for a specific type of drawing, you might prefer to open one stencil that contains only the shapes you use. After you complete a drawing, you can use its Document stencil to create a stencil that contains masters for only the shapes you added to your drawing.

Creating a new stencil from the Document stencil in a drawing requires a few steps, which aren’t intuitive. First, you open the Document stencil and edit it so that it contains the masters that you want in the order you want. Then, you delete all the shapes and drawing pages within the Visio file and save the drawing file as a stencil file.

Caution

Because you delete all the drawing file contents except the Document stencil, you must be careful to use the Save As command to prevent overwriting your drawing file.
Understanding the Document Stencil

For each drawing you create, Visio creates a Document stencil specific to that file, and stores a master for each shape you add to the drawing. Whether you create shapes with drawing tools or drag them from stencils or shape search results, Visio places a master for each unique shape on the Document stencil.

The Document stencil is a component of a Visio drawing file, not a separate file. You can use it to see which shapes you’ve used in a drawing or to make changes to every instance of a master across all pages in a drawing file. For example, if you want to make the Manager boxes in an organization chart smaller, you can modify the Manager master on the Document stencil. Every instance of the Manager shape in your drawing resizes to match that master. If you create a shape that you will use only in the current drawing, you can add it to the Document stencil so it’s easier to copy.

To create a new stencil from the Document stencil, follow these steps:

1. To prevent overwriting your drawing file, save the Visio drawing file that contains the Document stencil you want to work with.

2. To display the drawing file’s Document stencil, choose File ➪ Shapes ➪ Show Document Stencil.

3. If necessary, add or remove masters in the Document stencil, so that the Document stencil contains the master you want in the new stencil. If you want the masters in a different order, drag them into the sequence you want. You can also edit the master properties or rename the masters.

4. Delete all the shapes on all the pages in the drawing. The fastest way to delete all the shapes on a page is to press Ctrl+A and then press Delete.

   **Caution**

   It’s very important that you delete the shapes on the drawing pages before saving the file as a stencil. If you don’t, the shapes on the pages remain in the file and take up disk space even though they aren’t visible.

5. To save the Visio drawing file as a new stencil, choose File ➪ Save As. In the Save as Type list, choose Stencil. In the Save As dialog box, type the name for the stencil and click Save.

Quickly Storing Your Favorite Shapes

When you want to set aside favorite shapes without interrupting your work on a diagram, new tools in Visio 2003 come to the rescue. You can add shapes that you use often or want to access quickly to the Favorites stencil, which Visio creates automatically during installation and stores in the My Shapes folder under My...
Documents. As you work with Visio and develop an abundant supply of favorite and customized shapes, you can create additional custom stencils and store them in your My Shapes folder for easy access.

During installation, Visio 2003 automatically creates a My Shapes folder in your My Documents folder to store your custom stencils and creates a Favorites stencil in your My Shapes folder so that you can easily store the shapes you use most frequently.

To store and retrieve favorite shapes, use one of the following methods:

- **Store a favorite shape** — To store a shape in your Favorites stencil, right-click the shape you want in the Shapes window and choose Add to My Shapes ➪ Favorites from the shortcut menu.
- **Open your Favorites stencil** — To access masters in your Favorites stencil, choose File ➪ Shapes ➪ My Shapes ➪ Favorites.
- **Open other custom stencils** — If you created other custom stencils in your My Shapes folder, choose File ➪ Shapes ➪ My Shapes and then choose the custom stencil you want.

**Saving Stencils**

As with other types of Visio files, you can apply the Save command to stencils in several ways. Because stencils contain masters that are the basis for the shapes you add to drawings, you can maintain consistency on drawings by specifying a stencil as read-only so others can’t edit the masters.

When you choose File ➪ Shapes, Visio displays a list of stencil categories. When you choose a category, Visio displays the stencils in that category and you can choose the stencil you want to open. If you want to see your custom stencils in Visio’s stencil category list, you can save your custom stencils in subfolders within the Visio Solutions folder. By default, Visio installs stencils in C:\Program Files\Microsoft Office\Visio11\1033\Solutions.

You can also create a separate folder for your stencils on your computer or network and categorize your stencils by creating subfolders for each stencil category. You can easily access your custom stencils by setting Visio’s default stencil path to the top-level stencil folder you create. To specify the default path for your stencils, choose Tools ➪ Options and select the Advanced tab. Click File Paths and type your stencil path in the Stencils box.

To save a stencil, use one of the following methods:

- **Save a docked stencil** — To save a stencil docked in the Shapes window or elsewhere in the Visio window, right-click the stencil title bar and choose Save from the shortcut menu.
Save a floating stencil — Click the icon in the stencil title bar and then choose Save from the shortcut menu.

Copy a stencil — To save a stencil as a new stencil, right-click the stencil title bar and then choose Save As from the shortcut menu.

Prevent others from editing your stencil — To prevent others from opening your stencil and editing the masters, set the Read Only option in the Save As dialog box by clicking the Save arrow and then choosing Read Only.

Tip
Workspaces save the current arrangement of windows and stencils open in the Visio window as well as a few other items, so the next time you open your drawing, your Visio environment is just as you left it. By default, Visio saves the drawing workspace when you save a file. If you want to save the changes you've made to drawing pages without saving the window arrangement, click the Save arrow in the Save As dialog box and uncheck the Workspace check box in the drop-down list.

Adding Shapes to Stencils

In most cases, you create or customize stencils because you want quick access to the shapes you use frequently. You can turn any shape on a drawing page into a master by adding it to a stencil, whether you create it with Visio drawing tools or modify an existing shape. You can also add shapes from other stencils to the current editable stencil. To make a stencil editable, follow these steps:

1. Open the stencil you want to edit by using one of the following methods:
   - Create a new stencil — Choose File ▶ Shapes ▶ New Stencil.
   - Open your Favorites stencil — Choose File ▶ Shapes ▶ My Shapes ▶ Favorites.
   - Open another custom stencil — Choose File ▶ Shapes ▶ My Shapes and choose the custom stencil you want.

   Note
   If you store your custom stencils in subfolders within the Visio Solutions folder choose File ▶ Shapes, choose the category for the stencil, and then choose the stencil you want.

2. To make the stencil editable, right-click the stencil title bar and choose Edit Stencil from the shortcut menu. The icon in the stencil title bar changes to include an asterisk, indicating that the stencil is editable, as shown in Figure 31-1.
Open but not editable

Figure 31-1: Visio shows whether a stencil is editable or not.

By default, Visio opens stencils as read-only, but allows you to open them for editing when you use the Edit Stencil command. This behavior protects the contents of a stencil from inadvertent modifications. However, when you save a stencil as read-only to prevent others from changing your masters, Visio sets the Windows Read-Only flag on the stencil file. If you try to use Edit Stencil on this type of Read-Only file, Visio displays a message that the stencil can’t be edited at this time. If you want to edit a Read-Only file—perhaps to update the masters with new company standards—you can reset the Read-Only flag on the file. To do this, locate the file in Windows Explorer, right-click it, and choose Properties on the shortcut menu. In the Properties dialog box, select the General tab, uncheck the Read-Only check box, and click OK.

Adding Shapes from Drawing Pages

To add a shape from a drawing page to a stencil, follow these steps:

1. Make sure the stencil is open and editable.
2. On the drawing page, select the shape you want to add to the stencil.
3. Add the shape to the stencil by using one of the following methods:

- **Move the shape** — Drag the shape from the drawing page to the stencil.
- **Copy the shape** — Hold the Ctrl key as you drag the shape to the stencil.

When you add a shape to a stencil, it becomes a master. The master appears as an icon in the stencil with a label, Master.\(x\), where \(x\) is a number.

4. To rename the master with a more descriptive name, right-click the master icon in the stencil and choose Rename Master from the shortcut menu. Type the new name in the icon label and press Enter when you’re finished.

5. When you have finished adding shapes to the stencil, save the stencil file. See the “Saving Stencils” section in this chapter for more information about the different ways you can save a stencil.

To remove a master in a stencil, select the master and then press Delete.

**Adding Shapes from Other Stencils**

You can also add a shape from one stencil to another by using the Add to My Shapes command.

In Visio 2003, the Add to My Shapes command appears on the shortcut menu when you right-click a master in a stencil. You can use it to quickly copy a master to another stencil.

To add a shape from another stencil, follow these steps:

1. To make it easy to see the shapes you copy to a stencil, open both the stencil containing the master you want to copy and the stencil to which you want to copy it.

**Copying and Pasting Masters Between Stencils**

You can also use the Copy and Paste commands to add masters to other stencils. To do so, right-click the master you want to copy and choose Copy from the shortcut menu. Then right-click in the stencil to which you want to copy the master and choose Paste on the shortcut menu. If the destination stencil is editable, Visio copies the master. If the destination stencil is not editable, Visio asks you whether you want to open the stencil for editing so you can complete the paste operation. You can also use Ctrl+C and Ctrl+V to copy and paste masters, respectively.

If you try to paste a master into a built-in stencil, Visio displays a message that you can’t edit the stencil and provides instructions for adding the master to a custom stencil.
If you don’t open the stencil to which you copy a shape, Visio still copies the shape but doesn’t open the stencil so that you can confirm that the copy worked.

2. In the stencil that contains the master you want to copy, right-click the master, choose Add to My Shapes, and then choose one of the following options:

- **Favorites** — Adds the master to your Favorites stencil
- **A Custom Stencil** — Adds the master to the custom stencil you choose on the shortcut menu. Visio adds the master to the stencil without opening the stencil and saves the stencil automatically.
- **Add to New Stencil** — Creates a new stencil and then adds the master to it
- **Add to Existing Stencil** — Opens the Open stencil dialog box so you can choose the stencil to which you want to copy the master

## Modifying Stencil Appearance

Depending on the size of your screen or the amount of space your drawing window takes up, you might want to modify the appearance of your stencil windows to minimize the space they use. You can minimize the space needed for a stencil window by displaying only icons for masters. If you need as much information about a master as possible, you can display icons, master names, and details about each master. As a compromise between the two, you can display icons and names, which is the default setting, and specify how much text appears in the master labels. You can also rearrange the shapes in the stencil or use different background colors to make the stencils easier to read.

## Displaying Master Information

To specify the amount of information that Visio displays for each master in a stencil, right-click the Shapes window title bar and choose one of the following options:

- **Icons and Names** — Displays icons and master names
- **Icons Only** — Displays only icons
- **Names Only** — Displays only names, which uses less space in the window but requires more familiarity with the masters
- **Icons and Details** — Displays icons, names, and a brief description of the master

You can also right-click the title bar of a stencil and choose View to specify the information that Visio displays. Visio changes the information that appears in every stencil you open.
Changing Spacing and Color Settings

If you recognize shapes visually, you can reduce the space required for a stencil window by limiting the text displayed with each master. You can also use the amount of text displayed in labels to increase or decrease the spacing between master icons. In addition, you can change the background color for stencils to make them easier to read. Use any of the following methods to change the appearance of stencils:

- **Characters per line** — To specify how many characters of text appear in each line of a master label, choose Tools ➪ Options and select the View tab. Type the number of characters you want in the Characters Per Line box underneath the Stencil Spacing label. By specifying more characters per line, you increase the horizontal space between masters, in addition to providing more room for the master name.

- **Lines per master** — To specify the number of lines of text for each master label, choose Tools ➪ Options and select the View tab. Type the number of lines you want in the Lines Per Master box underneath the Stencil Spacing label. By increasing the number of lines, you increase the vertical space between masters, in addition to providing more room for the master name.

- **Background color** — To change the background color for stencils, choose Tools ➪ Options and select the Advanced tab. Click Color Settings and specify any of the following colors:
  - **Text Color** — Specify the color for master labels.
  - **Background Color 1** — Specify the background color for a stencil.
  - **Background Color 2** — If your monitor is set to 32-bit color, the stencil background grades smoothly from the first background color to the second.

Rearranging Shapes in Stencils

You can rearrange shapes in stencils by dragging the shapes to different positions in the stencil. Open the stencil you want to rearrange. If it isn’t editable, right-click the stencil title bar and choose Edit Stencil from the shortcut menu. Be sure to save the stencil after you have moved the masters into the positions you want.
Summary

Custom stencils are handy for a variety of reasons. You can use them to consolidate the built-in Visio shapes that you use most frequently onto a smaller number of stencils. You can use them to store your custom shapes. You can copy built-in Visio stencils to custom stencils so you can modify the shapes to suit your requirements. Visio provides several easy ways to create custom stencils. In addition to creating blank stencils or copying existing ones, you can use search results stencils or Document stencils as the foundation for new custom stencils. After creating a stencil, you can add, remove, or rearrange masters. You can also modify the information that appears in stencils to provide more detail or minimize the space the stencil requires.
Creating and Customizing Shapes

Whether you only use shapes from the built-in Visio stencils or craft highly specialized shapes used by your entire organization, you can modify many characteristics of the shapes on your drawings. You can change the appearance of any shape on a drawing, modify how it acts, edit the data associated with it, and define special behaviors for it.

When you plan to use a customized shape frequently or on more than one drawing, you can create a master of the shape that you can reuse by dragging it from a stencil onto a drawing page. If you’re creating customized shapes, you can use Visio drawing tools and Shape Operation commands to build just the shape you want, whether it is an open path or an enclosed area, a shape that acts like a line or a box with two dimensions. You can create masters by drawing geometry with Visio’s drawing tools, but it’s often easier to begin with existing shapes or objects from other applications as the basis for customized masters. In addition, masters offer an easy way to make changes to every copy of a shape on a drawing.

This chapter explains the difference between shapes and masters as well as the features that make shapes smart. You will learn how to create and modify masters and how to customize the graphic elements that comprise shapes and the behaviors that shapes exhibit. Finally, you will learn how to create and apply custom properties to shapes as well as how to create reports of custom property values.
Understanding Shapes and Shape Properties

If you plan to do more than drag shapes from an existing stencil onto a drawing page, it’s helpful to understand what makes shapes tick. Visio shapes are highly customizable, and they do what they’re told. By understanding the different types of shapes, and their components, behaviors, and properties, you can build custom shapes that do exactly what you want. Conversely, if a shape doesn’t behave as you would expect, you can more easily troubleshoot the problem by analyzing the shape’s configuration.

What Makes Shapes Smart?

Built-in Visio shapes are preprogrammed to perform their tasks. Modular furniture shapes snap together as they do in real life. Electrical components connect to represent the wiring for a building. Organization charts show information about employees and their position in the organization’s reporting structure.

Visio shapes have several features you can exploit to make the shapes behave the way you want for different situations. Whether you want to tweak the behavior of a built-in shape or develop your own custom shape behaviors, you can take advantage of the following smart features:

- **Shape behaviors** — Use the options in the Behavior dialog box to control shape selection, editing, positioning, and connections. For example, when you select a box in a title block, you can add text to the box to identify the drawing, whereas when you select a piece of equipment, you can add text to identify the equipment, not its components. See the section “Customizing Shape Behavior” later in this chapter to learn more.

- **Custom properties** — If data is an important part of a diagram, such as the department and employee associated with an office on a facilities plan, you can store additional information in custom properties associated with shapes. You can display custom property values in shape text, use them in calculations, or present them in reports. See the section “Working with Custom Properties” later in this chapter to learn more.

- **ShapeSheets** — The ShapeSheet for a shape contains fields that control every aspect of that shape. You can change shape behaviors and properties in the ShapeSheet, as well as define customized formulas for advanced performance.

Although you can specify a great deal about a shape by modifying it on a drawing page or in the master drawing window, you can learn how to program more advanced behaviors with a ShapeSheet in Chapter 33.
Understanding Shapes and Masters

Inheritance can be a powerful influence, whether it comes from a rich aunt or a Visio master. In Visio, you can easily construct drawings by adding shapes with behaviors and properties predefined. Visio uses the concept of masters to make drawing smart shapes fast and easy. A Visio master is a lot like the plate that Uncle Sam uses to produce money. It’s an original from which you can make as many copies as you want, with each copy initially possessing the same appearance, behavior, and properties as the original. By using masters to create the shapes on your drawings, you can do the following:

✦ Configure a shape once and reuse it again and again.
✦ Ensure consistency on all your drawings.
✦ Share shapes with other Visio users.
✦ Set up standard shapes for your entire organization.

When you drag a master onto a drawing page, you create an instance of the master. Initially, the instance is an exact duplicate of the master and is linked to the master so that changes made to the master propagate to every instance in the active drawing file. You can edit the instances of masters in any way you want, but some modifications break the link between an instance and its shape master. For example, if you ungroup a shape created from a grouped master, you’ll see the message “This action will sever the object’s link to its master.” The warning sounds ominous, but the only consequence is that the instance no longer inherits changes made to the master on the Document stencil. The instance remains on the page and you can continue to edit it.

Understanding Shape Geometry

Shape geometry isn’t that important if you simply drag built-in shapes onto a drawing and use them as is. However, when you begin to modify the appearance of existing shapes or create your own, understanding the building blocks of shapes is an important step for success. By learning shape terminology as well as the features and benefits of different shape elements, you can produce shapes that look and behave the way you want.

Exploring Shape Components

No matter how simple or complex shapes are, they are composed of line segments, arcs, and the occasional text block. Each line segment and arc has a start point and an end point. If you draw a single line segment or arc, you can identify the start point with a green square with an X inside it, and the end point by a green square with a plus symbol inside it. In addition, line segments and arcs include control...
points, indicated by a small green circle, at their midpoints. You can change the curvature or symmetry of a line or arc by selecting the Pencil tool and dragging the control point to a new location.

When you create a connected string of line segments and arcs, a diamond-shaped vertex appears at each intersection. You can change the length of lines and arcs or reposition them by dragging their end points or vertices. By assembling line segments and arcs to create shapes, you can access additional points to help you position, resize, and connect shapes. When you select a shape, Visio marks these points, called *handles*, so you know where to drag on a shape to make the changes you want. Shapes include the following types of handles:

- **Selection handles** — When you select a shape, red or green boxes appear, which you can drag to resize the shape.
- **Control points** — When you select a shape with the Pencil tool, small green circles appear, which you can drag to change the curve or symmetry of a line or arc, or to adjust the angle and magnitude of the eccentricity of an arc.
- **Connection points** — Blue Xs mark locations where you can glue connectors or other shapes.
- **Rotation handles** — For 2-D shapes, you can drag the red circle to rotate a shape.
- **Control handles** — You can drag the yellow diamonds that appear on some shapes to modify the shape's appearance. For example, you can use a control handle to change the swing on a door or to change the width of all the bars in a bar graph.

**Understanding 1-D and 2-D Behavior**

Visio shapes are either 1-D or 2-D, but the distinction has nothing to do with the way the shape looks. You can tell the difference between 1-D and 2-D shapes by the way they behave.

One-dimensional shapes don’t have to look like thin lines. You can transform a Fancy Arrow or Road shape into a 1-D shape, as described in the section “Switching Between 1-D and 2-D Behavior” later in this chapter. One distinguishing characteristic of 1-D shapes is that you can rotate and change the length of a 1-D shape in one step by moving one of its end points. Because 1-D shapes include start points and end points, you can use them to specify direction. One-dimensional shapes can include line ends, such as arrowheads, which you can use to differentiate the start and end of a line.

With 1-D shapes, you can change the relative proportion of the shape, as shown in Figure 32-1. For example, you can increase the length of a Fancy Arrow shape by
dragging an end point, but the width of the arrowhead and tail remain the same. However, when you drag the selection handles on the sides of a Fancy Arrow shape, the proportions of the arrowhead change to fit the new width, even though the length remains the same. Even if you want to, you can’t change the length and width of a 1-D shape at the same time, because 1-D shapes don’t have selection handles at their corners.

![Drag to change the length of a 1-D shape](image)

![Drag to change the width as shown in the bottom shape](image)

**Figure 32-1:** You can change the proportion of a 1-D shape.

Two-dimensional shapes include up to eight selection handles for resizing. You can drag selection handles on the edges of 2-D shapes to change their height or width independently. However, dragging selection handles at shape corners to resize the shape proportionately is a behavior unique to 2-D shapes.

---

**Note**

The distinction between 1-D and 2-D shapes is merely a behavioral difference that you set by choosing an Interaction Style option in the Behavior dialog box. For example, by default, a line segment is a 1-D shape with start and end points that you can drag to lengthen or shorten the line or to change its orientation. You can transform a single line segment into a 2-D shape by right-clicking the shape, choosing Format ▶ Behavior, and selecting the Box (2-dimensional) option on the Behavior tab. When you do so, you can drag selection handles at the midpoint of the line to transform the line into a box.
In addition to 1-D and 2-D shapes, it’s important to recognize the difference between open shapes and closed shapes. You create an open shape when you draw a series of connected line segments that zigzag across the page. Because open shapes don’t enclose an area, you can format the lines and text, but you can’t apply fill formatting to them. Conversely, you create a closed shape when you connect a path back to its starting point. Visio indicates that a shape is closed by applying a default fill format to it. However, you can apply a different fill format if you choose.

Creating and Editing Masters

Although Visio provides hundreds of built-in shapes, with thousands more available from other sources, you can create your own custom masters to exactly match your requirements. For example, if you design and sell custom furniture, you can create Visio masters for each of your designs so you can help clients lay out their furniture. You can create masters by drawing them with Visio’s drawing tools or by copying and editing existing shapes. You can even generate masters using converted CAD objects or data in a database. If your needs change, you can modify the appearance, behaviors, and properties of your custom masters, and apply those changes to the instances on your drawings.

Access to Stencil commands varies depending on whether you have a drawing open or not. To create and edit masters, you must first open a drawing so that the Shapes window opens. Otherwise, you won’t be able to access commands to make stencils editable or edit masters.

Creating Masters

Although Visio’s drawing tools are easy to use, you don’t have to apply them every time you want to create a custom master. You can create your own masters using any of the following methods:

- **Build a master with drawing tools** — Create a master and add graphics to it with Visio’s drawing tools and Shape Operation commands.
- **Use an existing shape** — Drag an existing shape from a drawing page to a stencil.
- **Create a master from an object from another application** — Convert an object from another application, such as Microsoft PowerPoint or AutoCAD, into a Visio master.
- **Copy an existing master** — Save an existing master on a stencil as a new custom master and modify it to suit your needs.
- **Build a master from database information** — Generate new masters by combining data from a database table with existing masters in stencils.
Chapter 32 ✦ Creating and Customizing Shapes

Drawing Masters
To create a new master in a stencil, follow these steps:

1. If you want to edit a built-in stencil, first save it as a custom stencil as discussed in Chapter 31.

2. Open any Visio drawing and then open the custom stencil in which you want to create a master by choosing File ➤ Shapes and then choosing the category and stencil you want. If the stencil is not editable, right-click the stencil title bar and choose Edit Stencil from the shortcut menu.

3. Right-click inside the stencil window and choose New Master.

4. In the New Master dialog box, specify the properties for the master. See the section “Modifying Master Properties” in this chapter to learn more. Click OK when you are done. In the stencil, Visio adds a blank master icon with the master name as a label.

   Note
   If you want to locate your master using the Search for Shapes command, add keywords separated by commas to the Keywords property in the Master Properties dialog box.

5. Right-click the new master and choose Edit Master ➤ Edit Master Shape.

6. In the master drawing window, create the graphics for the master. You can use any of the following methods:

   • **Draw components** — Use Visio drawing tools or Shape Operation commands to create the master graphics that you want.

   • **Use an existing shape or master** — Drag a shape from a drawing page or drag a master from a stencil into the master drawing window.

   • **Paste an object from another application** — Copy an object from another application such as AutoCAD and paste the object in the master drawing window.

   Tip
   You can also import an AutoCAD drawing into Visio, converting the AutoCAD objects into Visio shapes. You can then drag these shapes into an editable stencil to create new masters.

7. Choose File ➤ Close to close the master drawing window. When Visio prompts you to update the master, click Yes.

8. To save your changes, right-click the stencil title bar and choose Save Stencil from the shortcut menu.

Saving Existing Shapes as Masters
If you customize a shape on one of your drawings and want to use it on other drawings, you can save it as a master on a stencil. To save a shape on a drawing page as a master, follow these steps:
1. Open a drawing file so that the Shapes window opens and then open the stencil in which you want to save a master by choosing File ➤ Shapes. Choose the category and stencil you want. If the stencil is not editable, right-click the stencil’s title bar and choose Edit Stencil from the shortcut menu.

2. Drag the shape from the drawing page into the stencil. Visio adds an icon to the stencil with a generic name such as Master.x, where x is a number.

3. Click the icon label. When the master name is highlighted, type the name you want for the master and then press Enter.

4. If you want to specify other properties for the master, such as search keywords, right-click the new master, choose Edit Master ➤ Master Properties from the shortcut menu, and then define the properties you want.

5. Choose File ➤ Close to close the master drawing window. When Visio prompts you to update the master, click Yes.

6. To save your changes, right-click the stencil’s title bar and choose Save Stencil on the shortcut menu.

Creating Masters from Database Information
You can also build new masters based on an existing master and data within a database. For example, if you have a master for an office cubicle and store data about the cubicle’s color and components in a table in a database, you can create masters for each cubicle configuration in the database. When you drag a master to a drawing page, the instance shows the data for the associated record in the database. To create masters in this way, use the Database Wizard to create a stencil containing a master for each record in a database table.

To learn how to use the Database Wizard, see Chapter 10.

Modifying Masters
You can edit your masters to adapt them to your requirements, whether it’s to correct errors you find or to adjust them to meet changing requirements. For example, if your company decides to show which department owns each piece of furniture in an office plan, you can modify your furniture masters to do so.

You can configure the appearance and behavior of masters as you create them or revise them later. To modify an existing master, open any Visio drawing file so that the Shapes window opens and then open the stencil that contains the master. If the stencil is not editable, right-click the stencil’s title bar and choose Edit Stencil from the shortcut menu. After the stencil is open and editable, you can perform the following actions:

♦ Delete a master — Right-click the master you want to delete and then choose Delete Master from the shortcut menu.

♦ Rename a master — Right-click the master you want to rename, choose Rename Master from the shortcut menu, type the new name in the master label, and press Enter.
Modify master graphics — You can edit the drawing components for a master, including lines, arcs, text, and connection points. See the next section in this chapter to learn more.

Modify master properties — You can specify properties for a master, such as Name, Icon Size, and Keywords for shape searches. See the section “Modifying Master Properties” later in this chapter to learn more.

Change the icon image — You can revise the icon that represents the master in a stencil. See the section “Displaying Master Icons” later in this chapter to learn how.

Add or edit custom properties — You can associate custom properties with a master. See section “Working with Custom Properties” in this chapter to learn more.

Note

When you finish modifying masters on an editable stencil, be sure to save your changes by saving the stencil.

Editing Master Graphics

You can modify the appearance of a master by editing a shape on a drawing and then saving the shape as a master. However, you can also edit a master’s drawing elements in the master drawing window. Working in the master drawing window is much like working on a Visio drawing. You can use Visio drawing tools to edit existing graphics or add other shapes and objects to the master by dragging them into the window. However, unlike working in a Visio drawing, Visio prompts you to update the master shape when you close the master drawing window.

To edit a master in the master drawing window, first open any Visio drawing file so that the Shapes window opens, and then follow these steps:

1. In an editable stencil, right-click the master you want to edit and choose Edit Master ➪ Edit Master Shape. Visio opens the master drawing window with the master in the middle of the master drawing area.

2. Make any of the following changes you want to the master’s graphics:

   - **Edit drawing elements** — Use Visio drawing techniques to modify the lines, closed shapes, and text in a master. See the section “Operating on Shapes” later in this chapter to learn how to perform more sophisticated editing operations.

   - **Format drawing elements** — Use Visio formatting commands to change colors, line styles, text styles, and fills.

   - **Modify connection points** — See the section “Adding Connection Points to Shapes” later in this chapter to learn how to add or modify connection points on shapes and masters.
3. When you have finished editing the master graphics, choose File ➤ Close to close the master drawing window. When Visio prompts you to update the master, click Yes. On all the drawing pages in the active drawing file, Visio updates all the instances of the master with your changes.

4. If you want to continue editing masters, click Cancel when Visio prompts you to save changes to the stencil containing the master you edited. Repeat steps 1 through 3 to edit another master.

5. When you finish modifying masters, save the changes you made by right-clicking the stencil’s title bar and choosing Save from the shortcut menu.

The Document stencil in each Visio drawing file stores a copy of each master used on the drawing. When you open a Visio drawing that uses a master that you’ve changed on a stencil, you won’t see those changes by default because the drawing file references the copy of the master on the Document stencil. If you want the drawing file to use the master that you modified on a custom stencil, copy the modified master to the Document stencil.

**Modifying Master Icons**

If you drag a shape onto a stencil to create a master, Visio uses a miniature version of the shape as the icon you see in the stencil. However, you can modify the icon to better represent the master. For example, for complex shapes, you can simplify the icon to make it more readable. Editing a master icon in the icon editing window is a bit different from editing master graphics. You modify icons pixel by pixel, by pressing a mouse button and dragging the mouse over the pixels you want to change. Visio applies the color that you assigned to the mouse button. For larger changes, you can move or delete groups of pixels. The changes you make to a master icon apply only to the icon. They don’t affect the appearance of the master.

You can change the icon you see in a stencil by following these steps:

1. In an editable stencil, right-click the master you want to edit and choose Edit Master ➤ Edit Icon Image. Visio opens the icon editing window, displays the icon in the window, and displays two toolbars containing icon editing tools, as shown in Figure 32-2.

If you make changes to an icon manually, be sure to uncheck the Generate Icon Automatically from Shape Data check box in the Master Properties dialog box. Otherwise, Visio will replace the icon with the revised master when you modify the master in the master drawing window.
2. While the icon editing window is open, you can use the following methods to change the appearance of the master icon:
   
   • **Select colors** — To assign colors to the left and right mouse buttons, click the Left Button Color or Right Button Color box and click the color you want to apply with that mouse button.

   If you want the background to show through the icon, click Transparent for a mouse button color.

   • **Change single pixel colors** — Click the Pencil tool on the Icon Tools toolbar and then click the pixel you want to change with the mouse button assigned the color you want.
Part VI ✦ Customizing Templates, Stencils, and Shapes

- **Change the color of an area** — Click the Bucket tool on the Icon Tools toolbar and then click a pixel in the area you want to change with the mouse button assigned the color you want. Visio changes the color of all contiguous pixels of the same color as the pixel you clicked.

- **Move pixels** — Click the Lasso tool or Selection Net tool on the Icon Tools toolbar and drag around the area you want to move. When Visio displays a selection box around the pixels, drag them to a new location.

- **Delete pixels** — Click the Lasso tool or Selection Net tool on the Icon Tools toolbar and drag around the area you want to delete. When Visio displays a selection box around the pixels, press Delete.

When you move or delete pixels in a master icon, the stencil background color appears in the area from which you moved or deleted pixels.

3. When you have finished modifying the master icon, choose File ➪ Close to close the icon editing window. The changes you made to the icon appear in the stencil. If you want to continue modifying masters, click Cancel when Visio prompts you to save the stencil containing the master you edited. Otherwise, save your changes by right-clicking the stencil’s title bar and choosing Save from the shortcut menu.

You can undo changes you make to an icon while the icon editing window is open by choosing Edit ➪ Undo. However, after you close the icon editing window, you can’t use the Undo command to reverse the changes you made. You must edit the icon and use the icon tools to return the icon to its original appearance.

**Modifying Master Properties**

In addition to the graphic elements of a master, you can modify other aspects of a master, such as its name, the prompt that appears when you point to a shape in a stencil, the icon size, or the keywords you can use to search for the master. To modify a master’s properties, right-click a master in an editable stencil and choose Edit Master ➪ Master Properties. In the Master Properties dialog box, modify the properties you want and then click OK to close the dialog box when you’re done. To save the changes to the master, save the stencil that contains it. You can modify the following properties in the Master Properties dialog box:

- **Name** — The label that appears under the master icon in a stencil can be up to 31 characters. Visio might truncate the name you see depending on the number of characters per line and the number of lines per master you specify on the View tab of the Options dialog box.

- **Prompt** — If you create a prompt for a master, it appears in a balloon when you point to a master in a stencil. You can use the Prompt property to provide a description of the shape, its purpose, or hints about how to use it.
✦ **Icon Size** — The size of the icon for a master in a stencil can be Normal, Wide, Tall, or Double. By default, icons are Normal, which is 32 by 32 pixels.

✦ **Align Master Name** — You can align the master name to the left, center, or right of the master icon in the stencil.

✦ **Keywords** — The Search for Shapes command uses the words in this property to locate the master. When you enter more than one keyword, separate the keywords with commas. This field is only available when the master drawing page contains at least one shape.

✦ **Match Master by Name on Drop** — When you drag a master onto a page, you can specify whether Visio uses the version of the master stored on the Document stencil or the version stored on the shape stencil. When you check this check box, Visio looks for a master by the same name in the Document stencil. If it finds a match, it copies the master from the Document stencil to the drawing page. Use this setting to use a master that you modified in your drawing file instead of the default master on the shape stencil. If you uncheck this box, Visio copies the master from the shape stencil, so that you always use the original version of the master.

✦ **Generate Icon Automatically from Shape Data** — Check this check box when you want Visio to update the master icon every time you edit the master graphics. Uncheck this check box if you edit the icon manually and want to retain those changes.

### Creating Shortcuts to Masters

If you want to include a master on more than one stencil, you can create a shortcut to the master so that you can modify the master on one stencil and propagate the changes automatically to the other stencils. For example, if you want to add a master for a custom-built desk to the stencils for different lines of furniture, you can add the master to the first stencil and then copy shortcuts to the other stencils.

To create a master shortcut, follow these steps:

1. Open both the stencil that contains the master you want to copy and the custom stencil to which you want to add the shortcut. If the destination stencil is not editable, right-click its title bar and choose Edit Stencil from the shortcut menu.

2. In the stencil that contains the master, right-click the master and choose Copy from the shortcut menu.

3. Right-click the destination stencil window and choose Paste Shortcut from the shortcut menu.

4. To save your changes, right-click the editable stencil’s title bar and choose Save Stencil from the shortcut menu. When you edit the master in any of the stencils, Visio changes the master in every stencil linked with a shortcut.
Drawing Shapes and Masters

No matter how many stencils and masters Visio provides, sooner or later you’ll want to create a new shape or master or make changes to existing ones. For example, you might create or revise shapes to do the following:

✦ Draw a shape directly on a drawing when you plan to use it only once.
✦ Modify the line and fill styles for shapes to show status.
✦ Create masters for specific configurations of furniture that your organization uses for office cubicles to simplify the construction of office layouts.
✦ Create new masters by modifying existing Organization Chart masters to show each level of management in an organization chart with a different shape.

Whether you want to create a new shape or modify an existing one, you can use Visio’s drawing tools and Shape Operation commands to achieve the look you want. Even with the most specialized shapes, you can usually get a head start by modifying an existing shape. Drawing tools and Shape Operation commands work whether you are drawing a shape directly on a page or drawing a master in the master drawing window. In addition, if you draw a shape on a page and decide you want to make it a master, you can do so simply by dragging the shape onto an editable stencil.

Visio provides tools and drawing aids to simplify the construction of lines and curves. You can draw straight lines with the Line tool or the Pencil tool. For curves, you can use the Pencil tool, Arc tool, or Freeform tool. If you change your mind, you can even use the Pencil tool to convert arcs to lines, and vice versa. By using drawing aids and shape extension lines, you can snap your lines and curves to define the geometry you want. For example, you can use drawing aids or shape extension lines to draw lines at 45 degrees, create a line perpendicular to another, or draw a line tangent to a circle.

For additional instructions on drawing lines, curves, and closed shapes, see Chapter 2.

Drawing Line Segments and Paths

It’s easy to draw a single line. Click the Line tool on the Drawing Tool toolbar and then drag between two points on the drawing page. However, to produce a connected path or a closed shape, you have to draw a series of connected line segments. When line segments are connected, you can move or format them as a single entity, but you can also reposition each vertex to modify the path or shape. To create connected line segments, follow these steps:
1. Select the Line tool or the Pencil tool.

2. Drag the pointer from point to point to define the first line segment and release the mouse button without moving the mouse.

3. With the pointer still positioned over the second point, drag from point to point to create the next line segment.

   **Tip**
   If you draw a line segment incorrectly or in the wrong place, simply continue to create line segments until the path is complete. You can then use the Pencil tool to edit the line segments in the path.

4. Repeat step 3 until you have drawn all the line segments you want. If you want to close the shape, make sure that the last point in the drawing path overlaps the very first point in the path.

   **Cross-Reference**
   You can use drawing tools to create construction lines that you can use to align shapes on drawings. Although the Visio guide lines that you drag from a ruler onto a page perform the same function, they are a special type of drawing element and don’t print by default. To learn how to convert regular lines into infinite lines that you can use as a reference, see Chapter 33.

### Creating Closed Shapes

You can use the Rectangle or Ellipse drawing tools to quickly create closed shapes. To draw a closed shape with one of these tools, click the tool you want on the Drawing toolbar and then drag between two points on the drawing page. Visio creates the closed shape and applies a default fill style so you can see that the shape is closed.

If you use the Line, Pencil, Arc, or Freeform tool, you must be sure to close the drawing path if you want to apply a fill pattern or color to the shape. To close a drawing path, position the last point in the same position as the first point on the path, as shown in Figure 32-3. When you successfully close a shape, Visio applies a default fill to the shape so you can see that the shape is closed.

   **Note**
   If you can still see the drawing grid behind your shape after you’ve completed the entire path, the shape is not closed. See the section “Creating and Editing Shapes with the Pencil Tool” later in this chapter to learn how to close an open shape.
Click here to close the shape

![Diagram showing how to close a shape]

Figure 32-3: Overlap the first and last points to close a shape.

Drawing Graphics Precisely

When you create your own shapes, you often want to position lines and curves precisely in relation to other shapes on your drawing. For example, to construct HVAC or plumbing plans, you might want to draw ducts and pipes perpendicular to other lines or at specific angles. Visio drawing aids and shape extensions are guides to help you create a variety of precise geometric constructions, such as tangent lines.

You can also specify precise coordinates for the end points of lines in the Size & Position window.

Drawing aids are temporary dotted lines that show you where to click to draw squares, circles, and angled or perpendicular lines. Shape extensions function similarly to drawing aids, but enable snapping to additional geometry, as shown in Figure 32-4. For example, you can use drawing aids or shape extensions to perform the following tasks:

✦ **Drawing circles and squares** — When you use the Ellipse or Rectangle tools, drawing aids show you where to click to create a circle or square.

✦ **Drawing lines** — When you use the Line tool or Pencil tool, drawing aids appear when the line you are constructing approaches an increment of 45 degrees. Depending on the shape extensions you enable, shape extensions show you where to click to draw lines such as tangents to a curve or perpendicular to other lines.

✦ **Editing lines** — When you edit a line segment, drawing aids extend at 45-degree increments as well as at the line's original angle.
Figure 32-4: Shape extensions facilitate the creation of precise geometry.

To display drawing aids, choose Tools ➪ Snap & Glue and check the Drawing Aids check box in the Currently Active column. To enable snapping to shape extensions, check the Shape Extensions check box in the Snap To column, select the Advanced tab, and check the check box for each shape extension option you want to enable. Table 32-1 describes the shape extensions you can use to draw geometry.

You can adjust the attraction that shape extensions exert on the mouse pointer by dragging the Extensions slider to the left or right. As you drag the slider, the proximity of the pointer, in pixels, required to activate snapping appears in the Pixels box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alignment Box Extension</td>
<td>Extends lines from a shape’s alignment box so you can snap to the edges of a shape</td>
</tr>
<tr>
<td>Center Alignment Axes</td>
<td>Extends a line from the center of a shape’s alignment box so you can snap to the center of a shape</td>
</tr>
<tr>
<td>Curve Interior Tangent</td>
<td>Displays an extension line tangent to a curve. To draw a tangent to a curve, drag the pointer from the edge of the curve until the tangent extension line appears, and then drag the pointer along the extension line until the extension line turns red. As you continue to move the pointer, Visio shows a tangent line from the current pointer position to the curve.</td>
</tr>
<tr>
<td>Segment Endpoint</td>
<td>Highlights and snaps to the end point of a line segment or arc</td>
</tr>
<tr>
<td>Segment Midpoint</td>
<td>Highlights and snaps to the midpoint of a line segment or arc</td>
</tr>
</tbody>
</table>

Continued
Table 32-1 (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear Extension</td>
<td>Displays an extension of a line beyond its end point so you can extend the current line</td>
</tr>
<tr>
<td>Curved Extension</td>
<td>Extends an arc to show where to click to create an ellipse. For splines, this shape extension extends the curve from the nearest end point.</td>
</tr>
<tr>
<td>Endpoint Perpendicular</td>
<td>Displays a line perpendicular to the nearest end point of a line or arc so you can create a line perpendicular to an existing line or arc</td>
</tr>
<tr>
<td>Midpoint Perpendicular</td>
<td>Displays a perpendicular line from the midpoint of a line or arc so you can create a perpendicular line that bisects a line or arc</td>
</tr>
<tr>
<td>Horizontal Line at Endpoint</td>
<td>Displays a horizontal line from the end point of a line or arc so you can create a horizontal line starting at the end of an existing line</td>
</tr>
<tr>
<td>Vertical Line at Endpoint</td>
<td>Displays a vertical line from the end point of a line or arc so you can create a vertical line starting at the end of an existing line</td>
</tr>
<tr>
<td>Ellipse Center Point</td>
<td>Highlights and snaps to the center of an ellipse</td>
</tr>
<tr>
<td>Isometric Angles</td>
<td>Displays extension lines at isometric angles to simplify the construction of isometric diagrams</td>
</tr>
</tbody>
</table>

Creating and Editing Shapes with the Pencil Tool

With the Pencil tool, you can edit existing lines and arcs or create new ones. You can use it to correct crooked lines, reposition vertices and end points, switch between straight lines and circular arcs, or close open shapes. Click the Pencil tool on the Drawing Tool toolbar and then use one of the following methods to create or edit lines and arcs:

- **Draw a straight line** — Click a point on the drawing page and then drag the pointer straight in any direction. Visio indicates that it is in Line mode by changing the pointer to crosshairs, with an angled line below and to the right.

- **Draw an arc** — Click a point on the drawing page and then sweep the pointer in a curve. Visio indicates that it is in Arc mode by changing the pointer to crosshairs, with an arc below and to the right. By moving the pointer, you can adjust the radius of the arc as well as the angle it circumscribes.

- **Switch between Line and Arc mode** — Move the pointer back to the starting point. When the pointer changes to crosshairs only, drag or sweep the pointer to switch to Line mode or Arc mode.
Correct a crooked line — If you created line segments that aren’t orthogonal, straighten them by selecting the shape to display its vertices and then dragging an end point or vertex to a new location.

Change an arc into a straight line — Select the shape to display its handles. Drag the green eccentricity handle at the midpoint of an arc until the line is straight.

Change a straight line into an arc — Select the shape to display its handles. Drag the green eccentricity handle at the midpoint of a line until the arc is the radius you want.

Close an open shape — Select the shape to display its vertices. You can close a shape using one of the following methods:

- Drag a vertex to the starting point of the first segment in the shape.
- Draw a line from the last vertex in the existing path to the first.

Transforming Shapes into New Ones

The Visio Operations menu includes specialized commands you can use to assemble simple shapes into more complex shapes, deconstruct shapes into more elementary components, or tweak shape geometry into exactly what you want. Some shapes, such as those with holes or cutouts, are feasible only by splicing several shapes into one. Even complex shapes that you can construct with repeated use of the Pencil and Group commands are often easier to build with Shape Operation commands, and the resulting Visio files are more compact. If you’ve worked with CAD programs, you’re probably familiar with many of these functions. If not, the best approach is to experiment with these commands to find the combination that works.

To use Shape Operation commands, select the shapes you want to transform, choose Shape ➪ Operations, and then choose the command you want.

For Shape Operation commands, the order in which you select shapes is important for several reasons. For some commands, such as Subtract, Visio modifies the first shape selected using additional selected shapes, so the results vary depending on which shape you select first. In addition, Visio formats the resulting shape with the formatting from the first shape you select.

Assembling and Disassembling 2-D Shapes

Some Shape Operation commands transform several shapes into one. Conversely, the Fragment command divides shapes into smaller pieces. In some instances, you can achieve the same results using different Shape Operation commands. For other results, there’s only one solution. If one command doesn’t produce the results you want, try another command or experiment with a combination of them.
Updating the Alignment Box

You can use a shape’s alignment box to align it to the drawing grid or other shapes. If shapes don’t end up where you expect when you snap to a shape, the shape’s alignment box could be out of whack. To reset an alignment box to match the boundaries of a shape or group, select the shape or group and then choose Shape ➤ Operations ➤ Update Alignment Box.

![Caution](image)
The 2-D Shape Operation commands delete your original shapes, so it’s a good idea to make a copy of your shapes before you start. If a command doesn’t produce the results you expect, you can also reverse the changes by immediately choosing Edit ➤ Undo.

Creating a Union from Shapes

The Union command produces a new shape that encloses the area of the original shapes. When you apply the Union command to overlapping shapes, it creates a new shape that includes the total area occupied by the original shapes and deletes the original shapes. For example, you can produce a single shape that looks like a mountain range from a collection of triangles. To create results similar to those shown in Figure 32-5, first select the shape whose format you want to apply to the resulting shape, Shift+click the other shapes you want to merge, and then choose Shape ➤ Operations ➤ Union.

![Figure 32-5](image) You can create one shape that encloses the area of several.
You can create a single shape from several shapes that don’t overlap with the Union command. However, by creating a group out of several shapes by using the Group command, you can specify how the shapes in the group behave.

**Combining Shapes**
You can use the Combine command to produce a shape with holes, such as the frame of a window. The Combine command makes the overlapping areas of the selected shapes transparent so they look like holes, as demonstrated in Figure 32-6. It formats the shape based on the formatting of the first shape you select and deletes the original shapes when it’s done. To combine shapes, select the shape with the format you want for the resulting shape, Shift+click the other shapes you want to process, and then choose Shape ➢ Operations ➢ Combine.

**Figure 32-6:** Combine shapes to create a shape with holes.
Breaking Shapes into Smaller Pieces
You can break overlapping shapes into smaller pieces by using the Fragment command. When you fragment two or more shapes, any areas that overlap become new 2-D shapes and the remaining areas that don’t overlap also become 2-D shapes, as shown in Figure 32-7. In addition, you can draw lines through a 2-D shape to show where you want to break it. For example, by drawing lines through the center of a circle, you can break it into pie-shaped slices. To fragment shapes, select the shape with the format you want for the resulting shape, Shift+click the other shapes you want to process and any lines you want to use as breaks, and then choose Shape ➪ Operations ➪ Fragment.

Figure 32-7: You can use the Fragment command to break shapes into smaller pieces.

Removing Areas That Don’t Overlap
The Intersect command produces one shape that includes only the overlapping areas of the shapes you select. For example, you can intersect two ellipses to produce an irregularly shaped island for a traffic intersection, as shown in Figure 32-8. The Intersect command deletes the original shapes and formats the resulting shape
like the first shape you select. To intersect shapes, select the shape with the format you want for the resulting shape, Shift+click the other shapes you want to process, and then choose Shape ➪ Operations ➪ Intersect.

![Figure 32-8: You can create a shape from the overlapping area of other shapes.](image)

**Caution**
Because shapes that don’t overlap don’t have any intersecting areas, applying the Intersect command to non-overlapping shapes or individual shapes simply deletes the original shapes.

**Creating Cutouts**
You can create shapes with areas cut out. The Subtract command creates a new shape that looks like the first shape you select minus the overlapping areas from additional shapes. The order in which you select shapes is particularly important for the Subtract command because it affects both the resulting shape and the formatting that Visio applies, as illustrated in Figure 32-9. To cut shapes out of another shape, select the shape from which you want to cut out areas, Shift+click the other shapes you want to use as cutouts, and choose Shape ➪ Operations ➪ Subtract.
Manipulating Lines

Visio includes several Shape Operation commands specifically for creating and manipulating 1-D shapes on your drawings. For example, you can produce a set of parallel lines with the Offset command or use the Join command to create 2-D shapes from lines and arcs.

Joining Lines into Paths

The Join command and the Combine command have a lot in common. Just as Combine produces a single 2-D shape from several separate shapes, the Join command turns the 1-D lines and arcs you select into a single 2-D shape. For example, you can use the Join command to connect individual line segments into a single path. Although the Join command produces a 2-D shape, it only applies text and line formatting, not fill formatting, to the resulting shape. To join several lines and arcs, select the 1-D shape with the format you want to apply to the resulting shape, Shift+click the other shapes you want to join, and then choose Shape ➤ Operations ➤ Join.

Breaking Shapes into Lines and Arcs

The Trim command breaks shapes into separate lines and arcs. You can use lines to denote break points for the Trim command just as you can for the Fragment command. Visio converts shapes and lines into separate pieces wherever the lines intersect. For example, if you want to turn a long free-form curve into several
shorter pieces, you can draw lines through the curve where you want to split it and then use the Trim command to break it into separate curves. Select the shape with the format you want to apply to the resulting shape, Shift-click the other shapes you want to trim, and then choose Shape ➤ Operations ➤ Trim.

**Creating Parallel Lines and Curves**

You can quickly create parallel lines, grids, cross-hatching, concentric circles, or other repeating patterns with the Offset command. When you use the Offset command, it creates a set of parallel lines or curves at the distance you specify on both sides of the original shape, as shown in Figure 32-10. Unlike other shape operations, Offset does not delete the original shape. For example, if you use Offset on a single line, you end up with three equally spaced lines, the original in the middle and the two new ones on either side. To create parallel lines or curves, follow these steps:

1. Select a shape and choose Shape ➤ Operations ➤ Offset.
2. In the Offset dialog box, type the offset distance and click OK. Visio creates the additional lines on either side of the original.

*Figure 32-10: Offset creates new shapes on either side of the original shape.*
Reversing Line Ends
Sometimes, you draw a line in the wrong direction, such as lines with arrowheads. If the line direction is important, as in data flow diagrams, you can correct your error without recreating the line. To switch the start and end points of a line, select the line and then choose Shape ➪ Operations ➪ Reverse Ends.

Creating Curves from Lines
The Fit Curve command transforms lines with multiple segments into curves. Unfortunately, this command can produce very different results depending on the settings and error tolerance you choose. The only solution is trial and error. If you don’t like the results you obtain, press Ctrl+Z to undo those changes and try different settings. To create a free-form curve from a connected series of line segments, follow these steps:

1. Select the path that you want to convert to a curve and choose Shape ➪ Operations ➪ Fit Curve.
2. To create a curve that exactly fits the vertices of the selected path, use the default settings in the Fit Curve dialog box and click OK.
3. If you want to produce a simpler curve with fewer points, type a larger value in the Error Tolerance box and then click OK.

You can specify how Visio transforms a path into a combination of lines, arcs, and splines by setting the following curve parameters:

- **Periodic splines** — Check this check box to create a seamless spline from a closed and smooth shape. If the original shape is not smooth, uncheck the Cusps and Bumps check box to smooth sharp angles in the original shape.
- **Circular arcs** — Check this check box to replace the vertices in a path with either circular arcs or line segments.
- **Cusps and bumps** — Check this check box when you want to preserve sharp angles in the original shape.

Customizing Connection Points
Connection points identify locations on shapes where you can easily glue connectors and other shapes. If you want to glue to other positions, you can add connection points to any shape, regardless of whether it’s a built-in Visio shape or a custom one you created. You can also move connection points to other positions on a shape.
Connection points are available in different types. By specifying the connection point type, you can control how shapes connect. For example, you can use connection point types to ensure that the wiring on an electrical plan connects to electrical outlets the way it should in the real world.

**Adding, Moving, and Deleting Connection Points**

You can add, move, or delete connection points on any shape on a drawing. If you want to modify the connection points on a built-in Visio master, create a custom copy of the master and then edit the connection points the way you want.

To select the Connection Point tool, click the arrow next to the Connector tool on the Standard toolbar and then choose Connection Point Tool. To work with connection points, use one of the following methods:

- **Add a connection point** — Select a shape and click the Connection Point tool. Ctrl-click the selected shape at the position where you want the new connection point. As soon as you press Ctrl, Visio changes the pointer to blue crosshairs so that it’s easier to position the connection point.

  Make sure that the shape you want to edit is selected before adding a connection point. Visio creates connection points only for the selected shape, even if you click a position on a different shape.

- **Delete a connection point** — Click the Connection Point tool and select a connection point on a shape. When the connection point turns magenta, indicating it is selected, press Delete.

- **Move a connection point** — Click the Connection Point tool and select a connection point on a shape. When the connection point turns magenta, indicating it is selected, drag it to a new location.

**Working with Types of Connection Points**

For some drawing types, such as electrical plans or piping and instrumentation diagrams, you glue shapes to each other instead of connecting them with linear connectors. In the systems that these diagrams represent, components connect in specific ways. For example, it’s important that you connect the wiring to an electrical outlet the correct way or sparks will fly. Visio provides different types of connection points so you can control how shapes glue together.
Understanding Types of Connection Points

Visio provides three types of connection points to model the way components connect in the real world. Built-in Visio shapes already include the types of connection points needed to glue them properly. However, if you’re creating your own shapes and solutions, it’s important to understand how the three types work so that you can choose the right ones for your shapes:

✦ **Inward connection point** — Connects to end points of 1-D shapes (such as connectors), Outward connection points, and Inward & Outward connection points. It is the default connection point type used almost exclusively on drawings in which connectors connect shapes, such as organization charts. Visio indicates Inward connection points with a blue X. If you position a shape with an Inward connection point over another Inward connection point, the shapes won’t glue together.

✦ **Outward connection point** — Connects to Inward connection points, Inward & Outward connection points, shape geometry, and 1-D endpoints. For example, the Work Peninsula shape on the Cubicles stencil includes an Outward connection point. You can glue a Work Peninsula shape to the connection points on Work Surface or Corner Surface shapes, but you can’t glue two Work Peninsula shapes together, because in real life, the resulting cubicle arrangement wouldn’t stand up. Visio indicates Outward connection points with a blue square.

✦ **Inward and Outward connection point** — Connects to all types of connection points. For example, modular furniture on the Office Furniture stencil include Inward & Outward connection points so you can glue the components together in any order. The indicator for Inward & Outward connection points appropriately looks like a combination of the blue X of an Inward connection point and the blue square of an Outward connection point.

If shapes don’t glue the way you would expect, you might be trying to glue the wrong connection points together. Refer to Table 32-2 for a quick reference of valid connection points.

<table>
<thead>
<tr>
<th></th>
<th>Inward connection points</th>
<th>Outward connection points</th>
<th>Inward and Outward connection points</th>
<th>Shape geometry points</th>
<th>1-D shape end points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inward connection point</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Outward connection point</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Inward and Outward connection point</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Changing the Type of Connection Point

By default, Visio adds Inward connection points when you use the Connection Point tool. However, you can modify the type of connection point so your shape glues to the points you want. You can change connection points on shapes on drawings or on masters in custom stencils. If you want to change the type of connection point for a built-in shape, create a custom version of the shape and then change the connection point. To change the type of connection points, follow these steps:

1. Click the Connection Point tool on the Standard toolbar.

   Note
   If the Connection Point tool is not visible, select it by clicking the arrow next to the Connector tool on the Standard toolbar and then choosing Connection Point tool.

2. Right-click the connection point you want to modify. After it turns magenta, choose the type of connection point you want from the shortcut menu.

   Note
   In Visio 2002, you could also specify an angle for a connection point, to glue shapes at a specific angle. In Visio 2003, this feature is no longer available.

Customizing Shape Behavior

In addition to the visible components of a shape that appear on a drawing page and the connection points that control how shapes connect to each other, you can customize dozens of behaviors exhibited by shapes. For example, you specify what Visio highlights when you select a shape, whether a shape prints, how you can resize a shape, what happens when you double-click it, or how you can place it on a drawing. You can customize the behavior of any shape on your drawings or the masters in your custom stencils. If you want to customize the behavior for a built-in shape, create a custom version of the shape and then specify the behaviors you want.

You can define more advanced behaviors for shapes by modifying formulas in a shape’s ShapeSheet, as described in Chapter 33.

Specifying Double-Click Behavior for Shapes

By default, when you double-click a shape, Visio opens the shape’s text block so you can edit its text. However, you can choose from several other actions if you want the shape to perform another action when you double-click it. You can direct a shape to perform more complex actions by running a macro when you double-click the shape. To specify the action that occurs when you double-click a shape, follow these steps:
1. Right-click the shape you want to customize and choose Format  Behavior from the shortcut menu.

2. Select the Double-Click tab and choose one of the Double-Click options, described in Table 32-3.

3. Click OK. Confirm that the behavior works the way you want by double-clicking the shape.

<table>
<thead>
<tr>
<th>Double-Click Option</th>
<th>Resulting Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform Default Action</td>
<td>Performs the default double-click action defined for the shape</td>
</tr>
<tr>
<td>Perform No Action</td>
<td>Does nothing when you double-click the shape</td>
</tr>
<tr>
<td>Edit Shape’s Text</td>
<td>Opens the shape’s text block so you can edit its text</td>
</tr>
<tr>
<td>Open Group in New Window</td>
<td>When you select a group, this option opens the group in the group editing window so that you can modify the group. This option is not available if you select a shape.</td>
</tr>
<tr>
<td>Open Shape’s ShapeSheet</td>
<td>Opens the ShapeSheet for the shape</td>
</tr>
<tr>
<td>Custom</td>
<td>If you define a custom behavior in the EventDblClick cell in the Events section of the shape’s ShapeSheet, this option is selected. However, the option is always dimmed.</td>
</tr>
<tr>
<td>Display Help</td>
<td>Displays a help topic for the shape. To specify a help topic, enter either FILENAME!keyword or FILENAME!#number, where FILENAME is the name of a .hlp or .chm Windows help file, keyword is a term associated with the help topic, and number is an ID referenced in the MAP section of the help project file.</td>
</tr>
<tr>
<td>OLE Verb</td>
<td>When you select a linked or embedded object, this option activates an OLE command, such as Open. This option is not available when you select a Visio shape.</td>
</tr>
<tr>
<td>Run Macro</td>
<td>Runs the macro or add-on that you select in the drop-down list. The list box includes your custom macros as well as built-in Visio tools, such as Database Update.</td>
</tr>
<tr>
<td>Go to Page</td>
<td>Jumps to the page number specified in the drop-down list. To open the page in a new window, check the Open in New Window check box.</td>
</tr>
</tbody>
</table>
If you define a custom formula for a shape in its ShapeSheet, you can overwrite the custom behavior by choosing a double-click behavior other than Custom. However, if you protect the custom formula with the Guard function, Visio ignores the double-click option you choose and uses the custom formula instead.

### Specifying Placement Behavior

You can specify how a 2-D shape reacts when you use the Layout and Routing tools. For drawings in which connections are key components that convey critical information, such as database models, built-in shapes are already configured to behave the way you would expect. However, you can specify whether Visio lays out and routes around a shape, and, if it does, what happens when you place the shape on a drawing page.

**Note**

Because Placement options apply only to 2-D shapes, they are not available in the Behavior dialog box when you select a 1-D shape.

To specify Placement behaviors for a shape, follow these steps:

1. Right-click a shape and choose Format ➪ Behavior from the shortcut menu.
2. Select the Placement tab and specify the Placement options you want for the shape. Table 32-4 describes the options.
3. Click OK.

<table>
<thead>
<tr>
<th>Placement Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Placement Behavior</td>
<td>Specifies whether Visio always lays out and routes around a shape, ignores the shape during layout, or decides what to do based on the type of connector you glue to the shape. If you choose Let Visio Decide, Visio lays out the shape when you glue a Dynamic connector to it.</td>
</tr>
<tr>
<td>Do Not Move During Placement</td>
<td>Prevents Visio from moving the shape during automatic layout.</td>
</tr>
<tr>
<td>Allow Other Shape to Be Placed on Top</td>
<td>Allows Visio to place other shapes on top of the shape during automatic layout. To ensure that every shape on a page is visible, uncheck this check box.</td>
</tr>
</tbody>
</table>
Table 32-4  (continued)

<table>
<thead>
<tr>
<th>Placement Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Shapes Away on Drop</td>
<td>Specifies whether the shape moves other shapes out of the way when you reposition it on the page. You can choose to keep other shapes where they are, always move other shapes away, or use the option specified in the Page Setup dialog box. This option overrides the Move Other Shapes Away on Drop option on the Layout and Routing tab in the Page Setup dialog box.</td>
</tr>
<tr>
<td>Do Not Allow Other Shapes to Move This Shape Away on Drop</td>
<td>Specifies whether the shape remains where it is when other shapes are dropped onto the page, regardless of which Move Other Shapes Away on Drop option you choose.</td>
</tr>
<tr>
<td>Route Through Horizontally</td>
<td>Specifies whether connectors can route through the shape horizontally. Uncheck this check box if you want Visio to route around the shape.</td>
</tr>
<tr>
<td>Route Through Vertically</td>
<td>Specifies whether connectors can route through the shape vertically. Uncheck this check box if you want Visio to route around the shape.</td>
</tr>
</tbody>
</table>

Modifying Other Shape Behaviors

In addition to Double-Click and Placement behaviors, you can specify a variety of other behaviors for shapes on the Behavior tab of the Behavior dialog box. For example, you can specify the following:

✦ Whether a shape acts like a line or a 2-D shape
✦ Whether connectors split when you drop shapes on them
✦ Which elements are highlighted when you select a shape
✦ How you can resize a shape
✦ How groups behave

Preventing Shapes from Printing

If you want to add reference shapes to a drawing, such as construction lines or notes to colleagues, you can view them while you work on the drawing but prevent them from printing. To prevent a shape from printing, right-click the shape, choose Format ➤ Behavior, and select the Behavior tab. Check the Non-printing Shape check box under the Miscellaneous heading and click OK.
Switching Between 1-D and 2-D Behavior

No matter what a shape looks like, you can make it behave like a 1-D line or a 2-D shape. For example, if you define a line as a 2-D shape, you drag its selection handles to turn it into a rectangle. Conversely, you can create a shape with 2-D graphics, such as the Fancy Arrow shape on the Basic Shapes stencil, and make it act like a line. You can change the thickness of the Fancy Arrow shape by dragging its side selection points, but you can glue only to its start and end points.

To specify whether a shape behaves like a 1-D or 2-D shape, follow these steps:

1. Right-click the shape you want to switch, choose Format ➪ Behavior, and select the Behavior tab.
2. Under Interaction Style, select the Line (1-dimensional) or Box (2-dimensional) option, and then click OK.

Caution

Switching a shape’s behavior from 1-D to 2-D or vice versa can produce unexpected results, because this option changes the contents of the shape’s ShapeSheet. For example, it can break customized formulas you define in the ShapeSheet or glued connections between the shape and other shapes.

Showing That a Shape Is Selected

You can specify the elements that Visio highlights when you select a shape. To highlight different shape elements, right-click the shape and choose Format ➪ Behavior from the shortcut menu. Select the Behavior tab and then specify one or more of the following options under the Selection Highlighting heading:

✦ Show Shape Handles — Check this check box to display the shape’s selection handles.

Caution

If you uncheck Show Shape Handles, you can move the shape but won’t be able to resize it. If you uncheck Show Control Handles, you can activate the editing features that the control handles provide, but you must know where the control handles are without seeing them.

✦ Show Control Handles — Check this check box to display the shape’s control handles.

✦ Show Alignment Box — Check this check box to see the alignment box for the shape.

Note

If you uncheck all the Selection Highlighting options, Visio provides no visual indication that the shape is selected.
Controlling the Splitting of Connectors

If you work on a data flow diagram and realize that you’ve missed a process, the easiest solution is to drop a shape onto the connector where you want to insert the process, have Visio split the connector, and glue the two connector pieces to the new shape. You can specify exactly that behavior with the following options under the Connector Splitting heading in the Behavior dialog box:

✦ **Connector Can Be Split By Shapes** — When you select a connector, you can check this check box so that Visio splits the connector in two when you drop a shape that splits connectors onto it.

✦ **Shape Can Split Connectors** — When you select a shape, you can check this check box so that Visio splits a connector that can be split when you drop the shape onto it.

For these splitting options to work, you must also check the Enable Connector Splitting option on the Layout and Routing tab of the Page Setup dialog box and on the General tab of the Options dialog box.

Controlling Group-related Behaviors

Although groups are comprised of shapes, the groups are entities with properties and behaviors of their own. For shapes that belong to a group, you can control how a shape resizes. For groups, you can also specify how you add shapes to groups, select groups, and display group text and data.

To specify group-related behaviors, right-click the shape or group and choose Format ➪ Behavior from the shortcut menu. Select the Behavior tab and then choose one or more of the following behaviors:

✦ **Resizing shapes in groups** — In a predefined office cubicle, you don’t want to change the size of the work surfaces or partitions, because they represent the actual size of the furniture that the manufacturer delivers. Conversely, if you create a group of cells to create a tabular form, you might want the cells to change size as you increase or decrease the size of the table. To control how a shape resizes when it belongs to a group, choose one of the following options under the Resize Behavior heading:

  • **Scale with Group** — Select this option to have the shape resize proportionally when you resize the group. This is helpful when the shapes don’t represent real-world dimensions.

  • **Reposition Only** — Select this option to have the shape remain the same size when you resize the group. For example, if you create a group to represent a kitchen, you can set the appliances to Reposition Only so you can rearrange them within the kitchen, but not change their dimensions.

  • **Use Group’s Setting** — Select this option to have the shape resized based on the Resize behavior defined for the group.
✦ Adding shapes to groups — You can always add shapes to groups by selecting the shape and group and choosing Shape ➪ Grouping ➪ Group. However, you can also choose whether to use a drag and drop shortcut for adding shapes to groups. To control the methods you can use to add shapes to groups, use the following options:

- **Add Shape to Groups on Drop** — Check this check box under the Miscellaneous heading to add a shape to a group that accepts dropped shapes. To ensure that a shape remains separate no matter what option is set for a group, uncheck this check box.

- **Accept Dropped Shapes** — Check this check box under the Group Behavior heading if you want a group to absorb a dropped shape whose Add Shape to Groups on Drop check box is checked. For self-contained groups, such as factory-configured equipment, uncheck this check box if you want to prevent shapes from joining the group.

✦ Selecting shapes and groups — In some groups, such as office workstations, the group is the important element. You’re more likely to select the group so you can arrange your office space. For other groups, such as a title block, you usually want to select the shapes within the group to add the text to identify your drawing. To specify whether clicking selects the group or a shape within the group, choose one of the following options in the Selection drop-down list:

- **Group Only** — Select this option to prevent the selection of shapes within a group. By doing so, you can only edit the shapes within the group when you ungroup them.

- **Group First** — Select this option to select the group the first time you click and then subselect the shape within the group upon subsequent clicks.

- **Members First** — Select this option to select the shape within a group the first time you click and then select the group with the next click.

✦ Snapping in groups — If you want to snap and glue to shapes in a group, such as connecting cables to the Equipment shapes within a Cubicle group, check the Snap to Member Shapes check box under the Group Behavior heading.

✦ Displaying and editing text — To specify the display and editing of group text, choose one of the following:

- **Edit Text of Group** — Check this check box under the Group Behavior heading if you want to add text for the group. For example, you can use the group text box to show the model number for an office workstation.

- **Hide** — Select this option in the Group Data drop-down list to hide the group text box.

- **Behind Member Shapes** — Select this option in the Group Data drop-down list to display the group text behind the shape text.

- **In Front of Member Shapes** — Select this option in the Group Data drop-down list to display the group text in front of the shape text.
Adding Screen Tips to Shapes

If you’re creating shapes for others to use or want to show additional information about a shape on a page, you can customize shapes with ScreenTips that appear when you position the pointer over the shapes. Use one of the following methods to add or edit ScreenTips:

- **Add a ScreenTip**—Select the shape to which you want to add a ScreenTip and then choose Insert ➪ Shape ScreenTip. Type the text for the ScreenTip and click OK.
- **Edit a ScreenTip**—Select the shape and choose Insert ➪ Edit Shape ScreenTip. Edit the text the way you want and then click OK.
- **Delete a ScreenTip**—Select the shape and choose Insert ➪ Edit Shape ScreenTip. Delete the text in the Shape ScreenTip dialog box and click OK.

Working with Custom Properties

You can store data along with the graphics in your drawings by associating custom properties with shapes. With data attached to shapes on your drawings, you can search for shapes based on values in custom properties, review shape property values as you work, annotate your shapes by displaying properties in shape text blocks, and produce reports from shape data.

You can also use custom properties to configure the appearance of a shape. For example, by specifying a value for the Slices custom property associated with a Pie Chart shape, you can create or modify a Pie Chart shape to contain that number of slices. Configuring shapes with custom properties requires that both custom properties and programming be defined in a shape’s ShapeSheet. To learn how to configure a shape using custom properties and the ShapeSheet, see Chapter 33.

If you want to add the same set of properties to several masters or shapes, you can reuse custom properties and apply them in groups by creating custom property sets. For example, many of the shapes in the Business Process stencils include Duration, Cost, and Resources properties so you can track process statistics. In the Custom Property Set window, you can create, rename, or delete custom property sets and assign custom properties to those sets. You can also apply the properties in custom property sets to all the shapes you want at one time.

In Visio 2002, custom property sets were a feature of the Edit Custom Property Set add-on. In Visio 2003, Custom Property Sets is a command on the Tools menu. In addition, you can now apply more than one custom property set to shapes.
To store data in custom properties after they are associated with shapes, follow these steps:

1. Open the Custom Properties window by choosing View ➪ Custom Properties Window.
2. Select a shape to display its properties in the Custom Properties window. If the shape doesn’t contain any custom properties, the window displays the text No Custom Properties.

For some shapes, you can open the Custom Properties dialog box by right-clicking the shape and choosing Properties from the shortcut menu. After the dialog box is open, you can enter or edit values and click OK when you are finished.

3. To enter a value, click the property you want to edit and type the value in the box or click a value in a drop-down list.

If you aren’t sure what a custom property represents or what format you should enter, you can display the prompt for a property by pointing to the property label in the Custom Properties window.

### Creating and Editing Custom Properties

Whether you want to store data in shapes or annotate shapes with custom property values, you must first create custom properties and associate them with your masters or shapes. Although you can add custom properties to individual shapes on a drawing, it’s easier to apply custom properties to masters so that the instances you create on drawings already contain the properties you want.

When you add or edit custom properties for masters, you can control the scope of your changes by choosing the stencil in which you make your changes. If you want every instance you create in the future to incorporate your changes, edit the master in the Visio stencil. However, if you only want to change the instances on your current drawing, edit the master in the Document stencil for that drawing.

### Defining Custom Properties

Whether you create individual properties or define them through custom property sets, the real work of defining a custom property occurs in the Define Custom Properties dialog box. You can define new properties for shapes and masters by specifying options, as described in Table 32-5. When you select a shape that already contains custom properties, the Define Custom Properties dialog box displays those properties at the bottom of the dialog box. You can modify the options for these properties or delete them from the shape or master.

In Visio 2003, you can specify the language used to format a date as well as the calendar to use.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Label</strong></td>
<td>Consisting of alphanumeric characters and underscore characters, the label is the name of the custom property and appears next to the field in which you enter the property value.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>The data type for the property, including String, Number, Fixed List, Variable List, Boolean, Currency, Date, and Duration.</td>
</tr>
<tr>
<td><strong>Language</strong></td>
<td>Specifies the language to correctly format the date and time when you create a Date property. For example, English (U.S.) uses mm/dd/yy, whereas English (U.K.) uses dd/mm/yy.</td>
</tr>
<tr>
<td><strong>Calendar</strong></td>
<td>Specifies whether to use the Arabic Hijri (Islamic), Hebrew Lunar (Jewish), Saka Era (Hindu), or Western (Gregorian) calendar to convert a date entered in a Date property.</td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td>The format for the data type. The options available depend on the Type and Calendar options selected. You can select from lists of predefined formats when you define data types such as String, Number, Fixed List, Variable List, Currency, Boolean, Date, and Duration. To specify fixed lists or variable lists, type each item in the list separated by semicolons. For example, you can create a color list by entering <code>red;white;blue</code>. If you create a fixed list, you can only select one of the entries on the list. With variable lists, you can enter another value, such as <code>green</code>.</td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td>Specifies the initial value for the property. For existing properties, this box shows the current value. Omit this value if you want the property to be blank initially.</td>
</tr>
<tr>
<td><strong>Prompt</strong></td>
<td>Specifies text that appears when you select the property in the Custom Properties dialog box or pause the pointer over the custom property label in the Custom Properties window. You can use the prompt to see a description of the property or instructions on its use.</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Displays the existing custom properties for a shape. When you select a property in the list and modify it, Visio applies the changes you make to its definition immediately.</td>
</tr>
<tr>
<td><strong>New</strong></td>
<td>Creates a new custom property</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Deletes the custom property selected in the Properties list</td>
</tr>
</tbody>
</table>

In Developer mode, you can also do the following: specify the order in which custom properties appear in the Custom Properties dialog box and Custom Properties window, hide the property, or prompt users to enter custom property information when they create, duplicate, or copy shapes.
To define, edit, or delete custom properties for a shape or master, follow these steps:

1. Select the shape or master to which you want to add a property by using one of the following methods:
   - **Add to shape** — Select the shape on the drawing page.
   - **Add to master** — Right-click the custom stencil’s title bar and click Edit Stencil. Right-click the master and choose Edit Master➪Edit Master Shape. Select the shape in the master drawing window.
   
   You can edit a master in a stencil to modify all future instances of the master. To modify existing instances in the current drawing, edit a master on the Document stencil.

   - **Add to page** — Click any blank area of the page to ensure that nothing is selected.

2. Choose Shape➪Custom Properties. If Visio asks if you want to define custom properties, click Yes. If the shape already contains custom properties and the Custom Properties dialog box appears, click Define.

3. Choose one of the following tasks:
   - **Create a property** — If the shape has no custom properties assigned, you can begin specifying the property options for the default property, Property1. If the shape already has at least one custom property, click New.

   When you define custom properties in the Define Custom Properties dialog box, you can’t copy properties from one shape to another. To reuse custom properties, add them to custom property sets and apply those sets to your shapes and masters.

   - **Edit a property** — Select the property you want to edit in the Properties list and make the changes you want to the Label, Type, Language, Format, Calendar, Value, and Prompt options.

   - **Delete a property** — Select the property you want to delete in the Properties list and click Delete.

   If a shape has predefined custom properties, deleting them might affect the shape’s behavior.

4. When you have finished working with the custom properties, click OK.

5. If you worked with properties for a shape, you’re finished. If you added, edited, or deleted custom properties for a master, click the Close button in the master drawing window. When Visio prompts to update the master, click Yes and then save the stencil.

   If you edit a master in the Document stencil, Visio will update the master as well as all the shapes in the drawing file based on that master.
Displaying Custom Properties in Shape Text

To annotate shapes with custom properties, you can include in the shape’s text block a field that references the custom property. Text blocks can contain as many fields as you want and you can format the fields just as you can format text. For example, you can display multiple custom properties, such as an employee’s name and telephone extension. To display a custom property in a shape’s text block, follow these steps:

1. Select a shape on a drawing or a master in an editable stencil to which you want to add a text field and choose Insert Field.
2. In the Category list, select Custom Properties.
3. In the Field list, select the custom property you want to display in the text block.
4. In the Format list, select the format you want to apply to the custom property value.

To add more than one property to a shape or master’s text box, as demonstrated in Figure 32-11, follow these steps:

1. Double-click the shape or master to open its text block. Position the insertion point in the text where you want to insert the field for the property.
2. Choose Insert Field, select Custom Properties in the Category list, select the property you want to insert, select the format you want to apply, and click OK.
3. Position the insertion point in the shape’s text block where you want to insert text or another custom property field. Type the text or repeat step 2 to add another field.

Using Custom Property Sets

Custom property sets provide an easy way to define or modify a group of custom properties and apply them to multiple shapes. After you create and name a custom property set, you can add the properties you want to it or modify the definitions of
its properties. When you have configured the custom property set the way you want, you can apply the collection of properties in the set to the selected shapes on a drawing page, the Document stencil, or any open editable stencil.

Custom property sets also simplify adding custom properties to shapes that weren’t created by dragging masters from stencils. For example, built-in Workstation shapes on the Cubicles stencil include a dozen different custom properties. You can create a custom property set from the properties associated with a built-in Workstation shape. If you import additional Workstation shapes or create you own, you can easily associate those custom properties to your new shapes by applying the custom property set to your selected Workstation shapes or masters.

**Creating Custom Property Sets**

You can create custom property sets from scratch, but it’s often easier to create them from the properties associated with a shape, or to expand on a custom property set that already exists. For example, you can create a new custom property set based on the properties assigned to TQM shapes: Cost, Duration, and Resources. You might add Work and Department properties and then apply the new custom property set to all the masters in your custom TQM Shapes stencil.

To create a new custom property set, follow these steps:

1. If you intend to create a custom property set based on the properties associated with a shape or master, select the shape on a drawing page or a master in an editable stencil.

2. Choose Tools ➪ Custom Property Sets and click Add in the Custom Property Sets window.

3. Type the name for the set in the Name box, choose one of the following options, and then click OK:

   - **Create a New Set** — Creates a custom property set with the name you specify and no properties in it initially

   - **Create a New Set From the Shape Selected in Visio** — Creates a custom property set with the name you specify and all of the properties associated with the shape or master you selected in step 1

   - **Create a New Set From an Existing Set** — When you select this option, you can choose an existing custom property set from a drop-down list that contains the custom property sets available in every open drawing

Visio creates the custom property set and stores it in the current drawing or stencil. To add properties to a set, modify properties in a set, or apply a set to shapes, see the following sections.
Editing Custom Property Sets

Within the Custom Property Sets window, shown in Figure 32-12, you can add or modify the properties in a custom property set, as well as rename or delete existing custom property sets. To make changes to custom property sets, use one of the following methods:

- **Rename a custom property set** — In the Custom Property Sets window, select the set you want to rename in the list and click Rename. Type the new name and press Enter.

- **Delete a custom property set** — In the Custom Property Sets window, select the set you want to delete in the list and click Delete.

- **Modify the properties in a custom property set** — In the Custom Property Sets window, select the set whose properties you want to modify and click Define. In the Define Custom Properties dialog box, create new properties, modify existing property definitions, or delete properties, as described in the section “Defining Custom Properties” earlier in this chapter. Click OK when you're done.

Applying Custom Property Sets to Shapes and Masters

You can apply custom property sets to different shapes and masters depending on where you save the custom property sets. When you create a custom property set in a drawing, the set is saved in the drawing file and you can apply the set to shapes on the drawing pages or to masters in the Document stencil. However, if you create a custom property set in a stencil, you can only apply the custom property set to the masters in the stencil.

In Visio 2002, you applied custom property sets using the Apply Custom Property Sets add-on, and you could only apply one custom property set at a time to a shape or master. If you applied a new set, Visio automatically removed the previous custom property set. In Visio 2003, you apply custom property sets within the Custom Property Sets window and you can add as many sets as you want. You can also specify whether to remove existing sets when you add new ones.
To apply custom property sets to shapes or masters, follow these steps:

1. Select the shape or master to which you want to apply the custom property set using one of these methods:
   - **Select shapes** — On a drawing page, select the shape you want.
   - **Select masters** — In an editable stencil, select the master you want.
   
   To select additional shapes or masters, Shift+click the other shapes or masters you want to add to the selection.

2. Choose Tools ➪ Custom Property Sets and then check the check boxes for all of the custom property sets that you want to apply in the list.

3. Choose an option to either apply the set to selected shapes or selected masters. If you want to remove the existing custom property sets from the selected shapes or masters, make sure the Remove Existing Property Sets check box is checked.

4. Click Apply.

### Producing Reports with Custom Property Data

Several Visio templates include predefined reports that you can run to view and analyze the data stored with the shapes in your drawings. However, you can also define and format your own reports. Although you can create new reports from scratch, you can also modify existing reports to match your requirements and then save the modified report with a new name.

### Defining Custom Reports

When you want to work on reports, choose Tools ➪ Reports. By default, Visio displays the reports specific to the type of drawing that is active. If you want to start with an existing report from another type of drawing, uncheck the Show Only Drawing-specific Reports check box to view all of Visio’s built-in reports. To create a new custom report, click New in the Reports dialog box. If you want to base your report on an existing report, select the report you want to base your new report on in the Report list and click Modify. Either way, the Report Definition Wizard steps you through the process of defining a report. When you have completed the report definition, Visio saves your report where you specify and adds it to the list of available reports. As you step through the Report Definition Wizard, you specify the following features of your report:
The objects on which you want to report

The properties you want to display in the columns of the report and any criteria you want to use to limit the results shown in the report

The format for the report, including how the contents are grouped and sorted and how numbers are formatted

The Save options for the report, including the report definition name, a description, and where Visio saves the report

The following sections describe how to use the features in each step of the wizard.

Selecting Shapes on Which to Report

The first step to defining a report is to choose the shape to scan for data. You can report on every shape in your drawing file, the shapes on the current page, or only selected shapes. You can also specify criteria to further limit the shapes that Visio scans by clicking Advanced. In the Advanced dialog box, you can define multiple criteria that shapes must meet for inclusion in the report. For example, to produce a report of the furniture for the Accounting department, you can specify that the Department property in shapes on the Furniture layer must equal Accounting.

You can limit the shapes used in one of the following ways:

- **Shapes on a layer** — Select the `<Layer Name>` property. You can include or exclude a layer from a report by selecting = or <> in the Condition box.

- **Shapes by name or ID** — You can use the `<Master Name>`, `<Shape Name>`, or `<Shape ID>` properties to specify the named shapes you want.

- **Shapes with specific custom properties** — Select the custom property, select Exists in the Condition list, and then select TRUE in the Value list.

- **Shapes with specific values in custom properties** — Select the custom property and then specify the condition and value for the property. For example, you can select Duration, >, and 5 to report on all processes whose duration is longer than five weeks.

- **AutoDiscovery shapes** — Select the `<Autodiscovery Shape>` property to report on shapes that result from using AutoDiscovery.

The conditions and values you can choose depend on the property that you select. However, Visio offers a limited number of conditional operators, such as =, <>, and >=.

To add an additional criterion, define the criterion and then click Add. To delete a criterion, select it in the Defined Criteria list and then click Delete. You can delete all the defined criteria by clicking Clear.

After you define criteria, click OK to close the Advanced dialog box and then click Next to continue selecting the properties for the report columns.
If Visio’s report capabilities are too limited, you can export shape data to another format and use an application with more robust reporting tools to produce your report. To learn how to export data, see Chapter 9. You can also store data in a database so that you can produce reports from the database application but display the data in Visio by linking the data to shapes. To learn more about linking shapes to databases, see Chapter 10.

**Choosing Report Columns**

In the screen for choosing properties, Visio displays default shape properties, such as `<Master Name>` and `<Height>`, in addition to custom properties and user-defined properties from the ShapeSheet User-Defined Cells section. Default shape properties appear within angled brackets in the list. To see user-defined properties from the ShapeSheet, check the Show All Properties check box.

Check the check box for each property you want to use as a column in the report. Click Next to continue grouping, sorting, and formatting your report.

**Grouping, Sorting, and Formatting Report Contents**

You can group, sort, and format report results in several ways. For example, you can produce a report that groups the office furniture by department, calculating the number of desks for each department, and sorting the report by the average furniture cost per department.

To group the results of your report and calculate group values, click Subtotals. Choose the property you want to use to group your results in the Group By drop-down list, which contains the properties you specified as columns for your report. You can also specify which rows appear in your report by clicking Options. For example, you can show all values, only unique values, only subtotals, or grand totals. You can also prevent duplicate rows from appearing in your report.

If you want to perform a calculation for your report, for each property in the Properties list, check the check boxes for the calculations you want. Count is available for any type of custom property, but the other calculations only work with numerical properties. If a calculation isn’t valid for a property, the check box is dimmed. When you perform a calculation, it calculates the value for each group in the report. If you create an ungrouped report, the calculation represents all entries. You can choose from the following calculations:

- **Count** — Calculates the number of shapes with the same value in a custom property. For example, if there are 16 shapes with the value “Accounting” in the Department property, Count returns 16.
- **Total** — Sums the value of all the entries in a group or all entries for an ungrouped report
- **Avg** — Calculates the average of property values in a group or the entire report
Part VI ✦ Customizing Templates, Stencils, and Shapes

✦ Max — Returns the largest number from the list of property values
✦ Min — Returns the smallest number from the list of property values
✦ Median — Calculates the median for a list of property values. In a group of numbers, the median is the number with an equal number of values greater and less than it.

You can arrange the order of the columns in your report as well as specify the sort order for rows by clicking Sort. To rearrange the columns in your report, select a column in the Column Order list and then click Move Up or Move Down to change its position in the column order.

You can sort the rows in a report with up to three properties. Choose the custom properties for the first sort in the Sort By list and select the Ascending or Descending option. You can specify one or two more sort properties in the two Then By lists, also specifying ascending or descending order. For example, you can sort a report of office furniture first by department, then by employee name, and finally by Shape Name if it indicates the type of furniture.

For custom properties with numeric values, you can specify the number of decimals in numbers and whether to show units. Click Format and then choose the number of places to the right of the decimal point in the Precision box. To show units, check the Show Units check box.

After you specify any grouping, subtotals, sorting, and formatting you want, click Next to continue to saving the report.

Saving Custom Reports

When you save a custom report, you name the report and choose a location in which to save the report definition file. To save a report, follow these steps:

1. Type the name that you want to appear in the Reports dialog box. Use a brief but descriptive name for each report so you can choose the report you want more easily. To further identify the report, type a detailed description in the Description box. This description appears in the Description box in the Reports dialog box.

2. Choose an option to either save the report in the current drawing file or to a .vrd file in a folder on your computer. If you save the report in the current drawing file, you can access the report whenever the drawing file is open.

   Saving a report to a .vrd file enables you to run the report for any Visio drawing file.


   The final step in the save process only saves the report. You must click Run in the Reports dialog box to run a report and view the results.
Running Reports with Custom Property Data

When you run a report, you can specify how to format the results: as an Excel spreadsheet, as an HTML file to display as a Web page, as an XML file, or within a Visio shape. To run an existing report or one you defined, follow these steps:

1. Open the drawing on which you want to report and choose Tools ➪ Reports.
2. Select the report you want to use. If you don’t see the report in the list, uncheck the Show Only Drawing-specific Reports check box.
3. Click Run.

Summary

You can customize shapes on your drawings in numerous ways or create brand-new shapes using Visio drawing tools and Shape Operation commands. To reuse customized shapes, you can save them as masters on custom stencils so you can drag masters onto drawing pages to create drawing shapes. In this chapter, you learned the concepts that make shapes and masters so smart. You also learned how to perform the following actions:

- Create masters
- Modify master graphics and properties
- Modify master icons
- Use drawing tools and Shape Operation commands to create or edit shapes and masters
- Configure connection points to control how shapes glue together
- Specify shape behavior, including what shapes do when you double-click them, how layout and routing lays them out, and whether shapes act like 1-D or 2-D shapes
- Create and apply custom properties to shapes and masters

In the next chapter, you learn how to further customize your shapes by modifying properties and creating formulas in ShapeSheets.
Customizing Shapes Using ShapeSheets

Throughout this book, you’ll run across tips and techniques that talk about making changes to a shape’s ShapeSheet when there’s no way to make a shape do what you want from a drawing page. In reality, a shape on a drawing page is merely the graphical representation of the Visio shape. You can use Visio commands and dialog boxes to control and modify many aspects of a Visio shape through its graphical representation. However, a ShapeSheet in Visio is a spreadsheetlike view that includes fields that control every shape feature. Each field includes values or formulas that specify the graphic elements of a shape, how the shape looks, and how it behaves.

A shape on a drawing page and the set of values and formulas in a ShapeSheet are two views of the same Visio shape. When you modify a shape on a drawing page, Visio changes the appropriate values in the shape’s ShapeSheet. Conversely, when you modify fields in a ShapeSheet, Visio changes the appearance or behavior of the shape on the drawing page.

Of course, not every shape requires a value for every field. For example, if a shape doesn’t use connection points, the ShapeSheet doesn’t waste space by filling in fields with connection point attributes. Even so, shapes require numerous fields to completely define their appearance and behavior. The ShapeSheet is organized in tabular sections so that you can target the section you want to modify and locate the field you want to change. For example, the Shape Transform section specifies attributes for the location, size, and rotation for a shape, whereas the Fill Format section specifies attributes for filled areas.

This chapter explains the different sections of the ShapeSheet and shows you how to create a ShapeSheet formula.
Viewing ShapeSheets

Because a ShapeSheet is another view of a shape, it opens in a separate window. You can open every ShapeSheet in the same ShapeSheet window or open a new window for every ShapeSheet you want to see. You can focus on the changes you want to make by specifying which sections of the ShapeSheet appear in the window. If you want to add functionality to a shape, you can insert sections that are applicable to the type of shape but not currently used.

Opening ShapeSheets

Each element in a Visio drawing has a ShapeSheet associated with it, as illustrated in Figure 33-1. To open the ShapeSheet for an element, select the element and then choose Window ➪ Show ShapeSheet. The title bar for the ShapeSheet window shows the Visio drawing file, the drawing page, and the shape represented in the window. To select a Visio element so you can open its ShapeSheet, use one of the following methods:

✦ **Shape, group, guide, guidepoint, or OLE object** — Click the element to select it and then choose Window ➪ Show ShapeSheet.

✦ **Shape in a group** — Subselect the shape by clicking once to select the group, clicking again to select the shape, and choosing Window ➪ Show ShapeSheet.

✦ **Master** — Open the master’s stencil for editing by right-clicking the stencil’s title bar and choosing Edit Stencil from the shortcut menu. Right-click the master and choose Edit Master from the shortcut menu. Select the master in the master drawing window and choose Window ➪ Show ShapeSheet.

✦ **Page** — To show a page ShapeSheet, click an empty area of the drawing page to make sure no shapes are selected and then choose Window ➪ Show ShapeSheet.

For more information about selecting shapes, see Chapter 4.

You can specify whether every ShapeSheet opens in the same window or a new window opens for each. If you want to compare values for more than one shape, the option for opening new windows enables you to view multiple ShapeSheets side by side. However, if you work on each ShapeSheet independently, one ShapeSheet window requires less of the screen. To specify ShapeSheet window options, follow these steps:

1. Choose Tools ➪ Options and select the Advanced tab.

2. To use only one ShapeSheet window, check the Open Each ShapeSheet in the Same Window check box. Leaving this check box unchecked opens a new window for each ShapeSheet you view.
Graphical representation of shape

Graphical representation of shape

Cells specify shape appearance and behavior

Figure 33-1: A shape on a drawing is a graphical view of shape attributes in a ShapeSheet.

Tip
If you access ShapeSheets frequently, you can display the Show ShapeSheet command automatically on every shape’s shortcut menu (shown by right-clicking the shape) by choosing Tools ➪ Options, selecting the Advanced tab, and checking the Run in Developer Mode check box.

Viewing and Adding ShapeSheet Sections

When you consider all the things you can do with Visio shapes, it should come as no surprise that Visio ShapeSheets can include numerous sections. In fact, there are thirty different sections that a shape might use, depending on its configuration and features. For example, one-dimensional shapes include the 1-D Endpoints section, whereas only shapes with control points use the Controls section. Visio adds the sections required to construct a shape to its ShapeSheet. However, you can show or hide those sections or add others. Table 33-1 shows some of the more commonly used ShapeSheet sections.
## Commonly Used ShapeSheet Sections

<table>
<thead>
<tr>
<th>Section</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-D Endpoints</td>
<td>Specifies the coordinates of each end point on a 1-D shape</td>
</tr>
<tr>
<td>Shape Transform</td>
<td>Specifies shape extent, the coordinates of its position on the drawing page, rotation, pin position, and more</td>
</tr>
<tr>
<td>User-defined Cells</td>
<td>Includes custom values or formulas, such as the Visio version, keywords used for searching shapes, and scaling formulas. For example, formulas and attributes for employee pictures in Organization Chart shapes are stored in this section.</td>
</tr>
<tr>
<td>Custom Properties</td>
<td>Includes the labels and values for the custom properties associated with a shape</td>
</tr>
<tr>
<td>Geometry</td>
<td>Each path in a shape has its own Geometry section. Each Geometry section contains coordinates for each vertex in a path and specifies attributes such as whether shapes can be filled.</td>
</tr>
<tr>
<td>Protection</td>
<td>Specifies lock settings that you can set by choosing Format ➤ Protection, as well as a few locking options available only in the ShapeSheet, such as LockGroup.</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>Includes fields for controlling various shape behaviors, some of which are available by choosing Format ➤ Behavior</td>
</tr>
<tr>
<td>Group Properties</td>
<td>Specifies group behaviors, such as whether a group accepts a dropped shape</td>
</tr>
<tr>
<td>Line Format</td>
<td>Includes settings for lines and line ends</td>
</tr>
<tr>
<td>Fill Format</td>
<td>Includes settings for fill formats</td>
</tr>
<tr>
<td>Paragraph</td>
<td>Specifies paragraph formatting as defined on the Paragraph tab after choosing Format ➤ Text</td>
</tr>
<tr>
<td>Text Block Format</td>
<td>Specifies text block formatting as defined on the Text Block tab after choosing Format ➤ Text</td>
</tr>
<tr>
<td>Text Transform</td>
<td>Specifies size and position of a shape’s text block</td>
</tr>
<tr>
<td>Events</td>
<td>Defines behavior in response to specific events, such as double-clicking or dropping the shape onto the drawing page</td>
</tr>
<tr>
<td>Shape Layout</td>
<td>Specifies settings for layout features as defined on the Layout and Routing tab of the Page Setup dialog box, as well as Placement Behavior settings</td>
</tr>
</tbody>
</table>

To learn how to print ShapeSheet sections, see Chapter 3.
To hide or show the sections in a ShapeSheet, right-click the ShapeSheet window and choose View Sections from the shortcut menu. Check a Section check box to show the section; uncheck a Section check box to hide it, as demonstrated in Figure 33-2. To quickly modify the sections that appear, click All or None and then check and uncheck sections you want or don’t want.

In the View Sections dialog box, the check boxes and labels for sections not currently in use appear dimmed. For example, the Scratch section is useful for adding custom formulas without affecting built-in features. It won’t appear in the ShapeSheet unless you add it. To insert a section that isn’t in use, right-click the ShapeSheet window and choose Insert Section from the shortcut menu. The Insert Section dialog box opens, showing the sections you can insert. Sections that don’t apply to the shape are dimmed. Check the check box for each section you want to insert and then click OK.

**Exploring ShapeSheet Sections**

The Visio ShapeSheet is a powerful tool that you can use to control every aspect of a shape. With thirty different ShapeSheet sections and numerous cells within each section, this part of the chapter highlights cells that are particularly useful and provides examples of their use. For a complete reference to the purpose of each section and cell, choose Help ➤ Developers Reference. In the Visio Help Table of Contents, expand Microsoft Office Visio ShapeSheet Reference and then expand Sections to learn about ShapeSheet sections. Expand Cells to learn what each cell can do.

**Tip**

You can also learn a lot about ShapeSheet cells and formulas by looking at the settings for some of the built-in Visio shapes. Select a built-in shape that you have dragged onto the drawing page and open its ShapeSheet.
Here are some examples of ShapeSheet cells and what you might do with them:

✦ **Shape Transform** — Controls the position and orientation of a shape:
  - **Width** — Use a formula to set a shape’s width based on the size of the picture it contains, as in the User.Width cell for an Organization Chart shape.
  - **Height** — Link this cell to a database field to define a shape’s height with a dimension stored in a parts database.

  ![Cross-Reference](image)

To learn about linking ShapeSheet cells to fields in external data sources, see Chapter 10.

- **LocPinX and LocPinY** — Use formulas to position the center of rotation of a shape based on the shape’s width and height. By default, the pin is located at the center of a shape, but you can position it wherever you want.
- **Angle** — Use a formula to constrain a shape’s rotation to multiples of ninety degrees, as the Balloon Vertical Callout shape does.

✦ **Geometry** — Each path in a shape has its own Geometry section, which contains coordinates for each vertex in the path, and attributes that control the path’s appearance:
  - **MoveTo** — Use a reference to the ShapeSheet cells for control handle coordinates to start a line at the location of a control handle, similar to the behavior of Dimensioning shapes.
  - **LineTo** — Use a reference to other cells in the Geometry section to intersect one line with another, also illustrated by Dimensioning shapes.
  - **EllipticalArcTo** — If you draw several lines and arcs with the Pencil tool and accidentally create an arc when you intended to draw a straight line, you can correct the mistake in the ShapeSheet. In the Geometry section for the Pencil tool path, it’s easy to spot arcs even if they look like straight lines on the screen, as shown in Figure 33-3. Click an EllipticalArcTo cell to highlight the vertex on the drawing page. When the correct vertex is highlighted, right-click the EllipticalArcTo cell and choose Change Row Type on the shortcut menu. Select LineTo to draw a straight line instead.
  - **Infinite Line** — You can convert a line drawn on the drawing page to an infinite line, which acts like a true construction line. In the Geometry section, right-click the LineTo cell for the line and then choose Change Row Type from the shortcut menu. Select Infinite Line to create a construction line.
  - **Geometry.NoFill** — By default, Visio changes the NoFill value from TRUE to FALSE when you close a path so that you can apply a fill format to closed shapes. If you use Shape Operation commands to create compound shapes, you can set the NoFill fields for each Geometry section to
TRUE or FALSE, depending on whether you want that geometry to accept fill formatting when you apply it. For example, if you transform a checkerboard of squares into one shape, you can set alternating squares to NoFill = TRUE. When you apply fill formatting to the shape, half the squares apply the fill format.

Figure 33-3: You can highlight a vertex and change the kind of line segment it defines from the ShapeSheet.

- **Miscellaneous** — This section provides cells to set various attributes, including handle selection and visibility. Many of these attributes can be modified by choosing options on the Behavior tab in the Behavior dialog box:
  
  - **NoObjHandles** — To ensure that a shape is not resized, hide its selection handles by setting this field to TRUE.
  
  - **Comment** — Use logical functions in formulas along with cell references to custom properties to display different comments, depending on the values in custom properties.
• **NonPrinting** — Use logical functions and cell references so that a shape that includes an infinite line doesn’t print.

• **NoAlignBox** — To prevent someone from snapping to a shape’s alignment box, hide the alignment box by setting NoAlignBox to TRUE.

• **DropOnPageScale** — Use formulas to specify scaling factors based on the scale for the drawing page.

✦ **Fill Format** — This section specifies fill formatting and shadows:

  • **FillForegnd** — Link this cell to a database field — for example, to show a Chair shape in the color specified by a catalog database.

  • **FillBkgnd** — Use the RGB function to specify the exact color you want, such as FillBkgnd = RGB(250,150,100) to create a sepia tone for a pattern background.

✦ **Group Properties** — This section specifies behaviors and other attributes for groups, not the individual shapes within them:

  • **DontMoveChildren** — If you can’t move a shape that you subselect within a group, change the value in this cell in the group’s ShapeSheet to FALSE.

  • **IsTextEditTarget** — Use formulas and cell references to make the group’s text block editable when the grouped shapes already include text.

✦ **Protection** — This section includes cells for locking different aspects of shapes, including some that can only be modified in the ShapeSheet, including the following:

  • **LockCustProp** — Locks custom properties so they can’t be edited

  • **LockCrop** — Locks an OLE object to prevent it from being cropped with the Crop tool

  • **LockGroup** — Locks a group so it can’t be ungrouped. If you drop a built-in master onto a drawing page and can’t move a shape within it, change this cell value to 1 in the group’s ShapeSheet to unlock the group.

  • **LockCalcWH** — Locks a shape’s selection rectangle so it doesn’t change when vertices are edited

  • **LockVtxEdit** — Locks shape vertices so you can’t edit them with drawing tools

✦ **Actions** — This section defines menu items on a shape’s shortcut menu or a shape’s SmartTags.

  • **Action** — Type the formula to execute when a user chooses the command from the shortcut or SmartTag menu, as demonstrated in Figure 33-4.

  • **Menu** — Specify the name of a menu item on a shortcut or SmartTag menu.

  • **Checked** — Indicates whether an item is checked

  • **Disabled** — Indicates whether an item is dimmed
Events — This section specifies the actions to take when events occur:

- **EventDblClick** — Specify a formula to execute when a user double-clicks a shape, such as editing the shape text block, as most shapes do by default.
- **EventDrop** — Specify a formula to execute when a user drops a shape onto the drawing page.

Custom Properties — This section defines the custom properties associated with a shape, as well as attributes about each property, such as language or sort order:

- **Ask** — If you want Visio to query the user to enter custom properties when an instance is created, set this cell to TRUE.
- **SortKey** — Influences the order in which items are listed in the Custom Properties window and dialog box
- **Type** — Specifies the data type for the property
✦ **User-defined cells**—You can specify formulas that you can reference from other cells. You can name the cells in this section so that references to them are meaningful. The cells in the Scratch section can also contain user-defined formulas, but you can’t name Scratch cells.

  • **Prompt**—Specify the prompt for the User-defined cell.

  • **Value**—Specify a formula. For example, Visio Organization Shapes include User-defined cells to specify employee photo attributes. Built-in scaled objects often include an anti-scaling User-defined field.

### Writing ShapeSheet Formulas

To Visio, anything you type in a ShapeSheet cell is a formula, whether it’s a numeric value, a reference to another cell, or a formula with functions and operators. You can write formulas for ShapeSheet cells to define the shape behavior you want. For example, you can specify that the height of a shape is always half its width by writing a formula in the Height cell in the Shape Transform section. Visio evaluates a formula and shows the results in units appropriate for the cell. You can display cell contents in a ShapeSheet window as either formulas or values.

Visio creates many formulas by default when you create a shape. For example, Visio positions a shape’s pin at the shape’s center by default. If you look in a ShapeSheet, you’ll see the following formulas:

\[
\begin{align*}
\text{LocPinX} &= \text{Width} \times 0.5 \\
\text{LocPinY} &= \text{Height} \times 0.5
\end{align*}
\]

To conserve file space and simplify the propagation of changes from masters to instances, Visio instances inherit formulas from masters whenever possible. Shape instances inherit formulas from their masters on the Document stencil and inherit formatting from style definitions stored with the drawing. However, you can write local formulas in any cell for an instance. A local formula replaces the formula inherited from the master and is shown in blue text in the ShapeSheet window. If you change the formula for that cell in the master, the local formula in the instance’s cell prohibits the inheritance of the master’s formula.

When a cell contains a local formula, the formula appears as blue text.

Visio automatically updates some cells when you change a shape. When you apply a style to a shape, Visio deletes local formulas in the related cells unless you check the Preserve Local Formatting check box in the Style dialog box. If you want to prevent local formatting formulas from being overwritten, you can use the `GUARD` function.
Learning More About Programming Shapes

Programming shapes and automating Visio provides enough material to produce a second volume to this book. However, if you want to learn more about how to use ShapeSheets to program shapes, you can find resources on the Microsoft Developer Network Web site at http://msdn.microsoft.com/visio. This site includes articles about Visio shape programming, Visio developers’ documentation, plus links to books, training resources, and much more. To find specific information, enter keywords in the Search For box on the site.

Exploring the Elements of Formulas

Visio formulas are similar to Excel formulas. They always start with an equals sign, although Visio inserts the equals sign automatically. A formula can comprise any of the following elements:

✦ Numbers
✦ Coordinates
✦ Boolean values
✦ Operators
✦ Functions
✦ Strings
✦ Cell references
✦ Units of measure

The ShapeSheet Reference explains how each element works and how to include it in formulas. To learn more about these elements, choose Help ➤ Developer Reference. In the Visio Help Table of Contents, expand Microsoft Office Visio ShapeSheet Reference and then expand Concepts. To learn how to insert elements into formulas, expand Procedures.

Creating Formulas

If you’re familiar with creating formulas in an Excel spreadsheet, you’ll find that ShapeSheet formulas work much the same way. You can select a cell and type a formula or double-click a cell to display the insertion point so that you can edit the formula. However, if you are developing a long formula, it’s easiest to select the cell and then edit the formula in the formula bar.
To create or edit a formula in the formula bar, follow these steps:

1. In the ShapeSheet window, click a cell to select it and display the formula in the formula bar.

2. Type the formula, for example to calculate the position of a shape’s pin, as shown here.

   \[ \text{LocPinX} = \text{GUARD} (\text{Width} \times 0.5) \]

3. To include a reference to another cell in the formula, type the name of the cell, such as Width in the LocPinX formula.

4. To include a function, type the function name and then type its parameters in parentheses, as in the \text{GUARD} function in the LocPinX formula. To choose the function you want from a list, position the insertion point where you want to insert the function in the formula and then choose Insert \&gt; Function. Select the function you want and click OK.

   \textbf{Tip}
   
   The \text{GUARD} function is used frequently to prevent a formula from being modified by actions performed on the drawing page, such as moving or resizing. Cells often affected by moving and resizing are Width, Height, PinX, and PinY.

5. To accept the formula, click the Accept button to the left of the formula bar or press Enter.

6. If the formula contains an error, Visio displays an error message box. Click OK in the message box. Visio highlights the area, if not the exact location, of the error in the formula.

7. After you correct the error, click Accept or press Enter.

   \textbf{Tip}
   
   If you want to add shapes to a scaled drawing but don’t want the shapes to scale, you can define a formula in the ShapeSheet to prevent the shape from scaling. You can read an article about scaling formulas at http://msdn.microsoft.com/library/default.asp?url=/library/en-us/devref/HTML/DVS_12_Scaled_Shapes_and_Measured_Drawings_487.asp. Type \text{Formula Scale Visio} in the Search For box on the MSDN Web site to find other topics about controlling scaling with the ShapeSheet.

**Summary**

ShapeSheets and shapes on drawing pages are just different views of the same Visio element. You can create and modify many aspects of Visio shapes by working on the drawing page. However, some shape settings are available only on a shape’s ShapeSheet. You can open each ShapeSheet in a separate window to compare values between ShapeSheets or open each ShapeSheet in the same window to save screen space.
You can also define formulas in a shape's ShapeSheet to specify how a shape appears or behaves based on shape settings, values in other ShapeSheet cells, or even values in an external database. Formulas in ShapeSheets are powerful, as demonstrated by the behaviors exhibited by built-in Visio shapes. You can learn about customizing ShapeSheets in the Visio ShapeSheet Reference by choosing Help ➪ Developers Reference. You can also study the ShapeSheets for built-in shapes to see how they use formulas to produce specific behaviors.
If you’re like most people, you choose a formatting command when you want to change the way lines, text, and fill look on your Visio shapes. There’s nothing wrong with that technique if you’re changing the appearance of one or two shapes. However, when you want to apply the same formatting to several shapes or to all the shapes of the same type, applying styles is faster and produces more consistent results.

Built-in Visio shapes practically format themselves when you drag them onto a drawing page. Shapes associated with a template often have a coordinated appearance and automatically conform to the color schemes you apply. When you use Visio templates and built-in stencils, the shapes you add usually have styles that specify the formatting they use. Styles can control the formatting for lines, text, and fill; and they include a variety of options, such as line ends, patterns, color, and fonts.

It’s easy to apply the same formatting to shapes by applying the same style to them. In addition, to change the formatting for all the shapes that use the same style, you redefine the style, rather than reset the formatting on every shape. Although Visio templates offer sets of styles designed to work together, you can customize styles and define new line, fill, and line end patterns to fit your needs.

This chapter shows you how to work with existing styles as well as create and edit styles. You’ll also learn how to define line patterns, such as dots and dashes, fill patterns for hatch patterns, and line end patterns for the marks at the ends of lines.
Working with Styles

If you’ve used styles in Microsoft Word, you’ll find the concepts for Visio styles to be similar. However, in Visio, styles involve formatting more than just text—a style represents a named collection of format settings, including line, text, and fill formats that you can apply to text blocks and shapes. Because a style defines the formatting for lines, text, and fill, you can format every aspect of a shape’s appearance by applying one style.

Cross-Reference

For more information about applying styles to shapes, see Chapter 7.

When you apply a style to a shape, the style definition specifies the formatting for the lines, text, and fill for that shape. By using styles, you can ensure that the appearance of similar shapes is consistent. However, you can also apply shape-specific formatting to override the style formatting. For example, you can change the fill color for Organization Chart shapes that represent vacant positions that are about to be filled. This formatting that you apply manually with Format Text, Format Line, or Format Fill commands is known as local formatting because Visio stores the formatting locally with the shape. When you manually format shapes and then apply a style to those shapes, the styles overwrite the formatting settings for those shapes by default, removing your local formatting. You must check the Preserve Local Formatting check box in the Format Style dialog box if you want Visio to retain any manual formatting you’ve applied.

Note

Visio does not apply colors for a color scheme to shapes with local formatting, because color schemes function by redefining the colors associated with styles. Because local formatting overrides style formatting, your locally formatted shapes keep the color you assign. However, if you restore the original styles to shapes, they automatically conform to the current color scheme.

Assigning Default Styles to Drawings

Every Visio template includes a few basic predefined styles as well as styles specific to the template. For example, every template includes Guide, No Style, None, Normal, and Text Only styles. The Guide style applies formatting so that guide lines appear as dotted, blue lines, by default. The None style, as you would expect, formats elements by removing lines and fills and applying a basic text formatting to text. When you create your own templates by saving Visio drawing files, the styles in the drawing file are available automatically for every new drawing file you create using the template.

In addition, you can specify the default styles Visio applies when you draw shapes with drawing tools. Click an empty area on the drawing page to make sure that no shapes are selected. Choose Format ➪ Style, select the styles you want to use as defaults in the Text Style, Line Style, and Fill Style drop-down lists, and then click OK.
Style lists control which types of style formatting you apply. You can apply a specific type of formatting for a style, such as line formatting, or apply each type of formatting that the style specifies. When you work with styles but want manual formatting to remain, you can specify options to preserve your local formatting. In addition, you can protect your shapes in various ways so that formatting won’t change. If all else fails, you can start over by restoring the default styles for a shape. Use one or more of the following methods to apply styles to your shapes:

✦ **Apply specific types of formatting** — Choose a style from the style lists on the Format Shape or Format Text toolbars to apply text formatting, line formatting, or fill formatting. If the style you choose includes other types of formatting as well, Visio asks whether you want to apply those formats.

✦ **Apply all types of formatting** — Choose Format ➤ Style to select a style for each type of formatting.

    Tip

If the formatting you apply isn’t what you want, press Ctrl+Z to undo the formatting.

✦ **Preserve local formatting** — If you want to apply styles to shapes without resetting any local formatting that you’ve applied, choose Format ➤ Style, select the styles you want to apply, check the Preserve Local Formatting check box, and click OK.

✦ **Formatting locked shapes** — Shapes can be locked in two different ways, but you can remove these locks if you want to format the shapes in question. When you see an error message about shape protection preventing the execution of your command, that means the shape is locked against formatting. To remove this formatting lock, right-click the shape, choose Format ➤ Protection from the shortcut menu, and then uncheck the Format check box. If a shape doesn’t accept your formatting but you don’t see an error message, the formatting settings in the ShapeSheet are guarded, which prevents you from changing the value in the formatting cell. To remove the guard, select the shape and choose Window ➤ Show ShapeSheet. In the ShapeSheet, find the cell for the formatting you want to change and remove the **GUARD** function in that cell.

    Caution

Typically, shapes include the **GUARD** function or formatting locks when the shapes’ formatting is key to the proper behavior or appearance of those shapes. Although you can remove formatting locks and guards, be aware that shapes might behave differently or change their appearance in unexpected ways.

✦ **Restoring default styles for shapes** — If you want to remove local formatting so shapes revert to using style formatting, choose Format ➤ Style. For each type of style, select Use Master’s Format from the drop-down list.

    Note

Selecting Use Master’s Format resets styles only for shapes dragged from a stencil. Shapes that you draw directly on the page don’t have masters, so there are no master’s formats to apply.
Creating and Editing Styles

If you don’t like the formatting used in existing styles, you can edit them to specify the line, text, and fill formatting you want. If you frequently create your own custom shapes, you might want to create your own styles to accompany them. You can use style names that indicate the association between the shapes and styles. In addition, you can rename styles, delete styles no longer used, or copy styles between Visio drawings. No matter how you want to create or edit your styles, the Define Styles dialog box provides all the commands you need. You can create or modify multiple styles in one editing session. By using the Apply button in the Define Styles dialog box, you can apply the styles you’ve created or edited to selected shapes.

Creating Styles

Like styles in Microsoft Word, Visio styles can be based on other styles, inheriting formatting settings from the parent style. For example, if you want a set of styles to use the same color fills and fonts, but apply progressively thicker line weights, you can create a base style with the colors, fill formatting, text formatting, and line patterns you want. Then, you can base each style on the original, changing only the line weight. However, basing a unique style on another style might just mean more work. If you want to create a style from scratch, you can base it on the No Style style that is built into every Visio file by default.

If you’re a visual person and want to see the formatting before you create a style, you can format a shape with the settings you want. When the shape looks the way you want, you can save those settings as a style.

Creating Styles Based on Shape Formatting

You can create styles that include all the formatting applied to a shape. In addition to creating styles more quickly, you can preview the appearance of the formatting before you save the style. To create a style based on a shape’s formatting, follow these steps:

1. Select a shape that includes most, if not all, of the formatting you want. If you want to make any formatting changes, choose Format ➤ Text, Format ➤ Line, or Format ➤ Fill and select additional format options.
2. When the shape is formatted the way you want, choose Define ➤ Styles.
3. In the Name box, select <New Style> at the top of the drop-down list. Visio fills in the settings to match those of the selected shape.
4. Type the name you want for the style in the Name box and click Add to save the style to the drawing file. You can continue to define or edit other styles or click Close to end the style session.
Creating Styles from Scratch

To create a style from scratch, follow these steps:

1. Click an empty area on the drawing page to ensure that no shapes are selected and then choose Format ▶ Define Styles.

2. In the Name box, type the name you want for the new style.

3. In the Based On list, select an existing style that uses the formatting settings you want in the new style. If you don’t want to base the style on another style, select No Style from the drop-down list.

4. Under the Includes heading, check the check box for each type of formatting you want the style to apply. For example, to define a style for connectors, which don’t use fill, you can check the Text and Line check boxes, leaving the Fill check box unchecked.

   **Note**
   
   Checking the Includes check boxes also determines which toolbar style lists include the style.

5. To edit the formatting settings for the style, click the buttons in the Change area to open the dialog box for that type of formatting. For example, if you click Line, the Line dialog box opens, as shown in Figure 34-1. Specify the formatting you want and click OK to close the formatting dialog box. Repeat this step to edit formatting options for each type of formatting you want the style to apply.

   **Tip**
   
   You can prevent a style from appearing in the style lists—for example, when styles are designed for specific masters and you don’t want others to use those styles for anything else. To hide a style so it doesn’t appear on the style lists, check the Hidden Style check box before you save the style. Hidden styles still appear in the Name list in the Define Styles dialog box and in the Drawing Explorer window.

6. To save the style in the current drawing file, click Add.

7. Use one of the following methods to close the dialog box:
   
   • If shapes are selected and you want to apply the style to those shapes, click Apply and then click Close.
   
   • If you don’t want to apply the style to the selected shapes, click Close.
   
   • If no shapes are selected, click OK.
Editing Styles

You can edit the formatting in a style definition at any time. When you modify a style, any shapes in the drawing file formatted with that style reflect the changes to the style. To edit a style, follow these steps:

2. In the Name box, select the style you want to edit in the drop-down list.
3. For each type of formatting you want to edit, click the corresponding button in the Change area. In the formatting dialog box that opens, make the changes you want and click OK.
4. Under the Style heading, click the Change button to update the style definition and all shapes formatted with the style.
5. Repeat steps 2 through 4 to edit another style. Click Close when you’re finished.
Copying Styles Between Files

You can copy styles you create to other drawing files. If you intend to use the styles you create in many drawing files, the easiest approach is to save the drawing file containing the styles as a template. When you create new drawing files based on that template, they automatically contain the styles you want.

However, you can also copy styles from one drawing file to another drawing file that already exists by copying shapes formatted with those styles. When you paste shapes into a destination file, Visio copies any styles associated with the shapes. The styles remain in the destination file even if you delete the pasted shapes. If you want to copy several styles, you can create a new drawing page and paste all the shapes with the styles you want to copy onto that drawing page. After the styles are copied, you can delete the drawing page to easily remove the shapes.

If the destination drawing file already includes styles with the same names as the ones you want to paste, Visio doesn’t copy the styles from the source. Instead, it applies the style with the same name to the pasted shapes. To copy styles in this situation, you must rename the styles in the source before you copy the shapes to which they are applied.

You can also delete and rename styles in the Define Styles dialog box. For example, if you want to create a template, it’s a good idea to clean up the file by removing any unused styles before you save it. When you copy styles between drawing files, the styles you copy can’t use the same names as styles in the destination file. You can rename the styles in the source drawing file so that the styles copy correctly.

To delete a style, select the name of the style you want to delete and then click Delete. To rename a style, select the name of the style you want to rename and then click Rename. In the Rename Style dialog box, type the new name and click OK.

Creating Custom Patterns

Visio comes with numerous built-in line, line end, and fill patterns that you can apply to lines and shapes directly or associate with styles. However, you can also create your own patterns. Whether you want to create a line, line end, or fill pattern, you start by creating a pattern shape, which represents one copy of the pattern. Pattern shapes can be Visio shapes and fills or bitmaps you import from another application. You can use a pattern shape as a line pattern, a line end, or a fill pattern, as demonstrated in Figure 34-2.
Figure 34-2: You can use a pattern shape for line patterns, for fill patterns, or as line ends.

You can also specify how the pattern shape behaves under different circumstances, such as with straight or curved lines, or when closed shapes are resized. In addition, you can specify whether the pattern should be adjusted along with the drawing scale or maintained at a constant size.

After you define patterns, you can apply them to shapes as you would with any built-in pattern. Visio lists custom fill and line patterns at the bottom of the Pattern drop-down list in the Fill and Line dialog boxes. Custom line ends appear at the bottom of the Begin and End drop-down lists in the Line dialog box.

When you create custom patterns, you can’t use text, metafiles such as Visio Ink shapes, or gradient fills, rendered as solid fills.

Designing Pattern Shapes

Pattern shape design is the foundation of the patterns you create. Decisions you make while drawing a pattern shape can produce significantly different results in the patterns you create. Visio uses the following attributes of a pattern shape to determine the position and appearance of the shape in patterns:
✦ Pin position — Visio aligns a pattern shape in a pattern by the shape’s pin or center of rotation. If the pin is in the center of the pattern shape, a line pattern using the shape displays the shape centered along the line. However, if the pin is at the top of the shape, the pattern shape is offset below the line in the line pattern.

✦ Alignment box — When you tile a pattern shape in a pattern, Visio positions the alignment boxes for the pattern shape side by side. You can create the appearance of spaces between pattern shapes by making the alignment box larger than the pattern shape. If you make the alignment box smaller than the shape, the shapes overlap in the pattern.

Tip
To change the alignment box of a shape, use the Rectangle tool to draw a rectangle of the size you want and located where you want the alignment box to be. Select both the rectangle and the pattern shape and press Shift+Ctrl+G to group them. With the group selected, choose Edit ➪ Open Group to open the group window. In the group window, delete the rectangle and close the group window. The result is the pattern shape with an alignment box of the size and position of the deleted rectangle.

✦ Color — After you apply a pattern to a shape, you can change the color of any black areas in the pattern by changing the color of the line or fill. Areas created in any other color remain that color. When you design a pattern shape, be sure to draw elements in black if you want them to change color.

✦ Line weight — If you draw your own dash patterns, draw the line segments with lines of zero weight. The line segments inherit the line weight of the shape to which the pattern is applied.

Note
When you use a bitmap for a pattern shape, transparent areas on the bitmap aren’t transparent in the pattern. When you use a Visio shape as a pattern shape, the background shows through.

Designing Line Patterns
When you use shapes in line patterns, it’s important to take into account how your pattern shape will accommodate straight and curved lines and lines of varying widths. Visio line patterns use the following behavior options to specify how Visio applies your pattern shape under different circumstances, as shown in Figure 34-3.
Figure 34-3: Visio can arrange pattern shapes in several ways to create different line patterns.

🔹 **Tile and bend** — Visio tiles the pattern along the path of the line. If the path is not straight, Visio also distorts the pattern to conform to the path. For example, you can define a line pattern that includes all the painted lines for a highway. When you apply that style to a curved line, you want each of the painted lines to bend with the curves in the road, and you want the dashes for the passing line to stay the same length.

🔹 **Tile without distortion** — Visio tiles the pattern along the path of the line, but doesn’t distort the pattern to account for curves. For example, engineering plans often indicate pipelines with lines interspersed with letters that identify the type of pipeline. In this case, you want the line to bend with the curves, but you don’t want the letters to distort.

🔹 **Stretch** — Visio stretches a single copy of the pattern over the length of the line. You might use this behavior to create an arrow whose head and tail stretch to fit the length of the line.

🔹 **Tile over line** — Visio tiles the pattern without distortion but retains the original line formatting as well. You might use this behavior to draw a line pattern that looks like barbed wire, with a solid line that follows the curve but undistorted shapes at regular intervals along it.
Note

Line patterns can have no more than 1,000 instances of the pattern shape along a line.

Designing Line End Patterns

Line end patterns are simply pattern shapes attached to the ends of lines, so they have fewer options than line and fill patterns. You can add pattern shapes to the ends of lines in two ways:

✦ **Oriented with the line** — Visio rotates the pattern shape so it is aligned with the line. For example, arrowheads are typically oriented with the line.
✦ **Always upright** — The pattern shape is always upright with respect to the drawing page no matter what the orientation of the line is. If you use a symbol with letters in it, use this behavior to ensure that the letters are always right side up.

When you use a pattern shape as a line end, Visio positions the pin of the pattern shape at the end point of a line. However, if you want to simulate the behavior of Visio’s built-in arrowheads, move the pin to the side of the shape that you want to attach to the line and orient the shape with the line.

Tip

If a line end implies direction, such as the arrowheads on connectors on an organization chart, draw your pattern shape so it points to the right. By doing this, Visio points the line end in the right direction whether you apply it to the start point or end point of a line.

Designing Fill Patterns

Visio uses fill patterns to fill in closed shapes. Although fill patterns are often solid colors, you can create fill patterns with Visio shapes or bitmaps. If you’ve ever used a picture as a Windows background, the options for applying a shape or bitmap to a fill pattern should be familiar. You can use one of the following three techniques to apply a shape or image as fill, as shown in Figure 34-4:

✦ **Tile** — Visio copies the shape or image over a grid, as you would place tiles on a floor.
✦ **Center** — Visio positions one copy of the shape or image at the center of the closed area.
✦ **Stretch** — Visio stretches a single copy of the shape or image to fill the closed area.
For the best results, design separate fill patterns for scaled and unscaled drawings. Unscaled fill patterns appear at the size you created them. If the fill pattern uses a shape that is one inch square, the fill pattern uses a one-inch square no matter what scale the drawing uses. When you apply an unscaled fill pattern to a scaled drawing, the pattern might look as if it’s a solid black fill.

Note

Scale and pattern size don’t affect fill pattern when you use the option that stretches the image to fill the area.

### Scaling Line Ends

You can specify whether line ends are scaled or unscaled, which affects the size of the line ends when you apply them to lines. If you choose to apply an unscaled line end, the line end appears the same height as the weight of the line. If you use a very thin line, you won’t be able to see the line end. To increase the size of the line end, change the weight of the line, such as increasing it to .25 inches.

Conversely, when you create a line pattern that includes a shape that represents a real-world object, you can specify a scaled pattern shape. When you apply a scaled line end to a line, the line end resizes to match the scale of the drawing. In this situation, changing the weight of the line or selecting a size in the Begin Size or End Size drop-down list has no effect on the line end.
In addition to tiling and scaling, you can also control the transparency of fill patterns. Fill patterns that use shapes show the area between the repeated shapes as transparent. For example, if you tile a circle over an area, the pattern looks like colored polka dots over a transparent background.

Fill patterns are limited to 40,000 instances of a pattern shape or a grid of 200 by 200 shapes.

Creating New Custom Patterns

When the pattern shapes that you want to use exist, you can create any type of custom pattern using similar steps. Depending on where you want to save the pattern, use one of the following methods:

- **In current drawing** — Choose View ➤ Drawing Explorer Window.
- **In an existing stencil** — Choose File ➤ Shapes ➤ My Shapes and then choose the stencil in which you want to save the pattern. Right-click the stencil’s title bar and choose Edit Stencil. Right-click the title bar a second time and choose Drawing Explorer Window.
- **In a new stencil** — Choose File ➤ Shapes ➤ New Stencil. Right-click the title bar for the new stencil and choose Drawing Explorer Window.

If the Drawing Explorer Window option doesn’t appear on the stencil shortcut menu, choose Tools ➤ Options, select the Advanced tab, and check the Run in Developer Mode check box.

Creating a New Pattern

To create a line pattern, line end pattern, or fill pattern, follow these steps:

1. In the Drawing Explorer window, depending on the type of pattern you want to create, right-click Fill Patterns, Line Patterns, or Line Ends, and then choose New Pattern from the shortcut menu.
2. In the New Pattern dialog box, type the name for the pattern in the Name box.
3. If necessary, select the option for the type of pattern you want to create. By default, Visio selects the option based on which Drawing Explorer folder you right-clicked.
4. Click the icon for the behavior you want for the pattern. Visio displays icons that show each behavior for the type of pattern you are creating.
5. To adjust the pattern as the drawing scale changes, check the Scaled check box.
6. Click OK. Visio adds the new pattern to the appropriate folder in the Drawing Explorer window.
7. In the Drawing Explorer window, right-click the new pattern and choose Edit Pattern.

8. In the drawing page for the pattern, draw the pattern shape you want or copy a shape from another drawing page and paste it onto the pattern drawing page. You can also insert a bitmap onto the drawing page. Be sure to cover the entire drawing page with the fill pattern so that the pattern fills shapes completely.

9. Click the Close button at the top-right corner of the pattern shape drawing window and click Yes to update the pattern.

**Sizing Line Ends**

If you have added line ends, follow these steps to make the line ends appear at the size you want:

1. Draw or select a line on the drawing page and choose Format ➤ Line.
2. Click the arrow next to the Begin or End list and scroll down until you see the line end pattern you want. Select the line end in the drop-down list.
3. Click Apply.
4. If the line ends don’t appear at the size you want, click the arrow in the Weight box and choose Custom.
5. Type a heavier line weight, such as .25 in. Check the appearance of the line end in the preview window. Repeat this step until the line end is the size you want.
6. Click OK. To simplify the application of the pattern, save the current settings as a line style.

**Summary**

Formatting shapes with styles makes it easy to coordinate the appearance of shapes and quickly modify the appearance of many shapes at once. Although Visio includes quite a few built-in styles, you can define your own. You can create styles based on the formatting applied to a shape on a drawing page or specify options within the Define Styles dialog box.

You can also define your own patterns for lines, fills, or line ends. Line, line end, and fill patterns all use pattern shapes to define their patterns. Designing pattern shapes requires some care, as the pin position, alignment box, color, and line weights within a pattern shape can produce drastically different patterns. When you create patterns, you can specify how Visio applies the pattern shape to create the pattern and whether the pattern scales with the drawing page scale.
Customizing Toolbars and Menus

Like the user interface for other Microsoft Office applications, Visio menus, toolbars, and keyboard shortcuts provide easy access to commonly used commands. By default, Visio displays the commands you use most frequently and hides the ones you don’t. However, if you prefer, you can show full menus at all times.

You can also customize or create Visio menus and toolbars to display the commands you want in the order you want. If you prefer to use the keyboard, you can assign keyboard shortcuts so you can execute commands without switching between keyboard and mouse.

This chapter shows you how to customize menus and toolbars to include the commands you use frequently. You will learn how to modify button images on toolbars and specify menu and toolbar options. In addition, you’ll learn how to create keyboard shortcuts to increase your productivity.

Customizing Toolbars and Menus

Whether you use menus or toolbars, you don’t want to take screen space away from your drawings by displaying commands you don’t use. You can minimize the space that toolbars and menus consume by customizing existing toolbars and menus or creating your own.

It’s easy to customize the Visio interface, but the changes you make to menus and toolbars appear for every drawing you open. If you don’t want to change Visio’s built-in toolbars and menus or you want specialized menus for specific tasks, you can create new menus and toolbars that contain only the commands you want.

Note
Using Personalized Menus

By default, Visio personalizes toolbars and menus by displaying frequently used commands. Initially, menus and toolbars contain commands popular with most users. As you work, Visio adds the commands you choose to the menu and hides the commands you rarely use. To display the full menu of commands, click the chevron at the bottom of the menu.

If you would rather see full menus all the time, right-click any menu and choose Customize from the shortcut menu. In the Customize dialog box, select the Options tab and check the Always Show Full Menus check box. If you like personalized menus but your recent work has skewed the contents of your personalized menus, you can reset them to Visio’s default selections by clicking Reset Menu and Toolbar Usage Data on the Options tab.

Customizing Toolbars

You can add, remove, and rearrange buttons on toolbars. You can also specify the appearance of buttons, or create your own icons. To open a toolbar so you can customize it, follow these steps:

1. If the toolbar you want to customize is not visible, choose View ➪ Toolbars and then choose the toolbar you want.


Tip

You can reduce the area that toolbars take up by displaying the Standard and Formatting toolbars on one line. Right-click any toolbar and then choose Customize on the menu. Select the Options tab and uncheck the Show Standard and Formatting Toolbars on Two Rows check box. If a command you want doesn’t appear when these toolbars share a row, click the Toolbar Options arrow on the right end of the toolbar and choose the toolbar button you want.

To modify the contents or order of a toolbar, choose one of the following methods:

✦ Add a button — To add a button to a toolbar, follow these steps:

1. In the Customize dialog box, select the Commands tab. In the dialog box, Visio displays categories of commands on the left side and the commands within the selected category on the right side.

2. Choose the category of the command you want to add.

3. Drag the command you want from the Commands list to the toolbar until the I-beam (which resembles a standard cursor but looks more like a bolded, uppercase I) is where you want to add the command and release the mouse button.
✦ Remove a button — To remove a button from a toolbar, open the Customize dialog box, right-click the button you want to remove on the toolbar, and choose Delete in the shortcut menu.

If the Customize dialog box isn’t open, you can remove a button from a toolbar by pressing and holding the Alt key as you drag the button you want to remove off the toolbar. When an X appears below and to the right of the button, release the Alt key and the mouse button.

✦ Rearrange buttons — To move a button to another position on a toolbar, open the Customize dialog box and drag the button on the toolbar until the I-beam is positioned where you want to place the command, as illustrated in Figure 35-1, and then release the mouse button.

![Figure 35-1: Use the I-beam to position buttons on a toolbar.](image)

You can hide or display buttons without using the Customize dialog box. To do this, click the Toolbar Options button at the end of the toolbar, choose Add or Remove Buttons, and choose the name of the toolbar you want to customize. Visio displays a list of all the buttons associated with the toolbar. Check a command to display it or uncheck a command to hide it.

Although you can hide or display toolbar buttons using Toolbar Options, you can add buttons to or remove buttons from toolbars only when the Customize dialog box is open.

### Adding Menus to Toolbars

To add a menu to a toolbar, open the Customize dialog box and select the Commands tab. To add a built-in menu to a toolbar, select the Built-In Menus category and drag the menu you want from the Commands list onto the toolbar.

To add a custom menu to a toolbar, select New Menu in the Categories box and drag New Menu from the Commands list to the toolbar. Right-click the new menu on the toolbar, type a name in the Name box on the shortcut menu, and press Enter. You can add commands or menus to the new menu by dragging the commands or menus you want from the Customize dialog box to the pull-down area below the new menu name. To modify a menu entry, right-click it.
Customizing Menus

Just like toolbars, menus can contain commands or other menus. Although menus use more space than toolbars, they can include descriptions of commands and submenus that help you choose the right feature. In addition to adding, removing, or rearranging commands and submenus on a menu, you can change the appearance of menu buttons and even specify whether the menu displays buttons or text, as shown in Figure 35-2.

Figure 35-2: Edit commands or submenus on pull-down menus.

To customize a menu, open the Customize dialog box by choosing Tools ➪ Customize ➪ Toolbars and then using one of the following methods:

- **Add a command** — Select the Commands tab in the Customize dialog box, choose the category for the command you want to add, and drag the command from the Commands list to the position you want on the menu.

- **Add a menu** — Select the Commands tab in the Customize dialog box and choose the New Menu or Built-In Menus category. To create a new menu, drag the New Menu command from the Commands list to the desired position on the menu. To add a built-in menu to another menu, drag the menu from the Commands list to the menu.

- **Remove a command from a pull-down menu** — To remove an entry from a menu, with the Customize dialog box open, navigate to the command you want to remove, right-click it, and then choose Delete from the shortcut menu.
✦ **Rearrange commands** — To move a command or submenu to another position on a menu, with the Customize dialog box open, drag the command in the menu until the I-beam is positioned where you want to place the command and then release the mouse button.

✦ **Remove a menu from the menu bar** — With the Customize dialog box open, right-click the menu you want to remove from the menu bar and choose Delete from the shortcut menu.

If you want to reset menus you have customized to the commands Visio provides by default, choose View \(\Rightarrow\) Toolbars \(\Rightarrow\) Customize. Select the Toolbars tab and click Reset. When Visio prompts you, click OK to reset your menus.

### Creating Toolbars and Menus

When you frequently use a small number of commands from several built-in toolbars or menus, you can create a toolbar or menu of your favorites.

To create a new toolbar, open the Customize dialog box and then follow these steps:

1. Select the Toolbars tab and click New.
2. In the New Toolbar dialog box, type the name of the toolbar and click OK. Visio adds the toolbar name to the Toolbars list and displays the empty toolbar on the screen.
3. Follow the instructions in the section “Customizing Toolbars” earlier in this chapter to create the contents of the toolbar.

You can create new menus in the process of customizing a toolbar or another menu. To create a new menu on a toolbar or menu, select the Commands tab in the Customize dialog box, choose the New Menu category, and drag the New Menu command from the Commands list to the position you want on the menu. Name the menu and drag the commands you want onto the new menu.

When you create a new menu, it is available only on the toolbar or menu on which you place it. Visio doesn’t maintain a list of user-defined menus that you can use to add customized menus to other toolbars or menus.

You can only delete toolbars that you create. To delete a user-defined toolbar, open the Customize dialog box, select the Toolbars tab, choose the user-defined toolbar you want to delete, and choose Delete from the shortcut menu. When prompted, click OK to confirm the deletion.
Although you can’t delete built-in toolbars, you can reset them to their original configuration. When you select a built-in toolbar in the Customize dialog box, the Delete button is dimmed. To reset a built-in toolbar, select the Toolbars tab, select the toolbar in the Toolbars list, and then click Reset. When prompted, click OK.

Resetting a toolbar removes any custom buttons you created. To save custom buttons, copy them to another toolbar before you reset the current one.

Modifying Toolbars and Menus

You can rename toolbars and menus and group the commands on them. You can also modify button images and specify whether Visio displays a button, text, or both.

Renaming Toolbars and Menus

You can rename both user-defined and built-in menus, but you can only rename user-defined toolbars. Visio uses the menu name as the text that appears in a menu or toolbar, so it’s best to keep menu names short and descriptive. To rename toolbars and menus, open the Customize dialog box and then use one of the following methods:

✦ **Rename a user-defined toolbar** — Select the Toolbars tab, choose the toolbar you want to rename, and click Rename. In the Rename Toolbar dialog box, type the new name and click OK.

✦ **Rename a menu** — Right-click the menu, type the new name in the Name box on the shortcut menu, and press Enter.

To add a keyboard shortcut to access a menu, when you type the menu name in the Name box on the shortcut menu, type an ampersand (&) in front of the letter you want to use as the shortcut.

Grouping Commands and Menus

To group buttons on a toolbar or menu, right-click the button you want as the first in the group and choose Begin Group on the shortcut menu. To remove a separator, drag the two buttons or commands on either side of the separator closer together.

Changing the Width of a Drop-down List

To change the width of a drop-down list in a toolbar, follow these steps:

1. Open the Customize dialog box and select the drop-down list in the toolbar whose width you want to change.

2. Position the pointer over either end of the drop-down list and drag the pointer until the drop-down list is the width you want.
**Modifying the Appearance of an Entry**

When you right-click a menu or toolbar entry while the Customize dialog box is open, a shortcut menu appears with commands for changing the appearance of the entry. The commands on this shortcut menu include the following:

- **Reset** — Restores the original button, associated command, and settings for the button on a built-in toolbar
- **Delete** — Removes the button
- **Name** — Displays a box in which you can type the ToolTip for the button
- **Copy Button Image** — Copies the selected button image to the Clipboard so you can paste it to another button
- **Paste Button Image** — Pastes the image on the Clipboard to the selected button. You can copy graphics or images from other applications or buttons.
- **Reset Button Image** — Restores the default button image
- **Edit Button Image** — Opens the Button Editor dialog box so that you can edit the image
- **Change Button Image** — Displays a selection of images from which you can choose a new image
- **Default Style** — Displays only a button image on a toolbar and the button image and text on a menu
- **Text Only (Always)** — Displays only text in both toolbars and menus
- **Text Only (In Menus)** — Displays a button image on a toolbar and only text on menus
- **Image and Text** — Displays a button image and text in toolbars and menus
- **Begin a Group** — Adds a divider to the toolbar or menu
- **Assign Macro** — Opens the Customize Tool dialog box so you can designate a macro for the button

**Modifying Button Images**

You can modify the button images on a toolbar. For example, if you have different Print buttons for each printer you use, you can modify button images to indicate the associated printer.

To modify a button image, follow these steps:

1. Open the Customize dialog box, right-click the button you want to edit, and then click Edit Button Image. The Button Editor dialog box appears.
2. To modify the image, choose a color in the Colors section of the dialog box. To erase colored boxes in the image, click the Erase box.
3. In the Picture section, click individual cells or drag the mouse pointer over cells to change their color. You can see what the image looks like in the Preview section of the dialog box.

4. To move the image within the Picture section, click a directional arrow in the Move section of the dialog box. When the image fills the Picture section in one or more directions, Visio dims the appropriate directional arrows.

Creating Keyboard Shortcuts

If you prefer to use the keyboard more than the mouse, you can assign keyboard shortcuts to any command on any menu. To use a keyboard shortcut, press and hold the Alt key, press the shortcut letter for the menu, and then press the shortcut letter for the command. For example, to save a file, you can press Alt+F+S.

To create a keyboard shortcut, follow these steps:

1. Open the Customize dialog box and right-click the menu or command for which you want to define a keyboard shortcut.

2. In the Name box on the shortcut menu, type an ampersand (&) before the letter you want to use as the shortcut. In the menu, Visio underlines the shortcut letter for the command.

   Use a different letter for each keyboard shortcut. If you choose a letter that is already in use by another menu entry, you might have to press the letter more than once to select the command you want.

Sharing Customized Toolbars and Menus

When you customize toolbars and menus, they are associated with your Visio application, not a drawing file. To share a customized toolbar with someone else, you must copy it to a drawing file and send that file to your colleague. To share a customized toolbar or menu, follow these steps:

1. Choose View ➪ Toolbars ➪ Customize.

2. Select the Toolbars tab and then click Attach.

3. In the Custom Toolbars list, select a toolbar that you want to share and click Copy. Click OK after all the toolbars you want to share appear in the Toolbars in Drawing list.

4. Save the drawing file with the toolbars by pressing Ctrl+S.
Summary

You can customize built-in toolbars and menus to include only the commands you want. You can also create new toolbars and menus to consolidate your favorite commands from several built-in menus or to create specialized menus for the tasks you perform most often. Whether you customize or create menus and toolbars, you can add, remove, or rearrange entries. In addition, you can specify whether Visio displays a button image, a text description of the entry, or both. You can also customize or create button images to better represent the commands they represent.
Automating Visio

If you’re not a programmer, you might think that it’s difficult to automate Visio procedures, but you would be wrong. In Visio 2003, you can use a macro recorder to save the steps required to accomplish a task. You can save the macro as is or modify it using Visual Basic for Applications (VBA) to make it more flexible.

If you are a programmer, or can at least find your way around a programming language such as Visual Basic, you can write code to develop more complex automated solutions. You can automate any feature you want by writing code that controls Visio documents, windows, drawing pages, shapes, and ShapeSheet cells. To extend Visio’s capabilities, you write code to create Component Object Model (COM) add-ins, similar to the add-ons that are packaged with Visio, such as the Number Shapes add-on. You can then run these add-ins from menus, from shape shortcut menus, or in response to events.

In addition to macros and COM add-ins, you can use the Visio ActiveX control to integrate Visio into an external application. With this ActiveX control, you have complete access to the Visio object model and user interface. For example, you could develop an application that helps an engineer design a sound system for a customer and, when the design is complete, scan the resulting diagram to produce a parts list, an estimate, and a purchase order.

This chapter provides you with an overview of the development features that Visio offers and identifies resources for learning more both within Visio Help and online.
What’s New for Developers in Visio 2003

Visio 2003 includes several new features for developers, including a few significant additions, such as the macro recorder and the Visio Drawing control. If you’ve been using Visio automation features already, here are some of the new features in this release:

❖ **Microsoft Office Visio Drawing Control 2003** — Available with both Visio Standard and Visio Professional, this ActiveX control provides complete access to the Visio object model and user interface so you can fully integrate Visio into an external application.

❖ **Formula tracing window** — To identify interdependencies between ShapeSheet cells, this window shows cells that use or reference a ShapeSheet cell.

❖ **Keyboard and mouse events** — New events to handle mouse and keyboard events, such as mouse movements, mouse clicks, and keyboard actions.

❖ **Macro recorder** — Records the actions you perform within the Visio application. You can save these macros as is or edit them with VBA to add functionality or flexibility.

❖ **Primary interop assemblies (PIAs)** — Access the Visio object model from applications that use the common language runtime (CLR) 1.1.

❖ **ShapeStudio** — Available with the Visio 2003 Software Developers Kit (SDK), this add-on provides a development environment for creating Visio shapes.

❖ **SmartTags** — Add SmartTags to shapes to display drop-down menus and make shape actions and settings easier to find.

❖ **Publishing add-ons** — Instead of specifying file paths for Visio add-ons, you can publish add-ons using a Microsoft Windows Installer package to take advantage of Microsoft Office System application features such as language switching, installation on demand, and repair.

❖ **XML Web Service support** — Integrate XML Web Service into diagrams by selecting Web Service references from a dialog box.

Working with Macros

Macros are the simplest way to automate smaller tasks within Visio. If you’re still learning your way around VBA, you can generate the basic code for a procedure by using the macro recorder. You execute the commands and steps you want and Visio stores the code for those actions in a macro. You can edit the macro to add more functionality or prompts for input from the user. You can also write macros directly using VBA in the Visio environment.
To record a macro, follow these steps:

1. Choose Tools ➪ Macros ➪ Record New Macro.
2. Type the name of the macro, select the location in which you want to store the macro, and click OK.
3. Execute the commands and actions you want to automate.
4. When you’re done with the steps in your procedure, click Stop on the Stop Recording toolbar or choose Tools ➪ Macros ➪ Stop Recording.

To edit a macro using VBA, follow these steps:

2. In the Macros dialog box, select the macro you want to edit and click Edit.
3. If the macro you want to edit doesn’t appear, select the location in which the macro is stored in the Macros In drop-down list.
4. In the Microsoft Visual Basic Editor window, make the changes you want to the VBA code, as shown in Figure 36-1.
5. When you’re finished editing, choose File ➪ Close and Return to Visio.

Figure 36-1: You can write macros or complete VBA programs in the Visual Basic Editor window.
You can run macros in several ways, with the following representing the most common methods:

✦ Choose Tools ➪ Macros ➪ Macros. Select the macro and click Run.
✦ Double-click a shape whose double-click behavior is set to run a macro.

To specify a macro for a shape’s double-click behavior, select the shape and choose Format ➪ Behavior. Select the Double-Click tab and select the Run Macro option. Select the macro to run in the Run Macro drop-down list and click OK.

✦ Right-click a shape and choose a menu item that runs a macro. To add a shortcut command to run a macro, add the menu item in the Actions section of the ShapeSheet window as described in Chapter 33.

**Writing Add-Ins to Automate Visio**

You can automate Visio with programs written in VBA, Microsoft Visual Basic, C++, or any programming language that supports Automation, a proprietary Microsoft development environment. You can use COM add-ins the same way you do in other Microsoft Office System applications. In fact, if written appropriately, COM add-ins can work in more than one application. You can create COM add-ins using Microsoft Visual Basic 5.0 and later, Microsoft C++, Microsoft Office 2000 Developer Edition and later, or any of the Microsoft Visual Studio .NET applications.

With Automation, programs control Visio elements by accessing and using the Visio object model—Visio objects and their properties, methods, and events. Visio includes a type library that defines the objects, properties, methods, events, and constants that Visio exposes to Automation clients. Automation components include the following:

✦ **Objects**—Elements within the Visio application, such as documents, drawing pages, windows, shapes, and ShapeSheet cells containing formulas
✦ **Properties**—Attributes that determine the appearance or behavior of objects, much like the custom properties associated with shapes
✦ **Methods**—Actions that an object provides. For example, applying the Delete method to the Page object deletes a Page object and can renumber the remaining pages.
✦ **Events**—Occurrences that trigger the execution of code or programs

To use the Visio type library, a development environment must reference it. VBA projects in a Visio document reference the Visio type library automatically. If you use other development environments, you must use the appropriate commands or
steps to reference the library. When you use the Visio type library, you can use an object browser, such as the one in VBA, to view descriptions of objects supplied by an Automation server. The object browser displays the syntax of a Visio property, method, or event, and might include code you can paste into your program. In addition, by using the type library, the development environment you use can bind your code to Automation server code at compile time, which can result in faster program execution. For example, you can use objects such as Visio.Shape instead of the generic Object.

If you write your add-ins using VBA, you can access the Visual Basic Editor from within Visio. To open the Visual Basic Editor window, choose Tool ➤ Macros ➤ Visual Basic Editor.

Using the Visio Drawing Control

New to Visio 2003 is the Microsoft Office Visio Drawing Control 2003, an ActiveX control that enables you to integrate the Visio drawing surface into applications you develop. The Visio Drawing control provides full access to the Visio object model and user interface so you can interact through the Visio user interface and automate Visio procedures from within your applications.

The Visio Drawing control is installed when you install Visio, even if you choose the Minimal Install.

You can embed the Visio Drawing control in Visual Basic 6.0, Visual C++ 6.0, Visual Studio 7.1, and other ActiveX control containers. However, you can’t use the Visio Drawing control if you are developing a solution in VBA in Visio. You can insert more than one instance of the Visio Drawing control in your application, but each instance displays only one drawing window and one Visio drawing file.

By default, the Visio Drawing control opens a blank Visio drawing, but you can specify that the control open an existing Visio document, either at design time or at run time. The control doesn’t display the Visio startup screen, the Choose Drawing Type pane, or a docked Shapes window on startup. However, if you load an existing drawing that already displays a docked Shapes window, the window appears in the Visio Drawing control window. You can also display the Shapes window in a blank drawing by using the Document.OpenStencilWindow method from the Visio object model. You can use other methods to display menus and toolbars.

The Visio Drawing control does not expose the ShapeSheet in the user interface. However, you can use methods and properties in Automation to access ShapeSheet cells.
Learning More About Automating Visio

This chapter acts only as an introduction to programming features available in Visio 2003. Depending on which programming language you use or whether you’re developing macros within Visio with VBA or using the Visio Active X control, you can find dozens of books devoted to writing code in each language or environment. You can use the following Visio Help and Microsoft’s Web resources to obtain a great deal of material about developing solutions with Visio:

✦ **Visio Help** — Choose Help ➪ Developer Reference to access the Visio Automation Reference and the Visio ShapeSheet Reference. You can read about the Visio object model, Visio programming concepts, and obtain detailed information about objects, interfaces, methods, properties, events, and enumerations.

✦ **VBA Help** — When you’re working in the VBA window, choose Help ➪ Microsoft Visual Basic Help to read about generic Visual Basic topics and obtain assistance with VBA editing tools.

✦ **MSDN** — At http://msdn.microsoft.com/visio, you can access Microsoft’s documentation for Visio development as well as technical articles about development topics.

✦ **Other online resources** — At www.mvps.org/visio, you can download code contributed by Visio developers and find other sites with downloads or development information.

**Summary**

Visio 2003 introduces numerous enhancements and significant new features for developers. For less experienced programmers, Visio 2003 offers the macro recorder, which transforms the actions you perform in Visio into VBA code. For more advanced automation assignments, you can use any programming language that supports Automation, such as Visual Basic or Visual C++, to write COM add-ins with access to the entire Visio object model. In addition, the new Visio Drawing control is an ActiveX control that enables you to include the Visio interface and Visio functionality in external applications you develop.

✦ ✦ ✦
Installing Visio 2003

If you have installed other Microsoft products on your computer, the Visio installation should be quite familiar. Visio’s Setup program and the Microsoft Windows Installer use procedures similar to those for other Microsoft Office applications. This chapter describes how to install Visio 2003 from a CD or use other methods designed for deploying it in large organizations. You’ll learn how to install multiple versions of Visio on your computer, which is helpful if you use some of the features discontinued in Visio 2003 or previous versions. Although the installation procedure includes default options, this chapter will show you how to choose where to install Visio as well as which components you want to install.

To verify that you are installing a legal copy of the software, Microsoft requires that you activate your copy after installation. If you don’t, you can only run Visio a few times and can only use some of Visio’s features during those sessions.

Exploring Visio Installation Methods

If you are installing Visio on your home computer or a business computer that is not attached to a network, it’s easy to install Visio 2003 from the Visio 2003 CD. However, Microsoft Office 2003 offers additional installation methods when you want to deploy programs throughout an organization and allow users to easily maintain the software on their computers.

Cross-Reference
To learn more about the advanced deployment features of Microsoft Office 2003, review the Office Review Kit on Microsoft’s Web site at www.microsoft.com/office/ork/2003/.
Using a Local Installation Source

When you install Microsoft Office 2003 applications from a CD or from a compressed CD image on the network, the Setup program copies any required installation files to a hidden folder on the local computer. Windows Installer uses this local installation source to install Office. In addition, you can use this local source later to repair, reinstall, or update your Office programs. The local source also makes it easy to install features on demand or run the Setup program in Maintenance mode to add features you didn’t install initially.

With the local installation source, you can do the following:

✦ Add features easily — Users with slow or intermittent network connections can install features on demand or add new features without accessing the installation source on the network or CD.

✦ Distribute smaller updates — Administrators can distribute smaller client patches and users can apply them without access to the original installation source.

✦ Use less disk space — By using compressed cabinet files, the local installation source requires far less hard disk space than an entire uncompressed administrative image.

Deploying with an Administrative Installation Point

For large deployments, you can use an administrative installation point to customize Microsoft Office 2003 client installations and deploy them to users throughout your organization. The administrative installation point resides on a network server from which you can run Setup. When you use an administrative installation point, updates and maintenance originate from the administrative installation point on the network. Setup can’t create a local installation source for local updates and repairs. However, an administrative installation point provides the following benefits:

✦ Centralized management — You can manage one set of Office files located in a central location. You can also apply patches to a single administrative image and update all installations from that image.

✦ Standardized installations — You can create standard Office configurations suited to the needs of groups of users.

✦ Flexible installation options — You can specify whether features are installed on first use or run over the network. You can also use other deployment tools, such as Microsoft Systems Management Server to install software.
Using a Compressed CD Image

If you want the benefits of an administrative installation point but also want a local installation source, a compressed CD image for installing Office applications is an alternative. To create a compressed CD image, you simply copy the compressed files from the Visio 2003 CD or Office 2003 CD to a network share. With a compressed CD image, you can perform the following actions:

✦ **Create multiple configurations** — You can modify Setup.ini to customize Office and create multiple configurations from the same compressed CD image.

✦ **Set features for install on demand** — You can set features to be installed on demand, but you can’t run Office applications over the network.

✦ **Create chained packages** — You can attach additional packages to the Office installation to install standalone products such as Microsoft Office Publisher 2003 or Microsoft Office Project 2003.

✦ **Use software deployment tools** — You can use deployment tools such as Microsoft Systems Management Server to install Office on users’ computers.

Installing Visio on Your Computer

If you want to install Visio from a CD onto your computer, the Visio Setup program walks you through the steps for the installation. To start your Visio installation, follow these steps:

1. Close any programs that are running—including your virus protection software—and insert the Visio 2003 CD into your computer.

   If the Setup program doesn’t start automatically, click Start to open the Windows Start menu and choose Run. Type `D:\Setup` and click OK. If your CD drive uses a different drive letter, replace `D` with the CD drive letter on your computer.

2. Type the product key in the boxes in the first screen of the Microsoft Visio Setup dialog box and click Next.

3. Type your name, initials, and organization in the next screen and click Next.

4. Review the license agreement, select the I Accept the Terms in the License Agreement check box at the bottom of the screen, and click Next.

   If a previous version of Visio is installed on your computer, continue with the following section. For a new installation, skip ahead to the section “Using the Microsoft Windows Installer.”
Installing When a Previous Version Is Present

By default, the Visio 2003 Setup program removes installations of Visio 2002 and Visio 2000. If it finds previous versions of Visio, it displays them in the Previous Versions screen. To keep your Visio 2000 or Visio 2002 installations, follow these steps:

1. Select the Custom Install option in the Type of Installation dialog box and click Next.
2. In the Previous Versions screen, select the Keep All Previous Versions option and click Next.

If you plan to work with multiple versions and you don’t keep the installation source files on your computer, make sure that your Visio CD for each version you want to use is handy. You will need your CD every time the Auto-repair program runs.

When you use multiple versions of Visio on the same computer, Visio might display a dialog box when you start Visio. Wait while the Visio Auto-repair process sets up the files properly for the version you want to run and then work with Visio as you would normally.

Using the Microsoft Windows Installer

When you install Visio, you can specify the type of installation you want and where you want to install the program files on your computer. By default, the Setup program automatically selects the Typical Install option, which installs the most commonly used components. However, you can also choose to install every feature, only the required features, or only the features you want.

To continue with your Visio installation, follow these steps:

1. Select the type of installation you want from the following options:
   - **Typical Install** — Installs the most commonly used features and components. You can add or remove components later using the Setup program Maintenance mode.
   - **Complete Install** — Installs all Visio components and features
   - **Minimal Install** — Installs only the required components, which is helpful when disk space is at a premium
   - **Custom Install** — Installs the features you specify
2. To install Visio in a location other than the default path, C:\Program Files\Microsoft Office, click the Browse button, navigate to the installation path you want, and click OK. Click Next.
3. If you chose the Custom Install option, in the Advanced Customization screen, choose the features you want to install and how you want to run them with the following steps:

   a. Navigate to the feature you want to install by clicking the + in front of a category and then clicking the icon that precedes the feature you want, as shown in Figure 37-1.

   b. For the selected feature, choose one of the following installation methods:

      • **Run From My Computer** — Installs the selected feature on your computer
      • **Run All From My Computer** — Installs the selected features and all its options on your computer
      • **Installed on First Use** — Does not install the feature as part of the current installation. Visio will prompt you to install it the first time you try to use it. You will need your Visio CD handy or access to the installation files on your computer or the network.
      • **Not Available** — Does not install the selected feature

![Figure 37-1: Choose features to install and also how to run them.](image)

4. Repeat steps a and b for each feature you want to customize. Click Next when you have specified how you want to install the features you want.
Installation Option Icons

The Setup program uses the following icons to indicate how features will be installed:

✦ A white box with a drive icon indicates that features and options will be installed as you’ve specified.
✦ A gray box with a drive icon means some options for a feature won’t be installed.
✦ A white box with a red X means the features and its options won’t be installed.
✦ A white box with a drive icon and the number one means the feature will be installed the first time you use it.

Note

Visio provides two versions of each template and add-on: one version using U.S. units and the other using metric units. By default, the Setup program selects the version to install based on the locale and configuration on your computer. If you want to include both versions, you must perform a custom install and specify that you want to install the following: Solutions (US units), Solutions (Metric Units), Add-ons (US units), and Add-ons (Metric units).

5. Click Install to proceed with the installation. If you notice a problem after the installation begins, you can stop the installation by clicking the Cancel button. If you do this, the Setup program terminates. After you correct the problem, you must run the Setup program again and start from the beginning.

6. After Setup is complete, check for updates to Visio by checking the Check the Web for Updates and Additional Downloads check box.

7. If you don’t want to keep the Visio installation files on your computer for repairs or updates to your installation, check the Delete Installation Files check box. Deleting these files saves approximately 184MB of disk space. However, without these files, you will need your Visio CD to repair your installation or add components in the future.

8. Click Finish to complete the installation.

Activating a New Visio Installation

Activation is a technique that Microsoft uses to ensure that you’ve installed a legal copy of a Microsoft product. If you run Visio without activating it, the product runs in Reduced Functionality mode, which enables you to evaluate Visio’s features, but limits your ability to perform meaningful work. In addition, after you run Visio several times without activating, you won’t be able to run the program again until you reinstall and activate it.
When you activate Visio, Microsoft requires that you indicate your country or region, not personal information. The Microsoft Office Visio Activation Wizard creates a unique hardware identifier that identifies only the configuration of your computer solely for the purpose of activating Visio. You don’t have to reactivate your copy of Visio for minor upgrades, although you might have to reactivate if you completely rebuild your computer. During activation, you can also register your copy of Visio. The Activation Wizard starts automatically when you run Visio for the first time. However, you can also start the wizard by choosing Help ➪ Activate Product.

Note

Although registration requires personal information such as your name and contact information, rest assured that Microsoft employs a privacy policy and uses security mechanisms to protect your personal information and privacy.

Note

If you have trouble activating Visio, your Internet connection might be disconnected. To activate Microsoft Office Visio by telephone, start the Microsoft Office Visio Activation Wizard and follow the instructions.

If you do not activate Microsoft Office Visio after you install it, Visio starts in Reduced Functionality mode. You can open, close, and print existing drawings in Reduced Functionality mode, but you can’t perform the following tasks:

✦ Create new files
✦ Save changes to existing files
✦ Display anchored windows, such as Pan & Zoom, Size & Position, and Custom Properties
✦ Display built-in or custom stencils or drag shapes from stencils
✦ Cut, copy, or paste content. This includes the Paste Special command and placing content on the Clipboard.
✦ Access or assign shape properties or custom properties
✦ Import or export data
✦ Use Microsoft Visual Basic for Applications (VBA) and the Visio object model
✦ Enable existing macros or create new macros
✦ Access the ShapeSheet window

Maintaining and Repairing Visio

After your initial installation of Visio, you can uninstall Visio, add or remove Visio-specific features, or reinstall features that aren’t working properly. You can also instruct Visio to look for installation problems, such as missing or damaged files, and repair them.
Adding and Removing Components

You use the Visio Setup program when you want to install features that you omitted during your initial installation or remove features you don’t use, to recover disk space. You can also uninstall Visio using this program. When you run the Visio Setup program, you can choose from the following options:

✦ **Add or Remove Features** — Install or remove specific Visio features
✦ **Reinstall or Repair** — Reinstall or repair installed features when there is a problem with your Visio installation and you can’t run Visio or access Detect and Repair on Visio’s Help menu.
✦ **Uninstall** — Removes the Visio 2003 installation from your computer

To add or remove specific Visio features, follow these steps:

1. Click Start and choose Settings > Control Panel > Add/Remove Programs. If you’re using an earlier version of the Windows operating system or have configured Windows to not have the Control Panel as a menu, use the commands necessary to open the Control Panel window and then choose Add/Remove Programs.
2. Choose the version of Visio that you are using in the Currently Installed Programs list (Microsoft Office Visio Professional 2003 or Microsoft Office Visio Standard 2003).
3. To enter Maintenance mode, click Change.
4. Choose Add or Remove Features and click Next.
5. Expand the tree of features until you can see the feature you want to change. Click the feature and then select an option to remove it or run it. For more information about the update options that are available, refer to the section “Installing Visio on Your Computer” earlier in this chapter.
6. After you have made all your changes, click Update.

Repairing Your Visio Installation

You can find and correct problems with your Visio installation, such as missing files and registry settings. The Visio Detect and Repair command does not detect or repair problems with other Microsoft Office applications or fix problems with personal files, such as drawings.

Tip: If running Detect and Repair does not fix the problem, try reinstalling Visio.
To repair your Visio installation, follow these steps:

1. Choose Help ➤ Detect and Repair.

2. To restore the program shortcuts to the Microsoft Windows Start menu, check the Restore My Shortcuts While Repairing check box.

3. If your customized settings are hopelessly compromised, as a last resort you can restore default settings by checking the Discard My Customized Settings and Restore Default Settings check box.

   **Caution**

   Discarding your customized settings affects all Microsoft Office System applications, including Word and Excel. Checking the Discard My Customized Settings and Restore Default Settings check box resets the following: the application window’s size, menu and toolbar positions and customizations, the security level, view settings, the list of recently used files, and your user name and initials.

   If you still choose to discard your settings, you will have to reenter your user name and initials and then reset your environment when you restart Visio.

4. Click Start. Visio analyzes your installation and repairs any problems it finds.

## Learning More About Your Version of Visio

To learn about last-minute changes to Visio 2003, read the Microsoft Office Visio 2003 README file by following these steps:

1. Click Start ➤ My Computer. Double-click the drive on which you installed the Microsoft Office System. For earlier versions of the Windows operating system, open the Windows Explorer window and navigate to the drive that contains your Office installation.

   **Note**

   You can also open the My Computer window by double-clicking My Computer on your desktop.

2. Double-click Program Files, double-click Microsoft Office, and then double-click Visio11.

3. Double-click the folder corresponding to your language. For example, double-click 1033 for English or 1041 for Japanese.

4. Double-click VIREADME.htm.

When you’re connected to the Internet, you can also access the most up-to-date Help information by downloading Help topics from Microsoft Office Online. To change your Help settings, in the Help task pane, click the Online Content Settings link and make sure that the Show Content and Links from Microsoft Office Online check box and the Search Online Content When Connected check box are checked.
Summary

Whether you want to install Visio on one computer or hundreds, you can choose a method that makes installation easy. When you install Visio on your own computer, you can keep a copy of the installation on your hard disk so you can easily repair or reconfigure your installation without having to find your Visio CD. You can also use the Visio Setup program to add or remove Visio features, repair your Visio installation, or reinstall or uninstall the software.

In addition to the installation process, you must activate your copy of the software to use all its features. Activation doesn’t require any personal information; it is required solely to verify that you are installing a legal copy of the software.
Although many of its features are intuitive, Visio 2003 is a powerful tool with plenty of productivity shortcuts and special features. You can quickly increase your Visio expertise with the tools described in this quick reference.

The Getting Started Tutorial

The Getting Started Tutorial for Visio 2003 is a quick introduction to Visio’s basics. You can learn about basic concepts such as templates, stencils and shapes, components of the Visio interface, and how to obtain help.

The tutorial uses animations that demonstrate how to accomplish common tasks such as creating a drawing using a template. To start the tutorial, click Help ➪ Getting Started Tutorial. To watch an animation of the steps, expand a top-level topic, such as Create Diagrams, select a lesson, and then click Play (a green triangle) in the tutorial window. After watching the animation, you can minimize the tutorial window and duplicate the steps in Visio to perform the task on your own.

The tutorial covers creating drawings and adding shapes, connections, and text to those drawings. It shows how to format drawing contents and share drawings with others. Topics also include creating shapes, stencils, and templates. To familiarize you with working with specialized templates, the tutorial demonstrates how to create block diagrams, organization charts, and office layouts for scaled drawings.
Finding Help About Visio

When you are offline, Visio 2003 searches help topics stored on your computer. However, you can access help at Microsoft Office Online (http://office.microsoft.com/home/) when you are connected to the Internet. Microsoft Office Online provides more up-to-date help. You can read in-depth articles about Visio and other Office applications, study online training courses, and download templates and clip art.

To access specific pages of the Microsoft Office Online Web site in your browser, click one of the following links in the Help Task Pane:

- **Assistance** — Find help for any application in the Microsoft Office suite covering Office 97, Office 2000, Office XP, and Office 2003.

  To view any new Visio content on Microsoft Office Online, click New on the Web on the Visio Assistance page.

- **Training** — Take online training courses for any application in the Microsoft Office suite.

- **Communities** — Ask questions and obtain answers from other users through the Microsoft Office newsgroups.

- **Downloads** — Obtain additional tools, such as the Visio Viewer.

To open the Microsoft Office Online home page, choose one of the following methods:

- Choose Help ➤ Microsoft Office Online.

- Click Connect to Microsoft Office Online in the Getting Started or Help task pane.

You can access additional resources at Microsoft Office Online:

- **Templates** — Download additional templates and starter drawings. To locate Visio templates, type Visio in the Search box on the Templates page. You can also access Microsoft Office Online templates by clicking Templates on Office Online in the New Drawing Task Pane.

- **Clip Art and Media** — Download clip art and sounds.

- **Office Marketplace** — To increase your Visio productivity, obtain products from other companies or find a solution provider to help you customize Visio.

Viewing Visio Help Topics

Most people don’t read help files for fun. When you need assistance, you’re usually looking for help on a specific topic. To find help for a Visio topic, you can type a question or enter one or more keywords in the following locations:
By default, Visio displays help topics from Microsoft Office Online when you are connected to the Internet. When you are not connected to the Internet, Visio searches Offline Help.

If you want information about a broad topic, such as connecting shapes, the Visio table of contents is more useful. The table of contents pulls information from Microsoft Office Online if you are online; otherwise, it uses Microsoft Offline help. Follow these steps to quickly locate information for the topic you want in the Help table of contents:

1. Display the Help Task Pane by choosing View ➪ Task Pane. Click the down arrow in the task pane’s title bar and choose Help from the drop-down list.
2. Type a question or enter one or more keywords in the Search For box and click the green right arrow to start searching.
3. Look for a result that fits your keywords but is more general than specific, as demonstrated in Figure 38-1.
4. Click the table of contents heading, which is a gray link below the search result, as shown in Figure 38-1.

Configuring Your Help Settings

You can specify where Visio should look for help and what content it should display. To change your Online Content Settings, follow these steps:

1. Display the Help Task Pane by choosing View ➪ Task Pane, and then click the down arrow in the task pane’s title bar and choose Help from the drop-down list.
2. Click Online Content Settings under the See Also heading.
3. To use offline help, uncheck the Search Online Content When Connected check box.
4. To specify the online content you want to see, check one or more of the following check boxes:
   - **Search Online Content When Connected** — Displays online content when you are online
   - **Show Template Help When Available** — Displays help topics for the current template in the Template Help Task Pane
   - **Show Microsoft Office Online Featured Links** — Includes links to features at Microsoft Office Online in task panes
5. Click OK.
Searching the Microsoft Knowledge Base

The Microsoft Knowledge Base is a comprehensive database of support articles for every Microsoft product. No matter what keywords you enter, the Knowledge Base usually has some answers. To search the Microsoft Knowledge Base, follow these steps:

1. Navigate to [http://support.microsoft.com](http://support.microsoft.com) in your browser window.
2. Click Search the Knowledge Base.
3. Choose your version of Visio in the Select a Microsoft Product drop-down list.
4. Type keywords in the Search For box.
To maximize the relevance of your results, type words you would expect to find in an answer to your problem. Don’t use words that could apply to any answer, such as how, why, and is. To find help on errors, copy an error message in the Search For box.

5. Select options to specify how to use your keywords to search and how far back to look and then click the green arrow or click Go.

**Working with Visio Task Panes**

Task panes organize the features that are helpful for the most common tasks in Visio. The task pane docks on the right side of the screen by default. It is easy to work with task panes:

- To display the task pane in the drawing area, click View ➪ Task Pane.
- To choose a task pane, click the name of the task pane you want in the Task Pane drop-down list.

If you close the Visio task pane to display more of your Visio drawing, you can quickly display it again by clicking Ctrl+F1.

Visio 2003 includes several new task panes. The Help Task Pane includes links to the Microsoft Office Online Web site and a Search box in which you can enter questions or keywords. The Template Help Task Pane displays links to help topics for the template associated with the current drawing.

In addition to the Help and Template Task Panes, Visio includes several new task panes for collaboration, including Shared Workspace, Document Updates, and Reviewing.

**Accessing Help Quickly**

If you need only a hint about a shape or a toolbar command, ScreenTips are faster than help topics. To display ScreenTips, use one of the following methods:

- For a shape ScreenTip, pause the pointer over a master in a stencil. To obtain more information about the master, click More in the ScreenTip dialog box.
- For a toolbar ScreenTip, pause the pointer over the toolbar icon.

If you want help for a dialog box, click the question mark in the dialog box to display a help topic about the options in the dialog box.
Other Helpful Resources

Microsoft Office Online includes links to several additional Web sites with helpful resources. To navigate to these sites, click a link under the Related Web Sites heading:

✦ **Product Support** — Search the Knowledge Base, download software, work with Microsoft support technicians, or post a request to a community newsgroup at the Microsoft Support Web site.

✦ **Office Worldwide** — Navigate to the Microsoft Office Online Web site, which offers specialized content for a region or country.

✦ **Office Community** — Access Microsoft Office newsgroups.

✦ **Office Developer Center** — Navigate to the MSDN Web site to obtain Visio development resources and information.

✦ **Office Resource Kit** — Obtain tools to facilitate deploying Visio and other Office applications in your organization.

✦ **MS Press** — Find books and interactive training materials produced by Microsoft Press.

✦ **Microsoft.com** — Navigate to Microsoft’s home page.

✦ **Windows Update** — Review and install updates to your computer’s operating system, software, and hardware.

✦ **bCentral** — Obtain Office resources targeted for small businesses at Microsoft’s bcentral.com Web site (www.bcentral.com).

✦ **MSN** — This link takes you to MSN.com, Microsoft’s Web portal to all sorts of Internet content.

Summary

Visio offers a number of features you can use to learn about Visio. You can start with the Getting Started Tutorial. As you work, you can use the Visio Help Task Pane to find help on different topics or to select a topic from the Help table of contents. In addition, you can use numerous online help resources offered by Microsoft and many third parties.
Additional Resources for Templates and Stencils

Visio comes with dozens of templates and thousands of shapes. You can view thumbnails of diagram types in Visio to help you identify the one you want. You can also download additional templates and sample files from Microsoft Office Online.

Even with all of Microsoft’s Visio resources, you might not find what you need if you are producing highly specialized diagrams, such as detailed wiring diagrams for Juniper Networks equipment or a dog agility course. Fortunately, many companies provide additional templates and stencils for these applications. For example, you can obtain Visio stencils for some equipment when you purchase it from the manufacturer. Other companies sell third-party templates for a variety of applications. This chapter shows you how to find the templates and stencils that Visio offers, and templates, stencils, and other solutions from third-party resources and Web sites.

Using the Diagram Gallery

When you want to create a new drawing, Visio can help you select the right template for your drawing. When you select a category in the Choose Drawing Type Task Pane, Visio displays a simple example for each type of drawing in that category. If you position the pointer over an example, a description of the uses for that drawing type appears in the lower-left corner of the window. If these hints aren’t enough, you can browse through the Diagram Gallery to see more detailed examples and potential uses for each type of diagram.
To open the Diagram Gallery, choose Help  Diagram Gallery. You can browse through all the examples in the gallery by clicking Next or Back. Visio displays an example of the diagram, a description, and several potential uses, as shown in Figure 39-1. For example, when you choose a Floor Plan diagram, Visio specifies that a floor plan shows doors, windows, electrical outlets, and floor layout in a building. It describes how architects, general contractors, and facilities managers can use a floor plan to perform their work.

![Figure 39-1: Browse the Diagram Gallery to find the right template.](image)

The Diagram Gallery also provides links to templates and sample drawings on Microsoft Office Online. To find additional templates, click Templates in the Diagram Gallery to navigate to the Templates page at Microsoft Office Online. To download sample files, click Samples Diagrams to navigate to the Downloads page at Microsoft Office Online.

**Exploring the Visio Extras Stencils**

No matter what type of drawing you’re creating, you can use shapes from stencils other than the ones the template opens by default. Visio includes many of the most useful stencils in the Visio Extras category. To open one of these stencils, choose File  Shapes  Visio Extras and choose the stencil you want. Visio Extras stencils include shapes for annotations, backgrounds, borders and titles, callouts, connectors, patterns, dimensioning, symbols, title blocks, and more.

For a complete list of Visio Extras stencils, see Chapter 41.
Finding Templates and Samples at Microsoft Office Online

Microsoft Office Online provides additional templates as well as Visio files that contain sample content to get you started. For example, Microsoft Office Online includes 2004 calendars, localized network diagrams, and a DMAIC Flowchart for Six Sigma projects. To obtain templates online at the Templates page on Microsoft Office Online, follow these steps:

1. In the New Drawing Task Pane, click Templates on Office Online.
2. Type Visio in the Search box and click the green arrow to initiate the search. The search results include links to download templates and a rating for the template based on user opinion.
3. To download a template, click the name of the template. The download page shows a large example of a diagram for the template, the download size, and the version of Visio required to use the template.
4. Click Download Now. Visio opens a new drawing based on the downloaded template and displays help topics for the template in the Template Help Task Pane.

To download Visio files that contain sample diagrams that help you understand how to use those types of drawings, open the Downloads page at Microsoft Office Online by clicking Downloads in the Help Task Pane. To find Visio 2003 sample files, type Visio 2003 in the Search box. For example, you can download Visio 2003 Sample:20 Sample Diagrams file, which contains 20 diagrams with shapes already added, including a floor plan, flowchart, network diagram, calendar, electrical engineering control diagram, and a UML model. Use steps 3 and 4 above to download the file you want.

Finding Third-party Visio Templates and Stencils

Many equipment vendors offer Visio templates and stencils with shapes that represent the equipment they sell. For example, you can build accurate equipment layouts and network diagrams that show exactly where cables connect by downloading and using Visio templates from companies such as Dell, Cisco, and Hewlett-Packard. These templates include shapes that look just like their real-world components and contain connection points where network cables plug into the devices in real life.

In addition, third-party vendors and many service companies sell Visio templates for a variety of applications. If you are looking for a particular kind of template, enter keywords, such as “Visio,” “template,” and “networking” in your favorite search engine.
The following are a few online resources for finding, downloading, and purchasing templates and stencils:

- **An overall Visio resource site** — [www.mvps.org/visio/](http://www.mvps.org/visio/) offers all kinds of helpful Visio resources, including the following:
  - Information about using Visio
  - The newsgroups that Microsoft created for Visio
  - Links to other informational Web sites
  - Links to Web sites with stencils and templates for download or purchase. Click Download Sites to open a page that lists categories in alphabetical order on the left, and links to sites for templates and stencils on the right. The list includes companies under each category of template that they offer.
  - Examples of VBA code for Visio tasks

- **Visio Network Equipment** — If you obtained Visio Enterprise Network Tools before it was discontinued on June 30, 2003, you can download network shapes from [www.microsoft.com/office/visio/networkcenter/](http://www.microsoft.com/office/visio/networkcenter/).

- **Visimation.com** — This site sells stencils for numerous applications such as manufacturing, firefighting, restaurant management, and biology.

- **Templatesnext.com** — This site sells thousands of templates for categories such as agriculture, dating, jewelry, medical, and transportation.

- **Altimatech.com** — This site sells Visio stencils for over 1,300 IT equipment manufacturers, such as Cisco, Sun, Hewlett-Packard, Dell, Texas Instruments, and StorageTek.


- **Home-grown Sun Visio Templates** — Bruce Pullig offers the templates he created for Sun equipment at [www.visio.pullig.com](http://www.visio.pullig.com).

**Summary**

You can find many templates and stencils within Visio or within Microsoft’s online resources. In addition, thousands of third-party vendors sell additional templates and stencils for a variety of specialized applications. You can also find templates and stencils that individuals or companies offer at no charge by searching the Internet.
You can use keyboard shortcuts to increase your productivity and reduce fatigue. With keyboard shortcuts, you can keep your hands on the keyboard, saving the time it takes to switch between keyboard and mouse or to move the pointer to choose a command. Keyboard shortcuts can save significant time when you edit or format text, such as applying bold. They are equally effective for executing frequently used commands, such as Save. In addition, you can switch between using keyboard shortcuts and the mouse to give your fingers and muscles a break during long work sessions.

This chapter explains how to use keyboard shortcuts and identifies some of the more useful keyboard shortcuts built into Visio.

Using Keyboard Shortcuts

Many commands and tasks have their own keyboard shortcuts, whether it’s a function key, such as F4 to repeat your last action, or some combination of Ctrl, Shift, and letters of the alphabet, such as Ctrl-S to save. When a command has an associated keyboard shortcut, any menu entry for that command shows the keyboard shortcut after the command name.

In addition, you can easily access commands on menus and submenus by holding the Alt key while you press the letter underlined in a menu entry. For example, on the menu bar, the F in File is underlined. You can open the File menu by pressing Alt-F. While the File menu is open and you are still holding the Alt key, you can save your file by pressing S.

Note

Keyboard shortcuts in Help topics, menus, and dialog boxes refer to the U.S. keyboard layout. If the language for the keyboard layout you are using and the one you chose for Microsoft Office Visio or Visio Help are different, you might have to use different keys for your keyboard shortcuts.
Note

You can’t use Alt and a key for a second-level menu item unless the top-level menu is open. For example, Alt+S works only after you press Alt+F to open the File menu.

Handy Keyboard Shortcuts

Visio provides keyboard shortcuts for almost every command and menu entry. You can work on Visio drawings almost exclusively with the keyboard. However, if you can’t remember all those combinations of Ctrl, Shift, and Alt, memorize the keyboard shortcuts associated with the commands you use most frequently. This section includes a sampling of the more useful keyboard shortcuts. For a thorough list of keyboard shortcuts, type **keyboard shortcuts** in the Search box in the Help Task Pane and click the Help>Shortcut Keys link that appears.

File Shortcuts

File shortcuts make it easy to issue file-related commands, such as Open, New, Save, and Close.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+N</td>
<td>Open a new drawing based on the open drawing (File ➤ New ➤ New Drawing).</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Open the Open dialog box (File ➤ Open).</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save the active drawing (File ➤ Save).</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Open the Print dialog box (File ➤ Print).</td>
</tr>
<tr>
<td>Ctrl+F4</td>
<td>Close the active drawing window (File ➤ Close).</td>
</tr>
</tbody>
</table>

Action Shortcuts

You can quickly undo, redo, or repeat your actions with the following shortcuts.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Z</td>
<td>Undo the last action you performed (Edit ➤ Undo).</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>Redo the action undone by the Undo command (Edit ➤ Redo).</td>
</tr>
<tr>
<td>F4</td>
<td>Repeat the previous action. For example, if you just pasted a shape onto the page, you can paste another copy by pressing F4.</td>
</tr>
</tbody>
</table>

Editing and Formatting Shortcuts

Editing and formatting go much more quickly if you memorize and use the following keyboard shortcuts.
<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+X</td>
<td>Cut the selection from the active drawing and place it on the Clipboard (Edit ➤ Cut).</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy the selection to the Clipboard (Edit ➤ Copy).</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste the contents of the Clipboard to the active drawing page (Edit ➤ Paste).</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selection (Edit ➤ Clear).</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select all the shapes on the active page (Edit ➤ Select All).</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Copy the selection to the active drawing (Edit ➤ Duplicate). <strong>Note:</strong> You can copy a shape or text to the active drawing page by selecting it and then pressing Ctrl+D. You can make additional copies by pressing Ctrl+D again. To copy selected shapes or text to another drawing page or another application, use Ctrl+C to copy the selection to the Clipboard. After switching to the other page or application, press Ctrl+V to paste the contents of the Clipboard.</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Open the Find dialog box (Edit ➤ Find).</td>
</tr>
<tr>
<td>Ctrl+Shift+P</td>
<td>Toggle the Format Painter tool on or off.</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Toggle bold on or off.</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Toggle italic on or off.</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Toggle underline on or off.</td>
</tr>
<tr>
<td>Ctrl+F1</td>
<td>Toggle the task pane (View ➤ Task Pane).</td>
</tr>
<tr>
<td>Ctrl+Shift+I</td>
<td>Zoom to 100 percent magnification (View ➤ Zoom ➤ 100%).</td>
</tr>
<tr>
<td>Ctrl+W</td>
<td>Zoom to show the whole page (View ➤ Zoom ➤ WholePage).</td>
</tr>
<tr>
<td>Alt+F10</td>
<td>Maximize the Visio program window.</td>
</tr>
<tr>
<td>Alt+F5</td>
<td>Restore the Visio program window to its previous size after maximizing it.</td>
</tr>
<tr>
<td>Alt+Tab</td>
<td>Switch to the next program window.</td>
</tr>
<tr>
<td>Alt+Shift+Tab</td>
<td>Switch to the previous program window.</td>
</tr>
<tr>
<td>Ctrl+Tab</td>
<td>Make the next open drawing the active drawing.</td>
</tr>
<tr>
<td>Ctrl+F10</td>
<td>Maximize the active drawing window.</td>
</tr>
</tbody>
</table>

**Window and Viewing Shortcuts**

It’s easy to access different views or display different areas of a drawing with the following keyboard shortcuts.

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+F1</td>
<td>Toggle the task pane (View ➤ Task Pane).</td>
</tr>
<tr>
<td>Ctrl+Shift+I</td>
<td>Zoom to 100 percent magnification (View ➤ Zoom ➤ 100%).</td>
</tr>
<tr>
<td>Ctrl+W</td>
<td>Zoom to show the whole page (View ➤ Zoom ➤ WholePage).</td>
</tr>
<tr>
<td>Alt+F10</td>
<td>Maximize the Visio program window.</td>
</tr>
<tr>
<td>Alt+F5</td>
<td>Restore the Visio program window to its previous size after maximizing it.</td>
</tr>
<tr>
<td>Alt+Tab</td>
<td>Switch to the next program window.</td>
</tr>
<tr>
<td>Alt+Shift+Tab</td>
<td>Switch to the previous program window.</td>
</tr>
<tr>
<td>Ctrl+Tab</td>
<td>Make the next open drawing the active drawing.</td>
</tr>
<tr>
<td>Ctrl+F10</td>
<td>Maximize the active drawing window.</td>
</tr>
</tbody>
</table>
### Quick Reference

| **Ctrl+F5** | Restore the active drawing window size after maximizing it. |
| **F6** | Cycle focus through all open stencils, anchored windows, the task pane, and the drawing window. |
| **Print Screen** | Copy a picture of the screen to the Clipboard. |
| **Alt+Print Screen** | Copy a picture of the selected window to the Clipboard. |

### Zoom Shortcuts
The easiest way to zoom in or out is with the following keyboard shortcuts.

| **Alt+F6** | Zoom in. |
| **Alt+Shift+F6** | Zoom out. |

### Tool Shortcuts
You can check spelling or access macros with the following keyboard shortcuts.

| **F7** | Check the spelling on the active drawing (Tools ➤ Spelling). |
| **Alt+F8** | Open the Macros dialog box (Tools ➤ Macros ➤ Macros). |

### Shape Shortcuts
As you work on drawings, use the following shortcuts to work with and edit shapes.

| **Ctrl+G** | Group the selected shapes (Shape ➤ Grouping ➤ Group). |
| **Ctrl+L** | Rotate the selected shape to the left (Shape ➤ Rotate or Flip ➤ Rotate Left). |
| **Ctrl+R** | Rotate the selected shape to the right (Shape ➤ Rotate or Flip ➤ Rotate Right). |
| **Ctrl+H** | Flip the selected shape horizontally (Shape ➤ Rotate or Flip ➤ Flip Horizontal). |
| **Ctrl+J** | Flip the selected shape vertically (Shape ➤ Rotate or Flip ➤ Flip Vertical). |
| **F2** | Toggle between Text Edit and Shape Selection mode on a selected shape. |
| **Tab** | Change focus from shape to shape on the drawing page. Visio displays a dotted box around the shape with focus. |
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Shift+Tab</th>
<th>Change focus from current shape to previous shape on the drawing page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Select a shape that has focus.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To select multiple shapes, hold down Shift while you press Tab to cycle focus to another shape. When the shape you want has focus, press Enter to add that shape to the selection. Repeat for each shape you want to select.</td>
</tr>
<tr>
<td>Escape</td>
<td>Clear selection of or focus on a shape.</td>
</tr>
<tr>
<td>Arrow Keys</td>
<td>Nudge a selected shape.</td>
</tr>
</tbody>
</table>

### Dialog Box Shortcuts

When a dialog box is open, you can use the following keyboard shortcuts to move to the option or tab you want.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Move to the next option or option group.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift+Tab</td>
<td>Move to the previous option or option group.</td>
</tr>
<tr>
<td>Ctrl+Tab</td>
<td>Switch to the next tab in a dialog box.</td>
</tr>
<tr>
<td>Ctrl+Shift+Tab</td>
<td>Switch to the previous tab in a dialog box.</td>
</tr>
<tr>
<td>Arrow Keys</td>
<td>Move between options in an open drop-down list or between options in a group of options.</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Perform the action assigned to the selected button; check or uncheck the selected check box.</td>
</tr>
</tbody>
</table>

### Edit Box Shortcuts

An edit box is a field in a dialog box in which you type an entry, such as the name of a new page. The following keyboard shortcuts help you move and select edit box contents.

<table>
<thead>
<tr>
<th>Home</th>
<th>Move to the beginning of the entry.</th>
</tr>
</thead>
<tbody>
<tr>
<td>End</td>
<td>Move to the end of the entry.</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Move one character to the left.</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>Move one character to the right.</td>
</tr>
<tr>
<td>Ctrl+Left Arrow</td>
<td>Move one word to the left.</td>
</tr>
<tr>
<td>Ctrl+Right Arrow</td>
<td>Move one word to the right.</td>
</tr>
<tr>
<td>Shift+Home</td>
<td>Select everything from the insertion point to the beginning of the entry.</td>
</tr>
<tr>
<td>Shift+End</td>
<td>Select everything from the insertion point to the end of the entry.</td>
</tr>
</tbody>
</table>
**Menu and Toolbar Shortcuts**

Even when you use menus and toolbars, the following keyboard shortcuts can help you open and close menus or select the command you want.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F10 or Alt</td>
<td>Select the menu bar or close an open menu and submenu at the same time.</td>
</tr>
<tr>
<td>Tab</td>
<td>When a toolbar or menu bar is selected, select the next button or menu.</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>When a toolbar or menu bar is selected, select the previous button or menu.</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>When a menu or submenu is open, select the next command. Pressing the Up Arrow key selects the previous command.</td>
</tr>
<tr>
<td>Enter</td>
<td>Open the selected menu or perform the action for the selected button or command.</td>
</tr>
<tr>
<td>Escape</td>
<td>Close an open menu. When a submenu is open, close only the submenu.</td>
</tr>
</tbody>
</table>

**Help Shortcuts**

The Task Pane is a window within the Visio program window that provides access to all Visio help. The Help window is a separate window that displays topics and other Help content.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Display the Help Task Pane from a Visio window, or a context-sensitive topic from a Visio dialog box.</td>
</tr>
<tr>
<td>F6</td>
<td>Switch between the Help Task Pane and the active application.</td>
</tr>
<tr>
<td>Tab</td>
<td>Select the next item in the Help Task Pane or the next hidden text or hyperlink in the Help window.</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>Select the previous item in the Help Task Pane or the next hidden text or hyperlink in the Help window.</td>
</tr>
<tr>
<td>Enter</td>
<td>Perform the action for the selected item.</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>In a table of contents, select the next item. Pressing the Up Arrow key selects the previous item. In the Help window, the Down Arrow key scrolls down a small amount within the currently displayed Help topic. The Up Arrow key scrolls up in the Help topic.</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>In a table of contents, expand the selected item. The Left Arrow key collapses the selected item.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Scroll down one page within the currently displayed Help topic. The Page Up key scrolls one page up.</td>
</tr>
</tbody>
</table>
Summary

Keyboard shortcuts can save you time and reduce the finger and arm fatigue that ensues when you hold your hands over the mouse or keyboard for extended periods. Visio provides keyboard shortcuts for almost every command it offers, but you can increase your productivity by memorizing even a small subset of the available shortcuts. Even if you don’t know the function key or keyboard sequence for a command, you can select it from a menu or submenu by using the Alt key with the letters underlined in menu entries.
Visio comes with dozens of templates that you can use to create diagrams for work or play. Visio Standard 2003 provides templates for common diagramming tasks, such as building block diagrams, documenting business processes, or creating charts and graphs. You can also create basic diagrams for some architecture, engineering, and information technology tasks, such as laying out office space or creating a basic network diagram. Only a few of the architectural and engineering templates are available in the Standard version. The Basic Network Diagram template is the only informational technology template available in Visio Standard 2003.

When you want to create a variety of specialized diagrams, you'll want to use Visio Professional 2003. With the Professional version, you can create most of the common building plan diagrams, including electrical, HVAC, and mechanical plans. For information technology, you can create diagrams to document databases, networks, software, and Web sites using many of the popular modeling methodologies.

When you create a drawing with a template, Visio automatically opens stencils with the shapes typically used on that type of drawing. However, you can open additional stencils if you need other shapes. This chapter identifies the templates in each Visio category, the stencils these templates use, and the chapter of the book that describes how to use them. In addition, this chapter provides a list of the stencils available in the Visio Extras stencil category.
Templates for Office Productivity

Visio templates for office productivity run from the mundane block diagram to specialized diagrams for business process improvement methodologies such as Total Quality Management. Table 41-1 shows the templates for office productivity and business process improvement.

The Data Flow Diagram template is the only template that appears in an office productivity category that is available only with Visio Professional 2003. Several Flowchart templates, such as Basic Flowchart and Cross-functional Flowchart, are available in both the Flowchart and Business Process categories.

<table>
<thead>
<tr>
<th>Category</th>
<th>Template</th>
<th>Stencils</th>
<th>Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Diagram</td>
<td>Basic Diagram</td>
<td>Backgrounds, Borders and Titles, Basic Shapes</td>
<td>12</td>
</tr>
<tr>
<td>Block Diagram</td>
<td></td>
<td>Backgrounds, Borders and Titles, Blocks Raised, Blocks</td>
<td>12</td>
</tr>
<tr>
<td>Block Diagram</td>
<td>with Perspective</td>
<td>Backgrounds, Borders and Titles, Blocks with Perspective</td>
<td>12</td>
</tr>
<tr>
<td>Brainstorming Diagram</td>
<td>Brainstorming Diagram</td>
<td>Backgrounds, Borders and Titles, Brainstorming Shapes,</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Legend Shapes</td>
<td></td>
</tr>
<tr>
<td>Business Process</td>
<td>Audit Diagram</td>
<td>Backgrounds, Borders and Titles, Arrow Shapes, Audit</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Diagram Shape</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cause and Effect Diagram</td>
<td>Backgrounds, Borders and Titles, Arrow Shapes, Cause</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and Effect Diagram Shapes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EPC Diagram</td>
<td>Backgrounds, Borders and Titles, Arrow Shapes, Callouts,</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EPC Diagram Shapes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fault Tree Analysis</td>
<td>Backgrounds, Borders and Titles, Arrow Shapes, Fault</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tree Analysis Shapes</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Template</td>
<td>Stencils</td>
<td>Chapter</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Business Process (continued)</td>
<td>TQM Diagram</td>
<td>Backgrounds, Borders and Titles, Arrow Shapes, TQM Diagram Shapes</td>
<td>16</td>
</tr>
<tr>
<td>Charts and Graphs</td>
<td>Charts and Graphs</td>
<td>Backgrounds, Borders and Titles, Charting Shapes</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Marketing Charts and Diagrams</td>
<td>Backgrounds, Borders and Titles, Charting Shapes, Marketing Shapes, Marketing Diagrams</td>
<td>13</td>
</tr>
<tr>
<td>Flowchart</td>
<td>Basic Flowchart</td>
<td>Backgrounds, Borders and Titles, Arrow Shapes, Basic Flowchart Shapes</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>Cross Functional Flowchart</td>
<td>Arrow Shapes, Basic Flowchart Shapes, Cross Functional Flowchart Shapes (horizontal/vertical)</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>Data Flow Diagram</td>
<td>Backgrounds, Borders and Titles, Arrow Shapes, Data Flow Diagram Shapes</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>IDEF0 Diagram</td>
<td>IDEF0 Diagram Shapes</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>SDL Diagram</td>
<td>Backgrounds, Borders and Titles, SDL Diagram Shapes</td>
<td>15</td>
</tr>
<tr>
<td>Organization Chart</td>
<td>Organization Chart</td>
<td>Backgrounds, Borders and Titles, Organization Chart Shapes</td>
<td>14</td>
</tr>
<tr>
<td>Project Schedule</td>
<td>Calendar</td>
<td>Calendar Shapes</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>Gantt Chart</td>
<td>Backgrounds, Borders and Titles, Gantt Chart Shapes</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>PERT Chart</td>
<td>Backgrounds, Borders and Titles, PERT Chart Shapes</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>Timeline</td>
<td>Backgrounds, Borders and Titles, Timeline Shapes</td>
<td>17</td>
</tr>
</tbody>
</table>
Templates for Information Technology

You can use Visio information technology templates to document, design, and model your IT infrastructure and services. Whether you are working on software, hardware, or networks, you can find Visio templates to assist you. Table 41-2 shows the templates for information technology.

If you are using Visio Standard 2003, you can access the Basic Network Diagram only.

<table>
<thead>
<tr>
<th>Category</th>
<th>Template</th>
<th>Stencils</th>
<th>Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Database Model Diagram (Professional only)</td>
<td>Entity Relationship, Object Relational</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>Express-G (Professional only)</td>
<td>Express-G</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>ORM Diagram (Professional only)</td>
<td>ORM Diagram</td>
<td>19</td>
</tr>
<tr>
<td>Network</td>
<td>Basic Network Diagram</td>
<td>Backgrounds, Borders and Titles, Computers and Monitors, Network and Peripherals</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Active Directory (Professional only)</td>
<td>Active Directory Objects, Active Directory Sites and Services, Exchange Objects</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Detailed Network Diagram (Professional only)</td>
<td>Borders and Titles, Annotations, Callouts, Computers and Monitors, Network and Peripherals, Detailed Network Diagram, Network Locations, Network Symbols, Servers</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>LDAP Directory Diagram (Professional only)</td>
<td>LDAP Objects</td>
<td>23</td>
</tr>
<tr>
<td>Category</td>
<td>Template</td>
<td>Stencils</td>
<td>Chapter</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Network (continued)</td>
<td>Novell Directory Services Diagram (Professional only)</td>
<td>NDS Additional Objects, NDS GroupWise, NDS Objects, NDS Partitions, NDS ZenWorks</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Rack Diagram (Professional only)</td>
<td>Annotations, Callouts, Free-standing Rack Equipment, Network Room Elements, Rack-Mounted Equipment</td>
<td>23</td>
</tr>
<tr>
<td>Software</td>
<td>COM and OLE (Professional only)</td>
<td>COM and OLE</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Data Flow Model Diagram (Professional only)</td>
<td>Gane-Sarson</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Enterprise Application (Professional only)</td>
<td>Enterprise Application</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Jackson (Professional only)</td>
<td>Jackson</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Program Structure (Professional only)</td>
<td>Memory Structure, Language Level Shapes</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>ROOM (Professional only)</td>
<td>ROOM</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>UML Model Diagram (Professional only)</td>
<td>UML Activity, UML Collaboration, UML Component, UML Deployment, UML Sequence, UML Statechart, UML Static Structure, UML Use Case</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Windows XP User Interface (Professional only)</td>
<td>Common Controls, Icons, Toolbars and Menus, Wizards, Windows and Dialogs</td>
<td>21</td>
</tr>
<tr>
<td>Web Diagram</td>
<td>Conceptual Web Site (Professional only)</td>
<td>Backgrounds, Borders and Titles, Annotations, Callouts, Web Site Map Shapes, Conceptual Web Site Shapes</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Web Site Map (Professional only)</td>
<td>Web Site Map Shapes</td>
<td>22</td>
</tr>
</tbody>
</table>
Templates for Architecture and Engineering

Visio Professional 2003 provides templates for numerous architecture and engineering plans. You can build plans with Visio shapes or convert the contents of existing CAD drawings into Visio shapes. Table 41-3 shows the architecture and engineering templates. A few stencils for architecture and engineering don’t open automatically for any templates. You can access these stencils by choosing File ➤ Shapes, choosing the category you want, and then the stencil you want.

If you are using Visio Standard 2003, you can only access the Office Layout, Directional Map, and Directional Map 3D templates.

<table>
<thead>
<tr>
<th>Category</th>
<th>Template</th>
<th>Stencils</th>
<th>Chapter(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building Plan</td>
<td>Office Layout</td>
<td>Cubicles, Office Accessories, Office Equipment, Office Furniture, Walls, Doors, and Windows</td>
<td>25, 26</td>
</tr>
<tr>
<td>Electric and Telecom Plan (Professional only)</td>
<td></td>
<td>Annotations, Drawing Tool Shapes, Electrical and Telecom, Walls, Shell and Structure</td>
<td>26</td>
</tr>
<tr>
<td>Floor Plan (Professional only)</td>
<td></td>
<td>Annotations, Building Core, Dimensioning-Architectural, Drawing Tool Shapes, Electrical and Telecom, Points of Interest, Walls, Shell and Structure</td>
<td>25, 26</td>
</tr>
<tr>
<td>Home Plan (Professional only)</td>
<td></td>
<td>Annotations, Appliances, Bath and Kitchen Plan, Building Core, Cabinets, Dimensioning-Architectural, Drawing Tool Shapes, Electrical and Telecom, Furniture, Garden Accessories, Walls, Shell and Structure</td>
<td>25, 26</td>
</tr>
<tr>
<td>HVAC Control Logic Diagram Plan (Professional only)</td>
<td></td>
<td>Annotations, HVAC Controls, HVAC Controls Equipment</td>
<td>26</td>
</tr>
<tr>
<td>Category</td>
<td>Template</td>
<td>Stencils</td>
<td>Chapter(s)</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Building Plan (continued)</td>
<td>HVAC Plan (Professional only)</td>
<td>Annotations, Building Core, Drawing Tool Shapes, HVAC Ductwork, HVAC Equipment, Registers Grills and Diffusers, Walls, Shell and Structure</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>Plant Layout Plan (Professional only)</td>
<td>Annotations, Building Core, Dimensioning-Architectural, Drawing Tool Shapes, Electrical and Telecom, Shop Floor-Machines and Equipment, Shop Floor-Storage and Distribution, Vehicles, Walls, Shell and Structure</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>Plumbing and Piping Plan (Professional only)</td>
<td>Annotations, Drawing Tool Shapes, Pipes and Valves–Pipes 1, Pipes and Valves–Pipes 2, Pipes and Valves–Valves 1, Pipes and Valves–Valves 2, Plumbing, Walls, Shell and Structure</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>Reflected Ceiling Plan (Professional only)</td>
<td>Annotations, Building Core, Drawing Tool Shapes, Electrical and Telecom, Registers Grills and Diffusers, Walls, Shell and Structure</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>Security and Access Plan (Professional only)</td>
<td>Annotations, Alarm and Access Control, Initiation and Announcement, Video Surveillance, Walls, Shell and Structure</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>Site Plan (Professional only)</td>
<td>Annotations, Dimensioning-Architectural, Drawing Tool Shapes, Garden Accessories, Irrigation, Parking and Roads, Planting, Points of Interest, Site Accessories, Sport Fields and Recreation, Vehicles</td>
<td>26</td>
</tr>
<tr>
<td>Category</td>
<td>Template</td>
<td>Stencils</td>
<td>Chapter(s)</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Electrical Engineering</td>
<td>Basic Electrical Diagram</td>
<td>Fundamental Items, Qualifying Symbols, Semiconductors and Electron Tubes, Switches and Relays, Transmission Paths</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>(Professional only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Circuits and Logic</td>
<td>Diagram</td>
<td>Analog and Digital Logic, Integrated Circuit Components, Terminals and Connectors, Transmission Paths</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>(Professional only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Industrial Control</td>
<td>Systems</td>
<td>Fundamental Items, Rotating Equip and Mech Functions, Switches and Relays, Terminals and Connectors, Transformers and Windings, Transmission Paths</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>(Professional only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Systems</td>
<td>(Professional only)</td>
<td>Composite Assemblies, Maintenance Symbols, Maps and Charts, Switches and Relays, Telecom Switch and Peripheral Equip, Terminals and Connectors, Transformers and Windings, Transmission Paths, VHF-UHF-SHF</td>
<td>29</td>
</tr>
<tr>
<td>Map</td>
<td>Directional Map</td>
<td>Landmark Shapes, Metro Shapes, Recreation Shapes, Transportation Shapes, Road Shapes</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>Directional Map Shapes 3D</td>
<td></td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>(Professional only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Part and Assembly Diagram</td>
<td>Annotations, Dimensioning–Engineering, Drawing Tool Shapes, Fasteners 1, Fasteners 2, Geometric Dimensioning and Tolerancing, Springs and Bearings, Title Blocks, Welding Symbols</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>(Professional only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Template</td>
<td>Stencils</td>
<td>Chapter(s)</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td></td>
<td>(Professional only)</td>
<td>Equipment–Pumps, Equipment–Vessels, Instruments, Pipelines, Process Annotations, Valves and Fittings</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Professional only)</td>
<td>Equipment–Pumps, Equipment–Vessels, Instruments, Pipelines, Process Annotations, Valves and Fittings</td>
<td></td>
</tr>
</tbody>
</table>

**Visio Extras Stencils**

Several handy stencils are grouped within the Visio Extras category. Many templates open the following stencils, but you can use them to annotate and embellish any type of drawing:

- Annotations
- Backgrounds
- Borders and Titles
- Callouts
- Connectors
- Custom Line Patterns
- Custom Patterns–Scaled
- Custom Patterns–Unscaled
- Dimensioning–Architectural
- Dimensioning–Engineering
- Drawing Tool Shapes
- Embellishments
- Symbols
- Title Blocks
Summary

Visio Standard 2003 provides templates for basic diagramming tasks, but you’ll want to use Visio Professional if you create specialized diagrams. Visio automatically opens stencils when you use a template to create a drawing, but you can open other stencils if you need different shapes.
Index

NUMERICS
1-D Endpoints section (ShapeSheets), 646
1-D shapes, 11, 598–599
2-D shapes, 11, 598–599
3-D bar graphs, 241
3-D block diagrams, 233–235
3-D boxes, 229
3-D maps, 505
3-D pyramids in charts, 250
80-20 charts, 288

cubicles to office building layouts, 490–491
custom properties to shapes, 294
data to flowcharts, 293
dimensions to scaled drawings, 461–463
events (calendars), 301–302
features after installation, 696
functional bands (cross-functional
flowcharts), 282
Gantt charts to drawings, 312
intervals (timelines), 306
line jumps (connectors), 106
menus
to menus, 674
to toolbars, 673
milestones (timelines), 306
pages
to drawings, 33–34
to organization charts, 262
PERT charts to drawings, 320
process steps (flowcharts), 281
resources to space plans, 520–521
ScreenTips, 630
shapes
to flowcharts, 275–276
to stencils, 588–591
toolbar buttons, 672
topics to brainstorming diagrams, 326,
328–329
tree branches, 232
add-ins (COM), 684–685
add-ons
Color By Values, 447
Label Shapes, 446, 506
metric units, 694
Move Shapes, 79–80
Number Shapes, 446
publishing, 682
ShapeStudio, 682
U.S. measurement units, 694
adjusting tree branch position, 232

A
ABC Flow Charter (versions 2.0, 3.0, and 4.0), 7
accessing
commands, 709
drawing tools, 26
help, 703
ScreenTips, 703
shape masters, 583
Visual Basic Editor, 685
actions
keyboard shortcuts, 710
redoing, 83
undoing, 83
Actions section (ShapeSheets), 650–651
activating
layers, 473
new Visio installation, 694–695
Active Directory
Active Directory Sites and Services stencil, 442
Active Directory template, 436, 720
ActiveX controls
Visio Drawing Control, 682, 685
Visio Viewer, 208
adding
appointments (calendars), 301–302
callouts to drawings, 124
comments to drawings, 113
connection points, 101, 621

adjusting tree branch position, 232
administrative installation point (Microsoft Office 2003), 690
Adobe Illustrator, 7
Advanced File Search task pane, 48–49
Agile Database Techniques, Scott Ambler, 343
Agile Modeling, Scott Ambler, 343, 398
agriculture templates, 708
aliased text, 108
aligning shapes to grid, 105
alignment
numbered lists, 132–133
paragraphs, 131
pattern shapes, 665
shapes, 81, 614
text blocks, 130
walls, 486
Altimatech.com Web site, 708
Ambler, Scott
Agile Database Techniques, 343
Agile Modeling, 343, 398
The Object Primer, 3rd Edition: Agile Model Driven Development with UML 2.0, 370, 398
animation, 167–168
annotations
brainstorming diagrams, 332–333
building plans, 505–506
charts, 242, 251
flowcharts, 277
freehand, 219–220
Gantt charts, 316
graphs, 242, 251
ink, 6, 219–220
Web diagrams, 419
Annotations stencil, 123, 725
antialiased text, 108
applying
color schemes, 141–142
colors from color palette, 139
custom properties, 630–631
formats
to bulleted lists, 131–132
to fills (of shapes), 133
Format Shape toolbar, 128
Format Text toolbar, 128–129
Formatting toolbar, 128
to lines, 128–129
methods, 127
to numbered lists, 131–133
to paragraphs, 130–131
to shapes, 133–134
to text, 129–130
to text blocks, 130–131
pattern shapes, 664
styles, 137–138, 658–659
Applying UML and Patterns: An Introduction to Object-Oriented Analysis and Design and the Unified Process, C. Larman, 371
appointments (calendars)
adding, 301–302
deleting, 302
editing, 302
text, 302
Arc tool, 28–29
architecture templates, 722–724
arcs
breaking shapes into arcs, 618–619
drawing, 28–33, 612–613
flipping, 30
moving, 29
reshaping, 30
rotating, 30
area of shapes, calculating, 464–465
arranging shapes
layout, 104–105
Web diagrams, 418–419
arrays of shapes, 84–85
arrows
block diagrams, 230
branching arrows, 285
curved, 230
flexi-arrows, 230
forked arrows, 285
joined arrows, 285
lines, 129
modifying, 230
timelines, 309
art for calendar, 301
Asian languages, 216–217
assigning
groups to layers, 478
letters to keyboards shortcuts, 678
masters to layers, 477–478
resources to space plans, 519–520
shapes to layers, 476–477
assistants (organization charts), 255
associating departments with process steps (flowcharts), 281–282
association line (brainstorming diagrams), 326
audit diagrams
Audit Diagram Shapes stencil, 288
Audit Diagram template, 273, 288, 718
uses, 288
author (file), 47
auto-height boxes, 229
automatic layout of shapes, 102
automating Visio
additional resources, 686
COM add-ins, 684–685
developers’ tools, 682
macros, 682–684
Visio Drawing Control 2003, 685
Automation development environment, 684
auto-size boxes, 229
averaging shape size, 105
axis labels (bar/line graphs), 246–247

B
background colors
stencils, 592
text blocks, 130
background pages
deleting, 34
drawings, 34
layers, 475
printing, 56
templates, 580
backgrounds
flowcharts, 278
text blocks, 130–131
Backgrounds stencil, 725
bar graphs, 241, 243–245
Basic Diagram template, 225, 718
Basic Electrical Diagram template, 548, 724
Basic Flowchart Shapes stencil, 274
Basic Flowchart template, 272, 719
Basic Network Diagram template, 434–436, 720
Basic Shapes stencil, 225–226
bcentral.com Web site, 704
behaviors (shapes)
configuring, 103
connector splitting, 628
defined, 596
double-click behaviors, 623–624
group-related, 628–629
modifying, 626
pattern shapes, 664
placement, 103, 625–626
preventing shapes from printing, 626
selection, 627
switching between 1-D and 2-D behavior, 627
bending shape segments in block diagrams, 229
biology templates, 708
blank drawings, 26
Block Diagram with Perspective template, 233
block diagrams
arrows, 230
blocks, 224–225
boxes, 229
color schemes, 228
creating, 227–228
flow, 230–231
modifying, 228–229
onions, 224–225, 235–238
positioning shapes, 228
rearranging shapes, 228
relationships, 224, 228
shapes, 223, 228–229
stencils
Basic Shapes, 225–226
Blocks, 226
Blocks Raised, 226
Blocks with Perspective, 227
templates
   Basic Diagram, 225, 718
   Block Diagram, 225, 718
   Block Diagram with Perspective, 225, 233, 718
text, 228
3D, 233–235
trees, 224–225, 231–233
uses, 223–224
Blocks Raised stencil, 226
Blocks stencil, 226
Blocks with Perspective stencil, 227
borders
   Borders and Titles stencil, 125, 725
   flowcharts, 278
   shapes, 134
Boundary and Space shapes, 510–511, 517–518
boxes
   auto-height, 229
   auto-size, 229
   block diagrams, 229
   3-D boxes, 229
brainstorming data
   exporting, 336
   importing, 336
brainstorming diagrams
   annotations, 332–333
   appearance options, 332
   color schemes, 332
   connector styles, 331
   creating, 326
   exporting, 325
   layout, 329–331
   legends, 332–335
   outlines, 325
   resizing pages to fit, 331
   symbols, 334–335
   themes, 332
topics
   adding, 326
   adding multiple topics at once, 328–329
   association lines, 326
   connecting, 326–327, 329
   copying, 330
   hyperlinks, 328
   main topics, 327
   moving, 330–331
   peer topics, 328
   rearranging, 330
   reordering, 330
   shapes, 325–326, 332
   subtopics, 328
Web diagrams, 416
brainstorming tools
   Brainstorming Shapes stencil, 325
   Brainstorming template, 273, 323–324, 718
   Brainstorming toolbar, 324–325
   Legend Shapes stencil, 326, 333–334
   Outline window, 325
branches (trees)
   adding, 232
   adjusting position, 232
   deleting, 232
   distance between, 233
   removing, 232
branching arrows, 285
breaking organization charts across pages, 262
breaking shapes
   groups of shapes, 88–89
   into lines and arcs, 618–619
   into smaller pieces, 616
Browse Templates dialog box, 581
building plans. See also plan drawings; scaled drawings
   annotation, 505–506
   Electric and Telecom Plan template, 452, 722
   Floor Plan template, 452, 722
   Home Plan template, 453, 722
   HVAC Control Logic Diagram Plan template, 453, 722
   HVAC Plan template, 453, 723
   labeling, 506
   Office Layout template, 452, 722
   Plant Layout template, 453, 723
   Plumbing and Piping Plan template, 453, 723
   Reflected Ceiling Plan template, 453, 723
   Security and Access Plan template, 453, 723
   Site Plan template, 453, 723
building services plans
  ceiling grids, 497–498
  creating, 493
  electrical and telecom services, 498–499
  HVAC Control Logic diagrams, 496–497
  HVAC services, 493–495
  plumbing, 499–500
  security and access systems, 500

built-in templates
  customizing, 577–581
  location of, 580–581
  number of, 577
  organizing, 581

bulleted lists
  bullet symbols, 132
  creating, 131–132
  formatting, 131–132
  indents, 132

business process improvement methodologies, 287

business processes
  audit diagrams, 288
  cause and effect diagrams, 288–290
  event process chain (EPC) diagrams, 290–291
  fault tree analysis diagrams, 291–292
  fishbone diagrams, 288
  Ishikawa diagrams, 288
  Six Sigma business improvement process, 291–292
  TQM (Total Quality Management) diagrams, 292
  work flow diagrams, 293

Button Editor dialog box, 677

buttons (toolbars)
  adding, 672
  deleting, 673, 677
  displaying, 673
  hiding, 673
  image options, 677
  images, 678
  macros, 677
  rearranging, 673
  removing, 677
  resetting, 677
  saving custom buttons, 676
  ToolTips, 677

C

CAD drawings
  CAD library stencils, 545
  converting
    CAD drawings to Visio format, 541–545
    Visio drawings to CAD format, 545–546
  displaying, 534
  drawing scale, 537–539
  external file references, 536
  inserting, 469, 534
  invisible, 540
  layers, 471, 535
  measurement units, 537
  modifying, 536–537
  positioning, 540–541
  protecting, 539
  resizing, 540–541
  reviewing, 535
  viewing, 467, 534

CAD integration, 5, 8, 532–533

CAD programs, comparison with Visio, 533

calculating area and perimeter of shapes, 464–465

Calendar template, 298, 719

calendar
  appointments
    adding, 301–302
    deleting, 302
    editing, 302
    text, 302
  art, 301
  Calendar Shapes stencil, 301
  color schemes, 301
  colors, 301
  consolidating, 303
  creating, 298–300
  daily, 299
  date settings, 301
Continued
calendars (continued)
events
adding, 301–302
deleting, 302
editing, 302
text, 302
formatting, 301
Import Outlook Data Wizard, 303–304
importing Outlook calendar data, 175–176, 303–304
modifying, 301
monthly, 299–300
pages, 300
titles, 301
weekly, 299
yearly, 300
callouts
adding to a drawing, 124
custom properties, 124
moving, 124
onion diagrams, 237
stencils, 123, 725
uses, 123
caps (for lines), 129
Cascade command (Window menu), 21
cascading windows, 21
Category Explorer, 512–514
Cause and Effect Diagram template, 273, 288–289, 718
cause and effect diagrams, 288–290
CD installation of Visio, 691
ceiling grids, 497–498
Celko, J., Data and Databases: Concepts in Practice, 342
centering drawings when printing, 58
Change Topic dialog box, 326
character sets
Chinese character-encoding standard
GB18030, 6, 215
End User Defined, 6, 215
Unicode, 6, 215
Charting Shapes stencil, 121–123, 240–242
charts
annotations, 242, 251
Charting Shapes stencil, 240–242
Charts and Graphs template, 239–240, 719
divided bars, 242
80-20 charts, 288
Excel spreadsheets, 239
extendable shapes, 251–252
feature comparison charts, 242, 248–249
flowcharts
adding data, 293
adding shapes, 275–276
adding shapes in a sequence, 275–276
annotations, 277
Audit Diagram template, 273
backgrounds, 278
Basic Flowchart Shapes stencil, 274
Basic Flowchart template, 272, 719
borders, 278
Brainstorming template, 273
Cause and Effect Diagram template, 273
color schemes, 278
connecting shapes, 275
creating, 272, 275
cross-functional, 280–282
Cross-Functional Flowchart Shapes stencil, 274
Cross-Functional Flowchart template, 272, 719
Data Flow Diagram Shapes stencil, 274
Data Flow Diagram template, 273, 719
data flow diagrams, 283–284
data loops, 284
data stores, 284
DMAIC Flowchart, 292
templates, 284
template, 284
template, 284
EPC Diagram template, 273
external interactor, 284
Fault Tree Analysis Diagram template, 273
formatting, 278
functional bands, 282–283
hyperlinks, 279–280
IDEF0 Diagram template, 273, 719
IDEF0 diagrams, 285–286
IDEF0 Shapes stencil, 274
Import Flowchart Data Wizard, 6, 272
layout, 276
modifying, 277
multiple pages, 278–279
nonsequential, 276–277
numbering shapes, 276
off-page references, 280
on-page references, 279
Organization Chart template, 719
process steps, 281
processes, 284
rearranging shapes, 277
reversing direction of flow, 278
SDL Diagram template, 273, 719
SDL diagrams, 286
separators, 283
shapes, 274, 284
states, 284
synchronizing, 279–280
titles, 278
TQM Diagram template, 273
uses, 271
Work Flow Diagram template, 273
Gantt charts
adding to drawings, 312
annotations, 316
creating, 298, 312–313
data entry, 318–319
exporting, 319
formatting, 317
Import Project Data Wizard, 317–318
importing Microsoft Project data, 317–318
milestones, 314
modifying, 313, 316–317
navigating, 313–314	
task details, 313
tasks, 314–315
uses, 311
working time, 316
grids, 242
Marketing Diagrams stencil, 242–243
Marketing Shapes stencil, 242
organization charts
adding pages, 262
assistants, 255
breaking, 262
changing position types, 268
comparing, 269
consultants, 255
creating, 254–259, 262–263
creating with existing organization data, 259–261
deleting shapes, 266–267
Dotted Line Report connector, 256
editing shapes, 267–268
employee photos, 264
Excel spreadsheets, 270
executive summaries, 262
executives, 255
exporting, 270
fields, 265
hiding subordinates, 266
hyperlinks, 261, 269
layout, 263–264
managers, 255
modifying shapes, 267–268
moving shapes, 266
multiple pages, 268–269
Organization Chart Conversion Utility, 6
Organization Chart stencil, 254–255
Organization Chart template, 253–254, 719
Organization Chart toolbar, 254
Organization Chart Wizard, 257–259
positions, 255
readability, 265–266
reordering subordinates, 267
reports, 270
setting options, 264–265
shapes, 265
sharing, 269–270
spacing, 266
staff positions, 255
subordinates, 255
superiors, 255
synchronizing, 261, 268
team frame, 256
text, 265
three positions, 256
uses, 253
vacancies, 255
Continued
charts (continued)
  Pareto charts, 288
  PERT charts
    adding to drawings, 320
    creating, 298, 320–321
    project summaries, 321–322
    uses, 319–320
  pie charts, 241, 247–248
  stackable shapes, 251–252
  tabular charts, 242
  text, 251
  3-D pyramids, 250
  triangular charts, 250
  uses, 239
Charts and Graphs template, 239–240, 719
checking spelling, 108, 118
Chinese character-encoding standard GB18030, 6, 215
Choose Drawing Type command (File menu), 24
Choose Drawing Type pane, 24
Choose Profile dialog box, 303
circles, drawing, 32
circle-spoke diagrams, 249–250
Circuits and Logic Diagram template, 548, 724
clip art
  Clip Art task pane, 163
  Corel Clipart, 7
  finding, 163–164
  inserting, 163
  Microsoft Office Online, 700
  searching, 163–164
closed shapes, 600, 609–610
closing task panes, 703
Code Editor window, 361
collaboration
  document workspaces, 6, 209–214
  ink, 6, 219–220
  language support, 6, 215–217
  online meetings, 212
  track markup, 6, 217–221
  Visio Viewer, 6, 208–209
collapsing site maps, 423
Color By Values add-on, 447
color palette
  applying colors from, 139
  copying, 140–141
  defined, 139
  modifying, 140
  restoring, 140–141
  templates, 580
color schemes
  applying, 141–142
  block diagrams, 228
  brainstorming diagrams, 332
  calendars, 301
  creating, 142
  defined, 141
  editing, 142
  flowcharts, 278
  modifying, 142
  PowerPoint presentations, 165
  templates, 580
Color Settings dialog box, 142
color-coding
  network diagrams, 446–447
  shapes, 143
  space plans, 527
colors
  applying, 139
  calendars, 301
  creating, 139
  custom colors, 139
  default colors, 142
  fills (shapes), 133, 139
  layers, 475–476
  lines, 129
  number of, 138
  pattern shapes, 665
  selecting, 139
  transparency levels, 138
  using, 139
  viewing, 139
  walls, 487
Colors dialog box, 139
COM
  add-ins, 684–685
  COM Add-Ins and Automation Events, 44
COM and OLE template, 398, 721
defined, 399
elements of, 399–400
GUIDs, 400
interfaces, 399–400
relationships, 401
Vtables, 400
combining shapes, 615
Comma Separated Values (CSV) files, 7
commands
accessing, 709
adding to menus, 674
keyboard shortcuts, 709
personalized menus and toolbars, 672
rearranging on menus, 675
removing from menus, 674
comments
adding, 113
deleting, 113
editing, 113
inserting, 219
moving, 113
viewing, 113
communication connections (network diagrams), 438
comparing
organization charts, 269
Web site maps, 427
compressed CD image (Microsoft Office 2003), 691
Computer Graphics Metafile, 7
Conceptual Web Site Shapes stencil, 417
Conceptual Web Site template, 415–417, 721
Configure dialog box, 299
Configure Interval dialog box, 306
Configure Milestone dialog box, 306
Configure Timeline dialog box, 305, 307
configuring
behaviors (shapes), 103
help settings, 701–702
legends in brainstorming diagrams, 335
Connect Shapes command (Shape menu), 99
connecting
lines, 28
shapes in flowcharts, 275
topics (brainstorming diagrams), 326–327, 329
walls, 484–486
Connection Point tool, 101–102
connection points
adding, 101, 621
blue x indicator, 10, 96
changing types, 623
defined, 598
deleting, 101–102, 621
illustration, 11
inward, 101, 622
inward & outward, 101, 622
moving, 101–102, 621
outward, 101, 622
valid connections, 622
connections
dynamic, 102
shape-to-shape, 102
Connector tool, 98
connectors
brainstorming diagrams, 331
Connector tool, 98
Connectors stencil, 96–97
control points, 99
creating, 97–98
curved, 104
defined, 12, 95
direction, 104
direction information, 96
Dotted Line Report, 256
dynamic, 98
dynamic connectors, 12–13
dynamic-static, 98
derpoint, 12, 96–97
glue, 13–14, 100–101
jumps, 38, 106
layout and routing settings, 37–38
line jumps, 38, 106
methods for using, 97
modifying path of, 105
routing styles, 104–105
sequence of shapes, 99
spacing, 105–106

Continued
connectors (continued)
splitting, 38, 628
start point, 12
static, 98
static-dynamic, 98
straight, 104
straight connectors, 12–13
text, 109
Connectors stencil, 96–97, 725
consolidating
calendars, 303
shape masters, 583
consultants (organization charts), 255
control handles (shapes), 11, 598
control points, 598
control points (connectors), 99
Convert to Walls dialog box, 482
converting
CAD drawings to Visio format, 541–545
linked objects to embedded objects, 157
spaces into walls, 482–484
Visio drawings to CAD format, 545–546
coordinates, 78–79
copying
color palette, 140–141
formatting, 134
plan drawings, 469–470
shape masters, 84
shape masters (stencils), 590
shapes, 84
stencils, 588
styles, 663
text formatting, 130
text from other applications, 116
topics (brainstorming diagrams), 330
copyrights on shape masters, 583
Corel Clipart, 7
CorelDRAW! (versions 3.0 through 7.0), 7
CorelFLOW 2.0, 7
correcting text, 116
creating
block diagrams, 227–228
brainstorming diagrams, 326
building services plans, 493
bulleted lists, 131–132
calendars, 298–300
charts
feature comparison charts, 248–249
flowcharts, 272, 275
Gantt charts, 298, 312–313
organization charts, 254–263
PERT charts, 298, 320–321
pie charts, 247–248
3-D pyramids, 250
triangular charts, 250
color schemes, 142
colors, 139
connectors, 97–98
control handles (shapes), 11, 598
custom properties, 631–633
database models, 344
document workspaces, 210–211
drawings, 23–26
engineering drawings, 549
graphs
bar graphs, 243–245
line graphs, 246
guides, 74
hyperlinks, 148
keyboard shortcuts, 678
landscaping plans, 501
layers, 471–472
legends, 335
masters (shapes), 600–602
menus, 671, 675
network diagrams, 437
numbered lists, 132–133
OLE links, 148
onion diagrams, 235
pattern shapes, 664–665
patterns, 669–670
plan drawings, 468
ShapeSheet formulas, 653–654
site plans, 501
space plans, 514–516
stencils
from document stencil, 585–586
from existing stencils, 584
read-only option, 584, 588–589
from scratch, 585
from shape search results, 585
shortcuts, 583–584
styles, 136, 660–662
tab stops, 130
tables, 121–122
templates, 577–580
timelines, 305–306
toolbars, 671, 675
UML diagrams, 381–382
walls, 482, 484–485
Web diagrams, 416
Web pages, 179–180
windows, 20–21
cropping embedded objects, 161
Cross-Functional Flowchart Shapes stencil, 274
Cross-Functional Flowchart template, 272, 719
cross-functional flowcharts, 280–282
CSV (Comma Separated Values) files, 7
Cubicles stencil, 490–491
curved arrows, 230
curved connectors, 104
curves
  creating from lines, 620
drawing, 28–29, 31
freeform
drawing, 30
snapping, 27
parallel, 619
custom colors, 139
custom formula field type, 111
Custom Line Patterns stencils, 725
custom patterns, 663–664
Custom Patterns–Scaled stencils, 725
Custom Patterns–Unscaled stencils, 725
custom properties
  adding, 294
  applying, 630–631
callouts, 124
creating, 631–633
defined, 596
deleting, 633
displaying in shape text, 634
editing, 633
generating reports from, 294–295
options, 632
reports, 637–641
sets, 634–637
uses, 294
Custom Properties dialog box, 294
custom properties field type, 111
Custom Properties section (ShapeSheets), 646, 651
Custom Properties window, 19
Customer Experience Improvement Program, 5
customer feedback, 5
Customize dialog box
  Options tab, 672
  Toolbars tab, 675
Customize, Toolbars commands (Tools menu), 672
customizing
  built-in templates, 577–581
document stencils, 585–586
menus, 671, 674–675
toolbars, 671–673
cutouts (shapes), 617–618

D
daily calendars, 299
Data and Databases: Concepts in Practice,
  J. Celko, 342
data entry for Gantt charts, 318–319
Data Flow Diagram Shapes stencil, 274
Data Flow Diagram template, 273, 719
data flow diagrams (DFDs), 283–284, 401–402
Data Flow Model Diagram template, 6, 398, 721
data loops (flowcharts), 284
data stores (flowcharts), 284
database diagrams, 720
database links
  drawings, 190–191, 196–197
  limitations, 191
  masters (shapes), 194–196
  ODBC data sources, 191–193
  shapes, 188–190, 193–194, 261
  synchronizing, 199–202
Database Model Diagram template, 342, 720
database models
  Code Editor window, 361
  creating, 344
  data types, 356–357
  Database Properties window, 349–352
  display options, 363
  editing code, 360–361
  Entity Relationship stencil, 343
  Express-G, 363–365
  importing, 345
  indexes, 359
  keys, 354–355
  notation, 363
  Object Relational stencil, 343
  options, 361, 363
  ORM, 363–367
  Output window, 349
  preferences, 361–362
  refreshing, 348
  relational notation, 353
  relationships, 358–359
  reverse engineering, 345–348
  shapes, 343–344
  tables, 352–353, 355–357
  templates, 342
  updating shapes, 343–344
  uses, 341
  views, 357–358
  Visio for Enterprise Architects, 342
  Database Properties window, 349–352
  Date, C. J., *An Introduction to Database Systems, Seventh Edition*, 342
  date settings (calendars), 301
  date/time field type, 111
  dating templates, 708
  deactivating glue, 100
  default colors, 142
  default styles, 658
  Define Styles command (Format menu), 136
  Define Styles dialog box, 136
  Delete Pages command (Edit menu), 39
  Delete Pages dialog box, 39
  deleting
    appointments (calendars), 302
    background pages, 34
  comments, 113
  connection points, 101–102, 621
  custom properties, 633
  document workspaces, 213
  events (calendar), 302
  features after installation, 696
  functional bands (cross-functional flowcharts), 282
  guides, 75
  installation files, 694
  layers, 473–474
  legends, 335
  markup, 221
  masters (shapes), 590, 602
  menu commands, 674
  menus, 675
  pages, 34, 39
  ScreenTips, 630
  shapes, 83–84, 266–267
  styles, 663
  text, 115
  timelines, 309
  toolbar buttons, 673, 677
  toolbars, 675–676
  tree branches, 232
  Detailed Network Diagram template, 434, 436, 720
  Detect and Repair command (Help menu), 696–697
  developers
    features, 682
    resources, 686
  DFDs (data flow diagrams), 401–402
  Diagram Gallery, 50, 705–706
  Diagram Gallery command (Help menu), 50, 706
  diagrams
    audit diagrams, 288
    block diagrams
      arrows, 230
      Basic Diagram template, 225, 718
      Basic Shapes stencil, 225–226
      Block Diagram template, 225, 718
      Block Diagram with Perspective template, 225, 233, 718
      blocks, 224–225
Blocks Raised stencil, 226
Blocks stencil, 226
Blocks with Perspective stencil, 227
boxes, 229
color schemes, 228
creating, 227–228
flow, 230–231
modifying, 228–229
onions, 224–225, 235–238
positioning shapes, 228
rearranging shapes, 228
relationships, 224, 228
shapes, 223, 228–229
text, 228
3D, 233–235
trees, 224–225, 231–233
uses, 223–224
brainstorming diagrams
annotations, 332–333
appearance options, 332
association lines, 326
color schemes, ... to fit, 331
shapes, 325–326
subtopics, 328
symbols, 334–335
themes, 332
topics, 326–329, 332
Web diagrams, 416
cause and effect diagrams, 288–290
circle-spoke diagrams, 249–250
data flow diagrams, 283–284
event process chain (EPC) diagrams, 290–291
fault tree analysis diagrams, 291–292
fishbone diagrams, 288
HVAC Control Logic diagrams, 496–497
IDEF0 diagrams, 285–286
Ishikawa diagrams, 288
network diagrams
Color By Values add-on, 447
color-coding, 446–447
communication connections, 438
creating, 437
directory services, 441–442
drill-down diagrams, 439–441
equipment racks, 442–444
equipment reports, 445–446
hyperlinks, 439–441
Label Shapes add-on, 446
labeling, 446
large networks, 435
missing features in Visio 2003, 434–435
nodes, 437–438
Number Shapes add-on, 446
numbering, 446
rack diagrams, 442–444
shapes, 438
storing network information, 444–445
templates, 434–436, 720–721
topologies, 437–439
SDL diagrams, 286
software development diagrams
COM, 399–401
data flow diagrams (DFDs), 401–402
dialog boxes, 413–414
enterprise architecture diagrams, 405
Gane-Sarson methodology, 401
Jackson diagrams, 402–404
menus, 411–412
OLE, 399–400
program structure diagrams, 405
ROOM diagrams, 406
templates, 398–399, 721
toolbars, 412–413
user interfaces, 407–409
wizard prototyping, 409–411
TQM (Total Quality Management) diagrams, 292
UML diagrams
activity, 372, 386–387
adding elements, 378
Continued
diagrams (continued)
classes, 371
collaboration, 372, 390–391
communication, 390–391
component, 372, 391–392
creating, 381–382
deployment, 372, 392–393
displaying information in shapes, 379
Documentation window, 376
downloads, 373
element properties, 379–380
errors, 374
events, 373
limitations of Visio, 370
Model Explorer window, 374–377
models, 373
options, 373, 380–381
packages, 371, 373, 377–378
Properties window, 376
relationships, 383–384
removing elements, 378
reverse engineering code, 393–395
samples, 373
sequence, 372, 389–390
shapes, 374
state machine, 388
statechart, 372, 388
static structure diagrams, 382–383
 stereotypes, 373
UML Model Diagram template, 370, 721
use case, 371, 385–386
uses, 369
views, 373
Web diagrams
annotations, 419
arranging shapes, 418–419
brainstorming, 416
conceptual Web sites, 417–418
creating, 416
formatting, 418
site maps, 419–431
templates, 415–416, 721
work flow diagrams, 293
dialog boxes
help, 703
keyboard shortcuts, 713
software development diagrams, 413–414
digital photos, inserting, 164
dimensioning scaled drawings, 460–464
Dimensioning–Architectural stencil, 461, 725
Dimensioning–Engineering stencil, 461, 725
dimensions
doors (plan drawings), 489
measurement units, 463–464
openings (plan drawings), 489
precision, 463–464
windows (plan drawings), 489
direction information (connectors), 96
direction of connectors, 104
Directional Map template, 724
Directional Map 3D template, 724
directional maps, 503–504
Directory Services Diagram template, 6
directory services (network diagrams), 441–442
disabling
Com Add-Ins and Automation Events, 44
Visual Basic for Applications (VBA), 44
discarding customized settings, 697
discontinued features, 6–7
displaying
CAD drawings, 534
custom properties in shape text, 634
document stencils, 586
drawing aids, 27
Drawing Explorer, 18
grids, 9, 16
menus (full menus), 672
rulers, 9, 16
ScreenTips, 703
sections (ShapeSheets), 647
site maps, 428–429
stencil master information, 591
task panes, 16, 703
toolbar buttons, 673
toolbars, 15, 672
distributing drawings
e-mail, 206
   Exchange folders, 207
   routing options, 206–207
distributing shapes evenly, 81
divided bars (charts and graphs), 242
dividers for toolbars and menus, 677
DMAIC Flowchart template, 292
DMS (document management system), 45
DMS Open dialog box, 45
DMS Save dialog box, 45
docking
   Shapes window, 17
task panes, 16
toolbars, 15
   view windows, 19
document info field type, 111
document management system (DMS), 45
document stencils
customizing, 585–586
defined, 586
   displaying, 586
document workspaces
   collaboration, 6
creating, 210–211
defined, 209
deleting, 213
drawings, 212–213
e-mail alerts, 214
opening, 46
tasks, 214
Documentation window, 376
doors (plan drawings)
dimensions, 489
door schedules, 489
inserting, 487–488
repositioning, 488
reverse direction, 488
reverse swing, 488
Dotted Line Report connector, 256
double-click behaviors for shapes, 623–624
downloads
   checking for downloads after installation, 694
   Microsoft Office Online, 707
   UML diagrams, 373
   Visio Viewer, 208
drag and drop shapes, 9
drawing
   arcs, 28–33, 612–613
circles, 32
curves, 28–29, 31
   ellipses, 32
   freeform curves, 30
   lines, 28, 32–33, 608–609, 612–613
   rectangles, 31–32
   shapes, 608–613
   smooth drawing, 83
   splines, 30
   squares, 31
drawing aids, 27, 78
drawing area
   Custom Properties windows, 19
   Drawing Explorer, 18
   Drawing window, 16
girds, 16
   rulers, 16
   Shapes window, 17–18
   ShapeSheet window, 19
   Size & Position window, 19
Drawing Control 2003, 682, 685
Drawing Explorer, 18
Drawing Explorer command (View menu), 18
Drawing Explorer Window command (View menu), 40
Drawing Monitor, 202
drawing scale, 36–37, 455–458
Drawing Scale shape, 458
Drawing Tool Shapes stencil, 725
Drawing toolbar, 26
drawing tools
   accessing, 26
   Arc, 28–29
   Ellipse, 31
   Line, 28
   Pencil, 32–33
   Rectangle, 31
drawings
   animation, 167–168
   blank, 26

Continued
drawings (continued)

CAD drawings
- CAD layers versus Visio layers, 471
- CAD library stencils, 545
- converting to Visio format, 541–545
- converting Visio drawings to CAD format, 545–546
- displaying, 534
- drawing scale, 537–539
- external file references, 536
- inserting, 469, 534
- invisible, 540
- layers, 535
- measurement units, 537
- modifying, 536–537
- positioning, 540–541
- protecting, 539
- resizing, 540–541
- reviewing, 535
- viewing, 467, 534

callouts, 124
Choose Drawing Type pane, 24
comments
- adding, 113
- deleting, 113
- editing, 113
- inserting, 219
- moving, 113
- viewing, 113
creating, 23–26
database links, 190–191, 196–197
Diagram Gallery, 705–706
distributing
- e-mail, 206
- Exchange folders, 207
- routing options, 206–207
document stencils
- customizing, 585–586
- defined, 586
- displaying, 586
document workspaces, 212–213
engineering drawings
- creating, 549
- electrical engineering, 556–557
fluid power diagrams, 554–556
- parts and assemblies, 550–554
- process engineering, 557–573
- reports, 571–572
exporting, 176–177
finding, 43, 46–49
footers, 112
Gantt charts, 312
headers, 112
large drawings, 57–58
layout and routing settings, 37–38
markup, 218–219
measurement units, 44–45
New Drawing pane, 24
opening, 43–46
orientation, 56
pages
- adding, 33–34
- background pages, 34
- deleting, 34, 39
- inserting, 34
- renaming, 39
- reordering, 40
- rotating, 40–41
- settings, 33, 35
panning, 19–20
PERT charts, 320
plan drawings
- CAD drawings, 469
- copying, 469–470
- creating, 468
- door schedules, 489
- layers, 470–478
- merging, 470
- office building layouts, 490–493
- plant floor layouts, 492
- settings, 468
- walls, 482–489
- window schedules, 489
PowerPoint presentations, 164–170
previewing, 54
print settings, 35–37
printing, 55–58
protecting, 53–54
read-only copy, 53
sample drawings (Microsoft Office Online), 49–50, 707
saving, 26, 50–51
scaled drawings
dimensioning, 460–464
drawing scale, 36–37, 455–458
measurement units, 459–460
metric units, 453–454
templates, 452–453
U.S. units, 454
searching, 47–49
shapes
finding, 64–65
numbering, 91–92
sharing with Viewer, 208–209
sizes, 56
templates, 24–25, 577–581
text
aliased, 108
antialiased, 108
greeking, 108
inserting, 108
wavy lines, 108
update options, 214
viewing, 19–20
Web pages, 179–180, 183
zooming in/out, 19–20
drill-down diagrams, 439–441
duplicating shapes, 62–63, 84
dynamic connections, 102
dynamic connectors, 12, 98
dynamic glue, 13–14, 100
dynamic grid, 77
dynamic-static connectors, 98

E
eccentricity handles (shapes), 11
edit box shortcuts, 713
Edit menu commands
Delete Pages, 39
Find, 117
Links, 157
Replace, 118

ing 
editing
appointments (calendars), 302
color schemes, 142
comments, 113
custom properties, 633
database code, 360–361
embedded objects, 162–163
events (calendars), 302
fields, 112
hyperlinks, 153
images on toolbar buttons, 677–678
keyboard shortcuts, 711
locked shapes, 120
macros, 682–683
masters (shapes), 603–606
OLE links, 156
ScreenTips, 630
shapes, 267–268
stencils, 588–589
styles, 662
text, 108, 115, 117
track markup, 6
80-20 charts, 288
Electric and Telecom Plan template, 452, 722
electrical and telecom services (building services plans), 498–499
electrical engineering
Basic Electrical Diagram template, 548, 724
Circuits and Logic Diagram template, 548, 724
Industrial Control Systems template, 548, 724
Systems template, 548, 724
Ellipse tool, 31
ellipses, drawing, 32
e-mail alerts (document workspaces), 214
e-mail distribution of drawings, 206
embedded objects
cropping, 161
defined, 148
ing, 162–163
files
entire files, 158–159
parts of, 159–160
formatting, 160

Continued
embedded objects (continued)
   versus linked objects, 149
   moving, 160–161
   positioning, 160
   resizing, 161
   selecting, 160
   spacing, 161
   text, 116
   Web pages, 183
Embellishments stencil, 725
employee photos in organization charts, 264
Encapsulated Postscript files, 7
end points (connectors), 12, 96–97
End User Defined Character (EUDC), 6, 215
ends (lines)
   reversing, 620
   scaled, 668
   sizing, 670
   symbols, 129
   unscaled, 668
engineering drawings
   creating, 549
   electrical engineering, 556–557
   fluid power diagrams, 554–556
   parts and assemblies, 550–554
   process engineering, 557–573
   reports, 571–572
engineering templates, 548, 722–725
   Enterprise Application template, 398, 721
   enterprise architecture diagrams, 405
   Enterprise Architecture stencil, 405
   entities (flowcharts), 284
   Entity Relationship stencil, 343
   entity relationships (flowcharts), 284
   EPC (event process chain) diagrams, 290–291
   EPC Diagram template, 273, 718
   equipment racks (network diagrams), 442–444
   equipment reports, 445–446
   error messages when printing, 56
   EUDC (End User Defined Character), 6, 215
   event process chain (EPC) diagrams, 290–291
   events
      keyboards events, 682
      mouse events, 682
      UML diagrams, 373
   events (calendar)
      adding, 301–302
      deleting, 302
      editing, 302
      text, 302
   Events section (ShapeSheets), 646, 651
   Excel spreadsheets
      charts, 239
      graphs, 239
      organization charts, 270
   executives (organization charts), 255
   expanding
      site maps, 423
      timelines, 306–307
   exporting
      brainstorming data, 336
      brainstorming diagrams, 325
      drawings, 176–177
      Gantt charts, 319
      graphic formats, 172
      organization charts, 270
      shape data, 198–199
      shapes, 176–177
      timelines, 310–311
   Express-G template, 342, 363–365, 720
   extendable shapes, 251–252
   external file references, 536
   external interactor (flowcharts), 284

F
facilities management. See also space plans
   defined, 511
   Import Data Wizard, 523–525
   importing data into space plans, 522–523
   labeling shapes, 525–526
   reports, 528–529
fault tree analysis diagrams
   Fault Tree Analysis Diagram template, 273, 718
   Fault Tree Analysis Shapes stencil, 292
   uses, 291–292
Favorites stencil, 586–587
feature comparison charts, 242, 248–249
feedback, 5
Field command (Insert menu), 112
Field dialog box, 111–112
fields
  editing, 112
  footers, 112
  headers, 112
  inserting, 111–112
  organization charts, 265
  text, 110–112
  types, 111
file formats
  opening, 43
  saving, 43, 52
  Scalable Vector Graphics (SVG) format, 6
  unsupported file formats, 7
File menu commands
  Choose Drawing Type, 24
  File Search, 47
  New, 24
  Open, 44, 46
  Page Setup, 35, 54
  Print, 52, 55
  Print Preview, 54
  Save, 50
  Save As, 52
  Send To
    Mail Recipient, 206
    Routing Recipient, 206
  Shapes, New Stencil, 585
file paths for templates, 581
File Search command (File menu), 47
File Search dialog box, 49
file shortcuts, 710
files
  author, 47
  DMS (document management system), 45
  embedding, 158–159
  finding, 43, 46–49
  manager, 47
  opening, 43–46
  previewing, 54
  printing, 55–58
  properties, 46–47
  protecting, 53–54
  README file, 697
  read-only copy, 53
recently used files, 45
saving, 45, 50–52, 579
searching, 47–48
subject, 47
title, 47
types (formats), 43
Fill Format section (ShapeSheets), 646, 650
fills (shapes)
  applying, 133
  colors, 133, 139
  patterns, 133, 667–669
  styles, 138
  transparency, 133
Filter Outlook Data dialog box, 303
Filter window, 426
Find command (Edit menu), 117
Find dialog box, 117
finding
  clip art, 163–164
  drawings, 43, 46–49
  files, 43, 46–49
  resources (space plans), 528
  resources in space plans, 527
  sample drawings, 49–50
  shapes, 63–68
  templates, 49–50
  text, 116–117
firefighting templates, 708
fishbone diagrams, 288
fixed grid, 74
flexi-arrows, 230
flipping
  arcs, 30
  shapes, 76
floating toolbars, 16
Floor Plan template, 452, 722
flow (block diagrams), 230–231
flowcharts
  adding data, 293
  adding shapes, 275–276
  adding shapes in a sequence, 275–276
  annotations, 277
  backgrounds, 278
  borders, 278
Continued
flowcharts (continued)

- color schemes, 278
- connecting shapes, 275
- creating, 272, 275
- cross-functional, 280–282
- data flow diagrams, 283–284
- data loops, 284
- data stores, 284
- DMAIC Flowchart, 292
- entities, 284
- entity relationships, 284
- external interactor, 284
- formatting, 278
- functional bands, 282–283
- hyperlinks, 279–280
- IDEF0 diagrams, 285–286
- Import Flowchart Data Wizard, 6, 272
- layout, 276
- modifying, 277
- multiple pages, 278–279
- nonsequential, 276–277
- numbering shapes, 276
- off-page references, 280
- on-page references, 279
- process steps, 281
- processes, 284
- rearranging shapes, 277
- reversing direction of flow, 278
- SDL diagrams, 286
- separators, 283
- shapes, 274, 284
- states, 284
- stencils
  - Basic Flowchart Shapes, 274
  - Cross-Functional Flowchart Shapes, 274
  - Data Flow Diagram Shapes, 274
  - IDEF0 Shapes, 274
- synchronizing, 279–280
- templates
  - Audit Diagram, 273
  - Basic Flowchart, 272, 719
  - Brainstorming, 273
  - Cause and Effect Diagram, 273
  - Cross-Functional Flowchart, 272, 719
- Data Flow Diagram, 273, 719
- EPC Diagram, 273
- Fault Tree Analysis Diagram, 273
- IDEF0 Diagram, 273, 719
- Organization Chart, 719
- SDL Diagram, 273, 719
- TQM Diagram, 273
- Work Flow Diagram, 273
- titles, 278
- uses, 271
- Fluid Power Diagram template, 724
- Fluid Power template, 548
- Fluke Networks, 435
- folders
  - My Recent Documents, 45
  - My Shapes, 587
- footers, 112
- forked arrows, 285
- Format Line dialog box, 32
- Format menu commands
  - Define Styles, 136
  - Protection, 126, 135
  - Style, 137
  - Text, 130
- Format Painter, 130
- Format Shape toolbar, 32, 128
- Format Text toolbar, 128–129
- formats (files). See file formats formatting
  - applying
    - Format Shape toolbar, 128
    - Format Text toolbar, 128–129
    - Formatting toolbar, 128
  - methods, 127
  - bulleted lists, 131–132
  - calendars, 301
  - copying, 130, 134
  - embedded objects, 160
  - flowcharts, 278
  - footers, 112
  - Gantt charts, 317
  - headers, 112
  - keyboard shortcuts, 711
  - lines, 128–129
local formatting, 658–659
numbered lists, 131–133
paragraphs, 130–131
shapes
   applying, 133–134
   block diagrams, 229
   copying, 134
   fills, 133
   group of shapes, 134
options, 133
several shapes at once, 134
site maps, 422–423, 427–428
styles
   applying, 137–138, 658–659
   copying, 663
   creating, 136, 660–662
default styles, 658
defined, 136
deleting, 663
editing, 662
fill styles, 138
guides, 137
line styles, 138
no style, 137
none, 137
normal, 137
renaming, 663
restoring, 659
restoring default styles, 138
saving, 661
templates, 137, 658
text styles, 138
text-only, 137
viewing, 136
text, 129–130
text blocks, 130–131
text shapes, 122
timelines, 308
title blocks, 126
Web diagrams, 418
Formatting toolbar, 128
Forms template, 6, 239–240
Formula tracing window, 682
formulas (ShapeSheets)
   creating, 653–654
   writing, 652–653
freeform curves
   drawing, 30
   snapping, 27
freehand annotations, 219–220
functional bands (cross-functional flowcharts)
   adding, 282
   defined, 282
   deleting, 282
   moving, 283
   removing, 282
   resizing, 282–283
G
Gane, Chris, Structured Systems Analysis: Tools
and Techniques, 398
Gane-Sarson methodology (software
development), 401
Gane-Sarson stencil, 402
Gantt charts
   adding to drawings, 312
   annotations, 316
   creating, 298, 312–313
   data entry, 318–319
   exporting, 319
   formatting, 317
   Gantt Chart Options dialog box, 313
   Gantt Chart Shapes stencil, 312
   Gantt Chart template, 298, 312, 719
   Gantt Chart toolbar, 313–314
   Import Project Data Wizard, 317–318
   importing Microsoft Project data, 317–318
   milestones, 314
   modifying, 313, 316–317
   navigating, 313–314
   task details, 313
   tasks, 314–315
   uses, 311
   working time, 316
GB18030 Chinese character-encoding standard, 6, 215
Generate Site Map dialog box, 421, 423
geometry field type, 111
Geometry section (ShapeSheets), 646, 648–649
Getting Started Task Pane, 45
Getting Started Tutorial, 699

glue
deactivating, 100
dynamic glue, 13–14, 100
point-to-point glue, 100
shape-to-shape glue, 100
snap and glue options, 580
specifying points for, 100–101
static glue, 13–14, 100

gluing shapes, 82, 100–101

graphics
exporting, 172
importing, 172, 174–175
inserting, 163
Scalable Vector Graphics (SVG) format, 6, 173–174

graphs
annotations, 242, 251
axis labels, 246–247
bar graphs, 241, 243–245, 247
Charting Shapes stencil, 240–242
Charts and Graphs template, 239–240, 719
divided bars, 242
Excel spreadsheets, 239
extendable shapes, 251–252
grids, 242
line graphs, 242, 246–247
Marketing Diagrams stencil, 242–243
Marketing Shapes stencil, 242
stackable shapes, 251–252
text, 251
3-D bar graphs, 241
uses, 239

greeking text, 108
Grid command (View menu), 16
gridlines, printing, 36
grids
aligning shapes to grids, 105
charts, 242
coarseness, 74
displaying, 9, 16
dynamic grid, 77
fixed grid, 74
graphs, 242
intervals, 74
origin, 74
positioning shapes, 71–74
printing, 73
turning on/off, 73
variable grid, 74
Group Properties section (ShapeSheets), 646, 650

grouping shapes, 63, 88–90
group-related behaviors of shapes, 628–629
GUARD function, 659
guides
creating, 74
deleting, 75
modifying, 74
moving, 75
moving shapes, 81–82
positioning shapes, 71–72, 74–75
printing, 74
rotating, 75
shapes, 75
styles, 137
turning on/off, 74

H
Halpin, T. A., *Information Modeling and Relational Databases: From Conceptual Analysis to Logical Design*, 343
handles
connection points, 10–11, 598
control handles, 11, 598
control points, 598
eccentricity handles, 11
rotation handles, 11, 598
selection handles, 10–11, 598
Header and Footer command (View menu), 112
Header and Footer dialog box, 112
headers, 112
help
accessing, 703
Activation Wizard, 695
configuring settings, 701–702
developer reference, 686
dialog boxes, 703
Getting Started Tutorial, 699
keyboard shortcuts, 714
Microsoft Knowledge Base, 702–703
Microsoft Office Online Web site, 700
online resources, 704
ScreenTips, 703
searching, 700–701
task panes, 703
topics, 700–701
VBA, 686
Help menu commands
Detect and Repair, 696–697
Diagram Gallery, 50, 706
Help Task Pane, 703
hiding
sections (ShapeSheets), 647
shape borders, 134
shape numbers, 92
subordinates in organization charts, 266
task panes, 16
toolbar buttons, 673
toolbars, 15
hierarchical trees in block diagrams, 231
hierarchy of drawing components, 18
highlighting, 129
Home Plan template, 453, 722
HP OpenView Network Node Manager, 435
HVAC Control Logic diagrams, 453, 496–497, 722
HVAC Plan template, 453, 723
HVAC services (building services plans), 493–495
hyperlinks
creating, 148
description text, 151
editing, 153
flowcharts, 279–280
Full screen mode, 150
icons, 184
inserting, 150–153, 183–185
modifying, 153
network diagrams, 439–441
Normal mode, 150
organization charts, 261, 269
to other drawings, 153
shapes, 150
topics (brainstorming diagrams), 328
I
I-CAM (Integrated Computer-Aided Manufacturing), 274
IDEF (I-CAM Definition Methods), 274
IDEF0 Diagram template, 273, 719
IDEF0 diagrams, 285–286
IDEF0 Shapes stencil, 274
Illustrator (Adobe), 7
images on toolbar buttons, 677–678
IME (Input Method Editor), 216–217
Import Data Wizard, 516, 523–525
Import Flowchart Data Wizard, 6, 272
Import Outlook Data Wizard, 303–304
Import Project Data Wizard, 317–318
Import Timeline Data wizard, 309
importing
brainstorming data, 336
data for space plans, 515–517, 522–523
database models, 345
graphics files, 172, 174–175
Microsoft Project data into Gantt charts, 317–318
Outlook calendar data, 175–176, 303–304
timeline data, 309–310
indenting
bulleted lists, 132
text, 130–131
indexes (database models), 359
Indexing Service, 67–68
Industrial Control Systems template, 548, 724
Infopath, 6
Information Modeling and Relational Databases: From Conceptual Analysis to Logical Design, T. A. Halpin, 343
information technology templates, 720–721
Initial Graphics Exchange Specification, 7
ink, 6, 219–220
Input Method Editor (IME), 216–217
Insert menu commands
  Field, 112
  New Page, 34
  Object, 158
  Symbol, 110
inserting
  CAD drawings, 469, 534
  clip art, 163
  comments, 113, 219
  digital photos, 164
  doors (plan drawings), 487–488
  fields, 111–112
  graphics, 163
  hyperlinks, 150–153, 183–185
  OLE links, 154–155
  openings (plan drawings), 487–488
  pages to drawings, 34
  symbols, 110
text
  connectors, 109
  drawings, 108
  shapes, 108–109
  windows (plan drawings), 487–488
installing IME (Input Method Editor), 216–217
installing Microsoft Office applications
  administrative installation point, 690
  compressed CD image, 691
  location installation source, 690
installing Visio
  activation process, 694–695
  adding features, 696
  from CD, 691
  complete install, 692
  custom install, 692–694
  deleting installation files, 694
  downloads, 694
  Microsoft Windows Installer, 692–694
  minimal install, 692
  paths, 692
  README file, 697
  Reduced Functionality mode, 694–695
  registration, 695
  reinstalling features, 696
  removing features, 696
  repairing features, 696
  repairing the installation, 696–697
  Setup program, 691–694
  typical install, 692
  updates, 694
  when previous version is present, 692
instances (shape masters), 10, 62
Integrated Computer-Aided Manufacturing (I-CAM), 274
Interactive Discovery dialog box, 424
interface
  menus, 14
  task panes, 16
  toolbars, 14–16
International Telecommunications Union standards, 286
intersecting shapes, 616–617
intersections (maps), 504–505
intervals
  grids, 74
  timelines, 306, 308
An Introduction to Database Systems, Seventh Edition, C. J. Date, 342
invisible CAD drawings, 540
inward connection points, 101, 622
inward & outward connection points, 101, 622
Ishikawa diagrams, 288
IT equipment manufacturer stencils, 708

J
Jackson, Michael, Problem Frames: Analyzing and Structuring Software Development Problems, 398
Jackson diagrams, 402–404
Jackson template, 398, 721
jewelry templates, 708
joined arrows, 285
joining lines into paths, 618
jumps (connectors), 38, 106
K
keyboard events, 682
keyboard shortcuts
actions, 710
creating, 678
dialog boxes, 713
eat boxes, 713
editing, 711
file-related commands, 710
formatting, 711
help, 714
letters, 678
listing, 710
menus, 676, 714
shapes, 712–713
toolbars, 714
tools, 712
U.S. keyboard layout, 709
using, 709
viewing options, 711–712
windows, 711–712
zooming in/out, 20, 712
keys (database models), 354–355

L
Label Shapes add-on, 446, 506
labeling
building plans, 506
facilities shapes, 525–526
network diagrams, 446
process steps (flowcharts), 281
shapes, 90
LAN MapShot, 435
Landmark Shapes stencil, 506
landscaping plans, 500–501
language settings, 216
language support, 6, 215–217
large drawings, printing, 57–58
large network diagrams, 435
Larman, Applying UML and Patterns: An Introduction to Object-Oriented Analysis and Design and the Unified Process, 371
Lay Out Shapes command (Shapes menu), 104
Lay Out Shapes dialog box, 104
Layer Properties command (View menu), 472
Layer Properties dialog box, 472
layers
activating, 473
assigning
groups of shapes, 478
masters, 477–478
shapes, 476–477
background pages, 475
CAD drawings, 535
CAD layers versus Visio layers, 471
colors, 475–476
creating, 471–472
deleting, 473–474
locking, 474
printing, 474
properties, 474–475
removing, 473–474
renaming, 472–473
snapping, 475
templates, 580
uses, 470
visibility, 474
layout
brainstorming diagrams, 329–331
flowcharts, 276
organization charts, 263–264
site maps, 422
layout and routing settings, 37–38
Layout and Routing Spacing dialog box, 105
layout of shapes
aligning shapes to grid, 105
arrangement options, 104–105
automatic, 102
specifying layout options, 103–104
LDAP Directory template, 436, 720
legends
brainstorming diagrams, 332–335
Legend Shapes stencil, 326
letters for keyboards shortcuts, 678
levels of transparency, 138
Line dialog box, 129
line end patterns, 667
Line Format section (ShapeSheets), 646
line graphs, 242, 246
line jumps (connectors), 38, 106
line patterns, 128, 665–667
line styles, 138
Line tool, 28
lines
  arrows, 129
  breaking shapes into lines, 618–619
  caps, 129
  colors, 129
  connecting, 28
  creating curves from lines, 620
  drawing, 28, 32–33, 608–609, 612–613
  end point, 28
ends
  reversing, 620
  scaled, 668
  sizing, 670
  symbols, 129
  unscaled, 668
formatting, 128–129
highlighting, 129
joining into paths, 618
orthogonal, 28
parallel, 619
start point, 28
thickness, 128
walls, 487
weight, 128
linking
  defined, 148
  embedding, 149
linking tasks in Gantt charts, 315
links
database links
  drawings, 190–191, 196–197
  limitations, 191
  masters (shapes), 194–196
  ODBC data sources, 191–193
  shapes, 188–190, 193–194, 261
  synchronizing, 199–202
hyperlinks
  defined, 148
  description text, 151
  editing, 153
  flowcharts, 279–280
  Full screen mode, 150
  icons, 184
  inserting, 150–153, 183–185
  modifying, 153
  network diagrams, 439–441
  Normal mode, 150
  organization charts, 261, 269
to other drawings, 153
  shapes, 150
topics (brainstorming diagrams), 328
OLE links
  converting to embedded objects, 157
  defined, 148
  editing, 156
  inserting, 154–155
  managing, 156–157
  moving, 155
  resizing, 155
Links command (Edit menu), 157
Links dialog box, 156–157
List window, 426
listing keyboard shortcuts, 710
lists
  bulleted lists
    bullet symbols, 132
    creating, 131–132
    formatting, 131–132
    indents, 132
  numbered lists
    alignment, 132–133
    creating, 132–133
    formatting, 131–133
local formatting, 658–659
local installation source (Microsoft Office 2003), 690
locked groups of shapes, 89–90
locked shapes
  editing, 120
  formatting, 659
GUARD function, 659

locking layers, 474

Logical Network Diagram template, 434

logos, inserting in templates, 580

M

Mac Clipboard, 7

macro recorder, 682

macros

  editing, 682–683
  naming, 683
  recording, 683
  running, 684
  security, 44
  stopping recording, 683
  templates, 580
  toolbar buttons, 677
  uses, 682
  Visual Basic Editor window, 683

Macros commands (Tools menu)

  Macros, 683
  Record New Macro, 683
  Stop Recording, 683

Macros dialog box, 683

main topics (brainstorming diagrams), 327

manager (file), 47

managers (organization charts), 255

manufacturing templates, 708

maps

  Directional Map template, 724
  Directional Map 3D template, 724
  directional maps, 503–504
  intersections, 504–505
  Landmark Shapes stencil, 506
  metro maps, 504
  roads, 504–505
  3-D, 505

margins

  printing, 58
  text blocks, 130

Marketing Charts and Graphs template, 719

marketing diagrams, 249–250

Marketing Diagrams stencil, 242–243

Marketing Shapes stencil, 242

markup tracking, 6, 217–221

masters (shapes)

  accessing, 583
  assigning to layers, 477–478
  consolidating, 583
  copying, 84
  copying and pasting between stencils, 590
  copyrights, 583
  creating, 600–602
  database links, 194–196
  defined, 10, 62
  deleting, 590, 602
  displaying master information, 591
  editing, 603–606
  icon images, 603–605
  inheritance, 597
  instances, 10, 62
  labels, 592
  modifying, 602–606
  properties, 606–607
  renaming, 603
  shortcuts, 607

measurement units

  add-ons, 694
  CAD drawings, 537
  dimensions, 463–464
  drawing scale, 36–37
  drawings, 44–45
  rulers, 16, 73
  scaled drawings, 459–460
  specifying, 37
  templates, 694

mechanical engineering

  Fluid Power Diagram template, 724
  Fluid Power template, 548
  Part and Assembly Diagram template, 724
  Part and Assembly template, 548

medical templates, 708

menus

  adding to menus, 674
  adding to toolbars, 673

Continued
menus (continued)
commands
  adding, 674
deleing, 674
rerranging, 675
creating, 671, 675
customizing, 671, 674–675
deleting, 675
displaying full menus, 672
dividers, 677
keyboard shortcuts, 676, 714
menu bar, 14
modifying, 673
personalized, 672
removing, 675
renaming, 676
resetting, 675
sharing, 678
software development diagrams, 411–412
text-only display, 677
merging
  plan drawings, 470
  view windows, 19
metric units, 694
metro maps, 504
MicroGrafx
  Designer 3.1, 7
  Designer 6.0 English, 7
MicroMuse Precision, 435
Microsoft Infopath, 6
Microsoft Knowledge Base, 702–703
Microsoft Office Online
  clip art, 700
downloads, 707
Help Task Pane, 700
sample drawings, 50, 707
sounds, 700
templates, 700, 707
Microsoft Office Search dialog box, 47
Microsoft Office 2003
  administrative installation point, 690
  advanced deployment features, 689
  compressed CD image, 691
  local installation source, 690
Microsoft Office Visio Activation Wizard, 695
Microsoft Office Visio Drawing Control 2003, 682, 685
Microsoft Office Visio Viewer 2003, 6
Microsoft Project, 297
Microsoft Visio Setup dialog box, 691
Microsoft Visio 2002 files, opening, 43
Microsoft Visio 2003
  capabilities, 7–8
  discontinued features, 6–7
  drawing area, 16–19
  interface, 14–16
  new features, 4–6
Microsoft Web site, 689, 704
Microsoft Windows Installer, 692–694
Microstation (DGN), 7
milestones
  Gantt charts, 314
timelines, 306, 308
Mind Mapping Diagram template, 273
mirror images of shapes, 76
Miscellaneous section (ShapeSheets), 646, 649–650
misspelling indicator, 108
Model Explorer (Data Flow Model Diagram template), 6
Model Explorer window, 374–377
models for databases. See database models
modifying
  arrows, 230
  behaviors (shapes), 626
  block diagrams, 228–229
  CAD drawings, 536-537
  calendars, 301
  color palette, 140
  color schemes, 142
  connector paths, 105
  cubicles (office building layouts), 493
  cubicles (office plan drawings), 492
  flowcharts, 277
  Gantt charts, 313, 316–317
guides, 74
hyperlinks, 153
images on toolbar buttons, 677–678
masters (shapes), 602–606
menus, 673
shapes
  methods, 62–63
    organization charts, 267–268
space plans, 518–519
text blocks, 126
timelines, 308–309
trees, 232–233
monthly calendars, 299–300
mouse events, 682
Move Shapes add-on, 79–80
moving
  arcs, 29
  callouts, 124
  comments, 113
  connection points, 101–102, 621
  embedded objects, 160–161
  expanded timelines, 307
  functional bands (cross-functional flowcharts), 283
guides, 75
OLE links, 155
resources (space plans), 527
shapes
  guides, 81–82
  methods, 75
    in organization charts, 266
tab stops, 130
text, 120
text shapes, 120
toolbars, 16
topics (brainstorming diagrams), 330–331
tree trunks, 233
zero point on rulers, 73
MSDN Web site, 56, 686
MSN Messenger Windows NetMeeting
  Messenger Service, 212
MSN.com Web site, 704
multilanguage support, 6, 215–217
Multilingual User Interface packs, 6
multiple pages
  flowcharts, 278–279
  organization charts, 268–269
My Recent Documents folder, 45
My Shapes folder, 587

N
naming
  macros, 683
  stencils, 585
  templates, 579
navigating
  Diagram Gallery, 706
  Gantt charts, 313–314
  markup, 221
Network and Peripherals stencil, 438
network diagrams
  Color By Values add-on, 447
  color-coding, 446–447
  communication connections, 438
  creating, 437
  directory services, 441–442
  drill-down diagrams, 439–441
  equipment racks, 442–444
  equipment reports, 445–446
  hyperlinks, 439–441
  Label Shapes add-on, 446
  labeling, 446
  large networks, 435
  missing features in Visio 2003, 434–435
  nodes, 437–438
  Number Shapes add-on, 446
  numbering, 446
  rack diagrams, 442–444
  shapes, 438
  storing network information, 444–445
  templates, 434–436, 720–721
topologies, 437–439
Network Inspector, 435
New command (File menu), 24
New Drawing pane, 24–25
New Drawing Task Pane, 45, 50
New Layer dialog box, 472
New Page command (Insert menu), 34
New Toolbar dialog box, 675
New Window command (Window menu), 21
newsgroups, 700, 708
nodes (network diagrams), 437–438
nonprinting shapes, 55
nonsequential flowcharts, 276–277
Novell Directory Services Diagram template, 721
Novell Directory Services template, 436
nudging shapes, 75
Number Shapes add-on, 446
numbered lists
  alignment, 132–133
  creating, 132–133
  formatting, 131–133
numbering
  network diagrams, 446
  shapes, 90–92, 276

0
Object command (Insert menu), 158
object info field type, 111
The Object Primer, 3rd Edition: Agile Model
Driven Development with UML 2.0,
Scott Ambler, 370, 398
Object Relational stencil, 343
ODBC data sources, 191–193
ODMA (Open Document Management
Architecture) 1.5 standard, 45
Office 2003
  administrative installation point, 690
  advanced deployment features, 689
  compressed CD image, 691
  local installation source, 690
office building layouts
  cubicles, 490–493
  equipment, 491
  furniture, 491
  modular furniture, 491
Office Layout template, 452, 722
office productivity templates, 718–719
Office Review Kit, 689
off-page references (flowcharts), 280
OLE, 399
OLE links
  converting to embedded objects, 157
  creating, 148
  editing, 156
inserting, 154–155
managing, 156–157
moving, 155
resizing, 155
1-D Endpoints section (ShapeSheets), 646
1-D shapes, 11, 598–599
onion diagrams
  Block Diagram template, 225
  Callout shapes, 237
  Concentric Layer shape, 238
  Concentric Layer shapes, 236–237
  creating, 235
  modifying shapes, 235–238
  Partial Layer shape, 237–238
  relationships, 224
text, 237
uses, 224
online meetings, 212
on-page references (flowcharts), 279
Open command (File menu), 44, 46
Open dialog box, 43–44, 46
Open Document Management Architecture
  (ODMA) 1.5 standard, 45
open shapes, 600
Open Stencil dialog box, 584
opening
  Diagram Gallery, 706
drawings, 43–46
files, 43–46
ShapeSheets, 644
stencils, 46, 64, 584, 587, 706
templates, 46
Visio 2002 files, 43
workspaces, 46
openings (plan drawings)
dimensions, 489
inserting, 487–488
repositioning, 488
reverse direction, 488
reverse swing, 488
Options command (Tools menu)
  General tab, 45
  Security tab, 44
  Units tab, 16, 44
Options dialog box, 50–51
Optiview Console, 435
organization charts
  adding pages, 262
  assistants, 255
  breaking, 262
  changing position types, 268
  comparing, 269
  consultants, 255
  creating, 254–259, 262–263
  creating with existing organization data, 259–261
deleting shapes, 266–267
dotted line reports, 256
editing shapes, 267–268
employee photos, 264
Excel spreadsheets, 270
executive summaries, 262
executives, 255
exporting, 270
fields, 265
hiding subordinates, 266
hyperlinks, 261, 269
layout, 263–264
managers, 255
modifying shapes, 267–268
moving shapes, 266
multiple pages, 268–269
Organization Chart Conversion Utility, 6
Organization Chart stencil, 254–255
Organization Chart template, 253–254, 719
Organization Chart toolbar, 254
Organization Chart Wizard, 257–259
positions, 255
readability, 265–266
reordering subordinates, 267
reports, 270
setting options, 264–265
shapes, 265
sharing, 269–270
spacing, 266
staff positions, 255
subordinates, 255
superiors, 255
synchronizing, 261, 268

  team frame, 256
text, 265
three positions, 256
uses, 253
vacancies, 255
organizing built-in templates, 581
orientation
drawings, 56
printing, 36
timelines, 309
Orinoco Web site, 708
ORM templates, 342, 363–367, 720
orthogonal lines, 28
Outline window, 325
outlines of brainstorming diagrams, 325
Outlook calendar data, importing, 175–176, 303–304
Output Options dialog box, 172
Output window, 349
outward connection points, 101, 622
overflowing text, 109

P
page breaks
  reducing thickness, 58
  viewing, 58
page info field type, 111
page settings for templates, 580
Page Setup command (File menu), 35, 54
Page Setup dialog box, 35–36, 54, 58
page sizes, 36
pages
calendar, 300
drawings
  adding, 33–34
  background pages, 34
deleting, 34, 39
inserting, 34
renaming, 39
reordering, 40
rotating, 40–41
settings, 33, 35
organizational charts, 262
Pan & Zoom window, 20
panes
  Choose Drawing Type, 24
  Clip Art, 163
  New Drawing, 24–25
  Reviewing, 217
  Shared Workspace, 214
  panning drawings, 19–20
Paragraph section (ShapeSheets), 646
paragraphs
  alignment, 131
  formatting, 130–131
  indents, 131
parallel lines and curves, 619
Pareto charts, 288
Parking and Road stencil, 501
parking lots (site plans), 501–503
Part and Assembly template, 453, 548, 724
pasting shape masters, 590
pattern shapes
  alignment, 665
  applying, 664
  behaviors, 664
  built-in, 663
  colors, 665
  creating, 664–665, 669–670
  custom patterns, 663–664
  defined, 663
  fill patterns, 133, 667–669
  line end patterns, 667
  line patterns, 128, 665–667
  line weight, 665
  lines, 128
  pin position, 665
  using, 664
PCX files, 7
peer topics (brainstorming diagrams), 328
Pencil tool, 32–33
perimeter of shapes, calculating, 464
personalized menus and toolbars, 672
PERT charts
  adding to drawings, 320
  creating, 298, 320–321
  PERT Chart Shapes stencil, 320
  PERT Chart template, 298, 719
project summaries, 321–322
  uses, 319–320
photos
  employee photos in organization charts, 264
  inserting digital photos, 164
PIAs (primary interop assemblies), 682
pie charts, 241, 247–248
pin position (pattern shapes), 665
Piping and Instrumentation Diagram template, 548, 725
placement behaviors for shapes, 103, 625–626
plan drawings
  CAD drawings, 469
  copying, 469–470
  creating, 468
  door schedules, 489
  layers
    activating, 473
    assignments, 476–478
    background pages, 475
    colors, 475–476
    creating, 471–472
    deleting, 473–474
    locking, 474
    printing, 474
    properties, 474–475
    removing, 473–474
    renaming, 472–473
    snapping, 475
    uses, 470
    visibility, 474
  merging, 470
  office building layouts
    cubicles, 490–493
    equipment, 491
    furniture, 491
    modular furniture, 491
  plant floor layouts, 492
  settings, 468
  walls
    alignment, 486
    colors, 487
    connecting, 484–486
    converting spaces into walls, 482–484
creating, 482, 484–485

display options, 486
doors, 487–489

line styles, 487

openings, 487–489

properties, 486

resizing, 485–486

shapes, 485

thickness of, 486

Wall Shape list, 482

Walls, Doors, and Windows stencil, 482

Walls, Shell, and Structure stencil, 482

windows, 487–489

window schedules, 489

plans. See building plans; building services plans; landscaping plans; site plans; space plans

plant floor layouts, 492

Plant Layout Plan template, 453, 723

plumbing (building services plans), 499–500

Plumbing and Piping Plan template, 453, 723

point-to-point glue, 13, 100

populating template pages, 579

positioning

CAD drawings, 540–541

embedded objects, 160

shapes

block diagrams, 228

coordinates, 78–79

drawing aids, 78

dynamic grid, 77

grids, 71–74

guides, 71–72, 74–75

methods, 62

precision tools, 76–77

rulers, 71–73

text, 119–120

positions (organization charts), 255

PostScript graphics format, 172

PowerPoint presentations

animating drawings, 167

color schemes, 165

color-coordinated backgrounds, 166–169

embedding Visio drawings, 164–165

formatting Visio drawings, 165

sequences, 168

transitions, 170

pre-populating template pages, 579

preventing shapes from printing, 626

previewing

drawings, 54

files, 54

primary interop assemblies (PIAs), 682

Print command (File menu), 52, 55

Print dialog box, 52

print files, 52

Print Preview command (File menu), 54

print settings, 35–37, 580

Print Setup dialog box, 58

Print ShapeSheet file, 56

printing

background page, 56

drawing markup, 56

drawings, 55–58

error messages, 56

files, 55–58

foreground page, 56

gridlines, 36

guides, 74

layers, 474

margins, 58

markup, 56

orientation, 36

page size, 36

preventing shapes from printing, 626

selections, 55–56

ShapeSheets, 56

Problem Frames: Analyzing and Structuring Software Development Problems, Michael Jackson, 398

process engineering

Piping and Instrumentation Diagram template, 548, 725

Process Flow Diagram template, 548, 725

process steps (flowcharts)

adding, 281

associating departments, 281–282

Continued
process steps (flowcharts) *(continued)*

labeling, 281
splitting, 281–282

processes (flowcharts), 284
productivity templates, 718–719
Professional version, 717

Program Evaluation and Review Technique (PERT) charts. *See PERT charts*

program structure diagrams, 405
Program Structure template, 399, 721
programming shapes, 653

project scheduling

Gantt charts

adding to drawings, 312
annotations, 316
creating, 312–313
data entry, 318–319
exporting, 319
formatting, 317

Import Project Data Wizard, 317–318
importing Microsoft Project data, 317–318
milestones, 314
modifying, 313, 316–317
navigating, 313–314
task details, 313
tasks, 314–315
uses, 311
working time, 316

Microsoft Project, 297

PERT charts

adding to drawings, 320
creating, 320–321
project summaries, 321–322
uses, 319–320

templates

Calendar, 298, 719
Gantt Chart, 298, 312, 719
PERT Chart, 298, 719
Timeline, 298, 304–305, 719

timelines

arrows, 309
creating, 305–306
date format, 308
deleting, 309

exporting, 310–311
formatting, 308
Import Timeline Data wizard, 309
importing data, 309–310
intervals, 306
milestones, 306
modifying, 308–309
orientation, 309
revising dates automatically, 309
start and end dates, 308
synchronizing milestones and intervals, 308
time format, 308
timescale, 308
timescale date and markings, 309
uses, 304–305

properties

files, 46–47
layers, 474–475
masters (shapes), 606–607
walls, 486

Properties command (Tools menu), 46
Properties dialog box, 46
Properties window, 376
Protect Document dialog box, 54

protecting

CAD drawings, 539
files, 53–54
shapes, 135–136

Protection command (Format menu), 126, 135
Protection dialog box, 135
Protection section (ShapeSheets), 646, 650

publishing

add-ons, 682
Web, 177–185

Pullig, Bruce (home-grown Sun Visio templates), 708

Q

quality management

cause and effect diagrams, 288
80-20 charts, 288
Ishikawa diagrams, 288
Pareto charts, 288
TQM (Total Quality Management) diagrams, 292

R
Rack Diagram template, 434, 436, 721
rack diagrams, 442–444
Rack-mounted Equipment stencil, 443
readability of organization charts, 265–266
README file, 697
read-only copy, 53
read-only stencils, 588–589
Real-Time Object-Oriented Modeling (ROOM) diagrams, 406
rearranging
menu commands, 675
shapes
  in block diagrams, 228
  in flowcharts, 277
  in stencils, 592
toolbar buttons, 673
topics (brainstorming diagrams), 330
recently used files, 45
recording macros, 683
Rectangle tool, 31
rectangles, drawing, 31–32
redoing actions, 83
Reduced Functionality mode, 694–695
reducing thickness of page breaks, 58
Reflected Ceiling Plan template, 453, 723
refreshing
database models, 348
  space plans, 525
registration, 695
reinstalling Visio 2003 features, 696
relational notation (database models), 353
relationships
  block diagrams, 224, 228
  COM, 401
database models, 358–359
  UML diagrams, 383–384
removing
  features after installation, 696
  functional bands (cross-functional flowcharts), 282
  layers, 473–474
  menu commands, 674
  menus, 675
  tab stops, 130
toolbar buttons, 673, 677
tree branches, 232
Rename Layer dialog box, 472
Rename Style dialog box, 663
Rename Toolbar dialog box, 676
renaming
  layers, 472–473
  masters (shapes), 603
  menus, 676
  pages, 39
  styles, 663
toolbars, 676
reordering
  overlapping shapes, 87, 229
  pages, 40
  subordinates (in organization charts), 267
topics (in brainstorming diagrams), 330
repairing
  Visio 2003 features, 696
  Visio 2003 installation, 696–697
Replace command (Edit menu), 118
replacing text, 116–118
reports
custom property data, 294–295, 637–641
  engineering drawings, 571–572
equipment reports, 445–446
facilities reports, 528–529
organization charts, 270
Web site maps, 430–431
repositioning
doors (plan drawings), 488
openings (plan drawings), 488
text in shapes, 119–120
windows (plan drawings), 488
resetting
menus, 675
toolbar buttons, 677
toolbars, 676

reshaping shapes
arcs, 30
block diagrams, 229
methods, 86

resizing
CAD drawings, 540–541
embedded objects, 161
expanded timelines, 307
functional bands (cross-functional flowcharts), 282–283
OLE links, 155
shapes
block diagrams, 229
1-D shapes, 86
2-D shapes, 86
text, 120
walls, 485–486
width of drop-down lists in toolbars, 676
resizing pages to fit brainstorming diagrams, 331

resources (space plans)
adding, 520–521
asset resources, 519
assigning, 519–520
boundary resources, 519
categories, 521–522
computer resources, 519
finding, 527–528
moving, 527
person resources, 519
printer resources, 519
Smart Tags, 528
space resources, 519
unassigned, 520

restaurant management templates, 708

restoring
color palette, 140–141
styles, 659
styles (default styles), 138
restoring settings, 697

Reverse Engineer Wizard, 346–347
reverse engineering
code into UML diagrams, 393–395
databases, 345–348

reversing
direction of flow (in flowcharts), 278
line ends, 620

reviewing
CAD drawings, 535
markup, 221
Reviewing task pane, 217
Reviewing toolbar, 217, 220

roads
maps, 504–505
Road shapes, 504
site plans, 501–502

ROOM diagrams, 406
ROOM template, 399, 721

rotating
arcs, 30
guides, 75
pages, 40–41
shapes, 75
text, 120

rotation handles (shapes), 11, 598
routing drawings, 206–207
Routing Slip dialog box, 206, 303
routing styles (connectors), 104
routing styles of connectors, 105

rulers
displaying, 9, 16
measurement units, 16, 73
positioning shapes, 71–73
subdivisions, 72–73
Text Ruler, 130
turning on/off, 72
zero point, 73

Rulers command (View menu), 16
running macros, 684

S
sample drawings, 49–50
sample drawings (Microsoft Office Online), 50, 707

Save As command (File menu), 52
Save As dialog box, 51
Save command (File menu), 50
saving
  custom toolbar buttons, 676
drawings, 26, 50–51
file formats, 43, 52
files, 45, 50–52
print files, 52
stencils, 51, 587–588
styles, 661
templates, 51, 579
Visio 2002 files, 52
XML files, 52
Scalable Vector Graphics (SVG) format, 6, 173–174
Scale shape, 458
Scale Symbol shape, 458
scaled drawings
  dimensioning, 460–464
drawing scale, 36–37, 455–458
measurement units, 459–460
metric units, 453–454
templates, 452–453
U.S. units, 453–454
scaling line ends, 668
ScreenTips, 630, 703
SDL Diagram template, 273, 719
SDL diagrams, 286
Search command (Tools menu), 47
search results stencils, 68, 585
searching
  clip art, 163–164
drawings, 47–49
files, 47–48
help, 700–701
Microsoft Knowledge Base, 702–703
sample drawings, 49–50
shapes, 63–68
site maps, 424
templates, 49–50
text, 116–117
Web site maps, 424
sections (ShapeSheets)
  Actions, 650–651
  complete reference, 647
  Custom Properties, 646, 651
displaying, 647
Events, 646, 651
Fill Format, 646, 650
Geometry, 646, 648–649
Group Properties, 646, 650
hiding, 647
Line Format, 646
Miscellaneous, 646, 649–650
1-D Endpoints, 646
Paragraph, 646
Protection, 646, 650
Shape Layout, 646
Shape Transform, 646, 648
Text Block Format, 646
Text Transform, 646
User-defined Cells, 646, 652
Security and Access Plan template, 453, 723
security and access systems (building services plans), 500
security of macros, 44
selecting
  colors, 139
  embedded objects, 160
  shapes
    individual shapes, 69
    multiple shapes, 70–71
task panes, 703
templates, 581
text, 113–115
selection behaviors for shapes, 627
selection handles (shapes), 10–11, 598
selections of pages, printing, 55–56
Send To commands (File menu)
  Mail Recipient, 206
  Routing Recipient, 206
separators (flowcharts), 283
settings
  colors (defaults), 142
discarding customized settings, 697
drawing scale, 456–457

Continued
settings (continued)
language settings, 216
layout and routing settings, 37–38
plan drawings, 468
print settings, 35–37
restoring, 697
spacing, 38
templates, 579–580
Setup program (Visio installation), 691–694
shadows (shapes), 39, 134–135, 229
shape data, exporting, 198–199
Shape Layout section (ShapeSheets), 646
shape masters
accessing, 583
assigning to layers, 477–478
consolidating, 583
copying, 84
copying and pasting between stencils, 590
copyrights, 583
creating, 600–602
database links, 194–196
defined, 10, 62
deleting, 590, 602
displaying master information, 591
editing, 603–606
icon images, 603–605
inheritance, 597
instances, 10, 62
labels, 592
modifying, 602–606
properties, 606–607
renaming, 603
shortcuts, 607
Shape Transform section (ShapeSheets), 646, 648
shapes
alignment, 81, 614
area, 464–465
arrays, 84–85
behaviors
configuring, 103
connector splitting, 628
defined, 596
double-click behaviors, 623–624
group-related, 628–629
modifying, 626
pattern shapes, 664
placement, 103, 625–626
preventing shapes from printing, 626
selection, 627
switching between 1-D and 2-D behavior, 627
block diagrams, 223
borders, 134
Boundary and Space, 510–511, 517–518
brainstorming diagrams
main topic, 325
topic, 325–326
breaking
groups, 88–89
into lines and arcs, 618–619
into smaller pieces, 616
calculating area and perimeter, 464–465
callouts, 237
closed shapes, 600, 609–610
color-coding, 143
combining, 615
connection points
adding, 101, 621
blue x indicator, 10, 96
changing types, 623
Connection Point tool, 101–102
deleting, 101–102, 621
illustration, 11
inward, 101, 622
inward & outward, 101, 622
moving, 101–102, 621
outward, 101, 622
valid connections, 622
connections, 102
connectors
Connector tool, 98
Connectors stencil, 96–97
control points, 99
creating, 97–98
curved, 104
defined, 12, 95
direction, 104
direction information, 96
  dynamic, 13, 98
  dynamic-static, 98
end points, 12, 96–97
  glue, 13–14, 100–101
jumps, 106
  line jumps, 38, 106
methods for using, 97
modifying path of, 105
routing styles, 104–105
sequence of shapes, 99
spacing, 105–106
splitting, 38, 628
start point, 12
static, 98
static-dynamic, 98
straight, 104
straight connectors, 12–13

copying, 84

custom properties
  adding, 294
  applying, 630–631
  creating, 631–633
  defined, 596
  deleting, 633
  displaying in shape text, 634
  editing, 633
  generating reports from, 294–295
  options, 632
  reports, 637–641
  sets, 634–637
  uses, 294

cutouts, 617–618
database links, 188–190, 193–194, 261
database modeling, 343–344
defined, 61
deleting, 83–84, 266–267
distributing, 81
drag and drop, 9
drawing, 608–613
drawing scale, 458
duplicating, 62–63, 84
definition, 38, 628
editing, 267–268
exporting, 176–177
extendable shapes, 251–252
extension options, 611–612
fills
  colors, 133, 139
  formatting, 133
  patterns, 133
  transparency, 133
finding, 63–68
flipping, 76
flowcharts, 274, 284
formatting
  applying, 133–134
  in block diagrams, 229
  copying, 134
  fills, 133
  group of shapes, 134
  locked shapes, 659
  options, 133
  several shapes at once, 134
geometry, 597
gluing, 82, 100–101
grouping, 63, 88–90

guides, 75
handles
  connection points, 10–11, 598
  control handles, 11, 598
  control points, 598
  eccentricity handles, 11
  rotation handles, 11, 598
  selection handles, 10–11, 598
hyperlinks, 150
Indexing Service, 67–68
inheritance, 597
intersecting, 616–617
keyboard shortcuts, 712–713
labeling, 90
layout
  aligning shapes to grid, 105
  arrangement options, 104–105
  automatic, 102
  specifying layout options, 103–104
linking database records to shapes, 261
locked groups, 89–90

Continued
shapes (continued)
locked shapes
  editing, 120
  formatting, 659
  GUARD function, 659
text, 120
mirror images, 76
modifying, 62–63
Move Shapes add-on, 79–80
moving
  guides, 81–82
  methods, 75
  organization charts, 266
My Shapes folder, 587
network diagrams, 438
nonprinting shapes, 55
nudging, 75
numbering, 90–92, 276
1-D shapes, 11, 598–599
open shapes, 600
organization charts, 265
pattern shapes
  alignment, 665
  applying, 664
  behaviors, 664
  colors, 665
  creating, 664–665
defined, 663
fill patterns, 667–669
line end patterns, 667
line patterns, 128, 665–667
line weight, 665
pin position, 665
using, 664
perimeter, 464–465
positioning
  block diagrams, 228
  coordinates, 78–79
drawing aids, 78
dynamic grid, 77
grids, 71–74
  guides, 71–72, 74–75
  methods, 62
  precision tools, 76–78
  rulers, 71–73
programming, 653
protecting, 135–136
rearranging
  in block diagrams, 228
  in flowcharts, 277
  in stencils, 592
reordering overlapping shapes, 87, 229
reshaping, 86, 229
resizing
  block diagrams, 229
  1-D shapes, 86
  2-D shapes, 86
Road, 504
rotating, 75
Scale, 458
Scale Symbol, 458
ScreenTips, 630, 703
searching, 63–68
selecting
  individual shapes, 69
  multiple shapes, 70–71
sequences, 99
shadows, 39, 134–135, 229
SmartShapes, 9, 61
SmartTags, 682
snapping, 76–77
spacing
  average shape size, 105
  connectors, 105–106
  between shapes, 105
stackable shapes, 251–252
stencils
  adding, 588–591
  rearranging, 592
storing, 586–587
storing data, 87–88
templates, 580
text
  inserting, 108–109
  overflowing text, 109
  repositioning, 119–120
text shapes
  formatting, 122
  moving, 120
text-only, 109–110
Title Block Large, 458
Title Block Small, 458
transforming, 613–615
2-D shapes, 598–599
UML diagrams, 374
unions, 614–615
walls, 484–485
Shapes window, 17–18, 63
ShapeSheet window, 19
ShapeSheets
 formulas, 652–654
 opening, 644
 Print ShapeSheet file, 56
 printing, 56
 programming shapes, 653
 sections
 Actions, 650–651
 complete reference, 647
 Custom Properties, 646, 651
 displaying, 647
 Events, 646, 651
 Fill Format, 646, 650
 Geometry, 646, 648–649
 Group Properties, 646, 650
 hiding, 647
 Line Format, 646
 Miscellaneous, 646, 649–650
 1-D Endpoints, 646
 Paragraph, 646
 Protection, 646, 650
 Shape Layout, 646
 Shape Transform, 646, 648
 Text Block Format, 646
 Text Transform, 646
 User-defined Cells, 646, 652
 uses, 596
 window options, 644–645
 ShapeStudio add-on, 682
 shape-to-shape connections, 102
 shape-to-shape glue, 13, 100
 Shared Workspace task pane, 214
 shared workspaces. See workspaces
 sharing
 drawings, 208–209
 menus, 678
 organization charts, 269–270
 toolbars, 678
 Shop Floor–Machines and Equipment stencil, 492
 Shop Floor–Storage and Distribution stencil, 492
 shortcuts
 actions, 710
 creating, 678
 dialog boxes, 713
 edit boxes, 713
 editing, 711
 file-related commands, 710
 formatting, 711
 help, 714
 letters, 678
 listing, 710
 masters (shapes), 607
 menus, 676, 714
 shapes, 712–713
 toolbars, 15, 714
 tools, 712
 U.S. keyboard layout, 709
 using, 709
 viewing options, 711–712
 windows, 711–712
 zooming in/out, 20, 712
 Show ShapeSheet command (Window menu), 19
 showing. See displaying
 site maps
 broken links, 429–430
 collapsing, 423
 comparing, 427
 discovery settings, 422
 displaying across multiple pages, 429
 duplicate links, 429
 expanding, 423
 Filter window, 426
 formatting, 422–423, 427–428
 generating, 421–422
 hierarchical view, 428
 layout, 422
 List window, 426
 maintenance, 420
 memory models, 425–427
 Continued
site maps (continued)
   page-centric view, 428
   protected areas, 424
   protocols, 423
   reports, 430–431
   searching, 424
   shape size, 422
   uses, 419
   viewing, 423
   Web Site Map template, 416, 420, 721
site plans
   creating, 501
   parking lots, 501–503
   roads, 501–502
   Site Plan template, 453, 723
   uses, 500
Six Sigma business improvement process,
   291–292
Size & Position window, 19, 62, 120
Size & Position Window command (View menu),
   120
sizes of drawings, 56
sizing line ends, 670
SmartShapes, 9, 61
SmartTags, 528, 682
smooth drawing, 83
Snap & Glue command (Tools menu), 27
Snap & Glue toolbar, 100
snapping
   defined, 26
   freeform curves, 27
   layers, 475
   shapes, 76–77
   snap and glue options, 580
   strength of attraction, 27
software development diagrams
   COM, 399–401
   data flow diagrams (DFDs), 401–402
   dialog boxes, 413–414
   enterprise architecture diagrams, 405
   Gane-Sarson methodology, 401
   Jackson diagrams, 402–404
   menus, 411–412
   OLE, 399–400
program structure diagrams, 405
ROOM diagrams, 406
templates
   COM and OLE, 398, 721
   Data Flow Model Diagram, 6, 398, 721
   Enterprise Application, 398, 721
   Jackson, 398, 721
   Program Structure, 399, 721
   ROOM, 399, 721
   Windows XP User Interface, 399, 407–409,
      721
toolbars, 412–413
user interfaces, 407–409
uses, 721
wizard prototyping, 409–411
sounds, 700
space plans
   adding resources, 520–521
   assigning resources, 519–520
   Boundary and Space shapes, 510–511,
      517–518
   categories of resources, 521–522
   Category Explorer, 512–514
   color-coding, 527
   conceptual planning, 510
   creating, 514–516
   detailed conceptual planning, 510
   detailed space planning, 510
   display options, 526
   facilities management, 522–523
   finding resources, 527–528
   Import Data Wizard, 516–517, 523–525
   importing data, 515–517, 522–523
   modifying, 518–519
   moving resources, 527
   preliminary layouts, 514
   refreshing, 525
   SmartTags (for resources), 528
   Space Explorer, 512–514
   Space Plan Startup Wizard, 509–511,
      515–516
   Space Plan template, 453, 509, 512
   tracking plans, 514
   uses, 509
spacing
connectors, 105–106
embedded objects, 161
organization charts, 266
settings, 38
shapes
average shape size, 105
between shapes, 105
special characters, 110
specifying
measurement units, 37
page size, 36
shape layout options, 103–104
specifying points for glue, 100–101
spell checking, 108, 118
Spelling command (Tools menu), 118
splines, 30
splitting
connectors, 38, 628
process steps (flowcharts), 281–282
squares, drawing, 31
stackable shapes, 251–252
staff positions (organization charts), 255
start and end dates ( timelines), 308
states (flowcharts), 284
static connectors, 98
static glue, 13–14, 100
static-dynamic connectors, 98
stencils
Active Directory Sites and Services, 442
adding shapes, 588–591
Annotations, 123, 725
appearance, 591–592
Audit Diagram Shapes, 288
background colors, 592
Backgrounds, 725
Basic Flowchart Shapes, 274
Basic Shapes, 225–226
Blocks, 226
Blocks Raised, 226
Blocks with Perspective, 227
Borders and Titles, 125, 725
Brainstorming Shapes, 325
CAD libraries, 545
Calendar Shapes, 301
Callouts, 123, 725
Charting Shapes, 121–123, 240–242
Conceptual Web Site Shapes, 417
Connectors, 96–97, 725
copying, 588
creating
from document stencil, 585–586
from existing stencil, 584
read-only option, 584, 588–589
from scratch, 585
from shape search results, 585
shortcuts, 583–584
Cross-Functional Flowchart Shapes, 274
Cubicles, 490–491
Custom Line Patterns, 725
Custom Patterns–Scaled, 725
Custom Patterns–Unscaled, 725
Data Flow Diagram Shapes, 274
defined, 8–9
Dimensioning–Architectural, 461, 725
Dimensioning–Engineering, 461, 725
document stencils
customizing, 585–586
displaying, 586
Drawing Tool Shapes, 725
editing, 588–589
Embellishments, 725
Enterprise Architecture, 405
Entity Relationship, 343
Fault Tree Analysis Shapes, 292
Favorites, 586–587
Forms, 240
Gane-Sarson, 402
Gantt Chart Shapes, 312
IDEF0 Shapes, 274
IT equipment manufacturers, 708
Landmark Shapes, 506
Legend Shapes, 326, 333–334
Marketing Diagrams, 242–243
Marketing Shapes, 242
masters
accessing, 583
consolidating, 583
Continued
stencils (continued)
  copying and pasting between stencils, 590
  copyrights, 583
displaying master information, 591
defleting, 590
labels, 592
naming, 585
Network and Peripherals, 438
Object Relational, 343
opening, 46, 64, 584, 587, 706
Organization Chart, 254–255
Parking and Road, 501
PERT Chart Shapes, 320
Rack-mounted Equipment, 443
saving, 51, 587–588
search results stencil, 68, 585
shapes, 592
Shop Floor–Machines and Equipment, 492
Shop Floor–Storage and Distribution, 492
Symbols, 725
templates, 579–580
third-party, 707–708
Timeline Shapes, 305–306
Title Blocks, 725
Vehicles, 492, 501
Walls, Doors, and Windows, 482
Walls, Shell, and Structure, 482
Warehouse–Shipping and Receiving, 492
Web Site Map Shapes, 420
Wizards, 409
Workflow Diagram Shapes, 293
stopping macro recording, 683
styles
  applying, 137–138, 658–659
copying, 663
default styles, 658
defining, 136
depleting, 663
displaying, 662
ing fill styles, 138
guides, 137
line jumps, 106
line styles, 138
no style, 137
normal, 137
renaming, 663
restoring, 659
restoring default styles, 138
saving, 661
templates, 137, 580, 658
text styles, 138
text-only, 137
subject (file), 47
subordinates (organization charts), 255
subtopics (brainstorming diagrams), 328
summarizing projects, 321–322
Sun equipment templates, 708
superiors (organization charts), 255
SVG (Scalable Vector Graphics) format, 6, 173–174
switching between 1-D and 2-D behavior, 627
Symbol command (Insert menu), 110
symbols
  brainstorming diagrams, 334–335
  bulleted lists, 132
  inserting, 110
  Symbols stencil, 725
synchronizing
  database links, 199–202
  flowcharts, 279–280
  intervals (timelines), 308
  milestones (timelines), 308
  organization charts, 261, 268
system network diagrams, 402–403
Systems template, 548, 724

T

tab stops, 130
tables (text), 121–122
tabular charts, 242
Task Pane command (View menu), 16
task panes
  Advanced File Search, 48–49
  Choose Drawing Type, 24
  Clip Art, 163
closing, 703
defined, 16
displaying, 16, 703
docking, 16
Getting Started, 45
Help, 703
hiding, 16
New Drawing, 24–25, 45, 50
Reviewing, 217
selecting, 703
Shared Workspace, 214
Template Help, 703
viewing, 703
tasks
document workspaces, 214
Gantt charts, 314–315
keyboard shortcuts, 709
team frame (organization charts), 256
Template Help Task Pane, 703
templates
  Active Directory, 436, 720
  agriculture, 708
  architecture, 722–724
Audit Diagram, 273, 288, 718
background pages, 580
Basic Diagram, 225, 718
Basic Electrical Diagram, 548, 724
Basic Flowchart, 272, 719
Basic Network Diagram, 434–436, 720
biology, 708
Block Diagram, 225, 718
Block Diagram with Perspective, 225, 233, 718
Brainstorming Diagram, 273, 323–324, 718
built-in
customizing, 577–581
location of, 580–581
number of, 577
organizing, 581
Calendar, 298, 719
Cause and Effect Diagram, 273, 288–289, 718
Charts and Graphs, 239–240, 719
Circuits and Logic Diagram, 548, 724
color palettes, 580
color schemes, 580
COM and OLE, 398, 721
Conceptual Web Site, 415–417, 721
creating, 577–580
Cross-Functional Flowchart, 272, 719
Data Flow Diagram, 273, 719
Data Flow Model Diagram, 6, 398, 721
Database Model Diagram, 342, 720
dating, 708
defined, 8–9
Detailed Network Diagram, 434, 720
Directional Map, 724
Directional Map 3D, 724
Directory Services Diagram, 6
DMAIC Flowchart, 292
drawings, 24–25, 577–581
Electric and Telecom Plan, 452, 722
engineering, 548, 722–725
Enterprise Application, 398, 721
EPC Diagram, 273, 718
Express-G, 342, 363–365, 720
Fault Tree Analysis Diagram, 273, 718
file paths, 581
finding, 49–50
firefighting, 708
Floor Plan, 452, 722
Fluid Power, 548
Fluid Power Diagram, 724
Forms, 6, 239–240

Continued
templates (continued)
  Gantt Chart, 298, 312, 719
  Home Plan, 453, 722
  HVAC Control Logic Diagram Plan, 453, 722
  HVAC Plan, 453, 723
  IDEF0 Diagram, 273, 719
  Industrial Control Systems, 548, 724
  information technology, 720–721
  Jackson, 398, 721
  jewelry, 708
  layers, 580
  LDAP Directory, 436, 720
  Logical Network Diagram, 434
  logos, 580
  macros, 580
  manufacturing, 708
  Marketing Charts and Graphs, 719
  medical, 708
  metric units, 694
  Microsoft Office Online, 50, 700, 707
  Mind Mapping Diagram, 273
  naming, 579
  Novell Directory Services, 436
  Novell Directory Services Diagram, 721
  Office Layout, 452, 722
  office productivity, 718–719
  opening, 46
  Organization Chart, 253–254, 719
  ORM, 342, 363–367, 720
  page settings, 580
  Part and Assembly, 453, 548, 724
  PERT Chart, 298, 719
  Piping and Instrumentation Diagram, 548, 725
  Plant Layout Plan, 453, 723
  Plumbing and Piping Plan, 453, 723
  pre-populating pages, 579
  print settings, 580
  Process Flow Diagram, 548, 725
  Program Structure, 399, 721
  Rack Diagram, 434, 436, 721
  Reflected Ceiling Plan, 453, 723
  restaurant management, 708
  ROOM, 399, 721
  saving, 51, 579
  SDL Diagram, 273, 719
  searching, 49–50
  Security and Access Plan, 453, 723
  selecting, 581
  settings, 579–580
  shapes, 580
  Site Plan, 453, 723
  snap and glue options, 580
  Space Plan, 453, 509, 512
  stencils, 579–580
  styles, 137, 580, 658
  Sun equipment, 708
  Systems, 548, 724
  third-party, 707–708
  Timeline, 298, 304–305, 719
  TQM Diagram, 273, 719
  transportation, 708
  UML Model Diagram, 370, 721
  U.S. measurement units, 694
  uses, 577
  Web Site Map, 416, 420, 721
  window settings, 580
  Windows XP User Interface, 399, 407–409, 721
  wireless networks, 708
  Work Flow Diagram, 273, 719
  Templatesnext.com Web site, 708
  text
    aliased, 108
    antialiased, 108
    appointments (calendars), 302
    block diagrams, 228
    bulleted lists
      bullet symbols, 132
      creating, 131–132
      formatting, 131–132
      indents, 132
    callouts
      adding to a drawing, 124
      custom properties, 124
      moving, 124
      stencils, 123
      uses, 123
    charts, 251
    checking spelling, 118
comments, 113
connectors, 109
copying from other applications, 116
correcting, 116
deleting, 115
drawings, 108
drawing tools, 130
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
drawings, 108
headers, 112
indents, 130–131
locked shapes, 120
misspelling indicator, 108
moving, 120
numbered lists
  alignment, 132–133
  creating, 132–133
  formatting, 131–133
onion diagrams, 237
organization charts, 265
positioning, 119–120
replacing, 116–118
resizing, 120
rotating, 120
searching, 116–117
selecting, 113–115
shapes
  inserting, 108–109
  overflowing text, 109
  repositioning, 119–120
special characters, 110
spelling errors, 108
tab stops, 130
tables, 121–122
title blocks, 125–126
wavy lines, 108
Text Block Format section (ShapeSheets), 646
Text Block tool, 119
text blocks
  alignment, 130
  background colors, 130
  formatting, 130–131
  margins, 130
  transparency (of background), 130–131
Text command (Format menu), 130
Text dialog box, 130
text files (.txt), 7
Text Ruler, 130
text shapes
  formatting, 122
  moving, 120
text styles, 138
Text Transform section (ShapeSheets), 646
text-only display of toolbars and menus, 677
text-only shapes, 109–110
themes (brainstorming diagrams), 332
thickness options
  lines, 128
  walls, 486
third-party Visio templates and stencils,
  707–708
three positions (organization charts), 256
3-D bar graphs, 241
3-D block diagrams, 233–235
3-D boxes, 229
3-D maps, 505
3-D pyramids in charts, 250
Tile command (Window menu), 21
tiling windows, 21
Timeline Shapes stencil, 305–306
Timeline template, 298, 304–305, 719
timelines
  arrows, 309
  creating, 305–306
date format, 308
deleting, 309
expanding, 306–307
exporting, 310–311
formatting, 308
Import Timeline Data wizard, 309
importing data, 309–310

Continued
timelines (continued)
   intervals, 306, 308
   milestones, 306, 308
   modifying, 308–309
   orientation, 309
   revising dates automatically, 309
   start and end dates, 308
   time format, 308
   timescale, 308
   timescale date and markings, 309
   uses, 304–305
Title Block Large shape, 458
Title Block Small shape, 458
title blocks, 125–126
Title Blocks stencil, 725
titles
   Borders and Titles stencil, 125
calendars, 301
files, 47
flowcharts, 278
toolbars
   Brainstorming, 324–325
buttons
   adding, 672
deleting, 673, 677
displaying, 673
hiding, 673
image options, 677
images, 678
macros, 677
rearranging, 673
removing, 677
resetting, 677
   saving custom buttons, 676
   ToolTips, 677
creating, 671, 675
customizing, 671–673
deleting, 675–676
displaying, 15, 672
dividers, 677
docking, 15
Drawing, 26
floating, 16
Format Shape, 32, 128
Format Text, 128–129
Formatting, 128
Gantt Chart, 313–314
   hiding, 15
   keyboard shortcuts, 714
menus, 673
   moving, 16
Organization Chart, 254
   personalized, 672
   renaming, 676
   resetting, 676
   resizing width of drop-down lists, 676
Reviewing, 217, 220
ScreenTips, 703
sharing, 678
shortcuts, 15
Snap & Glue, 100
title blocks, 125–126
software development diagrams, 412–413
text-only display, 677
Toolbars command (View menu), 15, 672
   Connection Point, 101–102
   Connector, 98
drawing tools
   accessing, 26
   Arc, 28–29
   Ellipse, 31
   Line, 28
   Pencil, 32–33
   Rectangle, 31
   keyboard shortcuts, 712
   Text Block, 119
   ToolTips, 677
   Tools menu commands
   Customize, Toolbars, 672
Macros
   Macros, 683
   Record New Macro, 683
   Stop Recording, 683
Options
   General tab, 45
   Security tab, 44
   Units tab, 16, 44
Properties, 46
   Search, 47
Snap & Glue, 27
Spelling, 118
ToolTips, 677
topics (brainstorming diagrams)
  adding
    multiple topics at once, 328–329
    single topics, 326
association lines, 326
connecting, 326–327, 329
copying, 330
hyperlinks, 328
main topics, 327
moving, 330–331
peer topics, 328
rearranging, 330
reordering, 330
shapes, 332
subtopics, 328
topologies (network diagrams), 437–439
Total Quality Management (TQM) diagrams, 292
TQM Diagram template, 273, 719
track markup, 6, 217–221
transforming shapes, 613–615
transparency
  fills (shapes), 133
  levels of, 138
  text blocks, 130–131
transportation templates, 708
trees
  block diagrams, 224–225, 231–233
branches
  adding, 232
  adjusting position, 232
deleting, 232
distance between, 233
removing, 232
modifying, 232–233
moving tree trucks, 233
triangular charts, 250
turning on/off
  grids, 73
guides, 74
markup, 6
rulers, 72
track markup, 218
tutorial, 699
2-D shapes, 11, 598–599
.txt (text) files, 7
type library, 684–685
Type of Installation dialog box, 692

U
UML diagrams
  activity, 372, 386–387
  adding elements, 378
classes, 371
collaboration, 372, 390–391
communication, 390–391
component, 372, 391–392
creating, 381–382
deployment, 372, 392–393
displaying information in shapes, 379
Documentation window, 376
downloads, 373
element properties, 379–380
events, 373
limitations of Visio, 370
Model Explorer window, 374–377
models, 373
options, 373, 380–381
packages, 371, 373, 377–378
Properties window, 376
relationships, 383–384
removing elements, 378
reverse engineering code, 393–395
samples, 373
sequence, 372, 389–390
shapes, 374
state machine, 388
statechart, 372, 388
static structure diagrams, 382–383
stereotypes, 373
UML Model Diagram template, 370, 721
use case, 371, 385–386
uses, 369
views, 373

UML Shape Display Options dialog box, 379
undoing actions, 83
Unicode, 6, 215
uninstalling Visio 2003, 696
unions (shapes), 614–615
units of measurement
  add-ons, 694
  CAD drawings, 537
  dimensions, 463–464
drawing scale, 36–37
drawings, 44–45
  rulers, 16, 73
  scaled drawings, 459–460
  specifying, 37
  templates, 694
unsupported file formats, 7
update options (drawings), 214
updates, 694
U.S. measurement units, 694
user interfaces, 407–409
user-defined cells field type, 111
User-defined Cells section (ShapeSheets), 646, 652

V
vacancies (organization charts), 255
valid connections for connection points, 622
variable grid, 74
VBA (Visual Basic for Applications)
  disabling, 44
  help, 686
Vehicles stencil, 492, 501
versions, 692
View menu commands
  Drawing Explorer, 18
  Drawing Explorer Window, 40
  Grid, 16
  Header and Footer, 112
  Layer Properties, 472
  Rulers, 16
  Size & Position Window, 120
  Task Pane, 16
  Toolbars, 15, 672
view windows, 19
Viewer, 6, 208–209

viewing
  CAD drawings, 467, 534
colors, 139
comments, 113
drawings, 19–20
multiple windows, 21
page breaks, 58
site maps, 423
styles, 136
task panes, 703
views of database models, 357–358
visibility of layers, 474
Visimation.com Web site, 708
Visio Activation Wizard, 695
Visio Drawing Control 2003, 682, 685
Visio Enterprise Network Tools, 708
Visio Extras stencils. See stencils
Visio for Enterprise Architects, 342
Visio Professional 2003, 717
Visio 2002 files
  opening, 43
  saving, 52
Visio 2003
  capabilities, 7–8
discontinued features, 6–7
drawing area, 16–19
interface, 14–16
new features, 4–6
Visio 2003 installation
  activation process, 694–695
  adding features, 696
  from CD, 691
  complete install, 692
custom install, 692–694
deleting installation files, 694
downloads, 694
Microsoft Windows Installer, 692–694
minimal install, 692
paths, 692
README file, 697
Reduced Functionality mode, 694–695
registration, 695
reinstalling features, 696
removing features, 696
repairing features, 696
repairing the installation, 696–697
Setup program, 691–694
typical install, 692
updates, 694
when previous version is present, 692
Visio type library, 684–685
Visio Viewer, 6, 208–209
Visual Basic Editor
accessing, 685
Visual Basic Editor window, 683
Visual Basic for Applications (VBA)
disabling, 44
help, 686
W
walls
alignment, 486
colors, 487
connecting, 484–486
converting spaces into walls, 482–484
creating, 482, 484–485
display options, 486
doors, 487–489
line styles, 487
openings, 487–489
properties, 486
resizing, 485–486
shapes, 484–485
stencils
  Walls, Doors, and Windows, 482
  Walls, Shell, and Structure, 482
thickness of, 486
Wall Shape list, 482
windows, 487–489
Warehouse–Shipping and Receiving stencil, 492
wavy lines (in place of text), 108
Web diagrams
  annotations, 419
  arranging shapes, 418–419
  brainstorming, 416
  conceptual Web sites, 417–418
  creating, 416
  formatting, 418
site maps
  broken links, 429–430
collapsing, 423
comparing, 427
discovery settings, 422
displaying across multiple pages, 429
duplicate links, 429
expanding, 423
Filter window, 426
formatting, 422–423, 427–428
generating, 421–422
hierarchical view, 428
layout, 422
List window, 426
maintenance, 420
memory models, 425–427
page-centric view, 428
protected areas, 424
protocols, 423
reports, 430–431
searching, 424
shape size, 422
uses, 419
viewing, 423
templates, 415–416, 721
Web pages
  creating, 179–180
drawings, 179
embedded drawings, 183
hyperlinks, 183–185
options, 180–182
output formats, 177–180
Web Site Map Settings dialog box, 422–423
Web Site Map Shapes stencil, 420
Web Site Map template, 416, 420, 721
Web sites
  Altimatech.com, 708
  bcentral.com, 704
  Microsoft, 689, 704
  Microsoft Office Online, 50, 707
  MSDN, 56, 686
  MSN.com, 704
  Orinoco, 708
  Templatesnext.com, 708
  Visimation.com, 708
weekly calendars, 299
weight of lines, 128
What’s Up Gold, 435
Window menu commands
  Cascade, 21
  New Window, 21
  Show ShapeSheet, 19
  Tile, 21
windows
  cascading, 21
  Code Editor, 361
  creating, 20–21
  Custom Properties, 19
  Database Properties, 349–352
  Documentation, 376
  Drawing, 16
  Filter, 426
  Formula tracing, 682
  keyboard shortcuts, 711–712
  List, 426
  Model Explorer, 374–377
  Outline, 325
  Output, 349
  Pan & Zoom, 20
  Properties, 376
  Shapes, 17–18, 63
  ShapeSheets, 19, 644–645
  Size & Position, 19, 62, 120
  templates, 580
  tiling, 21
view windows
  docking, 19
  merging, 19
  viewing multiple windows, 21
Visual Basic Editor, 683
writing ShapeSheet formulas, 652–653
wireless network templates, 708
wizard prototyping, 409–411
wizards
  Activation Wizard, 695
  Import Data Wizard, 516–517, 523–525
  Import Flowchart Data Wizard, 6, 272
  Import Outlook Data Wizard, 303–304
  Import Project Data Wizard, 317–318
  Import Timeline Data wizard, 309
  Organization Chart Wizard, 257–259
  Reverse Engineer Wizard, 346–347
  Space Plan Startup Wizard, 509–511, 515–516
Wizards stencil, 409
Workflow Diagram Shapes stencil, 293
Work Flow Diagram template, 273, 719
work flow diagrams, 293
workspaces
  collaboration, 6
  creating, 210–211
  defined, 209
  deleting, 213
  drawings, 212–213
  e-mail alerts, 214
  opening, 46
  tasks, 214
XML files, 52
XML Web Service support, 682
yearly calendars, 300
zooming in/out
  drawings, 19–20
  keyboard shortcuts, 20, 712
  text editing, 108
ZSoft PC Paintbrush (PCX), 7, 172
zero point (rulers), 73